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Sugar Serve 12.3 Administration Guide
The Sugar Administration Guide helps system administrator users configure and
customize their CRM application. 

Introduction to Sugar Administration

Overview

The Administration Guide is the CRM admin's guide to configuring and
administering their Sugar instance. Admins have access to everything in this guide
but regular users with developer-level role access to at least one module can also
access certain admin functionality. To understand the difference between an
admin user and a regular user with developer-level role access, see the 
Understanding Admin and Developer Access in Roles article. Also, refer to the Role
Management documentation for details on configuring roles in your instance.

The majority of admin functionality in Sugar can be found on the Admin page,
accessible by opening the user menu in the top right corner of Sugar and selecting
"Admin":

The Admin page contains links to a wide variety of settings and tools for
configuring your Sugar instance, grouped by topic and also searchable using the 
search bar. Hover over any link to see a quick summary of what the linked page
includes. The following are some examples of admin functionality that most Sugar
administrators will likely have to work with closely:
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User, Password, Team, and Role management to manipulate user access
SugarIdentity for user management if your instance is SugarIdentity-
enabled
Email management to configure incoming and outgoing system email
accounts and behaviors
System management to control functional aspects and system-wide
preferences within Sugar
Module Builder to create new, custom modules as needed to fully match
your organization's processes
Studio to tailor existing modules to your organization's needs by adding or
modifying fields, relationships, and layouts
SugarBPM to design workflow processes to automate many actions in your
system

Admin Page Search

At the top of the Admin page, use the search bar to quickly find specific links
within the Admin page. When you start entering a search term, a list of matching
results is displayed and is updated as you type. If there are more than seven
matching results, use the page numbers and arrow buttons at the bottom to
navigate between the pages of results. Click any result to open the specific link.
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Admin Wizard

Overview

Sugar offers administrators a wide range of configuration options to set up their
account. Upon your initial log into Sugar, you will go through configuring some
basic settings (i.e., Your Information, Your Locale, etc.) for your user profile. You
may skip these steps and configure these settings in your user preferences at a
later time. Once your user profile set up is complete, you will be able to navigate to
a specific area of Sugar to perform various administrative functions (e.g.,
importing data, creating users, configuring the application via Studio, etc.) as well.
Please note that system administrators can also set up each user's basic settings
when creating a user in Sugar. This documentation will cover the various options
available when first accessing your Sugar account.

Note: For instances that use SugarIdentity, the administrator will need to
access SugarIdentity to create and manage user records as well as configure 
password requirements and set up LDAP/SAML authentication. 

Login Screen

The Sugar login screen is where you enter your login credentials (User Name,
Password) to access your instance. Please note that this applies to instances that
do not use SugarIdentity as well as instances that use SugarIdentity. To access
Sugar's login screen, enter in your Sugar instance URL
(e.g., https://example.sugarondemand.com) in your web browser. If you do not
know your instance URL or login credentials, please reach out to another system
administrator in your organization for assistance. Sugar's Admin Wizard will
launch upon your first successful login allowing you to configure various system-
wide settings as well as some personal settings. For more information on logging
in to Sugar, refer to the Getting Started documentation.

Note: If your organization uses multiple SugarIdentity-enabled instances (e.g.,
production, sandboxes) and you have accessed different user accounts in the
tenant(s) (e.g., ABC Production, ABC Test Sandbox), the login screen will display
an account selector with the list of users you have logged in as for the current
instance you are accessing. 
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Note: If your instance has more active users than is allowed by your Sugar license,
a warning is displayed on the login screen and regular users will not be able to log
in. Admin users will be able to log in but will be redirected to the Users module.
For more information, see the Understanding User Types, License Types, and
Sugar Licenses article.

Language

Users have the option to choose the primary language they want to be displayed in
Sugar by clicking the Language icon on the bottom right of the Login screen. The
Language dropdown list will appear allowing you to select the appropriate
language you want to be displayed in your Sugar account. The out-of-the-box
default language in Sugar is English (US), but administrators can change the
default language globally via Admin > Locale. For more information on configuring
the default language in Sugar, please refer to the Locale section of the System
documentation. Once the default language is changed, it will display as the default
selection on the login screen for all users.

Please note that you must select the language that you want to be displayed each
time you log in, otherwise the default language will display in Sugar.

Administrators can also configure what languages are available to select in the
Language dropdown list via Admin > Languages. For more information on
managing the available languages, please refer to the Languages section of the
System documentation.
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The following languages are available to display in Sugar:

Albanian Hungarian
Arabic Italian
Brazilian Portuguese Japanese
Bulgarian Korean
Catalan Latvian
Chinese (Simplified) Lithuanian
Chinese (Traditional) Norwegian
Croatian Polish
Czech Portuguese
Danish Romanian
Dutch Russian
English (UK) Serbian
English (US) Slovak
Estonian Spanish
Finnish Spanish (Latin)
French Swedish
German Thai
Greek Turkish
Hebrew Ukrainian

Your Information

                            8 / 829



 

Once the Admin Wizard is completed, you will have the option to configure some of
your personal settings via the User Wizard. The User Profile step is where you can
enter key information (i.e. name, email address, and phone) about yourself to be
stored in your user profile. Please note that the information you provide on this
step can be updated in your user preferences at a later time if desired. For more
information on configuring your personal information under user preferences,
refer to the Getting Started documentation.

Note: For instances that use SugarIdentity, the User Profile step of the User
Wizard is read-only and the displayed fields (e.g., First Name, Last Name) can only
be edited in SugarIdentity. 

The following options are available to configure your user profile:

First Name: Enter your first name.
Last Name: Enter your last name.
Email: Enter your email address.
Office Phone: Enter your office number.

Please note that all required fields will indicate "Required" in the field and must be
completed prior to moving to the next step of the wizard. Once your personal
information is entered, click "Next".

Your Locale

The Your Locale step is where you can configure the date, time, and name format
you want to be displayed in Sugar based on your current geographical
location. Please note that the information you provide on this page will override
the system locale settings and can be updated in your user preferences at a later
time, if desired. For more information on configuring your locale settings, please
refer to the Locale Settings section of the Getting Started documentation.
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The following options are available to configure your locale settings:

Time Format: Select the format you want the time stamps displayed in
Sugar.
Date Format: Select the format you want the date stamps displayed in
Sugar.
Name Format: Select the format you want the concatenated name fields
displayed in Sugar's list view and record view.

Once your locale information is entered, click "Next".

The following page confirms that you are ready to use Sugar and allows you to
perform various administrative functions (e.g., import data, create users, configure
the application via Studio). Selecting the action item(s) will take you directly to the
specific area of the Admin page to create new users, import data from external
sources, etc. Please note that you can click "Start Sugar" to go directly to your
Sugar account if you wish to configure these settings at a later time.
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SugarCloud Management

Overview

The SugarCloud section of Sugar's Admin page allows administrators to view,
access, and manage key information and data pertaining to their Sugar cloud
instance. 

 

The SugarCloud section contains the following menus:

Menu Description
SugarCloud Settings Create and manage user records,

manage password requirements, set up
LDAP, SAML, or OIDC authentication,
etc. in SugarIdentity.

SugarCloud Insights Monitor your instance's database and
file system storage usage, license usage,
and gain access to PHP error logs and
access logs.

SugarCloud Settings

SugarIdentity, which can be accessed via Admin > SugarCloud Settings, allows
customers to securely manage user identities as well as access applications and
services in the SugarCRM ecosystem. SugarIdentity provides a federated identity
solution based on industry standards and supports comprehensive single sign-on
for the Sugar application, Sugar Plug-in for Outlook, Sugar Connect, SugarCRM
mobile app, and the Sugar Plug-in for Microsoft Excel. For instances that use
SugarIdentity, the administrator will access SugarIdentity to perform actions such
as creating and managing user records, managing password requirements, and
setting up LDAP, SAML, or OIDC authentication. For more information, refer to
the SugarIdentity Guide. 

SugarCloud Insights
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The SugarCloud Insights page, which can be accessed via Admin > SugarCloud
Insights, allows administrators of instances hosted on Sugar's cloud servers (i.e.,
sugarondemand.com) to access and manage the following information:

View the total amount of file system and database storage being used
across your cloud instances along with a breakdown of the current
database and file system storage usage for each cloud instance.
Monitor the total number of active users counting against your Sugar
license.
Download your instance's backup files. 
Generate PHP error and access logs which can help provide useful
information when troubleshooting certain issues. 
Manage the email list for important SugarCloud service notifications.

Team Management

Overview

Team Management is used in Sugar to define permissions and groupings for users.
These permissions cover what records a user is and is not able to access. Teams
are used in conjunction with Roles to form a robust security model for non-admin
users in Sugar. Users can use team settings on specific records to allow different
users within Sugar the option to view these given records. Team settings can also
be used as a form of organization, thereby separating records to be associated with
specific teams for better tracking. Teams can be based on departments,
geographic regions, or whatever else works best in a given organization.

Teams Module Tab

Click the Teams module tab in the navigation bar, shown after selecting Team
Management in the Admin page, to access the Teams list view. You may also click
the three-dots menu in the Teams module tab to display the Actions and Recently
Viewed menus. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the list of teams you last viewed
in the module. 
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create Team Opens the edit view to create a new

team.
Teams Opens the list view layout to search and

display teams.

Team Types

From an administrative standpoint, teams will be handled differently based on
their types. From a user standpoint, all teams will be treated pretty much the
same. Each team type has their own special set of characteristics that aid in
defining it. The team types defined as:

The Global Team
Standard Teams
Private Teams

The Global Team

The Global team is created automatically when a Sugar instance is created. Global
is the default team for all new users, and every user is a member of the team by
default. Global is a universal team, so any records associated to the global team
will be viewable by the users on this team. The global team is intended to be
available for all users and a shared team for all users in Sugar.

Note: You cannot delete the Global team.

Standard Teams
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Standard Teams can be created by administrators via Team Management. These
are to be used throughout Sugar to organize and grant access on organizational
specifics to your organization. Standard teams are often broken out into groups by
departments, geographical regions, or duties. For example, you may have an East
and West team, and also a Sales and Support team.

Private Teams

For every user that is created in Sugar, a corresponding private team is
automatically created in the Teams module. By default, the private team name
is the user's first and last name. A private team name will be updated any time the
corresponding user's profile is edited and re-saved, even if the change was not
made to the user's first or last name. For example, the private team for Jane Smith
will be automatically named "Jane Smith". If the administrator edits private team
"Jane Smith" to "Jane Smith-HR", and then user Jane Smith later updates the phone
number on her user profile, Sugar will revert the private team name back to the
user's first and last name, "Jane Smith".

If your organization plans to edit private team names, you must disable the
automatic update feature. Navigate to Admin > System Settings and select the
checkbox next to "Prevent private team names from inheriting the user's name
fields". For more information on this setting, please refer to the System
 documentation.

Note: Private teams are not deleted in the same method as other teams. For more
information on deleting private teams, please review the Deleting Teams section of
this guide.

Team Membership Types

Team memberships are given to users in one of two ways, either by an explicit or
implicit membership. Regardless of the type, membership will control what records
regular users are able to see. Each membership can be granted in different ways
and can constitute different functionality. Team membership is represented in the
team's detail view, as well as the user's detail view.

Note: Administrators do not adhere to team security and therefore can see all
records.

Explicit team membership is forged when the relationship is defined from either
the team's or user's detail view. In addition, explicit relationships are also
represented with private team memberships. Explicit memberships, other than
private teams, can be removed as necessary from the team's or user's detail view.
Explicit memberships will also include membership functionality for actions such
as workflows, SugarBPM processes, and inbound email.

                           14 / 829



 

Implicit team membership is used for record visibility. Implicit membership relies
on the "Reports To" field in the User Profile. When one user reports to another, the
hierarchy of the "Reports To" field is kept intact. The user being reported to will
inherit the team membership of the subordinate user and be able to see any
records on both his or her own team, and the teams of which the subordinate user
is a member. The subordinate's teams can either be explicit or implicit teams in
this scenario.

Note: Implicit relationships cannot be removed, but the cause for their
relationship can be broken by changing the reporting hierarchy.

In the Team's detail view, the user's subpanel will showcase which relationships
are explicit and which are implicit. In the "Membership" column of the Users
subpanel, the user will either be marked as a "Member", meaning that they are an
explicit member, or "Member Reports-to", meaning they are an implicit member.
In addition, the users marked with the "Member Reports-to" will not include an
"Unlink" button, as they have another user (or users) reporting to them on this
team.

Creating Teams

There are two methods that can be used to create teams in Sugar. These are via
the Teams module tab's action list or by duplicating an existing team and then
editing it. After initially creating the team, the administrator will need to associate
users to the newly created team. For information on creating Private Teams,
please review the Repairing Teams section of this documentation.

Note: For instances that use SugarIdentity, administrators have the ability to log
in as other users in their organization using the "Impersonate (Log in as)" option in
SugarIdentity. So, after associating users to the appropriate teams, you can
preview the user's account via impersonation to ensure that the proper
permissions are in place. For more information on impersonating a user, refer to
the SugarIdentity Guide. 

Creating Via Teams Module
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The most common way to create a new team is via the Create Team option in
the Teams module tab. This opens up the edit view layout which allows you to
enter in all the relevant information for the team.

Use the following steps to create a team via the Teams module:

1. Navigate to Admin > Team Management.
Note: The Teams list view will open displaying all existing teams that are
currently available.

2. Click the three-dots menu in the Teams module tab and select "Create
Team". 

3. Enter a name and description of the team on the edit view screen that you
are now presented with. Enter the appropriate values for fields in the edit
view layout. All required fields are marked with a red asterisk and must be
completed prior to saving.

4. On the team's detail view, add users that are members of this team.

Creating Via Duplication

You can also create a new team by duplicating an existing team. The Copy option is
useful if the team you are creating has a similar set of members or a similar
description to an existing team

Use the following steps to create a team by duplicating an existing record:

1. Navigate to a team record's detail view.
2. Click the Actions menu and select "Copy".

3. The displayed edit view is pre-populated with the original team's values.
Update the name field, and description if need be, then click "Save".
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4. On the team's detail view, add any users that are members of this team that
are not on the original team, and remove any unwanted users.

Adding Users to Teams Via Teams Module

A user has to be associated to a team to be able to view records that are associated
to the specific team. Assigning a team is much like any other many-to-many
relationship in Sugar, where many users can be associated to one particular team,
and one user can also be assigned to multiple teams. From Team Management, a
user can be associated to a team via the Users subpanel at the bottom of the detail
view. To associate users to a team, follow the following steps:

1. Navigate to Admin > Team Management
2. From the Teams list view, select the team that you are working with
3. At the bottom of the page, click "Select User" from the Users subpanel 

4. Use the popup search menu to search for and select the user(s) you would
like to add to this team where you can either click on the user's name or, if
selecting multiple users, click their corresponding checkboxes and then
click "Select" 

5. After selecting the user(s) the popup search box will close and the user(s)
will now be displayed in the Users subpanel for the team to complete the
relationship 
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Adding Users to Teams Via Users Module

A regular user must be associated to a team to be able to view records that are
associated to that team. Assigning a team is much like any other many-to-many
relationship in Sugar, where many users can be associated to one particular team,
and one user can also be assigned to multiple teams. From User Management, a
user can be associated to a team via the user's detail view. For more information
on User Management, please refer to the User Management documentation. To
associate a team to a user via User Management, follow the following steps:

1. Navigate to Admin > User Management
2. From the Users list view, open the user record that you would like to edit
3. From the user's detail view, click on the "Access" tab 

4. Scroll past the role chart to the "My Teams" subpanel and click "Select" 

5. Use the popup search menu to search for and select the team(s) you would
like to add to this user where you can either click on the team's name or, if
selecting multiple teams, click their corresponding checkboxes and then
click "Select" 
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6. After selecting the team(s) the popup search box will close and the team(s)
will now be displayed in the My Teams subpanel for the user to complete
the relationship 

Viewing Teams
There are various options available for viewing team records in Sugar including via
the Teams list view, Teams detail view, Teams Last Viewed menu, from dashlets,
and from reports. 

Viewing Via List View

The Teams list view displays all team records meeting the current search criteria.
To access the list view, simply navigate to Admin > Team Management.
Alternately, if you are looking at a team's detail view, you can click the Teams
module tab to return to the list view. You can click the team's name to open the
record in detail view. For more information on viewing teams via list view, please
refer to the Teams List View section of this documentation. 

Viewing Via Detail View

The Teams detail view displays thorough team information showing the name and
description of the team, followed by a subpanel of the users associated to the team.
The detail view can be reached by clicking a team's link from anywhere in the
application including from the Teams list view. For more information on viewing
teams via detail view, please refer to the Teams Detail View section.

Viewing Via Recently Viewed

                           19 / 829



 

As you access different teams, Sugar will keep track of which teams you have
recently viewed. Click the three-dots menu in the Teams module tab to see a list of
the 3 records you most recently viewed in the module. Clicking the record's name
within the list will open it in detail view.

Viewing Via Dashlets

The Home page displays a collection of Sugar Dashlets which allow users to get a
quick view of various records, activities, reports, etc. You can view team
information in most module-specific dashlets. Clicking a team's name from any
dashlet will open the team in detail view. For more information on using dashlets,
please refer to the Dashlets section of the Home documentation.

Viewing Via Reports

Administrators have the option to build, run, and manage reports to gather key
data from records within Sugar. When building a report, there are options to either
run the report from the Teams module or add links to teams related to the records
that are being reported on. Once the report is run, you will be able to view the
team record's detail view by clicking the team's name in the report results. Please
note that you can only directly access team detail views with Rows and Columns
and Summation with Details-type reports as Summation and Matrix-type reports do
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not include hyperlinks in their display columns. For more information on using
reports, please refer to the Reports documentation.

Searching Teams

The Teams list view search function searches for the name of the team to help you
locate records easily and effectively. Once the search is performed, the relevant
results will be displayed in the Teams list view below.

The buttons in the search panel have the following functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.

To see all Team records, simply click "Clear" and then "Search" to perform a blank
search with no name filter.

Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all records that start
with the keyword entered in the search. If you would like to broaden the search,
you can use the wildcard at the beginning of your text as well (e.g.,
%Administrator). This will pull up any record that has the word "administrator" in
the name, regardless of how it starts or ends.
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For more information on using the various search methods as well as how
wildcards are used, please refer to the Search documentation.

Teams List View
The Teams list view displays all teams meeting the current search criteria, if any.
You can view the name and description of each team within the field columns.
Click on the name of the team to access the detail view for the team and review the
settings further. 

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to
the System documentation in the Administration guide.

Checkbox Selection

Teams can be deleted in a mass-delete fashion via the list view by selecting all of
the team records. To select individual team records on the Teams list view, mark
the checkbox on the left of each row. To select or deselect multiple teams on the
list view, use the options in the checkbox dropdown menu:

Select This Page: Selects all records shown on the current page of results
Select All: Selects all records in the current search results across all pages
of results
Deselect All: Deselects all records that are currently selected
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For more information on deleting teams, please refer to the Deleting Teams
section of this documentation.

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more teams at a time.
Mass Update Mass update one or more teams at a

time.
Export Export one or more teams to a CSV file.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header for either "Name" or "Description". The list
view may be sorted by only one column at a time.

Teams Detail View
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The Teams detail view displays thorough information about the team, as well as
the ability to perform most actions related to team management. The detail view
also includes a Users subpanel where users can be associated to the team and will
therefore take on the team's properties. 

Actions Menu

The Actions menu on the top left of each team's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration Guide.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit the name and description of this

team.
Copy Duplicate this team to create a new

team.
Delete Delete this team.

Users Subpanel

A user has to be associated to a team to be able to take on the team's membership
settings. Assigning a user is much like any other many-to-many relationship in
Sugar, where many users can be associated to one particular team, and one user
can also be assigned to multiple teams. From Team Management, a user can be
associated to a team via the Users subpanel at the bottom of the page. To associate
uses to a team, follow the following steps:

1. Navigate to the detail view of the team that you would like to edit.
2. At the bottom of the page, click "Select User" from the Users subpanel 
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3. Use the popup search menu to search for and select the user(s) you would
like to add to this team. You can either click on the user's name or, if
selecting multiple users, click their corresponding checkbox and then click
"Select" 

4. After selecting the user(s) the popup search box will close and the user(s)
will now be displayed in the Users subpanel for the team to complete the
relationship 

Next or Previous Record

On the upper right of the Teams detail view, there are two buttons that allow you
to page through each team in the Teams list view's current search results. Clicking
the Previous button displays the previous team of the current search results while
clicking the Next button displays the next team of the current search results. The
text in between shows which team result you are currently viewing within the total
number of current results.
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Editing Teams
Teams may be edited at any time to update or add information to the record or to
edit existing information. You can make changes to existing team records via the
Teams detail view and edit view, or from the Users module. Edit view is available
within the Teams module and includes the Name and Detail fields. 

Editing Via Detail View

You can edit teams via the detail view by clicking the Edit button on the upper left
of the page. Once the edit view layout is open, update either the Name or
Description fields, then click "Save" to preserve the changes made.

Editing Via List View

You can edit teams via the list view by clicking the Pencil icon to the left of each
team's name. After clicking the pencil, the window will move to the edit view.
Update the necessary fields, then click "Save" to preserve the changes. After
saving from the edit view, you will be returned to the detail view for the record
that you just updated. Because this method brings you to the edit view, the Name
and Description fields can be updated.
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Editing Via Users Module

The Users module allows you to see all of the teams associated with a specific user
in one place under the "Access" tab. The page will show the "My Teams" subpanel
with a list of all of the teams associated with the user. For more information about
viewing the teams from the Users module, please review the User Management
documentation.

On the "My Teams" subpanel, there is an option to edit the team. After clicking the
"Edit" button, the window will move to the edit view. Update the necessary fields,
then click "Save" to preserve the changes. After saving from the edit view, you will
be returned to the detail view for the record that you just updated. Because this
method brings you to the edit view, only the Name and Description fields can be
updated.

Deleting Teams

If a team record is invalid or is no longer being used in your organization's Sugar
instance, it may be deleted from either the Teams detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting team records will not delete any
related user records and will only remove the relationship.

The exception to this is found when trying to delete any private teams. Private
teams are only able to be deleted when the user that the team is for has been
deleted. To delete a private team, first delete the user via the user's detail view,
following the steps from User Management.

Deleting Via Detail View

Use the following steps to delete a team via the detail view:

1. Navigate to the team record's detail view.
2. Select "Delete" from the Actions menu. 
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3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Deleting Via List View

Use the following steps to delete one or more teams via the list view:

1. Navigate to the Teams list view by navigating to Admin > Team
Management.

2. Use the Search functionality to search to find the Team records you wish to
delete.

3. Select the desired team records individually or using the checkbox
dropdown's options.

4. Choose "Delete" from the Actions menu. 

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of team records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Removing Users From Teams

Users can be associated to multiple teams, and one team can also be associated to
many users. As changes occur within an organization, there may be times that
users need to be removed from specific teams. Breaking the relationship between

                           28 / 829



 

a team and a user can be done both from the Teams detail view and from the Users
detail view. Both modules include a subpanel to represent the relationship to the
other module.

To remove a user from a team, use the following steps:

1. Navigate to the team record's detail view
2. Click "unlink" to the right of the user's row 

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

To remove a team from a user, use the following steps:

1. Navigate to the user's detail view
2. From the user's detail view, click on the "Access" tab 

3. Scroll past the role chart to the "My Teams" subpanel and click "Remove"
on the row of the team you would like to remove 

4. A pop-up message will display asking for confirmation. Click "Ok" to
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proceed

Repairing Teams

Sugar's Repair menu includes two options for administrators to improve team
structures and functionality. These processes should not be needed often, and are
only used when the necessary changes are to be made. The repair options are as
follows:

Type Description
Upgrade Teams Checks to make sure that all users have

associated private teams.
Repair Teams A combination of four different repair

functions to rebuild team accesses.

 

Role Management

Overview

Roles in Sugar® determine which users can access modules as well as which
operations the users are allowed to perform within those modules. When
configuring role settings in Sugar, an administrator may choose to enforce
restrictions for entire modules or for selected fields on the records in a module, as
explained in the following sections. To fully leverage Sugar's security model, both
permission types can be used together for a given role and should be considered in
conjunction with the Team Management settings used by your organization.

Administrators have the ability to create different roles and assign regular users to
the roles. A user can be related to any number of roles, and when multiple roles or
role settings are applied, Sugar adheres to a most-restrictive policy to determine
the user's appropriate access levels. Administrators cannot be related to roles, as
their administrative rights supersede any restrictions imposed by Role
Management. For more information on System Administrator users, please review
the User Management documentation.

Roles control multiple layers of actions and access for users within Sugar:

Module-Level Permissions
Record-Level Permissions (i.e., Team-Based Permissions)
Field-Level Permissions
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Exceptions

The following modules respond uniquely to role settings in Sugar:

Forecasts Module: For the Forecasts module, roles will allow or deny
access at the module level with no further layers of access. Because the
Forecasts module uses data from the Opportunities, Products, Quotas,
Worksheet, and Time Period modules, the Forecasts module does not
respect the module- or field-level ACLs for those modules. For example, the
opportunity data that is shown in the Forecasts module worksheets will be
displayed and editable regardless of whether or not the user has access to
the Opportunities module or has field-level restrictions in that module.
Reports Module: If a user's role restricts their access to a field that is
used in a report, the user will not be allowed to see any information on the
report.

Roles Module Tab

Click the Roles module tab in the navigation bar, shown after selecting Role
Management in the Admin page, to access the Roles list view. You may also click
the three-dots menu in the Roles module tab to display the Actions and Recently
Viewed menus. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the list of roles you last viewed in
the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Role Opens the edit view to create a new

role.
List Roles Opens the list view layout to search and

display roles.
List Roles By User Opens a page for viewing each user's
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access according to their combined
roles.

Creating Roles

Sugar's roles specify which users can access modules, as well as which operations
the users are allowed to perform within those modules. When configuring role
settings in Sugar, an administrator may choose to enforce restrictions for entire
modules or for selected fields on the records in a module, as explained in the
following sections. To fully leverage Sugar's security model, both permission types
can be used together for a given role and should be considered in conjunction with
the team access settings used by your organization.

Creating Roles via Role Management

The most common way to create a role is via the Create Role option in the Role
Management module tab. This opens up the edit view layout which allows you to
enter in all the relevant information for the role.

Use the following steps to create a role via Role Management:

1. Navigate to Admin > Role Management.
Note: The Roles list view will open displaying all existing roles that
are currently available.

2. Click the three-dots menu in the Roles module tab and select "Create Role".

3. Enter the appropriate values for fields in the edit view layout. All required
fields will indicate "Required" in the field and must be completed prior to
saving.

4. On the Role Chart screen, configure the module and field permissions, and 
assign users to the role.

Creating Roles via Duplication

You can also create a new role by duplicating an existing role. The duplicate option
is useful if the role you are creating has similar information to an existing role.

Use the following steps to create a role by duplicating an existing record:

1. Navigate to a role record's detail view.
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2. Click the Actions menu and select "Duplicate".

3. The displayed edit view is pre-populated with the original role's values.
Update the necessary fields, then click "Save".

4. On the Role Chart screen, update the module and field permissions, and 
assign users to the role.

Setting Module-Level Permissions

Sugar's Role Chart contains ten columns and has a row for each module down the
left-hand side. The columns represent an access level or a type of operation within
Sugar, and the corresponding points between the columns and module rows define
the role's permission setting for the operation within the given module.

To configure or make changes to a role, follow the steps below:

1. On the Role Chart, find the intersection of the operation and the module
that you would like to adjust and click inside the corresponding table cell.

2. A dropdown list displays the options available for that configuration. Select
the appropriate security option based on the access and operation
definitions explained later on this page.

3. Repeat steps 1 and 2 for any other fields you would like to change in this
module for the current role.

4. When complete, click "Save" to secure the changes.
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Note: The most restrictive role setting always takes precedence when Sugar has to
choose between two or more settings.

The following table explains the Role Chart's components in detail. Please scroll 
beyond this table for descriptions of each configuration option.

Role Chart 
Column Header

Configuration
Options

Description Additional
Comments

Module
(blank header row)

N/A Identifies which
module the row's
settings will affect.

 

Access • Enabled
• Not Set
• Disabled

Controls access to
the entire module
for users in this
role.

When access to a
module is disabled,
the user is
prohibited from
viewing any
records in this
module. They
cannot see a tab for
the module in the
navigation bar, and
other module
records do not
reveal this
module's subpanel
to the user. For
more information,
please refer to the 
Module Access
definitions below
this table.

Access Type • Normal
• Not Set
• Admin
• Developer
• Admin &
Developer

For enabled
modules, Access
Type determines
how much control
users in this role
have over the
module.

Please refer to the 
Module Access
Type definitions
below this table.

Delete • All
• Owner
• Owner &
Selected Teams*
• Not Set
• None

Restricts users
from deleting or
merging records in
this module.

Restricting a user's
ability to delete
records also
restricts a user's
ability to merge
records in the
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module since
merging results in
deleting one or
more records.

Edit • All
• Owner
• Owner &
Selected Teams*
• Not Set
• None

Restricts users
from editing,
creating, or
merging records in
this module.

Although it is
labeled "Edit", this
role setting also
affects the Create
functionality
because the
process of creating
a record functions
the same way as
editing. It also
restricts the merge
functionality in
Sugar, which
modifies existing
records.

Export • All
• Owner
• Owner &
Selected Teams*
• Not Set
• None

Restricts users
from exporting data
from this module to
their local
computers.

This role setting
affects usage of the
Sugar API, which is
the framework
used for external
connections, such
as the Outlook Plug-
in. For more
information on
exporting, please
refer to the Export
documentation in
the Application
Guide.

Import • All
• Not Set
• None

Restricts users
from importing
data into this
module.

This role setting
affects usage of the
Sugar API, which is
the framework
used for external
connections, such
as the Outlook Plug-
in. For more
information on
importing, please
refer to the Import
documentation in
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the Application
Guide.

List • All
• Owner
• Owner &
Selected Teams*
• Not Set
• None

Restricts a user's
ability to see
records in a list
view or subpanel.

A module's list view
is not visible to
users where "List"
is set to "None".

Mass Update • All
• Not Set
• None

Restricts users
from using the
Mass Update
functionality in this
module's list view.

The Mass Update
option is not visible
on the list view's
Actions menu when
"Mass Update" is
set to "None". If
"List" is set to
"None", the Mass
Update
configuration is
inconsequential. To
entirely prohibit
users in a role from
updating many
records at once, set
"Import" to "None"
as well to prevent
mass updates via
import.

Record View • All
• Owner
• Owner &
Selected Teams*
• Not Set
• None

Restrict access to
the record view
which displays an
individual record's
details.

When "Record
View" is set to
"None", the
module's list view
displays record's
names, but the
names are not
hyperlinked to their
corresponding
record views like
they are for users
with the View
permission
enabled.

When a module's
Record View
setting is "None" or
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"Owner", the
access level for
"Edit" and "List"
must be set to the
same value to
ensure desired
functionality for
the SugarCRM
mobile app and
other API-based
applications.

*The Owner & Selected Teams option only appears for modules using team-based
permissions. For more information, please refer to the Enabling Team-Based
Permissions section of this page.

The following sections explain the various configuration options available in the
Role Chart. 

Module Access Definitions

The Access column provides the following options:

Enabled: The user can access this module in Sugar.
Not Set: The user is neither restricted nor granted access to this module.
When permission is "Not Set", the users within this role default to
"Enabled" access.
Disabled: The user cannot access this module, view any of its records, or
see any trace of its existence in Sugar.

Module Access Type Definitions

The Access Type column provides the following options:

Normal: The user can perform standard functions in this module barring
restrictions from other roles or team settings. The user cannot access the
Administration functions for this module.
Not Set: The user is neither restricted nor granted access to this module.
When permission is "Not Set", users within this role default to "Normal"
access.
Admin: The user is not subject to any Teams restrictions for this module
and can view all records, barring other role restrictions. Admin access also
forces "All" access for that module's action-related columns (e.g., Edit,
Delete, etc.) if the row's operation-related columns remain "Not Set".
However, any more restrictive options you may choose will supersede the
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Admin access. Please note that the module-level Admin access type does
not grant access to the Administration functions for this module.
Developer: The user has access to the module-specific sections of Studio,
Workflow Management, Dropdown Editor, and any other Administration
functions that are specific to the module. The user's access to Sugar
records is not affected; access remains subject to Teams restrictions and
action-related role restrictions for this module. For more information on
developer tools, please refer to the Developer Tools documentation.
Admin & Developer: The user is not subject to any Teams restrictions for
this module and can access Administration functions for this module. For
more information, please refer to the descriptions for the "Admin" and the
"Developer" access types above.

For more information on Admin, Developer, and Admin & Developer roles, please
refer to the article Understanding Admin and Developer Access in Roles.

Record Operation Definitions

The operation columns (e.g., Edit, Delete, etc.) provide the following configuration
options:

All: The user can perform this action on any and all records that they can
access in Sugar per their team memberships.
Owner: The user can perform this action only if they are the "Assigned To"
user on the record.
Owner & Selected Teams: The user can perform this action if they are
the "Assigned To" user on the record or if they belong to a team that is
designated as having extra access on the record. This option is only visible
if an administrator has enabled team-based permissions for the module.
Not Set: The user is neither restricted nor granted access to this function.
When permission is "Not Set", users within this role default to "All" access.
None: The user cannot perform this action on any records within this
Sugar module.

Note: When using the Owner & Selected Teams setting, any user with permission
to edit the Teams field can extend role permissions to other users. To maintain a
tighter security model, we recommend using this setting in conjunction with field-
level access control on the Teams field to regulate who can edit the teams on a
record.

Setting Record-Level Permissions

In Sugar, teams are typically used to control which groups of users can access a
record. Using the record-level, team-based permissions, however, an administrator
may choose to extend the purpose of teams to control who can perform certain
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operations on the record (e.g., edit, delete, etc.). When enabled, regular users can
use a record's Teams field to grant access such as viewing, editing, exporting,
importing, and deleting permission to specific users or user groups.

For more information on teams, please refer to the Team Management
documentation.

Enabling Team-Based Permissions

An administrator may decide to enable record-level, team-based permissions for
none, some, or all of the modules in a Sugar instance. Once enabled, the
administrator can build roles that utilize the new access option (Owner & Selected
Teams).

Follow these steps to enable the team-based permission capability:

1. Navigate to Admin > Team-based Permissions.

2. If an administrator has never enabled team-based permissions for this
instance, the configuration page will open and display a warning message
above a disabled checkbox. Click on the checkbox labeled "Enable team-
based permissions" to select the modules you want to enable. If the
checkbox is already selected, you will see the modules listed prominently
on the configuration page.

3. Place a checkmark in the boxes next to modules that should support team-
based permissions. The square behind the module name changes from gray
(disabled) to blue (enabled) upon selecting the checkbox. Once you are
satisfied with your selections, click "Save" to preserve the changes.
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After saving, you can confirm that a module has been enabled for team-based
permissions by clicking "Edit" on any record within the module and viewing the
Teams field. Each team's name in the widget should include a Lock button,
defaulted to a disabled (white) state.

If the Teams widget does not show the Lock buttons, confirm that you properly
saved the admin settings in step 3, perform a Quick Repair and Rebuild, and try
refreshing your browser's cache.

You may now create roles that utilize the "Owner & Selected Teams" access type
for actions in the enabled modules. Please note that team-based permissions have
no effect on Sugar until users have been assigned to roles that are configured with
"Owner & Selected Teams" access. For more information, please refer to the
Record Operation Definitions section of this page. For information on using team-
based permissions on a record, please refer to the User Interface documentation.

Disabling Team-Based Permissions

Disabling team-based permissions for a module permanently removes any data
associated with team-based permissions for that module. Any role definitions using
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the "Owner & Selected Team" option for field-access settings or operations in that
module revert to the more restrictive setting, "Owner". All record-level, team-
based permissions data for that module are also permanently deleted. Sugar will
not remember a record's role-related team settings if you ever wish to re-enable
the module for team-based permissions.

To disable team-based permissions for a module, navigate to Admin > Team-based
Permissions, uncheck the box next to the appropriate module's name, and click
"Save". To disable the functionality for the entire instance, simply uncheck the box
labeled "Enable team-based permissions" and click "Save". After disabling team-
based permissions for any module, please use the Quick Repair and Rebuild tool to
clear your system's cache.

Setting Field-Level Permissions

Role Management also provides the option to set permissions and restrictions on
specific fields within modules. To change the field-level permissions for a role,
follow these steps:

1. Navigate to Admin > Role Management.
2. Create and save a new role or select an existing role to edit.
3. On the left side of the screen, click on the name of the module that contains

the field(s) you would like to restrict.

4. On the next screen, find the field that you would like to restrict and then
click inside the table cell to the right of that field name. In this example,
click on the words "Not Set" next to the word "Type" to edit access to the
Type field.

Note: Some fields may be part of a group and the access setting will affect
all of the fields in the group. To see which fields, if any, are in a group with
the field you are editing, click the Plus (+) sign next to the field's name.
Any fields listed as part of a group will also be restricted at the level you
choose. Grouped fields cannot be controlled independently. If you cannot
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find the field that you would like to restrict in the fields table, it may be
grouped within another field. Try expanding fields that are likely to be
grouped with the field you are looking for (e.g., the Billing City field for
Accounts is grouped under the Billing Street field as part of the billing
address group).

5. From the dropdown list, select a level of field access for this role's
members based on the field-access definitions explained below.

6. Repeat steps 4 and 5 for any other fields you would like to change in this
module for the current role.

7. When complete, click "Save" to secure the changes.

Field Access Definitions

Not Set: The user is neither restricted nor granted access to this field.
When permission is "Not Set", users within this role default to "Read/Write"
access.
Read/Write: The user can see the value of this field and can edit it.
Read/Owner Write: The user can see the value of this field but can only
edit the field's value if they are the "Assigned To" user on the record.
Read/(Owner & Selected Teams) Write: The user can see the value of
this field but can only edit the field's value if they are the "Assigned To"
user on the record or if they belong to a team that is designated as having
extra access on the record. This option is only visible if an administrator
has enabled team-based permissions for the module.
Read Only: The user can see the value of this field but cannot change its
value.
Owner Read/Owner Write: The user can only see and edit this field if they
are the "Assigned To" user on the record.
(Owner & Selected Teams) Read/Owner Write: The user can only see
the value of this field if they are the "Assigned To" user on the record or if
they belong to a team that is designated as having extra access on the
record, but they can edit the field only if they are the "Assigned To" user on
the record. This option is only visible if an administrator has enabled team-
based permissions for the module.
(Owner & Selected Teams) Read/(Owner & Selected Teams) Write:
The user can only see the field and edit the field's value if they are the
"Assigned To" user on the record or if they belong to a team that is
designated as having extra access on the record. This option is only visible
if an administrator has enabled team-based permissions for the module.
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None: For Sidecar modules, the user can see this field on layouts (e.g.,
Record View) but cannot see its value. Instead, Sugar displays "No Access"
as the field's value. For Legacy modules (e.g., Documents), the user cannot
see the field on any layout. Instead, Sugar displays a blank space on the
edit and detail views.

Assigning Users to Roles

A user must be associated with a role to take on the role's permission settings.
Assigning a role is much like any other many-to-many relationship in Sugar, where
many users can be associated with any particular role, and one user can also be
assigned to multiple roles.

If a user is assigned to multiple roles, the most restrictive option for each setting is
respected. For example, if a user is assigned to two roles, one which restricts Edit
access for the Accounts module to "Owner" and the second which restricts it to
"Owner & Selected Teams", the "Owner" setting will be respected. View the Access
tab on each user's profile to see the cumulative effect of all of their assigned roles.

Note: For instances that use SugarIdentity, administrators have the ability to log
in as other users in their organization using the "Impersonate (Log in as)" option in
SugarIdentity. So, once you assign users to roles, you can preview the user's
account via impersonation to ensure that the proper permissions and restrictions
are in place. For more information on impersonating a user, refer to
the SugarIdentity Guide. 

Assigning Roles via Role Management

From Role Management, a user can be related to a role via the Users subpanel at
the bottom of the detail view. To relate users to a role, use the following steps:

1. Navigate to Admin > Role Management.
2. From the Roles list view, select the desired role.
3. At the bottom of the page, click "Select User" from the Users subpanel.

4. Use the pop-up search menu to search for and select the user(s) you would
like to add to this role where you can either click on the user's name or, if
selecting multiple users, click their corresponding checkbox and then click
"Select".
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After selecting the user(s), the pop-up search box will close and the user(s) will
now be displayed in the Users subpanel for the role to complete the relationship.

Assigning Roles via User Management

From User Management, a user can be related to a role via the user's detail view.
For more information on User Management, please refer to the User Management
documentation. To relate a role to a user via User Management, follow the
following steps:

1. Navigate to Admin > User Management.
2. From the Users list view, open the user record that you would like to edit
3. From the user's detail view, click on the "Access" tab

4. Scroll past the Role Chart to the subpanel for "Roles" and click "Select"

5. Use the pop-up search menu to search for and select the role(s) you would
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like to add to this user where you can either click on the role's name or, if
selecting multiple roles, click the corresponding checkboxes and then click
"Select"

After selecting the role(s), the pop-up search box will close and the role(s) will now
be displayed in the Roles subpanel for the user to complete the relationship.

Viewing Roles

There are various options available for viewing role records in Sugar including via
the Roles list view, Roles detail view, Roles Recently Viewed menu, the List Roles
by User function, and from the Users module.

Viewing via List View

The Roles list view displays all role records meeting the current search criteria. To
access the list view, simply navigate Admin > Role Management. Alternately, if you
are looking at a role's detail view, you can click the Roles module tab to return to
the list view. You can click the role's name to open the record in detail view. For
more information on viewing roles via list view, please refer to the Roles List View
section of this documentation.

Viewing via Detail View

The Roles detail view is where all of the modifications to the role settings can be
made. This page includes the name and description of the role, the chart where
module settings can be manipulated, links to the field-level action settings, and the
Users subpanel where users can be added to the role. For more information on
viewing roles via detail view, please refer to the Roles Detail View section of this
documentation.

Viewing via Recently Viewed

As you access different roles, Sugar will keep track of which roles you have
recently viewed. Click the three-dots menu in the Roles module tab to see a list of
the 3 roles you most recently viewed in the module. Clicking the role's name within
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the list will open it in detail view.

Viewing Roles by User

Role Management offers the option to view all roles assigned to specific users.
Click the three-dots menu in the Roles module tab and select "List Roles By User"
to view these roles.

You will be redirected to the Users module and a screen will appear with a
dropdown list with all users' names included. Select the user you would like to
view and a chart will show which is a compilation of all of the roles listed for the
user in the Roles subpanel, at the bottom of the page.
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Viewing via Users Module

User profiles show which roles the user is related to and how the user's roles
work together. When viewing a user profile, all role information can be found by
navigating to the "Access" tab. For information about accessing the Users module,
please refer to the Users documentation.

The access tab contains a chart showing all of the modules and actions available in
Role Management. This chart is a compilation of all of the roles listed for the user
in the Roles subpanel at the bottom of the page.

When viewing the chart, the most restrictive setting for the specific intersection
will take precedence, and will represent the option for the user. Therefore, if the
user has two roles assigned, one of which allows him or her to delete a record and
another which does not, Sugar will enforce the option where the user cannot
delete the record. The table shown in User Management cannot be edited. Instead,
the role itself must be edited which will change the setting for any other users
related to the role.

To view the role settings from User Management and make any necessary
changes, simply click the role's name from the Roles subpanel, which will take you
to the role's detail view.

                           47 / 829



 

Searching Roles

The Roles list view search function allows you to search for the name of the role to
help you locate records easily and effectively. Once the search is performed, the
relevant results will be displayed in the Roles list view below.

The buttons in the search panel have the following functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.

To see all Role records, simply click "Clear" and then "Search" to perform a blank
search with no name filter.

Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all records that start
with the keyword entered in the search. If you would like to broaden the search,
you can use the wildcard at the beginning of your text as well (e.g.,
%Administrator). This will pull up any record that has the word "administrator" in
the name, regardless of how it starts or ends.

For more information on using the various search methods as well as how
wildcards are used, please refer to the Search documentation.

Roles List View

The Roles list view displays all roles that meet the current search criteria (if any).
You can view the name and description of each role within the field columns. Click
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on the name of the role to access the detail view for the role and review the
settings further.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via the System menu in Admin. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration Guide.

Checkbox Selection

Roles can be deleted in a mass-delete fashion via the list view by selecting all of
the role records. To select individual role records on the Roles list view, mark the
checkbox on the left of each row. To select or deselect multiple roles on the list
view, use the options in the checkbox dropdown menu:

Select This Page: Selects all records shown on the current page of
results.
Select All: Selects all records in the current search results across all pages
of results.
Deselect All: Deselects all records that are currently selected.
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For more information on deleting roles, please refer to the Mass Deleting via List
View section of this documentation.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header for either "Name" or "Description". The list
view may be sorted by only one column at a time.

Roles Detail View

The Roles detail view displays thorough information about the role, as well as the
ability to perform most actions related to role management. It comprises of a chart
showing all modules in Sugar and actions that the user can have access to or be
restricted from. The detail view also provides links that, when clicked, drill down
into each module to make field-level permission changes. Finally, the detail view
includes a Users subpanel where users can be related to the role and will,
therefore, take on the role's properties.

Actions Menu

The Actions menu on the top left of each role's detail view allows you to perform
various actions on the current record. Administrator users can change the action
items to be displayed as separate buttons instead of a dropdown menu via Admin >
System Settings. For more information on configuring the actions menu, please
refer to the System documentation in the Administration Guide.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit the name and description of this

role.
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Duplicate Duplicate this role to create a new role.
Delete Delete this role.

Role Chart

The Role Chart comprises of ten columns and a row for each module down the left-
hand side. The columns each represent a type of action within Sugar, and the
corresponding point between the columns and module roles defines the role's
permissions. The role permissions can be updated from the detail view of each
role. For an explanation of each action and how to update roles, please review the 
Setting Module-Level Permissions section of this documentation.

Field Permissions

To the left of the Role Chart is a list of hyperlinked Sugar module names:

Click on a module name to access the Field Permissions view for the module. For
an explanation of each action and how to update field-level permissions, please
review the Setting Field-Level Permissions section of this page.

Users Subpanel
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Beneath the Role Chart, the Users subpanel is available for the Administrator to
relate one or more users to the current role. A user must be related to a role to
take on the role's permission settings. One user can be related to multiple roles. If
a user is related to multiple roles, the most restrictive option for each setting is
respected. 

To relate users to a role, use the following steps:

1. Navigate to the detail view of the role that you would like to edit.
2. At the bottom of the page, click "Select User" from the Users subpanel.

3. Use the pop-up search menu to search for and select the user(s) you would
like to add to this role. You can either click on the user's name or, if
selecting multiple users, click their corresponding checkbox and then click
"Select".

After selecting the user(s), the pop-up search box will close and the user(s) will
now be displayed in the Users subpanel for the role to complete the relationship.

Editing Roles

Roles may be edited at any time to update or add information to the record or to
edit the role restrictions. You can make changes to existing role records via the
Roles detail view and edit view, depending on the change being made. Changes via
the detail view are made directly on the role permission chart. Edit view is
available within the Roles module and includes the Name and Detail fields.

Editing via Detail View

You can edit roles via the detail view by clicking the Edit button on the upper left
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of the page. Once the edit view layout is open, update either the Name or
Description fields, then click "Save" to preserve the changes made.

Edits to the settings on the role are also performed via the detail view. Below the
Name and Description fields, is where you will find the role permission chart. This
chart is made up of rows representing the different modules in Sugar, and columns
representing each of the action types Sugar users can perform. Edits to this table
are made by clicking the box at the intersection of a row and column, which
produces a dropdown list of available options. For more information on module
permission changes, please review the information in the Setting Module-Level
Permissions section of this documentation.

Editing via List View

You can edit roles via the list view by clicking the Pencil icon to the left of each
role's name. After clicking the pencil, the window will move to the edit view.
Update the necessary fields, then click "Save" to preserve the changes. After
saving from the edit view, you will be returned to the detail view for the record
that you just updated. Because this method brings you to the edit view, only the
Name and Description fields can be updated.

Editing via Users Module

The Users module allows you to see all of the roles related to a specific user in one
place under the "Access" tab. The page will show a subpanel with a list of all of the
roles related to the user. For more information about viewing the roles from the
Users module, please review Viewing via Users Module.

On the "Roles" subpanel, there is an option to edit the role. After clicking the
"Edit" button, the window will move to the edit view. Update the necessary fields,
then click "Save" to preserve the changes. After saving from the edit view, you will
be returned to the detail view for the record that you just updated. Because this
method brings you to the edit view, only the Name and Description fields can be
updated.
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Deleting Roles

If a role record is invalid or is no longer being used in your organization's Sugar
instance, it may be deleted from either the Roles detail view or list view. Deleting
via the detail view allows you to delete a single record while the list view allows for
mass deleting multiple records at once. Deleting role records will not delete the
related user records and will only remove the relationship.

Deleting via Detail View

Use the following steps to delete a role via the detail view:

1. Navigate to the role record's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Mass Deleting via List View

Use the following steps to delete one or more roles via the list view:

1. Navigate to Admin > Role Management.
2. Use the search functionality to find the Role records you wish to delete.
3. Select the desired role records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.
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5. A pop-up message will ask for confirmation. Click "Ok" to proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of role records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Password Management

Overview

Password Management is used to administer requirements and other policies
about user passwords in Sugar. Sugar allows administrators to set up the
password requirements, manage the forgot password feature, configure the email
template for resetting passwords, etc. Password management is not used to
change users' passwords, which can be done via their User Profile.

Note: For instances that use SugarIdentity, an administrator will need to
access SugarIdentity to configure password requirements as well as set up LDAP
or SAML authentication. 

Password Requirements

The Password Requirements panel lets you configure minimum and maximum
lengths of passwords, as well as what characters are required in passwords. Filling
in either of the first two fields, Minimum Length and Maximum Length, will force a
requirement for your users to have passwords be more than or less than a given
amount of characters. Additionally, use any of the four checkboxes to force
character requirements on users' passwords. This can force users to include upper
case letters, lower case letters, numbers, or special characters in their passwords.
Please note that the configured password requirements also apply to the Sugar
Portal and must be respected when the portal user's password is created or
changed.

Note: For instances that use SugarIdentity, password requirements are configured
in SugarIdentity.

                           55 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/getting_started/#Password_Tab
https://support.sugarcrm.com/documentation/sugarcloud_services/sugaridentity/sugaridentity_guide/
https://support.sugarcrm.com/documentation/sugaridentity/sugaridentity_guide/#Configuring_Local_Passwords


 

 

Advanced Options

You can also specify words or other strings that are not allowed in a password,
called Regex Requirements. The configurations for Regex Requirements are found
in the Advanced Options section of the Password Requirements panel.

Note: For instances that use SugarIdentity, regex password controls are not
available.

To set a Regex Requirement, type in code of characters that are not allowed. In the
Regex Description field, write a message to users that will show when they try to
edit their passwords, explaining what strings are not allowed. For more
information on Regex usage, please review the Regular Expressions website at 
http://www.regular-expressions.info/.

Some examples of regular expressions in password rules are listed below:

Sample Expression Password Rule
Sugar Password cannot contain the word

Sugar.
([A-Za-z0-9])\1 Password cannot repeat a letter or

number consecutively; for example, AA
or 88.

([a-zA-Z]){4,} Password cannot repeat any two
consecutive letters; repeat characters or
letters must be separated by a special
character such as %.
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[ \t] Password cannot contain spaces and
tabs.

[@#$] Password cannot contain @, #, or $.

User Reset Password

The forgot password feature allows administrators to enable the Forgot Password
link to display in the Sugar login window. If a user does not remember their
password, they can click this option, enter their user name and their primary email
address in Sugar, and a Reset Password link will be emailed, guiding them through
the process to reset their forgotten password. For more information on how a user
resets his or her password, please view the Getting Started documentation.

Note: For instances that use SugarIdentity, the "Forgot Password?" link is
available on the Sugar login screen, but the feature cannot be configured.

The two requirements to utilize Forgot Password feature are:

A user has a valid primary email address configured in their User Profile.
A system outbound email server (SMTP) is configured in Email Settings.

Honeypot Validations

Honeypots are a non-intrusive method of human form submission confirmation that
is more effective than traditional CAPTCHA. Enabling the honeypot validation
option will add an invisible input field to the Forgot Password form which only bots
reading the HTML will be able to see. When the bots fill in the honeypot field,
Sugar knows to disregard the submission since it was not created by a human,
thus preventing unauthorized access to your Sugar instance.

Note: For Sugar instances that use SugarIdentity, Honeypot validation is not
available.

Email Templates

The reset password email template is available under the Email Templates section,
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and you can click the Edit button to modify the template. Click the Create button
instead if you wish to create a new version of the template.

Note: For instances that use SugarIdentity, the option to create/edit email
templates is not available.

The reset password email template is also available to access in the Email
Templates list view by navigating to the Emails module. For more information on
Email Templates, refer to the Emails documentation of the Application Guide.

Note: When creating a new version of the reset password email template, be sure
to copy the variable "$contact_user_link_guid" from the default Forgot Password
Email template as it is not available to select from the variable dropdowns.

User-Generated Password Expiration

Sugar can force users to create new passwords after a given period. Admins can
configure this for either specific amounts of time in days, weeks, or months, or
after a specific amount of logins. To configure a password expiration, select the
radio button next to the expiration period you would like to use and enter the
timeframe or amount of logins that the user will be allotted. Once the password
expiration is reached, users will see a message upon login, informing them that
their password has expired and to create a new password. The user will need to
enter their current password along with their new password and confirm the
password as well.
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Note: For instances that use SugarIdentity, password expiration rules are
configured in SugarIdentity. 

Login Lockout

To prevent unauthorized logins, Sugar includes a configurable lockout function.
This means that you will define a specific amount of unsuccessful attempts that a
user name can be used to log in before the user name will not be able to log in. You
also configure a given amount of time before the restriction is listed in either
minutes, hours, or days. To configure Login Lockout, click the radio button next to
"Lockout users after {blank} unsuccessful login attempts", fill in the maximum
number of attempts allowed and define the timeframe.

Note: For instances that use SugarIdentity, login lockout rules are configured
in SugarIdentity. 

Note: When a user has been locked out, the user must wait until the given
timeframe has passed. The only way to manually allow a user to log back in is by
clicking the Reset User Preferences button in the user's profile.

External Authentication

Sugar can respect external authentication protocols (i.e., LDAP and SAML) to give
users a seamless login process via single sign-on (SSO) services. LDAP and
SAML configuration options are located in the last two panels of the Password
Management page. Click the checkbox next to the external authentication type
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that you would like to enable. Upon selection, the page's contents will refresh and
the chosen protocol will supersede any other Password Management settings.

Note: For instances that use SugarIdentity, LDAP and SAML authentication are
configured in SugarIdentity.

Note: If a user logs out of their single sign-on account from outside of Sugar, they
will continue to be logged into Sugar.

The following sections explain LDAP and SAML options in more detail.

Note: Team Management and Role Management are still taken into account when
External Authentication is active.

LDAP

Sugar can be configured to accept Lightweight Directory Access Protocol (LDAP)
authentication if your organization has implemented LDAP or Active Directory
authentication. When users in your system attempt to log into Sugar, the
application will authenticate their credentials against your LDAP directory or
Active Directory. If authentication is successful, the user is granted access to
Sugar. If the authentication is unsuccessful, Sugar will then attempt to verify the
provided credentials against its own database of valid user names and passwords.
Please note that for instances that use SugarIdentity, LDAP is configured in
SugarIdentity.

To configure LDAP, navigate to Admin > Password Management, and enable the
"Enable LDAP Authentication" checkbox in the LDAP Support panel. Sugar will
then display some additional fields where you can enter information specific to
your LDAP or Active Directory account. 
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Once you have completed the form, you will then need to enable LDAP for users by
navigating to Admin > User Management, selecting the desired user, then clicking
the Advanced tab in their user profile. Enable the "LDAP Authentication Only"
checkbox then click "Save". Sugar will then synchronize the user's Active Directory
user name and present the password on the LDAP port. When the user next logs
into Sugar, they will enter their Active Directory username and password. 

LDAP Fields

Fill in the appropriate options in the following fields, and then click "Save" to
commit the changes. The following are suggested values for each field, but these
may vary depending on your LDAP configuration.

Field Suggested Values Description
Authentication Enter

"
username@MYSERVER.M
YDOMAIN.com" or "domai
n\\userfirstname.userlastn
ame" for the User Name,
and the corresponding
Password.

Note: The latter username
format requires double
backslashes after the
domain. Sugar will
automatically remove one
backslash upon Save.

Check this box to enable
the User Name and
Password fields.

Note: You must add
a service account user
(read-only access) to your
Active Directory to
authenticate via Sugar.
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Auto Create Users Typically, this box remains
disabled. 

Select this checkbox to
create the username in
the Sugar database if it
does not already exist. 

Note: When enabled, a
Sugar user is created for
every LDAP user logging
into the application. This
will occupy an active
Sugar license for each
created user.

Bind Attribute For Active Directory,
enter userPrincipalName. 

A case-sensitive value.

Enable LDAP
Authentication

 Uncheck this box if you
would like to disable LDAP
in your instance.

Encryption Select "StartTLS"
or "LDAPS" if the
LDAP server
supports it.
Select "none" for
no encryption.

Select the appropriate
option from the dropdown
to use StartTLS, LDAPS,
or no encryption when
connecting to the LDAP
server.

Encryption Key  If you are using LDAP with
SOAP, enter the
encryption key to encrypt
user passwords in the 
Sugar Plug-in for
Microsoft Outlook.

Note: The "php_mcrypt"
extension must be enabled
in the php.ini file.

Group Membership Group DN: Enter the
group DN name.

ou=groups
dc=example
dc=com

Group Name: Enter the
group name.

cn=sugarcrm

Select this checkbox if you
wish to specify that the
user is a member of a
specific group. 
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User Attribute: A unique
identifier used to check if
the user is a member of
the group.

uid

Group Attribute: The
attribute of the group that
will be used to filter
against the User Attribute.

MemberUid
Login Attribute For Active

Directory, enter
sAMAccountName.

A case-sensitive value.

Port Number Enter "636" if
using LDAPS
encryption.

Enter "389" if
using "StartTLS"
or no encryption.

Enter the default port
number.  

Server Enter MYSERVER.MYDO
MAIN.com.

Enter the FQDN of your
Active Directory Server
which should be your
Domain Controller.

 
User DN Enter ou=people,

dc=example, dc=com.
Enter the user DN name.

User Filter Enter is_user_id=1. Enter any additional
parameters to apply when
authenticating users.

SAML

Sugar can be configured to accept Security Assertion Markup Language (SAML)
for single sign-on if it is implemented at your organization. When users in your
system attempt to log into Sugar, the application will authenticate them against
SAML. If authentication is successful, the user is granted access to Sugar. If the
authentication is unsuccessful, Sugar will then attempt to verify the provided
credentials against its own database of valid user names and passwords. Sugar
supports the use of SAML version 2.0.
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Note: For instances that use SugarIdentity, SAML is configured in SugarIdentity.

Use the following steps to configure SAML authentication in Sugar:

1. Navigate to Admin > Password Management and place a check in the
"Enable SAML Authentication" box in the SAML Authentication panel.

2. Enter appropriate values in the fields on the SAML Authentication page. If
you have downloaded a metadata file from the identity provider (e.g., Okta,
Google, ADFS), then skip to step 3.

3. If you have obtained a metadata file from the identity provider (e.g., Okta,
Google, ADFS), then you can import the file by clicking the "Import IdP
Metadata File" button. Locate the metadata file you saved then click
"Open". Certain fields (e.g., Login URL, SLO URL, Entity ID, X509
Certificate) on the page will be auto-populated with data from the
file. Optionally, complete any other desired fields on the configuration page
based on your needs.
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Note: If you are using Okta with single logout enabled, then you will need
to complete the "Sign Logout Request", Request Signing Private Key", and
"Request Signing Certificate" fields in order to digitally sign the logout
request. 

4. Once the necessary fields have been completed, click "Save" to preserve
the settings. 

When using ADFS, you will need to export an XML metadata file containing the
SAML settings which you will need in order to configure a new trust relationship
between Sugar and ADFS to allow communication between the two services.
Simply click the "Export Metadata File" button to download the necessary file.
Please note that you will only be able to export a file if the required fields have
been completed and saved. Once you have the metadata file, follow the steps in
the Configuring SSO With Active Directory's ADFS article to configure a new ADFS
trust relationship. 

Please refer to the SAML-Toolkits example for more information on how to
configure advanced SAML connections.

SAML Fields

The available fields to configure on the SAML Authentication page are as follows:

Field Description
Enable SAML Authentication Uncheck this box if you would like to

disable SAML Authentication in your
instance. 

Login URL Enter the SAML URL for authentication.
Note: This is the path to the SAML
server to which you are authenticating. 

SLO URL Enter the single logout endpoint to
which Sugar will send logout requests.
When Sugar sends a logout request to
the identity provider (e.g., Okta), it will
extend that request and terminate
active sessions for all other service
providers that are sharing the session
established via SAML.
Note: Single logout requests can be
initiated from either the identity
provider or Sugar. 

Entity ID Enter a valid URI for the IdP (identity
provider) entity.
Note: Sugar will only accept SAML
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assertions from this ID. 
SugarCRM Entity ID Enter a valid URI for the service

provider entity. 
X509 Certificate Enter the SAML X509 certificate public

key. 
Auto-create user Check this box to automatically create a

new username in the Sugar database if
it does not already exist. When enabled,
a new Sugar user is created for every
SAML user logging into the application. 
Note: This will occupy an active Sugar
license for each created user.

Load login screen in same window to
avoid pop-up blocking

Enable this option to load the SAML
login screen in the current window to
prevent pop-up blockers from
preventing single sign-on. 

Request Signing Private Key Upload the PEM file containing the
private key to be used to sign the AuthN
and Logout requests.
Note: The private key must be uploaded
in order to sign the logout
request, logout response, and/or AuthN
request.

Request Signing Certificate Upload the CRT file containing the
X.509 certificate to be used to sign
the AuthN and Logout requests.
Note: The certificate should match the
uploaded private key. 

Request Signing method Select the digital signing method for the
logout request, logout response, and/or
AuthN request. The recommended
options are either "RSA-SHA256" or
"RSA-SHA512". 

Sign AuthN Request Check the box to sign the AuthN request
using the private key and certificate.  
Note: The "Request Signing Private
Key", "Request Signing Certificate", and
"Request Signing method" fields must
be completed in order to sign the AuthN
request.

Sign Logout Request Check this box to sign the logout
request using the private key and
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certificate.
Note: The "Request Signing Private
Key", "Request Signing Certificate", and
"Request Signing method" fields must
be completed in order to sign the logout
request.

Sign Logout Response Check this box to sign the
logout response using the private key
and certificate. 
Note: The "Request Signing Private
Key", "Request Signing Certificate", and
"Request Signing method" fields must
be completed in order to sign the logout
response.

If you are using OneLogin, please ensure that only the email address user field is
mapped to Sugar's email address field in OneLogin's parameters configuration.
Mapping to other fields such as user name is not supported and may prevent
authentication.

Note: You must disable the Forgot Password option if you are using SAML
authentication. 

Setting User Passwords

Administrators have the option to manually set or reset user's passwords as need
be. Setting a regular user's password is done simply through the Users module via
Admin > User Management. For more information on changing a user's password
from the Users module, please review the Resetting User Passwords section of the
Users documentation.

Note: For instances that use SugarIdentity, administrators will not be able to
manually change a user's password via the user's profile. But administrators can
send password reset emails to users via SugarIdentity. 

User Management

Overview

The User Management module provides administrators access to create, edit,
activate, and deactivate the profiles of all the users in their Sugar instance. This
module and underlying settings control each individual's login credentials as well
as some personalized settings. During the installation process, Sugar creates one

                           67 / 829

https://support.sugarcrm.com/documentation/sugarcloud_services/sugaridentity/sugaridentity_guide/user_management/#Resetting_User_Passwords


 

system administrator by default. The system administrator can log in and create
additional users, in a variety of capacities, to be able to access Sugar and utilize all
of the other CRM functionality. In combination with the role and team security,
administrators can fully establish a profile for each user in Sugar.

Notice: For instances that use SugarIdentity, the administrator will need to access
SugarIdentity to create and manage user records. 

User Types

There are four types of users in Sugar: Regular User, System Administrator, Group
User, and Portal API User. Each user type has different functions in Sugar which
will vary for each instance. Depending on an organization's use of Sugar, not all of
these user types will be necessary. Only regular users and system administrators
in an Active status count towards licensed user limits. The purpose of each user
type is explained in the following sections.

Regular User

A regular user is the most common of the user types. A majority of employees of an
organization will be regular users. This user can access most Sugar modules and
perform most standard functions by default. Regular users are subject to be
restricted in their abilities and what records they can access by an administrator
using the Teams and Roles functionalities in Sugar.

Regular Users will appear in the Employees module. To create a Regular User,
please review the Regular and Admin Users section of this page.

System Administrator

System Administrator users, or "admins," have all of the abilities and functionality
of a regular user, but also have administrative privileges as well. Admins can
perform functions such as creating and editing users, editing system-wide settings,
and have access to diagnostic and troubleshooting tools. In addition, admins can
access all modules and records and are not subject to team or role restrictions. All
instances of Sugar require at least one administrator, but it is also recommended
to have more than one in case the original admin is unavailable or is no longer with
the company.

System Administrators will appear in the Employees module. To create a System
Administrator, please review the Regular and Admin Users section of this page.

Note: All administrators where the user status is active count as a licensed user.
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Group User

A Group User is a bucket that is used for assigning records to a non-specific user
(e.g., Sales, Support) in the organization. Unlike a Regular or System
Administrator user, a Group user does not have access to log in to Sugar. Due to
this, they do not have the same profile settings available, including the option to
set a password. Since Group users cannot log in to Sugar, they do not count
against an organization's license count.

Examples of uses for a Group user would be to assign all new leads to a group user
named "Sales" or assign all newly-created support cases to "Support" before they
are delegated to specific users (e.g., John Smith) in the organization.

Please note that Group users will not appear in the Employees module. For more
information on how to create a Group user, please review the Group Users section
of this page.

Portal API User

A Portal API User is similar to a Group User except that it is created specifically to
communicate with the Sugar server using the Sugar Portal API functionality. It is
intended only for use with Sugar Portal; the user with user name
"SugarCustomerSupportPortalUser" is automatically enabled when the Sugar
Portal is enabled via Admin > Sugar Portal. It must remain enabled in order for
portal users to authenticate. This user can only be used to authenticate contact
credentials against portal API methods and determine portal account permissions
based on the Customer Self-Service Portal role. To create a Portal API user, please
review the Portal API Users section of this page.

Portal API Users will not appear in the Employees module and are not counted in
the user license agreement. More information about the Sugar Portal can be found
in the Sugar Portal documentation. Sugar's API documentation can be found in the 
Web Services section of the Developer Guide.

Note: The Portal API user is not intended to be a free API user for external
integrations and has very limited functionality through the API.

License Types

Users are given access to specific capabilities in the product by assigning them
one or more licenses (e.g., Sugar Sell Premier, Sugar Serve) in the License Type
field on the user record. See the License Management page for details on working
with user licenses and license limits.

To compare which functionality each license type has access to, refer to the 
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License Types Matrix page.

User Fields

The Users module contains a number of stock fields, which are included out-of-the-
box with Sugar. The below definitions are suggested meanings for the fields, but
many of the fields can be leveraged differently to best meet your organization's
needs. System Administrators have the ability to alter, remove, or add fields in the
User Profile tab via Admin > Studio, minus a few noted exceptions. For more
information on adding or modifying fields, please refer to the Studio
documentation.

For instances that use SugarIdentity, the following user fields are read-only and
can only be edited in SugarIdentity:

Username
Status
User Type
First Name
Last Name
License Type
Note: For certain SugarIdentity-enabled instances, this field is only
available to manage in SugarIdentity. 
Title
Department
Work Phone
Address Street
Address City
Address State
Address Postal Code
Address Country
Primary Email Address  

The User Profile tab contains the contact information for the user and other
important user-specific settings. The User fields are as follows:

Field Description
Address City The city of the user's address.
Address Country The country of the user's address.
Address Postal Code The postal code of the user's address.
Address State The state of the user's address.
Address Street The street name and number of the

user's address.
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Avatar Upload an image to this field to
represent the user that will be shown on
the Activity Stream and next to the
user's name on the navigation bar.

Business Center Name 1 The business center this user belongs
to.

Department The department where this user works.
Description A description or other information about

this user.
Display Employee Record Check this box if the user should have

an employee record show in the 
Employees module.

Email Address The user's email addresses, where a
primary address is selected to receive
email notifications and if this should be
a reply to address when using Sugar's
outbound email (SMTP) functionality.
Note: This field is not editable in Studio.

Email Client When clicking on an email address in
Sugar, this will determine if Sugar's
email composer will open or if the user's
primary email program on this computer
(e.g., Microsoft Outlook, Apple Mail,
etc.) will open.
Note: This field is not editable in Studio.

Employee Status The user's employment status in the
organization (Active, Terminated, or
Leave of Absence).
Note: The Employee Status and Status
fields are managed separately, so
consider choosing a new employee
status when the Status field changes.

Fax The user's fax number.
First Name The user's first name.
Home Phone The user's home phone number.
IM Name The user's instant message screen

name.
IM Type The user's instant message service type.
Last Name The user's last name.
License Type Determines what Sugar functionality the

user may access. For more information,
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refer to the License Types section
above.
Note: For certain SugarIdentity-enabled
instances, the License Type field is
managed in SugarIdentity.

Mobile The user's mobile phone number.
Other Phone An additional phone number for the

user.
Reports to The user's manager. The user that this

user reports to will become an implicit
member of this user's Teams. The
"Reports To" field is also leveraged by
several features in Sugar. For more
information, refer to the Understanding
the Reports To Field section of this
page.
Note: This field is not editable in Studio.

SMTP Password If an outgoing email server is defined in
Admin > System Email Settings, the
user's SMTP password can be input here
to send mail through Sugar.
Note: This field is not editable in Studio.

SMTP Username If an outgoing email server is defined in
Admin > System Email Settings, the
user's SMTP user name can be input
here to send mail through Sugar.
Note: This field is not editable in Studio.

Status Making a user inactive will make it so
this user cannot log in to Sugar. This
will also remove the user from taking a
license seat, without having to delete
the user. When making a user inactive,
the admin is prompted to use the 
Reassign Records function. 
Note: The Employee Status and Status
fields are managed separately, so
consider choosing a new employee
status when the Status field changes.

Title The user's job title.
User Name The user name will be what the user

logs in to Sugar with on the login page.
It will also show for other users when
they view fields such as "Assigned to"
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and "Created By". This is the name that
will define the specific user in Sugar
and should be unique for every user.

User Type Specifies what type of user this is which,
a system administrator, regular user,
etc as described in the User Types
section above.
Note: This field is not editable in Studio.

Work Phone The user's work phone number.

1 This field is only accessible to Sugar Serve and Sugar Sell users; users without a
supported license type cannot update the value of this field. See the License Types
section for more details.

The Advanced tab in the user's profile includes settings to configure how Sugar
will function for that specific user. The fields in the Advanced tab cannot be edited
in Studio.

Field Description
1000s Separator Select a character to use as a 1000's

separator, with an example showing in
the "Example" box.

Create Revenue Line Items in Preferred
Currency 

Mark the checkbox to use your
preferred currency when creating
revenue line items based on a product
catalog item, rather than the default
behavior of using the product catalog
item's currency.

Data Font Size The default font size of the PDF body
when generated by this user.

Date Format How date fields will appear for the user,
with the ability to control month, day,
and year formatting.

Decimal Symbol Select a character to use as a decimal
symbol, with an example showing in the
"Example" box.

Default Teams A default team defines the team set
when this user creates a record.
Whenever this user creates a record, the
team is set as the user's default team,
similar to how the "Assigned To" field is
set to be the created user.
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Note: Users can be assigned any
number of default teams.

Export Delimiter Character or characters used to delimit
exported data by this user.

Field Name Placement Choose whether field names are
displayed above or beside field values in
record view; by default, field names are
displayed beside the field value. This
option does not apply to the Record
View dashlet.

First Day of Week Which day of the week will show as the
first day when the user views the Sugar
legacy calendar.

Font for Footer Select a font for the footer in PDF
documents when generated by this user.

Font for Header and Body Select a font for the header and body of
PDF documents when generated by this
user.

iCal integration URL URL in which someone can subscribe to
the user's Sugar legacy calendar within
iCal or other programs that support iCal
integrations.

Import/Export Character Set The default character set used for
imports, exports, and vCard generation
for this user.

Main Font Size The default font size in the PDF header
when generated by this user.

Name Display Format How concatenated name fields will
appear for the user, with the ability to
control first name, last name, and
salutation formatting.

Notify on Assignment When this box is checked, the user will
receive an email notification when a
record is assigned to them by another
user.
Note: A system outbound mail account
must be enabled in Admin > System
Email Settings.

Preferred Currency Select the user's default currency to be
used when creating new records.
Additional currencies can be defined in
Admin > Currencies. 
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Publish at my Location Used to share free/busy information
between Sugar legacy calendar and
Microsoft Outlook calendar.

Publish Key Alphanumeric code entered by the user
to uniquely identify his or her legacy
calendar and populate the iCal
integration URL, Publish at my location
site, and Search Location.

Reminders This field sets the default reminder
settings for calls and meetings created
by this user so that when the user
creates a call or meeting, the reminder
settings will be pre-populated to the
configuration defined in this field.

Popup: Users that are invited to a call
or meeting created by this user to
receive a browser popup notification for
the call or meeting at a given time
interval before the activity.

Email all invitees: Invitees invited to a
call or meeting created by this user to
receive an email notification for the call
or meeting at a given time interval
before the activity.

Search Location Used to share free/busy information
between Sugar legacy calendar and
Microsoft Outlook calendar.

Select Modules for Navigation Bar The order of the module navigation bar
is defined by the order in the Display
Modules column and modules listed in
the Hide Modules column will not
appear in the bar.

Show Full Names When this box is checked, the user will
see users' full names ("John Smith")
instead of user names ("jsmith") when
using Sugar.

Show Preferred Currency Mark the checkbox to convert the base
currency to user-preferred currency in
list views and record views.
Note: User-preferred currency is not
used in the Quotes record view or for
quoted line items. For more information,
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refer to the Quotes and Quoted Line
Items documentation in the Application
Guide.

System Significant Digits Define how many digits will appear after
the decimal point when the user views a
currency field, with an example showing
in the "Example" box.

Time Format How time fields will appear for the user,
with the ability to control hour, minute,
and 12 versus 24-hour clock formatting.

Time Zone The user's time zone will be
automatically set to match their
browser's time zone by default. This
field is read-only.

User Wizard Prompt Mark the checkbox to have users go
through the New User Wizard upon
their first login.

Note: The Quotes and Revenue Line Items modules are not available for Sugar
Serve users. For more information on license types and the functionality available
for each type, refer to the License Types section. 

Understanding the Reports To Field

The Reports To field on the User record is used by various parts of Sugar to
determine who a user's manager (i.e., supervisor) is. Some examples of how Sugar
uses this relationship are described below:

Workflow Management: Alerts and actions in Sugar's Workflows module
allow you to send an alert to or assign a record to a user's manager. For
example, you may wish to notify a user's manager when that user creates a
new high-priority case. Refer to the Workflow Management documentation
for more information.
SugarBPM: Users' managers can be used in activity assignments, email
recipients, and evaluations when designing a process definition. For
example, you may wish to assign an approval activity to the manager of the
owner of a quote before the quote is ready to be sent to the customer.
Refer to the Process Definitions documentation for more information.
Teams: Managers are an implicit member of all of their reportees' teams,
which gives them access to all of their reportees' records. Refer to the 
Team Management documentation for more details on implicit and explicit
team membership.
Organization Chart Dashlet: This dashlet visually outlines the hierarchy of
Sugar users under the current user according to the Reports To field. The
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dashlet includes reportees that are one or two levels below them.

Note: Only administrators can edit the Reports To field.

Users Module Tab

Click the Users module tab in the navigation bar, shown after selecting User
Management in the Admin page, to access the Users list view. You may also click
the three-dots menu in the Users module tab to display the Actions and Recently
Viewed menus. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the list of users you last viewed in
the module. For more information on records last viewed, please refer to the 
Viewing Via Recently Viewed section of this page.

The options in the Actions menu allow you to perform the following types of action:

Option Description
Create New User Opens the edit view layout to create a

new user.
Note: For instances that use
SugarIdentity, the SugarIdentity console
opens in a new browser tab to create a
new user.

Create Group User Opens the edit view layout to create a
new Group User.

Create Portal API User Opens the edit view layout to create a
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new Portal API User.
Copy Content Copy user preferences and content from

one user to individual users or all users
in a team or role.

Copy User Settings Copy the current user's locale settings
to individual users or all users in a team
or role.

Reassign Records Opens the Reassign Records tool.
Import Users Opens the import wizard to create or

update users using external data.
Note: For instances that use
SugarIdentity, the import option can
only be used to update existing user
records. Administrators can access
SugarIdentity to import a list of new
users using a CSV file.

Creating Users

There are various methods for creating new users in Sugar. These are via the
Users module, duplication, or import. Creating users is an imperative function in
Sugar as it allows for other members of your organization to log in and work in
Sugar. Please note that you will not be able to add more users of a particular
license type than is allowed by your Sugar license. For more information on how
Sugar's licensed user limits work, refer to the Understanding User Types, License
Types, and Sugar Licenses article.

Notice: For instances that use SugarIdentity, the administrator will need to access
SugarIdentity to create new users.

Creating via Module Tab

The most common method for creating users in Sugar is via the Users module. The
edit view layout opens when creating the user directly from the Users menu and
includes all of the relevant fields to create a new user. The fields and options on
the Create page will vary depending on the type of user you are creating.

Regular and Admin Users

Regular and Admin users are the most common users that will be created in a
Sugar instance and contain the most detail and fields compared to the other user
types. For more information about the use of Regular and Admin users, please
review the Regular User and System Administrator sections of this page.
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Notice: For instances that use SugarIdentity, the administrator will need to access
SugarIdentity to create new users. For certain SugarIdentity-enabled instances,
the users' license type (e.g., Sugar Serve) is managed in SugarIdentity, and the
License Type field will be read-only in the Sugar application.

Use the following steps to create a new user:

1. Navigate to Admin > User Management.
2. Click the three-dots menu in the Users module tab to open the Actions

menu and select "Create New User". 

3. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

Enter the following information under the User Profile tab:
In "User Profile" enter a user name for this user which will
define the specific user in Sugar and should be unique for
every user. Sugar will default the user to being Active and a
Regular User, which can be updated if the user is going to
be an administrator.
In "Employee Information", contact information and other
specific information about the user can be added. This will
include phone numbers, contact address, the user's
department and job title, and any description information.
In "Email Settings" the user's email address or addresses
can be added. The email addresses can also be marked as
"Primary", meaning that this will be the first email address
that shows for the user, and "Reply-to", where automatic
notifications from Sugar will be sent. In this section, the
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user's outbound email client will be selected to default to
Sugar or an external program, such as Microsoft Outlook. If
a mail server is configured in Admin > System Email
Settings, additional options will display here for SMTP
Username and SMTP Password.

If the administrator has set up an OAuth2-based email
account, there will be an Authorize button that will initiate a
pop-up to authenticate the email account.

The Advanced tab includes preference-type settings (User Settings,
Layout Options, Locale Settings, PDF Settings, Calendar Options)
for the user. These are all specific to the user's account and will not
affect system-wide settings or other users. Options such
as assignment notifications, date and time formats, time zone,
preferred currency, etc. are available to configure under this tab.

4. A Password tab will appear to the right of the User Profile tab. The
administrator can manually enter a password for the user under this tab
and provide it to the user. Please note that the password requirements
listed on the right will be checked off as the new password meets the
required conditions.
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5. After entering the necessary information click the Save button.

Upon saving, an email will be sent to the user and a corresponding
Employee record will be created for the user. Once the user is created, the
administrator can assign Teams and Roles to the user via the Access tab.

Group Users

A Group user cannot log in to Sugar, but new and existing records can be assigned
to the Group user. The Create page for the Group user consists of the User Name,
Status, Name, User Type, and Email Address fields. For more information on how
to use Group users in Sugar, please review the Group User section of this page.

Use the following steps to create a Group user:

1. Click the three-dots menu in the Users module tab to open the Actions
menu and select "Create Group User".

 
2. Enter a name and user name (e.g., Support) for this user.
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3. In the Email Settings section, enter an email address or addresses for the
Group user. The group user's primary email address will be marked as
"Primary" and you can also mark "Reply-to" if any automatic notifications
from Sugar will be sent to this address.

Note: If your organization has a group inbox or alias for a team
represented by the group inbox, the email address can be added
here for all notifications to be sent to the entire team.

4. Click "Save" to create the user.

 

Portal API Users

A Portal API user cannot log into Sugar via the web interface, but the name and
user name will appear for other users as they view records assigned to the group
user or assign records to this user. The Portal API user creation screen only
contains five fields. For more information on the use of the Portal API user, please
review the Portal API User section of this page.

Use the following steps to create a Portal API user:

1. Click the three-dots menu in the Users module tab to open the Actions
menu and select "Create Portal API User".
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2. Enter a name and user name for the user.
3. In the Email Settings section, enter an email address or addresses for the

API user. The group user's primary email address will be marked as
"Primary" and you can also mark "Reply-to" if any automatic notifications
from Sugar will be sent to this address.

4. On the Password tab, enter and confirm a password for the user following
the password requirements set in Admin > Password Management. This
password will be used to log in to the API for this user.

5. Click "Save" to create the user.

Creating via Duplication

Often, administrators will find themselves in situations where multiple users must
be created at once, whether it be when they are first setting up Sugar, a new
group of employees is going to be using Sugar, etc. For situations such as these,
one user can be configured and additional users can be quickly set up using the
Copy option available on the record's detail view. When duplicating a user, all
fields are populated from the original record to the duplicated one, except for the
User Name field and password fields.
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Note: The Copy option is not available for instances that use SugarIdentity. 

Use the following steps to create a user by duplicating an existing user:

1. Navigate to the detail view of the user you would like to duplicate.
2. Click the Actions menu and select "Copy". 

3. The displayed edit view is pre-populated with the original user's values,
except for the user name and password.

4. Populate the "User Name" for the new user and edit any other fields or
preferences to be specific to the new user. Fill in any information for the
new user that did not exist on the original user.

5. A Password tab will appear to the right of the User Profile tab where
administrators can manually create a password for the user. Please note
that the password requirements listed on the right will be checked off as
the new password meets the required conditions.
Note: For instances that use SugarIdentity, administrators will not be able
to manually change or reset the user's password via the user's profile.
Users can instead click the "Forgot Password?" link on the Sugar login
screen to reset their passwords.

6. Click "Save".

The new user is now created and available for use. This process is applicable to all 
user types.

Creating via Import

The import function in Sugar allows you to push multiple user records into Sugar
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using a comma (or another character) delimited file instead of creating them one-
by-one. Use the following steps to import users via the Import Users option. For
more information on importing records to Sugar, please refer to the Import
documentation.

Note: For instances that use SugarIdentity, the import option can only be used to
update existing user records. Administrators can access SugarIdentity to import a
list of new users using a CSV file. 

The following steps cover importing new user records as an example:

1. Click the three-dots menu in the Users module tab to access the Actions
menu and select "Import Users".

2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only".

Click "Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. In Step 5, configure any fields you would like to use for duplicate checking.
7. In Step 6, view the import results.

The Created Records tab will show all of the new user records.
The Duplicates tab will show any records in the file that were
detected as a duplicate and thus not imported from the duplicate
check in Step 5 of the Import Wizard.
The Errors tab will show records that were not imported due to
errors detected during import.

Viewing Users
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There are various options available for viewing user records in Sugar including via
Users recently viewed, Users list view, Users detail view, dashlets, and reports.

Note: If your instance uses SugarIdentity, then you can also view the user's basic
and employment-related information in SugarIdentity.

Viewing via Recently Viewed

As you work, Sugar will keep track of which users you have recently viewed. Click
the Actions menu in the Users module tab to see a list of your most recently
viewed users, and click each name to open the user in detail view.

Viewing via List View

The Users list view displays all user records meeting the current search criteria.
To access the list view, navigate to Admin > User Management. While the list view
shows key user fields, you can click the user's name to open the record in detail
view. For more information on viewing users via list view, please refer to the Users
List View section of this page.

Viewing via Detail View

The Users detail view displays thorough user information including all user fields
followed by subpanels of the user's related records belonging to various modules.
The detail view also provides the Access tab, which allows Teams and Roles to be
related to the user. Any admin user can click a user record's link from anywhere in
the application, including from the Users list view to access the user's detail view.
For more information on viewing the user's detail view, please refer to the Users
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Detail View section of this page.

Viewing via Dashlets

The Home page displays a collection of Sugar dashlets that allow users to get a
quick view of various records, activities, reports, etc. Clicking a user's name from
any dashlet will open the user in detail view and administrators can make changes
to the user's profile as necessary. For more information on using dashlets, please
refer to the Dashboards and Dashlets documentation.

Viewing via Reports

Administrators have the option to build, run, and manage reports to gather key
data from records within Sugar. When building a report, you may either create a
report based on the Users module or add links to the Users module in a report
based on a module related to Users. Once the report is run, you can view the user
record's detail view simply by clicking the user's name in the report results. Please
note that you can only access user detail views via the Rows and Columns and
Summation with Details-type reports as Summation and Matrix-type reports do not
include hyperlinks in their display columns. For more information on using reports,
please refer to the Reports documentation.

                           87 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/dashboards_dashlets/
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/reports/


 

Impersonating Users

If your instance uses SugarIdentity, you have the ability to log in as other users in
your organization using the "Impersonate (Log in as)" option in SugarIdentity.
When impersonating a user in Sugar, you will be able to access and view the same
modules and settings as the user's actual account without having to obtain their
login credentials. For more information on impersonating a user, refer to
the SugarIdentity Guide. 

Searching Users

The Users module's list view includes Basic and Advanced Search functionality to
help you locate users easily and effectively. Once the search is performed, the
relevant search results will be displayed in the Users list view below. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to pull up all records that include the
keyword entered in the search. If you would like to broaden the search, you can
use the "Wildcard" (%) at the beginning of your text as well (e.g., %manager). This
will pull up any record that has the word "manager" in the name, regardless of how
it starts or ends (e.g., "Department Manager", "Product Manager" or "Project
Manager").

For more information on using the various search methods as well as how
wildcards are used, please refer to the Search documentation.

Basic Search

Basic search offers only Full Name as a searchable field. From the Basic search
panel, you can click "Advanced Search" to access additional search functionality.
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The buttons available in the Basic Search panel are also available in Advanced
Search.

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.

When you run a search, Sugar will return records matching the criteria you typed
in the Full Name search box. Once the search is complete, the relevant results will
populate in the list view below the search panel. To see all user records, simply
click "Clear" and then "Search" to perform a blank search with no filters.

Administrators can also configure what fields appear on the Users Basic Search via
Admin > Studio. For more information on editing the Basic Search layout, please
refer to the Studio documentation.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.
Layout Options: Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches: Save, recall, update, and delete searches that you use
often. For more information, please refer to the Saved Search section of the
Saved Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given values. For example, if you
select "Is Administrator" as "Yes" and enter in a "First Name" to search, Sugar will
only return the user records that have a matching first name and are admins. Once
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the search completes, the relevant results will populate in the list view below the
search panel. To see all user records, simply click "Clear" and then "Search" to
perform a blank search with no filters.

Administrators can configure what fields appear on the Users Advanced Search via
Admin > Studio. For more information on editing the Advanced Search layout,
please refer to the Studio documentation.

Users List View

The Users list view displays all user records meeting the current search criteria.
You can view the basic details of each user within the columns of fields.

You have the option to change what fields are displayed in list view by configuring
your layout options available in Users Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of
the Search documentation. You can also change what fields are visible in the list
view via Studio. For more information on editing list view layouts, please refer to
the Studio documentation.

Checkbox Selection

You can perform actions on user records directly from the list view by first
selecting the desired records. To select individual user records on the Users list
view, mark the checkbox on the left of each row. To select or de-select multiple
user records on the list view, use the options in the checkbox dropdown menu.

Select This Page: Selects all records shown on the current page of user
results.
Select All: Selects all records in the current search results including all
pages of user results.
Deselect All: De-selects all records that are currently selected.

 

Actions Menu
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The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more users at a

time.
Note: For instances that use
SugarIdentity, the administrator will
need to access SugarIdentity to mass
update the Status and User Type fields.

Export Export one or more users to a CSV file.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than potentially displaying thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow next and previous buttons can be
used to scroll through the records page-by-page. The two double-arrow first and
last page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
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will have a pair of arrows in the column header. The list view may be sorted by
only one column at a time. You can also set a default order-by column using the
layout options in Advanced Search to specify which field to automatically sort
results by in the list view. For more information on setting a default column sort,
please refer to the Layout Options section of the Search documentation.

Users Detail View

The Users detail view displays thorough user information including all user fields
which are grouped by default into the User Profile, Advanced, and Access panels.
You can also view information from records related to the Users module as
subpanels below the detail view. For more detailed information about adding
relationships, please refer to the Studio documentation. The detail view can be
reached by clicking a user record's link from anywhere in the application including
from the Users list view.

Note: If your instance uses SugarIdentity, then you can also view the user's basic
and employment-related information in SugarIdentity.

Administrators have the ability to change what fields are visible in the detail view
by configuring the field groupings via Admin > Studio. For more information on
editing detail view layouts, please refer to the Studio documentation.

Actions Menu

The Actions menu on the top left of each user's detail view allows you to perform
various actions on the current record. Please note that administrators in Sugar can
change the action items to be displayed as separate buttons instead of a dropdown
menu via Admin > System Settings. For more information on how to configure the
actions menu, please refer to the System documentation.
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Note: The Copy and Delete options are not available for instances that
use SugarIdentity. 

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this user.

Note: For instances that use
SugarIdentity, certain user fields (e.g.,
First Name, Last Name, Title, Work
Phone) can only be edited in
SugarIdentity.

Copy Duplicate this user.
Note: The Copy option is not available
for instances that are SugarIdentity-
enabled.

Delete Delete this user.
Note: The Delete option is not available
for instances that are SugarIdentity-
enabled. Administrators can access
SugarIdentity to delete a user from
Sugar.

Reset User Preferences Revert all user preferences back to
system-wide settings.

Tabs

The detail view for a user is broken up into multiple tabs to better organize the
different fields available in the Users module. Some of the available tabs in the
user's profile are "User Profile", "Advanced", and "Access". A Downloads tab is also
available when viewing your own profile. For more information on viewing your
personal user profile, please review the User Preferences documentation.

User Profile

The User Profile tab displays information specific to the user such as the user's
name, user type, employment status, contact information, etc. Administrators have
the ability to configure the User Profile layout via Admin > Studio. For more
information on editing the user's profile in the Users module, please refer to the 
Editing Via Detail View section of this page.

Note: For instances that use SugarIdentity, certain fields (e.g., First Name, Last
Name, Title, Work Phone) in the user's profile are read-only and can only be edited
in SugarIdentity.
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Advanced

The Advanced tab shows information specific to the user's preferences in Sugar.
Information such as the user settings, locale settings, PDF settings, etc. can be
easily viewed under this tab. Please note that the layout of this tab cannot be
edited in Studio. However, you can edit the information under the tab by clicking
the Edit button on the user's detail view. For more information on editing the
user's profile, please refer to the Editing Via Detail View section of this page.

Access

The Access tab summarizes the user's Team and Role settings so that it can easily
be viewed in one place. The Access table, Roles subpanel, and My Teams subpanel
will appear under the tab.

Access Table: The Access table summarizes the set of permissions
assigned to the user and allows you to view the type of access they have
along with the actions (e.g., View, Edit, Delete, etc.) they can perform in
Sugar. This table is very similar to what appears in Admin > Role
Management, but this table is not editable in the Users module.
Note: Users with more than one role assigned will have the more
restrictive role setting prevail on the access table. For example, if one role
allows the user to delete records in the Contacts module, but the other role
does not allow record deletion, the user will not be able to delete records in
the Contacts module.   
The table will list the modules in rows on the far left with column headers
representing the type of action (e.g., Delete, Edit, Export, etc.) users can
perform in each module. For more information on role settings, please refer
to the Roles documentation.

Roles Subpanel: The Roles subpanel will list all of the roles assigned to
the user along with the description of each role. Roles work in conjunction
with teams to form a robust security model for non-admin users in Sugar.
Roles control three different layers of access for users within Sugar:
module, field, and action-level access. System administrators can easily
assign roles to the user as well as remove roles via the Roles subpanel.
Teams Subpanel: The Teams subpanel will list all of the teams assigned to
the user along with the description of each team. The defined permissions
determine what records a user is and is not able to access. Teams are used
in conjunction with roles to form a robust security model for non-admin
users in Sugar. System administrators can easily assign teams to the user
as well as remove teams via the My Teams subpanel. For more information
on team settings, please refer to the Teams documentation.
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Subpanels

Subpanels can be added to the Users module by creating relationships via Admin >
Studio. All available subpanels will appear at the bottom of the user's detail view.
For more information on adding relationships, please refer to the Relationships
section of the Studio documentation.

The User Holidays, Shifts, and Shift Exceptions subpanels are available for the
Users module out of the box. The User Holidays subpanel allows administrators to
select specific days that the user will not be working, which is used when
calculating project timelines in the Projects module and user availability for record
assignment in SugarBPM. Holidays can be added using the Create button and
inputting a date and description of the holiday.

 

The Shifts and Shifts Exceptions subpanels show the shifts and shift exceptions to
which the user is related. This allows you to view the shifts and the exceptions to
these shifts that a user has so that you can understand their work schedule and
their availability to be round-robin assigned records in SugarBPM. To update an
employee's work schedule, click the relevant shift or shift exception to open its
record view and add or remove the user in the Users subpanel. See the Shifts and
the SugarBPM documentation for more details.

Editing Users

The user's profile can be easily edited by the user or the administrator by clicking
the Edit button on the user's detail view. In addition, changes to the user's profile
can be made via the Users list view as well by clicking the Pencil icon to the left of
the user's name. Editing the user's profile from the detail view and list view opens
the full edit view layout which includes all of the relevant fields that can be
updated as necessary.

Note: If your instance uses SugarIdentity, then you will need to access
SugarIdentity to update certain user fields.  
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Editing via Detail View

You can edit users by clicking the Edit button on the upper left of the user's detail
view. Once the edit view layout is open, update the necessary fields, then click
"Save" to preserve the changes made. For more information on the detail view,
please refer to the Users Detail View section of this page.

External Accounts

When viewing the edit view of a user, the External Accounts tab appears to the
right of the Advanced tab. The External Accounts functionality allows you to
connect external applications to Sugar, such as GoToMeeting, Google, and WebEx.
To create an external account record, follow the following steps:

1. Navigate to the detail view of the user to whom you would like to add the
account.
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2. Click on the External Accounts tab then click "Create".

 
3. Select the application you will be connecting to from the Application

dropdown field. The fields available to complete will vary depending on the
application (GoToMeeting, Google, WebEx) selected. If no fields are
present, click "Connect" and a pop-up window will open for you to grant
permission or input your credentials, depending on the application. Your
pop-up blocker must be disabled for the pop-up to appear. Please note that
additional external applications will appear on the list if they are enabled
via Admin > Connectors.

4. Enter the necessary information for the external application and click
"Connect". 

Should you wish to prevent users from creating external accounts, you can
remove the Create button for users in the External Accounts tab of their profiles by
disabling the External Accounts module via a role assigned to those users. Please
note the "Access Type" setting will not affect this module. Furthermore, editing or
deleting the external account can be done by clicking the account's name on the
External Account list view. This brings you back to the edit view with the
necessary options and available fields. 

The out-of-the-box connectors perform the following functions:

DocuSign: The DocuSign connector allows you to send documents to
DocuSign for electronic signature from within Sugar.
Dropbox: The Dropbox connector allows you to access your Dropbox via
the Cloud Drive dashlet on dashboards throughout Sugar.
GoToMeeting: The GoToMeeting connector allows you to create meetings
in Sugar that are tied to your GoToMeeting account and will show as such
on your GoToMeeting account. This allows the user to, after creating the
Sugar meeting record, start the GoToMeeting directly from within Sugar's 
Meetings module.
Google: The Google connector allows you to create documents within
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Sugar that, instead of uploading a file to the server hosting Sugar, allows
the user to link to an existing Google document from Google Drive or to
upload a file to that account. When clicking on a document name in the
Documents module or any Documents subpanels, the user will be brought
to Google Drive instead of the download being initiated. The Google
connector also allows you to use access your Google Drive via the Cloud
Drive dashlet on dashboards throughout Sugar.
Microsoft: The Microsoft connector allows you to access your Microsoft
OneDrive via the Cloud Drive dashlet on dashboards throughout Sugar.
WebEx: The WebEx connector allows you to create meetings in Sugar that
are tied to your WebEx account and will show as such on your WebEx
account. This allows the user to, after creating the Sugar meeting record,
start the WebEx meeting directly from within Sugar's Meetings module.

Editing via List View

You can edit users via the list view by clicking the Pencil icon to the left of each
user's name. The full edit view layout will open allowing you to make any changes
to the user's profile as necessary. Once the user's profile has been updated, click
"Save" to preserve the changes. For more information on the list view, please refer
to the Users List View section of this page.

Editing via Import

You can also update existing user records via import using a CSV file. To update
existing records, simply select the "Import Users" option under the Users module
tab. Please note that the import process will vary between instances that
use SugarIdentity and instances that do not use SugarIdentity. For instances
that do not use SugarIdentity, refer to the Import documentation for more
information on updating existing records via import. For instances that use
SugarIdentity, refer to the Importing Updates to Existing User Records section of
this page for more information.  

Deactivating Users

When a user is no longer a member of your organization, it is best practice to
deactivate them instead of deleting them. This ensures that the user will no longer
be able to log in to Sugar, but any historical information tied to the user will still
be available. While deactivating user records will not update any related records,
the Reassign Records tool will be presented and can be used to reassign all of the
user's records. If needed, you can filter list views to show records that are
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assigned to or created/modified by inactive users by filtering the user list on the
Status field. 

Note: Users that have been deactivated do not count towards your licensed user
count.

Note: If your instance uses SugarIdentity, you will need to access SugarIdentity to 
deactivate a user from Sugar. 

Use the following steps to deactivate a user and reassign their records:

1. Navigate to Admin > User Management and click the user you wish to
deactivate.

2. Edit the user record and change the Status field to "Inactive". Click "Save".
3. A pop-up message will display asking if you would like to reassign all of the

user's records. Click "Yes" if you wish to proceed.

4. You will then be presented with the Reassign Records tool. Follow the steps
on this page to complete the deactivation. For more information, please
review the Reassigning Records section.

5. Once the reassignment is complete, the user will be deactivated and no
longer able to log in to Sugar.

Please note that you can also filter list views to show records that are assigned to
inactive users by filtering the user list on the Status field and then mass updating
the records to be assigned to an active user.

Deleting Users

If a user record is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from the Users detail view. Please note that deleting
user records will not delete any related records and will only prevent the user from
being selected (e.g., Assigned to). When a user is no longer a member of your
organization, it is best to deactivate them by changing the Status field to "Inactive"
instead of deleting them. This way, any historical information tied to the user will
still be available, but the user will no longer be able to log in to Sugar.

Note: If your instance uses SugarIdentity, you will need to access SugarIdentity to 
delete a user from Sugar.  

Use the following steps to delete a user and reassign their records:

1. Navigate to Admin > User Management and click the user you wish to
delete.
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2. Select "Delete" from the Actions Menu.
3. A pop-up message will display asking for confirmation. Click "OK" to

proceed.

4. You will then be presented with the Reassign Records tool. Follow the steps
on this page to complete the deletion. For more information, please review
the Reassigning Records section.

5. Once your reassignment is complete, the user will be deleted, and you can
freely navigate around Sugar.

Exporting Users

Sugar's Export option allows users to download all fields for the selected users to
their computers as a .CSV (comma-separated values) file. This may be useful when
needing to use User data with other software such as Microsoft Excel or to update
existing records by exporting, making changes, and then importing the altered
users back into Sugar. For more information on updating existing records via
import, refer to the Import documentation.

Users may be exported from the Users list view by selecting "Export" from the
Actions menu. User data can also be exported via the Reports module by creating
or accessing reports containing specifically chosen fields for users and their
related record(s). For more information on exporting records in Sugar, please refer
to the Export documentation.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of user records. If you
encounter an error when performing this action, we recommend selecting the
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records in smaller batches.

Importing Updates to Existing User Records

In addition to importing new user records via Sugar's Import Wizard, you can also
import updates to existing user records in Sugar using a CSV file. Please note that
the import process will vary between instances that use SugarIdentity and
instances that do not use SugarIdentity.

For instances that do not use SugarIdentity, refer to the Import documentation
for more information on updating existing records via import.

For instances that use SugarIdentity, use the following steps to update existing
user records via import: 
Note: Fields that are only editable in SugarIdentity cannot be updated via import
in Sugar. 

1. Click the three-dots menu in the Users module tab to access the Actions
menu and select "Import Users".

2. In Step 1, select the import file and click "Next".
Note: To create new user records via import, click the "SugarCloud
Settings" link to perform the import in SugarIdentity. 
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3. In Step 2, confirm the import file properties. Click "Next".
Note: Configuring the import file properties (e.g., Name Display Format)
for fields (e.g., First Name, Last Name) that are not editable in Sugar will
not apply to the data in the import file.

4. In Step 3, confirm the field mappings for the import then click "Import
Now". 
Note: Fields that are only editable in SugarIdentity will not be available to
map. 

5. In Step 4, view the import results. The Errors tab will show records that
were not imported due to errors detected during import.
Note: If the import file includes any changes to fields that are only editable
in SugarIdentity, it will not get updated in the record.

Mass Updating Users

Mass Updating allows users to make the same change to multiple user records at
once from the Users list view. Users with administrator or developer-level access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. Due to PHP memory
limitations on the server, there may be occasions when the application times out
while updating a large number of user records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.
For more information on configuring mass update, please refer to the Studio
documentation in the Administration Guide.

Note: For instances that use SugarIdentity, the administrator will need to access
SugarIdentity to mass update the Status and User Type fields.

Use the following steps to mass update user records from the list view:
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1. Navigate to the Users list view via Admin > User Management.
2. Use the list view's Basic or Advanced Search to identify users you wish to

modify.
3. Select the desired users individually or using the checkbox dropdown's

options.
4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.

6. Click "Update" to save the changes to all of the currently selected user
records.

Resetting User Preferences

As users make changes while navigating around Sugar, their preferences are
stored in the Sugar database. This includes preferences such as sort orders on list
view, previous searches on both basic and advanced searches, and settings in the
Advanced tab of the user profile. Users can reset their preferences back to the
default out-of-the-box settings, which will revert the user's changes made in Sugar.
Please note that this action cannot be undone. If the user is currently logged in,
the changes will not take effect until the user is logged out and then back in.

Note: Resetting a user's preferences is the only way to allow a user access to
Sugar if they have been locked out using the Login Lockout feature in Password
Management.
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Use the following steps to reset a user's preferences:

1. Navigate to the user's detail view via Admin > User Management and
select the user (e.g., Jim Brennan) from the list view.

2. Select "Reset User Preferences" from the Actions menu. 

3. A pop-up box will appear confirming the reset. Click "OK" to proceed.

Resetting User Passwords

Administrators have the option to manually set or reset users' passwords as
necessary. Please choose one of the following methods based on whether your
instance uses SugarIdentity or not:

SugarIdentity disabled SugarIdentity enabled
1. Navigate to the user's detail view via
Admin > User Management.

2. Click the Edit button on the upper left
of the detail view.

3. On the Password tab, enter the new
password.

Administrators can click the lock icon in
the Users list view of SugarIdentity to
send password reset emails to users.
For more information, refer to
the SugarIdentity Guide. 
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4. Click "Save" to confirm your change.

Note: The user needs to log out and then back in for the change to take effect.

Copying User Preferences, Dashboards, and Filters to
Other Users

Administrators can reduce the learning curve for new users by broadcasting the
setup of an existing user to individual users or users on a given team or role via
the Copy Content (preferences, dashboards, and filters) and Copy User Settings
(locale settings) options in the Users menu.

Copying Content

Administrators can save time setting up users with the Copy Content tool, which
copies select user preferences, dashboards, and filters from one user to other
users, teams, or roles. Content can be copied to individual or multiple users,
teams, or roles. Copying user preferences will overwrite the recipient users'
existing preferences.

To copy content such as dashboards, filters, and user preferences from one user to
other users, follow these steps:

1. Navigate to the Users module via Admin > User Management.
2. Click the three-dots menu in the Users module tab to open the Actions

menu and select "Copy Content".

3. From the "Copy item" dropdown, select the type of content to be copied.
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Refer to the Content Types section for descriptions of each type of content.
4. In the "From User" list, select the name of the user from which to copy the

identified content.
5. Click into any of the "To" fields to open a Search and Select drawer to

locate the users, teams, or roles, to which the content should be copied. 
6. Click the Copy button at the top right-hand corner of the page. A

confirmation message displays when the copy has been completed.

Note: When content is copied to user accounts, the users are not notified of the
change.

Content Types

The following lists contain the types of content that can be copied from a user.

User Preferences

Default Teams: The teams set as default teams in the source user's profile
user settings.
Favorite Reports: The reports identified as favorites.
Navigation Bar Module Selection: The modules and the order in which
they are displayed in the navigation bar as defined in the source user's 
layout options.
Notify on Assignment: Copies the "Email on Assignment" option as
defined in the source user's profile user settings.
Reminder Options: Copies the reminders as defined in the source user's
profile user settings.
Scheduled Reporting: Copies the source user's scheduled report settings.
Sugar Email Client: Copies the email client as defined in the source
user's profile email settings.

Dashboards

From Modules: Select this option to copy all of the source user's
dashboards from a designated module.
Existing Dashboards: Select this option to locate specific dashboards to
copy from the source user.

Note: When a dashboard is selected as a favorite by the source user, it will be
identified as a favorite in all user accounts to which the dashboard is copied.

Filters

From Modules: Select this option to copy all of the source user's filters
from a designated module.
Existing Filters: Select this option to locate specific filters to copy from
the source user.
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Copying User Settings

The Copy User Settings tool allows administrators to easily set the locale settings
 for individual users or users in a given team or role.

To copy user locale settings to other users, follow these steps:

1. Navigate to the Users module via Admin > User Management.
2. Click the three-dots menu in the Users module tab to open the Actions

menu and select "Copy User Settings".

3. Select the checkbox next to the settings to be copied. Refer to the Getting
Started documentation in the Sugar Application Guide for more information
on these settings.

4. Click into any of the "To" fields to open a Search and Select drawer to
locate the users, teams, or roles to whom the settings should be applied. 

5. Click the Copy button at the top right-hand corner of the page. A
confirmation message displays when the assignment has been completed.
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Reassigning Records

Reassign Records is a tool available in the Users module for administrators to
change the Assigned To and Team fields for a specific user's records. This is best
used when a user is changing departments, teams, or roles within the organization,
or if the user is no longer an employee or using Sugar. The Reassign Records tool
is automatically presented when deleting or deactivating a user. Please note that
reassigning records cannot be undone in Sugar.

Note: You can locate records assigned to Inactive users by filtering the module's
list view.

Use the following steps to reassign records:

1. Navigate to the Users module via Admin > User Management.
2. Click the three-dots menu in the Users module tab to open the Actions

menu and select "Reassign Records".
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The Reassigning Records tool can also be accessed during the process of 
deleting or deactivating a user, where it is used to reassign a user's records
before deleting or deactivating them.

3. Select the user to whom the records are already assigned in the From User
field.

4. Select the user to whom the records will be assigned to in the To User
field.
Note: You can select the same user in both fields if you are just changing
the team for all of the user's records.

5. Select which team(s) the records will be assigned to in the Set Teams to
field.

6. Select the module(s) you wish to include in the record reassignment.
Multiple modules can be selected by holding down the Control key when
using a PC or the Command key when using a Mac.
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7. Selecting certain modules will display specific filters (e.g., Type) which can

be applied to the module. Use these filters if you do not want to include all
records assigned to the user. The list of modules and their filter fields are
as follows:
Module Filter Field
Accounts Type
Bugs Status
Calls Status
Cases Priority

Status
Dashboards Default Dashboard
Opportunities Sales Stage

Type
Tasks Status

8. After selecting any filters, click "Next" to access the reassignment
summary.

9. If you would like to see a detailed list of the changes that were made, click
"Verbose Output". This list will include a link to the changed records and a
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summary of changes that were made.
10. If you would like the changes to show in the Change Log for the changed

record, have any relevant workflows fire, or have assignment notifications
sent out, please click the Include Workflow/Notifications/Audit checkbox.
Note: This process performs a large set of actions at once and may take a
long amount of time to complete.

11. Click "Next" to complete the reassignment.
12. The final summary page will show how many records were affected and if

any errors occurred during the reassignment. Click "Return" to return to
the main screen of the Reassigning Records tool.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while reassigning a large number of user records. If you
encounter an error when performing this action, we recommend reassigning
records in smaller batches via each module's mass update option.

External Users

The External Users module is a read-only module that is used to store the
attributes of users in external systems that integrate with Sugar. Only users may
view the external user record and use subpanels to link and unlink external user
records to eligible modules (i.e., Cases, Accounts). The module is visible in Studio
to administrators. Additionally, external user records cannot be created or edited
within Sugar. 

The External Users module links the Sugar Self-Service Center end users to their
various activities, such as cases. When setting up the Self-Service Center, it is
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important that an administrator adds the External Users module to the Displayed
Subpanels column from within Admin > Display Modules and Subpanels. This
allows agents to relate cases and accounts to Self-Service Center end users. For
more information on displaying subpanels, please refer to the Developer Tools
page. 

For more information on the Self-Service Center and how it relates to cases, please
review the Sugar Self-Service Center Agent Guide.

License Management

Overview

There are two license concepts that are important to understand when
administering a Sugar instance: system licenses and user licenses. System licenses
 are the actual license key you receive when you purchase Sugar; they must be
entered into the License Management page and indicate how many seats of Sugar
you are entitled to. In particular, they dictate how many of each license type you
have, so if you have more than one (e.g., Sugar Sell and Sugar Serve), you can
assign the different license types to different users according to your
organization's needs. In contrast, user licenses are the specific license types that
are assigned to a given user. For example, you may purchase a license key that
includes 50 Sugar Sell users and 25 Sugar Serve users and then assign those
licenses to users according to which capabilities they need to access (i.e., Sell,
Serve, or both).

When managing a new Sugar instance, you must first set up your system license
followed by your user licenses, based on how many seats are included with your
license key. The sections below cover topics on both license concepts.

System Licenses

The License Management section of the Admin page allows administrators to edit
and revalidate their Sugar license as well as view information such as the
download key, expiration date, number of users, etc. Sugar is purchased with a set
number of user seats for each Sugar product (e.g., Sugar Enterprise, Sell, or
Serve). Sugar users, including administrators, are then assigned to one or more
products via the License Type field on each user record. If an instance has more
active regular and administrator users than have been purchased for each license
type, regular users will not be able to log in. Admin users will be able to log in but
will be redirected to the Users module in order to correct the issue. Once enough
users have been deactivated or additional seats have been purchased, regular
users will be able to log in again. For more information, refer to the Understanding
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User Types, License Types, and Sugar Licenses article. SugarCloud customers can
monitor the number of users counting against their license via the SugarCloud
Insights page.

Download Key

The download key is a 32-digit alphanumeric key that is unique to your Sugar
account. The number of user licenses your organization purchased and the
subscription expiration date are tied to your download key. Upon purchasing
Sugar, you will receive a welcome email containing your download key
information, which will need to be entered during installation of the Sugar
application. Once the download key is entered into the system, the corresponding
information such as the expiration date, number of users, number of offline client
licenses, and number of concurrent self-service portal users will automatically
populate and be displayed in Admin > License Management.

Editing the License Key

For Sugar instances hosted in SugarCloud, admins cannot edit the license key in
the application because it is managed by SugarCRM. However, although rare,
there may be times when system administrators of on-premises instances will need
to edit their license key via Admin > License Management. For example, some
product changes (e.g., Sugar Enterprise to Sugar Serve) may result in a new
license key being provided by SugarCRM. You will need to update the License
Management page with the new license key to associate your account with the new
Sugar product.

The fields in the License Management panel are as follows:

Download Key: The download key associated with your Sugar
subscription.
Expiration Date: The date your Sugar license expires.
Number of Users: The number of users allowed to access Sugar based on
the number of purchased licenses.
Number of Offline Client Licenses: The number of offline clients
associated with your license key.
Number of Concurrent Self-Service Portal Users: The number of self-
service portal users associated with your license key.

The following steps cover editing the license key for your account when changing
Sugar products as an example:

1. Navigate to Admin > License Management.
2. Click the Edit button and enter the download key associated with your new

Sugar product.
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3. Once the download key is entered, click "Save".
Note: The expiration date, number of users, etc. will automatically be
updated based on the new download key.

Please note that when you save the new license key information, the system
automatically checks it against the information in the SugarCRM database to make
sure it is valid.

License Validation

The License Validation panel of the License Management page allows
administrators to re-validate their license as necessary. Sugar automatically re-
validates your license once every 90 days as long as a system administrator logs
into Sugar within the 90 day period. However, if your system fails to communicate
with the License Validation server through the internet or you are behind a
firewall, you will have to re-validate the license via Admin > License Management.
If the re-validation is successful, the Status field in the License Validation panel
will display the timestamp of the successful validation. The validation key
expiration date will be 90 days from the date of the last successful validation date.

License Expiration

Typically, Sugar licenses are purchased for a one-year period (e.g., 01/03/2022 to
01/03/2023). Please note that you will be notified of your upcoming subscription
renewal via email or call and a notification will appear in the Sugar cube on the
upper left of your Sugar account regarding your license expiration. If the
subscription is renewed past the expiration date, then administrators must re-
validate their license via Admin > License Management in order to update the
account with the new subscription. If the administrator does not re-validate the
license, regular users will be prohibited from logging in to Sugar until the license
is successfully validated by the administrator.

Re-validating the License

Although Sugar automatically re-validates your license once every 90 days, there
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may be special circumstances where administrators must re-validate the license
via License Management. For example, if you renew your subscription after the
expiration date or if you purchase additional users or license types mid-term, you
will have to re-validate the license via Admin > License Management in order to
update your Sugar account with the new subscription.

The fields in the License Validation panel are as follows:

Validation Key: System-generated validation key associated with your
Sugar subscription.
Validation Key Expiration: The date the validation key expires. The
expiration date is typically 90 days from the last successful validation date.
Status: The status displaying the timestamp of the last failed or successful
validation.

Use the following steps to re-validate the license in Sugar:

1. Navigate to Admin > License Management.
2. Click the Re-validate button.

The system will communicate with the License Validation server to validate your
license based on your Sugar subscription. If the re-validation is successful, then
the status will reflect the date and time of the successful validation. If the system
fails to connect successfully with the License Validation server and you cannot re-
validate your license, use the Manual Validation option at the bottom of the
License Validation panel.

Manual Validation

If your system fails to communicate successfully with the License Validation server
through the internet, you have the option to perform a manual validation via Admin
> License Management.

Use the following steps to perform a manual validation in Sugar:

1. Navigate to Admin > License Management.
2. Click the Manual Validation link located at the bottom of the License

Validation panel.

                         115 / 829



 

3. Click the Export Download Key button to export the sugarkey.lic file. Click
"Save" in the pop-up window to save the file to your local machine.

4. Go to http://updates.sugarcrm.com/license and submit the sugarkey.lic file
for validation.
Note: If the validation is successful, the validation key file
(sugarvalidationkey.lic) will be generated, and the system will prompt you
to save the file.

5. Log back in to your instance and navigate to the Manual Validation page
(Admin > License Management > Manual Validation).

6. On Step 3, choose the sugarvalidationkey.lic file on your local machine and
click "Import".

Once the validation key is imported successfully, you have completed the manual
validation process. Sugar will update the validation status along with the
Validation Key Expiration date for the license key.

User Licenses

Regular users and system administrators both count towards your license limits
and have a field called "License Type" on their user record. This field determines
which functionality the user may access. The options that appear in this field are
determined by the product(s) that an organization has purchased from SugarCRM.
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When an organization has purchased more than one product, such as Sugar Sell
Premier and Sugar Serve, both will appear as options in the License Type field.
Each user must have at least one license type selected, and selecting multiple
products enables the user to access the combined functionality of all selected
options. Select multiple options by clicking while holding the control or command
key. Please note that for certain SugarIdentity-enabled instances, the License Type
field is managed in SugarIdentity console. 

Note: Licensed user limits are calculated per each license type, and an active user
assigned to multiple license types will be counted against each.

If a user has license access to a module but not to a specific field on the module,
the field value is replaced with a pill containing the text "License Required".

License Types

Each license type that a user has set in the License Type field in their profile gives
them access to different capabilities within Sugar. For example, only users with
the Sugar Serve license assigned to them can access certain Serve-only features,
such as the Service Console. For a complete overview of which features each
Sugar product gives you access to, see the License Types Matrix page.

Licensed User Limits

If an instance has more active users of a particular license type than is allowed by
its Sugar license, regular users will not be able to log in. Admins will be able to log
in but will be redirected to the Users module. Once they have deactivated enough
users, reduced the users assigned to over-limit license types, or purchased
additional seats, regular users will be able to log in again. Users with an inactive
status, Group users, and Portal API users do not count toward these limits. User
types are described in more detail in the User Management documentation.

If your instance uses SugarIdentity, please be aware of the following:

You will need to access SugarIdentity to deactivate users from Sugar. 
For certain SugarIdentity-enabled instances, the users' license type (e.g.,
Sugar Serve) is managed in SugarIdentity. So, the admin must access
SugarIdentity to remove any license assignments.

For more information on how Sugar's licensed user limits work, refer to
the Understanding User Types, License Types, and Sugar Licenses
 article. SugarCloud customers can monitor the number of active users counting
against their license via the SugarCloud Insights page.
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License Types Matrix

License Types Matrix

The following table describes what functionality is available for each license type
in Sugar 12.3.x. For more information on working with licenses in your Sugar
instance, refer to the License Management page. 

Capability
(Sugar
12.3.x)

Sell
Premier

Sell
Advanced

Sell
Essentials

Serve Enterprise

Guided
Selling 1

Data
Enrichment
and News
Feed 2,8

Geo
Mapping 3,8

Mail and
Calendar
Integration 4

✔ $  $ $

Enhanced

5

✔     

Common
Modules and
Capabilities

✔ ✔ ✔ ✔ ✔

Module
Loader 11

✔ ✔ * ✔ ✔

Campaigns
Forecasts
Leads
Opportunitie
s 6
Quotes &
Quoted Line

✔ ✔ ✔  ✔
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Items 6
Renewals
Console
Revenue
Line Items 6
Shipping
Providers
Targets &
Target Lists
Tax Rates
Web-to-Lead
Forms
Forecast Bar
Chart
Dashlet
In Forecast
Dashlet
Opportunity
Metrics
Dashlet
Product
Catalog
Quick Picks
Dashlet
Sales
Pipeline
Chart
Dashlet
Stock Sales
and
Marketing
Reports
Top 10 Sales
Dashlet

SugarLive
Sentiment
Analysis for
Calls 12

Console List
View
Dashlet for

✔ ✔ ✔ ✔  
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SugarLive

Sales
SugarBPM
Templates

✔ ✔ ✔   

Intelligent
Lead Prioriti
zation 9
Intelligent
Opportunity 
Prioritizatio
n 9

✔ ✔    

Change
Timers
Customer
Service
SugarBPM
Templates
External
Users
Service
Console
Stock
Customer
Service
Reports 10

   ✔  

List of Common Modules and Capabilities

The following table lists the modules and major capabilities that are common
among all of Sugar's CRM license types.

Common Modules Administration User-Facing
Capabilities
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Accounts 6
Bugs
Calendar
Calls
Cases 7
Contacts
Contracts
Documents
Emails
Employees
Escalations
Holidays
Knowledge Base
Meetings
Messages
Metrics
Notes
Notifications
Product Catalog 6
Projects
Purchases and Purchased
Line Items
Releases
Reports
Shifts and Shift
Exceptions
Tags
Tasks

Action Buttons
Business Centers
Copy Content
Copy User Settings
Data Privacy
Dropdown-Field-Based
Record Views
Legacy Workflows
Role-Based Dropdown
Lists
Role-Based Record Views
SugarBPM

Activity Streams
Advanced Reports
Cloud Drive Integration
Dark Mode
Doc Merge
DocuSign Integration
Focus Drawers
Sugar Portal 7
Tile View

Specialty Dashlets:
Active Subscriptions
Dashlet
Cases Summary Dashlet
Comment Log Dashlet
Knowledge Base Search
Dashlet
Product Catalog Dashlet
Purchase History Dashlet
Record View Dashlet
Timeline Dashlet

Enhanced Module Functionality for Sugar Sell License Types

The following functionality is included on top of base module functionality for users
with a Sugar Sell license type in Sugar 12.3.x.

Sugar Portal functionality:

Sugar Portal Chat: Embed a chat window in the portal so portal
users can start a chat session with agents using SugarLive.
Chatbot for Sugar Portal Chat: A chatbot provided in the 
collection of assets that are included in Sugar Sell allows portal
users to create a case, check the status of a case, or speak with an
agent from the portal chat window.

Enhanced Module Functionality for Sugar Serve License Types
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The following functionality is included on top of base module functionality for users
with a Sugar Serve license type in Sugar 12.3.x.

Sugar Portal functionality:
Sugar Portal Chat: Embed a chat window in the portal so portal
users can start a chat session with agents using SugarLive.
Chatbot for Sugar Portal Chat: A chatbot provided in the 
collection of assets that are included in Sugar Serve allows portal
users to create a case, check the status of a case, or speak with an
agent from the portal chat window.
Case deflection: Knowledge base article search from Sugar Portal's
Home page allows portal users better access to self-service issue
resolution prior to creating cases.
Case and knowledge base dashlets: The All Open Cases, Recently
Resolved Cases, and Knowledge Base Categories & Published
Articles dashlets allow portal users to view their company's current
and recent cases and search for knowledge base articles.
Request to close case: The Request To Close button on cases in the
portal allows customers to easily communicate that it is safe to
close their case. In Sugar, the List of Cases Requested For Close
dashlet informs you of all cases awaiting closure.
Record visibility: Admins can limit which portal users can see cases
as well as the emails and messages related to them to either all
contacts or only those related to the specific record.
Expanded customization: Admins can customize more aspects of the
portal and see a live preview of their changes, including configuring
the Home page banner, search bar, and dashboard.

Case SLA and resolution trends: Several fields are included on cases to
track trends in first response SLAs and case resolution time, using both
calendar hours and business hours.

Footnotes
1 Guided Selling powered by Sugar Automate (formally known as Customer Journey
Plug-in).
2 Data Enrichment and News Feed powered by Sugar Hint.
3 Geo Mapping powered by Sugar Maps.
4 Mail and Calendar Integration powered by Sugar Connect.
5 Enhanced Forecasting is powered by Sugar Discover.

6 This module includes enhanced functionality for some Sugar Sell license types.
7 This module includes enhanced functionality for Sugar Serve license types.
8 The Sugar Maps and Sugar Hint capabilities are also user license types.
9 Intelligent Lead and Opportunity Prioritization powered by SugarPredict.

                         122 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_user_guide/#Sugar_Portal_Chat
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/sugarlive/
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_deployment_user_guide/#Managing_Sugar_Portal_Chat
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_deployment_user_guide/#Managing_Sugar_Portal_Chat
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_deployment_user_guide/#Managing_Sugar_Portal_Chat
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_user_guide/#Help_Search_Box
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_user_guide/#Home
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/portal_user_guide/#Requesting_to_Close_a_Case
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/cases/#Case_Fields
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/sugar_automate/
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/sugar_hint/
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/sugar_maps/
https://support.sugarcrm.com/documentation/plug-ins/sugar_connect/
https://support.sugarcrm.com/documentation/discover/
https://support.sugarcrm.com/documentation/sugarcloud_services/sugarpredict/sugarpredict_user_guide_for_sugar_sell/


 

10 Some stock customer service reports are available for all products, but a
selection of them are only available for Serve, as indicated in the Stock Reports
page.
11 Sugar Sell Essentials customers do not have the ability to upload custom file
packages into Sugar using Module Loader.
12 Sentiment Analysis for Calls powered by SugarPredict for Serve and 
SugarPredict for Sell.

System

Overview

Sugar® comes with the ability to configure many different system settings to
personalize the way Sugar works. The System section is only available to
administrative users and can be accessed via the Admin screen. The following
sections are available options from the System section.

System contains the following menus:

Menu Description
System Settings Configure system-wide settings.
Locale Set default localization settings for your

system.
Currencies Set up currencies and conversion rates.
Repair Check and repair Sugar.
Diagnostic Tool Capture system configuration for

diagnostics and analysis.
Tracker Enable/Disable tracking.
PDF Manager Manage templates for generated PDF

files.
Mobile Select modules to appear in the Mobile

applications.
OAuth Keys OAuth key management.
Sugar Updates Check for the latest available Sugar

version.
Import Wizard Import records easily into the system.
Upgrade Wizard (On-site only) Upload and install Sugar

upgrades.
Languages Manage which languages are available
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for users.
Search Select modules for the Global Search

and configure full-text searching.
Connectors Manage connector settings.
Scheduler Set up scheduled events.
Archive Records Archive data from active tables in the

system using the Data Archiver module.
Web Logic Hooks Configure actions to call out to code

hosted outside of your Sugar instance to
process specified actions.

Content Security Policy Settings Define the allowable content for iframe
fields and Web Page dashlets.

License Management Manage license properties.

System Settings

System Settings allows administrators to configure system-wide settings to your
organization's specifications. The system settings are split across a few different
panes of related information. Change the values in any of the panels and click
"Save" to preserve your changes.

User Interface

The User Interface pane consists of a group of settings that affect the interface of
Sugar. Use the following settings to configure the different aspects of the
interface:

Listview items per page: The maximum number of records to display per
list view results set, as well as the search results set on the View All
Results page for Global Search. By default, this is set to 20 records per
results set. If additional related records exist, click "More <Module
Name>..." (e.g., "More Accounts...") at the bottom of the list view.

Note: The recommended setting is below 50 for acceptable
performance levels. As additional fields are added to the list view,
this number should be at the lower end of the recommended
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setting.
Subpanel items per page: The maximum number of records to display on
a page in subpanels. By default, this is set to 5. If additional related records
exist, click "More <Module Name>..." (e.g., "More Accounts...") at the
bottom of the subpanel to load the next set.

Note: The recommended setting is no more than 25 with lower
values recommended when subpanels include many fields.

Allow Column Freezing: Enable this checkbox to allow users to freeze the
first column in list views, consoles, and dashlets so that the first column
remains visible when scrolling horizontally in the list of results. If disabled,
the option to freeze the first column is hidden from all views.
System Name: The name of this instance of Sugar (e.g., "My Company
CRM") that displays in the browser's title bar after the current page's title.

Show Full Names: Select this option to set the default value for new users
to display the full name of users instead of login names throughout Sugar.
Note: For instances that use SugarIdentity, when the OpenID Connect
authentication is configured, the User Name field will be populated with a
unique alphanumeric ID (e.g., User ID). So, it is recommended that the
Show Full Names option be enabled to avoid having the alphanumeric IDs
display in Sugar. 
Current Logo: The logo used in the left-hand corner of the header bar
when viewing Sugar in light mode.
Select Logo: Click "Choose File" to navigate to and select a new logo for
your system to show when users are viewing Sugar in light mode. Logo
dimensions should be 212x40 pixels, with the standard transparent
background color, in PNG or JPG format.
Current Dark Mode Logo: The logo used in the left-hand corner of the
header bar when viewing Sugar in dark mode.
Select Dark Mode Logo: Click "Choose File" to navigate to and select a
new logo for your system to show when users are viewing Sugar in dark
mode. Logo dimensions should be 212x40 pixels, with the standard
transparent background color, in PNG or JPG format.
Display Downloads Tab: Select this option to display the Download tab in
the User settings and provide users with access to Sugar plug-ins and other
available files. 

Lead Conversion Options: Select an option from the dropdown menu to
determine the handling of related activity records (e.g., calls, tasks, etc.)
during lead conversion. For more information, please refer to the Leads
documentation in the Application Guide.

Move: This option moves all of the lead's activities to the contact
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record created during conversion. For customers who are using 
Sugar integrated with Sugar Market, this option will also move any
related records from the following Sugar Market-specific modules:
Event Management, Landing Pages, and Web Activities.
Do Nothing: This option does not alter the lead's activities during
conversion. The activities remain related only to the lead. This is the
default setting.

Display actions within menus: Select to display detail view and subpanel
actions within a dropdown menu. If disabled, the actions will display as
separate buttons. 

Note: Only applies to legacy modules.
Collapse all subpanels and disable sticky feature: Select this option to
collapse all subpanels in the record view by default and disable
automatically expanding previously-expanded subpanels in order to
improve performance. Once enabled, users wishing to view subpanel data
will need to expand the subpanel each time they return to a module.

Note: Only applies to Sidecar modules.
Prevent user customizable subpanel layout: Select this option to
prevent users from dragging and dropping subpanels to a different location
in the detail view layout.

Note: Only applies to legacy modules.

Proxy Settings

Proxy servers redirect internet traffic coming from and to the server running
Sugar. If you are using a proxy server, you will need to enter proxy information
into the system settings to allow the Sugar instance to communicate with the
internet. This is necessary to allow the system licensing to validate and update. For
more information on system licenses, please refer to the License Management
section.

Note: Proxy settings are not available for instances hosted on Sugar's cloud
service.

Use the following settings to configure proxy settings:

Use Proxy Server?: Select this option to use a proxy server and to reveal
the following fields.
Proxy Host: The host name or IP address of the proxy server to use.
Port: The communication port of the proxy server.
Authentication?: Select this option if the proxy server requires
authentication and to reveal the following fields.
User Name: The user name to authenticate to the proxy server.
Password: The password to authenticate to the proxy server.
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Outbound Calling

If the Enable Click-to-Call setting is enabled, Sugar displays all stock and custom
fields that have a type of "Phone" as a link in Sidecar modules. Click the link to dial
the phone number using your default computer telephony integration software
(e.g., Zoom).

In Sugar Sell and Serve, if your instance is configured to use SugarLive and you
are logged in to Amazon Connect, clicking a phone number link dials it in
SugarLive instead.

Tweet to case

Tweet to case allows a user to convert a customer tweet shown in the Twitter 
Dashlet into a case record. Select "Enable Tweet® to case integration" to enable

this feature.

Preview Pane Settings

The preview edit feature allows users to edit records directly from the intelligence
pane on list views. Please note that the "Enable edit in Preview pane" setting is
enabled by default, but administrators can disable the preview edit feature based
on their organization's needs by removing the checkmark from the box. For more
information on using this feature, please refer to the User Interface page in the
Application Guide.
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Activity Streams

Sugar's activity streams are disabled by default, but administrators can globally
enable the functionality based on their organization's needs. To enable the activity
stream in Sugar, simply place a check in the Enable Activity Streams box. When
the feature is enabled, record posts will be generated in the system when
performing actions such as creating records, updating records, linking records,
unlinking records, etc. In addition, users will be able to access activity streams
from anywhere within Sugar including via the home page, My Activity Stream
dashlet, module's list view, etc. Please note that when the activity stream is
disabled, Sugar will display a message in each of these locations indicating that
the activity stream is not enabled. For the intelligence pane, the record's related
activity stream posts will not appear.  

SugarBPM™

The SugarBPM™ panel contains the following configurations for the visual process
designer and the SugarBPM engine:

Auto-save process definitions: In the visual designer, process definitions
are auto-saved every 30 seconds by default. This setting allows you to
adjust the time interval in 30-second increments up to 5 minutes. To
disable the auto-save feature, select "Never".
Auto-validate process definitions on auto-save: Enabled by default, this
option lets you decide whether Sugar should validate the open process
definition's design each time the auto-save function runs. If auto-save is
disabled, then enabling this feature will have no effect.
Auto-validate process definitions on import: Enabled by default, this
option lets you decide whether Sugar should automatically validate process
definition designs when they are imported as .bpm files.
Error Number of Cycles: Specify how many times a process can loop
before the system stops the process definition. By default, this is set to 10.
Please note that increasing the number of cycles could negatively affect
performance.

Comment Log Settings
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The Comment Log Settings panel contains a field that allows admins to configure
the maximum number of characters shown per comment log entry. If an entry is
longer than this value, it is truncated with a "Show more..." link to display the full
text. Once the entry is expanded, a "Show less..." link is displayed to collapse the
text so that only the configured number of characters is shown again. The default
value is 500 characters.

Advanced

The Advanced panel consists of the following group of settings for advanced
configuration of Sugar:

Validate user IP address: Select this option to validate the user's IP
address while accessing Sugar. If the IP address of a user changes in mid-
session, Sugar will log them out and force them to log back in for security
reasons. Please note that this setting is disabled by default out-of-the-box.

Note: Some high-availability systems, VPNs, and switching Wi-Fi
and wired connections may change IP addresses and thus cause
your users to be logged out when they have not changed their
configuration.

Log slow queries: Select this option to log queries that take longer than
the slow query time threshold. This is useful for performance debugging.

Note: There is an inherent overhead to logging slow queries. If the
threshold is set too low, it may cause performance issues.

Maximum upload size: Specifies the maximum file size in bytes that is
allowed to be uploaded to Sugar. This setting affects images, import files,
and module uploads.

Note: The file upload size is also dependent on the php.ini
upload_max_filesize and post_max_size directives. This admin
setting will not affect the maximum cumulative file size for email
attachments, which is set to 10MB per message via the
max_aggregate_email_attachments_bytes configuration attribute.

Portal Session Timeout: The maximum time in seconds of inactivity for a
Sugar Portal session. The session will timeout and the customer will be
logged out when the time limit is reached with no activity.
Note: This value is only used for legacy versions of Sugar Portal available
in 6.5 and older.
vCal Updates Time Period: Determines the number of months the
Free/Busy data is published to vCal. Specify the number of months in
advance of the current date that Free/Busy information for calls and
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meetings to be published. To turn Free/Busy publishing off, enter "0". The
maximum is 12 months.
Log memory usage: Select this option to log memory usage per action
performed in Sugar. The data will be stored in the ./memory_usage.log file.
Slow query time threshold (msec): Specify a threshold in milliseconds to
begin logging slow queries at. If "Log slow queries" is selected, queries that
take longer than the threshold to process will be logged. If you have
enabled the Tracker Queries option on the Tracker page, you can run the
pre-defined Slow Queries report to view slow queries.
Display stack trace of errors: Select this option to display where errors
occur in the application's stack trace. This option is for debugging purposes
and should not be left on in a production instance.
Developer Mode: Available for on-site instances only, enabling this option
will disable caching to immediately view changes made to language,
vardefs, and template files. This option is for debugging purposes and
should not be left on in a production instance.
Import - Maximum Number of Rows: Specify how many rows are
allowed within import files. If the number of rows in an import file exceeds
this number, the user will be alerted. If no number or zero is entered, an
unlimited number of rows are allowed.

Note: Header rows count towards the total number of rows in the
import file.

Prevent private team names from inheriting the user's name fields:
Select this option if private team names may be different from the user's
first and last name. By default, Sugar will update a private team name to
[Firstname Lastname] any time the corresponding user's profile is edited
and re-saved, even if the change was not made to the user's first or last
name. Enable this option to ensure that edited private team names do not
revert to the system default.

Logger Settings

Sugar comes with a built-in logging system to log information or errors that occur
in the application. By default, the logs are written to sugarcrm.log in the Sugar
root directory. If a problem arises, you can refer to the log file for information that
may help in troubleshooting the issue. The Logger Settings panel consists of a
group of settings that affect the Sugar logs. Please note that SugarCloud
customers can generate PHP error logs and access logs via the SugarCloud
Insights page. 

Note: The Logger Settings panel is hidden for instances on Sugar's cloud
service. Should you require a log level to be temporarily changed on a SugarCloud
production environment, you must open a support case. For more information
about default configuration settings for Sugar's cloud environments, please refer
to the SugarCloud Policy Guide. 
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Use the following settings to configure the different aspects of Sugar logging:

Log File Name: Specify a name for the log file. Defaults to sugarcrm.
Maximum log size: Specify the maximum size of the log file in megabytes
(MB). The default is 10MB. Once a log file reaches the specified size it is
renamed to have an incrementing number and a new file will be created to
contain new logs.
Log Level: Select the event level that you want to capture in the log file.
The levels are listed below in order of the most log records to the least. The
default level is fatal. When specifying a logging level, the system will create
log files for the specified level as well as higher levels. For example, if you
select "error", the system creates log files for "error", "fatal", and
"security". Please note that there is an inherent overhead to logging. If the
log level is set too high, it may cause performance issues. The "info" and
"debug" settings are not recommended for continuous use in a production
environment.

debug: Logs events that help debug the application
info: Logs informational messages
warn: Logs potentially harmful events
deprecated: Logs a function in the application that will be removed
in an upcoming release
error: Logs error events in the application
fatal: Logs severe error events that cause the application to abort
security: Logs events that may compromise the security of the
application
off: The logger will not log any events

Append after filename: Select a time period from the dropdown list to
append to the file name (None, Month_Year, Day_Month, Month_Day_Year).
This makes it easier to identify the log that you want to view.
Default date format: The date format for the log file. This format must be
supported by strftime. Defaults to %c.
Maximum number of logs (before rolling): The maximum number of log
files to save. When the number of log files exceeds this limit, Sugar deletes
the log file that was created first. Defaults to 10.

View Log

The Sugar log is stored in the root directory of Sugar and is accessible from the
operating system. Administrators who do not have access to the operating system
running Sugar do have the ability to view the log through Sugar. Navigate to
Admin > System Settings and find the "View Log" link at the bottom of the screen: 
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This opens the log viewer for the current log file. You have the following options
for navigating the log file:

All: Select this option to view the entire log.
Mark Point: Select this option to mark a starting point in the current log
file.
Refresh From Mark: Select this option to view any entries made in the log
after the most recent mark.
Next: Select this option to view new entries in the current log file.

 

A common method for utilizing these options to debug a problem would be to click
"Mark Point", perform the action causing problems, and then select "Refresh From
Mark" to see any log entries caused by the action being debugged.

You also have the ability to search within the log file for keywords. To perform a
search, simply enter a keyword into the search box and press Enter on your
keyboard to execute the search.

Locale

Locale allows administrators to configure localization settings to your
organization's specifications. Some of the settings specified here can be overridden
by user-level personalizations such as date and time formats on the User
Preferences page. The locale settings are split across a few different panels of
related information. Change the values in any of the panels and click "Save" to
preserve your changes.
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User Interface

The User Interface panel consists of a group of locale settings that affect the
interface of Sugar. Use the following settings to configure the different aspects of
the interface:

Date Format: Select a format from the dropdown for displaying the date
throughout the application.
Language: Select a default language from the dropdown for use
throughout the application. Users can select a different language from the
login page. For more information regarding enabling or disabling
languages, please refer to the Languages section.
Name Format: Select a format from the dropdown for displaying people
names throughout the application. You can specify any combination of
salutation, first name, and last name.
Time Format: Select a format from the dropdown for displaying the time
throughout the application.

Users have the ability to override the default date, time, and name formats through
their user profiles. For more information on how to set locale settings per user,
please refer to the Locale Settings section of the Getting Started documentation in
the Application Guide.

System Currency

The System Currency panel consists of a group of currency settings that affect the
interface of Sugar. The system currency is displayed in addition to a record's
original currency in most places across Sugar. The value is displayed in the system
currency with a grey box containing the value in the record's currency next to it.
However, the system currency can be overridden by the user's preferred currency
if "Show Preferred Currency" is enabled in their Locale Settings and the user's
preferred currency is different from the system currency. Use the following
settings to configure the different currency options:
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Currency: The name of the default currency your organization uses to
conduct business.
ISO 4217 Currency Code: The ISO code for the currency.

Note: This setting must be populated in order for the currency
(e.g., EUR) to display in the Quotes detail view. 

Decimal Symbol: The default decimal symbol.
Currency Symbol: The default symbol for the currency.
1000s Separator: The default delimiter to separate thousands.

Users have the ability to override the currency defaults through their user profiles.
For more information on how to set currency settings per user, please refer to the 
Locale Settings section of the Getting Started documentation in the Application
Guide.

Export Settings

The Export Settings panel consists of a group of export settings that affect
different aspects of exporting in Sugar. Use the following settings to configure the
different export options:

Export Delimiter: The delimiter used to separate fields while exporting
data. Defaults to a comma.
Disable export: Select this option to disable the export option for all users,
including administrators.
Default Character Set for Import and Export: Select a default
character set from the dropdown that handles the expected characters in
an import and export. Defaults to ISO-8859-1.
Admin export only: Select this option to disable the export option for
standard users, administrators will be allowed to export.

Users have the ability to override the default export delimiter and character set
through their user profiles. For more information on how to set export settings per
user, please refer to the User Preferences section of the Getting Started
documentation in the Application Guide.

Note: Locales that use character encoding other than ISO-8859-1 must specify the
appropriate character set.

Database Collation

The Database Collation panel only shows if running on a MySQL database and
contains an option to change the collation of the connection Sugar makes to the
database. Select the desired collation from the dropdown. Defaults to
utf8_general_ci.
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Note: Changing this setting will not change existing tables, but only new tables
going forward. If this setting does not match the collation of the current tables in
the database then the database will return errors when accessing those tables.

Currencies

Currencies allow administrators to create and manage currencies and exchange
rates in Sugar. The defined currencies in the system can be viewed in the
Currencies list view which can be accessed by selecting "Currencies" under the
System panel of the Admin page. Please note that the default system currency
(e.g., USD) will always display first in the Currencies list view. The default system
currency cannot be edited via the Currencies module and will need to be edited via
Admin > Locale. For more information on configuring the default currency, please
refer to the System Currency section.

Note: For additional information regarding the basics of performing common tasks
or operations (e.g., creating records, editing records, deleting records) in the
application, please refer to the User Interface documentation in the Application
Guide. 

To create a new currency in the system, simply click the Create button on the
upper right of the Currencies list view. Enter appropriate values for the fields in
the record view layout then click "Save".

Field Description
Currency Name The name or designation of the

currency.

                         135 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/


 

Note: The currency name auto-
populates based on the value entered in
the ISO 4217 Code field.

ISO 4217 Code The ISO code for the currency.
Note: This setting must be populated in
order for the currency (e.g., EUR) to
display in the Quotes module.

Currency Symbol The default symbol for the currency.
Note: The currency symbol auto-
populates based on the value entered in
the ISO 4217 Code field.

Conversion Rate The conversion rate to get to this
currency from the system's default
currency.

Status The current status of the currency (e.g.,
Active, Inactive).
Note: Selecting "Inactive" will remove
this currency from currency fields
throughout the application.

Updating Conversion Rates

Users may use the currencies defined in Admin > Currencies when populating any
currency amount field in stock or custom modules. When doing so, the exchange
rate for the selected currency is stored on the record itself. The conversion rate
stored on each record will update to match the current rate specified in Admin >
Currencies under the following scenarios:

The record undergoes a save event (e.g., mass update, manual save, etc.)
and the record's currency has a different conversion rate defined in Admin
> Currencies than is currently saved in the opportunity.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job that updates all records saved
with that currency to the new rate.

To keep closed-business amounts historically accurate, opportunity and quote
records will not update if they are in a closed status. For more information about
updating opportunity currency rates, please refer to the Opportunities
documentation in the Application Guide. For more information about updating
quote currency rates, please refer to the Quotes documentation in the Application
Guide.

Languages
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The Languages section allows administrators to configure which languages are
available for users to log in with. To disable a language, simply drag the language
from the Enabled Languages panel to the Disabled Languages panel and click
"Save".

Any languages in the Disabled Languages section will not be in the Languages
dropdown while logging in.

Search

Global search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. For more
information on how to use global search, please refer to the Global Search section
of the Search documentation in the Application Guide. The Search administration
settings allow administrators to configure, enable, and index full-text search.
Global searches in the desktop application and the SugarCRM mobile app will be
returned by full-text search.

Configuring Full-Text Search

Sugar's global search is enabled with full-text searching abilities that use the
ElasticSearch engine. Full-text search allows users to search throughout various
fields and modules for an enhanced search experience. In order for results to
return for a particular module, the module must be enabled on the Full-Text
Search Configuration page. To enable or disable a stock or custom module for
global search, simply drag and drop the module between the Enabled Modules or
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Disabled Modules column and click "Save".

Disabled modules will not be included in the global search results nor available to
select in the Modules list on the Global Search bar in the desktop application. For
more information on filtering the global search by modules, please refer to the 
Filtering by Module section of the Search documentation in the Application Guide. 

After enabling modules for Global Search, a full system index must be performed
in order for the module to appear in the search results. For more information on
performing a system index, please refer to the Indexing Full-Text Search section of
this documentation.

Individual module fields must be enabled for full-text search in the field attributes
via Studio > {Module Name} > Fields > {Field Name}. For more information,
please refer to the Studio documentation.

Note: Only modules enabled for Full-Text Search can be referenced in user posts
on the activity stream. For more information on referencing record's in posts,
please refer to the Activity Stream documentation in the Application Guide.

Activating Full-Text Search

Sugar's global search is enabled with full-text searching abilities using the
ElasticSearch engine. Full-text search (FTS) allows users to search throughout
various fields and modules for an enhanced search experience. Please note that
ElasticSearch is required to be set up when installing Sugar for on-site instances
and it is automatically enabled by default for instances on Sugar's cloud service.
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Use the following steps to configure full-text search:

1. The ElasticSearch server is selected by default for the System Type field.
Note: For more information on ElasticSearch, please refer to 
www.elasticsearch.org.

2. Enter the host name or IP address of the full-text search engine.
Note: Defaults to "localhost" assuming you are running the search
engine on the same server as Sugar.

3. Enter the port number for Sugar to connect to the search engine.
Note: Defaults to "9200", which is ElasticSearch's default port
number.

4. Click "Test" to verify that the settings are entered correctly and confirm
that Sugar connects to the search engine successfully.

A pop-up message will confirm if the connection was successful or not.
5. If the connection was successful, click "Save" to preserve your changes.

Each enabled module has a set of fields that are enabled for full-text searching by
default. Administrators can enable or disable specific fields for full-text search via
Admin > Studio. For more information on how to enable or disable fields for full-
text search, please refer to the Studio documentation.

Note: Once a new module or field is added to full-text search, you must perform a
system index in order for that field or module to be included in the full-text search
results.

Indexing Full-Text Search

Full-text search relies on an index of the records and data to be able to quickly
locate results. After enabling full-text search, or enabling a module or field, you
should perform a full index of your system.
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Note: System performance can be affected while the index is being performed. It
is recommended to run a system index during low usage or off-hours.

Use the following steps to perform a full system index:

1. Click "Schedule System Index".

2. A pop-up message will display warning of potential performance issues
during the index. Click "OK" to proceed.

3. The list of available full-text search modules will display. Simply select one
or more module(s) to perform the index. You may also select "All" to index
all full-text search enabled modules.

4. Select the checkbox to delete the current index data before the index
operation runs. If this is the first index being performed on the system, you
do not need to select this option. If you have added fields to a module's
index, then this checkbox should be selected or the new field may not show
in the results.

5. Click the Index button to schedule the index.
6. The next time the scheduler runs, it will rebuild the index based on the

selected options. For more information on schedulers, please refer to the 
Schedulers documentation.
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Note: The time and resources required to perform an index are directly
proportional to the number of modules selected for the indexing. It is
recommended that you choose only the modules that require indexing and perform
the index during low usage or off-hours.

Configuring Legacy Global Search

Legacy global search has been deprecated and is no longer applicable to any parts
of Sugar. To enable modules for global search in the desktop application or the
SugarCRM mobile app, use the Full-Text Search Configuration instead.

Content Security Policy Settings

Content Security Policy (CSP) directives are used by web browsers to control
which content (e.g., images, scripts) can be loaded on a web page. For more
information on CSP directives, refer to the Content Security Policy (CSP) guide on
the MDN Web Docs - Mozilla website. Sugar prevents any external web content
from loading in elements such as iframes and Web Page dashlets in your Sugar
instance until the system administrator adds the web domain (e.g.,
https://example.com) as a trusted site on the Content Security Policy Settings
page. Once added, users can then enter in the appropriate URL (e.g.,
https://example.com) in iframe fields and/or Web Page dashlets to load the content
in Sugar. For additional information on CSP settings and how to configure the
default-src in Sugar, refer to this SugarClub dev blog post.

Please note that the following CSP directives are defined in Sugar by default:

img-src: This directive has pre-defined source values of data:, http:, https:,
and blob: in Sugar.
object-src: This directive has a pre-defined source value of 'self' in Sugar. 

The Content Security Policy Settings page is broken into two tabs containing the
basic and advanced CSP directives. 

The Basic tab contains the following CSP fields:

 Trusted Domains ('default-src'): Enter the external domains or source
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values that will be allowed to load in iframes and/or Web Page dashlets in
Sugar.
Note: The values defined for default-src will apply to the following
directives if the corresponding field is empty under the Advanced
tab: connect-src, font-src, frame-src, script-src, and style-src. 
Trusted Parent Domains ('frame-ancestors'): Enter the parent website
domains or source values that will be allowed to load Sugar using an
<iframe>, <object>, or <embed> HTML element. For a list of the allowed
source values, refer to the CSP: frame-ancestors guide on the MDN Web
Docs - Mozilla website.

If this field is empty, then Sugar will only load in your parent
website domains and not in any other external website domains. 
The values defined for frame-ancestors do not apply to any other
CSP directives. 

The Advanced tab contains the connect-src, font-src, form-action, frame-src, script-
src, and style-src fields. These settings are intended for administrators with an
advanced understanding of the individual CSP directives and are familiar with how
to configure them for their business needs. For more information about these
directives, refer to the Content-Security-Policy guide on the MDN Web Docs -
Mozilla website.

Please note that there are some commonly used source values and domains that
are pre-defined by default in the system for the CSP directives such as: 

'self'
'unsafe-inline'
'unsafe-eval'
https://*.pendo.io
*.sugarcrm.com
*.salesfusion.com
*.salesfusion360.com
*.sugarapps.com
*.sugarapps.eu

Note: Any new value(s) added to the CSP Settings page will be appended to this
list as long as it does not already exist in the system. 

CSP Guidelines

To add new domains or source values, simply enter the appropriate value(s) in the
CSP fields (e.g., Trusted Domains ('default-src')), keeping in mind the following
guidelines:

Enter values in the CSP fields in Sugar using an acceptable format (e.g.,
https://www.example.com, http:, https:), as covered in the section below.
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Separate multiple values in the CSP field in Sugar using whitespace.
Enter non-latin domain names in punycode format for CSP fields in Sugar.
For more information on punycode, refer to the Punycode article on the
Ionos website.
If you enter a value (e.g., 'self') that is already defined as a trusted domain
or source value in Sugar, the value will be disregarded as it already exists
in the system.
The values defined for default-src will apply to the following CSP directives
if the CSP field (e.g., frame-src) is empty in Sugar: connect-src, font-src,
frame-src, script-src, and style-src. 
Note: The default-src values do not apply to the form-action and frame-
ancestors directives.
If you define a value in the advanced CSP directives (e.g., font-src, frame-
src) in Sugar, then this value will supersede any value(s) entered in the 
Trusted Domains ('default-src') field.
If the form-action field is empty in Sugar then any supported source value
will be allowed for this directive.
The values defined for frame-ancestors do not apply to any other CSP
directives in Sugar.

Once the appropriate values have been entered, click "Save" to preserve your
settings. Please note that users who are logged in to Sugar at the time of the CSP
change will need to refresh their browser for the changes to take effect in their
session.  

Supported Source Values

The table below covers the source values that are supported in Sugar for CSP.
When entering values such as 'unsafe-hashes', http:, and https: please make sure
to enter the value as-is in the CSP directive fields. Some examples of acceptable
formats for URLs are: https://www.example.com, *.example.io, *.example.gov,
*.com, and https://*.example.com. Entering a URL such as https://example will
result in an error as it is missing the top-level domain (e.g., .com, .io, .org).

Note: The information in this table has been adapted from the CSP Quick
Reference Guide on the Content Security Policy website. 

Source Value Description
* Wildcard, allows any URL except data:

blob: filesystem: schemes
'self' Allows loading resources from the same

origin (same scheme, host and port)
data: Allows loading resources via the data

scheme (e.g., Base64 encoded images)
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domain.example.com Allows loading resources from the
specified domain name

*.example.com Allows loading resources from any
subdomain under "example.com"

https://example.com Allows loading resources only over
HTTPS matching the given domain

https: Allows loading resources only over
HTTPS on any domain

http: Allows loading resources only over
HTTP on any domain

'unsafe-inline' Allows use of inline source elements
such as style attribute, onclick, or script
tag bodies (depends on the context of
the source it is applied to)
and javascript: URIs
Note: Not supported for frame-
ancestors directive. 

'unsafe-eval' Allows unsafe dynamic code evaluation
such as JavaScript eval()
Note: Not supported for frame-
ancestors directive.

'unsafe-hashes' Allows you to enable scripts in event
handlers (e.g., onclick). Does not apply
to javascript: or inline <script>.

Please note that the following source values are not supported in Sugar and will
result in an error if entered on the CSP Settings page:

'none'
'nonce-'
'sha256-'
'strict-dynamic' 

License Management

The License Management section allows administrators to edit and revalidate their
Sugar license as well as view information such as the download key, expiration
date, number of users, etc. Refer to the License Management page for more details
on working with license keys and license types.

Connectors
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The connector settings page allows administrators to configure and manage the
various types of connectors to external data sources that integrate with Sugar. A
number of different connectors (e.g., Citrix GoToMeeting) come out-of-the-box with
Sugar and are enabled by default to allow users to easily view external data via
their instance.

Please note that connectors can be disabled and configured accordingly via Admin
> Connectors. Developers in your organization can also create connectors to other
data sources, which can be uploaded via Module Loader. For more information on
how to upload and install packages in Sugar, please refer to the Module Loader
documentation. You can also search for other available connectors via Sugar
Exchange (https://sugarexchange.sugarcrm.com).

Note: Sugar Sell Essentials customers do not have the ability to upload custom file
packages to Sugar using Module Loader.

Setting Connector Properties

Many connectors use web services and require certain connector properties (e.g.,
API Key, API Secret) to be configured prior to use. To configure the connector
properties, simply click the Set Connector Properties button on the Connector
Settings page.

The Set Connector Properties page displays a tab for each connector that must be
configured in order to use in Sugar. The tabs will include the necessary steps or a
link for you to obtain the information (e.g., API Key, API Secret) needed to set up
the connector. Once the necessary information has been entered, click "Save" to
preserve your settings.

The following connectors and their properties are available to configure:
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Connector Property Description
Twitter API Key The API Key provided by

Twitter
API Secret The API Secret provided

by Twitter
Microsoft Client ID The Client ID provided by

Microsoft
Client Secret The Client Secret provided

by Microsoft
Google Client ID The Client ID provided by

Google
Client Secret The Client Secret provided

by Google
Dropbox Client ID The Client ID provided by

Dropbox
Client Secret The Client Secret provided

by Dropbox
GoToMeeting Consumer Key The Consumer Key

provided by GoToMeeting
IBM SmartCloud OAuth Consumer Key The OAuth Consumer Key

provided by IBM
OAuth Consumer Secret The OAuth Consumer

Secret provided by IBM
DocuSign Environment Set to demo when testing

the app in DocuSign's
demo environment and set
to production once the
app has gone through
DocuSign's go-live
process.

Integration Key The Integration Key
provided by DocuSign

Client Secret The Secret Key provided
by DocuSign

Please note that Sugar's WebEx integration is configured via the External Accounts
tab of the user's profile. Since WebEx does not have global properties to configure,
it will not appear on the Set Connector Properties page. 

For more information on configuring the WebEx application, please refer to the 
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Getting Started documentation in the Application Guide.

Enabling Connectors

In order to utilize the connectors in Sugar, administrators should ensure that they
are enabled properly. Please note that certain connectors are enabled for the
entire application while some allow you to enable specific modules for the
connector. Simply click the Enable Connectors button on the Connector Settings
page to configure the modules that should be enabled for certain connectors.

The Enable Connectors page will display a tab for each connector that is available
in your Sugar instance. Connectors, where you can enable specific modules for,
will display the Enabled and Disabled columns where you can drag and drop the
desired module from the Disabled column to the Enabled column. Please note that
you can enable the connector for any modules (e.g., Accounts, Contacts) that have
a standard record view (for Sidecar modules) or detail view (for legacy modules)
layout in Sugar.

Mapping Connector Fields

Some connectors query external services based on fields in Sugar. These mappings
can be customized to use different fields based on your organization's needs. To
configure the field mappings, simply click the Map Connector Fields button on the
Connector Settings page.

The Map Connector Fields page has a tab for each connector that has field
mappings available. Each of the enabled module(s) will display the connector fields
and will need to have the corresponding Sugar field selected from the dropdown
list. If the connector is enabled for multiple modules, be sure to select the proper
fields for each module. Once the field mapping is set up properly, click "Save" to
preserve your changes.

Please note that the connector fields may not always match up with a stock field in
Sugar. If you wish to capture and map certain fields from the connector to Sugar,
you will need to create new fields via Admin > Studio. For more information on
how to create fields in Studio, please refer to the Studio documentation.

Managing Connector Search
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Connectors that have multiple fields for mapping need to specify which fields are
to be used when searching for data in the module. To designate the connector
fields for search, click the Manage Connector Search button on the Connector
Settings page. Please note that there are no connectors that come out-of-the-box
with Sugar that have search fields defined, so no connectors will be available to
configure on this page.

The Manage Connector Search page will normally display a tab for every
connector that needs connector fields defined for search. The available search
fields are limited to the input parameters of the connector being used. To enable a
field for search, simply drag and drop the desired field from the Available column
to the Default column. Once the necessary field(s) have been selected, click "Save"
to preserve your changes.

OAuth Keys

OAuth is an open standard for authorization that enables users to share private
resources stored on one site with another site without divulging personal
credentials such as user name and password. OAuth works with a public consumer
key and a private consumer key. Together, these keys identify which application
connects to the service. It is the choice of the Sugar administrator to decide how
many different keys to have and whom to give them to. Please refer to the User
Interface documentation for more information on working with the OAuth Keys
module and performing actions such as searching, editing, and deleting records.

Note: The system generated OAuth Support Portal Key cannot be modified and
should not be deleted.

OAuth Keys Fields

The OAuth Keys module contains a number of stock fields that come out-of-the-box
with Sugar. The following definitions are suggested meanings for the fields, but
the fields can be leveraged differently to best meet your organization's needs.

Field Description
Consumer Key Name The name or designation of the OAuth

Key.
Consumer Key Public key. A user name is a suitable

consumer key value.
Consumer Secret Private key. A password is a suitable

consumer secret value.
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Note: The private key is not sent when
making a connection.

OAuth Version The version of the OAuth
protocol/framework to use. (OAuth 1.0,
OAuth 2.0)

Description A description or other information about
the OAuth key.

Creating OAuth Keys

There are various methods for creating OAuth keys in Sugar including via the
OAuth Keys module and via duplication. The full edit view layout opens when
creating the OAuth keys directly from the OAuth menu and includes all of the
relevant fields for your organization's OAuth keys. The quick-create form is a
shortened version of the OAuth Keys edit view and typically contains fewer fields.

Creating via OAuth Keys Module

One of the most common methods of OAuth key creation is via the Create OAuth
Key option in the OAuth Keys module tab. This opens up the edit view layout which
allows you to enter all the relevant information for the OAuth key.

Use the following steps to create an OAuth key via the OAuth Keys module:

1. Navigate to Admin > OAuth Keys.
2. Click the three-dots menu in the OAuth Keys module tab and select "Create

OAuth Key".

3. Enter appropriate values for the Fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

4. Once the necessary information is entered, click "Save".

Creating via Duplication
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You can also create a new OAuth key by duplicating an existing record. The
duplicate option is useful if the key you are creating has similar information to an
existing OAuth key.

Note: The system-generated OAuth Support Portal Key cannot be duplicated.

Use the following steps to create an OAuth key by duplicating an existing record:

1. Navigate to an OAuth key record's detail view.
2. Select "Duplicate" from the Actions menu.

3. The displayed edit view is pre-populated with the original key's values.
Update the necessary fields, then click "Save".

Note: Consumer Key and OAuth Version fields cannot be edited after
creation. If either of these fields needs to be changed, you must create a
new OAuth key.

Tokens

Beneath an OAuth key record's fields is a subpanel containing related token
records. Tokens are created when the user establishes an OAuth connection with
the OAuth key pair. These are connections between the Sugar user, the OAuth
keys, and the permissions to enable the external application to access data. Tokens
created for each OAuth connection are listed in the Tokens subpanel of the
corresponding OAuth Keys detail view page. The Tokens subpanel can be collapsed
or expanded by clicking the double arrow to the left of the subpanel's name.
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To delete a token from an OAuth key, choose "Delete" from the far right of the
record's row.

Sugar Updates

The Sugar Updates page allows administrators to check for the latest available
Sugar versions. By default, Sugar automatically checks for updates on a periodic
basis to see if any version updates are available for your instance. If a new version
update is available, the Sugar Updates link in the Administration page will appear
red and display the latest Sugar version next to it. Administrators can uncheck the
automatic updates option in the Sugar Updates page if they do not wish to have
the system automatically check for updated version releases.

Use the following steps to perform a manual check for Sugar updates:

1. Navigate to Admin > Sugar Updates.
2. Click the Check Now button to see if a new update of Sugar is available.

If there is an available version update, a message will appear below the Check
Now button with the latest version along with a message to visit
store.sugarcrm.com/download to retrieve and download the latest version. Please
note that clients hosted on Sugar's cloud service are normally upgraded by the
SugarCRM team on a predetermined schedule as releases are made available. On-
Site clients will need to perform the upgrade themselves as Sugar is hosted on
their servers. If the system detects that you have the latest version of Sugar, then
the message will inform you that you have the latest version available.

Import Wizard

Import Wizard allows administrators to launch an import for any import enabled
module without navigating to the module itself. After selecting "Import Wizard"
from the Admin menu, you can select a module to perform an import on.
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After selecting the module, click "Next" to continue the import. The steps to
complete the import are identical to performing an import from the module. For
more information on how to perform an import, please refer to the Import
documentation in the Application Guide.

Upgrade Wizard

The Upgrade Wizard allows on-site customers to upgrade their Sugar instance to
the latest software version. The Upgrade Wizard is only available for
administrators of on-site installations. For steps to complete an on-site upgrade
using the wizard, please refer to the Installation and Upgrade Guide for your on-
site version of Sugar.

Repair

Repair allows administrators to perform common maintenance routines on their
instance of Sugar. The repair menu is available to only administrative users and
can be accessed through Admin > Repair.

For more information on the different repair options available, please refer to the 
Repair documentation in the Administration Guide.

Diagnostic Tool

Diagnostic Tool allows administrators to create a file with many diagnostic and
configuration details. This tool will collect basic system information regarding
Sugar and server configuration and place it all into a zip file to help debug or
diagnose issues. For more information on the diagnostic tool in Sugar, refer to the 
Introduction to the Diagnostic Tool article. The Diagnostic Tool has options that
you can turn on and off to include only specific configuration data. Select one or
more of the following available options:

Option Description
SugarCRM config.php Includes a copy of the config.php file

from the root directory of Sugar. This
file contains many useful system
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settings options in Sugar.
Note: The database password contained
in this file is replaced with asterisks
before sending for security purposes.

SugarCRM Custom directory Includes a copy of the entire custom
directory in Sugar

Phpinfo() Includes the output of the PHP function
phpinfo() saved to an HTML file. The
phpinfo() function returns information
about how PHP is configured on the
server running Sugar including the
version of PHP, the loaded Extensions,
and more.

MySQL - Configuration Table Dumps Includes an HTML file for each
configuration table in Sugar. The file
has three sections: field definitions,
indexes, and data.

MySQL - All Tables Schema Includes an HTML file titled
MySQLTablesSchema.html which has
two sections for each table in Sugar:
field definitions and indexes.

MySQL - General Information Includes an HTML file titled MySQL-
General-info.html. This file contains
some basic information about the
MySQL database Sugar is running on
such as version number and character
sets.

MD5 info Includes a PHP file that shows any file
in your instance of Sugar that has a
different hash than the stock file. This
can indicate which files are customized
and where they are located in your file
system.

Copy files.md5 Includes the list of all files and their
original MD5 hash in a file titled
files.md5
Note: Only available when the MD5 info
option above is selected.

Copy MD5 Calculated array Includes the list of all files and their
current hash in a PHP file titled
md5_array_calculated.php
Note: Only available when the MD5 info
option above is selected.

                         153 / 829



 

BeanList/BeanFiles files exist Includes an HTML file titled
beanFiles.html. This file contains a list
of the modules in Sugar and checks all
the references for that module to make
sure they are correct.

SugarCRM Log File Includes a copy of the current log file
for Sugar.

Sugar schema output (VARDEFS) Includes an HTML file titled
vardefschema.html which contains
detailed metadata on each table in
Sugar.

The more options selected, the bigger the resulting zip file will be. Select the
desired options and click "Execute Diagnostic".

Once the diagnostic tool is finished, select "Download the diagnostic file" to
download the zip file containing the results to your computer.
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Optionally, you can then select "Delete the Diagnostic file" to remove it from the
server. Large diagnostic files should be deleted from the server as they can pile up
and take necessary disk space.

Tracker

Tracker allows administrators to configure the system to track certain user actions
and information for Sugar modules. This information is used in tracker reports and
dashlets. By default the tracker options are disabled.
Use the following options to record tracker data:

Tracker Actions: Tracks user actions such as modules accessed and
records saved.
Tracker Sessions: Tracks active users' session data such as session
length.
Tracker Performance: Tracks system performance such as database
round trips, number of files accessed, server response time, and memory
usage.
Note: This option can cause performance issues and should not be enabled
in a production environment.
Tracker Queries: Tracks any query that takes longer than the specified
slow query time threshold and saves the data to the database. Tracker
queries logs the query, how many times it has been run, the last time ran,
and the average seconds the query took. "Log slow queries" also needs to
be selected before this option tracks data.
Note: This option can cause performance issues and should not be enabled
in a production environment.
Log slow queries: Select this option to log queries that take longer than
the slow query time threshold to the sugar log. This is useful for
performance debugging.
Note: This option can cause performance issues and should not be enabled
in a production environment.
Number of days of Tracker data to store when Scheduler prunes the
tables: Specify the number of days of data to be retained. The Prune
Tracker Tables scheduler will remove any tracker records older than the
specified number of days. For more information on the Prune Tracker
Tables scheduler, please refer to the Prune Tracker Tables section of the
Scheduler documentation in the Administration Guide.
Slow query time threshold (msec): Specify a threshold in milliseconds to
begin logging slow queries. If "Log slow queries" is selected, queries that
take longer to process than the threshold duration will be recorded in the
Sugar Log. If "Tracker Queries" is selected, queries will be logged to the
database.

Select the desired settings and click "Save" to preserve your changes.
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Note: Changing the Log slow queries and Slow query time threshold values will
also change them in Admin > System Settings.

Scheduler

Scheduler provides administrators with a method to automate the execution of
custom and system processes. The Scheduler menu is available to only
administrative users and can be accessed through Admin > Scheduler.

For more information on the different schedulers available, please refer to the 
Schedulers documentation in the Administration Guide.

PDF Manager

PDF Manager allows administrators to create and manage templates for generated
PDF files for any deployed module, custom or standard. The PDF Manager is
available to only administrative users and can be accessed through Admin > PDF
Manager.

For more information on the PDF Manager, please refer to the PDF Manager
documentation in the Administration Guide.

Mobile

The Mobile settings on the Administration page allow administrators to configure
what modules they want enabled or disabled for the SugarCRM mobile app and the
browser-based SugarCRM mobile application. In addition, you can enable the
mobile offline capability for your instance for the mobile app.

The browser-based mobile application allows users to access various Sugar
modules (stock and custom modules) via a web browser on a smartphone or PDA.
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The SugarCRM mobile app is a native mobile application that enables users to
access Sugar from mobile devices. For a list of supported devices for the mobile
app, please refer to the Mobile Supported Platforms page.

You can add, edit, and remove fields, including Calculated Value fields, to
customize the mobile layouts via Admin > Studio. For more information on
configuring fields, please refer to the Fields section of the Developer Tools
documentation. For more information on configuring the mobile layouts, please
refer to the Mobile Layouts section of the Developer Tools documentation.

Note: Calculated Value fields will not be updated in real-time for mobile edit view
layouts.

Configuring the SugarCRM Mobile App

You can configure which modules are available for use in the SugarCRM mobile
app via Admin > Mobile. Please note that the Bug Tracker, Campaigns, Products,
and Targets modules are not available for the mobile app. For more information on
enabling modules for the mobile app, please refer to the Enabling Modules for
Mobile Access section of this documentation.

Configuring Mobile Browser Access

The modules enabled for use via Admin > Mobile will also apply to the browser-
based mobile application. For more information on enabling modules for the
browser-based mobile application, please refer to the Enabling Modules for Mobile
Access section of this documentation. Please note that the Reports module is not
available for the browser-based mobile application.

Enabling Modules for Mobile Access

Use the following steps to enable modules for mobile access:

1. Navigate to Admin > Mobile.
2. To enable a module for the browser-based and native SugarCRM mobile

application, drag and drop the module from the Disabled Modules column
to the Enabled Modules column.

3. To disable a module, drag and drop the module from the Enabled Modules
column to the Disabled Modules column.
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4. Click "Save" to apply the changes made to the SugarCRM mobile app and
the browser-based mobile application.

Enabling Offline Mobile Access

You can also allow mobile offline capabilities for your instance in the SugarCRM
mobile app by marking the "Offline enabled" checkbox in Admin > Mobile.
Enabling offline access allows the user's mobile device to cache records for offline
viewing as well as buffer changes they make to records while offline. The changes
made will be synced once they are reconnected. Please note that the offline option
must be enabled in Sugar first before users can enable the offline capabilities on
their devices. For more information on enabling offline access for mobile devices,
please refer to the SugarCRM Mobile App User Guide.
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Repair

Overview

The repair functions in Sugar allow administrators to perform common
maintenance routines on their instance of Sugar. The repair menu is available to
only administrative users and can be accessed through Admin > Repair. The
following sections are available options from the repair menu.

Quick Repair and Rebuild

The quick repair and rebuild is the most commonly used repair option and should
be performed after significant changes have been made to your instance of Sugar.
If you notice inconsistencies with module layouts or fields as you have customized
them via Studio, this option is normally the best first course of action to try and
correct the issue. Sugar caches files to help access necessary files quickly. This
option clears out many of the cached files in Sugar which allows new versions of
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the files to be loaded. The quick repair and rebuild option performs the following
actions:

Clear Vardefs From Cache: Deletes any *vardefs.php file in the cached
modules folder
Clear Language Files From Cache: Deletes any {Module
Name}.lang.php file in the cached modules folder
Clear Template Files From Cache: Deletes any *.tpl files in the cached
modules folder
Clear JavaScript Files From Cache: Deletes any *.js files in the cached
modules folder
Clear JavaScript Language Files From Cache: Deletes any *.js files in
the cached jsLanguage folder
Clear Dashlet Files From Cache: Deletes any *.php files in the cached
dashlets folder
Clear Sugar Feed Files From Cache: Deletes the Sugar Feed files in
cached modules folder
Clear Smarty Template Files From Cache: Deletes any *.tpl.php files in
the cached smarty templates folder
Clear Theme Files From Cache: Deletes theme files in the cached theme
folder for all themes in Sugar
Clear XML Files From Cache: Deletes any *.xml files in the cached xml
folder
Clear Search Files From Cache: Deletes the unified_search_modules.php
file in the cached module folder
Clear External API Cache Files: Deletes the external API cache PHP and
JavaScript files in the cached include folder
Clear Additional Cache Files: Loops through the cached API folders and
deletes any *.php files as well as the cached clients folder
Clear PDF Font Cache Files: Deletes the cached PDF font list file
Rebuild Extension Files: Rebuilds language files, extensions, dashlet
containers, relationships, and the table dictionary; this step also clears any
cached files by APC or WinCache, resets the Zend accelerator, clears
eAccelerator's cache, and clears XCache cached files
Note: These functions will only run if the associated systems are installed
and running.
Rebuild Audit Tables: Creates audit tables for any module that has audit
enabled and where the audit table does not already exist; the results for
each table are printed on the page
Repair Database Tables: Checks to make sure the database is in sync
with the table dictionary and vardef files; any missing tables, columns, and
indexes will be scripted to be recreated as well as any column properties
that are incorrectly set in the database. The screen will display any
database changes that should be made. Click "Execute" to execute the
script to apply the changes to the Sugar database or click "Export" to save
the script to a SQL file.
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Upgrade Teams

The Upgrade Teams option performs some cleanup regarding team records in
Sugar. This can be useful to restore the private teams for all users in the event
they become corrupted or are removed for any reason. The upgrade teams option
performs the following actions:

Global Team: Creates or restores the global team if it does not exist or has
been deleted. All users are then assigned to the global team if not already.
Private Teams: Creates a private team for every user in the system that
does not already have a private team and assigns the user to their private
team.

The results are printed on the screen as to what teams already existed and what
teams were created.

Rebuild .htaccess File

Rebuild .htaccess File option creates or updates the .htaccess file in the root of the
Sugar directory. The .htaccess file contains specific commands to prevent
unauthorized access to certain files and directories on your webserver. File
permissions need to be configured correctly in order for Sugar to write to the
.htaccess file. If writing to the file fails, the expected contents for the file will be
printed on the page.

Note: If you have additional lines to add to the .htaccess file, place them outside of
the "# BEGIN SUGARCRM RESTRICTIONS" and "# END SUGARCRM
RESTRICTIONS" lines or they will be removed when running this repair function.
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Rebuild Config File

The Rebuild Config File option takes the config.php file in the root directory of
Sugar and rebuilds it to have all default values for any options not specified
directly. It first runs a check to make sure Sugar can write to the config.php file
and will return to you if it can or not. When ready to rebuild the config file select
"Rebuild".

The default values for the config will be merged with any custom values currently
set and will be loaded into the config.php file.

Rebuild Sugar Logic Functions

The Rebuild Sugar Logic Functions rebuilds the cache files for all Sugar logic
functions in the system. The Sugar logic functions are primarily used as formulas
in field definitions. The results of the repair are shown on the screen.

Rebuild Relationships

Rebuild Relationships clears out the relationship cache and data and rebuilds it
from the vardef files. Custom and stock relationships are all rebuilt. This repair
option is good to run after an upgrade or when installing or uninstalling custom
modules. The results of the repair are shown on the screen.

Rebuild Schedulers

The Rebuild Schedulers option removes all schedulers and recreates scheduled
jobs that come with Sugar by default. If you have customized the Active/Inactive
flag, the frequency the job runs, or even deleted a job, this repair option will
restore all settings back to their original default value and recreate any deleted
default schedulers. For more information on schedulers and their default settings,
please refer to the Schedulers documentation.

Note: This also deletes any custom schedulers added to Sugar. If you have made
changes to the default schedulers or created custom schedulers, please backup the
details of each scheduler before running this repair. 
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Rebuild WorkFlow

Rebuild Workflow deletes files in the custom workflows folder for each module and
then rebuilds the files from the workflow data in the database. This repair also
verifies the proper logic hooks are in place to properly fire the workflows and
rebuilds any plug-ins that are installed.

Rebuild Javascript Languages

The Rebuild Javascript Languages function deletes all files in the cached
jsLanguage folder and deletes any {Module Name}.lang.php file in the cached
modules folder. The cached files will be rebuilt when they are needed.

Rebuild JS Grouping Files

Rebuild JS Grouping Files takes the many different JavaScript files that are
required with Sugar and concatenates them together into the cache directory.

Note: The process will continue working if you navigate away from this page, but
if you wait you will see a notification on the page when it is complete.

Rebuild Sprites

Rebuild Sprites takes images in the following directories:

./include/images

./themes

./custom/themes

Creates the sprites and metadata files in the ./cache/sprites/ folder.

Note: The process will continue working if you navigate away from this page, but
if you wait you will see a notification on the page when it is complete.

Repair Non-Lowercase Fields

The Repair Non-Lowercase Fields option takes any custom field defined in Sugar
and, if the field contains an upper case letter, it will change the field to be
lowercase. The database, vardef files, and views are all searched through and
corrected for and uppercase fields. This option also clears any vardef files from the
cache when finished.

Repair Teams
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The Repair Teams option runs a quick check against the database for every user. It
performs the following checks:

Users not in the global team
Users who do not have a private team
Users who are not a member of a team that a user who reports to them is a
member of

If any of the checks return true, the page will indicate that records were found and
the associated action will be selected by default. Select the options you wish to
perform and click "Rebuild".

The selected options will perform the following:

Rebuild access to global team: Create a global team if one does not exist
and loops through every user and adds them to the global team.
Rebuild access to private team: Loops through every user and creates a
private team if one does not exist, and then adds the user to their private
team.
Rebuild team hierarchy: Loops through every user and makes sure every
manager is included in their employees' teams. This ensures that if Sally
reports to Jim, that Jim can see all of Sally's records.
Note: Sugar prevents a loop from being created via the Reports To field.
For more information on setting the Reports To field, please refer to the 
User Management documentation.
Clean up unused combinations of teams: Searches the database for
unused combinations of teams and deletes the records from the database.

The users looped through are displayed on the screen when complete.

Repair Roles

Repair Roles goes through every ACL enabled module and ensures that there are
appropriate database records to allow roles to be used on the specified module.
This repair is important to run after adding new modules via Module Loader or
Module Builder to make sure all of the role options are available for the new
module. If there is a module that has ACL enabled for it, but the module does not
show in the Roles section, then this repair option will add the module. The results
of the modules accessed are printed on the screen.
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Repair Inbound Email Accounts

Repair Inbound Email Accounts loops through every active inbound email account
in Sugar and verifies the settings configured. Any Inbound email account that fails
to successfully repair will be listed on the page and will require someone to
manually repair them by reentering a valid user name and password.

Remove XSS

The Remove XSS repair loops through the database and removes any malicious
scripts from specified field types. Select a module from the dropdown, or select
"All" to run for all modules.

The page will then display the count of records that will be scanned, and repaired
if necessary. Click "Execute" to being the repair.

You will see the count of Object(s) Repaired incrementing as it is running. Once
the repair is complete you will get a popup message saying "Done." and the count
repaired should match the count of objects found.

Repair Activities

Repair Activities takes Call or Meeting records where the status field does not
equal "Held" and updates the end date based on the duration of the activity. If the
status equals "Held" or the record is marked as deleted, this repair will skip it. The
screen will show "Done" when complete.
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Enable/Disable Seed Users

The Enable/Disable Seed Users option will either enable or disable the default
users that are installed with Sugar when selecting a demo installation. If the first
seed user retrieved from the database is set to "Active" then this option will give
you the option to "Deactivate" the seed users, otherwise, you have the option to
"Activate" the seed users.

This option will set the status based on the option presented for all users that have
an id that starts with "seed".

Note: If you did not populate Sugar with demo data when installing, this repair
will return "No seed users" and will not do anything.

Clear Additional Cache

The Clear Additional Cache option loops through the cached API folders and
deletes any *.php files as well as the cached clients folder. This option is also
performed by the Quick Repair and Rebuild option. The screen will show "Done"
when complete.

 

Schedulers

Overview

Schedulers in Sugar provide users with a method to automate the execution of
custom and system processes. Sugar comes with many default schedulers to
perform jobs such as monitoring inbound emails, executing workflows, running
reports and dispatching campaign emails. Schedulers are available only to
administrative users and can be accessed through Admin > Schedulers. 

Schedulers Fields

The Schedulers module contains a number of stock fields that come out of the box
with Sugar. The following definitions are suggested meanings for the fields, but
the fields may be leveraged differently to best meet your organization's needs.

Field Description
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Active From Time the scheduler begins to be active
per day.

Active To Time the scheduler stops being active
per day.

Date & Time End Date and Time the scheduler will stop
running on the specified interval.

Date & Time Start Date and Time the scheduler will begin
running on the specified interval.

Execute If Missed Specifies if a scheduler should be
executed during the next cron run in the
event that cron did not run at the exact
time a job is scheduled for.

Interval How often and when the schedule will
run, defaults to every day, every minute.

Job The job to execute on the defined
schedule.

Job Name The name or designation of the
scheduler.

Status The current status of the scheduler (i.e.,
Active, Inactive).

Note: Any times configured for schedulers will be based on the admin user's time
zone (user id = '1').

Default Schedulers

The default schedulers that packaged with Sugar are required for different
activities throughout the application. The following lists the default schedulers and
their default settings:

Name Interval Status
Activity Stream Purger On the hour; 04:00;

Sunday
Inactive

Check Inbound Mailboxes As often as possible. Active
Clean Jobs Queue On the hour; 05:00am Active
Create Future
TimePeriods

On the hour; 11:00pm Active

Elasticsearch Queue
Scheduler

As often as possible. Active

Process Time-Aware On the hour Active
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Schedules
Process Workflow Tasks As often as possible. Active
Prune Database on 1st of
Month

On the hour; 04:00am; 1st Inactive

Prune Old Record Lists As often as possible Active
Prune Tracker Tables On the hour; 02:00am Active
Publish approved articles
& Expire KB Articles

On the hour; 05:00am Active

Rebuild Denormalized
Team Security Data

Every 15 minutes Inactive

Remove diagnostic tool
files

On the hour; 04:00am;
Sunday

Active

Remove temporary files On the hour; 04:00am Active
Remove temporary PDF
files

On the hour; 04:00am Active

Run Active Data
Archives/Deletions

On the hour; 10:00PM;
Saturday

Active

Run Email Reminder
Notifications

As often as possible. Active

Run Nightly Mass Email
Campaigns

On the hour; From
02:00am to 06:00am

Active

Run Nightly Process
Bounced Campaign Emails

On the hour; From
02:00am to 06:00am

Active

Run Report Generation
Scheduled Tasks

On the hour; 06:00am Inactive

Sugar Heartbeat On the hour; 04:00am Active
SugarBPM™ Scheduled
Job

As often as possible. Active

Update tracker_sessions
Table

As often as possible. Active

SugarBPM Scheduled Job

The SugarBPM Scheduled Job is responsible for processes associated with the
SugarBPM automation suite. It is active and runs as often as possible by default.
The SugarBPM Scheduled Job will check for any active time-based process events
in a pending state. If any processes meet this criterion, the scheduler will ensure
the process flow continues. For more information about SugarBPM, please refer to
the SugarBPM documentation.
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Note: SugarBPM events processed by this scheduler will be run by the admin user
(user id = '1') in Process History unless the admin user is disabled.

Activity Stream Purger

The Activity Stream Purger scheduler can help manage the number of activity
stream records in the database. The scheduler is inactive by default with an
interval set to run weekly on Sundays at 4:00 AM when enabled. As your company
uses Sugar, the number of activity records will grow considerably over time which
can result in performance degradation. For this reason, it is strongly
recommended to enable the scheduler and set it to run during off-peak hours or at
least once a week to prune older records from the activities table. By default,
the scheduler will remove records that are older than 6 months as of the current
date from the activities table, and 25,000 records will be removed per scheduler
job run. Please note that user posts, comments, and attachments are preserved but
all other activity stream records generated from field updates, new record
creation, linking/unlinking records will be removed by the scheduler.

You can modify the following Sugar configuration settings if you wish to change
the values: 

$sugar_config['activitystreamcleaner']['months_to_keep']: Modify the value
of this Sugar config to change the number of months to keep activity
records.
$sugar_config['activitystreamcleaner']['keep_all_relationships_activities']:
Modify the value of this Sugar config if you wish to keep link/unlink-type
activity records in the table.    
$sugar_config['activitystreamcleaner']['limit_scheduler_run']: Modify the
value of this Sugar config to change the number of records to delete per
scheduler job run.

Check Inbound Mailboxes

The Check Inbound Mailboxes scheduler is active and runs as often as possible by
default. This scheduler will retrieve any unread email from active group inbound
email accounts configured in the system. Personal and bounce mail accounts are
not checked by this scheduler. If the group email account is configured to create
cases or to send auto-reply emails, then this scheduler will handle those tasks as
well. For more information on how to set up and configure a group inbound email
account, please refer to the Email documentation.

Clean Jobs Queue

The Clean Jobs Queue scheduler is active and runs every day at 5:00 AM by
default. The jobs queue is essentially a log of when each scheduler has run. This
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scheduler will go through the job queues and either soft or hard delete old records
in the jobs queue. A soft delete is simply hiding the record from Sugar, but keeping
it in the database for recovery if necessary. A hard delete is permanently deleting
it from the database. Job queue records will be soft and hard deleted by this
scheduler with the following criteria:

Soft Delete: Completed more than 7 days ago.
Hard Delete: Completed more than 21 days ago.

Note: The number of days for a soft and hard delete are configurable through the
sugar config files by modifying the values
of $sugar_config['jobs']['soft_lifetime'] and $sugar_config['jobs']['hard_lifetime'].

Create Future TimePeriods

The Create Future TimePeriods scheduler is active and runs every day at 11:00 PM
by default. When setting up the Forecasts module for the first time, you are
prompted with what type of time period (Yearly or Quarterly) and how many future
and past time periods you would like. This scheduler runs based off of those
settings and creates new time period records as needed for forecast data entry.

Elasticsearch Queue Scheduler

The Elasticsearch Queue Scheduler job is active and runs as often as possible by
default. New records, revised records, and deleted records are queued to be
processed by this scheduler and added to the full-text search index. Though this
scheduler is set to run as often as possible, it can take a few moments before
changes are available in global search results. For more information about Search,
please refer to the Search documentation.

Process Time-Aware Schedules

The Process Time-Aware Schedules job is active and runs hourly. This scheduler
processes entries in the time_aware_schedules table, which monitors and regulates
time-based functions (e.g., the Status field on purchased line Item records).

Process Workflow Tasks

The Process Workflow Tasks scheduler is active and runs as often as possible by
default. This scheduler processes and runs any time elapsed workflows are due to
run. If you utilize time-elapsed workflows, it is highly recommended to run this
scheduler as often as possible to ensure the workflows are executed quickly.

For more information on creating workflows, please refer to the Workflow
Management documentation.
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Note: Workflows processed by this scheduler will be run by the admin user (user
id = '1') unless the admin user is disabled.

Prune Database on 1st of Month

The Prune Database on 1st of Month scheduler is configured to run at 4:00 AM on
the first day of every month but is inactive by default. Sugar implements a soft
delete feature when deleting records through the application. Instead of deleting
the record right away, the system marks a field called deleted in the database for
the record. This scheduler runs through every table in the Sugar database and
deletes any record that has this deleted flag. This is beneficial to keep the
database small and efficient but will remove the ability to recover accidentally
deleted records. If you have a large database, we recommend activating this
scheduler and running it once a month for performance.

Prune Old Record Lists

The Prune Old Record Lists scheduler is active and runs as often as possible by
default. This scheduler job will clean up backend database entries Sugar uses
when generating export files. Such entries that are older than 1 hour from the
current date and time will be removed from the record_list database table.

Keeping this scheduler active will help prevent exports from failing due to size
limitations.

Prune Tracker Tables

The Prune Tracker Tables scheduler is active and runs daily at 2:00 AM by default.
This scheduler will delete data in the tracker tables based on the tracker prune
interval. This interval can be set from Admin > Trackers and defaults to 30 days if
not set. Any record older than the specified amount of days will be deleted from
the following tables:

tracker
tracker_sessions
tracker_perf
tracker_queries
tracker_tracker_queries

Keeping this scheduler active helps ensure overall system performance is kept at
optimum levels, as these tables are continually updated via common actions in the
application. For more information on trackers and setting this interval, please refer
to the Tracker documentation.

Publish Approved Articles & Expire KB Articles
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The Publish Approved Articles & Expire KB Articles scheduler is active and is set
to run daily at 5:00 AM by default. This scheduler publishes any Knowledge Base
articles that have a status of "Approved" and were scheduled for a later publish
date. It also checks for any articles that have reached their expiration date and
changes their statuses to "Expired".

Rebuild Denormalized Team Security Data

The Rebuild Denormalized Team Security Data scheduler is inactive by default
with an interval set to run every 15 minutes when activated. Team Security
denormalization can significantly improve SQL query performance when there are
a large number of Teams in an on-site Sugar instance. This feature relies on a
separate Team security denormalization table that needs to be updated as records
change to ensure Sugar's team security visibility rules are applied properly. When
denormalization is enabled via the perfProfile.TeamSecurity.default.use_denorm
configuration and inline updates are disabled via 
perfProfile.TeamSecurity.inline_update, then the Rebuild Denormalized Team
Security Data scheduler must be turned on to make sure the table is regularly
updated. 

Remove Diagnostic Tool Files

The Remove Diagnostic Tool Files scheduler is active and runs Sundays at 4:00 AM
by default. The ./cache/diagnostic directory serves as a temporary directory for
data generated by Sugar's Diagnostic Tool, which allows administrators and
developers to capture basic system and server configuration details in order to
diagnose problems in a Sugar instance. The tool places this data into a zip file on
the server. The Remove Diagnostic Tool Files scheduler will remove any of these
temporary files from the directory once a week during off-peak hours. For more
information about the Diagnostic Tool, please refer to the Diagnostic Tool
documentation.

Remove Temporary Files

The Remove Temporary Files scheduler is active and runs daily at 4:00 AM by
default. Sugar uses a cache directory to store files such as images, documents, and
installable modules uploaded by users. Some of these documents may be large in
size and can cause performance issues. This scheduler will remove any unused
files that are found in the ./uploads/tmp directory or in most user-configured
upload directories. For more information about temporary file storage, please refer
to the Advanced Configuration Options documentation.

Remove Temporary PDF Files

The Remove Temporary PDF Files scheduler is active and runs daily at 4:00 AM by
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default. The ./cache/pdf/ directory serves as a temporary directory for in-progress
PDF files generated from reports, quotes, and other parts of Sugar. Upon
successful completion of the PDF operation, the file is typically removed from the
directory, but there may be circumstances where orphaned PDF files could remain
in the directory. This scheduler will remove any PDF files from the directory
during off-peak hours.

Run Active Data Archives/Deletions

The Run Active Data Archives/Deletions scheduler is active and runs weekly on
Saturdays at 10:00 PM by default. This scheduler will look at the current list of
data archive records configured from the Data Archiver module and, for each one
that is marked as active, it will perform the specified archive or deletion. The
completed jobs will be registered as records in the Archive Runs module and can
be viewed from the subpanel of their parent data archiver records.

Note: It is recommended to run this scheduler during low usage or off-hours as it
can affect system performance.

Run Email Reminder Notifications

The Run Email Reminder Notifications scheduler is active and runs as often as
possible by default. This scheduler will send out email reminders for meetings and
calls that have met or passed the reminder time. Meetings and calls need to have a
status that does not equal "Held" in order for the email reminder to be sent to
invitees.

Run Nightly Mass Email Campaigns

The Run Nightly Mass Email Campaigns scheduler is active and runs on the hour,
every hour from 2:00 AM to 6:00 AM by default. This scheduler will process any
campaign emails waiting to be sent from the email queue up to the configured
batch amount. If the number of emails to send per batch is set to 500, and this
scheduler is set to run once an hour, then you will be sending 500 emails per hour.
Please configure this scheduler and the number of emails to send per batch to
allow the proper amount of email to be sent.

Note: Many email providers place limitations on email send rates such as emails
per hour, emails per day, unique recipients, etc. Please check with your email
provider to ensure that they will be able to process the volume of emails you desire
to send through campaigns.

For more information on setting the number of emails sent per batch, please refer
to the Email documentation.
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Run Nightly Process Bounced Campaign Emails

The Run Nightly Process Bounced Campaign Emails scheduler is active and runs
on the hour, every hour from 2:00 AM to 6:00 AM by default. This scheduler will
retrieve any unread email from active bounce inbound mail accounts configured in
the system. Bounce email accounts are important for receiving any bounced emails
from a campaign. Emails in the bounce mail account must match all of the
following criteria to be classified as a bounced email:

'From' email address must contain MAILER-DAEMON or POSTMASTER.
'Remove me' link from the original email must be in the email body.
The originating email does not have a campaign activity log type of invalid
email or send error.

We recommend setting this scheduler to run at the same time and interval as the
Run Nightly Mass Email Campaigns scheduler. For more information on how to set
up and configure a bounce inbound email account, please refer to the Email
documentation.

Run Report Generation Scheduled Tasks

The Run Report Generation Scheduled Tasks scheduler is inactive by default with
an interval set to run daily at 6:00 AM when activated. This scheduler executes any
scheduled reports and emails the results to the designated user. If you want to
utilize scheduled reports, please enable this scheduler, otherwise, the reports will
not be emailed. We recommend running this scheduler as often as possible, this
way if someone schedules a report for 6:15 AM, they will not have to wait until
7:00 to receive the report. For more information on scheduling reports, please
refer to the Scheduled Reports documentation.

Sugar Heartbeat

The Sugar Heartbeat scheduler is active with an interval set to run daily at 4:00
AM by default. This scheduler ensures that Sugar continues to receive heartbeat
information even if no users have logged into your instance in the last three days.
When this occurs, the Sugar heartbeat information will be sent automatically when
cron runs.

Update tracker_sessions Table

The Update tracker_sessions Table scheduler is active and runs as often as
possible by default. This scheduler updates the tracker_sessions table, setting all
records that have a date older than six hours to not active. This ensures any user
that is inactive for six hours or more will be logged out and their sessions will no
longer be active. Please keep in mind that PHP settings on the server may be more
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restrictive than the six-hour limitation on inactivity this scheduler imposes.

Schedulers Module Tab

Click the Schedulers module tab in the navigation bar, shown after selecting
Scheduler in the Admin page, to access the Schedulers list view. You may also
click the three-dots menu in the Schedulers module tab to display the Actions,
Recently Viewed, and Favorites menus. The Actions menu allows you to perform
important actions within the module. The Recently Viewed menu displays the list
of schedulers you last viewed in the module. The Favorites menu displays the list
of schedulers you most recently marked as favorites in the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Scheduler Opens the edit view layout to create a

new scheduler.
Schedulers Opens the list view layout to search and

display schedulers.

Creating Schedulers

There are various methods for creating schedulers in Sugar including via the
Schedulers module and via duplication. The full edit view layout opens when
creating the scheduler directly from the Schedulers menu and includes all of the
relevant fields for your organization's schedulers. Schedulers can be created for
built-in jobs within the application or they can be created to call a URL outside of
Sugar.

Creating via Schedulers Module
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One of the most common methods of scheduler creation is via the Create
Scheduler option in the Sugar Scheduler module tab. This opens up the edit view
layout which allows you to enter all the relevant information for the scheduler.

Use the following steps to create a scheduler via the Scheduler module:

1. Navigate to Admin > Scheduler.
2. Click the three-dots menu in the Sugar Scheduler module tab and select

"Create Scheduler".

3. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.
Note: For more information on setting the advanced options for the
interval, please refer to the Advanced Options section.

4. Once the necessary information is entered, click "Save".

Creating via Duplication

You can also create a new scheduler by duplicating an existing scheduler record.
The Copy option is useful if the scheduler you are creating has similar information
to an existing scheduler.

Use the following steps to create a scheduler by duplicating an existing record:

1. Navigate to a scheduler record's detail view.
2. Select "Copy" from the Actions menu.
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3. The displayed edit view is pre-populated with the original scheduler's
values. Update the necessary fields, then click "Save". For more
information on setting the advanced options for the interval, please refer to
the Advanced Options section.

Viewing Schedulers

There are various options available for viewing scheduler records in Sugar
including via Schedulers list view, Schedulers detail view, and Schedulers Recently
Viewed menu.

Viewing via List View

The Schedulers list view displays all scheduler records meeting the current search
criteria. To access the list view, simply click the Schedulers module tab. While list
view shows key scheduler fields, you can click the scheduler's name to open the
record in detail view. For more information on viewing scheduler via list view,
please refer to the Schedulers List View section.

Viewing via Detail View

The Schedulers detail view displays thorough scheduler information including all
scheduler fields followed by the log records of when this scheduler has run. The
detail view can be reached by clicking a scheduler record's link from anywhere in
the application including from the Schedulers list view. For more information on
viewing scheduler via detail view, please refer to the Schedulers Detail View
section.

Viewing via Recently Viewed

As you work, Sugar will keep track of which scheduler you have recently viewed.
Click the three-dots menu in the Sugar Scheduler module tab to see a list of the
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three schedulers you most recently viewed. Clicking the scheduler name will open
the scheduler in detail view.

Searching Schedulers

The Schedulers list view includes a Basic Search to help you locate records easily
and effectively in a module-specific manner. Once the search is performed, the
relevant results will be displayed in the Schedulers list view below. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g., %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search offers a few, commonly used fields for a simplified search experience.
The buttons in Basic Search panel have the following functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.

Once the search is complete, the relevant results will populate in the list view
below the search panel. To see all scheduler records, simply click "Clear" and then
"Search" to perform a blank search with no filters.

Schedulers List View
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The Schedulers list view displays all scheduler records meeting the current search
criteria. You can view the basic details of each scheduler within the field columns.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.
By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation.

Checkbox Selection

You can perform several actions on scheduler records directly from the list view by
first selecting the desired records. To select individual scheduler records on the
Schedulers list view, mark the checkbox on the left of each row. To select or
deselect multiple scheduler records in the list view, use the options in the
checkbox dropdown menu:

Select This Page: Selects all records shown on the current page of
scheduler results.
Select All: Selects all records in the current search results across all pages
of scheduler results.
Deselect All: Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more schedulers at a time.
Mass Update Mass update one or more schedulers at

a time.
Export Export one or more schedulers to a CSV

file.

Favorite Designation

Users have the option to mark scheduler records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Schedulers module tab. In the Schedulers list view, the star on the left of each
schedule's row is yellow once marked to indicate a favorite schedule. For more
information on marking records as favorites, please refer to the Favoriting
Schedulers section of this documentation.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time.
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Schedulers Detail View

The Schedulers detail view displays thorough scheduler information including all
scheduler fields which are grouped by default into the Overview, More
Information, and Other panels. You can also view a scheduler's log which appears
in beneath the scheduler fields. The detail view can be reached by clicking a
scheduler record's link from anywhere in the application including from the
Schedulers list view.

Actions Menu

The Actions menu on the top left of each scheduler's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this scheduler.
Copy Duplicate this scheduler.
Delete Delete this scheduler.

Favorite Designation

Users have the option to mark scheduler records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often so that they can easily be accessed via search or from the
Schedulers module tab. In the Schedulers detail view, the star on the right of the
scheduler's name is yellow once marked to indicate a favorite scheduler. For more
information on how to mark records as favorites, please refer to the Favoriting
Schedulers section of this documentation.
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Next or Previous Record

On the upper right of the Schedulers detail view, there are two buttons that allow
you to page through each scheduler in the Schedulers list view's current search
results. Clicking the Previous button displays the previous scheduler of the current
search results while clicking the Next button displays the next scheduler of the
current search results. The text in between shows which scheduler result you are
currently viewing within the total number of current results.

Job Log

Beneath the scheduler's fields is a subpanel with up-to-date entries of when the
scheduler was run and information specific to each scheduler job. You can view the
details of each job within the field columns (e.g., Job Status, Result), such as the
status (e.g., done) of the job, the outcome (e.g., success) of the job, any messages
with additional information, and the date/time of when the job was executed or
modified.

Editing Schedulers

Schedulers may be edited at any time to update or add information to the record.
You can make changes to existing scheduler records via the Schedulers edit view
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and quick-create forms. Edit view is available within the Schedulers module and
includes all of the Scheduler fields you should need.

Quick Create is available for editing schedulers from outside the Schedulers
module and opens as a pop-up without navigating away from your current page. It
generally contains fewer fields, but the Full Form button may be used to access the
full edit view should you need to edit additional fields.

For more information on setting the advanced options for the interval, please refer
to the Advanced Options section.

Editing via Detail View

You can edit schedulers via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes.
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Editing via List View

You can edit schedulers via the list view by clicking the Pencil icon to the left of
each scheduler's name. A pop-up window will open with the quick create form
which is a shortened version of the edit view layout. Update the necessary fields,
then click "Save" to preserve your changes.

Deleting Schedulers

If a scheduler record is invalid and should no longer appear in your organization's
Sugar instance, it may be deleted from either the Schedulers detail view or list
view. Deleting via the detail view allows you to delete a single record while the list
view allows for mass deleting multiple records at once.

Note: If you wish to disable a scheduler but do not want to delete it, you can set
the status to Inactive and it will not run.

Deleting via Detail View

Use the following steps to delete a scheduler record via the detail view:

1. Navigate to a scheduler record's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
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proceed.

Mass Deleting via List View

Use the following steps to delete one or more scheduler records via the list view:

1. Navigate to the Schedulers list view by clicking the Schedulers module tab.
2. Use the Search to find the scheduler records you wish to delete.
3. Select the desired scheduler records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of scheduler records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Schedulers

Sugar's Export option allows users to download all fields for the selected
schedulers to their computers as a CSV (comma-separated values) file. This may be
useful when needing to use Scheduler data with other software such as Microsoft
Excel. Due to PHP memory limitations on the server, there may be occasions when
the application times out while exporting a large number of scheduler records. If
you encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Schedulers may be exported from the Schedulers list view by selecting "Export"
from the Actions menu.
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Mass Updating Schedulers

Mass updating allows users to make the same change to multiple scheduler
records at once from the Schedulers list view. Currently, only fields with the data
type of date, datetime, dropdown, multiselect, and radio may be altered during a
mass update. Due to the PHP memory limitations on the server, there may be
occasions when the application times out while mass updating a large number of
scheduler records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.
Use the following steps to mass update scheduler records from the list view:

1. Navigate to the Schedulers list view by clicking the Schedulers module tab.
2. Use the list view's Search to find schedulers you wish to modify.
3. Select the desired schedulers individually or using the checkbox

dropdown's options.
4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.
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6. Click "Update" to save the changes to all of the currently selected
scheduler records.

Favoriting Schedulers

Each Sugar administrator has the option to designate their own favorite schedulers
that are important or will be viewed often. Once records are marked as favorites,
you can select your most recent favorites directly from the Sugar Scheduler
module tab.

Favoriting via List View

Use the following steps to mark records as favorites via the Schedulers list view:

1. Navigate to the Schedulers list view by clicking the Schedulers module tab.
2. Use Search to find the scheduler records you wish to mark as favorites.
3. Click the star icon on the left of each desired scheduler's row.
4. To remove the scheduler as a favorite, click the star again to revert it to

white.

Favoriting via Detail View

Use the following steps to mark records as favorites via the Schedulers detail view:

1. Navigate to a scheduler record's detail view.
2. Click the star icon to the right of the scheduler's name in the upper left of

the detail view to designate it as a favorite.
3. To remove the scheduler as a favorite, click the star again to revert it to

white.
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Advanced Options

From the edit view of a scheduler, you can select the Advanced Options checkbox
to refine the interval of the scheduler as well as configure the Advanced Options
panel.

This opens up the crontab notation for the interval field. Crontab notation gives
administrators more flexibility to define when and how often the scheduler runs.
Crontab notation allows you to enter a value for each time part for the job to run
on. You can specify complex values by using the following notations:

Character Description
* Asterisk is used to represent every value

for the specified time part. For example,
* in the mins field will run every minute.

/ Forward slash is used to represent
increments. For example, */15 in the
mins field will run every 15 minutes.
30/5 in the mins field will run starting at
the 30th minute of the hour and every 5
minutes after.
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, Comma is used to specify multiple
values. For example, 18,20 in the hrs
field will run at 6:00 PM and 8:00 PM.

- Hyphen is used to specify a range of
values. For example, 1-6 in the mo field
will run from January through June.

Specify the values to run in the following interval fields using cron tab notation:

min: Specify the minute of the hour to run on (0-59).
hrs: Specify the hour of the day to run on (0-23).
date: Specify the day of the month to run on (1-31).
mo: Specify the month of the year to run on (1-12).
day: Specify the day of the week to run on (0-6).

You may specify any combination of the fields to create the schedule needed to run
the job.

Setting up Cron Scheduler

In order for the schedulers to run at the designated times, there needs to be a
process running on the server to initiate the schedulers. This backend process will
call the cron.php file in Sugar with some specific parameters, and the cron.php file
will execute the schedulers as necessary.

Sugar instances hosted on Sugar's cloud service have the cron scheduler set up
automatically, but it must be configured for on-site instances. In UNIX systems
(MAC and Linux) you can configure crontab to run the schedulers. Navigate to
Admin > Scheduler to get the system information necessary to set up the crontab.

Note: The scheduler is throttled by default to prevent it from running more often
than every 30 seconds. This value is configurable by setting the
$sugar_config['cron']['min_cron_interval'] value in the config_override.php file.

Setting Up in Unix/Linux

Use the following steps to set up crontab to run the Sugar schedulers:

1. From a command prompt, execute the following command: 
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crontab -u apache -e

2. The text editor will launch as the user "apache". If your web server is
running under a different user, please adjust the line accordingly.

3. Add the commands displayed on the Admin > Schedulers page of your
Sugar application into the crontab file: 

* * * * * cd /var/www/sugar123; php -f cron.php > /dev/null 2>&1

Note: Make sure that the path to the root directory of Sugar and to PHP is
correct.

4. Save the changes to the file. This will run the cron job every minute.

You can check crontab to see what commands are being run by executing the
following command:

  crontab -u apache -l

PDF Manager

Overview

The PDF Manager is used to create and manage templates for generated PDF files
for any deployed module, custom or standard. Sugar comes with two PDF
templates out of the box (Quote and Invoice).

Note: Legacy Quote PDF Templates (custom Quote templates created through
code customizations) are not displayed in the PDF Manager but are still available
in the Quotes module provided the templates were built off the TCPDF engine.

PDF Manager Fields

The PDF Manager module contains a number of stock fields that come out-of-the-
box with Sugar. The below definitions are suggested meanings for the fields, but
the fields can be leveraged differently to best meet your organization's needs.

Field Description
Author The author name to be placed in the

PDF properties.
Description A description or other information about

the template.
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Footer Text The text to be placed in the template's
footer.

Header Logo File Click "Choose File" to upload a header
image to the template.
Note: The image will display as 454
pixels wide by 45 pixels high; the
uploaded image should be sized relative
to these dimensions.

Header Text The text to be placed in the template's
header.

Header Title The title of the template header.
Keyword(s) The keywords to be placed in the PDF

properties.
Module The module this template will work in.

Note: Once a template is created, the
module cannot be changed.

Name The name or designation of the
template.

Published Determines if a template is available to
users or not.

Subject The subject to be placed in the PDF
properties.

Teams The Sugar team(s) assigned to the
template record.

Template The content of the template.
Title The title to be placed in the PDF

properties.

PDF Manager Module Tab

The PDF Manager module tab can be accessed by navigating to the Administration
page and clicking "PDF Manager" in the System section. Once in the PDF Manager
list view, you can click the three-dots menu in the PDF Manager module tab in the 
navigation bar to display the Actions and Recently Viewed menus. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of templates you last viewed in the module. Please
note that clicking the module tab allows you to access the PDF Manager list view. 
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create PDF Template Opens the edit view layout to create a

new template.
View PDF Templates Opens the list view layout to search and

display templates.
Edit Report PDF Template Opens the edit view layout to modify the

report template.

Creating PDF Templates

There are various methods for creating PDF templates in Sugar including via the
PDF Manager module and duplication. The full edit view layout opens when
creating the template directly from the PDF Manager menu and includes all of the
relevant fields for your organization's templates.

Note: It is generally recommended to create a new template via duplication and
then modify the copy to suit your needs.

Creating Via PDF Manager Module

You can create a new template via the Create PDF Templates option in the PDF
Manager module tab. This opens up the edit view layout which allows you to enter
all the relevant information for the template.

Use the following steps to create a template via the PDF Manager module:

1. Navigate to Admin > PDF Manager.
2. Click the three-dots menu in the PDF Manager module tab and select

"Create PDF Template".
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3. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

4. Once the necessary information is entered, click "Save".

Creating Via Duplication

You can also create a new template by duplicating an existing template record. The
Copy option is useful if the template you are creating has a similar layout to an
existing template.

Use the following steps to create a template by duplicating an existing record:

1. Navigate to a template record's detail view.
2. Click "Copy" from the Actions menu.

3. The displayed edit view is pre-populated with the original template's
values. Update the necessary fields, then click "Save".
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Note: If you change the module field during duplication, you will have to remove
all variable references to the old module in the layout before saving.

Creating Content

The PDF template can contain images and HTML formatting as well as variable
fields from the assigned module. TincyMCE is the rich text editor for formatting
your template using HTML. For more information on using TinyMCE, please refer
to the TinyMCE section in the User Interface in the Application guide.

To add variable fields from the assigned module, simply select the desired field
from the Field dropdown and then click "Insert".

The variable will be placed wherever your computer's cursor is located in the
template and can be moved around as necessary.

Note: The Link section provides all one-to-one and one-to-many relationships to
provide linked data in the template.

For modules that have a subset of data in the template (e.g., Product line items in
Quotes), there are special containers in the template that indicate where the
repeating areas start and stop. These containers are designated by the following
commands:

Start: {foreach from=$product_bundles item="bundle"}
End: {/foreach}

Note: These lines are important and if removed can cause errors when generating
a PDF. If you encounter an error when generating a PDF, we recommend checking
the template for these start and end placeholders.
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To add images to a PDF template, simply select the image icon in the toolbar. Fill
out the image details (Image URL, Alignment, Dimensions, Border, etc.) in the
Insert/Edit Image dialog then click "Insert". 

Note: Images cannot be copied and pasted or dragged and dropped into a PDF
template. The image icon must be used to insert an image.

Viewing PDF Templates

There are various options available for viewing template records in Sugar
including via PDF Manager list view, PDF Manager detail view, and PDF Manager
Recently Viewed menu.

Viewing Via List View

The PDF Manager list view displays all template records meeting the current
search criteria. To access the list view, simply click the PDF Manager module tab.
While list view shows key template fields, you can click the template's name to
open the record in detail view. For more information on viewing templates via list
view, please refer to the PDF Manager List View section.

Viewing Via Detail View

The PDF Manager detail view displays thorough template information including all
template fields. The detail view can be reached by clicking a template record's link
from anywhere in the application including from the PDF Manager list view. For
more information on viewing templates via detail view, please refer to the PDF
Manager Detail View section.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which templates you have recently viewed.
Click the three-dots menu in the PDF Manager module tab to see a list of the 3
templates you most recently viewed. Click the template's name from the list to
open it in detail view.
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Searching PDF Templates

The PDF Manager list view includes a Basic Search to help you locate records
easily and effectively in a module-specific manner. Once the search is performed,
the relevant results will be displayed in the PDF Manager list view below. Please
note that Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g., %services). This
will pull up any record that has the word "services" in the name, regardless of how
it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic search offers a few, commonly used fields for a simplified search experience.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select a module and enter a template name, Sugar will only return template
records with a matching name that are assigned to that module. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all template records, simply click "Clear" and then "Search" to perform a
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blank search with no filters.

PDF Manager List View

The PDF Manager list view displays all template records meeting the current
search criteria. You can view the basic details of each template within the field
columns.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration Guide.

Checkbox Selection

You can perform several actions on template records directly from the list view by
first selecting the desired records. To select individual template records on the
PDF Manager list view, mark the checkbox on the left of each row. To select or
deselect multiple template records on the list view, use the options in the checkbox
dropdown menu:

Select This Page: Selects all records shown on the current page of PDF
template results.
Select All: Selects all records in the current search results across all pages
of PDF template results.
Deselect All: Deselects all records that are currently selected.

                         197 / 829



 

Actions Menu

The Actions menu to the right of the checkbox dropdown typically allows you to
perform various actions on the currently selected records.

The only action available from the PDF Manager list view is the following
operation:

Menu Item Description
Delete Delete one or more templates at a time.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time.

PDF Manager Detail View

The PDF Manager detail view displays thorough template information including all
template fields which are grouped by default into the Overview and PDF Document
Properties panels. The detail view can be reached by clicking a template record's
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link from anywhere in the application including from the PDF Manager list view.

Actions Menu

The Actions menu on the top left of each template's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration Guide.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this template.
Copy Duplicate this template.
Delete Delete this template.
Preview Preview this template.

Next or Previous Record

On the upper right of the PDF Manager detail view, there are two buttons that
allow you to page through each template in the PDF Manager list view's current
search results. Clicking the Previous button displays the previous template of the
current search results while clicking the Next button displays the next template of
the current search results. The text in between shows which template result you
are currently viewing within the total number of current results.

Editing PDF Templates
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Templates may be edited at any time to update or add information to the record.
You can make changes to existing template records via the PDF Manager edit
view. Edit view is available within the PDF Manager module and includes all of the
template fields you should need.

Editing Via Detail View

You can edit templates via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes.

Editing Report PDF Template

The Report PDF Template is used when generating a report as a PDF. The report
template may be edited at any time to include your company's logo. This logo
displays in the header for all Report PDF files. The image will display as 454 pixels
wide by 45 pixels high; the uploaded image should be sized relative to these
dimensions.

You can edit the report template via the detail view by selecting the Edit Report
PDF Template option from the PDF Manager module tab.
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Once the edit view layout opens, update the necessary fields, then click "Save" to
preserve your changes.

Deleting PDF Templates

If a template record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the PDF Manager detail view or list
view. Deleting via the detail view allows you to delete a single record while the list
view allows for mass deleting multiple records at once.

Deleting Via Detail View

Use the following steps to delete a template record via the detail view:

1. Navigate to a template record's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.
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Mass Deleting Via List View

Use the following steps to delete one or more template records via the list view:

1. Navigate to the PDF Manager list view by clicking the PDF Manager
module tab.

2. Use the Basic Search to find the template records you wish to delete.
3. Select the desired template records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of template records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Adding a Header Image to PDF Template

Image files can easily be uploaded from your local machine to be used as a header
image on a PDF template. After uploading and saving the image to the
template's Header Logo File field, it will be shown on the PDF generated by users
in Sugar.

Header images will display as 454 pixels wide by 45 pixels high, so the uploaded
image should be sized relative to these dimensions (e.g., 908x90 or 1816x80).

After saving an appropriately sized image file to your computer, use the following
steps to add the header image to the PDF template:

1. Create a new PDF template or open up an existing template via Admin >
PDF Manager. 

2. Click the "Choose File" button in the Header Logo File field to open a file
selection window from your browser.
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3. Select the image file from your local machine then click "Open" to add the
image.

Please note that you must save then preview the PDF template in order to view the
inserted header image. 

Previewing PDF Templates

Previewing PDF templates allows you to see what the template will look like before
publishing it in Sugar. The preview option displays the PDF template with the
database field names and not actual data values and is accessible from the detail
view.

Use the following steps to preview a template via the detail view:

1. Navigate to a template record's detail view.
2. Select "Preview" from the Actions menu.

3. The PDF will download to your computer for viewing.

Web Logic Hooks

                         203 / 829



 

  

Overview

Web logic hooks allow you to establish events on a per-module basis for Sugar to
send data from the record in focus to an external URL so that additional
processing can be completed outside the Sugar application. When a Web Logic
Hook is triggered, the data is not sent instantaneously. Rather, the data is queued
and processed under the Dispatch Web Logic Hook scheduled job. Once the job is
processed through a regular scheduler run, the data for the record that triggered
the hook is transmitted to the designated URL in a JSON format for further
processing. This can allow you to send this data to other applications within your
organization or to manipulate the data and transmit it back to Sugar via the REST
API.

Web Logic Hook Fields

The Web Logic Hooks module contains a number of stock fields that come out-of-
the-box with Sugar. For information on using and editing various field types, refer
to the User Interface documentation. The below definitions are suggested
meanings for the fields, but the fields can be leveraged differently to best meet
your organization's needs.

Field Description
Module Name The module that the web logic hook will

trigger off when the trigger event
occurs in that module.

Name The name of the web logic hook.
Request Method The HTTP request method that the web

logic will utilize to call out to the
specified URL.

Trigger Event The event that must occur in order for
the web logic hook to process.

URL The URL that will receive the data
transmitted by the web logic hook.

Note: This URL should be a URL
outside of your SugarCRM instance. If
you have an instance on Sugar's cloud
service, it is your responsibility to host
the URL that will process the web logic
hook.
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Working With Sugar Modules

While the Web Logic Hooks module has some features that only apply to web logic
hooks, it also uses the Sidecar user interface that most Sugar modules are based
on. The following sections detail menus, views, and actions common to Sidecar
modules and contain links to additional information within the page or links to the
User Interface documentation. 

Web Logic Hooks Menus

The Web Logic Hooks module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation.

Module Tab Menus

Click the Web Logic Hooks module tab in the navigation bar, shown after
selecting Web Logic Hooks in the Admin page, to access the Web Logic Hooks list
view. You may also click the three-dots menu in the Web Logic Hooks module tab
to display the Actions and Recently Viewed menus. The Actions menu allows you to
perform important operations within the module. The Recently Viewed menu
displays the list of web logic hooks you most recently viewed.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Web Logic Hook Opens the record view layout to create a

new web logic hook.
View Web Logic Hooks Opens the list view layout to search and

display web logic hooks.

List View Menus

The Web Logic Hooks list view displays all web logic hook records and allows for
searching and filtering to locate specific web logic hooks. You can view the basic
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details of each record within the field columns of the list view or click a web logic
hook's name to open the record view. To access a module's list view, simply click
the module's tab in the navigation bar.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual web logic hook records or
click the checkbox in the list header to select all records displayed on the current
set of list view results.

 

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more web logic

hooks at a time.
Merge Merge two or more duplicate web logic

hooks.
Delete Delete one or more web logic hooks at a

time.
Export Export one or more web logic hooks to a

CSV file.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.
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List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual web logic hook directly from the list view. 

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this web logic hook in the

intelligence pane.
Edit Edit this web logic hook.
Delete Delete this web logic hook.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Record View Actions Menu

The Web Logic Hooks record view displays a single web logic hook in full detail
including its fields. To access a web logic hook's record view, simply click a
hyperlinked web logic hook name from the Web Logic Hooks list view. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this web logic hook.
Share Share a link to this web logic hook via

email.
Find Duplicates Locate potential duplicates of this web

logic hook.
Copy Duplicate this web logic hook to create a

new web logic hook.
Delete Delete this web logic hook.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

In the table below, the left column contains links to the User Interface page
covering topics that are applicable to all Sidecar modules. The right column has
links to sections of the current page that cover topics specific to web logic hooks.

General Instructions for Working
With Sugar Modules

Web-Logic-Hooks-Specific
Instructions

Use the links below to navigate to the When Web-Logic-Hooks-specific help
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User Interface page which covers topics
generic to many Sugar modules.

exists for each topic, use the links below
to navigate to sections of the current
page.

Creating Records  
Viewing Records  
Searching for Records  
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane  
Editing Records  
Deleting Records  
Exporting Records  
Finding Duplicate Records  
Merging Records  
Sharing Records  

Data Archiver

Overview

The Data Archiver in Sugar lets an administrator archive or delete Sugar records
from their database either on demand by manually triggering a job or at regular
intervals via the Run Active Data Archives/Deletions scheduler. While archiving
records simply moves the data to a hidden table, deleting records via Data
Archiver frees up space in your database by allowing administrators to selectively
and permanently prune records.

In addition to the Data Archiver module, the Archive Runs module is displayed as a
subpanel under the record view of any data archiver record. The Archive Runs
subpanel displays a history of runs that have occurred for the parent data archiver
record, giving the administrator a clear history of what has occurred in the system
and access to the affected record IDs.

Data Archiver Fields

The Data Archiver module contains the following fields. For information on using
and editing various field types, refer to the User Interface documentation. 

Field Description

                         209 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Creating_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Viewing_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Searching_for_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#List_View
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Record_View
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Intelligence_Pane
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Editing_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Deleting_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Exporting_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Finding_Duplicate_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Merging_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Sharing_Records
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Field_Types


 

Active The enabled or disabled state of the job
for scheduled runs; only active records
will be processed by the Run Active
Data Archives/Deletions scheduler. An
administrator will still be able to click
on "Perform Now" to run the job
manually even if the Active field is set to
false.

Filter The filter(s) that should be applied to
the module records in order to identify
the subset of records to archive or
delete.

Module The module that contains records you
want to archive or delete; all modules
are available in the Data Archiver
module list.

Name A unique and descriptive name for the
job.

Process Type Select whether you want to archive or
hard delete the records identified by
this job.

Note: Fields, layouts, and columns for the Data Archiver module and related
Archive Runs module are not available for customization in Studio.

Archive vs Hard Delete

Jobs created in the Data Archiver module can have one of two process types:
Archive or Hard Delete. Please note that it is recommended to run the Archive or
Hard Delete jobs during low usage or off-hours as it can affect system
performance.

An archive process type will remove specified records from the active table of the
chosen module and transfer them to a newly created archive table. The archive
table is a clone of the active table. Because archiving simply moves records from
one part of your database to another, it does not free up any room in your
database, but it does remove old or non-essential data from the view of users. Once
archived, the data can no longer be accessed via the Sugar user interface.
SugarCloud customers can access their archived data by making and downloading
a database backup to access their archive tables.

A hard-delete process type will permanently remove specified records from the
active table of the chosen module, freeing space on your database. When hard
deleting records such as notes, documents, and emails, the record's file

                         210 / 829



 

attachments will also be removed. Hard deleting records gives administrators the
ability to selectively prune their databases and not just mark entries as deleted as
the standard "soft delete" does when users delete records via the application's
interface. As an added benefit, you can filter jobs in the Data Archiver on the
"Deleted" database field, which is hidden from standard filters in Sugar, letting you
manually prune user-deleted records as needed if you prefer not to enable the
automated Prune Database on 1st of Month scheduler. Hard deleting is not
reversible, so this information can never be retrieved again. For that reason, we
recommend performing regular backups and storing them locally before
performing hard-delete actions. 

Creating and Running a Data Archiver Job

Data Archiver jobs will run automatically on regularly set intervals when the Run
Active Data Archives/Deletions scheduler is active. Whether the scheduler is active
or not, an administrator may also run Data Archiver jobs manually as needed by
clicking the "Perform Now" button on a data archiver record.

Use the following steps to clean up your database by creating an archive or hard-
delete job in the Data Archiver module:

1. Navigate to Admin > Archive Records.
2. Click "Create" to define a new set of records to archive or delete.
3. Complete the form fields, using the field descriptions above as guidance.

Use the Add button at the end of the filter row to create additional filter
criteria if needed.

4. Click "Save".

After saving an active Data Archiver record, the archive or deletion will
automatically process the next time the Run Active Data Archives/Deletions
 scheduler runs. Alternatively, you may click on "Perform Now" in the data
archiver job's record view to run the job immediately without activating or waiting
for the scheduler.

Note: It is recommended to run the data archiver job during low usage or off-
hours as it can affect system performance.
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Each time a Data Archiver record runs, a new entry will appear in its Archive Runs
subpanel, which includes the following information:

Date of Process: The date and time that the Data Archiver job ran.
Process Type: Whether the job archived or hard-deleted records.
Module: The module which contained the processed records.
Filter Definition: The filters that were applied to identify the processed
records.
Number Processed: The number of records that were identified and
processed by the job.
Source: The ID of the user who initiated the run.

Retrieving Archived Records and Deleted Record IDs

When you hard-delete data via the Data Archiver, Sugar will preserve the IDs (and 
only the IDs) of the records that are deleted in a database table called
archive_runs. All other data related to the hard-deleted records will be gone and
not recoverable from any means other than a local backup. Therefore, we
recommend backing up your database before performing hard-delete actions.
Customers with access to their database can retrieve the list of IDs that were hard
deleted in the row of the archive_runs table that is associated with the job that ran
from the parent data_archivers record. SugarCloud customers can make and
download a database backup to access the archive_runs table or create a report in
the Advanced Reports module if they are using Sugar Sell or Serve. Once you have
the deleted IDs, you may be able to restore hard-deleted records by comparing the
IDs with your backup.

Records that are archived via the Data Archiver are stored in the database in a
table cloned from the originating module table. The clone will have
_archive appended to the end of its table name (e.g., accounts_archive). Customers
with access to their database can find their archived data in these archive tables.
SugarCloud customers can make and download a database backup to access their
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archive tables or create an Advanced Report if they are using Sugar Sell or Serve.

Email Administration

Overview

Sugar comes with many different email-related capabilities, many of which require
an administrator to set up or configure. Email administration covers the system
email settings, campaign email settings, email archiving, inbound email, and
managing the email queue.

Email Accounts

Outgoing Email Accounts

There are three types of outgoing email accounts used in Sugar:

System Email Account: The administrator sets up the system email account
by configuring the System Email Settings. Sugar uses this account to send
campaigns and email notifications such as password reset emails, record
assignment notifications, and workflow alerts.
Default User Email Account: A default email account is automatically
created by Sugar for each user in Sugar. The default user account will use
the primary email address stored in the user's profile. To use their default
email accounts for sending email through Sugar, users must edit their
profile and select "Sugar Email Client" as their outgoing email client. For
more information on how users configure their user accounts, refer to the 
Emails documentation in the Application Guide. 
Note: The users' default email accounts may be affected by the "Allow
users to use this account for outgoing email" option in Admin > System
Email Settings. If the administrator has enabled the option, users will not
be able to configure their default email account and must instead utilize the
system email account or create a new user email account. Users will see
the system email account in the Outgoing Email Accounts list view with an
asterisk to indicate that it is a system account.
User Email Accounts: User email accounts can be created by all users
and can consist of the user's personal email accounts (e.g.,
jane@example.com) as well as any shared email accounts. Shared email
accounts allow a group of users to send outbound email messages using the
same email account (e.g., support@example.com). If you have existing
group email accounts that should be available to select when composing
emails, it is recommended that you create a shared email account via
Emails > Email Settings, making sure that it is assigned to the specific
team(s) who can use the account to send emails. For more information on
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creating outgoing email accounts, refer to the Emails documentation in the
Application Guide. 
Note: The "Allow users to configure email accounts" option must be
enabled in order for users to see the Create button to create new outgoing
email accounts when they navigate to Emails > Email Settings.

Incoming Email Accounts

There are two types of incoming email accounts used in Sugar:

Group Mail Accounts: Group inbound email accounts allow multiple users,
such as team members, to view emails from an external mail account.
When emails are addressed to your organization but not to any particular
user, you can route them to a Group mail account such as 
support@example.com or sales@example.com. Users can subsequently
distribute emails in the Group mail account to other team members. Emails
received to a Group mail account will have no assigned user unless "Create
Case from Email" has been enabled for the account.
Note: Group Mail Accounts will only import unread messages from the mail
server.
Bounce Handling Mail Accounts: Bounce handling email accounts are
configured to store campaign emails that are returned to the server, or
"bounced" back to you due to incorrect email addresses or incompatible
server settings on the receiving end. You can create a bounce handling
inbox separately for each campaign, or you can create one that is common
to all campaigns. The system tags every bounced campaign email with a
unique identifier that enables you to identify the campaign.

Note: The Campaigns module is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
License Types Matrix documentation. 

System Email Settings

The System Email Settings section allows Sugar administrators to configure the
system's outbound email settings as well as additional email and security options.
Make any necessary changes in the sections below and click "Save" to commit the
changes.
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Outgoing Mail Configuration

  This section applies to the system email settings. For help setting up the email
accounts for individual users, please refer to the Emails documentation in the
Application Guide. 

The Outgoing Mail Configuration section contains details for sending email
notifications, scheduled reports, workflow alerts, etc. Enter appropriate values for
the following fields, keeping in mind that all required fields are marked with a red
asterisk and must be completed prior to saving:

"From" Name: The name the outgoing email will come from; for example,
the name of your organization. Defaults to "SugarCRM".
"From" Address: The email address the outgoing email will come from.
Defaults to "do_not_reply@example.com". 

If specifying a different address than the email address associated
with the account you are authenticating, the email server being
utilized may need to be configured to allow the email account to
send email as the entered From Address. 
For more information on configuring "Send As" permissions with
Gmail, refer to Gmail's Help documentation. 
For Exchange Online, enter only the authorized email address, as it
cannot send emails using a different email address unless the
organization's Exchange admin has configured the account to allow
this. 

Choose your Email provider: Click on the tile that corresponds with your
mail provider (e.g., Google, Exchange Online) to populate provider-specific
values. Refer to the table below this list for details about the fields shown
for each provider.

                         215 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/emails/#Creating_Outgoing_Email_Accounts
https://support.google.com/mail/answer/22370?hl=en


 

Allow users to use this account for outgoing email: Check this box if
you would like users to be able to send emails using the same outbound
mail account. If the option is not selected, users will still be able to use the
outbound mail server to send emails by entering their personal mail
account information in their user preferences. For more information on
setting up the email settings in user preferences, please refer to the Email
Settings section of the Getting Started documentation.

Once the appropriate mail server information is entered, you can send a test email
to make sure it is configured properly. Click "Send Test Email", enter your email
address, and send the test. If you do not receive the test email, re-enter the
account information including the password to ensure it is all correct.

Email Provider Fields Description
Google Authorize Click this button to

authorize the Google mail
account to be the system
email account. The Google
connector must be 
configured via Admin >
Connectors before you can
authorize and set up the
mail account. 
Note: A "This app isn't
verified" warning may
appear after selecting
your Gmail account to
authorize. You can click
the Advanced link then
click the "Go to..." link at
the bottom of the window
to proceed and grant
permission for the
connection to occur. For
more information on this
warning, refer to
the Unverified apps article
on the Google Cloud
Platform Console Help
page.

Status The status will display
"Authorized" once the mail
account is authorized.

Authorized Email Address The email address of the
authorized Google mail
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account. 
SMTP Mail Server The web address of the

external email server
Sugar will connect to.

SMTP Port The communication port
number used for
connecting to the mail
server.

Use SMTP Authentication This option is
automatically enabled to
require server
authentication for the
account. Most email
servers require
authentication for security
purposes. By default,
authentication is required
for Google.

Enable SMTP over SSL or
TLS

Select the appropriate
option from the dropdown
to use Secure Socket
Layer, Transport Layer
Security, or no encryption
when connecting to the
mail server.

Exchange Online Authorize Click this button to
authorize the Microsoft
Exchange mail account to
be the system email
account. The Microsoft
connector must be 
configured via Admin >
Connectors before you can
authorize and set up the
mail account. 

Status The status will display
"Authorized" once the mail
account is authorized.

Authorized Email Address The email address of the
authorized Microsoft
Exchange mail account. 

Exchange Server The web address of the
external email server

                         217 / 829



 

Sugar will connect to.
Exchange Server Port The communication port

number used for
connecting to the mail
server.

Use SMTP Authentication This option is
automatically enabled to
require server
authentication for the
account. Most email
servers require
authentication for security
purposes. By default,
authentication is required
for Exchange.

Enable SMTP over SSL or
TLS

Select the appropriate
option from the dropdown
to use Secure Socket
Layer, Transport Layer
Security, or no encryption
when connecting to the
mail server.

Yahoo! Mail Yahoo! Mail ID Enter the email address or
user name to connect to
the SMTP server.

Yahoo! Mail Password Enter the password
associated with the
entered email address or
user name.

Exchange Basic
Authentication 

Exchange Server The web address of the
external email server
Sugar will connect to.

Exchange Server Port The communication port
number used for
connecting to the mail
server.

Use SMTP Authentication Check this box to require
server authentication for
the account. Most email
servers require
authentication for security
purposes. By default,
authentication is required

                         218 / 829



 

for Exchange. If left
unchecked, the SMTP
server must accept
anonymous connections,
which is not
recommended. 

Enable SMTP over SSL or
TLS

Select the appropriate
option from the dropdown
to use Secure Socket
Layer, Transport Layer
Security, or no encryption
when connecting to the
mail server.

Exchange Username Enter the user name to
connect to the SMTP
server.

Exchange Password Enter the password
associated with the
entered user name.

Google Basic
Authentication

SMTP Mail Server The web address of the
external email server
Sugar will connect to.

SMTP Port The communication port
number used for
connecting to the mail
server.

Use SMTP Authentication Check this box to require
server authentication for
the account. Most email
servers require
authentication for security
purposes. By default,
authentication is required
for Google. If left
unchecked, the SMTP
server must accept
anonymous connections,
which is not
recommended. 

Enable SMTP over SSL or
TLS

Select the appropriate
option from the dropdown
to use Secure Socket
Layer, Transport Layer
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Security, or no encryption
when connecting to the
mail server.

Gmail Email Address Enter the email address to
connect to the SMTP
server.

Gmail Password Enter the password
associated with the
entered email address.

Other SMTP Mail Server The web address of the
external email server
Sugar will connect to.

SMTP Port The communication port
number used for
connecting to the mail
server.

Use SMTP Authentication Check this box to require
server authentication for
the account. Most email
servers require
authentication for security
purposes. By default,
authentication is required
for email providers such
as Outlook. If left
unchecked, the SMTP
server must accept
anonymous connections,
which is not
recommended. 

Enable SMTP over SSL or
TLS

Select the appropriate
option from the dropdown
to use Secure Socket
Layer, Transport Layer
Security, or no encryption
when connecting to the
mail server.

Username Enter the user name to
connect to the SMTP
server.

Password Enter the password
associated with the
entered user name.
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Email Options

The Email Options section provides some global options for email configuration.
Check the box next to the desired options:

Note: Logged-in users must log out and back in for changes to the following
settings to take effect.

Assignment Notifications: When enabled (default), Sugar will send email
notifications to users automatically when records are assigned to them.
When assigning a record to yourself, you will not receive a notification of
the assignment.
Note: To receive notifications, users must also have "Notify on Assignment"
checked in their user profile.
Send notification from assigning user's e-mail address: Enable this
option to have Sugar send notifications from the email address and name of
the user who is assigning a record to another user. This option is disabled
by default.
Note: The SMTP server being used must allow sending from a different
email address than the authenticated account and the email account may
need to be configured to allow the Send As permission. For more
information, please refer to the following articles:

Configuring "Send As" Permissions With Exchange
Configuring "Send As" Permissions With Office 365 
Configuring "Send As" Permissions With Gmail 

Allow users to configure email accounts: Determines whether users
can create new outgoing email accounts. When enabled (default), users will
see a Create button when they navigate to Emails > Email Settings.
Opt-out new email addresses by default: Enable this option to mark
new email addresses added to Sugar records as opted-out by default. Email
addresses that are marked as opted-out cannot receive campaign emails
from Sugar. Please note that changing this setting will not affect email
addresses already existing in Sugar. For more information on opted-out
email addresses, please refer to the Emails documentation in the
Application Guide.

Email Security Settings

The Email Security Settings section allows Sugar administrators to decide which
HTML tags are allowed to be displayed in Sugar. The selected tags will not be
allowed for viewing within Sugar. There are two options to mass set the tag
selection:

Select Outlook default minimum security settings: Select this option
to automatically select every tag that Outlook also restricts. This will not

                         221 / 829

https://support.sugarcrm.com/knowledge_base/email/configuring_send_as_permissions_with_exchange/index.html/
https://support.sugarcrm.com/knowledge_base/email/configuring_send_as_permissions_with_office_365/index.html/
https://support.sugarcrm.com/knowledge_base/email/configuring_send_as_permissions_with_gmail/index.html/
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/emails/#Understanding_Email_Address_Opt-Outs


 

strip the style tag which is used by default in Outlook. This option is
selected by default.
Toggle All Options: Select this option to either select all tags or deselect
all tags.

After selecting one of those options you can individually select or deselect
additional tags to restrict or allow the tags, respectively.

Related Contacts Emails

The Related Contacts Emails section allows administrators to enable or disable
related contact's emails from appearing in the Emails subpanel and History dashlet
for certain modules (Cases, Accounts, Opportunities). In order to have emails from
related contacts appear in the Emails subpanel, simply mark the checkbox to the
right of the module name (e.g., Opportunities). To disable related contact's emails
from appearing in the Emails subpanel, uncheck the box for the specific module as
necessary. Click "Save" to preserve the change.

  

Campaign Email Settings

Note: The Campaigns module is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
License Types Matrix documentation. 

The Campaign Email Settings section allows Sugar administrators to configure
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some backend settings for sending campaign emails. Select the appropriate values
for the following fields:

Number of emails sent per batch: When the "Run Nightly Mass Email
Campaigns" scheduler runs, it will send out the specified number of emails
for a single run. The default is set to 500. Some email servers have one or
more of the following restrictions for a specific timeframe (e.g., hour, day,
etc.): the number of unique recipients, how many times the same email can
be sent to individual recipients, and the most common, how many emails
can be delivered. This setting helps control the outgoing email to conform
to these restrictions. For example, if your scheduler is set to run every
hour, the number of emails to send per batch is set to 500, and you have
1600 emails to send out, starting at 2:00 AM the last batch of emails will be
sent at 5:00 AM. Please check with your email provider to determine the
proper level.
Location of campaign tracking files: Campaign tracking files log
responses from campaign targets. If you are running Sugar on an external
network, select "Default" to accept the default location. However, if your
Sugar instance is behind a firewall, then choose "User Defined" and specify
the path to your external web server in the field below. The external web
server must have the ability to connect to your Sugar instance behind the
firewall. Ensure that you create a file named index.php to handle requests
for three different types of entry points: campaign_trackerv2, removeme,
and image, and place the index.php file in the path to your external web
server. This index.php file must make the appropriate calls to the index.php
file located in the root of your Sugar instance in order to properly record
the activities in Sugar. For more information on how to set up a custom
campaign tracker page, please refer to the Using a Custom Page For
Campaign Trackers section of the Advanced Config Options documentation
in the Administration Guide.
Keep copies of campaign messages: Set this option to "Yes" to keep a
copy of every email sent during a campaign. If "No" is selected, the
template is saved and one copy of the email is stored in the Emails module.
The email record will have an empty To field but the recipients will be
visible in the email's related records subpanels. The default is set to "No".
Note: Storing every email sent does take up space in the database and can
reduce performance. We recommend setting this value to "No".
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Make any necessary changes and click "Save" to commit the changes.

Email Queue

The Email Queue option in Admin is where Sugar administrators can monitor and
perform actions on queued email. When sending a campaign, the emails are not
sent immediately but are instead queued to be sent. Each queued email has a
"Send On" date and time set by the campaign they are sent from. The scheduler
"Run Nightly Mass Email Campaigns" takes the queued emails that are ready to be
sent based on this date and time and sends them in batches. If an email fails to
send from the queue for any reason it will be flagged as a send attempt and, by
default, Sugar will not attempt to send that email for another 24 hours. Once
Sugar reaches six failed attempts to send an email it will be deleted from the
queue. In order to send a failed email sooner than the default 24 hours, you can
perform a mass update to reset the In Process field. For more troubleshooting
information, refer to the Troubleshooting Campaigns Failing to Send From Email
Queue article. This section will cover how to use the email queue as well as the
various actions and options available from within the email queue.

Note: The Campaigns module is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
License Types Matrix documentation. 

Viewing via List View

The email queue list view displays all queued email records meeting the current
search criteria. To access the list view, simply click the Email Queue link on the
Admin page. List view shows key email fields including links to the Campaign,
Recipient, and Marketing Message records. For more information on viewing
queued email via list view, please refer to the Email Queue List View section.

Searching Queued Email
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The email queue list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Email Queue list view
below. Please note that Sugar automatically appends the wildcard character (%) to
the end of your search phrase. This allows the system to retrieve all records that
start with the keyword entered in the search. If you would like to broaden the
search, you can use the wildcard at the beginning of your text as well (e.g.,
%services). This will pull up any record that has the word "services" in the name,
regardless of how it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
The buttons and checkboxes available in Basic Search panel have the following
functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.

Once the search is complete, the relevant results will populate in the list view
below the search panel. To see all queued email records to which you have access,
simply click "Clear" and then "Search" to perform a blank search with no filters.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.
Layout Options: Use the expandable Layout Options section to configure
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your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches: Save, recall, update, and delete searches that you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you enter a
campaign name to search and a recipient name, Sugar will only return queued
email records with matching both fields. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all queued
email records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters.

Email Queue List View

The Email Queue list view displays all queued email records meeting the current
search criteria and to which your user has access. You can view the basic details of
each email within the field columns.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Advanced Search. For more information on configuring
your list view, please refer to the Layout Options section of the Search
documentation.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
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change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration Guide.

Checkbox Selection

You can perform several actions on queued email records directly from the list
view by first selecting the desired records. To select individual queued email
records on the Email Queue list view, mark the checkbox on the left of each row.
To select or deselect multiple queued email records on the list view, use the
options in the checkbox dropdown menu:

Select This Page: Selects all records shown on the current page of
results.
Select All: Selects all records in the current search results across all pages
of results.
Deselect All: Deselects all records that are currently selected.

 

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more queued emails at a
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time.
Mass Update Mass update one or more queued emails

at a time.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

Deleting Queued Email

If a queued email is invalid or should no longer be sent, it may be deleted from the
list view. The list view allows for mass deleting multiple records at once. Deleting
queued emails will not delete the campaign or target, but will remove the instance
of this email so it will not be sent.

Mass Deleting via List View

Use the following steps to delete one or more queued email records via the list
view:

1. Navigate to the Email Queue list view by clicking the Email Queue link on
the Admin page.

2. Use the Basic or Advanced Search to find the queued email records you
wish to delete.

3. Select the desired records individually or using the checkbox dropdown's
options.

4. Choose "Delete" from the Actions menu.

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.
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Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of queued email records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Mass Updating Queued Email

Mass Updating allows users to make the same change to multiple queued email
records at once from the Email Queue list view. Currently, only fields with the data
type of date, datetime, dropdown, multiselect, and radio may be altered during a
mass update. Due to the PHP memory limitations on the server, there may be
occasions when the application times out while mass updating a large number of
queued email records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Use the following steps to mass update queued email records from the list view:

1. Navigate to the Email Queue list view by clicking the Email Queue link on
the Admin page.

2. Use the list view's Basic or Advanced Search to find the queued email you
wish to modify.

3. Select the desired records individually or using the checkbox dropdown's
options.

4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.

Note: After an email has failed to send, setting In Process to "No" will flag
the email to attempt to send again. Otherwise, the email will not attempt to
be sent again until 24 hours have passed. Optionally set the Send Date to
configure when the email should be attempted again.

6. Click "Update" to save the changes to all of the currently selected queued
email records.
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Sending Queued Email

Email in the queue will be automatically be sent out in batches by the "Run Nightly
Mass Email Campaigns" scheduler. For more information on setting up and
configuring scheduler, please refer to the Schedulers documentation in the
Administration Guide. Alternatively, you can manually send a batch of emails in the
queue. The amount of queued email that will be sent is equal to the "Number of
emails sent per batch" value specified in the Campaign Email Settings.

Use the following steps to manually send a batch of queued emails from the list
view:

1. Navigate to the Email Queue list view by clicking the Email Queue link on
the Admin page.

2. Choose "Send Queued Campaign Emails" from below the list view.

3. Sugar will then send a batch of queued email whose Send On date and time
is equal to now or in the past.
Note: If an email fails to send it will not be tried again for 24 hours.

Selecting specific records and searching for specific records will not determine
which queued emails will be sent. This process will send a batch of emails that are
queued to be sent in order by the Send On field. For more information on setting
the batch amount, please refer to the Campaign Email Settings section. 

Note: If your batch size is set high and you have a lot of queued email, this process
can take a while to run through a single batch.

Note: The Campaigns module is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
License Types Matrix documentation. 
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Creating via Duplication

You can also create a new group mail or bounce handling account by duplicating
an existing inbound email account record. The copy option is useful if the inbound
email account you are creating has similar information to an existing inbound
email account.

Use the following steps to create an inbound email account by duplicating an
existing record:

1. Navigate to an inbound email account record's detail view.
2. Click "Copy".

3. The displayed edit view is pre-populated with the original account's values.
Update the necessary fields, then click "Save".

Email Archiving

The Sugar Email Archiving service allows users to easily archive email to Sugar
records simply by sending the email to a special email address. The email
archiving service monitors the email address and imports the email into your
instance of Sugar and links related records without the use of a plug-in or other
syncing process.

This section explains how the administrator can enable the Sugar Email Archiving
service. For complete steps to use Sugar Email Archiving once it is enabled, please
refer to the Emails documentation in the Application Guide. 
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Enabling Email Archiving

Before you can use Sugar Email Archiving, you need to enable the service for your
instance. Email Archiving can be enabled for multiple instances per license key,
but each instance must be registered independently and receive its own, unique
email address. If you clone an instance that has Email Archiving enabled, the clone
will show as having Email Archiving enabled, but must have the service disabled
and re-enabled in order to receive its own email address and start using the
service. For further troubleshooting information, refer to the Troubleshooting the
Sugar Email Archiving Service article.

Use the following steps to enable email archiving via the Administration page:

1. In the Email section of the administration page, Select "Email Archiving".
2. Read the Email Archiving feature description, Master Subscription

Agreement, and privacy policy.
3. Select the checkbox to agree to the teams and click "Enable Email

Archiving".

Note: Your instance needs to be reachable over the internet from
SugarCRM's Email Archiving server. For more information, refer to the 
Troubleshooting Sugar Email Archiving (SNIP) Activation article.

4. The next screen displays the unique email address assigned to your
instance for Email Archiving. Forward emails to this email address to
automatically archive the messages to Sugar.

To begin using the email archiving service, please refer to the Emails
documentation in the Application Guide. To turn off this feature, navigate to Admin
> Email Archiving and click "Disable Email Archiving".

Note: If you disable and then re-enable Email Archiving, you will be assigned an
archiving email address that is different than the one you were using before.

Inbound Email

Inbound Email allows external email to be pulled into Sugar. Inbound accounts can
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be configured as either group email accounts or bounce email accounts
. Group inbound accounts can be configured to create case records in Sugar or
send automatic replies to imported email. Prior to Sugar 7.10.x, you could enable
the "Allow users to send emails using the "From" Name and Address as the reply-to
address" option to allow users on teams who had access to the group email
account to be able to select the "From" name and email address associated with
the group email account when composing emails in Sugar. As of Sugar 9.0.x, you
can instead create shared email accounts directly via Emails > Email Settings
which allows groups of users belonging to the assigned team(s) to send outbound
email messages using the same email account (e.g., support@example.com). For
more information on creating shared email accounts, please refer to the Emails
documentation. The following sections will cover how to use the Inbound Email
module as well as the various actions and options available from within the
module.

Note: The Check Inbound Mailboxes scheduler must be configured and running in
order to retrieve inbound email messages in Sugar. For more information on
setting up and configuring the inbound email scheduler, please refer to the 
Schedulers documentation.

Inbound Email Fields

The Inbound Email module contains a number of stock fields that come out-of-the-
box with Sugar in order to configure inbound email accounts. The below
definitions are the meanings for the available fields.

Field Description
Assign To Teams The Sugar team(s) assigned to the email

record.
Note: Users will only be able to see
emails in group accounts as allowed by
their team memberships.

Auto-Reply Template Select an existing template or click
"Create" to create a new one to send an
automated response notifying email
senders that you received their email.
Note: If both Auto-Reply and Case Reply
templates are selected, Sugar will
respond to the sender with the Case
Reply template only.

Create Case from Email Select this option to create cases
automatically from inbound emails. Only
available for Group Accounts and
defaults to not checked.
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For more information on creating cases
via email, the distribution method, and
case auto-reply, please refer to the 
Creating Cases From Email section.

Distribution Method Only available if Create Case from Email
is checked for a Group Account and
allows you to select Round-Robin or
Least-Busy for assigning the new cases.

Email Provider Select the email provider for the
inbound email account.
Note: The "Google Mail" and "Exchange
Online" options allow you to connect
your Sugar instance to these email
services via OAuth2. The "Other" option
covers all other email account
configurations (e.g., Yahoo) that are
supported in Sugar.

From Address Enter the email address ( e.g.,
serviceinfo@example.com) that will
appear as the "From" email address for
automatic responses to imported email.
Defaults to the email address from your
user profile.

From Name Enter the name (e.g., Service Info) that
will appear as the "From" name for
automatic responses to imported email.
Defaults to your first and last name from
your user profile.

Import Emails Automatically Select this option to create email
records automatically in Sugar for all
incoming emails. Only available for
Group Accounts and defaults to
checked.

Leave Messages On Server Select this option if you do not want to
remove emails from the server when
they are opened in Sugar. This will allow
the messages to remain visible and
appear unread in other email clients.
Only available for Group Accounts and
defaults to Yes.

Mail Server Address The web address of the external email
server from which emails will be
imported in Sugar.
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Mail Server Port The communication port number used
for connecting to the mail server.

Mail Server Protocol The mail protocol used to communicate
with the mail server. IMAP is the default
selection and provides the best
functionality with Sugar.

Monitored Folders The folders in your external account
that Sugar will monitor. Inbox is
selected by default. To select one or
more folders to monitor click "Select"
and then pick the folders in your
external account for Sugar to monitor.

Name The name or designation of the account.
New Case Auto-Reply Template Only available if Create Case from Email

is checked for a Group Account and
allows you to select or create an
automated response template notifying
email senders that a case has been
created to resolve their issue.
For more information on creating cases
via email, the distribution method, and
case auto-reply, please refer to the 
Creating Cases From Email section.

No Auto-Reply to this Domain Enter a domain name or multiple
domains separated by commas to
exclude from receiving auto-reply
emails. It is common to specify your
organization's domain to prevent auto-
replies from being sent to your
organization's members.

Number of Auto-responses Set the maximum number of auto-
responses to be sent to a unique email
address during a period of 24 hours.

Password Enter the password associated with the
email address or username.

Reply-to Address Enter the email address that will receive
any replies to the auto-reply template. If
left blank, replies will be sent to the
From Address.

Reply-to Name Enter the name that will be used to
receive any replies to the auto-reply
template. If left blank, replies will be
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sent to the From Name.
Sent Folder Select a folder from your external

account to store any email being sent
from that account through Sugar.

Status The current status of the account (i.e.,
Active, Inactive).

Trash Folder Select a folder from your external
account to be designated as the trash
folder. Sugar will place deleted emails
into this folder on your external
account.

Use SSL Check this box to force the connection
and communication between Sugar and
the mail server to use a secure socket
layer of encryption.

Username Enter the email address or username
used to connect to the SMTP server.

Inbound Email Module Tab

Click the Inbound Email module tab in the navigation bar, shown after selecting
Inbound Email in the Admin page, to access the Inbound Email list view. You may
also click the three-dots menu in the Inbound Email module tab to display the
Actions and Recently Viewed menus. The Actions menu allows you to perform
important operations within the module. The Recently Viewed menu displays the
list of inbound email accounts you most recently viewed.

The Actions menu allows you to perform the following operations:
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Menu Item Description
New Group Mail Account Opens the edit view layout to create a

new Group Mail Account.
New Bounce Handling Account Opens the edit view layout to create a

new Bounce Handling Account.
All Mail Accounts Opens the list view layout to display all

inbound mail accounts.
Schedulers Opens the list view layout to search and

display schedulers.

Creating Inbound Email Accounts

There are various methods for creating inbound email accounts in Sugar. The full
edit view layout opens when creating the inbound account directly from the
Inbound Email menu and includes all of the relevant fields for your organization's
accounts.

Creating Group Mail Accounts

One of the most common methods of Group Mail Account creation is via the New
Group Mail Account option in the Inbound Email module tab (visible when you
navigate to Admin > Inbound Email). This opens up the edit view layout which
allows you to enter all the relevant information for the group mail account. Please
note that Group Mail Accounts will only import unread messages from the mail
server.

Use the following steps to create a group mail account via the Inbound Email
module:

1. Navigate to Admin > Inbound Email.
2. Click the three-dots menu in the Inbound Email module tab and select

"New Group Mail Account".
3. Enter appropriate values for the fields in the edit view layout. 

Note: If your mail account is using Gmail, click "Prefill Gmail™ Defaults" to
populate many fields with defaults to connect to Gmail.

4. Once the necessary information is entered, click "Save". Optionally, click
"Test Settings" to verify your entries.
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Creating Bounce Handling Accounts

One of the most common methods of Bounce Handling Account creation is via the
New Bounce Handling Account option in the Inbound Email module tab. This opens
up the edit view layout which allows you to enter in all the relevant information for
the bounce handling mail account.

Use the following steps to create a bounce handling account via the Inbound Email
module:

1. Navigate to Admin > Inbound Email.
2. Click the three-dots menu in the Inbound Email module tab and select

"New Bounce Handling Account".
3. Enter appropriate values for the fields in the edit view layout.  

Note: If your mail account is using Gmail, click "Prefill Gmail™ Defaults" to
populate many fields with defaults to connect to Gmail.

4. Once the necessary information is entered, click "Save". Optionally, click
"Test Settings" to verify your entries.

Note: The Campaigns module is not available for Sugar Serve users. For more
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information on license types and the functionality available for each, refer to the 
License Types Matrix documentation. 

Viewing Inbound Email Accounts

There are various options available for viewing inbound account records in Sugar
including via Inbound Email list view, detail view, and Last Viewed menu.

Viewing via List View

The Inbound Email list view displays all inbound account records. To access the list
view, simply click the Inbound Email module tab in the navigation bar. While list
view shows key inbound account fields, you can click the account's name to open
the record in detail view. For more information on viewing inbound accounts via
list view, please refer to the Inbound Email List View section.

Viewing via Detail View

The Inbound Email detail view displays thorough inbound account information
including all fields. The detail view can be reached by clicking an account record's
link from anywhere in the application including from the Inbound Email list view.
For more information on viewing inbound accounts via detail view, please refer to
the Inbound Email Detail View section.

Viewing via Recently Viewed

As you work, Sugar will keep track of which inbound accounts you have recently
viewed. Click the three-dots menu in the Inbound Email module tab to see a list of
the 3 records you most recently viewed in the module. Clicking the record's name
within the list will open the record in detail view.

                         239 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Navigation_Bar


 

Inbound Email List View

The Inbound Email list view displays all inbound account records meeting the
current search criteria and to which your user has access. You can view the basic
details of each account within the field columns.

Modifying the Case Macro

The Case Macro field determines what distinct string Sugar will use to match
emails to the Cases module. The case macro string can be added anywhere within
the email subject and does not need to be at the beginning for it to match. The
Case Macro is on the Inbound Email list view and displays the current case macro
string. By default, this string is set to [CASE:%1]. To customize it, you can change
CASE to a different word, but you must preserve the rest of the string; for
example, [TICKET NUMBER:%1].

Note that the macro is case-sensitive and also takes spaces into consideration. As a
result, capitalization and spacing must match the case macro to ensure that the
email is related to the case. For example, using the default case macro of
"[CASE:%1]", incoming emails must have no space before the case number and the
text must use the same capitalization in order to be related to the existing case.
That is, an email with the subject "[CASE:1234]" will automatically be related to
case number 1234 while an email with the subject "[CASE: 1234]" or "[Case:1234]"
will not.
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Click "Save" to preserve your changes.

Pagination

List view displays the current results broken into pages that you can scroll through
rather than displaying potentially thousands of rows at once. To the right just
below the case macro you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration Guide.

Checkbox Selection

You can perform several actions on inbound account records directly from the list
view by first selecting the desired records. To select individual inbound account
records on the Inbound Email list view, mark the checkbox on the left of each row.
To select or deselect multiple inbound account records on the list view, use the
options in the checkbox dropdown menu:

Select This Page: Selects all records shown on the current page of
inbound account results.
Select All: Selects all records across all pages of inbound account results.
Deselect All: Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown typically allows you to
perform various actions on the currently selected records.

The only action available from the Inbound Email list view is the following
operation:

Menu Item Description
Delete Delete one or more inbound accounts at

a time.

Column Sorting

List view provides the ability to sort all of the current results by a field column in
either ascending or descending order. To sort by a field or switch the sort
direction, click the column header noting that the fields which allow sorting will
have a pair of arrows. The list view may be sorted by only one column at a time.

Inbound Email Detail View

The Inbound Email detail view displays thorough inbound account information
including all inbound account fields which are grouped by default into the Mail
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Account Information and Advanced Setup panels. The detail view can be reached
by clicking an inbound account record's link from anywhere in the application
including from the Inbound Email list view.

Action Buttons

The Action Buttons on the top left of each inbound account's detail view allow you
to perform various actions on the current record.

The action buttons allow you to perform the following operations:

Menu Item Description
Edit Edit this inbound account.
Copy Duplicate this inbound email account.
Delete Delete this inbound account.

Editing Inbound Email Accounts

Inbound accounts may be edited at any time to update or add information to the
record. You can make changes to existing inbound account records via the Inbound
Email edit view. Edit view is available within the Inbound Email module and
includes all of the Inbound Email fields you should need.

Editing via Detail View

You can edit inbound accounts via the detail view by clicking the Edit button on
the upper left of the page. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve your changes.

Editing via List View
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You can edit inbound accounts via the list view by clicking the Pencil icon to the
left of each inbound account's name. Once the edit view layout is open, update the
necessary fields, then click "Save" to preserve your changes.

Deleting Inbound Email Accounts

If an inbound account record is invalid or should no longer appear in your
organization's Sugar instance, it may be deleted from either the Inbound Email
detail view or list view. Deleting via the detail view allows you to delete a single
record while the list view allows for mass deleting multiple records at once.
Deleting inbound account records will not delete the email imported from this
account.

Deleting via Detail View

Use the following steps to delete an inbound account record via the detail view:

1. Navigate to an inbound email account record's detail view.
2. Click "Delete".

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Mass Deleting via List View

Use the following steps to delete one or more inbound email account records via
the list view:

1. Navigate to the Inbound Email list view by clicking the Inbound Email
module tab.

2. Select the desired inbound email account records individually or by using
the checkbox dropdown's options.

3. Click "Delete".
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4. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of inbound account records. If
you encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Creating Cases From Email

To create a case via email, simply send an email to a group inbound email account
that has the case creation option selected. The subject and description of the case
are populated with the subject and body of the email respectively. The new case is
assigned to the team defined in the inbound email account record and the case can
be assigned to a specific user in that team based on two rules:

Round-Robin: Sugar distributes cases evenly among all users within the
team.
Least-Busy: Sugar distributes cases to the least busy user within the team.
Least busy is defined by the person with the least number of unread emails
assigned to them.

Note: Case assignment is distributed to all members of the specified team, but
excludes any inherited members of the team due to the "Reports To" structure. For
more information on teams and the Reports To structure, please refer to the Team
Management and User Management documentation in the Administration Guide.

Cases created from email are automatically related to contact and account records
that match the email address in the From field of the email. If a case auto-reply
template is specified, the sender of the email will receive an email based on the
template selected. The response contains the system-generated case number
formatted according to the case macro as a subject line. The body of the email
displays below the template text. The case auto-reply also ignores the "No Auto-
Reply to this Domain" setting.

Note: If both the Auto-Reply and Case Auto-Reply templates are selected, Sugar
will respond to the sender with the Case Auto-Reply template only.
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Developer Tools

Overview

The Developer Tools section of Sugar's Admin page contains various configuration
menus that help you customize your instance to best suit your organization's
needs. Developer Tools allow you to edit the look, feel, and functionality of your
instance, including adding fields, changing layouts, adding automated processes,
and creating entirely new modules.

The Developer Tools section contains the following menus:

Menu Description
Studio Modify fields, relationships, and layouts

for existing modules
Module Builder Create new modules to be deployed into

this instance or exported to other Sugar
instances

Module Loader Upload and manage customization
packages to your instance, such as
additional modules or third-party
integrations

Sugar Portal Configure your Sugar Portal
Workflow Management Manage automated processes in Sugar

to optimize and streamline your
company's business process 

SugarOutfitters Access SugarOutfitters, the official
SugarCRM marketplace, where you can
explore and find a vast selection of third-
party solution add-ons that can add new
capabilities to your Sugar instance. 

Note: The SugarOutfitters option does
not appear for Sugar Sell Essentials
customers. 

Module Names and Icons Change the name, select a color, and
designate an icon or abbreviation for
each module.

Display Modules and Subpanels Hide or display modules and subpanels
across the application

Configure Navigation Bar Quick Create Configure which modules appear in the
Quick Create menu on the navigation
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bar
Configure API Platforms Manage platform identifiers for custom

API integrations
Dropdown Editor Manage dropdown lists to add new lists

or edit existing lists
Relate Fields Denormalization Manage database optimization for large

instances to improve sorting and loading
speeds

Studio

Studio enables administrators to customize stock or custom modules by modifying
fields, page layouts, and more. This allows Sugar to be modified to ideally fit your
organization's needs and terminology. Please note that only users with
administrator or developer access have the ability to make changes via Admin >
Studio. For more information on how to utilize Studio, please refer to the Studio
documentation.

Module Builder

Module Builder enables administrators to create, deploy, and maintain custom
modules in Sugar. For your convenience, the custom modules are based on
templates such as Basic, Person, Company, etc. Modules can then be deployed
within your instance of Sugar so that users can utilize the new module in their
daily process. In addition, modules can be exported for additional development or
published and then imported to other Sugar instances. For more information on
using Module Builder, please refer to the Module Builder documentation.

Module Loader

Module Loader is used to import packages into Sugar that make changes to core
files. Examples of module-loadable packages include Sugar custom modules that
were created in Module Builder, language packs, third-party integrations, or any
other type of file that would make changes to Sugar's core file system. Module
Loader provides a portal within the application where zip files can be easily
uploaded and then installed. For more information on how to use Module Loader,
please refer to the Module Loader documentation.

Sugar Portal

The Sugar Portal is a powerful tool that allows Sugar users to share published
knowledge base articles with customers and interact with them via notes. Your
customers can log into the portal and review knowledge base articles covering a
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variety of topics such as common troubleshooting tips, frequently asked questions,
etc. The information allowed and viewable in the portal can be updated and
restricted by Sugar users as allowed by team membership, user access type, and
assigned roles. Administrators can configure portal settings, the look and feel of
the theme, and the layout configurations via Admin > Sugar Portal. For more
information on configuring the portal, please refer to the Sugar Portal
documentation.

Workflow Management

Sugar's Workflow functionality allows administrators to configure cause and effect
type actions throughout Sugar and across multiple modules. Workflows can be
used to update fields, send emails, or create records once certain sets of conditions
are met. Workflows are a great way to configure automated processes within
Sugar so that users do not need to remember manual steps and instead can focus
on their primary tasks and job responsibilities. Administrators can create and
manage workflows via Admin > Workflow Management. For more information on
workflows, please review the Workflow Management documentation.

Module Names and Icons

Depending on your business needs, it may be necessary to alter modules' names,
display options, and colors to better align with your various business components.
Administrators can easily rename modules, choose to display an icon or
abbreviation, and choose a background color via Admin > Module Names and
Icons. Changes will be reflected globally across Sugar so that every appearance of
the given module name and icon is updated to your preference, immediately and
seamlessly to all users. Please review the sections below to learn how to configure
your module names and module icons.

Configuring Module Names

When editing a module's name, you are given the option to update both the
singular and plural versions of the word. To rename the modules in a language
other than English, use the Language dropdown field at the top of the
page. Selecting a new language in the dropdown clears out any changes you have
made in the current language. Be sure to save the current language before
selecting a new one.

The following steps cover renaming the Contacts module as an example:

1. Navigate to Admin > Module Names and Icons.
2. Locate the module you wish to change and enter a new singular and plural

name for the module.
3. Click "Save" to deploy your changes across your instance.
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Configuring Module Icons

When configuring a module's icon, you can choose an icon (i.e., image) or
abbreviation (e.g., Co) for what is shown within the circle, and a color for the circle
itself. Please note that updating the module icon options (i.e., the Display and
Module Background Color fields) will apply the change across all languages after
clicking "Save" for the current language you are modifying.

The selections in the Display and Module Background Color fields determine what
will appear in the navigation bar and the module icon. The image below shows
what you can expect to see for the Accounts module, which is using an icon and a
green background, and the Contacts module, which is using an abbreviation and a
pink background.

                         249 / 829



 

The following steps cover updating the Contacts module as an example:

1. Navigate to Admin > Module Names and Icons.
2. Locate the module you wish to change and select "Icon" or "Abbreviation"

from the Display field.
1. If you chose "Icon", select which icon you would like in the next

field.
2. If you chose "Abbreviation", verify the letters in the next field are

correct or edit the letters as needed.
3. Select a color from the available options in the Module Background Color

field.
4. Click "Save" to deploy your changes across your instance.

Display Modules and Subpanels

Administrators have the ability to control which modules and subpanels will appear
in their instance via Admin > Display Modules and Subpanels. This option is useful
as any unnecessary module(s) and subpanel(s) can be hidden to prevent users from
accessing it. Please note that not every module and subpanel in Sugar is enabled
by default when initially installed.

Once the "Display Modules and Subpanels" page is open, you will see the
Displayed Modules, Hidden Modules, Displayed Subpanels, and Hidden Subpanels
columns. To configure which modules are displayed on the navigation bar, drag
and drop the module from the Hidden Modules column to the Displayed Modules
column. To hide a module, simply drag and drop the module from the Displayed
Modules column to the Hidden Modules column. To configure which subpanels
appear in modules, drag and drop the module from the Hidden Subpanels column
to the Displayed Subpanels column. To hide a subpanel, simply drag and drop the
module from the Displayed Subpanels column to the Hidden Subpanels column.
After making the necessary changes, click "Save" at the top of the page to deploy
your changes or "Cancel" to revert back to your previous settings.

Please note that if a hidden module is related to a module that is visible in Sugar, it
will display as a subpanel in the record view (for Sidecar modules) or detail view
(for Legacy modules) of the related module. In addition, hidden modules continue
to be available to users when viewing, creating, and managing reports via the
Reports module. When a subpanel is hidden, users cannot view any related records
from the record view (for Sidecar modules) or detail view (for Legacy modules) of
the related module.
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Users have the option to hide and display modules per their viewing preference via
the User Profile. The list of available modules to display and hide in a user's
account is based on the modules in the Displayed Modules column of the Display
Modules and Subpanels page. To disable the users' ability to modify which
modules are hidden or displayed on their navigation bar, uncheck the Allow users
to select modules to appear in the navigation bar checkbox above the Displayed
and Hidden Modules columns.

If you wish to prevent certain users from accessing specific modules in Sugar, you
can keep the module enabled globally but assign a role to the user. For more
information on creating and assigning roles, please refer to the Role Management
documentation.

Configure Navigation Bar Quick Create

The Quick Create menu allows users to easily create new records from anywhere
in Sugar. Simply click the quick-create button on the upper right of any Sugar
page to access the menu. Administrators can easily configure the Quick Create
menu via Admin > Configure Navigation Bar Quick Create menu to control which
modules are enabled/disabled, as well as the order the modules will appear in the
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menu.

Once the "Configure Navigation Bar Quick Create" page is open, you will see the
Enabled Modules and Disabled Modules columns. Modules that appear within the
Enabled Modules column will display in the Quick Create menu. To enable a
module to be displayed in the Quick Create menu, drag and drop the module from
the Disabled Modules column to the Enabled Modules column. To disable a
module, simply drag and drop the module from the Enabled Modules column to the
Disabled Modules column. You can also change the order of the modules as they
appear in the Quick Create menu by dragging and dropping the modules up-and-
down within the Enabled Modules list. After making the necessary changes, click
"Save" at the top of the page to deploy your changes or "Cancel" to revert back to
your previous settings.

Note: The Quick Create menu can display a maximum of 10 modules at one time.

Configure API Platforms

Developers use the platform parameter to distinguish their custom platform from
other clients when using the Sugar API. For example, when a user accesses Sugar
via the desktop client and the mobile client simultaneously without being logged
out of either, it is because the API recognizes that they are different platforms due
to their unique platform identifiers. The platform identifier makes it easy for a
Sugar administrator to configure which API platforms are allowed to access their
instance via Admin > Configure API Platforms. In addition, you can enable or
disable the "Enable Notifications" checkbox next to each platform to specify
whether notifications should be sent to users for record changes applied by that
platform. See the Getting Started page for details on receiving notifications for
record assignments. To learn more about platform identifiers, please refer
to the Dev Blog in SugarClub.

The API Platforms panel is a list of client IDs that have been given permission to
interact with your Sugar instance and the checkbox indicating whether or not
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notifications will be sent to users for the platform's actions. The panel
automatically displays some standard platform identifiers required by every Sugar
instance. The stock API platforms listed in the following table cannot be removed
and must not be reused as platform identifiers for a custom integration:

API Platform Identifier Platform/Client
base Sugar desktop client (default platform)
mobile SugarCRM mobile app
portal Sugar Portal (Sell, Serve)
opi Sugar Plug-in for Microsoft Outlook 2.x
lpi Sugar Plug-in for IBM Notes
collabspot Sugar Connect
collabspotbackend Sugar Connect
discover Sugar Discover
sugarlambda SugarLive
kiosk Sugar Self-Service Center

To allow a new integration for your Sugar instance, find the package's platform
parameter, enter it in the text box below the API Platforms panel, and then click
"Add". You may need to ask your developer to check the
.custom/clients/platforms.php file for this information. Once added, "Enable
Notifications" is turned on by default but can be disabled using the checkbox if you
do not want users to receive assignment notifications triggered by that platform.
To remove any custom API platforms from the list, click the Remove icon next to
the API platform identifier that you wish to remove. Upon removing the platform,
all integrations that relied upon it will stop working.
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Alternatively, developers may choose to create a module loadable package to add
custom identifier(s) via Sugar's Module Loader tool. To remove platform identifiers
that were added via Module Loader, simply uninstall the package. More
information on adding platform identifiers via Module Loader can be found on
the Dev Blog in SugarClub and the Platforms documentation in the Developer
Guide.

Dropdown Editor

The Dropdown Editor allows administrators to view, modify, and create dropdown
lists which can be added as fields in Sugar. Since dropdown lists are not module-
specific, they are stored and managed through the Dropdown Editor. Dropdown
lists can only be associated with dropdown, multiselect, and radio-type fields via
Admin > Studio. For more information on associating dropdown lists to the
different field types, please refer to the Studio documentation.

Some dropdown fields (e.g., Status) are used to group tile views in Sugar, and the
columns displayed in the tile view's header are determined by the values of that
field. So, modifying the values in a dropdown list, such as changing the display
label, will automatically update the column header values in tile view as well. But
please note that adding a new value in the dropdown list will not automatically add
it as a new column header in tile view. Once the new dropdown value has been 
added, you will need to navigate to Tile View Settings and click "Save" in order to
push the new value as a column header in tile view. If you do not wish to add the

                         254 / 829

https://sugarclub.sugarcrm.com/dev-club/b/dev-blog/posts/unknown-platforms-to-be-restricted-in-winter-18-release/
https://support.sugarcrm.com/smartlinks/developer_guide/architecture/extensions/platforms/
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Tile_View


 

new dropdown value as a column header, you can move the value from the
Available Values column to the Hidden Values column in Tile View Settings. 

You can restrict which dropdown values are available to users based on their roles.
For more information about role-based visibility, please refer to the Editing Role-
Based Availability section of this page.

Certain dropdown lists cannot be edited via the Dropdown editor as they are
controlled by a separate area (e.g., Contract Types, Releases, etc.) of the Admin
page. These include dropdown lists for the Forecasting, Bug Tracker, Contracts,
and Products and Quotes modules. Please refer to the appropriate sections of the
Administration Guide for more information regarding the fields and how they can
be edited.

Adding Dropdown Lists

Dropdown lists can be created at any time and added to a Dropdown type field via 
Studio. When creating a list, please keep in mind that this list is not module-
specific, so be sure to properly name your list and any dropdown options to avoid
any confusion in the future.

If desired, you can restrict which dropdown values are available to users based on
their roles. For more information about role-based visibility, please refer to the 
Editing Role-Based Availability section of this page.

Use the following steps to create a dropdown list via Dropdown Editor:

1. Navigate to Admin > Dropdown Editor.
2. Click the Add Dropdown button, which is located above the list of existing

dropdown lists.

3. Enter a name for your dropdown list in the Name field (e.g.,
"account_manager_list").

Note: The name must be alphanumeric and use the underscore
character for spaces.
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4. To create the items that will appear in your dropdown list, enter an "Item
Name" and a "Display Label". Click "Add" once you have populated both
fields to add the value to the dropdown list.

The item name is the backend system name for the list item and
must be alphanumeric. An underscore or a period can be used for
the item name.
The display label defines what will be displayed in the actual
dropdown. Please note that there are no character restrictions
when entering the display label. Click "Add" once you have
populated both fields to add the value to the dropdown list.

5. Once all values have been added to your dropdown list, you can click one of
the sort options to rearrange the values as desired. Lists can be sorted
alphabetically in ascending or descending order based on the display label.
You can also sort the list manually by dragging and dropping the values up-
and-down the list.

6. Click "Save" at the top of the screen to complete and add your dropdown
list. You will be directed back to the main dropdown editor page once the
save completes.
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Viewing Dropdown Lists

The Dropdown Editor displays all existing dropdown lists in two separate sections
(Dropdowns list, Dropdown Editor) on the page. The Dropdowns list to the left of
the page displays the dropdown lists in alphabetical order. The Dropdown Editor
tab displays the dropdown lists in columns and allows you to view more of the lists
at once instead of scrolling down a single list.

Once you locate the dropdown list you are looking for, click the list's name to open
the Edit Dropdown tab to view and edit the list. The Edit Dropdown tab displays
the name, the set language for the list, list values, and the item name. The list will
be ordered as they appear in the dropdown list when added as a field to a layout.
You can reorder the list if you wish by dragging and dropping the items into the
desired positions.

Localizing Dropdown List Values

If your organization uses Sugar in languages other than English, Sugar can display
translated dropdown lists to localize the language. For example, Sugar will display
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Spanish dropdown items when a user is logged into Sugar in Spanish. You must
provide the translations for each language by specifying display labels for each
dropdown item. First, finalize your list's items by adding or removing items; the
item names (a.k.a. database values) and order of items will be consistent across all
languages. Choose the desired language to edit in the Language dropdown above
the list. If the chosen language is different than the system default language, a
Comparison Language dropdown will appear below the Language dropdown.
Select a comparison language to easily compare labels in two different languages
(e.g., Spanish and the system default language of English). The display label is
displayed on the left and the comparison language label is displayed on the right.
Items that are the same in both languages will have an i icon (highlighted in red in
the image below), indicating that there may be an error in translation since the
label is the same for both languages. Click the pencil icon for each item and enter
a translated display label. You can only edit the display label, not the comparison
language label in this edit mode. When all labels have been translated, click "Save"
to preserve your changes. After saving, you will be redirected to the Dropdown
Editor screen.

Editing Dropdown Lists

Dropdown lists can easily be modified via the Dropdown Editor by selecting the
specific dropdown list which opens the edit layout. You can reorder the items in
the list, add new values, remove unnecessary values, change the display label for a
value, or change the display label language. 

Some dropdown fields (e.g., Status) are used to group tile views in Sugar, and the
columns displayed in the tile view's header are determined by the values of that
field. So, modifying the values in a dropdown list, such as changing the display
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label, will automatically update the column header values in tile view as well. But
please note that adding a new value in the dropdown list will not automatically add
it as a new column header in tile view. Once the new dropdown value has been 
added, you will need to navigate to Tile View Settings and click "Save" in order to
push the new value as a column header in tile view. If you do not wish to add the
new dropdown value as a column header, you can move the value from the
Available Values column to the Hidden Values column in Tile View Settings. 

If desired, you can restrict which dropdown values are available to users based on
their roles. For more information about role-based visibility, please refer to the 
Editing Role-Based Availability section of this page.

Please note that the name of the dropdown list cannot be changed once created.
Also, dropdown lists cannot be deleted since they can span multiple modules in
Sugar and cause important data to be lost if removed in error. Once the necessary
modifications have been made, click "Save" on the upper right to preserve the
changes made.

To sort the list alphabetically, you can simply click the Sort Ascending or Sort
Descending button on the bottom left of the tab view. Please note that the sorting
is based on the display label. You can also reorder the items in your list, by
dragging and dropping the items into the desired position.

To add a new value, enter an item name and corresponding display label below the
list of existing values then click "Add". Please note that the item name is the back-
end system name and must be alphanumeric without any special characters other
than an underscore or a period. The text in the display label defines how the value
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will be displayed in the dropdown list when viewed in the user interface. Please
note that there is no character restriction for the display label.

To remove a value from the list, click the Minus icon to the far right of the item
row. Once deleted, the item will show a strikethrough and will be removed from
the list once saved.

The item name of a dropdown value cannot be edited, but you can update the
display label via the Dropdown Editor. Simply locate the value in the list then click
the Pencil icon to the far right of the item row. Enter the new value into the open
text box then click anywhere on the page to close the edit.

Editing Time Intervals

The "After Time Elapsed" workflow triggers after a specified period of time has
elapsed from when a record save occurs in Sugar. For more information on "After
Time Elapsed" workflows, please refer to the Workflow Management
documentation. When creating the conditions for the workflow, you have the
option to specify the time interval (e.g., 0 hours, 4 hours, 1 day, 1 week, etc.) used
by the system to execute the workflow. The available time interval values can
easily be modified via the Dropdown Editor.

The Dropdown Editor contains the "tselect_time_dom" list, which allows
administrators to configure the time intervals used for time elapsed workflows. To
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add new time intervals to the dropdown list, simply enter the "Item Name" and
"Display Label", keeping in mind that the item name must display the number of
seconds corresponding to the new time interval. The display label value should
have the time as it relates to minutes, hours, days, etc. For example, if you are
adding 2 hours to the time interval list, the item name value will be "7200" and the
display label will show "2 hours".

Editing Role-Based Availability

You can restrict which options are available for a user to select when he or she is
editing records based on the user's role. When editing a particular dropdown list,
the Roles dropdown appearing on the top right contains all existing roles in the
Sugar application. The Default role-list allows admins to add, remove, or reorder
options within a dropdown list. By default, none of the other Sugar roles have
customized lists, so changes made to the Default role-list will automatically be
copied to the other role-lists upon save. This means that as long as no role-lists are
customized here, all users will continue to see the dropdown options and order
matching the Default role-list.

Note: It is recommended to assign each user to a maximum of one role. Users
belonging to multiple roles which each have customized role-views may experience
unexpected behavior when using record views. For more information about roles,
please refer to the Role Management documentation.

If you wish to restrict certain roles to use a modified list of options when editing
records, select the desired role from the Roles dropdown to make changes specific
to that role (e.g., Marketing Administrator).

When viewing a Sugar role's role-list (e.g., Marketing Administrator), you have the
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option to disable, enable, or reorder the existing options. Options cannot be added
or deleted via any role-list except "Default". Drag and drop an option in order to
change its position in the role-list's options list. To disable an option, deselect
the checkbox in the option's row. Doing so will prevent the option from appearing
in the dropdown when a user belonging to this role is editing or creating a record.
Once an option is disabled, it will appear greyed out with a strike-through. When
the desired changes have been made, click "Save & Deploy".

Note: Each role's role-list must have at least one enabled option.

Once you have saved and deployed a modification to a role-list, it is considered
customized and will display an asterisk (*) next to the role's name in the Roles
dropdown. Reordering options on the Default role-list will no longer have any
effect on customized role-lists. However, adding an option, deleting an option, or
changing an option's display label on the Default role-list will add, remove, or alter
the option for all role-lists including customized role-lists.

Note: A user who is restricted by their role from a value in a list will not be able to
select that value when editing a record, but they will see the value on the record
view if a different user has set it. 

Note: Role-based customizations to dropdown lists are included when exporting
customizations from Studio. For more information, please refer to the Studio and 
Module Loader documentation.

Relate Fields Denormalization

Relate Fields Denormalization is a Sugar administration tool that can be used by
customers with very large database tables to optimize the database structure for
faster sorting and data load of relate-type field values on list view pages. The
denormalization process will copy the values of stock Sugar relate fields from their
own tables into a text field (e.g., denorm_field_name) in the table of the related
module (i.e., the parent table) via cron job. The new text field is then used for
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sorting in list views. Then, a logic hook will continue to monitor any value changes
made to the relate field, the source field that the relate field points to, and to the
linked record ID. The logic hook will also react to changes made to the
relationship.

As an example, you may want to denormalize the Account Name relate field for the
Opportunities module so that when you sort by Account Name in the Opportunities
list view, Sugar will query its search against the field value in the Opportunities
table instead of against the JOIN table for accounts_opportunities.

Note: While denormalizing the data will speed up sorting in list views, it may
increase the time it takes to update records in the denormalized module (1-5%
degradation in the worst case).

To denormalize a relate field in your instance, use the following steps:

1. Navigate to Admin > Relate Fields Denormalization, located in the
Developer Tools section of the page.

2. Choose the module that contains the relate field you would like to
denormalize. Each module's name will display a number that indicates how
many relate fields are eligible for denormalization in that module. The
following criteria must be met in order for a field to be eligible for field
denormalization:

The field must be a stock relate-type field. Custom fields cannot be
denormalized.
The field must be configured as "Available" in the list view layout
for the module. For more information on list view layouts, refer to
the Studio documentation.
The relate field must be sortable in the list view. This is not an
admin configurable option, so we recommend confirming this before
continuing.

3. Click on the field name that you want to denormalize under "Field List" and
drag and drop it to the "Denormalized Fields" section on the right.

4. Click Save.
5. Review the Pre-check Results window and take note of the estimated time

to complete, which could take up to an hour depending on the table sizes.
Click "Confirm" to continue. Alternatively, you may choose to copy the SQL
shown in the window, click "Cancel", and execute the command manually if
you would prefer not to initiate the cron job.
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After confirming, the process will continue in the background and show its
progress in the Work Status field. You may click on the refresh icon to update the
latest progress until it is "Done".

You may click on the Remove (x) icon to remove your scheduled denormalization
job from the job queue, but as best practice, it is recommended to allow an in-
process job to fully complete without stopping it. Denormalization changes that
have been applied to a field can be reversed by moving it from the "Denormalized
Fields" side back to "Field List" and clicking "Save". Reversing a denormalization
action will remove the related logic hook and Sugar will resume using the regular
field, but the denormalized field will still exist in the database.

Studio

Overview

Studio enables administrators to modify Sugar's fields, page layouts, and more to
fit your organization's needs and terminology. Only users with administrator or
developer access can make changes via Admin > Studio. 
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Scope

This documentation covers how to use Studio, including the various actions and
options available within Studio. The Studio documentation contains the following
pages:

Studio (current page)
Fields
Action Buttons
Relationships
Layouts
Mobile Layouts
Subpanels
Sugar Logic

Additionally, the User Interface page in the Application Guide contains
documentation for the user-facing elements that are configured in Studio, and the 
Knowledge Base contains several business use-case tutorials and best practices to
employ when using Studio.

Navigation

Studio's navigation is different than other modules within Sugar. Studio is divided
into three main sections: the main panel, the Modules panel, and a footer.

Main Panel

The main panel in Studio is where you can access the modules, add fields,
configure layouts, and perform other in-app customizations. It displays to the right
of the Modules panel and houses the various components (e.g., fields, layouts,
subpanels, etc.) of the module. As you select the different components, they will
load in new tabs on the main panel.

For example, if you select "Fields" on the main panel, the list of available fields
along with the options to configure will appear under the Edit Fields tab.
Additional tabs that appear as you configure the module can be closed by clicking
the "X" within the tab.
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The main panel also includes a breadcrumb bar showing your current location in
Studio. You can navigate to a specific section by clicking the link within the
breadcrumb bar.

To go back to the previous page that you were viewing, click the Left arrow on the
breadcrumb bar. Clicking the Home icon to the right of the arrow will navigate you
back to the Developer Tools home page.

Modules Panel

The Modules panel is located to the left of the page and displays a list of existing
stock and custom modules that are editable through Studio. Please note that all
modules (e.g., Campaigns, etc.) using the Legacy user interface will display an
asterisk (*) to the right of the module's name in Studio. The associated fields,
labels, layouts, subpanels, etc. are grouped within each module. Click the plus sign
(+) preceding the module name to expand the module tree and display the
associated items (e.g., fields, layouts, etc.). Simply select an item in the Modules
panel to load the view in the main panel to the right.

Please note that if you do not see the Modules panel, it may be collapsed. Locate
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the gray bar to the left of the main panel and click the Right arrow to expand the
Modules panel.

Footer

The footer is located at the bottom of Studio pages and displays buttons that
enable you to navigate to the different areas (e.g., Dropdown Editor) of Developer
Tools.

The options in the footer allow you to navigate to the following locations:

Menu Item Description
Home Navigates to the home page of the

Developer Tools
Studio Navigates to the home page of Studio
Module Builder Opens Module Builder to create or edit

modules
Sugar Portal Editor Opens the Sugar Portal Editor to

configure the Portal
Dropdown Editor Opens the Dropdown Editor to modify

dropdown options

Editing Labels

Labels are used throughout Sugar to designate field headers, subpanel titles, error
messages, and more. To modify the labels for a module, select "Labels" from the
Modules panel under the desired module (e.g., Accounts). Please note that HTML
tags are not supported in labels. If you need to define labels for more than one
language profile in Sugar, refer to the Editing Labels for Localized Languages
section.
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The Edit Labels tab will open in the main panel displaying all the labels associated
with the module. If the label you want to change cannot be found, change the filter
dropdown option from "Frequently used labels" to "All Labels".

Modify the labels accordingly per the selected language and click "Save and
Deploy" when complete. This will save your changes and instantly deploy them to
your Sugar instance.

To change the name of the module, click "Change Module Name" to the right of
the Save & Deploy button.

This will direct you to the Module Names and Icons page where you can change
the labels for the module accordingly. For more information on how to rename
modules, please refer to the Module Names and Icons section of the Developer
Tools documentation.

 

Editing Labels for Localized Languages

For instances where localization is needed, use the Language dropdown to select a
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language other than the system default.

When a non-default language is selected, the system's default language and
associated labels will appear on the right side of the screen in the Comparison
Language column. The Comparison Language dropdown can then be changed as
needed. The labels should be updated in the left column and are read-only in the
right column. Please note that some labels may appear with a help button
indicating that "This label may not be translated". Once you have made the
necessary changes to your labels, click "Save & Deploy".

Resetting Modules

Sugar comes with the ability to reset an entire module back to the default settings.
You can also pick and choose which customizations you would like to remove. To
reset a module, select the module from the Modules Panel and click "Reset
Module" in the Main Panel.

The next screen will give you the following options to remove specific
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customizations:

Clear Relationships: Deletes all relationships added via Studio.
Remove Custom Fields: Deletes all fields added via Studio.
Reset Layouts: Resets the layouts back to the out-of-the-box configuration.
You will need to click "Save & Deploy" on edit view and detail view layouts
to be able to access the layouts.
Reset Labels: Deletes the custom language files located in
./custom/modules/{Module Name}/language/ which sets the labels for the
module.
Clear Extensions: Deletes any customizations made to stock or custom
fields and sets them back to the default. Deletes the module folder located
in ./custom/Extension/modules/.

Select the desired options and click "Reset" to execute the reset.

Exporting Customizations

Sugar allows you to export a module's customized layouts, fields, and field labels
from one Sugar instance to import into another Sugar instance. To do this, you will
need to package the customizations in Studio, export it to your local machine, and
then upload it into another Sugar instance. The system applies the customizations
to the appropriate layouts, fields, and field labels.

Note: Safari users will need to change the default browser setting to disable
automatic unzipping of files to ensure that exported packages install properly in
Sugar. Navigate to Safari > Preferences > General and uncheck "Open 'safe' files
after downloading" to disable the setting. 

Use the following steps to export your customizations via Studio:

1. From the Studio home page, select "Export Customizations" in the main
panel.
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2. Enter appropriate values in the following fields. All required fields are
marked with a red asterisk and must be completed prior to saving.

Package Name: Enter the name of the package to be displayed during
installation.
Author: Enter the name of the author creating the package to be displayed
during installation.
Description: Enter a description of the export to be displayed during
installation.
Select at least one module to include in the customization export and click
"Export".

The customizations are saved to your computer in a zip file that can be
loaded into a different instance of Sugar via the module loader. For more
information regarding installing packages, please refer to the Module
Loader documentation.

Note: Sugar Sell Essentials customers do not have the ability to upload custom file
packages to Sugar using Module Loader.

Exporting Role-Based and Dropdown-Field-Based
Customizations

If you have created role-based or dropdown-field-based custom record views or 
custom dropdown lists, these customizations will be included in your exported
package. When installing the package on another Sugar instance, you will be given
the opportunity to map role-based customizations from the package's roles to the
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destination instance's roles. Please refer to the Module Loader documentation for
more information.

Fields

Overview

The Fields section in Studio allows administrators to create new fields for stock
and custom modules as well as update existing fields. To access the Fields section
in Studio, select "Fields" from the Modules panel under the desired module (e.g.,
Cases) and the Edit Fields tab will open in the main panel.

Field Types

Studio comes out-of-the-box with many different types of fields, which can be
created in Sugar. Please note that the options and properties available when
configuring the field varies for each data type.

The following data types are available in Studio:

Data Type Description
ActionButton Creates buttons in record view for

shortcuts to specific actions (e.g., create
email). Please refer to the Action
Buttons documentation for information
on configuring Action Button fields.

Address Creates fields for street, city, postal
code, state, and country.

Note: Custom address fields cannot be
grouped together like stock address

                         272 / 829



 

fields (e.g., billing address).
AutoIncrement Creates a field that automatically

populates a number, increasing
subsequent records' field values by one,
on the first save of a record. As an
integer-type field, AutoIncrement is
limited at the database level to values
up through 2147483647.

Note: This field cannot be edited.
Checkbox Creates a checkbox for data fields with a

Yes/No action.
Currency Creates a field to enter a currency

value. The system automatically creates
a dropdown of the currency type if the
field does not already exist in that
module.

Date Creates a field to enter a date. Includes
a button for a calendar popup.

DateTime Creates a field to enter the date and
time. Includes a Calendar icon button to
choose a date via the popup calendar, as
well as a dropdown list to select the
time.

Decimal Creates a field to hold a number
rounded to a specified decimal
precision. Sugar stores the exact
representation of the number in the
database (e.g., For a precision of 2:
1.236 is stored as 1.24).

Dropdown Creates a field where you can associate
a dropdown list of values.

Note: For calculated Dropdown fields,
the result of the formula gets written to
the database, and Sugar does not
validate these results. So, if the
resulting value is not a valid option in
the dropdown list, then the dropdown
field will be blank as it found no
matches. For example, if the dropdown
list has values "A, B, C" and the formula
results in a value of "1", then "1" will be
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written to the database, and the field
will appear blank.

Encrypt Creates a field for sensitive information,
such as social security numbers, whose
value is to be encrypted in the Sugar
database. The value is encrypted using
the Blowfish algorithm prior to being
captured in the database. It is decrypted
prior to display in the user interface to
users. The first time an encrypted field
is enabled, a unique key is automatically
generated and stored on the filesystem
in the file
./custom/blowfish/encrypt_field.php.
This generated key is used for all
subsequent field-level encryption and
decryption operations.

Flex Relate Creates a dropdown list from which you
can relate a single record from a variety
of modules. See the Introduction to
Relationships and Relate Fields article
for an explanation of the differences
between relate fields, flex relate fields,
and relationships.

Note: Only one Flex Relate-type field is
allowed per module. Out of the box, the
Flex Relate option is not available for
the Accounts, Calls, Contracts,
Meetings, Notes, and Tasks modules.

Float Creates a field to hold a number
rounded to a specified decimal
precision. Sugar stores the value
differently based on the database
platform Sugar is running on.

HTML Creates static HTML-formatted text to
display in record views.

Iframe Creates a field to store or generate a
URL to display an iframe in record
views.

Note: To load content from an external
website in the iframe field,
administrators will need to add the URL
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(e.g., https://www.example.com) as a
trusted site via Admin > Content
Security Policy Settings.

Image Creates an image field to upload an
image to display on a record.

Integer Creates a field to specify positive or
negative numbers with no decimal
places.

Note: Integer fields are limited at the
database level to values up through
2147483647.

MultiSelect Creates a dropdown list of values where
multiple values can be selected at once.

Phone Creates a field to enter a phone number.
If the Enable Click-to-Call setting is
turned on in Admin > System Settings,
phone number fields are displayed as
links that can be opened to dial them
using the default computer telephony
integration software on the user's
computer.

For Sugar Sell or Serve users logged in
to Amazon Connect, calls are dialed in
SugarLive.

Radio Creates a radio button for a user to
select one value from a dropdown list.

Relate Creates a field to associate a record
with another module's record as a one-
way relationship. You can add multiple
Relate fields to a module.

Note: Relate fields and custom
relationships are independent of each
other. Changes made to either one are
not reflected in the other. Relate fields
can be added to a report, but any data
on the related record cannot be
accessed in the report. To access
related record data in a report you will
need to create a custom relationship.
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See the Introduction to Relationships
and Relate Fields article for an
explanation of the differences between
relate fields and relationships.

Relationship This field type cannot be used when
creating a field in Studio, but it is
automatically created for one-to-one and
many-to-one relationships that add a
field representing the relationship in the
module. For example, the Account Name
field on the Contacts module has a type
of "Relationship" because it is based on
a many-to-one relationship between
contacts and accounts. See the 
Introduction to Relationships and Relate
Fields article for an explanation of the
differences between relate fields and
relationships.

TextArea Creates an open text area field for
multiple lines of text.

TextField Creates a field for a single line of text.
URL Creates a field to store or generate a

URL and display as a link.

Note: Name-type and ID-type fields cannot be created via Studio. Each stock
module and module created via Module Builder will have a Name-type and ID-type
field. The Name-type field is automatically displayed in the header of each record
view (for Sidecar modules) while the ID field is not available in Studio but is a part
of the unique URL for each record.

Field Options

Fields provide ways to store different data types in Sugar. While many fields come
with Sugar by default, there can be instances where your organization needs to
create custom fields to store additional data.

Each field, depending on the data type, will have different properties and options
available when configuring the field via Studio. Please note that some properties
can exist across all data types and some are unique to only a few types.

The following properties and options are available for fields in Studio:

Allow Imports
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Applies to: Address, Checkbox, Currency, Date, Datetime, Decimal, Encrypt,
DropDown, Float, HTML, IFrame, Integer, MultiSelect, Flex Relate, Phone, Radio,
Relate, TextArea, URL, TextField

Select one of the following options to determine the field's behavior when
importing records:

Yes: This field is available to be mapped to when performing an import.
No: This field is not available to be mapped to when performing an import.
It will be omitted from the Module Field dropdown list.
Required: This field is required to be mapped to when performing an
import. It will have an asterisk (*) next to it in the Module Field dropdown
list to indicate that it is required.

Audit

Applies to: Address, Checkbox, Currency, Date, Datetime, Decimal, Encrypt,
DropDown, Float, IFrame, Image, Integer, MultiSelect, Phone, Radio, Relate,
TextArea, URL, TextField

Select this checkbox to audit the field for changes made in Sugar. 

Users can view the changes made to audited fields via the View Audit Log
option in the module's record view (for Sidecar modules) or detail view (for
Legacy modules).
Fields marked as "Audit" will generate update posts in the activity stream
for Sidecar modules (e.g., Accounts, Contacts, etc.) whenever the field gets
updated. For more information on activity streams, please refer to the 
Activity Streams documentation.

AutoIncrement Next Value

Applies to: AutoIncrement

This field allows you to set and view which value is the next to be applied to a
record. As an integer-type field, AutoIncrement is limited at the database level to
values up through 2147483647.

Boost Value

Applies to: Phone, TextArea, TextField, URL

Enter a boost value for the field to enhance the relevancy of the field for full-text
search. The default boost value is 1.0 which indicates a neutral boost. To apply a
positive boost, set the boost value higher than 1. To apply a negative boost, use
values lower than 1. For example, a value of 1.35 will positively boost a field by
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135%. But using a value of 0.60 will apply a negative boost. It is not necessary to
perform a full system index when boost values are changed for fields.

Border

Applies to: Image

Select this checkbox to add a border around the image for this field.

Calculated Value

Applies to: Checkbox, Currency, Date, Datetime, Decimal, DropDown, Encrypt,
Float, Integer, Phone, TextArea, TextField

Select this checkbox to designate this field as a calculated field. This opens up the
Formula option and disables the Default Value and Importable options. For more
information regarding entering a formula for a calculated value, please refer to the
Formula option listed in this section. The result of the formula will be entered into
the field for any new or modified records. When selecting this option, the field
value cannot be modified by users.

Note: For calculated Dropdown fields, the result of the formula gets written to the
database, and Sugar does not validate these results. So, if the resulting value is not
a valid option in the dropdown list, then the dropdown field will be blank as it
found no matches. For example, if the dropdown list has values "A, B, C" and the
formula results in a value of "1", then "1" will be written to the database, and the
field will appear blank.

Columns

Applies to: TextArea

Enter the number of columns to specify the width of a TextArea data type field.

Comment Text

Applies to: All data types except Flex Relate

Enter a comment or description about the field. The comment text is only viewable
via Studio.

Default Value
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Applies to: Address, AutoIncrement, Checkbox, Currency, Date, Datetime,
Decimal, Encrypt, DropDown, Float, IFrame, Integer, MultiSelect, Phone, Radio,
TextArea, URL, TextField

Specify or select a default value for this field when a record is created. Default
values for the record are populated by default but can be modified by users.

Dependent

Applies to: All data types except ActionButton and Address

Select this option to designate this field as being dependent on a formula or a 
parent dropdown.

For dropdown data type fields you can select "Parent Dropdown" or
"Formula" for the dependency.

Selecting "Parent Dropdown" will open the Parent Dropdown option as
shown below. Selecting "Formula" will open the "Visible If" option to create
a dependency formula. For other field data types (e.g., Date), select the
Dependent checkbox to open the Visible If option. For more information
regarding entering a formula to make a dependent field visible, please
refer to the Visible If option listed in this section.

Disable Format

Applies to: Integer

Select this checkbox to disable number formatting such as the thousands
separator.

Display Label

Applies to: All data type fields except Flex Relate. Flex Relate uses the Label
Value option.

Enter a value to display as the field label and header in layouts. Normally defaults
to the Field name entered when creating field. This value is also modifiable via the 
Labels section of Studio.
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Drop Down List

Applies to: DropDown, MultiSelect, Radio

Select a list of values to associate to the field. Only values in the chosen list will be
available for selection in the field. Click "Edit" to change the values for the
currently selected list, or click "Add" to create a new list.

For more information on editing dropdown values via the Dropdown Editor, please
refer to the Editing Dropdown Lists section of the Developer Tools documentation.

Duplicate Merge

Applies to: All data type fields except Image

Select one of the following options to determine the field's functionality when
records are being merged:

Disabled: Selected by default. The field will not appear on the Merge
Duplicates screen.
Enabled: The field will appear on the Merge Duplicates screen.
In Filter: (Legacy/BWC modules only) The field will appear in the Merge
Duplicates feature, and will also be available in the Find Duplicates feature.
Default Selected Filter: (Legacy/BWC modules only) The field will be
used for a filter condition by default in the Find Duplicates page, and will
also appear in the Merge Duplicates feature.
Filter Only: (Legacy/BWC modules only) The field will not appear in the
Merge Duplicates feature but will be available in the Find Duplicates
feature.

Field Name

Applies to: All data type fields

Enter the name of the field being created. Once a field has been created the field
name cannot be changed.

Field names can contain only alphanumeric characters as well as the
underscore character.
Custom fields added via Studio are automatically appended with "_c" to
ensure the field does not conflict with a current or future stock field.
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Formula

Applies to: Checkbox, Currency, Date, Datetime, Decimal, Encrypt, Float, Integer,
Phone, TextArea, TextField when the Calculated Value option is selected.

Contains the current formula to return a calculated value. Click "Edit Formula" to
launch the formula builder and change the formula. For more information on how
to build a formula using the formula builder, please refer to the Using Sugar Logic
 documentation.

Full Text Searchable

Applies to: Phone, TextArea, TextField, URL

Specify whether or not the field should affect Global Search results.

Disabled: Select "Disabled" if you do not want this field to be captured
when the database is indexed for searches. Search indices collect the
values of searchable fields for evaluation by the Global Search.
Searchable: Select "Searchable" to include this field's value in search
indexes.

Selecting "Searchable" will reveal the Boost value field, which
allows you to set a relevance weight for searches.
When a user's search query matches the value of a field with a
higher boost level, the record will appear higher in the search
results. For more information regarding boost values in Full-Text
Search, please refer to the Search documentation in the Application
Guide.

Note: For a list of searchable fields for each module for global search, please refer
to the Search documentation in the Application Guide.

Generate URL

Applies to: IFrame, URL

Select this checkbox to allow variables from the current module to be placed into
the Default Value option for creating dynamic URLs.

                         281 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/search/#Admin_Configuration
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/search/#Global_Search


 

This is useful for providing links or Iframes to internal systems such as an
ERP or to external systems such as Google Maps.

Select the desired field to add from the dropdown and click "Insert Field"
to add the field to the Default Value. When selecting this option, the field
value cannot be modified by users.

Height

Applies to: Image

Enter the number of pixels to vertically scale the image for this field. Enter only
the Width or Height options to retain the aspect ratio of the image.

Help Text

Applies to: All data types

Enter basic instructions for populating this field. The text entered here will display
below the field when creating or editing a record for modules using the Sidecar
user interface. For modules using the Legacy user interface, the help text will
appear when users hover their mouse within the field in the Edit View layout.

HTML

Applies to: HTML

Enter static rich text with formatting or HTML code to display on a record. For
more information on how to use the text editor please refer to the TinyMCE section
of the User Interface documentation in the Application Guide.

IFrame Height

Applies to: IFrame

Enter the number of pixels for the height of the IFrame field. The width of the
IFrame field is always the width of the field container.

Importable: Select one of the following options to determine the field's
functionality when records are being imported:
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Yes: The field can be included in an import operation.
No: The field cannot be included in an import.
Required: A value for the field must be provided in any import.

Label Value

Applies to: Flex Relate

Enter a value to display as the field label and header in layouts. This value is also
modifiable in the Modules panel under Labels. Defaults to "Flex Relate".

Make Visible for Calculations

Applies to: Checkbox, Currency, Date, Datetime, Decimal, Encrypt, DropDown,
Float, Integer, MultiSelect, Phone, Radio, TextArea, URL, TextField

Select this checkbox to make the field available for use in the currentUserField()
Sugar Logic function. For more information and an example use case, refer to the 
Calculated Field - Setting Field Conditions Based on User Attributes knowledge
base article.

Note: This field option is only available in the Users module.

Mass Update

Applies to: Checkbox, Date, Datetime, Decimal, DropDown, Encrypt, Float,
IFrame, Integer, MultiSelect, Phone, Radio, Relate, Text, URL

Select this checkbox to add this field as an option to mass update.

Note: It is not possible to mass update a relate field based on a one-to-one
relationship because doing so would invalidate the one-to-one relationship.

Max Size

Applies to: Address, Decimal, Float, IFrame, Integer, Phone, URL, TextField

Enter  the maximum number of characters  (or, for DB2 databases, the maximum
number of bytes)  allowed for this field. Defaults to 255.

Max Value

Applies to: Integer

Enter the highest value allowable for this field. If a user enters a higher value in
the field than the specified value, a notification will appear upon save informing
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them of the set maximum value.

Note: Integer fields are limited at the database level to values up through
2147483647.

Min Value

Applies to: Integer

Enter the lowest value allowable for this field. If a user enters a value in the field
that is lower than the specified value, a notification will appear upon save
informing them of the set minimum value.

Module

Applies to: Relate

Select a module from the dropdown to relate to the current module. A module can
relate back to itself, a good example of this would be a relate field on Contacts to
relate back to Contacts for a referred by field. This will allow users to select which
contact record referred a different contact. The chosen module cannot be modified
once the field is created.

Open Link In

Applies to: URL

Select one of the following options to determine how a URL will open:

New Window: Opens the URL in a new Tab or Window depending on your
browser and settings.
Same Window: Opens the URL in the same window as the record you are
currently browsing.

Parent Dropdown

Applies to: All data types except ActionButton and Address

When the Dependent option has "Parent Dropdown" selected, choose an option
from the dropdown to specify the parent that controls the visibility of this
dropdown field. The Parent Dropdown option is populated with the other dropdown
data type fields in the current module.
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Click "Edit Visibility" to specify which options are available from the current
dropdown for each value of the parent dropdown. In the Visibility Editor window,
drag values from the current dropdown list to the value sections of the parent
dropdown. This will determine which options in the dropdown list are available
when the parent dropdown is set to the specified value. In this example, if the
parent dropdown is set to "Apparel", then the current dropdown will have options
1, 2, and 3 where if the parent dropdown is set to "Banking", then the current
dropdown will only have options 2 and 3 available. If there are no available options
for a parent dropdown value, then the dependent dropdown will not display. To
remove an item from the list, simply click and drag the value to the Trash bin on
the left. Once the values are set, click "Save" to preserve your changes.

Precision

Applies to: Decimal, Float

Enter a number to specify the number of digits to the right of the decimal point the
value should be stored as in Sugar.

Read-Only Field

Applies to: HTML, TextArea

Select this checkbox to mark the field as read-only in Sugar. The user will not be
able to enter a value for the field when editing the record.

Read-Only If

Applies to: HTML, TextArea when the Read-Only Field option is selected.
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The "Read-Only If" option allows you to use Sugar Logic to define criteria that
determine when the field should be read-only on the layout. 

If left blank, the field will always be read-only.
To make it read-only conditionally, click "Edit Formula" to launch the
formula builder. For more information on how to build a formula using the
formula builder, please refer to the Using Sugar Logic documentation.

Reportable

Applies to: All data type fields except Encrypt, Flex Relate, HTML, IFrame, and
Image

Select this checkbox to allow the field to be used in reports.

Required Field

Applies to: All data type fields except ActionButton, Checkbox, and HTML

Select this checkbox to mark the field as required in Sugar. The user will be
required to enter a value for the field when saving the record.

Note: This field option is not available for the out-of-the-box Account Name field
on the Contacts, Opportunities, Revenue Line Items, Leads, Quotes, Quoted Line
Items, Cases, and Purchases modules. Instead, this can be controlled using
the require_accounts setting in the config_override.php. See the Core Settings
 page in the Developer Guide for more details.

Required If

Applies to: All data type fields except ActionButton, Checkbox, and HTML when
the Required Field option is selected.

The Required If option defines the criteria that determine when the field is
required on the layout. 

If left blank, the field will always be required.
To make it required conditionally, click "Edit Formula" to launch the
formula builder. For more information on how to build a formula using the
formula builder, please refer to the Using Sugar Logic documentation.
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Rows

Applies to: TextArea

Enter the number of rows to specify the height of a TextArea data type field.

System Label

Applies to: All data types

Enter the system value for storing the label of the field. This is defaulted to the
name of the field preceded with "LBL_". Any lowercase characters entered will be
converted to an uppercase upon saving. Once the field has been created, the
system label cannot be changed. It is recommended that administrators avoid
naming fields with the same system label in order to prevent the same label and
header values from existing in the system.

Note: Only single-byte characters are supported for system labels for fields.

Visible If

Applies to: All data types except ActionButton and Address when the Dependent
 option is selected or "Formula" is selected from the Dependent option dropdown.

Contains the current formula to determine if a field is visible on the layout or not.
Click "Edit Formula" to launch the formula builder to change the formula.

The formula must result in a Boolean (true/false) response. For more information
on how to build a formula using the formula builder, please refer to the Using
Sugar Logic documentation.

Width

Applies to: Image

Enter the number of pixels to horizontally scale the image for this field. Enter only
the Width or Height options to retain the aspect ratio of the image.

Creating Fields

Use the following steps to create a new field via Studio:
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1. Expand out the tree under the desired module (e.g., Cases) in the Modules
panel and select "Fields".

2. In the main panel, click "Add Field".

3. Enter appropriate values for the Field Options.
Note: For ActionButton type fields, click "Configure Buttons" at the bottom
of the field definitions, and then proceed with the configuration steps on
the Action Buttons page.

4. Once the necessary information is entered, click "Save".
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Please note that once a field is created, it must be placed on the record view (for
Sidecar modules) or edit view (for Legacy modules) layout before users can enter
data into that field. For more information on editing layouts, please refer to the 
Editing Layouts documentation.

Note: New fields cannot be created if you have reached the MySQL row size limit
of the table in your database. For more information, please refer to the 
Troubleshooting Row Size Limit Errors in Sugar article. 

Editing Fields

Use the following steps to edit an existing field via Studio:

1. Expand out the tree under the desired module (e.g., Cases) in the Modules
panel and select "Fields".
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2. In the main panel, select a field to edit. Sorting the fields by the column
header will help in locating the field faster.

Note: Fields created via Studio will display an asterisk next to their
names.

3. Enter appropriate values for the Field Options.
4. Once the necessary information is entered, click "Save".
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Deleting Fields

Use the following steps to delete an existing field via Studio:

1. Expand out the tree under the desired module (e.g., Cases) in the Modules
panel and select "Fields".

2. In the main panel, select a field to delete. Sorting the fields by the column
header will help in locating the field faster.

Fields created via Studio will display an asterisk (*) next to their
names.
Note: Stock fields cannot be deleted.

3. Click "Delete" to remove the field.
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4. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

When deleting fields, both the field and all the data related to the
field in the database will be permanently removed. Before deleting
a field, confirm that the field is no longer used or displayed in the
following places:

Report filters or display columns
Workflows that filter by or display the field
Dashlets that filter by or display the field
Sugar Logic formulas for other fields
Email templates
Saved searches (legacy modules)

5. The field will automatically be removed from any module layouts when
deleted.

Cloning Fields

Use the following steps to clone an existing field via Studio:

1. Expand out the tree under the desired module (e.g., Cases) in the Modules
panel and select "Fields".

2. In the main panel, select a field to clone. Sorting the fields by the column
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header will help in locating the field faster.
Note: Fields created via Studio will display an asterisk (*) next to
their names.

3. Select "Clone" to duplicate the field.
Note: Some non-standard stock fields (e.g., Name) do not have the
ability to clone.

4. Enter appropriate values for the Field Options.
5. Once the necessary information is entered, click "Save".
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Action Buttons

Overview

Action Buttons are custom buttons that can be added to records to enable users to
perform quick actions directly from records such as sending an email, creating or
editing a related record, and opening an external web page. Action Buttons are
implemented as a field type in Studio and are easily extended using Sugar Logic
 and SugarBPM.

Understanding Action Buttons

Action Buttons are powerful tools that provide your users with shortcuts to
perform tasks within records that otherwise would require leaving the record. The
benefit of using Action Buttons is that they support an efficient workflow, giving
users the tools they need to perform their work directly where they need it. Action
Buttons look like standard Sugar action buttons in record views and can be
displayed in records, their headers, or both. Buttons are easily configurable by
style (color, labels, icons) and function (direct action or calculated) and their
availability in records can be made dependent on specific conditions as well as role
or team-based permissions. 

For examples of how Action Buttons can be used in records, please refer to the 
Action Button Example Use Cases section. 

Compatibility
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Action Buttons are Sugar fields and are subject to access control rules that may be
set via team membership, user type, and role restrictions. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: If you previously installed the Custom Buttons package included in the
wTools bundle, please refer to the Understanding Action Buttons vs wTools
Custom Buttons article to help you determine if you should re-create your Action
Buttons directly in Studio in your Sugar instance.

Configuring Action Buttons

Administrators can place an Action Button on a record by creating and configuring
a new field in Studio with a Data Type of "ActionButton" for the record's module
and then adding that field to the desired layout. The "ActionButton" type field
requires additional configuration after the field is created. This section describes
the configuration options available for Action Buttons. To see how Action Buttons
are displayed in records, please refer to the User Interface documentation in the
Application Guide.

A single ActionButton field may be configured to show one or more buttons. When
one field contains more than one button, the buttons can be shown either side-by-
side in the singular field's area or as an Actions-menu style button with a
dropdown list using the display settings in the Layout Configuration panel. If you
would like to have more granular control over the access and placement of
multiple buttons within a module, consider creating them as separate fields so that
they can be managed independently. For more information, refer to the Working
With Multiple Buttons section.

Note: You can only configure custom Action Buttons as described in this section;
you cannot configure the standard Sugar action buttons or module Actions menus.

To configure Action Buttons, click "Configure Buttons" at the bottom of the field
definition when creating the field:
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The button configuration drawer opens:

 

The configuration drawer includes the following sections:

Header: A tabbed view of all buttons included in the current field.
Properties: Options like the button's label, icon, color, and dependencies.
Layout Configuration: Additional display options for record views and
action menus.
Action: The action(s) that will occur when the button is clicked by a user.
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Refer to the following sections for information on configuring each of these areas.

Header

The Header section across the top of the drawer contains tabs that represent each
button for the current field. The Properties and Action display for the selected tab.
When there are multiple buttons for the field, display settings in the Layout
Configuration panel apply to all buttons. 

Properties

Define basic visual options in the Properties section of the Action Button
configuration drawer. When there are multiple buttons for the field, these settings
only apply to the button defined on the active tab in the header.

Label: The text to be displayed on the button. You do not need to include a
label; you may want to only include an icon (see "Show Icon" below).
Show Label: When enabled, the text identified in the Label field will be
displayed on the button. When not selected, the button will be blank or
display only the icon if the "Show Icon" option is selected.
Color Scheme: The button color. Select an option from the dropdown list
and view the results in the Preview section of the Layout Configuration
 panel.
Dependent: When enabled, the button will only display in records when
the conditions defined in the Formula field are met.

Formula: Conditions that define the criteria for displaying the
button on records. Please refer to the Sugar Logic documentation
for more information.

Tooltip: Text to be displayed when a user hovers over the button.
Show Icon: When enabled, the icon identified in the Icon field below will
display on the button. Refer to the Preview area of the Layout
Configuration panel to see how the icon will appear on the button.
Icon: Filename of the icon to be displayed on the button. The Show Icon
field must be enabled for the icon to be displayed. Refer to the Preview
area of the Layout Configuration panel to see how the icon will appear on
the button.
Stop On Error: When enabled, the defined action in a chain of actions will
stop if an error is encountered.

Layout Configuration

Define additional display options for the Action Button and view the button display
in the Preview section of the Layout Configuration panel. This panel is divided into
tabs for settings that apply to record views and those that apply to action menus.
When there are multiple buttons for the field, these settings apply to the entire
group of buttons.

                         297 / 829



 

Record Views Tab

Preview: View-only section that shows you the button appearance based on
the current settings.
Display Settings:

Type: The Action Button style
Dropdown: When multiple buttons are configured for the
same field, the first button displays with a dropdown list that
contains the other button labels.

Button: A single button.
Button Group: When multiple buttons are configured for
the same field, they are displayed in the record together
with no space between them.

Display Label on Record: When enabled, displays the text
identified in the Action Button Field Label above or next to the
button on records (the location is determined by the user
preference setting). This is not the label that is displayed on the
button (see "Show Label" in the Properties section).

Display in Header: When enabled, displays the button in the
record header adjacent to the record name. If the field is also added
to the record view layout, users will see the button in both places. If
this option is not enabled, then the button must be added to the
record view layout in Studio.
Hide on Edit: When enabled, the button will be hidden when the
record is in Edit mode.
Size: Set the button's display size (Default, Small, Large). Refer to
the Preview area after making a selection to compare sizes.

Action Menus Tab

Preview: View-only section that shows you the button appearance based on
the current settings.
Display Settings:
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List View: Display the button as an item in list view actions menus.
Subpanels: Display the button as an item in subpanel actions
menus.
Record View: Display the button as an item in record view actions
menus.
Record View Dashlet: Display the button as an item in record view
dashlet actions menus.
Order: When multiple action buttons exist in the same module, this
number dictates the order in which this button will display in
actions menus. The lowest number displays the highest in the list
(e.g., "1" is higher in the actions menu list than "2").

Action

In the Action section, define the action that will occur when a user engages the
Action Button. 

Action Description Fields
Assign Record Assigns the record to the

designated user.
Assign To: Select the
user to whom the record
should be assigned.

Compose Email Enables users to quickly
compose an email using
an email template. When
the button is engaged, the
configured email client is
opened with the selected
email template and
designated recipients. 

Use PMSE: When
enabled, the
available 
SugarBPM Process
Email Templates
will be displayed in
the Template list
below. The
templates available
are those that
were created with
the target module
where you are
creating the field
(e.g., when
creating an Action
Button field in the
Contacts module,
only the Process
Email Template
records with a
"Target Module"
set to Contacts will
be displayed.)

                         299 / 829



 

Template: Name
of the standard
email template or 
SugarBPM Process
Email Template to
be used to
compose the email.
Email To:
Conditions that
define the email
recipients. Please
refer to the Sugar
Logic
 documentation for
more information.

Create Record Enables users to quickly
create records in other
modules from the current
record.

Module: Name of
the Sugar module
in which the
record will be
created.
Auto
Create: When
enabled, Sugar will
create and save a
new record in the
module identified
above. If this
option is not
enabled, then the
user must
manually save the
newly created
record after
engaging the
button.
Preset: The field
for which you want
to set a value in
the newly created
record. After
selecting the field
from the dropdown
list, a text box
displays where you
can identify the
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value or set a
calculated value
using Sugar Logic.
Link: When
enabled, the newly
created record will
be related to the
record from which
the Action Button
was pressed (i.e.,
the parent
record). 
Copy Parent
Values: This
option populates
fields in the newly
created record
with the values
from matching
fields in the parent
record.
Preset From
Parent: The field
in the newly
created record to
be populated with
the value from the
parent record.
After selecting the
field from the
dropdown list, a
text box displays
where you can
select the field
name from the
parent record from
which the value
will be copied.

Doc Merge Launches the Doc Merge
feature to create a
document using data from
the current record. 

Template: Name
of the document
template on which
the merge is
based.
Convert to PDF:
When selected, the
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document created
by the merge will
be generated in
PDF format
instead of the
native DOCX or
XLSX format.

Open URL Opens a URL in a new
browser window. 

Calculated: When
enabled, the URL
to be opened will
be constructed
based on the
conditions
identified. Please
refer to the Sugar
Logic
 documentation for
more information.
URL: Direct URL
to be opened in a
new browser
window.

Run Report Provides a shortcut to run
reports from a record.

Run Report: Name of the
Sugar report to be run
when the button is
engaged.

Update Record Provides a shortcut to
update specific fields in
the current record. 

Fields: Name of
the field(s) in the
current record to
be updated. After
selecting the field
from the dropdown
list, a text box
displays where you
can identify the
value or set a
calculated value
using Sugar Logic.
To update another
field, select the
field name from
the list, which will
add a new text box
where you can
identify the value.
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Auto Save: When
selected, the
updated record is
automatically
saved after the
user engages the
button. If this
option is not
enabled, then the
user must
manually save the
updated record
after engaging the
button.

Assigning Multiple Actions to One Button

To assign more than one action to the same button:

1. After defining the first action as described in the Actions table above, click
the + icon at the top right corner of the Action block.

2. Define the action and repeat for any additional actions.
3. To change the order in which the actions are processed, drag and drop the

Action blocks into the order that you want the actions to process, with the
first action being at the top.

4. To delete an action, click the - icon at the top right corner of the Action
block and then click the Confirm button in the confirmation message.

Note: To stop the chain of actions when an error is encountered, enable the Stop
On Error option in the Properties section.

Working with Multiple Buttons
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Several buttons can be shown within the same field. This is useful for grouping
multiple shortcuts that are related to the same workflow within a module.

To create additional buttons for the current field:

1. Click the plus icon in the header.

A new tab opens to define the new button and the button is added to the
Preview display on the right.

2. To reorder buttons, drag the tab in the header to the desired location with
the button on the far left being first.

Note: If buttons exceed the horizontal space in a record header, then the button
type is automatically converted to a dropdown button.
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Displaying Action Buttons in Records

As with all field types, you need to add the Action Button to a layout before it will
display in records unless you only want the buttons to display in the record header,
which can be configured using the display settings in the Layout Configuration
panel. Action Buttons can be added to record view layouts and mobile layouts.

Action Button Example Use Cases

There are many use cases for Action Buttons depending on the module and your
own workflows. The following are just a few examples of how Action Buttons can
be utilized. For details on how to implement these examples, please refer to the 
Creating an Action Button article.

Escalate a Case
Reject a Lead
Add a Call Note to an Opportunity
Access Supporting Documents from a Quote
Email a Team
Include a Map Link to Account Location

Escalate a Case

Provide your Support team with a one-step method of case escalation with an
Action Button that updates the Priority field to "High" and the Assigned To field to
the manager. While you can also define a Sugar BPM process for case escalation,
utilizing an Action Button in this way does not require BPM knowledge and allows
your Support reps to instantly escalate a case while engaged with a customer on
the phone.

Reject a Lead

Enable your Sales team to quickly update a lead record to reject the lead,
assigning the record to the regional sales manager, setting the status to "Dead",
and adding "no purchase potential" to the Description field. 
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Add a Call Note to an Opportunity

Using an Action Button in an opportunity record can provide quick creation of calls
associated with the opportunity. For example, automatically create a call record
with the Status field set to "Held", Direction set to "Outbound", and Description
populated with the name of the opportunity.

Access Supporting Documents from a Quote

Use an Action Button to provide a link to external systems that contain supporting
documentation. For example, link to design documents located in a corporate
intranet from a quote record to provide user access to all information directly
where it is needed.
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Email a Team

Including an email Action Button can be a time saver in any module. This type of
Action Button enables users to quickly send email to a predetermined recipient list
using an email template or process email template.

Include a Map Link to Account Location

Including an Action Button that links to a specific map location (e.g.,
https://google.com/maps?q={primary account address}) can provide your Sales
team with directions to the account's location in one click.
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Relationships

Overview

Relationships define the links between different modules in Sugar and allow
records between those modules to be related. Related records display in fields or
subpanels on a module's record view (for Sidecar modules) or detail view (for
Legacy modules) depending on the relationship type. When you create a new
relationship between two modules, the system automatically creates the necessary
subpanels, related fields, and metadata relationships. Relationships provide the
added benefit in reports to allow access to a related record's fields in addition to
the base module's fields.

The relationships section in Studio allows administrators to create new
relationships between custom and stock modules as well as change some
properties on existing relationships. To access the Relationships section in Studio,
select "Relationships" from the Modules panel and the module's relationship tab
will open in the main panel.

Relationship Types

Sugar contains a few different types of relationships you can create between
modules. The relationship type will determine which fields or tables will be created
in the database as well as what the interface will look like to the user when
managing relationships for the affected records.

When you create a relationship between modules, the module you initiate the
relationship from is considered the primary module and the module that you relate
it to is the related module.

The following sections explain the relationship types available in Studio. 

One-to-One Relationships

When records in the primary module and the related module are uniquely related
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to each other, you have a one-to-one relationship. In other words, each primary
record will relate to only one related record and vice-versa.

As an example, in a one-to-one relationship between Accounts and Contacts, an
account can be associated with only one contact and a contact can be associated
with only one account. The relationship will show as a field in each module's
record view. For this two-way relationship, changing the related record from one
module's record will also change the value in the other module's record.

From the primary Accounts module:

From the related Contacts module:

Note: You can alternatively create a one-way relationship between modules using
relate fields. For more information regarding relate fields, refer to the Field Types
 documentation. For an explanation of the differences between relate fields and
relationships, see the Introduction to Relationships and Relate Fields article.

One-to-Many and Many-to-One Relationships

In one-to-many relationships, one primary record may relate to many records in
the related module, but the related module records will only be able to relate to
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one primary record. This is often referred to as a parent-child(ren) relationship.

Note: Only modules with subpanels available can be on the "Many" side of a
relationship. For example, the Product Catalog module lacks a subpanel; therefore,
Product Catalog can only be selected on the "One" side of a relationship.

As an example, in a one-to-many relationship between Accounts and Contacts, an
account can be associated with many contacts, but each contact can be associated
with only one account. The record view of the primary module will display a
subpanel for the related module, and the record view of the related module will
display a field containing a link to the related record.

A one-to-many relationship is the same as a many-to-one relationship except the
primary and related modules are reversed. 

From the primary Accounts module:

From the related Contacts module:
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You can also create a one-to-many relationship between a module and itself. For
example, Sugar relates Accounts to Accounts in order to allow "Member
Organization" sub-accounts within the primary "Member of" parent account.

Note: Adding a custom one-to-many relationship to "Activities" will add custom
relationships to calls, meetings, messages, notes, tasks, and emails. This will also
automatically add these subpanels to the record view.

Many-to-Many Relationships

In many-to-many relationships, many primary records may be related to many
related records, often overlapping. For example, the contact Joe Smith may relate
to many different Sugar campaign records, and each of those campaign records
may relate to many contacts in addition to Joe Smith.

For a many-to-many relationship between Accounts and Contacts, an account could
be associated with many contacts, and a contact, in turn, could be associated with
many accounts. Both modules' record views would display a subpanel for the
opposite module.

Note: Only modules with subpanels available can be on the "Many" side of a
relationship. For example, the Product Catalog module lacks a subpanel; therefore,
Product Catalog can only be selected on the "One" side of a relationship.

Creating Relationships

Use the following steps to create a new relationship via Studio:

1. Expand the tree under the desired module (e.g., Cases) in the Modules
panel and select "Relationships".
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2. In the main panel, click "Add Relationship".

3. Enter appropriate values for the following options:
Type: Select the type of relationship to create from the options in the 
Relationship Types section.
Module: The Primary module is set as the module to which you are adding
the relationship. Select the related module from the dropdown list to the
right. The Primary and Related module can be the same in order to create a
parent-child relationship.
Label: Enter a label to reference the Primary module or Related module's
subpanels for this relationship.

Note: This option is only available for the "Many" side of a
relationship.Subpanel from: Select a subpanel option to display the Primary or Related

module's records in. This will determine the fields displayed in the
subpanel.

Note: This option is only available for the "Many" side of a
relationship.

4. Once the necessary information is entered, click "Save & Deploy".
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5. The required fields and subpanels are instantly created and deployed to the
appropriate modules.

Editing Relationships

Use the following steps to edit a relationship via Studio:

1. Expand out the tree under the desired module (e.g., Cases) in the Modules
panel and select "Relationships".

2. In the main panel, select a relationship to edit.
Sorting the column header will help in locating the relationship
faster.
Note: Relationships created via Studio will display an asterisk next
to their names.
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3. The only editable field on a relationship is the Label field for naming the
Primary or Related modules subpanels.

Note: This option is only available for the "Many" side of a
relationship.

4. Once the necessary information for the Label field is entered, click "Save".

Deleting Relationships

Use the following steps to delete a relationship via Studio:

1. Expand out the tree under the desired module (e.g., Cases) in the Modules
panel and select "Relationships".
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2. In the main panel, select a relationship to delete.
Sorting the column header will help in locating the relationship
faster.
Note: Relationships created via Studio will display an asterisk next
to their names.

3. Select "Delete" to remove the relationship.

4. A pop-up message will display asking for confirmation. Click "Yes" to
proceed.
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Note: If you wish to retain the data and table structure that
currently exists for the relationship, select the "Do Not Remove
Tables" option. Leaving the "Do Not Remove Tables" unchecked will
delete the relationship data and remove the tables for the
relationship from the database.
Before deleting a relationship please verify and resolve the
following issues:

Relationship must be removed from any report filters or
displays
Relationship must be removed from any workflows that
filters or displays fields from the relationship
Relationship must be removed from any Sugar Logic
formulas referencing the relationship

Layouts

Overview

The layouts in Studio are used to represent the various views (e.g., record view,
list view, edit view, etc.) in Sugar. Users with administrator or developer access
have the ability to configure these layouts via Admin > Studio. Please note that the
layouts available to configure will vary based on whether the module uses the 
Sidecar or Legacy user interface. All modules using the Legacy user interface will
display an asterisk (*) to the right of the module's name in Studio. The available
layouts for the selected module will appear once you open up the Layouts option.
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Layout Types

Sugar comes with different types of layouts to represent different sections of
Sugar. Please note that not all layouts are available in every module. Mobile
Layouts are not described here since they are managed in a separate location.
Please refer to the Mobile Layouts page for more information.

The following layout options are available in Sugar:

Record View (for Sidecar modules): Record view is used to modify,
create, or view the current record's details within a specified module. This
layout is specific to modules using the Sidecar user interface and controls
the layout for viewing, creating, and editing a record, as well as the quick-
create layout and the fields displayed when the record is viewed via the
preview pane.
Record View Dashlet (for Sidecar modules): The Record View dashlet
displays the record view of a module within a tab of the dashlet. This layout
is used to configure the fields displayed in the tab. Note that this layout can
be configured in Studio for all supported Sidecar modules as well as any
custom modules.
Edit View (for Legacy modules): Edit view layout is used to modify or
create records in the specified module.

                         317 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Sidecar_Modules
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/dashboards_dashlets/#Record_View_Dashlet
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Sidecar_Modules


 

Detail View (for Legacy modules): Detail view layout is used to view the
current data for a record within the specified module.
List View: List view layout is used to view multiple records within the
specified module. The list view is also used for displaying the results from
module search (for Sidecar modules), as well as Basic or Advanced search
(for Legacy modules).
Preview View: Preview view is used to display a read-only snapshot of
records in the specified module.
Quick Create (for Legacy modules): Quick Create layout is used in
Sugar to quickly view and modify records within a specified module without
having to navigate away from the current page. For example, logging a call
from the Quotes detail view will open up the call's quick create form.
Popup List View: Pop-up list view layout is used to view a list of records in
a pop-up window (i.e., a Search and Select drawer) when selecting one or
more records to relate to a current record. For example, if you want to edit
the Accounts list view when you click "Search and Select..." in the Account
Name field on a contact record, you would edit the Accounts pop-up list
view layout.

Popup Search (for Legacy modules): Pop-up search layout allows users
to search for records in the pop-up window to relate to a current record
and appears above the pop-up list view in the same window. Legacy
modules (e.g., Quotes) use this layout for pop-up searching while Sidecar
modules (e.g., Accounts) use the Search layout's configuration.

Search: Search layout is used to allow users to search for records from a
module's list view via module search (for Sidecar modules) or Basic and
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Advanced search (for Legacy modules). This layout is also used by Sidecar
modules on the pop-up search and select. In addition, changes made to the
Search layout for Sidecar modules affect the list of available fields to filter
for the module's list view dashlet (e.g., My Contacts) since it is controlled
by the same layout.
Note: Encrypt fields cannot be added to Search layouts.

Layout Options

Administrators have the ability to configure the various layouts (e.g., record view,
list view, etc.) available via Studio. The following are some of the options available
to administrators when configuring layouts in Studio. Record views may be
configured to display differently based on the viewing user's role.

Panels

Every field on a layout is contained within a panel, which can be organized to
contain groups of similar or related fields to assist in organization. Modules using
the Legacy user interface will have fields grouped by default into the Overview and
Other panels while modules using the Sidecar user interface will have the Business
Card and Show More panels. You can change the panel header titles by clicking
the Pencil icon to the right of the panel name. 

Note: You can have the panel collapsed by default on the Record View, Edit View,
or Detail View by marking the Collapse? checkbox to the far right of the panel
header.

Record View layout (for Sidecar modules):

Edit View layout (for Legacy modules):
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Tabs

Each of the panels (Business Card, Overview, etc.) may optionally be displayed as
tabs in the layout. You can also nest panels within other panels defined as tabs.
For example, if you set the Business Card panel as a "Tab" and leave "Show More"
as a panel in the Record View layout, the Show More panel will appear within the
Business Card tab.

Every panel listed under a Tab display type will be a panel within the tab until the
next Tab display type panel is reached. So if you add a new panel below "Show
More" and set both the Business Card and Show More panel as "Tabs", then the
newly added panel will appear within the Show More tab.

Restoring Layouts

Sugar keeps a history of the changes made to each layout. You can preview and
restore historical layouts via "View History". For more information on viewing the
history of layouts, please refer to the Viewing Layout History section of this
documentation.

It is also possible to restore the layouts back to the default out-of-the-box layout.
For more information on how to reset a layout to default, please refer to the 
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Restoring Customized Layout to the System Default Layout section in this
documentation.

Note: When using role or dropdown specific record view layouts, please refer to
the Restoring Customized Layout to the Base Layout section for more information.

Sync And Copy (Legacy Modules)

Sugar provides administrators with the ability to sync and copy certain layouts to
assist in configuring layouts. Often it makes sense for a module's edit view and
detail view layouts to be identical. Instead of having to duplicate any changes
made to one layout, administrators can configure the detail view layout to be
synced to the edit view layout.

To sync the layouts, select the Sync to DetailView checkbox on the upper right of
the EditView layout and click "Save & Deploy".

The current detail view layout will be replaced with the current edit view layout. At
this point, changes cannot be made to the DetailView layout in Studio, but any
changes made to the EditView layout will automatically be synced to the
DetailView layout when saved.

As an alternative to syncing the layouts, administrators can copy the layout from
the EditView to the DetailView or QuickCreate layouts. This is especially useful if
you want the layouts to be similar, but different. Make any necessary changes to
the EditView layout, then navigate to either the DetailView or QuickCreate layout.
Select "Copy from EditView" to replace the current layout with details from the
EditView layout. Once copied, you can continue to edit the DetailView layout.

Note: The copy feature is a one-time copy of the layouts. Any future changes to the
EditView layout will not be reflected on the DetailView layout without performing
the copy again.

Editing Layouts

You can add, remove, hide, and reorder the fields for the available layouts in the
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module by selecting the specific layout under the Modules panel to edit. Please
note that the List View, PopupView, and Search layouts have columns where you
can designate fields users can and cannot see. 

Record views may be configured to display differently based on the viewing user's
role or based on a dropdown field's selected value. For more information see the 
Creating Role-Based Record View Layouts and Creating Dropdown-Field-Based
Record View Layouts sections of this page.

Note: Fields that are restricted to specific license types (e.g., Sugar Sell or Sugar
Serve) can only be added to layouts by a user with the appropriate license type. If
the field is already on a layout, users without the appropriate license type can
remove it from the layout, but cannot re-add it. In addition, if a user does not have
license access to a specific field, the field value is replaced with a pill containing
the text "License Required". See the User Management documentation for an
outline of what each license type includes.

Editing Record View Layout

The following steps cover editing the Record View layout for the Accounts module
as an example:

1. Navigate to Studio > Accounts > Layouts > Record View either by clicking
the tiles or by expanding the navigation tree in the lefthand panel.

2. To add a field to the Record View layout, drag the field from the list of
fields in the Toolbox to your desired "(filler)" location on the layout. You
can also drag a field to a location on the layout that already has a field in
place; the newly added field and the existing field on the layout will swap
places.
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3. To remove a field from the layout, drag and drop the field from the layout
to the trash bin in the toolbox to remove the field from the layout. You may
remove an entire row in the layout using the same method.

4. To expand or minimize the field column in the layout, click the Plus icon (+)
to stretch the field over two columns or click the Minus icon (-) to fit the
field into one column. Some fields with content that can become long (e.g.,
Comment Log) are better suited to being displayed across two columns.
Note: The layout will display a "(filler)" if there is no field in that location.

5. To add a new row, drag the "New Row" item in the Toolbox to the layout to
allow additional fields or blank spaces to be added.
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6. To add a new panel, drag the "New Panel" item in the Toolbox to the layout
to group different sets of fields together in the Record View layout.

7. Once the layout is finalized, click "Save & Deploy" to preserve your
changes and deploy immediately. You can click "Save" to preserve the
changes made but not deploy them to Sugar's user interface.

Note: It is recommended that dependent fields be placed below and/or to the right
of the independent field to preserve the correct display of fields on the layout.

Creating Standard Record View Layouts

The Layout Determined By dropdown is set to Standard Layout by default and is
the record view that all users see. The availability and organization of fields may
be altered to provide only the relevant fields according to your business practices.
You may manipulate the layout as described in the Editing Record View Layout
 section above. All users will see the customizations made to the Standard Layout
upon clicking "Save and Deploy". 
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Creating Base Layouts

When creating role or dropdown-based layouts, you can choose to customize the
Base Layout. You may manipulate the layout as described in the Editing Record
View Layout section above. After clicking "Save & Deploy", changes made to the
Base Layout will be applied to all non-customized role or dropdown field layouts.

Creating Role-Based Record View Layouts

Record Views can be configured to display customized layouts based on the
viewing user's role. The availability and organization of fields may be altered to
provide only the relevant fields for each user's role according to your business
practices. When configuring layouts for role-based views, the Role dropdown
appearing on the top contains all existing roles in the Sugar application as well as
a "Base Layout" option.  By default, none of the Sugar roles have customized
views, so changes made to the Base Layout will automatically be copied to the
other role-views upon save. This means that as long as no role-views are
customized here, all users will see the record view layout matching the Base
Layout. 

Note: It is recommended to assign each user to a maximum of one role. Users
belonging to multiple roles that each have customized role-views may experience
unexpected behavior when using record views. For more information about roles,
please refer to the Role Management documentation.

Role-based customizations to record views are included when exporting
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customizations from Studio. For more information, please refer to the Exporting
Role-Based and Dropdown-Field-Based Customizations section of the Studio
documentation and the Module Loader documentation.

Follow the steps below to create a role-based record view for a module (e.g.,
Accounts).

1. Navigate to Admin > Studio > Accounts > Layouts > Record View.
2. Select "Role" from the "Layout Determined By" dropdown.
3. Select a role from the Role dropdown.

 

When viewing a Sugar role's role-view (e.g., Sales Administrator), you have the
option to add, remove, and rearrange fields and panels. You may manipulate the
layout as described in the Editing Record View Layout section of this page. The
inclusion and location of fields will be specific to the role-view you are customizing.
However, changes made to a field's display label from any of the role-views will
update that field's display label on all role-views.

Once you have saved a modification to a role-view, it is considered customized and
will display an asterisk (*) next to the role's name in the Role dropdown. Adding,
removing, and rearranging fields or panels on the Base Layout will no longer have
any effect on customized views.

Note: Role-based views are not available for Legacy modules' detail views or any
other Sidecar layouts besides the record view. The Sidecar module must be
available for editing in Studio for you to be able to create role-based record views.
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Creating Dropdown-Field-Based Record View Layouts

Record views can be configured to display customized layouts based on the value
selected in a given dropdown field on the record. The availability and organization
of fields may be altered to provide only the relevant fields for the dropdown field's
value according to your business practices. For example, you may want to collect
different data points about an account that is in the Energy industry than you
would for an account in the Education industry; dropdown-based layouts let you
swap the fields that are visible when a user sets an account to Industry = "Energy"
vs. when they set Industry = "Education".

When editing a particular module's record view, the Field Name dropdown
contains all available dropdown fields for the module, and the Value dropdown
field contains the values for the corresponding field. By default, none of the
dropdown fields' values have customized views, so changes made to the Base
Layout will automatically be copied to the other views upon save. This means that,
as long as no dropdown views are customized here, all users will continue to see
the record view layout matching the Base Layout.

Dropdown-field-based customizations to record views are included when exporting
customizations from Studio. For more information, please refer to the Exporting
Role and Dropdown Field-Based Customizations documentation and the Module
Loader documentation.

Follow the steps below to allow certain dropdown field values to use a modified
record view for a module (e.g., Accounts).

1. Navigate to Admin > Studio > Accounts > Layouts > Record View.
2. Select "Dropdown Field" from the Layout Determined By dropdown.
3. Select a field from the Field Name dropdown.
4. Select the field's value from the Value dropdown

 

When viewing a Sugar dropdown field's value (e.g., "Energy" from the Industry
dropdown field in the Accounts module), you have the option to add, remove, and
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rearrange fields and panels. You may manipulate the layout as described in the 
Editing Record View Layout section above. The inclusion and location of fields will
be specific to the view for the dropdown field's value you are customizing.
However, changes made to a field's Display Type (e.g., Panel) from any of the
views will update that field's Display Type on all views.

Once you have saved a modification to a dropdown-field-based record view, it is
considered customized and will display an asterisk (*) next to the field value in the
Value dropdown. Adding, removing, and rearranging fields or panels on the Base
Layout view will no longer have any effect on customized views.

Note: Dropdown-field-based views are not available for Legacy modules' detail
views or any other Sidecar layouts besides the record view. The Sidecar module
must be available for editing in Studio for you to be able to create dropdown-field-
based record views.

Copying From a Customized Record View Layout

Customized layouts may be copied to another role or dropdown field layout, but
not to the Base Layout.

1. Select the layout to alter in either the Role or Value dropdown field.
2. Click "Copy from..." and select the customized layout to duplicate. The

"Copy from..." button will only appear when a customized layout is
available to be copied.

3. Click "Copy" and then "Save" or "Save & Deploy". 
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This will update the current layout to match the copied layout, and the current
layout will now be considered customized and display an asterisk (*) next to the
layout's name in the Role or Value dropdown.

Restoring Customized Layout to the Base Layout

The Restore Base Layout button may be used to bring a customized view back to
the base layout.

1. Select the customized layout in either the Role or Value dropdown field.
2. Click "Restore Base Layout" and then "Save" or "Save & Deploy". 

This will re-establish the link between the selected layout and the base layout so
that changes to the base layout will once again be automatically applied to the
selected layout. This will also remove the asterisk from the selected layout's name
in the Role or Value dropdown since it is no longer considered customized.
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Restoring Customized Layout to the System Default Layout

The Restore Default Layout button can also be used to bring a customized layout
back to Sugar's out-of-the-box record view layout.

1. Select "Standard Layout" from the Layout Determined by dropdown or
"Base Layout" in either the Role or Value dropdown field.

2. Click "Restore Default Layout" and "Save & Deploy".

This will remove any Studio changes to the layout so that it once again matches
the system's stock layout. All other, non-customized role or dropdown field layouts
will also be updated to match.

Editing List View Layout

The List View layout has columns where you can define the fields that users can
and cannot see. The List View layout also controls the list of available fields for the
module's list view dashlet (e.g., My Contacts). Once the appropriate configurations
are made in Studio, the deployed changes will be reflected in the Columns field of
the corresponding module dashlet's Configuration Options page. Keep in mind that
the module dashlet will not automatically reflect the Studio changes and users
must edit the dashlet to view the changes, add new fields to the layout, etc. 

To configure the List View layout, move the displayed fields among the Default,
Available, and Hidden columns:
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Default: Drag fields into the Default column to display them on the default
List view layout. The top-to-bottom order of fields corresponds with the left-
to-right presentation of columns on the list view (or right-to-left for users
viewing an RTL language). For example, the topmost field in the default
column will be shown in the leftmost column of the list view.
Available: Drag fields into the Available column to make them available for
users to personalize their view of the layout without making them part of
the default layout. Users will be able to click the Column Selection icon to
see the list of available fields. For more information on working with
columns in the list view, please refer to the User Interface documentation.
Note: Not all list-type layouts have an Available fields section.
Hidden: Drag fields into the Hidden column to hide them from users in the
list view. Hidden fields will be unavailable in list view regardless of a user's
team or role settings, but they may still be available to users in other places
such as in reports or the record view.

Note: To enable fields as filters in a Sidecar module's list view and list view
dashlet (e.g., the "My Contacts" dashlet), please refer to the Editing Search
Layout section. 

The following steps cover editing the List View layout as an example:

1. Expand "Layouts" from the Modules panel under the Accounts module and
select "List View".

2. To add a field to the List View layout, drag and drop the fields from the
Hidden column to the Default column. The fields in the Default column will
be available to add as display columns in the corresponding module dashlet
(e.g., My Accounts).
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3. To remove a field from the layout, drag and drop the field from the Default
column to the Hidden column.

4. To change the left-to-right order of the fields displayed on the list view,
drag and drop fields up or down within the Default list. The order of fields
designated for the List View layout also affects the order for the list of
available fields in the corresponding module dashlet (e.g., My Accounts).

5. Optionally, modify the label and width for the field. Click the Pencil icon
next to each field, enter the new label or select the width (e.g., small,
medium, large), then click "Save". Changes to a field's label will affect all
List View layouts for this module. For more information on setting column
widths, please refer to the List View Column Widths section.

6. Click "Save & Deploy" to preserve your changes and deploy immediately.

List View Column Widths

Administrators can easily set the column widths for specific fields when
configuring the List View layout. You can choose from a pre-defined list of width
sizes (e.g., small, medium, large) that are available out-of-the-box with Sugar or
enter a custom width value. The custom width value should be entered in pixels
(e.g., 200) for Sidecar modules. Legacy modules should be entered as a percentage
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(e.g., 40) of the total width of the list view that should be dedicated to the column.

The following table describes the available column width sizes for fields in Sugar's
list-view layouts. The Approximate Characters column indicates the maximum
number of characters the column will display before indicating overflow with an
ellipsis. For example, a column size with an Approximate Characters value of 4
would display "University of Miami" as "Univ...". This number is an approximation
due to the various widths of characters in the alphabet (e.g., a "w" character
occupies more horizontal space than an "i" character). Users may expand the
default column width manually or hover over the ellipses to reveal the field's entire
contents.

Name Width Approximate
Characters

xxsmall 20px 1
xsmall 40px 2
small 68px 8
medium 128px 15
large 180px 30
xlarge 280px 50
xxlarge 460px 85

Note: For currency fields, Sugar enforces a minimum 141px column width.
Therefore, only the "large" setting and above will apply and custom values must be
defined as 141 or wider.

Editing Search Layout

The Search layout controls which fields are available as filters in a module's list
view, list view dashlet, or the Renewal or Service Console's module tab's list view.
You edit the Search layout using the same method as the List View layout, but
using only the Default and Hidden columns. Fields placed in the Default column
will be available as filters for users in the module's list view and list view dashlet;
fields placed in the Hidden column will not. For more information on dragging and
dropping fields between the Default and Hidden columns, please refer to the 
Editing List View Layout section of this page.

Note: After an administrator edits the Search layout for a module in Studio, users
must edit or re-create their list view dashlets to see the deployed changes to their
available filters or columns.

Editing Record View Dashlet Layout
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The Record View dashlet layout can be configured in Studio for all supported 
Sidecar modules as well as any custom modules. You edit the Record View dashlet
layout using the same method as the Record View layout. The only exception is
that the Comment Log field cannot be added to the dashlet's layout. However, the 
Comment Log dashlet can be used instead to view the Comment Log on a
dashboard.

Editing Preview View Layout

The Preview View layout may be configured to display differently based on the
viewing user's role or based on a dropdown field's selected value. For more
information see the Creating Role-Based Record View Layouts and Creating
Dropdown-Field-Based Record View Layouts sections of this page. The following
steps cover editing the Preview View layout for the Accounts module as an
example:

1. Expand "Layouts" from the Modules panel under the Accounts module and
select "Preview View". The Preview View layout will display in the main
panel to the right.

2. To add a field to the Preview View layout, drag the field from the list of
fields in the Toolbox to the desired "(filler)" location on the layout. You can
also drag a field to a location on the layout that already has a field in place;
the newly added field and the existing field on the layout will swap places.

3. To remove a field from the layout, drag and drop the field from the layout
to the trash bin in the toolbox to remove the field from the layout. You may
remove an entire row in the layout using the same method.
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4. To add a new row, drag the "New Row" item in the Toolbox to the layout to
allow additional fields or blank spaces to be added.

5. To add a new panel, drag the "New Panel" item in the Toolbox to the layout
to group different sets of fields together in the Record View layout.
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6. Once the layout is finalized, click "Save & Deploy" to preserve your
changes and deploy immediately. Click "Save" to preserve the changes
made but not deploy to Sugar's user interface.

Viewing Layout History

Layouts, subpanels, and mobile layouts in Studio keep a history of the last ten
changes made to the specific layout. To view the history for any of these layouts,
simply select "View History" from the Record View layout for Sidecar modules, or
other view layout for Legacy modules in Admin > Studio.

The following steps cover viewing the layout history for the Record View layout as
an example:

1. Navigate to the Record View layout in Admin > Studio.
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2. Click the View History button on the upper left of the layout editor.

3. The History dialog box will appear showing the timestamps of the last ten
saves to the selected layout.

4. Click the timestamp or Preview button and a preview of the modified layout
will appear in a new tab of the main layout panel.

5. To restore a specific layout per the history, click the Restore button within
the Preview layout or from the History dialog box.
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The chosen Record View layout will load into the editor where you can make the
desired changes to the layout. Click "Save" to preserve your changes or "Save &
Deploy" to preserve your changes and deploy immediately.

Mobile Layouts

Overview

Mobile layouts are used to represent the views in the SugarCRM mobile app. The
mobile layouts section in Studio allows administrators to add fields and configure
the various mobile layouts. To access the mobile layouts section in Studio, expand
"Mobile Layouts" from the Modules panel under the desired module. The available
mobile layouts for the selected module will appear under "Mobile Layouts".

For all other layout types, please refer to the Layouts page.

Mobile Layout Types

There are various mobile layouts in Sugar to represent the different areas of the
SugarCRM mobile application. Please note that not all layouts are available in
every module and the different mobile applications will use the information defined
here differently.

The following mobile layouts are available in Sugar:

Edit View: Edit view layout is used to modify or create records in the
specified module.
Detail View: Detail view layout is used to view the current data for a
record within the specified module. Certain fields are translated to the
mobile app as buttons instead of data. For example, instead of seeing the
phone number, there is a phone icon to be able to call the number on the
record.
List View: List view layout is used to view multiple records within the
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specified module. The first eleven fields in the Default column will be
displayed in the mobile app by default unless the user has customized their
view.

Mobile Layout Options

Administrators have the ability to configure the various mobile layouts available
via Studio.

The following options are available when configuring mobile layouts in Studio:

View History: Sugar keeps a history of the changes made to each layout.
You can preview and restore historical layouts via "View History". For more
information on viewing the history of layouts, please refer to the Viewing
Layout History documentation.
Restore Default Layout: Restores the mobile layout back to the default
out-of-the-box layout. For more information on how to restore the default
layout, please refer to the Restoring Default Layouts documentation.
Role: Record views may be configured to display differently based on the
viewing user's role. For more information, please refer to the Creating Role-
Based Record View Layouts documentation.

 

 

Editing Mobile Layouts

You can add, remove, hide, and reorder the fields for the available layouts in
"Mobile Layouts" by selecting the specific layout under the Modules panel to edit.
Please note that the method for modifying Mobile EditView and DetailView layouts
are similar. The Mobile ListView layout has columns where you can designate
fields users can and cannot see.

Mobile EditView and DetailView can both be configured to display customized
layouts based on the viewing user's role. The availability and organization of fields
may be altered to provide only the relevant fields for each user's role according to
your business practices. For more information about configuring role-based
layouts, please refer to the Creating Role-Based Record View Layouts
 documentation.
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The following steps cover editing the Mobile EditView layout for the Cases module
as an example:

1. Expand "Mobile Layouts" from the Modules panel under the Cases module
and select "Mobile EditView". The Mobile EditView layout will display in
the main panel to the right.

2. To add a field to the Mobile EditView layout, drag the field from the list of
fields in the Toolbox to the desired "(filler)" location on the layout.

3. You can also drag a field to a location on the layout that already has a field
in place. The newly added field and the existing field on the layout will
swap places.

4. To remove a field from the layout, drag and drop the field from the layout
to the trash bin in the Toolbox to remove the field from the layout. You may
remove an entire row in the layout using the same method.
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5. To add a new row, drag the "New Row" item in the Toolbox to the layout to
allow additional fields or blank spaces to be added.

6. Once the layout is finalized, click "Save" to preserve your changes or "Save
& Deploy" to preserve your changes and deploy them instantly.

Unlike the Mobile EditView layout, the Mobile ListView layout has columns where
you can designate fields users can and cannot see. When configuring the Mobile
ListView layout, you will see three columns (Default, Available, Hidden) where
fields can be dragged and dropped accordingly.

Default: This column contains fields that are displayed in the list view; the
first eleven fields are shown by default unless a user has customized their
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list view for the module using the List View Builder in the mobile app. See
the SugarCRM Mobile App User Guide for more details on List View
Builder.
Available: Available fields are fields that will not show by default in the
layout, but if the layout can be personalized, users can add these fields to
their view of the layout. Not all list type layouts have an available fields
section.
Hidden: This column contains fields that will not be displayed or available
to be added to the list view by users.

The following steps cover editing the Mobile ListView layout as an example:

1. Expand "Layouts" from the Modules panel under the Cases module and
select "Mobile ListView".

2. To add a field to the Mobile ListView layout, drag and drop the fields from
the Hidden column to the Default column. The top eight fields will be
displayed on the Cases list view if the user has not customized their list
view at all using the List View Builder in the mobile app. See the 
SugarCRM Mobile App User Guide for more details on List View Builder.
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3. Click the Pencil icon to modify the label of the field as well as the width size
the field will take up in the list view. Please note that the modified label will
display in all ListView layouts.

4. Click "Save & Deploy" to preserve your changes and deploy immediately.

Subpanels

Overview

Related records between modules in Sugar are commonly displayed in Subpanels.
Similar to list type layouts, administrators can modify the subpanel layouts to
change which fields are shown in a module's subpanel. You can add or remove
fields for these subpanels depending on the information you want to be displayed
to users. You can also rename a subpanel if needed. To access the subpanels
section in Studio, expand "Subpanels" from the Modules panel under the desired
module and the available subpanels will appear. Please note that the list of
available subpanels for each module will vary.
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Subpanel Options

When configuring the Subpanel layout in Studio, there are options that allow you
to change the subpanel title, view historical layout changes, and restore the
default layout.

The following options are available when configuring subpanels in Studio:

Subpanel Title: Sugar administrators have the option to modify the name
of the subpanel. This will change the display value of the subpanel when
viewing the record view (for Sidecar modules) or detail view (for Legacy
modules) of a record from the specified module.
View History: Sugar keeps a history of the changes made to each
subpanel. You can preview and restore historical layouts via "View
History". For more information on viewing the history of subpanels, please
refer to the Viewing Layout History documentation.
Restore Default Layout: Restores the subpanel layout back to the default
out-of-the-box layout. For more information on how to reset a subpanel to
the default layout, please refer to the Restoring Default Layouts
 documentation.
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Editing Subpanels

The following steps cover editing the Notes subpanel for the Cases module as an
example:

1. Expand "Subpanels" from the Modules panel under the Cases module and
select "Notes". The Notes subpanel layout will display in the main panel to
the right.

2. To add a field to the list of available column options within the Subpanel
layout, drag and drop the fields from the Hidden column to the Default
column. You can then drag the field up and down the list to change the
position of the field in the subpanel.
Note: When in a module's Record View, individual users can select which
available fields to display in each subpanel by clicking the Gear icon.
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3. To remove a field, drag and drop the fields from the Default column to the
Hidden column.

4. Click the Pencil icon to change the column width of the field in the
subpanel. Administrators can choose from a pre-defined list of width sizes
(e.g., default, small, medium, etc.). Please note that selecting the Default
width will set the list view column to equal the Medium width size.
Selecting "custom" from the list will allow you to enter a custom width
value in the open box. The custom width value should be entered in pixels
(e.g., 200) for Sidecar modules. Legacy modules should be entered as a
percentage (e.g., 40) of the total width of the list view to be dedicated to
the column.
Note: When defining the column width for currency fields (e.g., Likely,
Best, etc.), only "large" and above applies because there is a minimum
width requirement in Sugar for this field type. In addition, when defining a
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custom width for currency fields, the value must be 141px or wider.

5. Click "Save & Deploy" to preserve your changes and deploy them
immediately.

Sugar Logic

Overview

Sugar Logic allows administrators to write simple formulas and logic checks to
provide a calculation for a field or to set the visibility of a field. For more
information regarding the types of fields that you can use Sugar Logic with, please
refer to the Field Options documentation. A calculated field uses a formula to
derive its value based on the values of other fields as well as mathematical or
logical operators. A dependent field uses a formula to determine whether or not
the field should be displayed. These formulas are automatically recalculated when
the record is updated. In addition, when a record containing a formula's input field
is updated, the formula is automatically recalculated.

Note: When creating a calculated formula for a Currency field, the currency
symbol should not be used for a value (e.g., $100) in the formula. The formula
should only define the numeric value (e.g., 100), as including the currency symbol
will result in improperly calculated values.

When a calculated or dependent field is created or its formula is modified, all
existing records in the module will not use the new formula until they have
undergone a save action. To update the existing records to use the new formula,
the module's list view includes a Recalculate Value action. Admin users or users
with developer-level access can use this feature to cause existing records to
recalculate affected fields without having to perform an update on each record
individually. For more information, please refer to the User Interface
 documentation in the Application Guide.

Administrators can access the formula builder for the fields and options that
accept formulas by selecting "Edit Formula".
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To browse all of the functions available, refer to the Complete List of Sugar Logic
Functions section of this page. For more information and examples using Sugar
Logic, please refer to the Sugar Logic section of the Knowledge Base, which
includes articles covering the use of dependent and calculated fields. Topics range
from introductory information to example Sugar Logic formulas and detailed
walkthroughs of how to construct various fields and formulas in the formula
builder.

Functions

Functions are listed on the lower left-hand corner of the formula builder and
provide a variety of calculations, logic checks, and formatting options. To locate
the function you need, simply scroll through the list or enter search criteria to
narrow the list. Refer to the Complete List of Sugar Logic Functions section of this
page to browse all of the available functions.

To see how to use a function, simply hover over the function to view the syntax,
parameters, and a brief description of what the function does.

The function name is followed by a comma-separated list of parameters to the
function. The list specifies the data type expected for each parameter. For
example, the function "daysUntil" expects one parameter of Date type.
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The description in the hover text will typically specify what data type is being
returned, but if it does not, the symbol to the right of the function also represents
the function's data type.

The following is a list of the possible return type symbols and the data types they
return:

Symbol Description
# Returns a Number
Calendar Returns a Date object with a date and

time
% Returns a Boolean (true or false) value
A Returns Text
[ ] Returns a List
? Returns a variable data type that could

be any of the above

Fields

Fields are listed on the lower right-hand corner of the formula builder and contain
the fields for the current module. Fields can be referenced in formulas and will
start with a $. To locate the field you need, simply scroll through the list or enter
search criteria to narrow the list.

To add a field to the formula, simply click on the field to be added. The variable
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name for the field will be placed at the end of the formula. You can also type the
variable names manually in the formula.

Related Field

Related fields are available to be added to formulas via the related function. You
can manually add related function calls to your formula or you can build the syntax
for the related function by clicking "Related Field".

This will open a dialog box that will assist in building the syntax to use the related
function. Select a module and a field within that module to pull the related field
from and click "Insert".

The resulting syntax for the selected options will be added to the formula.

Note: If a record has multiple related records to a module, the related function
will pull the field from one of the related records. It is not recommended to rely on
the related function to pull the same related records for a many relationship.

Rollup

In addition to adding related fields, you can also add aggregate functions on
related fields to formulas via the rollup functions. You can manually add rollup
function calls to your formula or you can build the syntax for the rollup function by
clicking "Rollup".
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This will open a dialog box that will assist in building the syntax to use the rollup
function. Select the type of rollup function (Sum, Average, Minimum, or Maximum)
to perform on the module field. To perform a count of related records, please refer
to the count function listed in the Functions section. Select a module and a field
within that module to perform the rollup function on and click "Insert".

The resulting syntax for the selected options will be added to the formula.

Note: Rollup functions can only aggregate number type fields.

Complete List of Sugar Logic Functions

Some functions require a given number of parameters while others are more
flexible. Most parameters require a specific data type to be passed in for the
function to work. Functions with the same data type can be nested in a single
formula.

The following functions and their parameters (multiple parameters are
represented by "...") are available in Sugar:

Function Description Parameters Return Type
abs Returns the

absolute value of
$param1.

Number $param1 Number

add Returns the sum of
the given
parameters.

Number $param1,
…

Number

addDays Returns $date
moved forward or

Date $date,
Number $days

Date
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backward by $days.
and Returns true if and

only if all given
parameters are
true.

Boolean $param1,
…

Boolean

average Returns the
average of the
given parameters.

Number $param1,
…

Number

ceil Returns $param1
rounded up to the
next integer.

Number $param1 Number

concat Returns all of the
given parameters
appended together
in the order passed.

String $param1, … Text

contains Returns true if
$needle is within
$haystack.

String $haystack,
String $needle

Boolean

count Returns the
number of records
related to this
record by $module

Relate $module Number

countConditional Returns the
number of records
related to this
record by $link and
that match the
value of a specific
field.

Relate $link, Field
$string, Values $list

Number

createList Returns a list of the
given parameters.

Generic $param1,
…

List

currentUserField Returns the value
of a field in the
Users module
($field) for the
currently viewing
user (e.g., currentU
serField("departme
nt")). 
Note: Field values
that can be
evaluated in the

String $field Variable
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Users module are
limited to fields
that have the
"Make visible for
calculations" field
option enabled.

date Returns $param1
as a Date object.

String $param1 Date

dayofweek Returns the
number of the day
of the week that
$param1 falls on.

Date $param1 Number

dayofmonth Returns the
number of the day
of the month as
extracted from a
date or datetime
field.

Date $param1 Number

daysUntil Returns the
number of days
from now until
$param1.

Date $param1 Number

divide Returns the
$numerator divided
by the
$denominator.

Number
$numerator,
Number
$denominator

Number

equal Returns true if
$param1 is equal to
$param2.

Generic $param1,
Generic $param2

Boolean

floor Returns $param1
rounded down to
the next integer.

Number $param1 Number

forecastIncludedCo
mmitStages

Returns all the
included commit
stages for the
Forecast module.

 List

forecastSalesStage
s

Returns the values
of all not-closed
sales stages and
any included closed
sales stages for the
Forecast module

Boolean
$includeWon,
Boolean
$includeLost

List
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from the
sales_stage_dom
dropdown list. If
$includeWon is
true and
$includeLost is
false, it will return
all sales stage
values that are not
"Closed Lost".

forecastOnlySalesS
tages

Exclusively returns
the values of
included sales
stages for the
Forecast module
from the
sales_stage_dom
dropdown list. If
$includeWon is
true and the
remaining
parameters are
false, it will return
all "Closed Won"
values.

Boolean
$includeWon,
Boolean
$includeLost,
Boolean $includeEv
erythingElse

List

getDropdownKeySe
t

Returns a List of
the keys in the
dropdown named
$param1. This list
must be defined in
the Dropdown
editor.

String $param1 List

getDropdownValue Returns the value
for the $key found
in the dropdown
named $list. This
list must be defined
in the Dropdown
editor.

String $list, String
$key

Text

getDropdownValue
Set

Returns a List of
the values in the
dropdown named
$param1. This list
must be defined in

String $param1 List
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the Dropdown
editor.

getListWhere Returns the
matched array from
lists.

String $trigger,
Enum $lists

List 

greaterThan Returns true if
$param1 is greater
than $param2.

Number $param1,
Number $param2

Boolean

hoursUntil Returns the
number of hours
from now until
$param1. 

Date $param1 Number

ifElse Returns $return1 if
$condition is true
or $return2 if
$condition is false.

Boolean $condition,
Generic $return1,
Generic $return2

Variable

indexOf Returns the
position of $needle
in $haystack or -1 if
$haystack does not
contain $needle.
The index starts at
0.

Generic $needle,
List $haystack

Number

isAfter Returns true if
$param1 is after
$param2.

Date $param1,
Date $param2

Boolean

isBefore Returns true if
$param1 is before
$param2.

Date $param1,
Date $param2

Boolean

isForecastClosed Returns true if
$status is in the
forecast config for
sales_stage_won or
sales_stage_lost

String $status Boolean

isForecastLost Returns true if
$status is in the
forecast config for
sales_stage_lost 

String $status Boolean 

isForecastWon Returns true if
$status is in the
forecast config for
sales_stage_won

String $status Boolean 
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isInList Returns true if
$item is contained
within $list. $list
can be a dropdown
or multiselect field
type.

Generic $item, List
$list

Boolean

isValidDate Returns true if
$param1 is a valid
date string.

String $param1 Boolean

isValidEmail Returns true if
$param1 is in a
valid email address
format.

String $param1 Boolean

isWithinRange Returns true if
$value is greater
than or equal to
$min and less than
or equal to $max.

Number $value,
Number $min,
Number $max

Boolean

ln Returns the natural
log of $param1.

Number $param1 Number

log Returns the $base
Log of $value.

Number $value,
Number $base

Number

max Returns highest
value of the given
parameters.

Number $param1,
…

Number

maxRelatedDate Returns the highest
value of $field in
records related to
$module.

Relate $module,
String $field

Date

median Returns the median
of the given
parameters.

Number $param1,
…

Number

min Returns lowest
value of the given
parameters.

Number $param1,
…

Number

monthofyear Returns the
number of the
month that
$param1 is in.

Date $param1 Number

multiply Returns the value
of the given
parameters

Number $param1,
…

Number

                         356 / 829



 

multiplied together.
negate Returns the

negated value of
$param1.

Number $param1 Number

not Returns true if
$param1 is false,
and false if
$param1 is true.

Boolean $param1 Boolean

now Returns a Date
object representing
todays date and the
current time.

 Date

number Returns the
numeric value of
$param1.

String $param1 Number

or Returns true if any
given parameters
are true.

Boolean $param1,
…

Boolean

pow Returns the $value
raised to the power
of $exponent.

Number $value,
Number $exponent

Number

prorateValue Returns the
$baseValue
prorated using
$dv1 and $du1 as
the duration value
and unit of the
numerator
and $dv2 and $du2
as the duration
value and unit of
the denominator.
Supports day,
month, or year as
duration units.

Number
$baseValue,
Number $dv1,
String $du1,
Number $dv2,
String $du2

Number

related Returns the value
of $field in the
related $module.

Relate $module,
String $field

Variable

rollupAve Returns the
average value of
$field in records
related to $module.

Relate $module,
String $field

Number
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rollupConditionalS
um

Returns the sum of
the values of $field
in records related
by $link where
$conditionField
contains something
from
$conditionalValues.

Relate $link, String
$field, String
$conditionField,
List
$conditionalValues 

Number 

rollupMax Returns the highest
value of $field in
records related to
$module.

Relate $module,
String $field

Number

rollupMin Returns the lowest
value of $field in
records related to
$module.

Relate $module,
String $field

Number

rollupSum Returns the sum of
the values of $field
in records related
to $module.

Relate $module,
String $field

Number

strlen Returns the
number of
characters in
$param1.

String $param1 Number

strReplace Returns modified
$subject after
replacing
occurrences of
$search within
$subject string with
the value specified
by $replace.
Include true as the
fourth argument to
make the search
case-sensitive.

String $search,
String $replace,
String $subject,
Boolean $case-
sensitive (optional)

Text

strToLower Returns $param1
converted to lower
case.

String $param1 Text

strToUpper Returns $param1
converted to upper
case.

String $param1 Text

subStr Returns the portion String $value, Text
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of $value specified
by $start and
$length. The
position starts at 0.

Number $start,
Number $length

subtract Returns $param1
minus $param2.

Number $param1,
Number $param2

Number

timestamp Returns the passed
in datetime string
as a unix
timestamp.

 Date

today Returns a Date
object representing
todays date.

 Date

toString Returns $param1
converted to a
string.

Generic $param1 Text

translateLabel Returns the
translated value of
$label for $module.

String $label,
String $module

Text

valueAt Returns the value
at position $index
in $haystack.

Number $index,
List $haystack

Variable

year Returns the year
portion of $param1
in YYYY format.

Date $param1 Number

Module Builder

Overview

Module Builder enables administrators to create, deploy, and maintain custom
modules in Sugar. Modules can be created in Module Builder and then deployed
within your instance of Sugar or exported for additional development and
deployment to other instances of Sugar. This is convenient for testing new modules
and for distributing a module to many different instances. Please note that only
users with administrator or developer access can create and manage custom
modules via Admin > Module Builder. This documentation will cover how to use
Module Builder as well as the various actions and options available from within
Module Builder.

Navigation
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Sugar's Module Builder is divided into three main sections which consist of the
main panel, packages panel, and footer. You can easily create, access, and manage
the custom modules via the main panel and Packages panel. The footer of Module
Builder allows you to access different areas (e.g., Studio, Dropdown Editor) of the
Developer Tools section by clicking the corresponding buttons at the bottom of the
page.

Main Panel

The main panel in Module Builder is where you can create a new package, access
existing packages, deploy a package, etc. As you create and configure the
module(s) within the package, the various sections (e.g., layouts, fields, etc.) you
access will open inside tabs on the main panel. Additional tabs that open up can be
closed by clicking the "X" within the tab.

The main panel also displays the breadcrumbs bar showing your current location
in Module Builder. You can navigate to a specific section by clicking the link within
the breadcrumb bar.

To go back to the previous page you were viewing, click the Left arrow on the
breadcrumbs bar. Clicking the Home icon will navigate you back to the Developer
Tools home page.

Packages Panel

The Packages panel is located to the left of the main panel and displays a list of
existing packages and associated custom modules that are accessible via Module
Builder. The custom modules are grouped under a package and the fields, layouts,
subpanels, etc. specific to each module appear when you expand out the tree for
the module.

                         360 / 829



 

Select an item in the Packages panel to load it into the main panel. Please note
that if you do not see the Packages panel, it may be collapsed. Simply locate the
gray bar to the left of the main panel and click the Right arrow to expand the
Packages panel.

Footer

The footer is located on the bottom left of Module Builder and displays buttons that
enable you to navigate to the different areas (Studio, Dropdown Editor, etc.) of
Developer Tools.

The options in the footer allow you to navigate to the following locations:

Menu Item Description
Home Navigates to the home page of

Developer Tools.
Studio Navigates to the home page of Studio.
Module Builder Opens Module Builder to create and

manage custom modules.
Sugar Portal Editor Opens the Sugar Portal Editor to
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configure the Portal.
Dropdown Editor Opens the Dropdown Editor to create

and edit dropdown lists.

Packages

Packages in Module Builder allow you to create and house multiple modules of
different types. Please note that a package must first be created in order to create
a custom module via Module Builder. While packages can be useful to group
similar or dependent modules together to ensure they are deployed together, it is
generally recommended that a separate package be created for each module. This
can help prevent potential issues down the road since if you ever need to uninstall
a module and it is part of a larger package, then all modules in that package must
be uninstalled. Keeping modules isolated to their own package allows greater
flexibility in the future if a module is no longer needed.

Creating Packages

Use the following steps to create a new package via Module Builder:

1. Navigate to the Module Builder's main panel and click "New Package".

2. Enter appropriate values for the following fields:
Package Name: The name or designation of the package. The
package name is what displays in the Packages panel and in Module
Loader when installing packages.
Author: The author who is creating the package. The author
displays in Module Loader when installing packages.
Key: The key is an alphanumeric text to distinguish modules with
similar names. The system will prefix all class names, directories,
and table names with this key.
Description: A description or other information about the package.
Readme: Click "Readme" to display an open text box where you can
enter additional information about the package or modules
contained in the package.
Note: All required fields are marked with a red asterisk and must
be completed prior to saving.
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3. Once the necessary information is entered, click "Save".

Deploying Packages

Once the package is created and saved, you can create custom modules by clicking
the New Module icon. Please note that the package must contain at least one
module in order to properly publish and deploy the package, as well as export the
customizations. There are various options (e.g., deploy, publish, export, etc.)
available when viewing the package which allows you to perform various actions.

The Package options allow you to perform the following operations:

Action Description
Save Click "Save" to preserve any changes

made to the Package details (Package
Name, Author, etc.).

Deploy Installs the package into the current
instance. Any modules in the package
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will be created or updated in the current
instance.
Note: Do not re-deploy a package once
deployed from Module Builder as any
workflows, code-level customizations, or
changes made through Studio for the
custom modules will be lost. It is
recommended that module packages be
deleted from Module Builder after a
successful deploy to avoid an accidental
re-deploy. Please use Studio to perform
any additional configurations to your
module once deployed.

Publish Saves the package into an installable zip
file containing all customizations.
Upload the file via Module Loader to
install the package into a different
instance.
Note: Packages developed on Sugar
Serve can only be installed on instances
running the same version of Sugar
Serve.

Note: Sugar Sell Essentials customers
do not have the ability to upload custom
file packages to Sugar using Module
Loader.

Export Saves the package into an importable
zip file containing all customizations.
Upload the file via Module Loader to
view the package in Module Builder on a
different instance where it can then be
further developed and deployed.
Note: Packages developed on Sugar
Serve can only be installed on instances
running the same version of Sugar
Serve.

Note: Sugar Sell Essentials customers
do not have the ability to upload custom
file packages to Sugar using Module
Loader.

Deleting Packages
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If a package is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from Module Builder. Please note that deleting a
package will delete all files contained in the package, but will not remove the
package from any instance where the package was deployed. For more information
on how to uninstall a deployed package from an instance, please refer to the 
Module Loader documentation in the Administration guide.

Note: We recommend deleting packages from Module Builder after they have been
deployed in a production instance to prevent them from accidentally being re-
deployed. The only exception to this rule is in a development environment as you
may want to continue working and testing until you are ready to move the module
to your production environment.

Use the following steps to delete a package via Module Builder:

1. Select the desired package from either the Packages panel or from the
main panel.

2. Click "Delete" to remove the package.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Modules

Various types of modules can be created and configured within the package in
Module Builder. Although multiple custom modules can be created in a package, it
is generally recommended that only one module be created per package. This will
help prevent potential issues down the road and allow greater flexibility in the
future if a module is no longer needed.

Note: Activity streams are not available for custom modules.
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Module Types

Module Builder comes with a few predefined module templates for creating
modules. Select the module type that best fits your organization's use of the new
module and then customize the module to further fit your needs.
The following module types are available by default in Module Builder:

Type Description
Basic Generic module with only the most basic

fields defined by default. All other
module types build on top of the basic
module type.

Company Contains fields designed for company,
account, or organization type records.
Includes billing and shipping addresses,
email address, phone numbers, industry,
website, and more.

File Contains fields designed for file upload
or document records. Includes category,
expiration date, status, filename, and
more.

Issue Contains fields designed for bug, issue,
or case record types. Includes issue
number, status, priority, work log, and
more.

Person Contains fields designed for people,
contacts, or lead records. Includes first
and last name, primary and alternate
addresses, email addresses, phone
numbers, and more.

Sale Contains fields designed for sales,
transactions, or opportunities. Includes,
amount, currency, probability, sales
stage, and more.

Module Options

When creating modules in Module Builder, the following configuration options are
available:

Module Name: The name (e.g. HelpDesk) or designation of the module.
The module name is what displays in the Packages Panel as well as in
Studio after deploying.
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Plural Label: The plural label (e.g. HelpDesks) for the module name. The
label is what displays when using the module within Sugar.
Singular Label: The singular label (e.g. HelpDesk) for the module name.
The label is what displays when using the module within Sugar.
Importing: Select this option to enable importing for the module.
Team Security: Select this option to enable team security for the module.
If this option is unchecked, records in this module will not be assigned to a
team and will be restricted by roles only. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.
Navigation Tab: Select this option to add the module and module actions
to the navigation bar.
Type: Select the module type to use as a template when building the
module. Each module type includes a list of stock fields by default which
can be added and removed in the layout as necessary. Please note that the
module type can only be selected when initially creating the module. For
more information regarding the module types, please refer to the Module
Types section of this page.

Creating Modules

While you have the option to create multiple types of modules within a package, it
is generally recommended that only one module be created per package. This will
help prevent potential future issues and allow greater flexibility if a module is no
longer needed.

Creating Modules Via Package

One of the most common methods of module creation is via the New Module option
in the package. When the New Module icon is selected, it opens up the New
Module screen that allows you to enter the module's details (e.g., name, label, etc.)
and to select the module type to use as a template.

Use the following steps to create a custom module in the package:

1. Select a package from the Packages Panel to create a new module.

2. In the main panel select "New Module".
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3. Enter the appropriate values for the Module options. All required fields are
marked with a red asterisk and must be completed prior to saving.

4. Select a module type (e.g. file) to use as a template when configuring your
module.

5. Once the necessary information is entered, click "Save".

Creating Modules Via Duplication

You can also create a new module by duplicating an existing module within a
package. The duplicate option is useful if the module you are creating has similar
information or structure to an existing module.

Use the following steps to create a module by duplicating an existing module:

1. Select a package from the Packages panel to create a new module.
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2. In the main panel, select a module to duplicate.

3. Click "Duplicate" to create a copy of the module.

4. The selected module is duplicated to a new module with a "1" appended at
the end of the module name. Update the necessary fields, then click "Save".
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Modifying Modules

The associated fields, labels, layouts, subpanels, etc. for each module can be
modified within each package. Click the plus sign (+) preceding the module name
to expand the module and view the associated items (e.g. Layouts, Fields, etc.).
Selecting the module from the Packages panel will load the view into the main
panel. You can modify the Module options for the selected module via this page.

Modifying Labels

Labels are used throughout Sugar for items like buttons, field headers, subpanel
titles, error messages, and more. To modify the labels for a module, select "Labels"
from the Packages panel under the desired module.

The Labels tab will open up in the main panel where you can change the names for
specific labels associated to the module. Please note that you can also define the
primary language to use per the language packs currently installed in Sugar when
changing the labels. Select the desired language from the dropdown to view and
modify the labels according to that language.
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Modify the labels for the selected language and click "Save" to preserve your
changes.

Fields

The Fields section in Module Builder allows administrators to create new fields as
well as change properties on existing fields within a module. To access the Fields
section in Module Builder, select "Fields" from the Packages panel under the
desired module and the view will open up in the main panel to the right.

Field Types

The Fields section for each module contains a number of stock fields that come out
of the box with Sugar. Please note that each data type has various options and
properties available to configure.

The following data types are available to be added to modules in Module Builder:

Data Type Description
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Address Creates fields for street, city, postal
code, state, and country.
Note: Custom address fields cannot be
grouped together like the stock address
fields.

Checkbox Creates a checkbox for data fields with a
Yes/No action.

Currency Creates a field to enter a currency
value. The system automatically creates
a dropdown of the currency type if the
field does not already exist in that
module.

Date Creates a field to enter a date. Includes
a button for a calendar popup.

DateTime Creates a field to enter the date and
time. Includes a button for a calendar
popup as well as dropdowns for the
time.

Decimal Creates a field to hold a number
rounded to a specified decimal
precision. Sugar stores the exact
representation of the number in the
database (e.g., For a precision of 2:
1.236 is stored as 1.24).

DropDown Creates a field that you can associate
with a dropdown list of values.

Encrypt Creates a field for sensitive information,
such as social security numbers, whose
value is to be encrypted in the Sugar
database. The value is encrypted in the
database but is visible in the user
interface to users.

Float Creates a field to hold a number
rounded to a specified decimal
precision. Sugar stores the value
differently based on the database
platform Sugar is running on.

HTML Creates static HTML-formatted text to
display in record views.

IFrame Creates a field to store or generate a
URL to display an iFrame in record
views.
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Note: To load content from an external
website in the iframe field,
administrators will need to add the URL
(e.g. https://www.example.com) as a
trusted site via Admin > Content
Security Policy Settings.

Image Creates an image field to upload an
image to display on a record.

Integer Creates a field to specify positive or
negative numbers with no decimal
places.

MultiSelect Creates a dropdown list of values where
multiple values can be selected at once.

Flex Relate Creates a dropdown list from which you
can relate a single record from a variety
of modules. Only one Flex Relate field is
allowed per module. If the module
already has a Flex Relate field, this
option does not display in the Data Type
dropdown list.

Phone Creates a field to enter a phone number.
Radio Creates a radio button for a user to

select one value from a dropdown list.
Relate Creates a field to associate a record

with another module's record as a one-
way relationship. You can add multiple
Relate fields to a module.
Note: Relate fields and custom
relationships are independent of each
other. Changes made to either one are
not reflected in the other. Relate fields
can be added to a report, but any data
on the related record cannot be
accessed in the report. To access
related record data in a report you will
need to create a custom relationship.

TextArea Creates an open text area field for
multiple lines of text.

TextField Creates a field for a single line of text.
URL Creates a field to store or generate a

URL and display as a link.

Field Options
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Fields provide ways to store different data types in Sugar. While many fields come
out of the box with Sugar by default, there can be instances where your
organization needs to store additional data.

When creating or modifying fields via Module Builder, there are some properties
that exist across all field types, and there are some that are unique to only a few
types.

The following field properties and options are available in Sugar:

Audit: Select this checkbox to audit the field for changes made in Sugar.
Users can view the changes made to audited fields via the View
Change Log option in the module's record view (for Sidecar
modules).
Note: The Audit option is available for all data type fields.

Boost value: Enter a boost value for the field to enhance the relevancy of
the field for full-text search. 

The default boost value is 1.0 which indicates a neutral boost. To
apply a positive boost, set the boost value higher than 1. To apply a
negative boost, use values lower than 1. For example, a value of
1.35 will positively boost a field by 135%. But using a value of 0.60
will apply a negative boost.
Note: It is not necessary to perform a full system index when boost
values are changed for fields.

Border: Select this checkbox to add a border around the image for this
field.

Note: The Border option is only available for Image data type fields.
Calculated Value: Select this checkbox to designate this field as a
calculated field.

This opens up the Formula option and disables the Default Value
and Importable options. For more information regarding entering a
formula for a calculated value, please refer to the Formula option
listed in this section.

The result of the formula will be entered into the field for any new
or modified records. When selecting this option, the field value
cannot be modified by users.
Note: The Calculated Value option is only available for the
following data type fields:
Checkbox Currency
Date Datetime
Decimal Encrypt
Float Integer
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Phone TextArea
TextField  

Columns: Enter the number of columns to specify the width of a TextArea
data type field.

Note: The Columns option is only available for TextArea data type
fields.

Comment Text: Enter a comment or description about the field. The
comment text is only viewable via Module Builder and Studio.

Note: The Comment Text option is available for all data type fields
except Flex Relate.

Default Value: Specify or select a default value for this field when a
record is created. Default values for the record are populated by default on
the record view layout but can be modified by users.

Note: The Default Value option is available for all data type fields
except HTML, Image, Flex Relate, and Relate.

Dependent: Select this option to designate this field as being dependent
on a formula or a parent dropdown.

For DropDown data type fields you can select "Parent Dropdown" or
"Formula" for the dependency.

Selecting "Parent Dropdown" will open the Parent Dropdown option
as shown below. Selecting "Formula" will open the Visible If option
to create a dependency formula. For other field data types (e.g.
Date), select the Dependent checkbox to open the Visible If option.
For more information regarding entering a formula to make a
dependent field visible, please refer to the Visible If option listed in
this section.

Note: The Dependent option is available for all data type fields
except Address.

Disable Format: Select this checkbox to disable number formatting such
as the thousands separator.

Note: The Disable Format option is only available for Integer data
type fields.

Display Label: Enter a value to display as the field label and header in
layouts. Normally defaults to the Field name entered when creating the
field.

This value is also modifiable in the packages panel under Labels.
Note: The Display Label option is available for all data type fields
except Flex Relate. Flex Relate uses the Label Value option.

Drop Down List: Select a list of values to associate to the field.
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Only values in the chosen list will be available for selection in the
field. Click "Edit" to change the values for the currently selected
list, or click "Add" to create a new list.
Note: The Drop Down List option is only available for the
DropDown, MultiSelect, and Radio data type fields. For more
information on editing dropdown values via the Dropdown Editor,
please refer to the Editing Dropdown Lists section of the Developer
Tools documentation.

Duplicate Merge: Select one of the following options to determine the
field's functionality when records are being merged:

Disabled: Selected by default. The field will not appear in the
Merge Duplicates feature and will not be available to use for the
filter conditions in the Find Duplicates feature.
Enabled: The field will appear in the Merge Duplicates feature, but
will not be available to use for the filter conditions in the Find
Duplicates feature.
In Filter: The field will appear in the Merge Duplicates feature, and
will also be available in the Find Duplicates feature.
Default Selected Filter: The field will be used for a filter condition
by default in the Find Duplicates page, and will also appear in the
Merge Duplicates feature.
Filter Only: The field will not appear in the Merge Duplicates
feature but will be available in the Find Duplicates feature.
Note: The Duplicate Merge option is available for all data type
fields except Image.

Field Name: Enter the name of the field being created. Once a field has
been created, the field name cannot be changed.

Field names can contain only alphanumeric characters as well as
the underscore character.
The Field Name option is required for all data type fields.
Please do not name a custom field "processed", as this will cause
the web logic hooks to fail to trigger because it conflicts with
Sugar's internal logic hook handling. Be sure to use a different, un-
reserved string as the field name to avoid any unexpected behavior
in Sugar.

Full Text Searchable: Specify whether or not the field should affect
Global Search results.

Disabled: Select "Disabled" if you do not want this field to be
captured when the database is indexed for searches. Search indices
collect the values of searchable fields for evaluation by the Global
Search.
Searchable: Select "Searchable" to include this field's value in
search indexes.
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Selecting "Searchable" will reveal the Boost value field,
which allows you to set a relevance weight for searches.
When a user's search query matches the value of a field with
a higher boost level, the record will appear higher in the
search results. For more information regarding boost values
in Full Text Search, please refer to the Search
documentation in the Application Guide.
Note: The Full Text Searchable option is only available for
the following data type fields:
Phone TextArea
TextField URL

Formula: Contains the current formula to return a calculated value.
Click "Edit Formula" to launch the formula builder and change the
formula. For more information on how to build a formula using the
formula builder, please refer to the Using Sugar Logic section of
this page.

Note: The Formula option is only available when the Calculated
Value option is selected.

Generate URL: Select this checkbox to allow variables from the current
module to be placed into the Default Value option for creating dynamic
URLs.

This is useful for providing links or iFrames to internal systems
such as an ERP or to external systems such as Google Maps.
Select the desired field to add from the dropdown and click "Insert
Field" to add the field to the Default Value. When selecting this
option, the field value cannot be modified by users.
Note: The Generate URL option is only available for IFrame and
URL data type fields.

Height: Enter the number of pixels to vertically scale the image for this
field. Enter only the Width or Height options to retain the aspect ratio of
the image.

Note: The Height option is only available for Image data type fields.
Help Text: Enter basic instructions for populating this field. The text
entered here will display when users hover their mouse on the field in
record view.

Note: The Help Text option is available for all data type fields.
HTML: Enter in static rich text with formatting or HTML code to display
on a record. For more information on how to use the text editor please
refer to the TinyMCE section of the User Interface documentation in the
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Application Guide.

Note: The HTML option is only available for HTML data type fields.
IFrame Height: Enter the number of pixels for the height of the IFrame
field. The width of the IFrame field is always the width of the field
container.

Note: The IFrame Height option is only available for IFrame data
type fields.

Importable: Select one of the following options to determine the field's
functionality when records are being imported:

Yes: The field can be included in an import operation.
No: The field cannot be included in an import.
Required: A value for the field must be provided in any import.

Label Value: Enter a value to display as the field label and header in
layouts. This value is also modifiable in the packages panel under Labels.
Defaults to "Flex Relate".

Note: The Label Value option is only available for Flex Relate data
type fields.

Mass Update: Select this checkbox to add this field as an option to mass
update.

Note: The Mass Update option is only available for the following
data type fields:
Date Datetime
DropDown MultiSelect
Radio  

Max Size: Enter the maximum amount of characters allowed for this field.
Defaults to 255.

Note: The Max Size option is only available for the following data
type fields:
Address Decimal
Float IFrame
Integer Phone
URL TextField

Max Value: Enter the highest value allowable for this field. If a user enters
a higher value in the field than the specified value, a notification will
appear upon save informing them of the set maximum value.

Note: The Max Value option is only available for Integer data type
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fields.
Min Value: Enter the lowest value allowable for this field. If a user enters
a value in the field that is lower than the specified value, a notification will
appear upon save informing them of the set minimum value.

Note: The Min Value option is only available for Integer data type
fields.

Module: Select a module from the dropdown to relate to the current
module.

A module can relate back to itself, a good example of this would be
a relate field on Contacts to relate back to Contacts for a referred
by field. This will allow users to select which contact record
referred a different contact. The chosen module cannot be modified
once the field is created.

Note: The Module option is only available for Relate data type
fields.

Open Link In Select one of the following options to determine how a URL
will open:

New Window: Opens the URL in a new Tab or Window depending
on your browser and settings.
Same Window: Opens the URL in the same window as the record
you are currently browsing.
Note: The Open Link In option is only available for URL data type
fields.

Parent Dropdown: Select an option from the dropdown to specify the
parent that controls the visibility of this dropdown field.

The Parent Dropdown option is populated with the other dropdown
data type fields in the current module.

Note: The Parent Dropdown option is only available when the
Dependent option has "Parent Dropdown" selected.
Click "Edit Visibility" to specify which options are available from the
current dropdown for each value of the parent dropdown. In the
Visibility Editor window, drag values from the current dropdown list
to the value sections of the parent dropdown.

This will determine which options in the dropdown list are available
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when the parent dropdown is set to the specified value. In this
example, if the parent dropdown is set to "Apparel", then the
current dropdown will have options 1, 2, and 3 where if the parent
dropdown is set to "Banking", then the current dropdown will only
have options 2 and 3 available. If there are no available options for
a parent dropdown value, then the dependent dropdown will not
display. To remove an item from the list, simply click and drag the
value to the Trash bin on the left. Once the values are set, click
"Save" to preserve your changes.

Precision: Enter a number to specify the number of digits to the right of
the decimal point the value should be stored as in Sugar.

Note: The Precision option is only available for Decimal and Float
data type fields.

Reportable: Select this checkbox to allow the field to be used in reports.
Note: The Reportable option is available for all data type fields
except Encrypt, Flex Relate, HTML, IFrame, and Image.

Required Field: Select this checkbox to mark the field as required in
Sugar. The user will be required to enter a value for the field before saving
the record.

Note: The Required option is available for all data type fields
except Checkbox and HTML.

Rows: Enter the number of rows to specify the height of a TextArea data
type field.

Note: The Rows option is only available for TextArea data type
fields.

System Label: Enter the system value for storing the label of the field.
This defaults to the name of the field preceded by "LBL". Any lowercase
characters entered will be converted to an uppercase upon saving. Once
the field has been created, the system label cannot be changed.

It is recommended that administrators avoid naming fields with the
same system label in order to prevent the same label and header
values from existing in the system.
Note: The System Label option is available for all data type fields.
Note: Only single-byte characters are supported for system labels
for fields.

Visible If: Contains the current formula to determine if a field is visible on
the layout or not.

Click "Edit Formula" to launch the formula builder to change the
formula.
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The formula must result in a Boolean (true/false) response. For
more information on how to build a formula using the formula
builder, please refer to the Using Sugar Logic section of this page.
Note: The Visible If option is only available when the Dependent
option is checked or "Formula" is selected from the dropdown.

Width: Enter the number of pixels to horizontally scale the image for this
field. Enter only the Width or Height options to retain the aspect ratio of
the image.

Note: The Width option is only available for Image data type fields.

Creating Fields

Use the following steps to create a new field via Module Builder:

1. Expand out the tree under the desired module in the Packages panel and
select "Fields".

2. In the main panel click "Add Field".

3. Enter appropriate values for the Field options. Please note that Field Name
is required.

4. Once the necessary information is entered, click "Save".
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5. Once a field is created it must be placed on the record view layout in order
for users to enter data into that field. For more information on editing
layouts, please refer to the Editing Layouts section of this page.

Editing Fields

Use the following steps to edit an existing field via Module Builder:

1. Expand out the tree under the desired module in the Packages panel and
select "Fields".

2. In the main panel, select a field to edit. Sorting the fields by the column
header will help in locating the field faster.

Note: Fields created via Module Builder will display an asterisk (*)
in front of their name.
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3. Update the necessary Field options and click "Save" once complete.

Deleting Fields

Use the following steps to delete an existing field via Module Builder:

1. Expand out the tree under the desired module in the Packages panel and
select "Fields".

                         383 / 829



 

2. In the main panel, select a field to delete. Sorting the fields by the column
header will help in locating the field faster.

Fields created via Module Builder will display an asterisk in front of
their name.
Note: Fields added via the module type template cannot be deleted.

3. Select "Delete" to remove the field.
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4. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Before deleting a field please verify and resolve the following
issues:

1. Field must be removed from any report filters or displays.
2. Field must be removed from any workflows that filters or

displays the field.
3. Field must be removed from any dashlet that filters or

displays the field.
4. Field must be removed from any Sugar Logic formulas.
5. Field must be removed from any email templates.
6. Field must be removed from any saved searches.

5. The field will automatically be removed from any module layouts when
deleted.

Note: When deleting fields in a module and re-deploying the
package, the data related to the field in the database will not be
removed.

Cloning Fields

Use the following steps to clone an existing field via Module Builder:

1. Expand out the tree under the desired module in the Packages panel and
select "Fields".
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2. In the main panel, select a field to delete. Sorting the fields by the column
header will help in locating the field faster.

Note: Fields created via Module Builder will display an asterisk (*)
in front of their names.

3. Select "Clone" to duplicate the field.
Note: Some non-standard stock fields (e.g. Name) do not have the
ability to clone.
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4. Enter appropriate values for the Field options.
5. Once the necessary information is entered, click "Save".

Relationships

Relationships define the links between different modules in Sugar and allow
records between those modules to be related. Related records display in fields or
subpanels on a module's detail page depending on the relationship type. When you
create a new relationship between two modules, the system automatically creates
the necessary subpanels, related fields, and metadata relationships. Relationships
provide the added benefit in reports to allow access to a related records fields in
addition to the base module's fields.
The relationships section in Module Builder allows administrators to create new
relationships between custom and stock modules as well as change some
properties on existing relationships. To access the relationship section in Module
Builder, select "Relationships" from the Packages panel under the desired module.
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Note: Relationships created through Module Builder cannot be deleted in Studio
after being deployed. Due to this, it is recommended that relationships be created
in Studio after deploying the module instead of via Module Builder. As a best
practice, never re-deploy the module from Module Builder as it will remove all
customizations made to your module via Studio, code customizations, etc.

Relationship Types

Sugar contains a few different types of relationships you can create between
modules. The relationship type will determine what fields or tables will be created
in the database as well as what interface the user will see to manage the
relationship.
The following relationship types are available in Module Builder:

One-to-One: Records in the primary module and the related
module are uniquely related to each other. For a one-to-one
relationship between Accounts and Contacts, an account can be
associated with only one contact and a contact can be associated
with only one account. The relationship will show as a field in each
module's record view where changing the relationship from either
module will also change the value in the other module.

From the primary Accounts module:

From the related Contacts module:
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Note: You can create a one-way relationship between
modules using relate fields. For more information regarding
relate fields, please refer to the Field Types section of this
page.

One-to-Many: Records in the primary module can have relationships with
many records in the related module. For a one-to-many relationship
between Accounts and Contacts, an account can be associated with many
contacts, but each contact can be associated with only one account. The
record view of the primary module will display a subpanel for the related
module, and the detail view of the related module will display a field
containing a link to the related record.
From the primary Accounts module:

From the related Contacts module:
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Note: A one-to-many relationship is the same as a many-to-one relationship
except the Primary and Related modules are reversed. Adding a custom
one-to-many relationship to "Activities" will add custom relationships to
calls, meetings, messages, notes, tasks, and emails. This will also
automatically add these subpanels to the record view.

Many-to-Many: Records in both the primary module and the related
module can have multiple records related in each module. For a many-to-
many relationship between Accounts and Contacts, an account can be
associated with many contacts, and a contact can be associated with many
accounts. Both module's record view will display a subpanel for the
opposite module.

From the primary Accounts module:

From the related Contacts module:
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Note: Only modules with subpanels available can be on the "Many"
side of a relationship. For example, the Product Catalog module
lacks a subpanel; therefore, Product Catalog can only be selected
on the "One" side of a relationship.

When you create a relationship for a module, the selected module is considered to
be the primary module and the module that you relate it with is the related
module.
You can also create a relationship between a module and itself. In this case, the
relationship becomes a parent-child relationship. For example, you can create a
relationship from Accounts to Accounts in order to create sub-accounts within the
primary account.

Creating Relationships

Use the following steps to create a new relationship via Module Builder:

1. Expand out the tree under the desired module in the Packages Panel, and
select "Relationships".
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2. In the main panel, click "Add Relationship".

3. Enter appropriate values for the following options:
Type: Select the type of relationship to create from the options in the 
Relationship Types section.
Module: The Primary module is set to the moduleto which you are adding
the relationship. Select the Related module from the dropdown. The
Primary and Related modules can be the same to create a parent-child
relationship.
Label: Enter a label to reference the Primary module or Related module's
subpanels for this relationship. This option is only available for the "Many"
side of a relationship.
Subpanel from: Select a subpanel option in which to display the Primary
or Related module's records. This will determine the fields displayed in the
subpanel. This option is only available for the "Many" side of a relationship.

4. Once the necessary information is entered, click "Save".

5. The required fields and subpanels are instantly created and saved in the
package.

Editing Relationships

Use the following steps to edit a relationship via Module Builder:

1. Expand out the tree under the desired module in the Packages Panel, and
select "Relationships".
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2. In the main panel, select a relationship to edit. Click the column headers to
sort the grid by different columns to assist in locating the relationship.

3. The only editable field on a relationship is the Label field for naming the
Primary or Related module subpanels. Please note that this option is only
available for the "Many" side of a relationship.

4. Once the necessary information for the Label field is entered, click "Save".

Deleting Relationships

Use the following steps to delete a relationship via Module Builder:

1. Expand out the tree under the desired module in the Packages panel and
select "Relationships".
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2. Select a relationship to delete in the main panel. Click the column headers
to sort the grid by different columns to assist in locating the relationship.

3. Click "Delete" to remove the relationship.

4. A pop-up message will display asking for confirmation. Click "Yes" to
proceed.

Note: If you wish to retain the data and table structure that currently
exists for the relationship, select the "Do Not Remove Tables" option.
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Leaving the "Do Not Remove Tables" unchecked will delete the relationship
data and remove the tables for the relationship from the database when the
package is installed.
Before deleting a relationship please verify and resolve the following
issues:

Relationship must be removed from any report filters or displays.
Relationship must be removed from any workflows that filters or
displays fields from the relationship.
Relationship must be removed from any Sugar Logic formulas
referencing the relationship.

Layouts

Layouts are used to represent many screens in Sugar. The layouts section in
Module Builder allows administrators to add fields and configure layouts. To
access the layouts section, expand "Layouts" from the packages panel under the
desired module. The available layouts for the selected module will appear below.

Layout Types

Sugar comes with different types of layouts to represent different sections of
Sugar. Please note that not all layouts are available in every module.
The following layouts are available to configure in Module Builder:

Record View: Record view layout is used to modify, create, or view a
record within the specified module. Please note that this layout is specific
to modules using the Sidecar user interface.
List View: List view layout is used to view multiple records within the
specified module and displays all results meeting the current search
criteria.
Popup List View: Popup list view layout is used to view multiple records
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via a popup window used to locate and select records in the specified
module.
For Sidecar modules:

Popup Search: Popup search layout is used to allow users to perform a
search via the popup window used to select records in the specified
module.
For Sidecar modules:

Layout Options

Administrators have the ability to configure the various layouts (e.g. record view,
list view, etc.) available via Module Builder. Please note that the layouts can be
configured via Admin > Studio as well once the module has been deployed. For
more information on configuring layouts, please refer to the Studio documentation.

The following are some of the options available to administrators when configuring
layouts via Module Builder:

Panels: Every field on a layout is contained within a panel. Panels can be
open or collapsed by default and have a title defining the panel. Panels can
be organized to contain groups of similar or related fields to assist in
organization.
Select the Pencil icon next to the Panel title to modify the title. Select the
Collapsed? checkbox to default the panel as collapsed. Users can open and
close panels as they prefer.
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Note: The default panel name cannot be modified in Module Builder.
View History: Sugar preserves a history of the changes made to each
layout. Click "View History" and the History dialog box will display the
timestamp of when changes occurred and allow you to preview the layout
then restore if you wish. For more information on viewing the history of
layouts, please refer to the Viewing Layout History section of this page.
Restore Defaults: Sugar provides the option to restore a layout to its
original default configuration. For more information on how to restore the
default layout, please refer to the Restoring Layout Defaults section of this
page.

Editing Layouts

You can add, remove, hide, etc. the fields for the available layouts in the module by
selecting the specific layout under the Packages panel to edit. Please note that the
List View and Popup View layouts have columns where you can designate fields
users can and cannot see.

Once a module is deployed, record views may be configured in Studio to display
differently based on the viewing user's role.

Editing Record View Layout

The following steps cover editing the Record View layout as an example:

1. Expand "Layouts" from the Packages panel under the desired module and
select the layout (e.g. Record View) you wish to edit. The Record View
layout will display in the main panel to the right.
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2. To add a field to the Record View layout, drag the field from the list of
fields in the Toolbox to a "(filler)" location on the layout per your
preference.

You can also drag a field to a location on the layout that already has
a field in place. The newly added field and the existing field on the
layout will swap places.

3. To remove a field from the layout, drag and drop the field from the layout
to the trash bin in the toolbox to remove the field from the layout. You may
remove an entire row in the layout using the same method.
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4. To expand or minimize the field column in the layout, click the Plus icon (+)
to stretch the field over two columns or click the Minus icon (-) to fit the
field into one column.

Note: The layout will display a "(filler)" if there is no field in that
location.

5. To add a new row, drag the "New Row" item in the Toolbox to the layout to
allow additional fields or blank spaces to be added.

6. To add a new panel, drag the "New Panel" item in the Toolbox to the layout
to group different sets of fields together in the Record View layout.
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7. Once the layout is finalized, click "Save" to preserve your changes.

Note: It is recommended that dependent fields be placed below and/or to the right
of the independent field in order to preserve the correct display of fields on the
layout.

Editing List View Layout

Unlike the Record View layout, the List View layout has columns where you can
designate fields users can and cannot see. When configuring the List View layout,
you will see three columns (Default, Available, Hidden) where fields can be
dragged and dropped accordingly.

Please note that editing the List View layout affects the list of available fields for
the module's list view dashlet as well since both are controlled by the same layout
(List View). Once the custom module is deployed, the configurations made to the
list view layout in Module Builder will be reflected in the Columns fields of the
corresponding module dashlet's Configuration Options page. After the custom
module is deployed, all succeeding changes to the List View layout can be made via
Studio. Please keep in mind that the custom module dashlet will not automatically
reflect the Studio changes and users must edit the dashlet in order to view the
changes, add new fields to the layout, etc.

Administrators can easily set the column widths for specific fields when
configuring the List View layout. You can choose from a pre-defined list of width
sizes (e.g., small, medium, large, etc.) that are available out-of-the-box with Sugar
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or enter a custom width value in pixels (e.g. 200) for Sidecar modules.

Note: When defining the column width for currency fields (e.g., Likely, Best, etc.),
only "large" and above will apply because there is a minimum width requirement in
Sugar for this field type. In addition, when defining a custom width for currency
fields, the value must be 141px or wider.

The following table lists the available column width sizes in Sugar along with the
corresponding width in pixels:

Default: This column contains fields that are displayed in the layout.
Available: Available fields are fields that will not show by default in the
layout, but if the layout can be personalized, users can add these fields to
their view of the layout. Not all list type layouts have an available fields
section.
Hidden: This column contains fields that will not be displayed in the
layout.

The following steps cover editing the List View layout as an example:

1. Expand "Layouts" from the Packages panel under the desired module and
select "List View".

2. To add a field to the List View layout, drag and drop the fields from the
Hidden column to the Default column.

Note: The fields in the Default column will be available to add as
display columns in the corresponding custom module dashlet (e.g.
My HelpDesk).
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3. To remove a field from the layout, drag and drop the field from the Default
column to the Hidden column.

4. To change the left-to-right order of the fields displayed on the list view,
drag and drop fields up or down within the Default list.

Note: The order of fields designated for the List View layout also
affects the order for the list of available fields in the corresponding
custom module dashlet (e.g., My HelpDesk).

5. To modify the label of the field, as well as the width of the field, click the
Pencil icon next to each field. 

6. Enter the new label or select the width (e.g. small, medium, large, etc.)
then click "Save". Please note the modified label will display in all List View
layouts for this module.

Note: Administrators can choose from a pre-defined list of width
sizes (e.g., default, small, medium, etc.). Please note that selecting
the Default width will set the list view column to equal the
Medium width size. Selecting "custom" from the list will allow you
to enter a custom width value in the open box. The custom width
value should be entered in pixels (e.g., 200) for the fields.

7. Once the layout is finalized, click "Save" to preserve your changes.
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Mobile Layouts

Administrators can also configure the mobile layouts for the SugarCRM mobile app
by expanding "Mobile Layouts" for the desired module from the Packages panel.
The list of available mobile layouts will display below and you can select the
specific layout (e.g., Mobile EditView, Mobile ListView, etc.) you wish to configure.

Mobile Layout Types

There are various mobile layouts in Sugar to represent the different areas of the
SugarCRM mobile application. Please note that not all layouts are available in
every module and the different mobile applications will use the information defined
here differently.

The following mobile layouts are available in Sugar:

Edit View: Edit view layout is used in Sugar to modify or create records in
the specified module.
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Detail View: Detail view is used in Sugar to view the current data for a
record within the specified module. Certain fields are translated to the
SugarCRM mobile app as buttons instead of data. For example, instead of
seeing the phone number, there is a phone icon to be able to call the
number on the record.
List View: List view layout is used in Sugar to view multiple records within
the specified module. Only the first two fields in the list view section will be
displayed in the mobile app.

Mobile Layout Options

Administrators have the ability to configure the various layouts available via
Module Builder. Please note that the mobile layouts can be configured via Admin >
Studio as well once the module has been deployed. For more information on
configuring layouts, please refer to the Studio documentation.

The following are some of the available options when configuring mobile layouts
via Module Builder:

View History: Sugar preserves a history of the changes made to each
layout. Click "View History" and the History dialog box will display the
timestamp of when changes occurred and allow you to preview the layout
then restore if you wish. For more information on viewing the history of
layouts, please refer to the Viewing Layout History section of this page.
Restore Defaults: Sugar provides the option to restore a layout to its
original default configuration. For more information on how to restore the
default layout, please refer to the Restoring Layout Defaults section of this
page.

Editing Mobile Layouts

You can add, remove, hide, etc. the fields for the available layouts in "Mobile
Layouts" by selecting the specific layout under the Packages panel to edit. Please
note that the Mobile EditView and DetailView layouts are modified in similar
fashions. The Mobile ListView layout has columns where you can designate fields
users can and cannot see.

The following steps cover editing the Mobile EditView layout as an example:

1. Expand "Mobile Layouts" from the Packages panel under the desired
module and select "Mobile EditView". The selected layout will display in the
main panel to the right.
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2. To add a field to the Mobile EditView layout, drag the field from the list of
fields in the Toolbox to a "(filler)" location on the layout per your
preference.

You can also drag a field to a location on the layout that already has
a field in place. The newly added field and the existing field on the
layout will swap places.

3. To remove a field from the layout, drag and drop the field from the layout
to the trash bin in the Toolbox to remove the field from the layout. You may
remove an entire row in the layout using the same method.
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4. To add a new row, drag the "New Row" item in the Toolbox to the layout to
allow additional fields or blank spaces to be added.

5. Once the layout is finalized, click "Save" to preserve your changes.

Unlike the Mobile EditView layout, the Mobile ListView layout has columns where
you can designate fields users can and cannot see. When configuring the Mobile
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ListView layout, you will see three columns (Default, Available, Hidden) where
fields can be dragged and dropped accordingly.

Default: This column contains fields that are displayed on the list view.
Available: Available fields are fields that will not show by default in the
layout, but if the layout can be personalized, users can add these fields to
their view of the layout. Not all list type layouts have an available fields
section.
Hidden: This column contains fields that will not be displayed on the list
view.

The following steps cover editing the Mobile ListView layout as an example:

1. Expand "Layouts" from the Packages panel under the desired module and
select "Mobile ListView".

2. To add a field to the Mobile ListView layout, drag and drop the fields from
the Hidden column to the Default column.

3. Click the Pencil icon to modify the label of the field as well as the width
percentage the field will take up in the list view. Please note that the
modified label will display in all List View layouts in the SugarCRM mobile
app.

4. Once the layout is finalized, click "Save" to preserve your changes.

Available Subpanels

Related records between modules in Sugar are commonly displayed in Subpanels.
Similar to list type layouts, administrators can modify the available subpanel
layouts to change which fields are shown in a module's subpanel. You can add or
remove fields for these subpanels depending on the information that you want to
display to users. To access the subpanels section in Module Builder, expand
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"Available Subpanels" from the Packages panel under the desired module. The
available subpanel for the selected module will appear to the right of the screen.

Subpanel Options

When configuring the Subpanel layout in Module Builder, there are some available
options that allow you to view historical layout changes as well as restore the
default layout. Please note that the subpanel layout can be configured via Admin >
Studio as well once the module has been deployed. For more information on
configuring layouts, please refer to the Subpanels section of the Studio
documentation.

View History: Sugar keeps a history of the changes made to each
subpanel. These changes and when they occurred can be viewed and
restored via "View History". For more information on viewing the history of
subpanels, please refer to the Viewing Layout History section of this page.
Restore Defaults: Sugar also contains the ability to restore a subpanel to
its original default configuration. For more information on how to reset a
subpanel to default, please refer to the Restoring Layout Defaults section of
this page.

 

Editing Subpanel Layout

Use the following steps to modify a subpanel via Module Builder:

1. Expand "Available Subpanels" from the Packages panel under the desired
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module and select the subpanel you wish to edit. The selected subpanel
layout will display to the right in the main panel.

2. To add a field to the Subpanel layout, drag and drop the fields from the
Hidden column to the Default column.

You can drag the field up and down the list to change the position of
the field in the subpanel.

3. To remove a field, drag and drop the fields from the Default column to the
Hidden column.
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4. Click the Pencil icon to change the column width of the field in the
subpanel.

Note: Administrators can choose from a pre-defined list of width
sizes (e.g. default, small, medium, etc.). Please note that selecting
the Default width will set the list view column to equal the
Medium width size. Selecting "custom" from the list will allow you
to enter a custom width value in the open box. The custom width
value should be entered in pixels (e.g. 200) for the fields.
When defining the column width for currency fields (e.g. Likely,
Best, etc.), only "large" and above applies because there is a
minimum width requirement in Sugar for this field type. In addition,
when defining a custom width for currency fields, the value must be
141px or wider.

5. Once the subpanel layout is finalized, click "Save" to preserve your
changes.
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Using Sugar Logic

Sugar Logic allows administrators to write simple formulas and logic checks to
provide a calculation for a field or to set the visibility of a field. A formula specifies
one or more field values along with operators and functions that are mathematical
or logical. When you execute a formula, Sugar performs the calculation to derive
the value. When a field is used in a formula, Sugar recalculates the value whenever
a user updates it and saves the record. Similarly, if you update a formula, Sugar
recalculates the field value based on the updated formula. For the complete list of
Sugar Logic functions and how to use them, please refer to the Studio
 documentation.

For more information regarding the types of fields that support the use of Sugar
Logic, please refer to the Field Options section of this page.

Viewing Layout History

Layouts, subpanels, and mobile layouts keep a history of the last ten changes made
to each layout. To view the history for any of these layouts, simply click "View
History" on the layout editor view in Module Builder.

The History dialog box will open up displaying the timestamps of when changes
occurred and allow you to preview the layout by clicking the Preview button.
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The preview will show the details of the layout as of the specific time it was saved.
To restore the layout to the particular version you are viewing, simply click the
Restore button from under the Preview tab or in the History dialog box. The
restored layout will load into the layout editor allowing you to make any additional
changes as necessary. Click "Save" to preserve your changes.

Restoring Layout Defaults

Many layouts, subpanels, and mobile layouts can be restored to their original
default configuration. To restore the default for any of these layouts, simply select
"Restore Default" from the edit layout screen in Module Builder.
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The default layout will load into the editor allowing you to make changes as
necessary. Click "Save" to preserve your changes.

Deleting Modules

If a module is invalid or should no longer appear in a package, it may be deleted
from Module Builder. Please note that deleting a module from a package will not
remove the module from any instances where the package was deployed. For more
information on how to uninstall a deployed package from an instance, please refer
to the Module Loader documentation.
Use the following steps to delete a module from a package via Module Builder:

1. Select the desired package and module from the Packages panel or the
main panel.

2. Click "Delete" to remove the module.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Module Loader
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Overview

Module Loader is used to install a variety of custom file packages, including
custom modules, into a Sugar instance. Using Module Loader, you can also
manage and uninstall these packages, all done through Sugar's user interface.
Packages are uploaded as a ZIP file from an administrator's local computer and
then, when deployed, will force changes upon the instance's filesystem and
database.

Custom module packages can be created and modified in Module Builder, and
then, after deployment, they will show in Module Loader. They can also be
exported from Module Builder in one instance, and then uploaded to another
instance via Module Loader.

Module Loader Layout

Module Loader consists of three panels. The panels include all necessary
information about the packages, and also include different buttons to perform
actions, explained in Module Loader Fields. The panels are:

Installed Packages: This panel shows all installed packages. On this
panel, you have the option to uninstall or disable installed packages. After
installation, the packages will move from the Uploaded Packages panel to
this panel.

Module Upload: This panel consists of an upload option where files can be
uploaded to Sugar via a browser file selection window. Please review 
Uploading Modules for more information on using this panel.

Uploaded Packages: This panel shows all packages that have been
uploaded to Sugar, but have not yet been installed, or have been
uninstalled. Packages can be installed or deleted from Sugar using this
panel.

Module Loader Fields
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Module Loader contains different fields on the Installed Packages and Uploaded
Packages panels. Each set of fields show relevant and identifying information
about the module package.

The Installed Packages panel consists of the following fields:

Field Description
Name The name of the package, pulled from

the manifest.php file of the package.
Action Button allowing you to uninstall the

package from your Sugar instance if the
package is marked as uninstallable in
the manifest.php file of the package.

Enable/Disable Button allowing you to enable or disable
the functionality of the package without
uninstalling.
Note: Always perform a Quick Repair
and Rebuild after disabling and then re-
enabling a package via Module Loader.

Type Describes the type of package, pulled
from the manifest.php file of the
package.

Version The version of the package pulled from
manifest.php file of the package.

Date Installed The date and time that the package was
installed.

Description The description of the package pulled
from the manifest.php file of the
package.

The Uploaded Packages panel consists of the following fields:

Field Description
Name The name of the package pulled from

the manifest.php file of the package.
Install Button allowing you to install the

package to your Sugar instance.
Delete Button allowing you to delete the

package from your Sugar instance.
Type Describes the type of package, pulled

from the manifest.php file of the
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package.
Version The version of the package, pulled from

manifest.php file of the package.
Date Published The date and time that the package was

initially created from the publisher.
Uninstallable Tells you if the package is uninstallable

from the manifest.php file of the
package.

Description The description of the package pulled
from the manifest.php file of the
package.

Uploading Packages

After receiving the file that you would like to install, you must first upload it to
your Sugar instance. To upload a file, use the following steps:

1. Navigate to Admin > Module Loader
2. Click the "Choose File" button in the Module Upload panel to open a file

selection window from your browser

3. Select the file from your local computer
4. After you select your file, click the "Upload" button to complete the process

5. After it has been uploaded, the package will show in the Uploaded
Packages panel

It is also possible to upload packages using a REST API endpoint. Refer to the 
Developer Guide for more information.

Installing Packages

After uploading a package to Module Loader, it must be installed for the package's
contents to take effect on your instance. To install a package, follow the following
steps:
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1. Follow the steps to upload your package to Module Loader.
2. Click the "Install" button on the Uploaded Packages panel.

3. You will be brought to the installation screen to confirm that the packages
should be installed and to read and accept any license or readme
documentation as needed. Click "Commit" when ready to run the
installation.

4. The next page will show a progress bar and a completion notice. If there
are any errors, they will be displayed with a verbose explanation of what
went wrong. If not, click "Display Log" to show what happened during the
installation process.

Note: To sustain the stability, security, and integrity of Sugar's
cloud service environment, all installed packages are scanned to
check for code not conforming to environmental agreements. Any
package that fails this scanner will not be installed and the installer
will produce a reason for the failed installation. If this happens,
please contact the developer of your package for more information.

5. Click "Back to Module Loader" when complete to return to Module Loader.
If you do not need to install any further packages, you can navigate to any
other section of Sugar as need be.

If you install a package that causes an error or puts the Sugar instance into an
unusable state within the first five minutes, the package installation is rolled back
so that the Sugar instance can become usable again. Details of the errors can be
found in the sugarcrm.log file to help troubleshoot the cause.
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It is also possible to install packages using a REST API endpoint. Refer to the 
Developer Guide for more information.

Uninstalling Packages

After a package has been installed in your Sugar instance, it can be removed if it is
no longer needed. When uninstalled, the package will remove any available
customizations to your instance from the filesystem and database. Any legacy
workflows based on the module will also be deleted.

Note: Packages have to be defined as "Uninstallable" in the manifest.php file of
the package to be able to be uninstalled.

To uninstall a package, perform the following steps:

1. Navigate to Admin > Module Loader.
2. Locate the package you would like to uninstall in the Installed Packages

panel.
3. Click the "Uninstall" button.

Note: If you do not see an Uninstall button next to your package, it
may be caused by one of the following circumstances:

There may be a newer version of the package installed that
has an Uninstall button and that package must be
uninstalled first. 
The manifest.php file may not define the package as
uninstallable.
The package may be missing files that are critical to
performing the uninstall.

4. If the package has added any database tables to your instance, you will see
a selection of whether to remove or retain the database tables. If the
database tables include any information you would like to keep, select the
"Do Not Remove Tables" option. An example of this would be if you are
uninstalling a custom module but will be reinstalling a new version of the
same module. You would want to keep the data but remove any files
associated with the old module that will be replaced with the new package.

5. Click "Commit" when you are ready to uninstall the package.

6. The next page will show a progress bar and a completion notice. If there
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are any errors, they will be displayed with a verbose explanation of what
went wrong. If not, click "Display Log" to show what happened during the
uninstall process.

7. Click "Back to Module Loader" when complete to return to Module Loader.
If you do not need to uninstall any further packages, you can navigate to
any other section of Sugar as need be.

8. After the package has been uninstalled, it can be deleted from your
instance via the Uploaded Packages panel.

It is also possible to uninstall packages using a REST API endpoint. Refer to the 
Developer Guide for more information.

Installing Role-Based Customizations

Administrators have the ability to create role-based custom dropdown lists and
role-based custom record views via Studio and Dropdown Editor. These role-based
customizations are included when exporting customizations via Studio. When the
exported package is then installed on a destination instance, administrators will be
given the opportunity to map the package's customized roles to the destination
instance's roles. Sugar will attempt to select a matching role from amongst the
destination instance's roles. The role mapping can be manually altered by selecting
a different role from the dropdown menus. If you do not want to install a role's
customizations, choose "Do not map this role" in the dropdown. Once the mappings
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are correctly set, click "Commit" to proceed with installing the package.

Importing Role-Based Custom Record Views

If the package contains role-based custom record views, the mapped roles in the
destination instance will be updated to match the package's custom record views.
Any prior customizations made record view for the destination instance's role will
be overwritten. Regardless of any prior customizations made on the destination
instance, all mapped roles will be updated to completely match the imported role-
based record views. For more information about creating role-based custom record
views, please refer to the Studio documentation.

Importing Role-Based Custom Dropdown Lists

When a package contains non-stock dropdown values for the default role, the
destination instance's default role-list will be completely overwritten by the
package.

If the package, the destination instance, or both include role-based custom
dropdown lists, Sugar will take the destination instance's original customized role-
lists into consideration when deciding on the resulting customized role-lists. The
following table demonstrates how default custom dropdown lists and role-based
custom dropdown lists will be affected:

When a cell indicates "Undefined", it means that the role does not have a
customized role-list, and it will inherit the custom default list.
When a cell indicates "Any", it means that the role's role-list is customized,
but any of the possible combinations of values will produce the same result.
When a cell indicates "Empty", it means that the role's role-list is
customized to have no enabled values.
In every situation, the resulting default role-list will be overwritten to
exactly match the package's default role-list.

Situation Destinati Destinati Package Package Resulting Resulting
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and
Outcome

on
Default
Role-List

on
Custom
Role-List

Default
Role-List

Custom
Role-List

Default
Role-List

Custom
Role-List

The
destinatio
n and
package
match.

The
destinatio
n remains 
unchanged
.

A,B,C B,C A,B,C B,C A,B,C  B,C

This role is
not
customize
d in the
destinatio
n or
package.

This role
will not be
customize
d and
will inherit
the default
role-list.

A,B,C  Undefined X,Y,Z Undefined X,Y,Z Undefined 

This role is
customize
d in both
the
destinatio
n and
package.

This role's
custom
role-list is
updated to
match the
package's.

A,B,C Any A,B,C A,C A,B,C A,C

This role is A,B,C  Any X,Y,Z X,Y X,Y,Z   X,Y
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customize
d in both
the
destinatio
n and
package.

This role's
custom
role-list is
updated to
match the
package's.
This role's
custom
role-list
has no
enabled
options in
the
package.

This role's 
custom
role-list
will have
no enabled
values.

A,B,C Any,
Empty, or
Undefined 

 X,Y,Z Empty  X,Y,Z  Empty 

This role is
customize
d in the
destinatio
n but not
in the
package.

This role's
custom
role-list is
reduced to
the values 
present in
both the d
estination'
s custom

A,B,C A,C A,B,E Undefined A,B,E A
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role-list
and the
package's
default
role-list.
This role is
customize
d in the
destinatio
n but not
in the
package.

This role's
custom
role-list
will have
no enabled
values
since
there is no
overlap
between
the destin
ation's
custom
role-list
and the
package's
default
role-list.

A,B,C Any X,Y,Z Undefined X,Y,Z Empty

This role is
customize
d in the
destinatio
n but not
in the
package.

This role's
custom
role-list
will have
no enabled
values

A,B,C C A,B,E Undefined A,B,E Empty
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since
there is no
overlap
between
the destin
ation's
custom
role-list
and the
package's
default
role-list.

For more information about creating role-based custom dropdown lists, please
refer to the Dropdown Editor documentation.

Sugar Portal

Overview

The Sugar Portal is a powerful tool that allows Sugar users to interact with
customers and share information related to multiple modules (Bugs, Cases,
Knowledge Base). The portal allows customers to log in and review information
directly from your Sugar instance and perform actions such as submitting cases
and bugs, communicating with your employees regarding the cases and bugs, as
well as reviewing knowledge base articles. To enable the portal for your instance,
the Enable Portal option must be enabled via Admin > Sugar Portal. This will
enable a Portal API User in Admin > User Management which must be left enabled
in order for portal users to authenticate. This documentation covers the basics on
how to configure the various portal settings, the look and feel of the portal, as well
as configure the layout for the available modules (e.g., Cases) in the portal.

For more information on how a Sugar user can interface with the portal, refer to
the Portal Deployment User Guide.

For more information on how your customers can interface with the portal, refer to
the Portal User Guide.

Configure Portal

The Configure Portal page allows administrators to enable the portal and configure
different aspects of the portal interface such as enabling or disabling modules,
defining the number of records to display per list view, etc. For more information
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on how these settings are applied in the portal, refer to the Portal User Guide.

The following settings are available to configure when setting up your portal:

Field Description
Enable portal Enable the checkbox to have the portal

enabled for customers. After enabling
the portal and clicking "Save", the portal
URL will appear under the checkbox
which is where you can access the
portal for your instance.

Number of records to display on list Enter the maximum number of records
to display per list view results set in the
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portal. By default, this is set to 20
records per results set.
Note: This value must be no greater
than 100.

Default assigned for new portal
registrations

Select the Sugar user that will be
assigned to the contact records created
from the portal registrations.

Portal modules Select which modules will appear in the
portal's navigation bar by dragging and
dropping the module between the
Displayed Modules and Hidden Modules
columns. You can also designate the
order of the modules displayed in the
navigation bar by selecting the module
in the Displayed Modules column and
moving it up or down. 
Note: To completely remove access to
the module from the portal, then you
will need to disable access to the
module via Admin > Role Management
for the Customer Self-Service Portal
Role. For more information on roles,
refer to the Role Management
documentation. 

Visibility: Case Select which portal users you wish to be
able to see cases in the portal. The
following are the options:

All contacts related to the
account: Choose this option if
you wish for all the customer's
portal users to be able to see all
of their organization's cases.
Only primary contact and
contacts related to the case:
Choose this option if you wish
for only the customer's portal
users that are related to a
specific case to be able to see
that case. This includes the user
in the Primary Contact field and
all contacts in the case's
Contacts subpanel.

Note: This setting only applies to
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instances with the Cases module
enabled for the portal.

Visibility: Email Select which portal users you wish to be
able to see emails in the case timeline in
the portal. The following are the
options:

All contacts who can see the
case: Choose this option if you
wish for all contacts with access
to a particular case to be able to
see all emails related to the case.
Only participating contacts:
Choose this option if you wish
for only the contacts that are
participants in the email (i.e.,
contacts in the To, From, CC,
and BCC fields on the email) to
be able to see an email.

Visibility: Message Select which portal users you wish to be
able to see messages in the case
timeline in the portal. The following are
the options:

All contacts who can see the
case: Choose this option if you
wish for all contacts with access
to a particular case to be able to
see all messages related to the
case.
Only participating contacts:
Choose this option if you wish
for only the contacts that are
participants in the message (i.e.,
contacts in the Guests field on
the message) to be able to see a
message.

Portal Contact Information Enter the company's contact information
(i.e., phone, email, URL) that will be
available to portal users requiring
additional assistance logging into their
account. This information can be
accessed by clicking the Forgot
Username link on the Forgot Password
screen or clicking the "Did not get an
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email?" link after the portal user
submits their username to initiate their
password reset.
Note: At least one field must be
configured in order for the contact
option to be available in the portal. 

Enable notes on the Knowledge Base
module

Enable this setting to allow portal users
to view and create notes on Knowledge
Base articles. When disabled, the Notes
subpanel and Add a Note button are
hidden.

Allow new users to sign up Enable this setting to allow new users to
create a portal account from the portal
login page. When disabled, the Sign Up
link on the login page is hidden.

This setting can also be controlled in
the system config_override.php file via
the portal_enableSelfSignUp
property. See the Core Settings page in
the Developer Guide for details on this
property.

Allow portal users to close case Enable this field to display the Request
To Close button on open cases in the
portal. Customers can click the button
to request to have the case closed,
which sets the Request Close and
Request Close Date fields on the case.
See the Sugar Portal User Guide for
more details.

Note: This setting only applies to
instances with the Cases module
enabled for the portal.

Enabling the Sugar portal will create a Customer Self-Service Portal Role and
enable a Portal API user in Admin > User Management which must be left enabled
for portal users to authenticate. The information viewable in the portal can be
updated and restricted by Sugar users as allowed by team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation in the
Administration Guide.
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Do not delete the Customer Self-Service Portal Role or the Portal API user, as they
are system-generated based on portal activation. If the portal role or user is
accidentally deleted, you must disable and re-enable the Sugar Portal to recreate
them.

Note: Hiding a module via Admin > Display Modules and Subpanels will not
remove the module from the portal. You will need to disable access to the module
via Admin > Role Management for the Customer Self-Service Portal Role in order
to remove it from the portal. For more information on roles, refer to the Role
Management documentation. 

Theme Portal

The Portal Theme Preview page allows you to customize the look and feel of the
portal, such as changing the logo, banner, text, and colors, to match your
organization's theme and message. Certain settings on this page only take effect if
they are available in your product. The following lists outline the settings available
for each product:

Sugar Serve:

All settings on the page, including the dashboard in the bottom left corner

Sugar Sell:

Login Page Image URL
Navigation Bar Logo URL
Button Color
Text Link Color

Sugar Enterprise:

Login Page Image URL
Navigation Bar Logo URL
New Case Button
New Case Message
New Case Button Text
Button Color
Text Link Color

Making changes to a setting that is not available in your product will have no
impact on the portal.

The Portal Theme Preview page is divided into three sections. On the left, you can
see a preview of the portal Home page. Specifically, the top half is a preview of
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configuration changes you make on the right side and the bottom half is a
dashboard that you can configure in place. On the right, you can update a variety
of settings to change the portal experience. The left-hand-side preview is updated
in real-time so you can quickly see the results of your changes on the right.

The right-hand-side panel includes the following settings:

Login Page Image URL: Enter the URL of the image you wish to display
on the portal login page. The image is scaled down if necessary to fit in the
login box.

If you do not enter a URL, the SugarCRM logo is displayed by
default. 
For reference, the SugarCRM logo that is used by default has
dimensions of 1000 x 189 px and is scaled down on the login page.
When you enter a URL, a preview of the image is displayed directly
below the field; if you do not see a preview, the image cannot be
found using the URL and will not appear in the portal.
Since the login page is not shown in the preview on the left, it is
recommended to open the portal login page to verify that the image
is displayed as you would like and to resize the image if it is not.

Navigation Bar Logo URL: Enter the URL of the image you wish to
display in the top left corner of the portal. The image is scaled down if
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necessary to fit in the navigation bar.
If you do not enter a URL, the SugarCRM logo is displayed by
default. 
For reference, the SugarCRM logo that is used by default has
dimensions of 22 x 22 px. Either a small, square image or a short
but wide image is recommended to ensure it scales down nicely.

Banner Background Style: Choose the style of background to use. The
following options are available:

Default: This is the default blue gradient that is used if you do not
change the background.
Color: This allows you to specify any color. Selecting it causes the
Background Color field to appear, where you can choose a color by
entering the hex color code or clicking in the text field to open the
color picker.
Image: This allows you to use an image. Enter the URL of the
image you wish to use; the image is scaled down if necessary.

When you enter a URL, a preview of the image is displayed
directly below the field; if you do not see a preview, the
image cannot be found using the URL and will not appear in
the portal.

New Case Button: Enable this checkbox to add a button to the navigation
bar for users to create a case.
New Case Message: Enter the text you would like to display next to the
New Case button.
New Case Button Text: Enter the name you would like to use for the New
Case button, if not "New Case". If you leave this value blank while the New
Case button is enabled, the default value of "New Case" will be used.
Search Bar: Enable this checkbox to display a search bar on the Home
page to allow users to search knowledge base articles.
Search Bar Text: Enter the text you would like to display above the search
bar. You can use the following variable to display the full name of the portal
user within the message: {{full-name}}.
Button Color: Choose a color for all portal buttons by entering the hex
color code or clicking in the text field to open the color picker.
Text Link Color: Choose a color for the text of all links in the portal by
entering the hex color code or clicking in the text field to open the color
picker. Link text is not represented in the preview on the left, so it is
recommended to log in to the portal to verify that the color you have
chosen meets your expectations.

Once you are happy with your changes to the settings on the right-hand side, click
"Save & Deploy" to push the changes to all portal users. If you want to reset all the
settings to their default values, click the link at the bottom of the section. Note
that this does not affect the dashboard section at the bottom left; there is a
separate Restore Default Dashlets option in the floating actions button in the
dashboard.
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The note at the bottom of the right section also contains a link to open the Amazon
Connect Settings page to set up Sugar Portal Chat.

On the left-hand side, the top section shows a live preview of the changes you
make in the right panel. The bottom section is a dashboard that can be configured
in the same way you edit any dashboard, by dragging, resizing, adding, editing,
and removing dashlets. This includes defining filters for List View dashlets to limit
which records portal users see, in addition to the basic restrictions that are
already applied to portal users (e.g. case visibility defined in Configure Portal).
Note that custom filters saved in the Portal Theme Preview page are only available
for use in configuring the portal and are not available in the rest of Sugar.
Likewise, existing custom Sugar list view filters cannot be used in the portal.

Changes you make in the dashboard are immediately visible to all users without
using the Save & Deploy button. To avoid disruption to your portal users, it is
recommended to make portal dashboard configuration changes outside of regular
business hours. If you want to reset the dashboard and all of its dashlets to the
default layout and settings, click the Restore Default Dashlets option in the floating
actions button, but note that this cannot be undone. This does not impact the
settings on the right-hand side of the page.

Layouts

The Sugar Portal Editor also allows you to configure the record view and list view
 layouts for the Cases, Bugs, and Knowledge Base modules in the portal. You can
also configure the Contacts record view layout to control what fields to display in
the portal user's profile. Please note that both stock and custom fields that appear
in Admin > Studio are available to add to the portal layouts.

Record View

The portal record view displays key record information including all relevant fields
for the module (e.g., Knowledge Base) and the user's profile. The editor allows you
to add a field to the Record View layout by dragging the field from the list of fields
in the Toolbox to a "(filler)" location on the layout per your preference. You can
also change the location of existing fields in the layout by dragging and dropping
the field to a different location on the layout. To remove a field from the layout,
simply drag and drop the field(s) from the layout to the trash bin in the Toolbox.
Please note that changes to the Record View layout will also affect what fields
appear when a portal user previews a record (e.g. knowledge base) in the portal.
Once the layout is finalized, click "Save & Deploy" to preserve your changes and
deploy them to the portal. You can also click "Save" if you wish to preserve the
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changes but not deploy the changes to the portal. For more information on editing
the record view layout, refer to the Studio documentation. 

List View

The portal list view displays all records that meet the current search criteria in the
Cases, Bugs, and/or Knowledge Base modules that the portal users can access. The
editor allows you to drag and drop fields between the Default, Available, and
Hidden columns as follows: 

Default: Drag fields into the Default column to display them in the default
List View layout. To change the left-to-right order of the fields displayed on
the list view (or right-to-left for users viewing an RTL language), drag and
drop the fields up or down within the Default list. 
Available: Drag fields into the Available column to make them available for
portal users to personalize their view of the list view layout without making
them part of the default layout. Portal users will be able to click the
Column Selection icon to the far right of the list view column headers to
see the list of available fields.
Hidden: Drag fields into the Hidden column to hide them from portal users
in the module's list view. 

You can also modify the label and width for a field by clicking the Pencil icon to the
right of each field and entering the new field label and selecting the width (e.g.,
small, medium) of the field column in the list view.

Once the list view layout is finalized, click "Save & Deploy" to preserve your
changes and deploy them to the portal. For more information on editing the list
view layout, refer to the Studio documentation.
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Legacy Workflow Management

Overview
Notice: While the legacy functionality discussed on this page is still supported in
the product, we recommend using the latest technology for the best user
experience. Please refer to the SugarBPM documentation to learn more.

Sugar's Workflow functionality allows administrators to configure cause-and-effect
type actions throughout Sugar and across multiple modules. Workflows can be
used to update fields, send emails, or create records when certain conditions are
met. Workflows are a great way to configure automated processes within Sugar so
that users do not need to remember manual steps and instead can focus on their
primary tasks and job responsibilities.

All workflow conditions are reached and checked for once a record is saved.
Workflows can be configured to either start their process to perform the job the
moment the save occurs, or they can be delayed for a given amount of time.

The following save events can trigger a workflow to fire:

Manually saving a record
Mass updating records
Importing records
Another workflow updating a record
Reassigning Records via User Management
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Updating or creating a record via plug-ins
Updating or creating a record via SugarCRM mobile applications
Updating or creating a record via the portal
Updating or creating a record via the Web Services

Workflows can be viewed and configured by any System Administrator User. In
addition, regular users with a role that provides Developer access will be able to
access workflows for the module they have the rights to. For more information on
Roles, please review the Roles documentation.

Workflow Fields

The Workflow module contains seven fields that will retain both functional and
organizational purposes in Workflows. These fields cannot be edited or added to
because of their functional purposes in the workflow process.

Field Dropdown Options Description
Applies To New and Updated

Records
New Records Only
Updated Records
Only

Choose if this workflow is
going to fire on all saves,
when a new record is
created, or when an
existing record is updated

Description (Text Area Field, no
character limit)

A description of this
workflow and its purpose

Execution Occurs When record saved
After time elapses

Whether the workflow
effects will occur once a
record is saved, or if they
will be re-checked and
occur after a defined
amount of time

Name (Text field, limit of 50
characters)

Identifying name of the
workflow

Processing Order Alerts then Actions
Actions then Alerts

If your workflow is going
to include both email
alerts and workflow
actions, select which of
the two you would like to
happen first

Status Active
Inactive

When set to Inactive, the
workflow will not process
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Target Module (Module List) A list of all modules in
Sugar that are compatible
with workflows. Choose
which module the primary
conditions will be
triggered from

Workflow Module Tab

Click the Workflow module tab in the navigation bar, shown after selecting
Workflow Management in the Admin page, to access the Workflow list view. You
may also click the three-dots menu in the Workflow module tab to display the
Actions and Recently Viewed menus. The Actions menu allows you to perform
important actions within the module. The Recently Viewed menu displays the list
of workflow definitions you last viewed in the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Workflow Definition Opens the edit view layout to create a

new workflow.
List Workflow Definitions Opens the list view layout to search and

display workflows.
Alert Email Templates Opens the Alert Template menu to allow

you to create, view, and edit existing
alert email templates.

Workflow Sequence Opens the Workflow Sequence menu to
allow you to reorganize the processing
order of your workflows for each
module.

Creating Workflows
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Workflows are created by accessing the Admin menu, navigating to the Developer
Tools section and then clicking on the link for Workflow Management.

Once on the Workflow Management module, you can create a new workflow or
duplicate an existing one. The process of creating workflows contains four main
sections. First, the workflow itself must be created. This creation process will
include the name of the workflow, as well as the rest of the values for the fields
listed in the Workflow Fields section of this documentation. After the workflow has
been saved, the next step will be to configure the Workflow Conditions, which
defines what will cause the workflow to happen, or its triggers. Finally, the 
Workflow Alerts and Workflow Actions must be configured. These define what the
workflow will do to Sugar records or what emails will be sent out after triggered.

Creating Via Workflow Module

The most common method of workflow creation is via the Create Workflow
Definition option in the Workflow Management module. This opens up the edit
view layout which allows you to enter in all the relevant information for the
workflow.

Use the following steps to create a workflow via the Workflow Management
module:

1. Navigate to Admin > Workflow Management.
2. Click the three-dots menu in the Workflow Definitions tab to open the

Actions menu and select "Create Workflow Definition".

3. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

4. Once the necessary information is entered, click "Save".
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5. Define the conditions of the workflow that will trigger the workflow to
process as described in Creating Workflow Conditions.

6. Define what will happen when the workflow is processed as described in 
Creating Workflow Alerts and Creating Workflow Actions.

Creating Via Duplication

You can also create a new workflow definition by duplicating an existing workflow
record. The duplicate option is useful if the workflow you are creating has similar
information, conditions, and alerts and actions to an existing workflow as all of
these are copied over during the duplication process.

Use the following steps to create a workflow definition by duplicating an existing
record:

1. Navigate to a workflow definition's detail view.
2. Click the Actions menu and select "Copy".

3. The displayed edit view is pre-populated with the values of the original
workflow. Update the necessary fields then click "Save".
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Creating Workflow Conditions

Workflow conditions are an essential function when creating workflows. Workflow
Conditions define the "cause" side of the workflow's cause and effect type
functionality. At least one condition must exist for a workflow to trigger. If more
than one conditions exist, they all must be fulfilled for the workflow to trigger.

Use the following steps to create a workflow condition:

1. Navigate to the detail view of the workflow.
2. Click "Create" on the Conditions subpanel to open a popup box with the

different condition possibilities. 

3. Follow the prompts in the popup to create the different conditions, as
described below. Once complete, click "Save" and the condition will be
added to your workflow definition.

4. Repeat this process as necessary to add additional conditions.
5. After the condition has been created, it will appear in the conditions

subpanel.

Note: The available conditions will vary depending on the execution type ("When
record saved" or "After time elapses") you have chosen for the workflow.

Creating "After Time Elapsed" Workflow Conditions

Before creating workflows with time-elapsed conditions, please take note of the
following:

The system's Process Workflow Tasks scheduler must be enabled and
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running as often as possible for time-elapsed workflows to work. For more
information, please refer to the Schedulers documentation.
When a time-elapsed condition is used on a workflow definition, the Date
Modified and Modified By fields will change on the records affected by the
workflow's action(s). The Modified By user will be the admin user with ID =
1 (usually "Administrator") and the Date Modified will reflect the date and
time that the action occurred in the system.
The time intervals (e.g., 0 hours, 4 hours) available when setting up time-
elapsed conditions can be configured via Admin > Dropdown Editor. For
more information on configuring the time intervals, please refer to the 
Developer Tools documentation. 

The "After time elapsed" workflow condition options are different for the first
condition and subsequent conditions. This is to ensure that your time-based
condition is recorded. After that, you can set additional conditions to filter the
records from which the workflows will fire.

When used as the first condition of a workflow, the "After time elapsed" options
are as follows:

When a field in the target module changes to or from a specified
value: You will be asked to specify a specific field within the module, and
its value. Then, you will select the amount of time after the change that,
after this threshold, the workflow will fire.
Field does not change for a specified amount of time: You will be
asked to specify a specific field within the module and a timeframe. After
the field changes, if it does not change again in the given timeframe, the
workflow will fire.

When used as subsequent conditions of a workflow, the "After time elapsed"
options are the two mentioned above as well as two additional options:

When a field in the target module contains a specified value: This
condition is used to filter records that should or should not be included in
the workflow. You will be asked to specify a field and the value of the field,
and if you want to include records where the field is a specific value, or if it
is not a specific value. These conditions will vary by which field is chosen.
When the target module changes and a field in a related module
contains a specified value: This condition is used to filter records based
on their related records. You will be asked to specify which relationship you
would like to the workflow to look at, and which field and value should or
should not be used when triggering the workflow.

Creating "When Record Saves" Workflow Conditions

The "When record saves" workflow condition options are as follows:
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When a field in the target module changes to or from a specified
value: This option can be used to specify both the new value of a specific
field to trigger a workflow, and also what the previous value was. You will
be asked to specify the specific field and the new value after save to use
this condition. The previous value is not required.
When the target module changes: This option will cause the workflow to
trigger when any change to the record takes place.
When a field on the target module changes: This option will cause the
workflow to trigger when there is any change to a specific field, regardless
of what the change is.
When a field in the target module contains a specified value: This
condition is used to filter records that should or should not be included in
the workflow. You will be asked to specify a field and the value of the field,
and if you want to include records where the field is a specific value, or if it
is not a specific value. These conditions will vary by which field is chosen.
When the target module changes and a field in a related module
contains a specified value: This condition is used to filter records based
on their related records. You will be asked to specify which relationship you
would like to the workflow to look at, and which field and value should or
should not be used when triggering the workflow.

Creating Workflow Alerts

Workflow alerts are one of the possible effects of workflow's cause-and-effect type
functionality. These can be used with or without workflow actions. Workflow
alerts, when triggered by the workflow condition, will cause an email to be sent to
a specified recipient. These recipients include Sugar users or individuals related to
the target module. To create a workflow alert, follow the following steps:

1. Navigate to the detail view of the workflow.
2. Click "Create" on the Alerts subpanel, which will bring you to the alert

setup page.

3. You will be presented with the following fields to populate. Field Descri
ption

Name Choose
a brief,
descrip
tive
name
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for this
alert.

Alert
Type

Default
s to "E
mail",
which
is the
most c
ommon
usage,
but
you
can ch
oose "I
nvite"
if the
alert is
going
to send
an invi
tation
for app
ointme
nt-
based 
module
s.

Source
Type

Choose
"Norm
al mes
sage"
to type
a plain-
text
email 
messa
ge in
the
Alert
Text
field,
or
choose
"Custo
m Tem
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plate"
to
select
and
use a 
Workfl
ow
Alert T
emplat
e.

Alert
Text

Enter
text
that
will be
sent to
the
alert's 
recipie
nts as
a
simple
email 
messa
ge
withou
t forma
tting
or vari
ables.

Note:
This
field is
shown
only
when
the
Source
Type
field co
ntains 
"Norm
al mes
sage".

Custo Select
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m Tem
plate

from
your a
vailabl
e 
Workfl
ow
Alert T
emplat
es for
this
alert's
target 
module
.

Note:
This
field is
shown
only
when
the
Source
Type
field co
ntains 
"Custo
m Tem
plate".

4. Enter necessary values for all fields and click Save.

5. On the next screen, click "Create" on the "Alert Recipient List" subpanel to
choose your recipients.
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Note: The only options that will send to someone
other than a Sugar user are "Recipient associated with the target module"
and "Recipient associated with a related module".

6. Pick the recipients, select any blue hyperlink text to define any variables,
such as who a specified user is, or if the recipient should be sent the email
as a "To", "CC", or "BCC" recipient, and then click "Save" to continue.

7. Repeat steps 5 and 6 as need be to add additional recipients for this
workflow alert.

8. Click the hyperlink for "Send alert to the following recipient" to make any
changes, remove any errant recipients with the "Remove" button on the
corresponding row, or the "Edit" button on the top left if you need to
change any configurations. Once complete, click "Return to Workflow
Definition". 
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9. After the alert has been created, it will appear in the Alert Subpanels.

Creating Workflow Actions

Workflow actions are one of the possible effects of workflow's cause and effect
type functionality. These can be used with or without Workflow Alerts. Workflow
actions, when triggered by the workflow condition, will cause either updates to
existing records or creation of new records. To create a workflow action, follow the
following steps:

1. Navigate to the detail view of the workflow that you are working on
2. Click "Create" on the Actions subpanel to open a popup box with the

different action possibilities

3. Follow the prompts in the popup to create the different actions, as
described in Workflow Actions. Once complete, click "Save" and the action
will be added to your workflow definition.

4. Repeat this process as necessary to add additional actions.

5. After that action has been created, it will appear in the Actions Subpanel.

Workflow Action Types
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There are four options for actions that are available. These options can make
updates to the module your workflow is tied to, or a module related to this target
module. The options can also create records in related modules or modules related
to related modules. The options are as follows:

Update fields in the target module: You will be given the option so
select one or more fields within the target module of the workflow, and
what the new value or values should be.
Update fields in a related module: You will first be given the option to
choose which related module to the target module you would like to
update. After selecting the related module, you will select one or more
fields within the related module to update, and what the new value or
values should be.
Create a record in a module associated with target module: You will
be given the option to choose a related module to your target module. This
action will create a new record in the related module, such as creating a
new call related to an account, where Accounts is the target module. After
selecting the module, you will be given the option to populate any or all
fields with the related module. Any required fields will be marked with a
red asterisk.
Create a record associated with a module related to the target
module: This action will take a record, or all records, related to your
target module, and create a related record to this middle module. When
creating these actions, you are asked to select the related module to your
target module, and then select that module's related module where the new
record is going to be created. For example, if your workflow's target
module is Contacts, the following screenshot shows how a call will be
created and related to the contact's related Opportunity. 
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On the next screen, after selecting your modules, you will select one or
more fields within the related module to update, and what the new value or
values should be. Clicking on the "Advanced Search" button at the bottom
of this window will allow you to select if the workflow is specific for all
related records (Opportunities), or if the related record should be filtered
at all.

The "Advanced Search" function also contains special functions for specific
field types:

Assigned User: Allows you to configure the action to set the
assigned user to be either the actual user or the user's manager
who either is currently assigned to the triggered record, the one
who most recently updated it, the one who created it, or is the one
saving the record.
Team ID: Allows you to configure the action to set the team to be
the default team of the user who triggered the workflow or, if it is
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updating a related record, to match the primary team of the
triggered record.
Dropdown Fields: Allows you to configure the action to
sequentially move the dropdown option forward or backward in the
order in which it appears in the dropdown list.

Viewing Workflows

There are various options available for viewing workflow records in Sugar
including via Workflow Definitions list view, Workflow Definitions detail view, and
the Workflow Definitions Last Viewed menu. Each method will provide varying
degrees of detail and insight into the workflow.

Viewing Via List View

The Workflow Definitions list view displays all records meeting the current search
criteria. To access the list view, simply click the Workflow Definitions module tab,
which is made available by navigating to Admin > Workflow Management. While
list view shows key workflow fields, you can click the workflow definition's name to
open the record in detail view. For more information on viewing workflows via list
view, please refer to the Workflows List View section of this documentation.

Viewing Via Detail View

The Workflow Definitions detail view displays thorough workflow information
including all workflow fields followed by subpanels showing the Conditions, Alerts,
and Actions that process the workflow. The detail view can be reached by clicking
a workflow definition's link from the Workflow Definitions list view. For more
information on viewing workflows via detail view, please refer to the Workflow
Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which workflows you have recently viewed.
Click the three-dots menu in the Workflow module tab to see a list of your most
recently viewed workflows and click each name to open the workflow definition in
detail view.
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Searching Workflows

The Workflow Definitions list view includes a Basic and Advanced Search to help
you locate records easily and effectively. Once the search is performed, the
relevant results will be displayed in the Workflows list view below. Please note that
Sugar automatically appends the wildcard character (%) to the end of your search
phrase. This allows the system to retrieve all records that start with the keyword
entered in the search. If you would like to broaden the search, you can use the
wildcard at the beginning of your text as well (e.g., %created). This will pull up any
workflow that has the word "created" in the name, regardless of how it starts or
ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a simplified search experience allowing you to search for just
the name of the workflow. From the Basic Search panel, you can click "Advanced
Search" to access additional search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear criteria from the Name field.
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When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. Once the search is complete, the
relevant results will populate in the list view beneath the search panel. To see all
workflow definitions, simply click "Clear" and then "Search" to perform a blank
search with no filters.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons and dropdowns available in Advanced Search have the following
functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.
Layout Options: Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches: Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select the Target
Module as "Accounts" or "Contacts" and enter in the word "Created" for the Name
search, Sugar will only return workflow definitions with a matching name from the
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Accounts or Contacts modules. Once the search completes, the relevant results will
populate in the list view beneath the search panel. To see all workflow definitions,
simply click "Clear" and then "Search" to perform a blank search with no filters.

Workflows List View

The Workflows list view displays all workflow definitions meeting the current
search criteria. You can view the basic details of each workflow within the field
columns. The list view also allows for records to be edited or deleted as need be.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but the number of records
displayed can be changed via Admin > System Settings. For more information on
changing the number of displayed records, please refer to the System
documentation.

 

Checkbox Selection

You can delete workflow definitions directly from the list view by first selecting the
desired records. To select individual workflows on the Workflow Definitions list
view, mark the checkbox on the left of each row. To select or deselect multiple
workflow definitions on the list view, use the options in the checkbox dropdown
menu:

Select This Page: Selects all records shown on the current page of
workflow results.
Select All: Selects all records in the current search results across all pages
of workflow results.
Deselect All: Deselects all records that are currently selected.
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Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

 

Workflow Detail View

The Workflow Definition detail view displays thorough workflow information
including all workflow fields. You will also see the Conditions, Alerts, and
Actionssubpanels beneath the workflow fields. The detail view can be reached by
clicking a workflow record's link from the Workflow Definitions list view or from
the recently viewed menu.

Actions Menu

The Actions menu on the top left of each workflow definition's detail view allows
you to perform various actions on the current record. The action items can be
configured to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration Guide.
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The Options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this workflow definition.
Copy Duplicate this workflow definition.
Delete Delete this workflow definition.

Next or Previous Record

On the upper right of the Workflow Definitions detail view, there are four buttons
that allow you to page through each workflow in the Workflow Definition list view's
current search results. Clicking the Previous button displays the previous workflow
of the current search results while clicking the Next button displays the next
workflow of the current search results. The two double-arrow First Page and Last
Page buttons allow you to skip to the first or the last workflow of your current
results. The text in between shows which workflow result you are currently
viewing within the total number of current results.

Conditions Subpanel

The Workflow Conditions subpanel allows you to create additional conditions for
your workflow and also lets you view and modify the existing ones. The subpanel
shows a Description and a Value for each condition. The Description is an
automatically generated, brief explanation of the condition. The Value shows what
field or fields are covered in the condition, if not expressly stated in the
description. The Conditions subpanel allows the following operations to be
performed.
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To view the details or edit a condition, either click the condition's
description in the subpanel or click the edit button from the far right of the
record's row to open the condition popup.
To create a new workflow condition, choose "Create" from above the
subpanel, then follow the steps supplied in the Creating Workflow
Conditions section of this documentation.
To delete a condition on this workflow, choose "Remove" from the far right
of the record's row.

 

Alert Subpanels

The Workflow Alert subpanel allows you to create additional alerts for your
workflow and also lets you view and modify the existing ones. The subpanel
displays the "Detail"s, "Type", and "Event Description" for each condition. After an
alert has been created, there is also a column for Recipients. The "Event
Description" is automatically generated and provides a brief explanation of the
alert with the name of the Alert record and what template (if applicable) is being
sent to the recipients. The Alerts subpanel allows the following operations to be
performed.

To view or edit an alert, either click the alert's event description or click
"Edit" on the far right of the row to open the alert's edit view.
To view the recipients of the alert, click "Show" from the far left of the
record's row. Click "Hide" to collapse the drawer highlighting the
recipients
To edit or add recipients of the workflow alert, click "Recipients". This
button will also open the alert's detail view.
To create a new workflow alert, choose "Create" from above the subpanel,
then follow the steps supplied in the Creating Workflow Alerts section of
this documentation.
To delete an alert on this workflow, choose "Remove" from the far right of
the record's row.
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Actions Subpanel

The Workflow Actions subpanel allows you to create additional actions for your
workflow and also lets you view and modify the existing ones. The subpanel shows
a Details, Type and an Event Description for each condition. The Event Description
is an automatically generated, brief explanation of the action that will be
performed by the workflow. The Conditions subpanel allows the following
operations to be performed.

To view the details or edit a condition, either click the condition's
description in the subpanel or click the edit button from the far right of the
record's row to open the condition popup.
To view the actions that will be performed, click "Show" from the far left of
the record's row. Click "Hide" to collapse the drawer highlighting the
actions.
To create a new workflow action, choose "Create" from above the subpanel,
then follow the steps supplied in the Creating Workflow Actions section of
this documentation.
To delete an action on this workflow, choose "Remove" from the far right of
the record's row.

 

Editing Workflows

Workflows may be edited at any time to update or add information to the
definition. You can make changes to existing workflow definitions via the
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Workflows edit view. Edit view is available within the Workflows module and
includes all of the Workflow fields. It can be accessed either via the detail view or
list view. Please note that Conditions, Alerts, and Actions are not edited through
the Workflow edit view.

Note: After a workflow has been created, the fields "Execution Occurs" and
"Target Module" cannot be edited

Editing Via Detail View

You can edit workflows via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes made.

Editing Via List View

You can edit workflows via the list view by clicking the Pencil icon to the left of
each workflow's name. The page will navigate to the edit view. Update the
necessary fields, then click "Save" to preserve the changes. After saving, you will
be brought to the detail view of the workflow.

Deleting Workflows

If a workflow definition is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Workflow Definition's detail view
or list view. Deleting via the detail view allows you to delete a single record while
the list view allows for mass deleting multiple records at once. Deleting the
workflow definition will also remove the conditions, actions, and alerts to stop
workflows from firing.

Deleting Via Detail View
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Use the following steps to delete a workflow via the detail view:

1. Navigate to a workflow definition's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Mass Deleting Via List View

Use the following steps to delete one or more workflows via the list view:

1. Navigate to the Workflow Definitions list view via Admin > Workflow
Management.

2. Use the Basic or  Advanced Search to find the Workflow Definitions you
wish to delete.

3. Select the desired records individually or using the checkbox dropdown's
options.

4. Choose "Delete" from the Actions menu. 

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of workflow definitions. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Workflow Alert Templates

When sending a workflow alert, you have the option of sending either a "Normal
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Message" which will be just a simple, plain text alert, or utilizing a workflow
template. Templates have the option to use full HTML editing, to include
formatting changes, colors, variables to include data from fields in Sugar, and
more.

Alert Template Fields

The Workflow Templates functionality contains several fields that will retain both
functional and organizational purposes in Workflows. These fields cannot be edited
or added to because of their functional purposes in the workflow process.

Field Description
Body This is where you can design your email

template using the WYSIWYG (What you
See Is What You Get) editor. Click the
"Alt Text" checkbox to edit the plain text
version of this email. The entry into this
box is what will actually be sent to the
recipients of the email.

Description A short explanation of the template and
what it is used for.

Field List Used to select which field from the
given module will be inserted into the
Variable Insert field to eventually be
inserted into the template, which can be
changed by updating the Related
Module dropdown field.

From Address What sender's email address will be
shown on the email when received by
the recipient.

Note: Mail servers have the
functionality to override this setting
meaning the email address will show as
the one that actually sends this, defined
in Admin > System Email Settings.
Please review the Emails documentation
for more information.

From Name What sender's name will be shown on
the email when received by the
recipient.

Name Identifying name of the template.
Related Module List of modules related to the Target
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Module, which will change the Field List
and, therefore, change the fields that
can be used for variables in the email.

Subject The subject line of the email which will
show for the recipients.

Target Module Selected when creating the template
and a non-editable field, this will cause
the template show when using the
template for workflows made to the
corresponding module.

Type Will only show as workflow, but will vary
when making other template types to
include Email and Campaign.

Value Type Select "New Value" or "Old Value" if the
variable will be changing on the
workflow to determine if the variable
should include the value of the field
before or after the record is saved.

Variable Insert This field will build the variable for you
based on the Target Module, Related
Module, Field List, and Value Type
fields.

Creating Alert Templates

Alert Templates are created only via the Workflow module. Alert templates can be
created either directly from the workflows module via the Alert Templates page, or
via duplication. The Target Module is defined during the creation process, and
then a full edit view layout opens including all fields that will be necessary to
create the template.

Creating Alert Templates Via Workflows Module

The most common method of template creation is via the Alert Email Templates
option in the Workflow Definitions module tab. This will open the edit view layout
allowing you to configure the template to your specifications.

Use the following steps to create the template via Workflow Management:

1. Navigate to Admin > Workflow Management.
2. Click the three-dots menu in the Workflow Definitions tab and select "Alert

Email Templates".
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3. Select the module you wish to create the alert template for then click
"Create".

4. Enter appropriate values for the following fields below. Required fields are
marked with a red asterisk and must be completed prior to saving.

Name: Enter a name for the email template. 
Type: Leave as "Workflow".
From Name: The name that the email recipient will see as the
sender.
From Address: The email address that the email recipient will see
as the sender.
Note: This may be overwritten by your mail server configured in
Admin > System Email Settings.
Description: Enter a description or other information about the
template.
Related Module: To insert a field from a record related to the
target module, select the related module. 
Subject: Enter the subject of the email that will be sent.
Body: Enter the body of the emails that will be sent.
Attachments: Click the "Choose File" button to open a file
selection window from your browser and attach a file. Click the
Sugar Document button to attach a file from the sugar database.

5. Populate the template body that will be sent to the email recipients. Insert
variables as necessary for your workflows.

6. Using the TinyMCE functions, add simple formatting to your email's
content. For more advanced customization you can click the HTML button
in the top left to access and edit the generated HTML code. For more
information on using TinyMCE, please refer to the User Interface
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documentation.
Note: If images or advanced CSS are required in your email template, it is
highly recommended to host the images or CSS file on a publicly available
hosting service and link to it in the email template.

7. Once the necessary information is entered, click "Save" to preserve your
changes to the email template.

Creating Alert Templates Via Duplication

You can also create a new template by duplicating an existing template. The
duplicate option is useful if the template you are creating has similar information
to an existing template.

Use the following steps to create a template by duplicating an existing template:

1. Navigate to an existing template's detail view.
2. Click the action option for "Copy".

3. The displayed edit view is pre-populated with the original template's
values. Update the necessary fields then click "Save". 
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Inserting Variables

When constructing the subject and body of your email, Sugar allows you to insert
variables, or placeholders, into the template that will be populated with the
record's information for that variable. The variables allow you to insert data from
fields within the record that triggered the workflow and its related records into
your template. Use the following steps to insert a variable for the recipient's first
name into the template:

1. Click to place your cursor on the location in the subject or body where the
recipient's first name should appear.

2. Set the variable dropdown to the desired field from the workflow's target
module. For our example, select "First Name".

3. Choose between "New Value" and "Old Value" in the value dropdown field.
This will determine if the value of the given variable shown on the template
will be the value of the field in question before or after the workflow fired.
This functionality is especially helpful if you are showing a change between
two values, such as an opportunity moving from new ("Old Value") to closed-
won ("New Value"). "New Value" is the default option for this list.

4. Click "Insert" to insert the generated variable name to your subject or body
at your cursor's location.
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Note: You can click "Alt Text" at the bottom of the page to have the plain text
option send differently than the HTML text.

Viewing Alert Templates

There are various options available for viewing workflow templates in Sugar
including via Workflow Templates list view, Workflow Templates detail view, and
from the Emails module.

Viewing Alert Templates Via List View

The Workflow Templates list view displays all workflow templates and key fields
about each template. To access the list view, simply navigate to the Workflow
Management section of the Admin menu and select "Alert Email Templates" from
the Workflow Definitions module tab. Use the Alert Templates list view for the
following functions:

To open the record in detail view, click the template's name.
To re-sort the list view results one column at a time, click the column
header, and the columns will sort alphabetically or chronologically.
Use the arrows in the top right side of the list view navigate through the
pages of your templates, or skip to the first or last page using the double
arrow buttons.
To delete a template, click "Remove" from the far right of the
corresponding template's row.

Viewing Alert Templates Via Detail View

The Alert Templates detail view displays thorough alert template information
including all template fields and a preview of the workflow template that recipients
will see after it is sent. The detail view can be reached by clicking a template's link
from the Alert Templates list view.
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While viewing the detail view, the preview of the email template is shown as the
last field option. You can also click the "Alt Text" checkbox to see how this email
will look when the recipient views it as plain text.

Viewing Alert Templates Via Emails Module

The Emails module contains all of the email templates in Sugar. Alert Templates
can be accessed via Emails, in addition to accessing via Workflow Management. To
access alert templates via Emails, simply select the View Email Templates option
from the Emails module tab.

This will bring you to the Email Templates list view where you can select which
template you would like to view. For more information on navigating the Emails
module, please review the Emails module section of the Application Guide.

Editing Alert Templates

Alert Templates may be edited at any time to update or add information to the
template. You can make changes to existing templates via the Alert Templates edit
view. Edit view is accessible via the Alert Templates detail view. You can edit alert
templates via the detail view by clicking the Edit button on the upper left of the
page. Once the edit view layout is open, update the necessary fields, then click
"Save" to preserve the changes made.

Deleting Alert Templates

If an alert template is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Alert Templates detail view or
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list view. Deleting alert templates will not delete any workflows using them. If a
workflow is utilizing a template which you are deleting, it is recommended that the
workflow be updated to include a new template on the alert.

To delete a template from the template's detail use the following steps:

1. Navigate to the Alert Templates detail view.
2. Click the Delete button.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

To delete a template from the list view, use the following steps:

1. Navigate to the Alert Templates list view.
2. Select the "Remove" button on the row of the template you would like to

delete. 

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Time Intervals for Time Elapsed Workflows

Time elapsed workflows trigger after a specified amount of time has passed from
when the record was saved. Users with administrator or developer access have the
ability to add new time intervals to the dropdown list ("tselect_type_dom") used for
time elapsed workflows. The time interval dropdown list can be viewed and edited
via Admin > Dropdown Editor. For more information on Dropdown Editor, please
refer to the Developer Tools documentation.

By default, the time intervals are:

4 days5 days1 week2 weeks3 weeks 0 hours 3 days 30 days
4 hours 60 days
8 hours 90 days
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12 hours 120 days
1 day 150 days
2 days 180 days

The following steps cover adding a 1 hour time interval to the dropdown list via
Dropdown Editor as an example:

1. Navigate to Admin > Dropdown Editor.
2. Locate the tselect_type_dom dropdown list and click to view the details.

3. Enter an item name (e.g., 3600) and display label (e.g., 1 hours) into the
corresponding fields below the existing item list.

Please note that the Item Name field must be in seconds equaling to
the hours, days, weeks you wish to add.

4. Click "Add" to add the new value to the dropdown list.
Note: The value will be added to the end of the list, but you can
drag and drop the item to the top of the list if you wish. For more
information on how to reorder and position values in the dropdown
list, please refer to the Developer Tools documentation.
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5. Once the item has been added and placed in the correct position, click
"Save" to preserve the change.

The newly added time interval will now appear in the corresponding dropdown list
when creating the condition for a time elapsed workflow.

Workflow Sequence

When a record is saved within a module, Sugar will check all workflows for that
module to see if they need to process and perform any actions or send any alerts.
Sugar processes each of the workflows in sequential order, one after another. By
default this order is determined as the order in which the workflow definitions
were created; the oldest workflow fires first, moving up to the newest. This order,
however, can be reorganized using the Workflow Sequence menu.

Workflow Sequence can be accessed through the following process:

1. Navigate to Admin > Workflow Management.
2. On the Workflow Definitions module tab, select "Workflow Sequence".

3. Select the module you would like to reorganize from the dropdown menu
and click "Select".

This process will produce a list view with all of the workflows for the particular
selected module. The list view will show three columns containing details from the 
workflow fields, as well as a fourth column for "Process Order".
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The Process Order column is used to reorganize the workflows into their correct
processing order. The Up button will move the workflow up one rung in the
process, whereas the Dn button will lower it in the sequence. The order of the
workflow process for this module is determined on this menu, starting at the top
and working its way down.

Products and Quotes

Overview

The Products and Quotes section of the Admin panel enables you to define
products and product details that are used in modules that are exclusive to Sugar
Sell users. The Products and Quotes panel provides access to the following
modules:

Module Description
Product Catalog List of products sold by your

organization; used as a template for the
Quoted Line Items and Revenue Line
Items modules for Sugar Sell users.

Product Categories Populates the categories by which
products are organized in the Product
Catalog.

Product Types Populates the Type dropdown list in the
Product Catalog.

Manufacturers Populates the Manufacturer Name
dropdown list in the Product Catalog.

Please note the following as pertains to access and visibility of Product Catalog-
related modules:

Quotes Configuration, Shipping Providers, and Tax Rates are additional
modules that work with the Product Catalog but are not accessible by
Sugar Serve users. For more information on license types and the
functionality available for each, refer to the License Types Matrix

                         469 / 829



 

documentation. 
For some older, unsupported versions of Sugar, the Product Catalog,
Product Categories, Product Types, and Manufacturers modules were only
available to Administrator users. Information specific to these modules can
now be found in the Product Catalog documentation in the Application
Guide.
For Sugar Serve users to leverage the Product Catalog, an administrator
would need to add a custom relate field from the Product Catalog module
to a supported Sugar Serve module (i.e., Bugs, Cases, or Knowledge
Base). For more information on setting up a Product Catalog field for bugs,
cases, or knowledge base articles, please refer to the Creating a Relate
Field article.

For instructions concerning views and actions which are common across most
Sugar modules, such as creating, editing, and deleting records, please refer to the 
Working With Sugar Modules section of this page.

Product Catalog, Product Categories, Product Types,
and Manufacturers

For some older, unsupported versions of Sugar, the Product Catalog, Product
Categories, Product Types, and Manufacturers modules were only available to
Administrator users but can now be accessed by all users subject to license type
and standard role and team restrictions. Information specific to these modules can
now be found in the Product Catalog documentation in the Application Guide.

Working With Sugar Modules

The Shipping Providers and Tax Rates modules use Sugar's Sidecar user interface.
The following sections detail menus, views, and actions common to sidecar
modules and contain links to additional information within the page or links to the
User Interface documentation.

Menus

Sugar modules contain various options that are available via menus in the module
tab, list view, and record view. The following sections present each menu type,
using the Shipping Providers module as an example, and its options with links to
more information about each option in the User Interface documentation or, for
module-specific functionality, within this page.

Module Tab Menus

The Shipping Providers list view can be accessed by navigating to the Admin page
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and selecting "Shipping Providers" under the Product and Quotes panel. Click the
tab to access the Shipping Providers list view. You may also click the three-dots
menu in the Shipping Providers tab to display the Actions and Recently Viewed
menus. The Actions menu allows you to perform important actions within the
module. The Recently Viewed menu displays the list of shipping providers you most
recently viewed. 

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Shipping Provider List Opens the Shipping Providers list view

layout to search and display shipping
providers.

Tax Rate List Opens the Tax Rates list view layout to
search and display tax rates.

List View Menus

The Shipping Providers list view displays all shipping provider records and allows
for searching and filtering to locate specific shipping providers. You can view the
basic details of each record within the field columns of the list view or click the
shipping provider's name to open the record view. To access the module's list view,
simply navigate to the Admin page and select "Shipping Providers" under the
Product and Quotes panel. You can also click the module's tab in the navigation
bar once the Shipping Providers module opens.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual shipping provider records
or click the checkbox in the list header to select all records displayed on the
current set of list view results. 
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more shipping

provider records at a time.
Merge Merge two or more duplicate shipping

providers.
Delete Delete one or more shipping provider

records at a time.
Export Export one or more shipping provider

records to a CSV file.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on individual shipping provider records directly from the list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this shipping provider in the

intelligence pane.
Edit Edit this shipping provider.
Delete Delete this shipping provider.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Record View Actions Menu

The Shipping Providers record view displays a single shipping provider in full
detail including its fields. To access a shipping provider's record view, simply click
the hyperlinked shipping provider name in the Shipping Providers list view. The
record view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record. 
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this shipping provider.
Share Share a link to this shipping provider via

email.
Find Duplicates Locate potential duplicates of

this shipping provider.
Copy Duplicate this shipping provider.
Delete Delete this shipping provider.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this table describe behaviors and functionality
specific to the Products- and Quotes-related modules. 

Content Link Description
Creating Records
  Basic Record Creation

The Creating Records section covers the
various methods of creating new
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  Creating Via Subpanels
  Creating Via Duplication
  Importing Records

records, including via the Create button
in the module, via the subpanel on
related module records, duplication of
an existing record, and importing a list
of records into Sugar using a .csv
spreadsheet.

Viewing Records
  Viewing Via List View
  Viewing Via Record View
  Viewing Via Recently Viewed
  Viewing Via Preview
  Viewing Via Reports

The Viewing Records section describes
the various methods of viewing records,
including via the list view and record
view, the Recently Viewed menu in the
module tab, previewing records in the
right-hand side panel, and reports
displaying the record's data.

Searching for Records
  Global Search
  List View Search
  Creating a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating Sugar
records: global search, which searches
across all Sugar modules, and list view
search, which searches and filters
within the module.

List View
   Total Record Count
   Create Button
  List View Search
  Checkbox Selection
  Mass Actions Menu
  Favorite Designation
  Column Reordering
  Column Resizing
  Column Sorting
  Column Selection
  Preview
  Record Actions Menu
  Pagination
  Dashboards

The List View section walks through the
many elements of the List View layout,
which contains a filterable list of all
records in the current module. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the list view are described in the List
View Mass Actions Menu and List View
Record Actions Menu sections of the
module overviews below.

Note: You can only mark records as
favorites via the Product Catalog list
view. 

Record View
  Favorite Designation
  Next or Previous Record
   Actions Menu
  Show More
  Dashboards

The Record View section walks through
the many elements of the Record View
layout, which contains detailed
information about a single record. While
the generic menu options are described
in the User Interface sections linked to
the left, the options specifically
available in the record view are
described in the Record View Actions
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Menu sections of the module overview
sections below.

Note: You can only mark records as
favorites via the Product Catalog record
view.

Editing Records
  Editing Inline Via Record View
  Editing Via Record View
  Editing Inline Via Subpanels
  Editing Inline Via List View
  Mass Editing Via List View

The Editing Records section describes
the various methods of editing existing
records, including inline via the record
view, in full edit mode on the record
view, inline via the subpanel on related
module records, inline via the list view,
and via the Mass Update option on the
list view. 

Deleting Records
  Deleting Via Record View
  Deleting Via List View
  Mass Deleting Via List View

The Deleting Records section describes
the various methods of deleting
unwanted records, including via the
record view, an individual record's
Actions menu on the list view, and the
Mass Actions menu on the list view.

Exporting Records The Exporting Records section provides
an introduction to the export
functionality, which allows you to
download a list of records and all their
data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Records The Finding Duplicate Records section
provides instructions for locating
duplicate records. If searching on
matching fields (e.g. Name) identifies
one or more duplicates, they can be
merged into a single record.

Merging Records
  Merging Via List View

The Merging Records section provides
instructions for merging duplicates,
which combines field values and related
records into a single record.

Favoriting Records The Favoriting Records section
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  Favoriting via List View
  Favoriting via Record View

describes the various methods of
marking records as favorites, including
via the list view and record view.

Note: You can only mark records as
favorites via the Product Catalog
module. Favoriting a product catalog
record allows you to easily access the
product from the list view, Product
Catalog Quick Picks dashlet, or the
Product Catalog module tab. For more
information on the Product Catalog
Quick Picks dashlet, please refer to the
Opportunities or Quotes
documentation. 

Sharing Records The Sharing Records section provides
instructions for the Share record view
option, which composes an email with a
link to the record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the record view.

Amazon Web Services

Overview

Amazon Web Services (AWS) allows you to configure Amazon Connect, which
Sugar requires to power SugarLive and Sugar Portal Chat. Specifically, Amazon
Connect receives data and routes calls to agents and facilitates customer chat
sessions initiated in Sugar Portal. From there, the agent and the customer
communicate using Amazon's Contact Control Panel (CCP) embedded in
Sugar. SugarLive and Sugar Portal Chat are available using the Sugar Serve 11.0
and higher or Sugar Sell 11.1 and higher license types.

To start using SugarLive and Sugar Portal Chat, you must complete some or all of
the following steps, depending on which features you wish to use:

1. Set up Single Sign-On (optional)
2. Set up SugarLive and optional additional features
3. Set up Sugar Portal Chat and optional chatbot 
4. Configure Amazon Connect in Sugar to enable the above features in Sugar

Prerequisites
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SugarLive and Sugar Portal Chat are available in Sugar Serve or Sugar Sell once
you have connected your Sugar instance to an Amazon Connect instance that may
also rely on other Amazon services. Therefore, these features can only be used
after an admin has completed certain configuration steps in the Deployment Guide
. In addition, SugarLive and Sugar Portal Chat can only be used with certain web
browsers. For more information, refer to the Supported Platforms page.

The following table shows the Amazon services, most of which require payment to
Amazon on a per-use basis, used by various Sugar Serve or Sugar Sell features.
Each link opens the relevant product page on Amazon's website for that particular
service:

Amazon Service Description Sugar Serve or Sugar
Sell Features that use it

Amazon Connect Amazon Connect is used
to provide SugarLive's
omnichannel capabilities.

SugarLive
Sugar Portal Chat

AWS CloudFormation AWS CloudFormation is
used to create a stack to
manage all the resources
needed by the Amazon
services that SugarLive
depends on.

Call recordings in
SugarLive
Call transcripts
and sentiment
analysis in
SugarLive
Sugar Portal Chat
Chatbot in Sugar
Portal Chat

Amazon S3 Amazon S3 is used for the
storage of Amazon
Connect files, including
call recordings, call
transcripts with sentiment
analysis, and chat
transcripts.

SugarLive
Call recordings in
SugarLive
Call transcripts
and sentiment
analysis in
SugarLive

AWS Lambda AWS Lambda is used to
run code that passes
information between
Amazon Connect and
Sugar.

Call recordings in
SugarLive
Call transcripts
and sentiment
analysis in
SugarLive
Sugar Portal Chat
Chatbot in Sugar
Portal Chat

Contact Lens for Amazon
Connect

Contact Lens, a feature of
Amazon Connect available

Call transcripts
and sentiment
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at additional cost, is used
to generate call
transcripts and sentiment
analysis for SugarLive
calls.

analysis in
SugarLive

Amazon Lex Amazon Lex is used to
build a conversational
chatbot that customers
can speak to in Sugar
Portal Chat.

Chatbot in Sugar
Portal Chat

Amazon API Gateway Amazon API Gateway is
used to establish the
communication via API
between Sugar and
Amazon Connect.

 Sugar Portal Chat

Setting up Single Sign-On

Before setting up SugarLive, you may want to consider setting up single sign-on
(SSO). This will allow your agents to log in to SugarLive with the same credentials
they use to sign in to Sugar. First, you would set up an identity provider (e.g.,
OneLogin) for Sugar and Amazon Connect. See the following articles for steps to
set up some common identity providers for Sugar and AWS:

Configuring SSO With OneLogin Using SAML
Configuring SSO With Okta Using SAML
Configuring SSO With Google Using SAML
Configuring SSO With Active Directory's ADFS

Next, Configure SAML in your Sugar instance. You must ensure you have an
Amazon Connect instance that uses SAML 2.0-based authentication.

Note: An existing Amazon Connect instance that does not use SAML cannot be
updated to start using it. You must create a new instance that uses SAML
2.0-based authentication. See the Plan your identity management in Amazon
Connect article on Amazon's website for more details on identity management
options in Amazon Connect.

Setting up SugarLive

To use SugarLive, an admin must do the following:

Set up your organization's Amazon Connect instance, including phone
numbers, external chat apps, routing, contact flows, and users. Refer to the
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Get Started page of the Amazon Connect Administration Guide on
Amazon's website for details on these steps, or see their Amazon Connect
documentation for a full set of resources.
Add your Sugar instance URL to your Amazon Connect's approved origins
list so that the two systems can communicate. See the Use an allow list for
integrated applications article on Amazon's website for the steps to do this.
Refer to the Amazon Connect Settings page to complete the configuration
within Sugar.

Also, there are optional SugarLive features that require external services and
admin configuration:

Single sign-on: Before setting up SugarLive, you may want to consider
setting up single sign-on (SSO). This will allow your agents to log in
to SugarLive with the same credentials they use to sign in to Sugar. 
Call recordings: Download and configure the files necessary for call
recording, including creating an AWS CloudFormation stack, configuring a
Lambda function, and enabling call recording in your Amazon Connect
contact flows. 
Call transcripts and sentiment analysis: Download and configure the
files necessary for call transcripts and sentiment analysis, including
creating an AWS CloudFormation stack, configuring a Lambda function,
and enabling call recording and Contact Lens speech analytics in your
Amazon Connect contact flows.

Note: SugarLive can only be used with certain web browsers. For more
information, refer to the Supported Platforms page. 

Setting up Sugar Portal Chat

To use Sugar Portal Chat, an admin must do the following:

Set up a contact flow in your organization's Amazon Connect instance for
use in the portal chat or use the sample contact flow included with your
SugarLive assets, which uses a sample chatbot and requires additional
configuration. Please note, the sample chatbot is an example of how
customer service organizations may choose to leverage a contact flow.
Download and configure the files necessary for Sugar Portal Chat,
including creating an AWS CloudFormation stack.
Refer to the Amazon Connect Settings page to complete the configuration
within Sugar. The style settings for the portal chat window can be left as
their default values or optionally configured to match your organization's
desired theme.

Also, to use a chatbot in Sugar Portal Chat using Amazon services, an admin must
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do the following:

Download and configure the files necessary for a chatbot in Sugar Portal
Chat, including creating an AWS CloudFormation stack, importing and
configuring a Lex bot, configuring your Amazon Connect instance, and
importing and configuring a contact flow.
Update the Sugar Portal Chat tab in Admin > Amazon Connect Settings in
Sugar to use the contact flow configured above. 

Note: SugarLive can only be used with certain web browsers. For more
information, refer to the Supported Platforms page.

Configuring Amazon Services for use in Sugar Serve or
Sell

To use certain SugarLive and Sugar Portal Chat features that rely on Amazon Web
Services (AWS), you must download and set up a collection of assets. These files
are available as a zip file on your account's Downloads page. On the Downloads
page, select "Serve" or "Sell" in the dropdown menu and then open your Sugar
version to find the zip file. Once you have the files, follow the steps in the Amazon
Connect Deployment Guide for SugarLive to set up various Amazon services for
these features.

The following four Sugar Serve or Sell features require this AWS configuration:

Sugar Portal Chat basic functionality
Sugar Portal Chat chatbot
SugarLive call recordings
SugarLive call transcripts and sentiment analysis

You can choose to set up any or all of the above features. Following the Amazon
Connect Deployment Guide for SugarLive, you will need to first set up a
CloudFormation stack. From there, you can choose which of the four features to
set up and then follow the relevant steps. In the case of the chatbot, you are also
able to use your own Amazon Lex chatbot and Amazon Connect contact flow, if you
prefer, but Sugar Serve and Sell come with a sample of each and the necessary
Lambda functions to get you started.

If you need assistance with any of the Amazon services, you will need to contact
Amazon's Customer Support department. See the Contact Us page on Amazon's
website for details on their support offerings.

Amazon Connect Deployment Guide for SugarLive
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Overview

To use some of the features in Sugar Serve and Sell, you must perform specific
steps in Amazon Web Services (AWS) using the files provided in the zip file
available for download from your account's Downloads page. However, please note
that SugarLive is a robust product and the external configuration that it requires
in AWS is outside of Sugar's typical scope of support. 

This guide covers the setup on the Amazon side for SugarLive and Sugar Portal
Chat features. To use each of these five features, you must first complete the steps
in the Creating the AWS CloudFormation Stack section and then the appropriate
section for the feature after that:

Call recording in SugarLive calls
Call transcripts and sentiment analysis in SugarLive calls
Sugar Portal Chat
Chatbot in Sugar Portal Chat
Chat window on your own website (optional)

See the Amazon Connect Settings page for details on setting up these features in
Sugar. 

Prerequisites

To walk through this guide, you must already have an Amazon Connect instance
and a Sugar instance. To successfully create an Amazon Connect instance and the
S3 bucket required by many of the SugarLive features, your AWS account must
have the "AmazonConnect_FullAccess" policy attached in the IAM console on
Amazon's website. To attach the "AmazonConnect_FullAccess" policy, see this
article on Amazon's website: Adding and removing IAM identity permissions.

Note: SugarLive and Sugar Portal Chat can only be used with certain web
browsers. For more information, refer to the Supported Platforms page.

Upgrading the SugarLive Package

v1.4 of the package updates the following files:

Lambda-v1.3.zip
README.pdf

If you are using the files in v1.3 of the zip file, follow these steps to start using
v1.4:

1. Upload the new Lambda-v1.3.zip file to your S3 bucket.
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2. Update your CloudFormation stack parameters by clicking Update > Use
current template > Next.

3. Update the InstallationFile parameter to be the Lambda zip file you just
uploaded, including the path within the bucket.

4. All other settings can be left as is. Click "Next" on this page and the
following page and then enable the checkbox at the bottom before clicking
"Update stack".

Creating the AWS CloudFormation Stack

1. Open Amazon S3 and either create a new S3 bucket or use an existing
bucket.

2. Upload Lambda-v1.3.zip to a location within the S3 bucket.
3. Open AWS CloudFormation > Create Stack > With new resources.

4. Select "Upload a template file" and upload CloudFormation_Template-
v1.3.yml. Click "Next".

5. Enter a stack name.
6. Populate the following parameters:

1. InstallationS3BucketName: The bucket name created or selected
in step 1

2. InstallationFile: The file, including the path within the bucket,
uploaded in step 2

1. An easy way to find this value is to open the created object
in step 2 and find the key
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Note: The remaining parameters can be skipped at this
time. You will insert values for them as needed when setting
up specific features in the below sections. If you want to set
them now for the features you plan to use, see the following
sections for the required parameters:

Setting up Call Recording 

Setting up Call Transcripts and Sentiment Analysis

Setting up Sugar Portal Chat

Setting up the Chatbot in Sugar Portal Chat

7. Click "Next" and leave the Configure Stack Options and Advanced Options
sections as is.

8. Click "Next" and enable the checkbox under the Capabilities section at the
bottom.

                         484 / 829



 

9. Click "Create stack". This may take a few minutes and you can refresh the
Events tab of the stack to monitor the progress

Once the stack is ready, you can proceed to one of the below sections in this guide
to set up certain SugarLive features.

Creating the AWS Secret

An AWS secret holding the credentials for your Sugar instance is required when
setting up all of the SugarLive features. Use the following steps to create a secret
that can be used in your CloudFormation stack:

1. Open AWS Secrets Manager, click "Store a new secret", then select "Other
type of secrets" as the secret type.

2. Add two rows in the Secret Key/Value tab and populate them with the
sugarUsername and sugarPass keys listed below with their values. 

1. sugarUsername: The username of a Sugar user that AWS Lambda
will use to access Sugar. This user should have the privileges
required to perform the necessary actions in Sugar (e.g., update
call records to save the call recording URL).

2. sugarPass: The password of the provided Sugar user
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3. Click "Next" and provide a name for the secret. Click "Next" again
and then "Store".

Setting up Call Recording

1. Follow the instructions in the Creating the AWS CloudFormation Stack
section.

2. Follow the instructions in the Creating the AWS Secret section to create a
secret. Note its ARN, which you will copy and paste into the
CloudFormation stack in a later step.

3. Once the stack has been created, update the stack parameters with more
values by clicking Update > Use current template > Next.

4. Enter values for the following parameters that are required for call
recording:

1. EnableCallRecordingLink: "true"

2. AWSConnectInstanceName: The instance name of your Amazon
Connect instance (i.e. the first part of your instance's URL)

3. AWSConnectDomain: The domain of your Amazon Connect
instance (e.g. "awsapps.com")
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4. CallRecordingPartialURL: The partial URL used to construct call
recording links. This value should not be changed from the default
value unless AWS updates how call recording links are generated.

5. SugarURL: The URL of your Sugar instance

6. SugarSecretARN: The ARN of the secret you created

5. All other settings can be left as is. Click "Next" on this page and the
following page and then enable the checkbox at the bottom before clicking
"Update stack".

6. Next, add an S3 trigger to the Call Recording Lambda function by opening
the Resources tab of the stack and searching for "callrecording".

7. Click on the link in the Physical ID column for the function that is returned.
It will open the Lambda function in a new tab.

8. In the Lambda function, click "Add trigger".

9. Search for S3 and select it.
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10. Fill out the fields that appear with the following values:

1. Bucket: The name of the bucket used by your Amazon Connect
instance. To find it, open Amazon Connect > your instance > Data
storage and copy the bucket name from the path where call
recordings will be stored.

2. Event type: "All object create events"

3. Prefix:
"connect/<your-connect-instance-name>/CallRecordings/"

4. Suffix: Leave this field blank.

11. Enable the checkbox at the bottom and click "Add". If you see the following
error, an S3 trigger with the same prefix or suffix has already been added
to the bucket:

12. Then, in your Amazon Connect instance, ensure that your contact flows
have call recording enabled by adding a "Set recording and analytics
behavior" block and turning on call recording within it.

Note: Be sure to do this for every contact flow that you want to enable call
recordings for (e.g. the inbound and outbound flows).

13. Save and publish the contact flows.
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After completing these steps, the link to the call recording will be stored in the
Recording field on the call record for calls completed in SugarLive that use one of
the contact flows you configured. Note that the link will be immediately saved but
the audio file may take a few minutes to become available at that link after you
have cleared the contact in SugarLive.

Setting up Call Transcripts and Sentiment Analysis

1. Follow the instructions in the Creating the AWS CloudFormation Stack
section.

2. Follow the instructions in the Creating the AWS Secret section to create a
secret. Note its ARN, which you will copy and paste into the
CloudFormation stack in a later step.

3. Once the stack has been created, update the stack parameters with more
values by clicking Update > Use current template > Next.

4. Enter values for the following parameters that are required for call
transcripts:

1. EnableCallTranscriptUpload: "true"

2. SugarURL: The URL of your Sugar instance

3. SugarSecretARN: The ARN of the secret you created

5. All other settings can be left as is. Click "Next" on this page and the
following page and then enable the checkbox at the bottom before clicking
"Update stack".

6. Next, add an S3 trigger to the Contact Lens Lambda function by opening
the Resources tab of the stack and searching for "savecalltranscript".
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7. Click on the link in the Physical ID column for the function that is returned.
It will open the Lambda function in a new tab.

8. In the Lambda function, click "Add trigger".

9. Search for S3 and select it.

10. Fill out the fields that appear with the following values:

1. Bucket: The name of the bucket used by your Amazon Connect
instance. To find it, open Amazon Connect > your instance > Data
storage and copy the bucket name from the path where call
recordings are stored.

2. Event type: "All object create events"
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3. Prefix: "Analysis/"

4. Suffix: Leave this field blank.

11. Enable the checkbox at the bottom and click "Add". If you see the following
error, an S3 trigger with the same prefix or suffix has already been added
to the bucket:

12. Then, in your Amazon Connect instance, ensure that your contact flows
have Contact Lens enabled by adding a "Set recording and analytics
behavior" block if one has not already been added. Turn on call recording
and Contact Lens speech analytics within it. Contact Lens call transcripts
cannot be enabled unless call recordings are enabled in the contact flow
first.

 

Note: Be sure to do this for every contact flow that you want to enable call
transcripts and sentiment analysis for (e.g. the inbound and outbound flows).

After completing these steps, the transcript will be stored in the Transcript field on
the call record for calls completed in SugarLive that use one of the contact flows
you configured. The customer and agent sentiment will also be stored in the
Customer Sentiment and Agent Sentiment fields on the call. These fields are not
displayed by default but can be added to your record and list view layouts using
Studio. Note that it may take a while for Contact Lens to process the transcript
and sentiment analysis and it will take more time for longer calls.

Setting up Sugar Portal Chat

1. Follow the instructions in the Creating the AWS CloudFormation Stack
section.
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2. Follow the instructions in the Creating the AWS Secret section to create a
secret. Note its ARN, which you will copy and paste into the
CloudFormation stack in a later step.

3. In your CloudFormation stack, update the stack parameters with more
values by clicking Update > Use current template > Next.

4. Enter values for the following parameters that are required for Sugar
Portal Chat:

1. EnableSugarPortalChat: "true"

2. AmazonConnectInstanceID: The ID of your Amazon Connect
instance. To find it, open Amazon Connect > your instance >
Overview and copy the last part of the instance ARN (i.e. everything
after "instance/").

3. ContactFlowID: The ID of the contact flow you wish to use in
Sugar Portal Chat. If you plan to use the sample contact flow and
chatbot included with Sugar Serve, you can enter a dummy value
for now. You will update this when completing the steps to set up
the chatbot later. To find the ID of a contact flow, click "Show
additional flow information" on the left of your contact flow and
copy the last part of the ARN (i.e. everything after "contact-flow/").

4. SugarURL: The URL of your Sugar instance

5. SugarSecretARN: The ARN of the secret you created
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5. All other settings can be left as is. Click "Next" on this page and the
following page and then enable the checkbox at the bottom before clicking
"Update stack".

6. In your Sugar instance, open Admin > Amazon Connect Settings > Sugar
Portal Chat tab to configure the following portal chat settings:

1. Enable Amazon Connect Chat: "true"

2. API Gateway: The Invoke URL for the API gateway you are using.

1. To find it, search for "api" in the Resources tab of your stack
and click the link in the Physical ID column of the
StartChatAPIGateway value. This will open the API gateway
in a new tab.

2. From there, open Stages > Prod and copy the Invoke URL to
paste in Sugar.

3. Contact Flow ID: The ID of the contact flow you wish to use in
Sugar Portal Chat. This is the same value you entered in the
ContactFlowID parameter in your stack.
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4. Amazon Connect Instance ID: The ID of your Amazon Connect
instance. To find it, open Amazon Connect > your instance >
Overview and copy the last part of the instance ARN (i.e. everything
after "instance/"). This is the same value you entered in the
AmazonConnectInstanceID parameter in your stack.

7. Save your changes to the Amazon Connect Settings page.

8. If you have not already, enable the portal under Admin > Sugar Portal >
Configure Portal.

After completing these steps, Sugar Portal Chat will be enabled for your Sugar
instance and the chat window will appear for customers using the portal to
connect to an agent. If you wish to also set up the chatbot, continue to the Setting
Up the Chatbot in Sugar Portal Chat section.

Setting up the Chatbot in Sugar Portal Chat

1. Follow the instructions in the Creating the AWS CloudFormation Stack
section.

2. Follow the instructions in the Setting up Sugar Portal Chat section.

3. Unzip the Portal_Chat.zip file. In your Amazon Connect instance, open
Routing > Contact flows > Create contact flow > Import flow and select
the portal chat contact flow

in the unzipped Portal_Chat directory (e.g.
SugarCRM_Portal_Chat_Contact_Flow-v1.0).

4. Save the contact flow. There is no need to publish it yet because we will
publish it after making further changes later.

5. In your CloudFormation stack, update the stack parameters with more
values by clicking Update > Use current template > Next.

6. Enter values for the following parameters that are required for the Sugar
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Portal Chat chatbot. Most values will already be accurate, but at a
minimum, you will need to update the ContactFlowID parameter to use the
sample contact flow included with Sugar Serve:

1. EnableSugarPortalChat: "true"

2. AmazonConnectInstanceID: The ID of your Amazon Connect
instance. To find it, open Amazon Connect > your instance >
Overview and copy the last part of the instance ARN (i.e. everything
after "instance/").

3. ContactFlowID: The ID of the contact flow you imported in step 3.
To find the ID, click "Show additional flow information" on the left
of your contact flow and copy the last part of the ARN (i.e.
everything after "contact-flow/").

4. SugarURL: The URL of your Sugar instance

5. SugarUsername: The username of a Sugar user that AWS Lambda
will use to access Sugar

6. SugarPassword: The password of the provided Sugar user

7. All other settings can be left as is. Click "Next" on this page and the
following page and then enable the checkbox at the bottom before clicking
"Update stack".

8. Next, in Amazon Lex, open Actions > Import and import
SugarServeSampleBot.zip, which can be found in the unzipped Portal_Chat
directory. Note that if you have not created a Lex bot before, you may be
directed to the Get Started page at first. If so, you will need to click "Get
Started" and then "Cancel" to get to the main console. In addition, there
are two different versions of the Lex console. The Lex bot provided by
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Sugar is only compatible with the V1 console, so be sure to switch to the V1
console before importing:

Note: If you have imported the sample bot before, uploading it again will
overwrite the previous one. To avoid this, rename the sample bot before
importing it by unzipping the bot, opening the JSON file, and changing the
"name" value of the "resource" entry to something unique. Then, zip the
updated JSON file and import that zip file instead.

9. Open the imported Lex bot > Editor tab > the "sugarFallback" intent >
Fulfillment and select "AWS Lambda function". In the Lambda Function
field that appears, select the "<your-stack-name>-LexGetStringFunction"
function. Once done, click "Save Intent".

10. Click "Build" to build the Lex bot. When that is complete, click "Publish"
and enter the bot name as the alias (e.g. "SugarServeSampleBot").

11. Then, open Amazon Connect > your instance > Contact flows and select
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the newly-created Lex bot under the Amazon Lex section.

12. Click "Add Lex Bot" to add it.

13. Under the AWS Lambda section, add the following Lambda functions:

1. <your-stack-name>-CaseStatusFunction

2. <your-stack-name>-CreateCaseFunction

14. Next, open your Amazon Connect instance and open the contact flow you
imported in step 3. There should be three "Get customer input" blocks. 

In each of these three blocks, select the newly-created Lex bot under the
Amazon Lex section and save.
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15. Find the "Invoke AWS Lambda function" block of the getCase flow by
following the arrow from the "getCase" option in the first "Get customer
input" block through to the first "Invoke AWS Lambda function" block. It
should be at the top of the contact flow. Open it and select
the <your-stack-name>-CaseStatusFunction Lambda function in the
Select a Function field. Save the block.

16. Find the other "Invoke AWS Lambda function" block, which is the one that
comes after the "Transfer to flow" block. Open it and select the

<your-stack-name>-CreateCaseFunction Lambda function in the Select a
Function field. Save the block.

17. Find the "Transfer to flow" block and open it. Select "Sample queue
configurations flow" in the Select a Flow field and save.

18. Save the contact flow and then publish it.

19. In your Sugar instance, open Admin > Amazon Connect Settings > Sugar
Portal Chat tab to configure the following portal chat settings. Most values
will already be accurate, but at a minimum, you will need to update the
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Contact Flow ID field to use the sample contact flow included with Sugar
Serve:

1. Enable Amazon Connect Chat: "true"

2. API Gateway: The Invoke URL for the API gateway you are using.

1. To find it, search for "api" in the Resources tab of your stack
and click the link in the Physical ID column of the
StartChatAPIGateway value. This will open the API gateway
in a new tab.

2. From there, open Stages > Prod and copy the Invoke URL to
paste in Sugar.

3. Contact Flow ID: The ID of the contact flow you imported in step
3. This is the same value you entered in the ContactFlowID
parameter in your stack.

4. Amazon Connect Instance ID: The ID of your Amazon Connect
instance. To find it, open Amazon Connect > your instance >
Overview and copy the last part of the instance ARN (i.e. everything
after "instance/"). This is the same value you entered in the
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AmazonConnectInstanceID parameter in your stack.

20. Save your changes to the Amazon Connect Settings page.

21. If you have not already, enable the portal under Admin > Sugar Portal >
Configure Portal.

After completing these steps, the chatbot will be enabled in Sugar Portal Chat for
your Sugar instance. Customers using the portal can work with the chatbot or
connect to an agent in the portal chat window.

Setting up an External Chat Window

If you prefer, you can set up an external chat window on your own hosted website,
as opposed to using the Sugar Portal. From there, you can configure the contact
flow in your Amazon Connect instance to set several attributes. These attributes
are read by SugarLive and can be used to open relevant customer data in the
Detail panel when the chat session starts. The following attributes are available to
be set: 

sugarCaseNumber: The unique number assigned to the case 
sugarContactId: The record ID of the contact
sugarContactEmail: The primary email address of the contact
sugarContactName: The first and last name of the contact

They are read in the above order, which means that SugarLive opens the record(s)
that match the first provided attribute.

If SugarLive receives a chat with any of these attributes, it opens the matching
case and contact records in the Detail panel. If more than one contact matches
(e.g., via name or email), they are opened in the Search tab instead so the agent
can select the correct one to open. See the contact attributes documentation on
Amazon's website for more details on how to use attributes in your contact flows.

Amazon Connect Settings

Overview

Amazon Connect is an Amazon Web Services (AWS) tool that receives incoming
calls and chats and routes them to your own customer service or sales automation
system (e.g., SugarLive). It also facilitates the customer side of chat sessions (e.g.,
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chat sessions initiated in Sugar Portal). Both the agent and the customer
communicate using Amazon's Contact Control Panel (CCP) embedded in Sugar.

Once you have set up your Amazon services so that you can use them
with SugarLive and Sugar Portal Chat, there are a few settings within Sugar to
complete before you can start using these features. These settings are found under
the Amazon Web Services section of the Admin page from within Sugar, split
between two tabs on the Amazon Connect Settings page.

The General tab includes basic settings to connect Sugar to your Amazon Connect
instance and set your identity management system. The Sugar Portal Chat tab
 includes additional settings to enable a chat window in the portal so your
customers can chat with a chatbot or your customer service representatives. In
this tab, there are also settings to customize the chat window to match your
organization's branding. See the below sections for details on the settings found in
each tab.

General Tab

In order for SugarLive and Sugar Portal Chat to communicate with your Amazon
Connect instance, you must complete the following configuration fields:

Contact Control Panel URL: Enter the complete URL used to access your
Contact Control Panel (CCP), for example
"https://example.my.connect.aws/ccp-v2". See the Launch the CCP article
on Amazon's website to determine what the URL to your CCP is.
Instance Name: Enter the name of your Amazon Connect instance. The
instance name is the first portion of your Amazon Connect URL. For
example, in the URL "https://example.awsapps.com/connect/ccp-v2", the
instance name is "example".
Instance Region: Enter the region code of your Amazon Connect instance
(e.g., "us-west-2"), which can be found in the top right corner of the
Amazon Connect console. Click on the name of the region to open the
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Region menu, where you can see the code that corresponds to that region.
Identity Management System: Enter the identity management system
you wish to use. Options include Amazon Connect and SAML 2.0. If you
choose Amazon Connect, users will log in to SugarLive using their Amazon
Connect credentials. If you choose SAML 2.0, you must set up an identity
provider (e.g., OneLogin), configure SAML in your Sugar instance, and use
an Amazon Connect instance that uses SAML 2.0-based authentication.
Note that an existing Amazon Connect instance that does not use SAML
cannot be updated to start using SAML. You must create a new instance
that uses SAML 2.0-based authentication. See the Plan your identity
management in Amazon Connect article on Amazon's website for more
details on identity management options in Amazon Connect.

Note: SAML 2.0 in SugarLive can only automatically log users in if
SAML is configured in Sugar and users log in to Sugar using single
sign-on (SSO). If SAML is not configured in the instance or users
choose not to use it, they will have to manually log in to SugarLive
using their SSO credentials.

Endpoint URL: Enter the SAML endpoint to which users must connect to
authenticate with your single sign-on identity provider using SAML. This
field is only displayed if "SAML 2.0" is selected as the identity management
system.

To disable Amazon Connect in your Sugar instance, simply set the Contact Control
Panel URL, Instance Name, and Instance Region fields to blank and save the page.
This removes the SugarLive button from Sugar's navigation bar when you save the
Amazon Connect Settings page. It also prevents the portal chat from working but
does not remove the chat window from the portal; to remove it from the view, you
must disable the Enable Amazon Connect Chat checkbox in the Sugar Portal Chat
tab as well.

When you enable SugarLive by saving a value in the Contact Control Panel URL,
Sugar automatically updates the Content Security Policy (CSP) Settings so that the
domains required by SugarLive are included in the database. These values are not
shown in the user interface and no extra action is required by an admin. If you
disable SugarLive by removing the value in the Contact Control Panel field, the
domains are automatically removed from the CSP settings. See the System page
for more details on the CSP.

If you are configuring Amazon Connect for use with SugarLive, refer to the 
SugarLive page in the Application Guide for details on how your customer service
or sales representatives can start using it. If you are also configuring Amazon
Connect to use Sugar Portal Chat, refer to the Sugar Portal Chat documentation in
the Portal User Guide for details on how your customers can start using it.

Sugar Portal Chat Tab
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To allow your customers to chat with your agents or a chatbot from the portal, you
must complete the fields in the Settings section of the Sugar Portal Chat tab in
addition to the fields in the General tab described above. To customize the
appearance of the chat window to match your organization's branding, update the
remaining settings on this tab; these settings have minimal default values that can
be used if you wish to leave them as is.

Settings

The following fields are required for Sugar Portal Chat to work:

Enable Amazon Connect Chat: Turn this setting on to enable chat in the
portal. Once enabled, the below three fields appear and are required to
finish configuring Sugar Portal Chat.
API Gateway: Enter the API Gateway endpoint URL used to start a chat
session; in Amazon API Gateway, this is the Invoke URL. This field is only
displayed if Enable Amazon Connect Chat is enabled.
Contact Flow ID: Enter the ID of the contact flow you wish to use in the
portal chat. If a contact flow's ARN is "arn:aws:connect:us-
west-2:123456789012:instance/1111/contact-flow/2222", the contact flow
ID is "2222". This field is only displayed if Enable Amazon Connect Chat is
enabled.
Amazon Connect Instance ID: Enter the ID of your Amazon Connect
instance for use in the portal chat. If your instance ARN is
"arn:aws:connect:us-west-2:123456789012:instance/1111", the instance ID
is "1111". This field is only displayed if Enable Amazon Connect Chat is
enabled.

Header

Use the following fields to customize the appearance of the header in the portal
chat window:

Image URL: Enter the URL of the image you wish to display at the top of
the chat window.
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For reference, the SugarCRM logo that is displayed by default has
dimensions of 790 x 147 px, but the image you provide will be
scaled down if necessary to fit in the chat window.
When you enter a URL, a preview of the image is displayed directly
below the field; if you do not see a preview, the image cannot be
found using the URL and will not appear in the portal.
It is recommended to log in to the portal to verify that the image is
displayed as you would like and to resize the image if it is not.
If you do not enter a URL, the SugarCRM logo is displayed by
default.

Title: Enter the title text you want to be displayed at the top of the chat
window. The default title, as shown in the example image, is "Hi there! I am
your Service Assistant".
Title Color: Choose the color of the header's title text by entering the hex
color code or clicking in the text field to open the color picker.
Subtitle: Enter the text you want to be displayed below the title at the top
of the chat window. Its font is slightly smaller than that of the title.
Subtitle Color: Choose the color of the subtitle text by entering the hex
color code or clicking in the text field to open the color picker.
Background Color: Choose a background color for the header at the top
of the chat window by entering the hex color code or clicking in the text
field to open the color picker.

Footer

Use the following fields to customize the appearance of the footer in the portal
chat window:

Title: Enter the text you want to be displayed at the bottom of the chat
window.
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Title Color: Choose the color of the footer's title text by entering the hex
color code or clicking in the text field to open the color picker.

End Chat Button

Use the following fields to customize the appearance of the End Chat button in the
portal chat window:

Text Color: Choose the color of the text in the End Chat button by entering
the hex color code or clicking in the text field to open the color picker.
Size: Specify the height and width of the End Chat button in pixels.
Button Fill: Choose the color of the background in the End Chat button by
entering the hex color code or clicking in the text field to open the color
picker.

Messages

Use the following fields to customize the appearance of the chat messages in the
portal chat window:

Text Color: Choose the color of the text in all messages sent and received
in the chat window by entering the hex color code or clicking in the text
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field to open the color picker.
Customer Chat Bubble Color: Choose the color of the background in the
customer's chat bubbles by entering the hex color code or clicking in the
text field to open the color picker.
Agent Chat Bubble Color: Choose the color of the background in the
agent's chat bubbles by entering the hex color code or clicking in the text
field to open the color picker.

Sugar Maps Administration

Overview

With Sugar Maps, our integration with Microsoft Bing Maps, users can quickly see
which records are in close proximity to each other, plot records on a content-rich
map, and generate driving directions between records. This guide walks through
the steps to configure Sugar Maps. For information on using Sugar Maps once it
has been installed, please refer to the Sugar Maps User Guide.

Note: If you have Sugar Sell Premier, Sugar Maps powers the geo-mapping
capability. Sugar Maps is automatically enabled and you do not need a separate
license key for Sugar Maps.

Prerequisites

The following prerequisites must be met before Sugar Maps can be used:

Sugar Maps is included with Sugar Sell Premier and powers the geo-
mapping capability. Sugar Maps can also be purchased as an add-on for
Sugar Sell Advanced, Enterprise, and Serve. Sugar Maps can be purchased
by contacting your Sugar partner or representative. 
If you purchased Sugar Maps as an add-on, an administrator must enable
the Sugar Maps license for users who should have access.
You must be a System Administrator to complete the configuration on this
page.

Configuring Sugar Maps

Once Sugar Maps is enabled in your instance a System Administrator will need to
perform a series of configuration steps to control the behavior and visibility of
Sugar Maps. These steps can include creating schedulers, enabling and
configuring modules, configuring the subpanel, setting measurement units, and
disabling Sugar Maps.  
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Sugar Maps Schedulers

The Records Geocoder and Geocoder Resolver schedulers trigger the Sugar Maps
geocoding process. Geocoding generates the latitude and longitude of a record's
address, which then allows Sugar Maps to map a record. The Records Geocoder
sends the records to the geocoding server in batches of 1000, and the Geocode
Resolver polls the server for the geocoded results and imports the information into
Sugar. Sugar Maps schedulers are created and enabled automatically in Sugar Sell
Premier instances that did not have Sugar Maps enabled prior to upgrading. If you
have purchased Sugar Maps as an add-on you will need to create the schedulers
manually.

Note: The Records Geocoder scheduler's "Job Name" may vary based on how and
when the scheduler was created. Please refer to the Understanding Sugar Maps
Scheduler's Job Names help article for more information.

Creating Sugar Maps Schedulers

If you have purchased Sugar Maps as an add-on you will need to create the needed
schedulers manually.
Note: The Sugar Maps schedulers must be created by a System Administrator that
is assigned a Sugar Maps license. 

Use the following steps to create the Records Geocoder and Geocoder Resolver
schedulers:

1. Navigate to Admin > Scheduler.
2. Click the three-dots menu in the Sugar Scheduler module tab and select

"Create Scheduler".

3. Set the Job Name field to "Records Geocoder".
4. Set the Job field to "Geocoder Maps".
5. We recommend setting the Sugar Maps schedulers to run 30 minutes apart

from one another, with the Records Geocoder scheduler running first. To
achieve this, check the Advanced Options checkbox field to reveal the
additional interval settings. Then set the interval to 0 min for the Records
Geocoder scheduler. Under Advanced Options, set the Date and Time Start
to a future date and time starting at the top of an hour.
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6. Click the Save button to create the scheduler.
7. Repeat steps 1-6 to create the Geocoder Resolver scheduler, setting the

scheduler job to "Geocoder Resolver". The Geocoder Resolver scheduler
"Interval" should be set at 30 min intervals, with the Date and Time Start
set a half-hour after the Records Geocoder scheduler start date and time. 

Refer to the Schedulers documentation for complete steps on creating schedulers.

Enabling and Configuring Modules for Sugar Maps

Sugar Maps can be enabled for a range of stock modules as well as custom
modules. To enable a module, you will need to add the module in your Maps
Configuration settings and map the module's fields or a related module's fields for
geocoding.

Use the following steps to enable a module for Sugar Maps:

1. Navigate to Admin > Maps.
2. From the Maps Configuration page, select the module you want to add

from the Add a new module for geocoding dropdown.
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3. Click the pencil icon to access the module's mapping settings for
geocoding.

4. From the mappings page, use the Mapping Type dropdown to select if you
would like to configure your field mappings to the selected module's fields
or to a related record's fields.
Note: When mapping to a related record only related records with an
address field will be available.
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5. When mapping to the selected module's fields, use the dropdowns to map
each address field to the module field that matches the address value you
want to use for geocoding.

6. Click the Save button. 

Configuring the Maps Subpanel

Once a module is enabled for Sugar Maps, the Maps subpanel is automatically
added to the module's record view. From your Maps Configuration settings, you
can edit the columns displayed when viewing records from a specific module type
within the Maps subpanel.

Use the following steps to configure the columns shown in a Maps subpanel:

1. Navigate to Admin > Maps.
2. Click the subpanel icon for an enabled module.

3. Click the plus icon to add a column.
4. Use the dropdown to select the column field.
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5. To remove columns, click the x icon. If you need to reset the subpanel
configuration to the default settings click the refresh icon.

6. Click the Save button.

Setting the Measurement Unit for Driving Directions

You can choose to display driving direction distances in kilometers or miles.

Use the following steps to set the default measurement unit used for driving
directions:

1. Navigate to Admin > Maps > Maps.
2. Select the default measurement unit from the Measurement Unit dropdown

field.
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3. Click the Save button.

Geocoder Log Viewer

System Administrators can access the Geocoder Log Viewer to review all
geocoding activity. This view provides a quick and comprehensive way to
troubleshoot geocoding for your enabled modules. 

Use the following steps to access the Geocoder Log Viewer:

1. Navigate to Admin > Maps > Log Viewer.

2. Adjust the available fields to filter your results by the geocode activity
status, date and module.
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Bug Tracker

Overview

In the Bugs module, there are two dropdown fields, "Found in Release" and "Fixed
in Release", that cannot be edited through normal means. Although these are
dropdown fields, they do not show a dropdown list option in Dropdown Editor to
add, remove, and edit the dropdown options.

The release dropdown list is instead controlled by the Releases section of the
Administration page. The release list is more comprehensive than a standard
dropdown list, so each list option needs additional information. This documentation
will cover how to use the Releases module to make changes to the list that controls
these fields.

Release Fields

The Releases module contains three fields that come out-of-the-box with Sugar.
These fields are not found in Studio, and therefore cannot be edited.

Field Description
Release Version The version name or number of this

release.
Status Select Active from this dropdown list to

display the name in the Release
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dropdown list. Inactive records will only
show in the list view of this page.

Order Enter a number to specify the order in
which the release is displayed in the
dropdown list. Numbers can be
repeated in this field, so they can either
be ranked in order (1,2,3...), in order of
importance (1,1,1,2,2,2,3,3,3...), or any
other ranking that is used internally.

Release Module Tab

The Releases module tab can be accessed by navigating to the Administration page
and clicking "Releases" in the Bugs section.

Once in the Releases list view, you can click the three-dots menu in the Releases
module tab that appears in the navigation bar to display the Actions menu. The
Actions menu allows you to perform important operations within the module.
Please note that clicking the module tab only allows you to access the Releases list
view.

Creating Releases
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Releases can only be created from the Releases module. Use the following steps to
create a release option for dropdown lists:

1. Navigate to Admin > Releases.
2. Click the Create button above the Releases list view.

3. An editable subpanel will open below the list view. Enter the required
information on the fields provided.

4. Click one of your two save options. Both will store your new record and
have it available for use through Sugar. However, the behavior after
clicking is dependent on which button used:

Save: After clicking "Save", the same release option that you
created will remain editable for you to make additional changes if
need be, after appearing on the list view above.
Save & Create New: After clicking "Save & Create New", the
release appears on the list view, the edit form's "Release Version"
field is cleared out, and the "Order" field is increased by one.

Viewing Releases

All of the release options are shown on a list view in the Releases module. Due to
the Releases module only containing three fields, all of the necessary details are
shown on this list view. The list view is always available when viewing the Releases
module, and specific releases can be selected from the list, but records can also be
selected via the Recently Viewed section of the module tab.
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Viewing Via Module

To view all of the releases, navigate to Admin > Releases. The list view displays
with all currently available releases within Sugar. The list view can be ordered by
any of the three fields within Releases. To see additional releases, use the arrows
in the top right of the list view to scroll through available pages. Here, you can see
which records of the total amount of releases are currently being displayed. The
two single-arrow Next and Previous buttons can be used to scroll through the
records page-by-page. The two double-arrow First Page and Last Page buttons
allow you to skip to the beginning or the end of the list.

From this list, any of the releases can be clicked and either edited or deleted.

Editing Releases

Changes to releases can be made at the discretion of any admin at any time. To
make changes, such as changing the name of the release and how it shows in the
Bugs module, whether the release value is active or not, or the order in which the
releases display, the release record needs to just be accessed via the list view.
Follow these steps to edit releases:

1. Navigate to Admin > Releases.
2. Select the release that you would like to edit by clicking the release name.

3. This will open the editor below the list view for the specific record where
you can make the necessary changes.
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4. Click one of your two save options. Both will store your updates to the
record. However, the behavior after clicking is dependent on which button
used:

Save: After clicking "Save", the same release option that you edited
will remain editable for you to make additional changes if need be,
after the changes update on the list view above.
Save & Create New: After clicking "Save & Create New", the
changes to the release appear on the list view, the edit form
defaults back to creating a new record.

Deleting Releases

If a release option is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from the Releases list view. Deleting release
options will not delete the bugs that use them. Instead, if a bug's "Found in
Release" or "Fixed in Release" field was filled in with the deleted release, the field
will now be blank. Use the following steps to delete a release option from the Bugs
module:

1. Navigate to Admin > Releases.
2. Click the Delete button corresponding to the release that you would like

deleted.

The page will refresh and the option will now be removed from the list view and no
longer appear in the dropdown fields (e.g., Found in Release).

Contract Types

Overview
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The Contract Types module in Admin > Contract Types enables you to create and
manage contract types for the Contracts module. When a contract type is created,
it will display in the Type Name field in the Contracts module for users to select.
Please note that when a contract record is created with a specific contract type,
the related documents to the contract type will also appear in the Documents
subpanel of the contract record.

Only administrators or users with developer-level role access have the ability to
modify the available contract types and the order in which they appear in the Type
Name field. This documentation will cover the basics of the Contract Types module
as well as the various options available in performing the actions related to the
module.

Contract Type Fields

The Contract Types module contains two stock fields that come out-of-the-box with
Sugar. For information on using and editing various field types, refer to the User
Interface documentation. Please note that Contract Type fields are not editable via
Admin > Studio as the module does not exist in Studio.

Field Description
Name The name of the contract type.
List Order A number to specify the order in which

the contract type is displayed in the
Type Name field in the Contracts
module.

Ordering Contract Types

When creating contract types, you will define the order in which the contract type
option is displayed in the Type Name field of the Contracts module. Enter the
numeric value (e.g., 1, 2, 3) in the contract type record's List Order field to
determine the order it will display in the contract's Type Name field. For example,
a contract type with a list order of "1" will be displayed at the top of the list
followed by the next value (e.g., 2), and so forth. Please note that you can change
the list order by editing the contract type via the list view or record view. 

Working With Sugar Modules

While the Contract Types module has some features that only apply to contract
type records, it also uses the Sidecar user interface that most Sugar modules are
based on. The following sections detail menus, views, and actions common to
Sidecar modules and contain links to additional information within the page or
links to the User Interface documentation.
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Menus

The Contract Types module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Contract Types-specific
functionality, within this page.

Module Tab Menus

The Contract Type module tab can be accessed by navigating to the Admin page
and clicking the Contract Types link in the Contracts section. Once in the Contract
Types list view, you can click the three-dots menu in the Contract Type module tab
to display the Actions and Recently Viewed menus. The Actions menu allows you to
perform important operations within the module. The Recently Viewed menu
displays the list of contract type records you most recently viewed. 

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Contract Type Opens the record view layout to create a

new contract type.
View Contract Types Opens the list view layout to search and

display contract types.

                         519 / 829

https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Viewing_via_Recently_Viewed
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Basic_Record_Creation
https://support.sugarcrm.com/documentation/sugar_versions/12.3/serve/application_guide/user_interface/#Viewing_Records


 

List View Menus

The Contract Types list view displays all contract type records and allows for
searching and filtering to locate specific contract types. You can view the basic
details of each record within the field columns of the list view or click a contract
type's name to open the record view. To access the module's list view, simply
navigate to the Admin page and select "Contract Types" under the Contracts panel.
You can also click the module's tab in the navigation bar once the Contract Types
module opens.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual contract type records or
click the checkbox in the list header to select all records displayed in the current
set of list view results.

 

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Merge Merge two or more duplicate contract

types.
Delete Delete one or more contract types at a

time.
Export Export one or more contract types to a

CSV file.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
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Doc Merge widget.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual contract type directly from the list view. 

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this contract type in the

intelligence pane.
Edit Edit this contract type.
Delete Delete this contract type.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Record View Actions Menu

The Contract Types record view displays a single contract type in full detail
including its fields and subpanels of related records. To access a contract type's
record view, simply click the hyperlinked contract type name in the Contract Types
list view. The record view's Actions menu appears on the top right of the page and
allows you to perform various operations on the current record. 
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The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this contract type.
Share Share a link to this contract type via

email.
Find Duplicates Locate potential duplicates of this

contract type.
Copy Duplicate this contract type to create a

new contract type.
Delete Delete this contract type.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

In the table below, the left column contains links to the User Interface page
covering topics that are applicable to all Sidecar modules. The right column has
links to sections of the current page that cover topics specific to contract types.

General Instructions for Working
With Sugar Modules

Contract-Types-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics

When Contract-Types-specific help
exists for each topic, use the links below
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generic to many Sugar modules. to navigate to sections of the current
page.

Creating Records  
Viewing Records  
Searching for Records  
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane  
Editing Records Ordering Contract Types
Deleting Records  
Exporting Records  
Finding Duplicate Records  
Merging Records  
Sharing Records  

SugarBPM

Overview

SugarBPM™ enables administrators to streamline common business processes by
managing approvals, sales processes, call triaging, and more. SugarBPM is an easy-
to-use business process management (BPM) and workflow tool that adds advanced
BPM functionality to Sugar.

The SugarBPM suite features an extensive toolbox of modules that provide the
ability to easily create digital forms and map out robust workflows using a drag-
and-drop interface.

Scope

This documentation only defines relevant BPM terminology and the concepts used
specifically for SugarBPM modules. It is not intended for general BPM educational
purposes, and should not be used as a complete BPM modeling resource.

The SugarBPM documentation contains the following pages:

SugarBPM™ (current page)
Process Definitions
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Process Business Rules
Process Email Templates 
Stock SugarBPM Templates

Additionally, the Processes page of the Application Guide contains documentation
for the user-facing elements of SugarBPM, and the Knowledge Base contains
several business use-case tutorials on how to design some common processes for
your organization.

Prerequisites

Basic knowledge of process design is required.
Basic knowledge of process standards such as BPMN is preferred. BPMN is
a flowchart-based notation used to define business processes within an
organization.
You should know which business processes you want to automate in Sugar.

Core Concepts

A business process is a set of logically related tasks that are performed in order to
achieve a specific organizational goal. It presents all of the tasks that must be
completed in a simplified and streamlined format. SugarBPM empowers Sugar
administrators to automate vital business processes for their organization. Some
examples of business processes that can be automated using SugarBPM include
invoice approvals, lead routing, customer service case routing, and automated
reminders and escalations.

SugarBPM Modules

In order to seamlessly automate business processes, the SugarBPM suite leverages
four interconnected process-related modules. The Process Business Rules module
and the Process Email Templates module are used to create rules and email
templates that will be referenced by records created in the Process Definitions
module. Once a process definition has been created, it will generate a record in the
Processes module each time the process definition is triggered.

The Process Business Rules, Process Email Templates, and Process Definitions
modules can be viewed and configured by any system administrator user. In
addition, regular users with a role that provides developer access to one or more
modules for which a SugarBPM process can be triggered (e.g., Accounts module,
Cases module) will be able to access all SugarBPM functions for those modules.
For example, a regular user with developer access to the Accounts and Cases
module can see the SugarBPM functions so that they can design process
definitions, business rules, and email templates targeting the Accounts and Cases
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modules. Regular users without developer role permissions will only have access to
the Processes module. For more information about roles, please review the Role
Management documentation.

The following image illustrates the relationship between the SugarBPM modules:

The following table describes the four SugarBPM modules and their intended use.
To learn more about any of the modules, click on the hyperlinked module name.

Note: We recommend reading this page in its entirety before moving on to other
SugarBPM sections.

Module Description
Process Definitions A process definition defines the steps in

an overall business process. Process
definitions are created by a Sugar
administrator. The process definition
consists of a network of activities and
their relationships, criteria to indicate
the start and end of the process, and
information about the individual
activities (e.g., participants) contained
within the business process.

Processes A process is a running instance of a
process definition. A single process
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begins every time a process definition is
executed. For example, a single process
definition could be created to automate
quote approvals, but because users may
engage in several quote approvals per
day, each approval will be represented
by a separate process instance, all
governed by the single process
definition. In other words, the Processes
module is the many-to-one (M:1) child
module of Process Definitions.

The Processes module is the only
SugarBPM module that is visible to
regular users. From the Processes
dashlet and module list view, they will
be able to see running processes if there
is anything for them to approve, reject,
or review.

There are three ways an administrator
can view a list of processes:

Processes module list view:
List views for the Processes
module display processes that
require the logged-in user to
take approve, reject, or review
action. Admin users, like regular
users, will only see the processes
that are waiting for them. List
views can be accessed by
navigating to Processes > View
Processes.
Processes dashlet: This dashlet
displays processes that require
the logged-in user to take
approve, reject, or review action.
Admin users, like regular users,
will only see the processes that
they need to act upon.
Process Management page: This
is the one place in Sugar where
an administrator can see all
running, cancelled, and
completed processes. From the
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Process Management page, the
admin can also monitor process
status, reassign or cancel an in-
progress process, or repair
processes in an error state. The
Process Management page is
accessible via the Admin >
SugarBPM panel or via the
Processes module tab by clicking
on "Process Management".

Process Business Rules A process business rule is a reusable set
of conditions and outcomes that can be
embedded in a process definition. The
set of rules may enforce business policy,
make a decision, or infer new data from
existing data. For example, if Sally
manages all business opportunities of
$10,000 or more, and Chris manages all
business opportunities under $10,000, a
process business rule can be created
and used by all relevant process
definitions to ensure that the
assignment policy is respected. In the
case of an eventual personnel change,
only the process business rule will need
to be edited to affect all related
processes.

Process Email Templates A process email template is required in
order to include a Send Message event
in a process definition. Sugar's core
product includes several places where
email templates can be created for
different purposes, but SugarBPM
requires all sent messages to be created
via the Process Email Templates
module.

Basic Visual Notation Elements

SugarBPM depends on process definitions created by the administrator using a
Visual Designer tool. When complete, the design will graphically display a
collection of flow elements that connect with each other to define and regulate a
business process in Sugar.
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The following table defines the different types of flow elements that are available
when creating a process definition in the Visual Designer.

Element Symbol Definition
Events An Event is something

that happens during the
course of a business
process. Events affect the
flow of the Process and
usually have a trigger
and/or a result. They can
start, interrupt, or end the
flow of a process.

An Event is represented
by a circle in the Visual
Designer.

Start Events The Start event indicates
where a process will
begin. It defines the action
that will trigger the
Process. The Start event
will always be triggered
by a record in the Sugar
module selected as the
process definition's Target
Module.

Note: A process
definition's target module
will be the same module
that is used for the Start
event.

A Start event is
represented by a green

                         528 / 829



 

circle on the Visual
Designer canvas.

Intermediate Events As the name suggests,
Intermediate events occur
after a process starts but
before the process is
complete. Intermediate
events that are placed
within the overall process
flow represent things that
happen during the normal
operation of the process
such as sending messages,
receiving messages, or
mandatory waiting
periods.

Intermediate events are
represented by blue
circles in the Visual
Designer.

Activities The only unit of work that
may require a user
response (opposed to
automation) is an Activity.
It is a moment within a
flow where a user must
decide if a circumstance is
approved or rejected, or
review a record that has
been routed to them.

Activities are represented
by rounded-corner
rectangles in the Visual
Designer.

Actions Actions are automated
elements used to execute
a business rule, create or
update a Sugar record, or
identify a process user.
Actions are completed by
the SugarBPM engine and
do not require any human
interaction to execute.
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Actions are represented
by rounded-corner
squares in the Visual
Designer.

Gateways Gateway elements are
used to control the flow of
a process via merging and
splitting. When several
activities may result in a
common outcome, a
gateway serves as a
merging mechanism, or a
"converging" element.
When a single activity may
result in several different
outcomes, a gateway
serves as a splitting
mechanism, or a
"diverging" element.

A Gateway is represented
by a diamond in the Visual
Designer.

End Events End events signal
completion of a process.
There are three end-event
options: Do Nothing,
Terminate Process, or
Send Message. An End
event is represented by a
red circle in the Visual
Designer.

Basic Steps to Automate a Business Process

It is important to understand how all of the modules and elements of the
SugarBPM suite will work together. Here is the best-practice chronology of the
overall procedure for automating business processes in Sugar using SugarBPM:

1. Create a SugarBPM Dashboard: Before using SugarBPM for the first time,
create a new dashboard specific to SugarBPM for easy, one-stop access to
all automated business processes and their components.

2. Create and Configure a Process Business Rule: (optional) Create at least
one Process Business Rule that will be used in a process definition. For
example, automated lead assignments might require a process business

                         530 / 829



 

rule to define which lead source values will be assigned to which user.
3. Create and Configure a Process Email Template: (optional) Prepare at least

one Process Email Template for processes that require alerts or
notifications.

4. Create and Configure a Process Definition: Using the Process Designer
canvas, create the visual design of the overall business process that you
want to automate. The process definition may make use of Process
Business Rules and Process Email Templates created in previous steps.

5. Process Management: With all of the SugarBPM modules now working in
harmony, administrators can navigate to the Process Management page to
monitor process status, reassign or cancel an in-progress process, or repair
processes in an error state. Users can monitor the Processes dashlet for
activities that are queued or awaiting feedback.

Creating a SugarBPM Dashboard

Before getting started, we recommend that the administrator user creates a
SugarBPM-specific dashboard on their home page. This will allow the
administrator to easily manage Process Definitions and their supporting modules
all in one place. Regular users who may be engaged in running processes should
place the Processes dashlet on their home pages to stay abreast of activities
requiring their attention.

Processes Dashlet
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This is the only SugarBPM dashlet available to regular users. It is important for all
users who may be engaged in a process to place this dashlet on their home
screens. Open, running processes and self-service processes waiting to be acted
upon by the logged-in user will be listed in this dashlet.

Note: Users (including administrators) will see only the processes that
immediately require their attention.

To add a Processes dashlet, please refer to the Dashboards and Dashlets
 documentation, choosing "Processes" from the Add a Dashlet page.

After saving the dashlet and its containing dashboard, the dashlet will offer several
process-specific management tools:

Current: Click on this button to view all processes that are running within
the expected timeframe.
Overdue: Click on this button to view all processes that have a due date in
the past. The label "Overdue" and the due date will be displayed adjacent
to the process description.
My Processes: View this tab to view the running processes upon which the
logged-in user must act. Self-Service processes are not displayed here.

To execute a Process from the dashlet, click on the name of the
process. Please note that admin users cannot see processes running
for other users via the dashlet. To access the system's exhaustive
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list of running and completed processes, refer to the Process
Management section of this documentation.

Self Service Processes: View this tab to view only the running processes
in the queue to be claimed by a user. Self-Service processes are configured
inside the User Activity element settings of the related process definition.
Process Description: Running processes are displayed in list view format
with descriptive fields including the unique process number, the name of
the affected Sugar record, the process title, the responsible user's name,
and the label of the relevant process step.
Due Date: When a due date exists it will appear adjacent to the process
description.

Process Definitions Dashlet

You must be an administrator user to add this dashlet to your home page. To add a
Process Definitions dashlet, please refer to the Adding Dashlets section of the
Dashboards and Dashlets documentation, choosing "Process Definitions" from the
Add a Dashlet page.

After saving the dashlet and its containing dashboard, the dashlet will offer several
SugarBPM-specific administration tools:

Actions Menu: Click on the plus (+) icon to access the "Create Process
Definitions" and "Import Process Definitions" options. Please note that
imports for this module must have a .bpm file extension.

My Process Definitions: Click on this button to list all process definitions
created by the current admin user.
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All Process Definitions: Click on this button to list all process definitions
created by any admin user.
Enabled: View this tab to view a list of process definitions that are
currently enabled in the system.
Disabled: View this tab to view a list of process definitions that are
currently disabled in the system. Disabling a process definition will prevent
it from triggering new processes. Any running processes related to the
disabled process definition will pause in an In-Progress state until the
process definition is re-enabled.
Process Definition Shortcut Buttons

Design: Click on this icon to edit the process definition via the
Visual Designer.

Delete: Click on this icon to delete the adjacent process definition.
A confirmation message will appear on the top of the screen; click
"Confirm" to delete the process definition or click "Cancel" to close
the message without deleting.

Export: Click on this icon to export the process definition to a .bpm
file.

Disable/Enable: Click on this icon to disable an active process
definition or to enable an inactive one. Disabled process definitions
will be listed in the "Disabled" tab.

All process definitions are disabled by default and must be
enabled by an administrator. For more information, please
refer to Enabling Process Definitions.
Disabling a process definition will prevent it from triggering
new processes. Any running processes related to the
disabled process definition will pause in an In-Progress state
until the process definition is re-enabled.

Description: Click this icon to open a blue alert window that
displays the admin-specified description of the process definition.
To close the description dialogue, click on the x in the corner of the
message.
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Process Email Templates Dashlet

You must be an administrator user to add this dashlet to your home page. To add a
Process Email Templates dashlet, please refer to the Adding Dashlets section of
the Dashboards and Dashlets documentation, choosing "Process Email Templates"
from the Add a Dashlet page.

After saving the dashlet and its containing dashboard, the dashlet will offer several
SugarBPM-specific administration tools:

Actions Menu: Click on the plus (+) icon to access the "Create Process
Email Template" shortcut.

My Process Email Templates: Click on this button to list all email
templates created by the current admin user.
All Process Email Templates: Click on this button to list all email
templates created by any admin user.
Process Email Template Shortcut Buttons

Edit: Click on this icon to edit the template record from record
view. It is then possible to access the template designer from the
record view.

Delete: Click on this icon to delete the adjacent email template. A
confirmation message will appear on the top of the screen; click
"Confirm" to delete the email template or click "Cancel" to close the
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message without deleting.

Export: Click on this icon to export the process email template to a
.pet file.

Description: Click this icon to open a blue alert window that
displays the admin-specified description of the process email
template. To close the description dialogue, click on the X in the
corner of the message.

Process Business Rules Dashlet

You must be an administrator user to add this dashlet to your home page. To add a
Process Business Rules dashlet, please refer to the Adding Dashlets section of the
Dashboards and Dashlets documentation, choosing "Process Business Rules" from
the Add a Dashlet page.

After saving the dashlet and its containing dashboard, the dashlet will offer several
SugarBPM-specific administration tools:

Actions Menu: Click on the plus (+) icon to access the "Create Process
Business Rule" shortcut.
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My Process Business Rules: Click on this button to view business rules
created by the logged-in admin user.
All Process Business Rules: Click on this button to view business rules
created by any admin user.
Business Rules Shortcut Buttons

Edit: Click on this icon to edit the rule configuration from the
Business Rules Builder interface.

Delete: Click on this option to delete the adjacent business rule. A
confirmation message will appear on the top of the screen; click
"Confirm" to delete the process business rule or click "Cancel" to
close the message without deleting.

Export: Click on this icon to export the process business rule to a
.pbr file.

Description: Click this icon to open a blue alert window that
displays the admin-specified description of the process business
rule. To close the description dialogue, click on the X in the corner
of the message.

Process Management List View

For processes, the admin user is restricted to the same access as a regular user in
the Processes module. This means that in Processes list view and the Processes
dashlet, the admin user will not see processes unless they have participated in that
process or they are expected to participate in it.

The exhaustive list of open and completed processes is accessible only via the
admin's Process Management page. This page can be accessed from either of the
following two places in Sugar:
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Admin > SugarBPM™ > Process Management.
The Processes module tab's actions menu:

The following columns are available from the Process Management page:

Process Number: Similar to a case number, this is a unique auto-
increment number assigned to the process in the order it was triggered by
the SugarBPM. This field is not related to the Sugar system ID field.
Process Definition Name: The name of the originating process definition
that triggered the process.
Record Name: The related Sugar module record to which the process
applies.
Run Order: The order in which running processes targeting the same
module are executed. This value is set on the process definition and is
optional; processes with a blank run order are run last. In the case of a tie,
processes are run oldest to newest by their process definition's Date
Created field.
Date Created: The date and time that the process was triggered.
Assigned To: The user who is assigned to the Sugar record that triggered
the process's Start event.
Process User: The user who is responsible for executing the current
activity in a running process if a Route or Approval activity is running.
Process Owner: The administrator who created the process definition (not
necessarily affiliated with the running process).
Status

Completed: The process has successfully reached an end event and
is no longer running.
Cancelled: An administrator user has chosen to cancel this
process.
In Progress: The process is currently open and running.
Terminated: The record that triggered the process has been
deleted or merged.
Error: The process has encountered a configuration problem and is
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paused.

Record Actions Menu

The Record Actions menu to the right of each record's Preview button allows users
to view vital process information, re-direct processes, and navigate to the process
execution screen directly from the list view.

Menu Item Description
Preview (eye icon) See an image of the current process and

how it has progressed within the overall
flow.

History Launch the Process History window,
which provides a historical summary of
the process's lifecycle.

Show Notes Display user-created comments and add
your own.

Select New Process User Display all of the process users who
have engaged with the process and,
optionally, reassign its current activity
to a new process user. To reassign the
process after clicking this option, select
a new value for the "Process User" field
and then click "Done".

Execute Available only for processes in an Error
state, the "Execute" option allows an
administrator to re-commence the flow
of a process that has been stopped due
to an error. This option should only be
used after the condition that caused the
error has been corrected.

Cancel Terminate the process occurrence.

Preview
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Administrators can view the progression of a process within the overall flow
directly from the Processes list view by clicking the Preview icon to the far right of
each process list row. A color-coded representation of the process' design layout
will display to the right of the list view providing key information regarding the
stages that have already been completed, the current stage of the process, and the
stages that have yet to execute.

The executed and in-progress stages of the process will be displayed in color, while
skipped or not-yet-executed stages will be presented in a grayed-out style.

Note: To view the process design layout in more detail, simply click on the preview
image to open a full-sized version of the flow in a new browser tab.

On the upper right of the intelligence pane, there is a Left and Right arrow button
that allows you to scroll through the list view's current search results by
previewing the next or previous record. To close the preview, simply click the "X"
on the upper right of the intelligence pane.

Searching Processes

The Process Management list view includes a module search to help you locate
running, completed, and incomplete processes easily and effectively. Once the
search is performed, the relevant results will be displayed in the list view below.

Unlike the standard Sugar filter, the Process Management search bar will query all
Process fields by default with the exception of "Record Name", which is technically
a field from a related module. Furthermore, Sugar automatically assumes a
wildcard character (%) at both the beginning and the end of your search phrase for
processes. This means that, for example, a search for "error" will return processes
named "Approve Error Resolution" as well as processes that are in an "Error"
status.
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The search also provides a Filter option that can be used in combination with the
open Search box to narrow your search further using the available options as
follows:

All: Returns all processes.
Processes Completed: Returns only processes with a status of
"Completed".
Processes Terminated: Returns only processes with a status of
"Terminated".
Processes In Progress: Returns only processes with a status of "In
Progress".
Processes Cancelled: Returns only processes with a status of "Cancelled".
Processes Error: Returns only processes with a status of "Error".

 

When you choose a filter, Sugar will return processes that match both the selected
filter and any name provided in the "Search..." bar in the filtered list view results.
For example, if you select "Processes Completed" in the Filter options and enter a
search query, Sugar will only return processes that contain a match to the search
query and have a Completed status. To see all processes, simply select "All" in the
filter and remove any text from the search bar. You can also click the X that
appears within the search bar. When you run a search using a saved filter, the
search will not be preserved when you navigate away from the module. Returning
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to the Process Management page will automatically display all unfiltered results.

Unattended Processes

An unattended process is a running process instance that has been interrupted
because an activity is dependent upon the response of an inactive or deleted user.
If an activity is encountered within a process, and the activity's process user
record's status is "Deleted" or "Inactive" or its employee status is "Not Active", the
process will be considered unattended. The activity cannot be completed unless
the administrator designates a new process user.

Note: While an unattended process will also appear in the Process Management
list, its status will remain "In Progress" and will not indicate that it is in an
unattended state.

The list of unattended processes is accessible via the admin's Unattended
Processes page. This page can only be accessed from the Processes module tab's
actions menu:

To select a new process user for an unattended process, follow these steps:

1. From the Unattended Processes list view, expand the actions menu for the
row that contains the unattended process.

2. Click on "Select New Process User".

3. After a brief pause, the Select New Process User drawer will appear.
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4. Find and select the name of the new process user and then click Done.

The updated process should no longer be visible in the Unattended Processes list,
and the new process user will see the activity in their Processes dashlet and list
view.

Terminated vs. Cancelled Processes

SugarBPM automatically terminates a process when the record related to the
process' Start event is deleted. The associated process will be removed from the
Processes dashlet and the process record will display "Terminated" in the Status
column of the Process Management list view. Processes may also be terminated as
a result of meeting conditions specified in the Process Termination settings. For
more information, please refer to the Process Definitions documentation.

Cancelled processes, on the other hand, have been intentionally stopped by the
administrator. The associated process will be removed from the Processes dashlet
and the process record will display "Cancelled" in the Status column of the Process
Management list view.

Importing and Exporting SugarBPM Module Records

SugarBPM supports import/export functionality for records in all modules except
the Processes module, which only contains running instances of process
definitions. To import records into the Process Definitions, Process Email
Templates, or Process Business Rules modules, the import file must be formatted
as the appropriate proprietary file type, as shown in the table below.

SugarBPM Module Supported File Extension
Process Definitions .bpm
Process Email Templates .pet
Process Business Rules .pbr
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Note: The .bpm file type is a package that may include email templates and
business rules that are related to the process definition. Process email templates
and process business rules, when exported or imported on their own, will have the
.pet and .pbr file extensions, respectively. More information is available in the 
Exporting and Importing SugarBPM Records sections below.

Due to the proprietary nature of the SugarBPM file types, only files that have been
exported from a Sugar instance can be imported into a Sugar instance. For
example, an administrator may choose to design process definitions in a sandbox
or development instance before moving them to a production environment. For
this, the process definitions would be exported from the dev instance as .bpm files
and then imported into the production instance's Process Definitions module.

Note: Please refer to the article Exporting and Importing a Process Definition for
important notes about version compatibility for SugarBPM imports.

Exporting SugarBPM Records

Exported SugarBPM records will automatically download as the appropriate file
type. If a process definition uses any email templates or business rules, then the
related records will automatically be included as part of the exported process
definition's .bpm file. Any tags applied to the SugarBPM records in the .bpm file
will also be retained. The user who later imports the process definition will be
prompted to decide which supporting files they want to import with the process
definition. The process definition and related email template(s) and business
rule(s) will be created in their respective modules. More information is available in
the Importing SugarBPM Records section below.

SugarBPM module records can be exported from any of the following locations:

The record's list view actions menu:

The record's record view actions menu:
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The dashlet's Export button adjacent to the record:

Importing SugarBPM Records

You can import a business rule (.pbr), an email template (.pet), or a process
definition (.bpm) that has been exported from another Sugar instance. Most often,
this action is performed between a production and development instance for
testing or debugging.

Note: By default, Sugar will automatically validate imported process definitions,
but you may disable this feature via Admin > System Settings.

After exporting a SugarBPM module record, it can be imported via the option in
one of the following menus:

The Actions menu on the module's dashlet:

The module tab's Actions menu:
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When importing a process definition record, if the .bpm file was exported with
related email templates and business rules, you will see a list of those records and
be given the option to import them as well. Select the checkbox next to the record
type (e.g., Business Rules) to import all of the records in that category. To select
related records individually, enable only the checkboxes next to those records. 

Click "Import" when you are ready to continue. The process definition and any
related email template(s) and business rule(s) will be created in their respective
modules and retain their settings and field values, including record-level tags.
Please note that the systems that you are exporting and importing between should
be clones so that any custom fields, modules, or relationships used by the
SugarBPM records can be found.

SugarBPM Settings

To configure SugarBPM settings such as auto-save and auto-validation intervals,
navigate to Admin > System Settings and find the SugarBPM™ panel. For more
information on the system configuration options for SugarBPM, please refer to
the System documentation.

SugarBPM Log Viewer
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Administrators and developers can gain insight into the performance of the
SugarBPM engine by viewing the SugarBPM log. To access the SugarBPM Log
Viewer, navigate to the Admin page and click on "Log Viewer" under the
SugarBPM panel.

There are two options on the SugarBPM Log Viewer page:

Refresh: Refreshes the log view, loading the last records.
Clear: Permanently deletes all log history. This cannot be undone.

 

The log level is set to Critical, which is equivalent to Sugar's Fatal log level and
starts recording events as soon as SugarBPM has been installed. A developer can
update the system config.php to change SugarBPM settings including
"logger_level" and "error_timeout". Changes that are made to config.php are
honored in real-time. For more information, please refer to the Core Settings
documentation in the Developer Guide.

SugarBPM Scheduler

Schedulers in Sugar automate the execution of system processes. Schedulers are
available only to administrative users and can be accessed by navigating to Admin
> Schedulers. SugarBPM Scheduled Job is responsible for processes associated
with SugarBPM. It is active and runs as often as possible by default. The
SugarBPM Scheduled Job will check for any active, time-based process events
(e.g., Wait events, Receive Message events, and Send Message events) in a
pending state. If any processes meet this criterion, the scheduler will ensure that
the process flow continues.

For more information about Sugar schedulers, please refer to the Schedulers
 documentation. For more information on troubleshooting the SugarBPM
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Scheduled Job, please refer to the Troubleshooting Wait Events in SugarBPM
 article.

Note: Process events processed by this scheduler will be run by the admin user
(user id = '1') in Process History unless the admin user is disabled.

SugarBPM Excluded Fields
As the SugarBPM functionality evolves, certain fields and field types that were
available in earlier versions may be prohibited in later versions for data integrity
purposes. Please be sure to stay up to date with the SugarBPM Exclude List for a
list of the excluded items in SugarBPM modules and the Sugar version in which
they were removed.

Process Definitions

Overview

The Process Definitions module is one of four modules that make up SugarBPM™,
Sugar's business process management tool that enables administrators to
streamline common business processes by managing approvals, sales processes,
call triaging, and more. Process definitions are central to the SugarBPM suite.
They define the steps in automated business processes and control the flow of
work that is allocated during running processes in Sugar. Process definitions are
created by a Sugar administrator and consist of a network of activities and their
relationships, criteria to indicate the start and end of the process, and information
about the individual activities (e.g., participants) contained within the business
process.

Before continuing, please read the SugarBPM overview page, which defines
critical vocabulary and other elements that may be referenced on this page.

This documentation contains the following pages:

SugarBPM
Process Definitions (current page)
Process Business Rules
Process Email Templates
Stock SugarBPM Templates

Additionally, the Processes page of the Application Guide contains documentation
for the user-facing elements of SugarBPM.

The following image illustrates the relationship between all of the SugarBPM
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modules:

The process definition will be the parent record for countless running processes in
Sugar. Every time a process definition's Start event is triggered, a single process
will begin to run in Sugar. When a running process requires action from a user,
that user will see the process in their Processes dashlet and Processes module list
view. Users will never see the parent process definition that controls the process,
nor will they see any processes for which they are not required to act.

This is an example of a complete process definition created in the Visual Designer:

In the example above, the Start event is triggered when a $10,000+ opportunity
moves to stage "Quotation" from any other stage. Every time this condition is met,
the process definition will generate a new process instance.

Note: If a process definition will utilize process business rules or process email
templates, those records must be created before designing the process definition.
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For more information about creating records in these supporting SugarBPM
modules, please refer to the corresponding section of the SugarBPM
documentation.

This documentation will cover information and actions specific to the Process
Defintions module. For instructions concerning views and actions which are
common across most Sugar modules, such as creating, editing, and deleting
records, please refer to the Working With Sugar Modules section of this page.

Process Definition Fields

The Process Definitions module contains the following fields. For information on
using and editing various field types, refer to the User Interface documentation. 

Field Description
Assigned To The Sugar user assigned to the process

definition.
Date Created The date the process definition record

was created.
Date Modified The date the process definition record

or its design was last modified.
Description A description or other information about

the process definition.
Integration Sync ID The sync key field used by external

integrations to identify Sugar records in
the external application. See the 
Integrate REST API endpoints in the
Developer Guide for more details on
how to use this field.
Note: This field is not visible in the user
interface.

Name A unique and descriptive name.
Run Order The order in which running processes

targeting the same module are
executed. The field is optional, and
processes with a blank run order are
run last. In the case of a tie, processes
are run oldest to newest by their
process definition's Date Created field.

Status The enabled or disabled state of the
process definition.

Tags User-created keywords that can be used
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to identify records in filters, dashlets,
and reports.
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Target Module The module that will be used for the
Start event in the process definition
design.

Fields Exclusive to Process Definition Design

The following fields are available when designing process definitions targeting the
given modules, but are not available in typical module views (e.g., record view) or
in Studio. They can be leveraged in your process definitions, but it is important to
note that some should only be read and not updated, while others can be updated
under certain circumstances. See the sections below for more details.

Field Module(s) Description
Contact Source Contacts A system-level dropdown

field that represents the
origin of newly created
contacts. Its possible
values are "Internal" and
"External".

Is Attachment Notes A system-level checkbox
field that Sugar sets to
"true" on notes
that represent a file
attachment to another
record (i.e., an email,
knowledge base article, or
another note).

Note Source Notes A system-level dropdown
field that represents the
origin of newly created
notes. Its possible values
are "Internal" and
"External".

Pending Processing Bugs, Cases, and custom
issue-type modules

A system-level checkbox
field. Sugar automatically
sets the field to "true" on
cases when creating a
case via inbound email or
relating a case to an
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inbound email. Sugar does
not update it on bugs or
other issue-type modules.

Contact Source

The Contact Source field is available on the Contacts module. It is a system-level
dropdown field that represents the origin of newly created contacts. It is set to
External on contacts created via Portal and set to Internal on contacts created in
Sugar. This field is not available in Studio or the user interface and is only
available in SugarBPM. Note that it is intended to be read but not written to in
order to preserve the accurate meaning of its value. Therefore, its value can be
read in process definitions to determine the source of a contact, but should not be
changed.

Is Attachment

The Is Attachment field is available on the Notes module and is a system-level
checkbox field that indicates if the note represents a file attachment to another
record. Files attached to records are stored in Sugar as notes and when designing
process definitions, you may need to know if a particular note is an attachment to
another record or not. This field differentiates between an individual note and an
attachment note because it is only set to "true" on notes that are attachments to
emails, knowledge base articles, or other notes.

Specifically, this field can be used to prevent inadvertent processes targeting the
Notes module from being triggered for attachment notes. For example, if you
create a process definition that is triggered when a new note is created, you may
want to add a Start event criteria for "Is Attachment" is equal to "false". This way,
processes are only started for notes that were created by a user or another
workflow and not when a file is attached to a record. This can be particularly
important for notes that are created with many attachment files, because in Sugar,
the new note is created, as well as an additional note for every attachment file on
the original note. If you do not want to trigger a process for each of these, the Is
Attachment field can be used to filter out note records that do not meet the
criteria.

Note Source

The Note Source field is available on the Notes module. It is a system-level
dropdown field that represents the origin of newly created notes. It is set to
External on notes created via Portal and set to Internal on notes created in Sugar.
This field is not available in Studio or the user interface and is only available in
SugarBPM. Note that it is intended to be read but not written to in order to
preserve the accurate meaning of its value. Therefore, its value can be read in
process definitions to determine the source of a note, but should not be changed.
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Pending Processing

The Pending Processing field is available on the Bugs and Cases modules and also
on all issue-type modules created in Module Builder. It is a system-level checkbox
field. Sugar automatically sets the field to "true" on cases when creating a case via
inbound email or relating a case to an inbound email. Refer to the Cases
documentation for more details on how emails and cases can work together.

In addition to Sugar setting the value of the Pending Processing field on cases,
Sugar Serve includes several stock process definitions that both read and write to
the field on cases. If your instance uses these SugarBPM templates to automate
customer service processes, do not update the Pending Processing field on cases.
Doing so may cause the processes to behave unexpectedly. However, you may still
read its value in process definitions without updating the field.

Sugar and the stock SugarBPM templates only use the Pending Processing field on
the Cases module and not the Bugs module or other issue-type modules. Therefore,
it is safe to leverage the field and make changes to it on bugs and other issue-type
modules in SugarBPM (e.g., via process business rules or Change Field events in
process definitions).

Note: The Cases and Bugs modules are not available for Sugar Sell users. For
more information on license types and the functionality available for each type,
refer to the License Types Matrix documentation. 

Process Definitions List View Dashlets

There are two specialized dashlets available exclusively on the intelligence pane
for the Process Definitions module's list view. The following sections describe
these dashlets, which offer insight into running processes in your instance.

Note: For more information on creating dashboards and adding dashlets to the
intelligence pane, please refer to the Dashboards and Dashlets documentation.

Pending Activities by Process

The Pending Activities by Process dashlet displays a summary of the total number
of activities that are awaiting a response from a process user. All open process
activities are reflected in the dashlet as a whole number and are also grouped by
user in the circular graph.
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You can refine the dashlet's view by selecting a process definition from the
dashlet's filter. This will restrict results to only the processes related to that
process definition.

Process Summary Dashlet

The Process Summary dashlet can also be added to the Process Definition's list
view intelligence pane. It displays an overview of all processes that have triggered
in your instance.
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You can customize the dashlet view using the options above the chart. Toggle the
display between "Stacked" and "Grouped" to view the results in different formats.
To exclude a status from the display, click on the solid circle next to that status's
name in the key above the chart.

Creating Process Definitions

Note: All process definitions are disabled by default so that they will not trigger
during the design phase. Please refer to the Enabling Process Definitions section of
this page for steps to enable a completed process definition.

Process Definitions can be created from any of the following places in Sugar:

Process Definitions dashlet:
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Process Definitions module tab menu:

Process Definitions list view:

Upon clicking "Create Process Definition" (or the Create button from list view), you
will be directed to the process definition's record view. The record view is where
you store information that will make it easy to find and understand the process
definition in the future. For more information about the available fields in the
Process Definitions module, please refer to the Process Definitions Fields section
of this documentation.

After completing this form, you will be directed to the Visual Designer canvas
where the process definition's elements can be composed.

Designing Process Definitions

Creating a process definition for your business process is easy using SugarBPM's
visual designer, where you can graphically assemble a series of flow elements
using an intuitive drag-and-drop interface. All process definitions are set to
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"Disabled" by default in order to prevent triggering of processes before the design
is complete. This means that you must change the status to "Enabled" before it will
work. Please see Enabling Process Definitions for more information.

Using the Visual Designer

Before designing a process definition, take a moment to understand how to
interact with process definition elements on the design canvas. In the visual
designer, process definitions are auto-saved every 30 seconds by default, and the
Undo button can revert changes as far as 25 levels back per session. You can
disable or adjust the auto-save increment via Admin > System Settings.

Note: The visual designer interface may not be compatible with some touchscreen
mobile devices. Please build process definitions from a desktop or laptop computer
to prevent any potential complications.

Editing Tools

If you edit the design of an enabled process definition, any running process will
immediately adapt to the new flow pattern. Therefore, it is best practice to disable
a process definition before making changes to its design. Disabling the process
definition will prevent running processes from adapting to the new flow
prematurely. Changing the process definition's status to "Disabled" will not cause
any interruptions to already running processes. Upon re-enabling the process
definition, any processes still running will adapt to the new flow.

Three icons on the right side of the design toolbar represent editing tools for your
process definition design.

Undo: Click the Undo button to revert the last change made in the Process
Definition (up to 25 changes). When an undo action restores a design
element on the page, it should also restore the element's configuration, but
you should always confirm the configuration via the element's settings.
Redo: Click the Redo button to reverse an undo action. When a redo action
restores a design element on the page, it should also restore the element's
configuration, but you should always confirm the configuration via the
element's settings.
Save: This control allows you to save changes made to the Process
Definition design. The Save button is enabled only when there are unsaved
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changes. Keep in mind that the Visual Designer auto-saves your work every
30 seconds by default and the auto-save increment can be configured or
disabled via Admin > System Settings.

Always review the settings for any canvas element re-instated by the Undo or Redo
buttons to confirm they are configured as expected.

Process Validation

When using the SugarBPM visual designer for creating process definitions, a
validation job periodically runs to inspect the layout and configuration of the
process definition's elements. The validation job may run automatically at regular
intervals configured in Admin > System Settings, and the administrator may also
manually trigger the validate action at any time from the designer toolbar.

Three icons on the right side of the design toolbar represent the validation tools
for your process definition design.

Validate: The Validate button triggers an action that inspects each
element in the design and verifies that evaluations and settings are valid.
Any errors or warnings are displayed as badges on the affected elements
and in the Error Console in the lower part of the screen.
Save and Validate: Click the Save and Validate button to save your work
and simultaneously validate the process design.
Show/Hide Errors: Click this button to view or minimize the Error
Console. The console displays warnings and errors that were found in the
last validation action and may not reflect changes you have made since the
last validation ran. For the most accurate information, click on Validate or
Save and Validate immediately after repairing any errors.

Any configuration or sequence flow errors will be displayed in the Process
Validation pane at the bottom of the design canvas. Expanding the validation pane
will not force a new validation, but clicking "Validate" or "Save and Validate" will
automatically expand the validation pane if it has been minimized or not yet
opened.

Some errors will occur and then resolve themselves naturally as the Process
Definition is pieced together. For example, all elements will be considered in an
error state until the appropriate connectors have been inserted in between
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elements. For more information on the errors and warnings returned by the
process validator, refer to the article Troubleshooting Validation Errors and
Warnings for Process Definitions.

Comments

The Comment element allows admins to mark up the designer canvas with helpful
annotations connected to Action and Activity elements. While all elements can be
descriptively labeled, further explanation may be needed to explain more complex
Process Definitions.

To insert a comment onto the Designer Canvas, simply drag and drop the comment
icon onto the canvas and then double-click on the text "Text Annotation" to type a
comment. Hit Enter to preserve the comment.

Sequence Flow

When you assemble a process definition, you are defining the overall sequence
flow. The flow dictates the processing order of the events, actions, and activities in
a process and is visually represented by lines called sequence connectors. Each
sequence connector originates from a single source element (e.g., action, event,
etc.) to a single target element.

Adding Sequence Connectors

All elements of a process flow must be connected by at least one directional line.
Failure to connect flow elements correctly will result in an error in the Process
Validation panel.

1. To connect two elements on the Designer canvas, hover over the outer
edge of the Start event icon until the mouse tip changes into a crosshair:
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2. Click the mouse button and drag the black square at the end of the
connector onto the subsequent design element:

3. Release the mouse button and the square at the end of the connector line
will transition into an arrow pointing toward the subsequent element and
indicating the direction of flow from one element to another.

4. Optionally, adjust the position of the process elements as described in the 
Moving and Deleting Design Elements section to achieve an organized
appearance.

Note: When dragging a connector to a subsequent element, you may choose to
release the mouse button at the top, bottom, left, or right edge of the element in
order to aesthetically organize the process and avoid running into other connector
lines, which may possibly affect the flow of the process. For more information on
interacting with objects on the canvas, please refer to the Moving and Deleting
Design Elements section of this documentation.

Removing Sequence Connectors

To remove unwanted or misplaced sequence connectors from the design canvas,
simply click on the line and press Delete on your keyboard as explained here:

1. Click on the segment of the line that you wish to remove. The connector
will transition to a selected state, and the beginning and end points of the
connector line will be represented by red dots. Please confirm that the line
connecting these red dots is the line that you intend to delete.
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2. Press the Delete key on your keyboard. The selected line will disappear.

If you accidentally delete a sequence connector, simply press the Undo button on
the toolbar. Always review the settings for any canvas element reinstated by the
Undo or Redo buttons to confirm they are configured as expected. For more
information on interacting with objects on the canvas, please refer to the Moving
and Deleting Design Elements section of this documentation.

Moving and Deleting Design Elements

To reposition or remove an entire branch or group of elements from a process
definition design, you can easily mass select them on the canvas. The following
table summarizes the mass actions available via the design canvas.

Task Procedure
Select a single element Point to the element on the design

canvas until the mouse tip becomes a
four-headed arrow then click the shape.

Select multiple elements within an area Click on the design canvas above and to
the left of the elements that you want to
select and then drag to create a
selection box around the shapes. Any
elements partially within the selection
area will be included as part of the
selection.

Move an element or group of elements
using your mouse

1. Select the element(s) that you
want to move.

2. Position the mouse pointer over
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one of the elements. A four-
headed arrow appears.

3. Click and drag the elements to
their new positions.

4. All of the selected elements will
move the same distance and
direction from their original
positions.

Nudge an element or group of elements
using the arrow keys

1. Select the element(s) that you
want to move.

2. Press an arrow key in the
direction you want the group to
move. The elements will nudge
one pixel for each tap of an
arrow key. Press and hold the
arrow key to move the elements
quickly.

Note: If pressing an arrow key scrolls or
zooms the entire canvas instead of
moving the selected elements, please
make sure that the SCROLL LOCK key
is disabled on your keyboard.

Delete an element or group of elements
within an area

1. Select the element(s) that you
want to delete.

2. Press the delete key to remove
the selected items from the
design canvas.

Note: Sequence connectors associated
with deleted elements will also be
deleted.

Delete a sequence connector Please refer to Removing Sequence
Connectors for more information on how
to remove unwanted or misplaced
sequence connectors from the design
canvas.

Deselect all elements Click a blank area on the design canvas.

Evaluation Criteria Box

Certain elements in the process definition design can be configured in a criteria
box. For these evaluations, you can interact with the operators and variables that
comprise the criteria in the following ways:
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Criteria pills are movable via drag and drop:

 

Criteria can be inserted by placing a cursor at the point of insertion and then
clicking on the operator or variable to insert:

 

Note: Never use single quotes ( ' ' ) or double quotes (" ") inside the criteria
builder; the SugarBPM engine automatically recognizes input types when
processing the condition.

For more information on defining criteria, please refer to the Setting Conditions
section of this page.

Process Definition Settings

Every process definition has a well-concealed option to configure important overall
settings. To access this option, simply right-click on any empty space on the
process definition's design canvas and select the "Process Definition" menu item:

The Process Definition settings window will open where you can edit the name and
description without exiting the designer. In addition, the settings window contains
two tools for enhanced security over records that engage in processes triggered by
the current process definition. The following sections describe how to configure 
Terminate Process conditions and how to prevent users from making changes to
records during the process duration via Locked Fields.
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Terminate Process

All process definitions should include a condition for termination. Informally
known as the process definition's "emergency brake," the Terminate Process
settings can tell Sugar when NOT to start a process or under what conditions a
process should abruptly end. If a process's target record meets the Terminate
Process conditions, the process instance will instantly force stop and display a
status of "Terminated" in the Process Management list. This setting is important to
prevent conflicts between multiple running processes or conflicts between
SugarBPM and other automated parts of your Sugar instance (e.g., Workflows,
Sugar Logic, or third-party customizations).

Follow these steps to define Terminate Process conditions for a process definition:

1. Navigate to the Visual Designer canvas for the relevant process definition.
2. Find a blank spot on the design canvas and right-click to access the Process

Definition's general settings.

3. Click on "Process Definition". The Process Definition settings will appear.
Here you can edit the record-level settings and set Terminate Process
criteria for this process definition.
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4. Click inside the Terminate Process field to reveal the criteria builder.

5. Refer to the Module Field Evaluation section of this page to build a
conditional statement that, when met, will force-stop a running process
that was triggered by this process definition.

6. Click "Save" to preserve this setting and return to the design canvas. Be
sure to save the overall process definition before navigating away from the
canvas.

Locked Fields

The Locked Fields feature of SugarBPM lets administrators, developers, and
process administrators prevent users from changing select field data on records
that are involved in active processes. Any number of fields (from none to all) can
be locked on the record. When a record becomes involved in a process that has
locked fields, that record will respect those field locks until the record is no longer
participating in the process.
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Note: Locked Fields configured in the Process Definition settings do not apply to
the process user when he or she is executing the process. To prevent the process
user from editing fields during the approve/reject or route stage, you must
configure the fields as read-only on the Activity's Read-Only Fields tab.

Follow these steps to set Locked Fields for records participating in the current
process definition:

1. Navigate to the Visual Designer canvas for the relevant process definition.
2. Find a blank spot on the design canvas and right-click to access the Process

Definition's general settings.
3. Click on "Process Definition".

4. The Process Definition settings will appear. Here you can edit the record-
level settings and set Locked Fields for this process definition. In the
Locked Fields section, place a checkmark next to the field or fields for
which you would like to prohibit editing:

5. Click "Save" to preserve this setting and return to the design canvas. Be
sure to save the overall process definition before navigating away from the
canvas.
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Note: Records that are processed through the job queue, imported, mass updated,
or merged will undergo locked-field validation.

Adding a Start Event

A Start event indicates where a process will begin. It defines the action that will
trigger a new process to run. The target module chosen in the process definition's
record view is the module that is used for the Start event in the process definition
design. When a record in the target module meets the criteria set in the Start
event, then a new process will commence based on this process definition. In other
words, the Start event will receive a message from the target module that it is time
to begin a new process.

Follow these steps to add a Start event to the process definition:

1. Drag the Start event icon onto the Designer canvas.

2. Double-click the Start event icon's label to rename it.

Note: The Start event will have an error icon and a warning icon if the
process validator runs before the Start event has been configured and
connected to the next element. This is normal. For more information about
resolving validation errors, refer to the Process Validation section of this
page.

3. To configure the Start event, right-click on the Start event icon and choose
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"Settings".

4. Select an "Applies to" preference to choose how the process definition will
be triggered to start. See the Start Event Types section below to
understand each option.

5. Click inside the Criteria field to expose the criteria builder and set the
conditions for the Start event. Please refer to the Creating Conditions for
Events and Actions section of this page to configure the conditions for the
Start event.

Note: Comparison operators in Start event evaluations may not always work as
expected for existing records that were last edited before the process definition
was enabled. To ensure that existing records are evaluated properly for
comparators such as "field changes from/to", perform an arbitrary mass update on
the target module's records immediately after enabling the process definition so
that Sugar can capture the "from" field values.

Start Event Types

There are several options when choosing how a process definition will be triggered
to start. You can trigger processes based on several different conditions in a single
Start event.

New Records Only: A new process will begin if a record is created and the
specified conditions are met on the first save.
Updated Records Only (First Update): A new process will begin the first
time the specified conditions are met on an existing record, even if the
record has been updated several times before it qualifies. Once a record
meets the conditions to trigger a First Update process, it cannot trigger
that process definition again.
Updated Records Only (All Updates): A new process will begin every
time an existing record is saved and the specified conditions are met, as
long as a process is not already running against the record. A given process
definition can only run one process instance against a particular record at a
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time. However, it is important to note that two or more different process
definitions may simultaneously run against the same record.
New Records or First Update: A new process will begin when a new
record is created or the first time it is updated if the specified conditions
are met. Once a record meets the conditions to trigger a New Records or
First Update process, whether it was triggered by a new record or a first
update, it cannot trigger that process definition again.
New Records and All Updates: A new process will begin every time a
new record is created or an existing record is saved and the specified
criteria are met, as long as a process is not already running against the
record. A given process definition can only run one process instance
against a particular record at a time. However, it is important to note that
two or more different process definitions may simultaneously run against
the same record.
Relationship Change: A new process will begin every time a related
record is added or removed from the target record and the specified
conditions are met. This option can be configured to trigger on any module
relationship change or only a change from a specified module.

 

Adding Multiple Start Events

Most use cases can be represented in a single Start event using one of the Start
event types. It is best practice to use only one Start event when possible to prevent
creating an invalid process definition with multiple Start events that can meet
their conditions simultaneously. However, certain very specific use cases cannot
be achieved using the available "Applies To" options. In these cases, it is
acceptable to use multiple Start events, as long as they contain mutually exclusive
criteria. In other words, only one Start event can evaluate to "true" for any given
record. If it is possible for two or more Start events to evaluate as "true" against
one Sugar record, the criteria for these Start events will be met simultaneously.
SugarBPM does not support this type of configuration.

The following table demonstrates the proper and improper use of Start events that
apply to multiple scenarios:

  Applies to Criteria Explanation

 Good design Start Event #1 Accounts; Type {is} Using a single
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New Records
or First Update

Customer Start event
prevents any
possibility of an
invalid process
definition that
can meet two
sets of criteria
simultaneously.

 Acceptable
design

Start Event #1 Accounts;
New Records
Only

Type {is}
Prospect

This
combination of
conditions
cannot be
represented in
a single Start
event, so in this
case, it is
necessary to
use two. A
Sugar record
cannot be
simultaneously
"new" and
"updated" (i.e.,
existing). It is
therefore
impossible for
these two Start
events to
evaluate as
"true" at the
same time,
making them
mutually
exclusive.

Start Event #2 Accounts;
Updated
Records Only
(First Update)

Type {is}
Customer

 Bad design Start Event #1 Accounts;
New Records
Only

Type {is}
Customer

This
combination of
Start event
criteria is not
mutually
exclusive. A
new account in
Sugar may be
classified as
both "Manufact
uring" and
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"Customer",
which would
make both
events evaluate
as "true".
Instead, use
one Start event
with an OR
operator
between the
two sets of
criteria.

Start Event #2 Accounts;
New records
Only

Industry
{contains}
Manufacturing

The "Good design" example above applies a process definition to both new and
updated records by using a single Start event triggered by "New Records or First
Update".

The "Acceptable design" example above applies a process definition to both new
and updated records by using one Start event triggered by "New Records Only"
and a second Start event triggered by "Updated Records Only". For this use case,
each Start event type has different criteria, which is why two events are needed.
When using multiple Start events, join each of them to the next element in the
process definition with separate connectors. Multiple Start events in a process
definition should always merge into a single path.

Scenarios That Require Multiple Start Events

Most criteria can be represented in a single Start event, but there are a few types
of scenarios where this is not possible:

Processes that start with a split flow that eventually converges cannot be
represented in a single Start event. If each subsection involves different
elements before converging, multiple Start events are necessary to initiate
each flow. An example of this is the stock Case Follow-Up Date
Management process definition that comes out-of-the-box with Sugar
Serve.
Processes with Start event criteria that differ depending on if the process is
triggered by a new record or an updated record cannot be represented in a
single Start event. In other words, the following set of criteria can only be
represented in two Start events: (new record AND Status = A) OR (updated
record AND Status = B).

Adding Intermediate Events

As the name suggests, intermediate events occur after a process starts but before

                         571 / 829



 

the process is complete. Intermediate events that are placed within the overall
process flow represent things that happen during the normal operation of the
process such as sending messages, receiving messages, or mandatory waiting
periods.

Note: Intermediate events require the SugarBPM Scheduled Job scheduler to
execute. If schedulers are not running, the flow of the process will be interrupted.
For more information, please refer to the SugarBPM documentation.

Intermediate events are represented by the second group of icons on the design
toolbar. There are three icons that each enable a configurable event.

The types of intermediate events are:

Wait Events
Receive Message Events
Send Message Events

Wait Events

This element will stop the execution of a process by the time interval set in the
configuration. Wait events support specified times as well as a calculated delta
between two times or events.

Note: Schedulers, specifically the SugarBPM Scheduled Job, must be running to
execute Wait events. If schedulers are not running or if the event is not properly
configured, the flow will be halted indefinitely, thereby stopping the flow of the
process. For more information, please refer to the SugarBPM documentation.

A Wait event's clock begins when the Wait event is triggered. For example,
consider a process definition that contains three five-minute Wait events. Each one
will pause and evaluate a running process at 5-minute intervals for an aggregate
15 minutes of wait time from the beginning until the end of the process definition.
While the Wait events enforce an evaluation at 5, 10, and 15 minutes into the
process, the settings for each element need only account for the 5-minute span
between timed events, and not its relative distance from the start of the process.
Therefore, the Duration setting for each Wait event in the example should be set to
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5 minutes.

To add a Wait event to the flow, drag and drop the clock icon onto the canvas:

To configure this event, right-click on the icon and choose "Settings". A new
window will display:

The configuration window has two main options: Duration and Fixed Date. Choose
one of these options to enable its configuration fields.

Duration (radio button): Choose this option to define the duration of the
Wait event in minutes, days, or hours.

Duration (text field): Required field when "Duration" is selected
above. Enter an integer to use in conjunction with the Unit field.
Unit (dropdown): The duration defined in days, hours or minutes.

Fixed Date (radio button): Choose this option if the Wait event will be
based on one or more of the record's datetime fields, a specific date, or a
calculated formula. Formulas may be constructed using a combination of
operators, Sugar variables, and constants.
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Criteria: Click inside this field to reveal the criteria builder. Please
refer to the Creating Conditions for Events and Actions section of
this page for instructions on using the criteria builder.

Receive Message Events

This event will stop the flow of a process definition until the established criteria in
the configuration are accomplished. In essence, it is a Wait event that pauses until
a condition is met instead of for a specified duration. Most notably, Receive
Message events can detect when a field's value changes or when a related record
is added or removed.

Note: Schedulers, specifically the SugarBPM Scheduled Job, must be running to
execute Receive Message events. If schedulers are not running or if the event is
not properly configured, then the event will stop the flow of the process. For more
information, please refer to the SugarBPM documentation.

To add a Receive Message event to the flow, drag and drop the Receive Message
icon onto the canvas:

To configure this event, right-click on the icon and choose "Settings". A criteria
builder window will display:
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Click inside the Criteria field to reveal the criteria builder. Please refer to the 
Creating Conditions for Events and Actions section of this page for further
instructions.

Send Message Events

This event is the only one that can send email messages. These messages must be
created in the Process Email Templates module. Your email template can contain
field variables to reference actual data from your target record or its related
records. 

Note: Schedulers, specifically the SugarBPM Scheduled Job, must be running to
execute Send Message events. If schedulers are not running or if the event is not
properly configured, the flow will ignore the event and continue running without
sending any mail. For more information, please refer to the SugarBPM
documentation.

Note: If your email template has been configured with a variable to show the old
value of a changed field, it is important to strategically position the Send Message
event within your process definition's design. For more information, refer to the 
Process Email Templates documentation. 

To add a Send Message event to the flow, drag and drop the envelope icon onto
the canvas:
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Right-click on the canvas icon and select "Settings" to open its configuration
window, which contains the following options:

Module: (read-only) This is the module that was set as the target module
for the process definition and which also must be the target module for the
email template.
Email Template: (required) Choose an email template from the dropdown
list. This list will only display templates that use the target module shown
in the previous field.
From: (required) Choose who should be shown as the sender of this email.
Options include users associated with the target record (e.g., Record
Owner), System Email, any Sugar user, and any outgoing email account
configured in Sugar. If you select a user, the name of the sender will be the
user's first and last name, and the email address of the sender and reply-to
email address will be their primary email address. For details on how these
fields are set for outgoing email accounts, see the Emails documentation.
To (required), Cc, Bcc: Specify the message's recipients. For more
information, refer to the Working With Recipient Fields section.

 

Note: Marketing and campaign emails should never be sent using SugarBPM. This
is because SugarBPM does not respect the subject's request to opt out, which
raises a liability concern.

Working With Recipient Fields

Recipient fields for Send Message events have options that are unique when
compared with the recipient fields in Sugar's Emails module. Send Message events
can be configured to send messages to individual recipients or users, members of
user teams or roles, their user relationships such as a supervisor, users who
created, modified, or are assigned to records, and other recipients from the
process's target record or records related to the target record. 
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Email addresses can be added to the recipient fields via a combination of free
entry in the recipient box and using the User, Recipient, Teams, and Role menus.
These methods are described in the following sections.

Adding Recipients via Free Entry

When you click inside the text area and start typing, Sugar will display a list of
suggestions that auto-updates as you type. If the text you enter is found in an email
address or name field for a record that has an email address in Sugar, then the
corresponding record will be suggested as a potential match. You may click on a
matching recipient to add their email address to the distribution list or continue
typing a complete email address (e.g., mail@example.com) directly into the To, CC,
or BCC field. When entering email addresses directly, press the Enter key after
each address.

Adding Recipients via User Menu

To send a message to a user or the manager of a user associated with the target
record, expand the User recipient panel. 
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The User panel contains five rows but only the topmost Module field and bottom-
most User row (highlighted in red above) are required.  The available options are:

Module (required): Select the first-level module relationship to the user
recipient.

If the user (or user's manager) is related to the target record, then
select the target module. For example, the user who created or is
assigned to the target record.
If the user is related to a one-away record (e.g., a user who is
related to a record that is related to the target record), then select
the module that contains the user field.
If the user is related to a two-away record (e.g., a user who is
related to a record that is related to a record that is related to the
target record), then select the intermediate module here, not the
target module nor the module that contains the user field.

Field/Value: Optionally, apply a filter to the first-level module. For
example, if the first-level module is Opportunities, you can restrict the
criteria to apply to only in-progress opportunities by setting "Status > is
equal to > In Progress". 
Related To: Optionally, select a second-level module relationship. For
example, set the second-level module to Contacts if you want to send an
email to the users related to contacts that are related to the records in the
first-level module.
Field/Value: Optionally, apply a filter to the second-level module.
User (required; not labeled): In the final row, select whether to send the
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message to a user or to the user's manager, and what their relationship to
the bottom-most selected module is.

Note: Another way to add users as recipients is to message all users on a Sugar
team. Refer to the Teams recipient option for more information.

Adding Recipients via Recipient Menu

To send a message to an email address stored in the Sugar database within the
target module or a related module's email address field, expand the Recipient
panel. 

The Recipient panel contains five rows but only the topmost Module field and
bottom-most Email Address Field rows (highlighted in red above) are required. The
available options are:

Module (required): Select the first-level module relationship to the
recipient.

If the recipient's email address is on the target record, then select
the target module.
If the recipient's email address is on a one-away record (e.g., in a
field on a record that is related to the target record), then select the
module that contains the email address field.
If the recipient's email address is on a two-away record (e.g., in a
field on a record that is related to a record that is related to the
target record), then select the intermediate module here; not the
target module nor the module that contains the user field. 

Field/Value: Optionally, apply a filter to the first-level module. For
example, if the first-level module is Opportunities, you can restrict the
criteria to apply to only open and won opportunities by setting "Status > is
not equal to > Closed Lost". 
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Related To: Optionally, select a second-level module relationship. For
example, set the second-level module to Contacts if you want to send an
email to a recipient related to contacts that are related to the records in
the first-level module field.
Field/Value: Optionally, apply a filter to the second-level module. 
Email Address Field (required): Finally, select the field that contains the
recipient's email address.

Adding Recipients via Teams Menu

To send a message to the explicit members of a Sugar team or to all teams
assigned to the target record, expand the Teams panel. The Team dropdown menu
shows all active teams in Sugar but does not list any private or inactive teams. It
also includes an "All teams assigned to the record" option to dynamically choose all
teams in the Teams field on the target record at the time the process runs. To add
all of the users on a team as recipients, select the team and then click "Add" to
move the team's name to the distribution list. To add users from more than one
team, simply select the next team and click "Add" again.

Adding Recipients via Role Menu

Click on the Role menu item to send a message to all of the users assigned to a
specified Sugar role. To add users from more than one role, select the role, click
"Add" and then select the next role and click "Add" again.

Adding Form Activities

The only unit of work that requires user interaction (as opposed to automation) is
an Activity. It is a moment within a flow where a user must decide if a
circumstance is approved or rejected, review a record that has been routed to
them, or send a record to DocuSign. Activities are represented by the solid square
icon on the design toolbar:
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Activities pause a process until a user makes a decision to either approve or reject
the record or indicates that they have reviewed a record that has been routed to
them. When a process reaches this point in the flow, the appropriate user will see
a line item in their Processes dashlet or Processes module list view. An Activity
form element is configured in two steps. First, configure the Forms setting and
then configure the Users setting.

To add a Form activity to the process definition's flow, drag and drop the Activity
icon onto the canvas:

Forms Setting

The "Forms..." setting controls what type of form the process user will see when
they are asked to execute this activity. The process user must be separately
configured in the "Users..." setting. There are three types of Activity forms:

Approve/Reject: This type of form will present itself as an Approve button
and a Reject button on the record view of the record that triggered the
process. A Gateway element must be placed after the Approve/Reject
activity in order to specify a flow for approval as well as a flow for
rejection.
Route: This type of form should be used to ensure that a record within a
process has been viewed or edited by the user configured in the Activity's
"Users..." setting. The form will present itself as a Route button on the
record view of the record that triggered the process. The process user has
the option to edit the record before clicking the Route button. The
administrator may choose to ensure only relevant fields are edited by
leveraging the Read Only Fields and Required Fields options for this
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activity.
Send to DocuSign: This type of form will present itself as a Send to
DocuSign button on the record view of the record that triggered the
process.

Note: If an activity is not properly configured, it will default to an Approve/Reject
form.

To configure the Forms setting for an activity, right-click on the icon and select
"Forms...".

 

A configuration window will open. The configuration window has four tabbed
sections.

General Tab
Read-Only Fields Tab
Required Fields Tab
Expected Time Tab
Email Tab

These are explained in detail in the following sections.

General Tab

View the General tab (displayed by default) to choose a form type for the activity.
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Form Buttons: Select the type of form to display.
Route: The user will be prompted to acknowledge that they have
reviewed and optionally edited/commented on the record.
Approve/Reject (default): The user will be prompted to approve or
reject a circumstance. Approve/Reject Form activities should always
be followed by a Gateway element with Form Response Evaluation
criteria to define the next step of the process in the case of approval
or rejection.
 Send to DocuSign: The user will be prompted to view the record.
Then, they can press the Send to DocuSign button in the Processes
dashlet to open DocuSign's website, where they can manage
documents, recipients, and the signing workflow. 

Other Routing Options: During a Form activity's execution, the process
user may be given the option to reassign the record associated with the
process. It may be appropriate to create specialized teams for users who
will be engaged in particular parts of a process. For more information
about managing teams and users, see the Team Management and User
Management sections of the Administration Guide.

Change Assigned To User: Enabling this option will add the
"Change Assigned To User" option to the actions menu of the
process execution screen, as seen here:

When the process activity is executed, the process user must select
this option if they want to change the Sugar record's Assigned To
user. The process user can only assign a user from the team
configured by admin in the team field under "Other Routing
Options".
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Select New Process User: Enabling this option will add the
"Select New Process User" option to the actions menu of the
process execution screen, allowing the designated process user to
delegate the Form activity to someone else. The process user can
only select a new user from the team configured by admin in the
Team field under "Other Routing Options".

The current process user may select a new process user from the
team configured by admin in the "Other Routing Options" Team
field.

Read-Only Fields Tab

Here, the administrator can restrict the process user from editing some or all
fields on the Sugar record for which the process applies. Place a checkmark next
to the fields that should not be edited during the form processing step.

Note: Fields configured as Locked Fields in the Process Definition settings do not
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apply to the process user when he or she is executing the process. To prevent the
process user from editing a field during the approve/reject or route stage, you
must configure the fields as read-only in the activity's Read-Only Fields tab.

Required Fields Tab

In this tab, the administrator can require the process user to complete some or all
fields on the Sugar record for which the process applies. Place a checkmark next
to the fields that must be populated during the form processing step.

Expected Time Tab

Complete the fields in the Expected Time tab to set a timeout interval for the
process user to execute this activity. When the time specified in the Duration field
has expired, the activity will be considered overdue. If an Activity is overdue, the
Due Date property will be shown in red on the process execution screen and the
process will appear in the "Overdue" tab of the My Processes dashlet.

Email Tab
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If you wish to send an email notification to the process user to inform them that a
new process has been assigned to them, enable the checkbox in this tab. Then,
select a process email template to use for the email. In this scenario, it is most
useful to use an email template that contains a link to the process so the recipient
can click the link to open the specific process requiring action in Sugar. See the 
Process Email Templates page for details on inserting this link.

Users Setting

The "Users..." setting controls which user will be responsible for executing the
process activity form. When a process reaches the activity in a flow, the process
user will see a line item in their Processes dashlet or Processes module list view.
The form type and other options must be separately configured in the "Forms..."
setting.

Note: The Assignment Method chosen here refers only to the user that will
execute the process, or "Process User". References to the Sugar record's assigned
user are labeled "Assigned To User".

To configure the Users setting for an activity, right-click on the icon and select
"Users...".

A configuration window will open. Choose one of the following process user
assignment methods from the dropdown list:
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Static Assignment
Round Robin (default)
Self Service

These three options are explained in detail in the following sections.

Note: If this activity type is not properly configured, it will default to the Round
Robin process-assignment method for the Global team.

 

Static Assignment

Choose "Static Assignment" to assign process Activities to a specific process user.
You can also select one of the following variable user types:

Current User: The Current User refers to the last process user who has
been defined in the process definition. If no process user has been
previously defined, the Current User will be the user who is in the Assigned
To field of the targeted Sugar record.
Record Owner: The Record Owner is the user who is in the Assigned To
field of the targeted Sugar record.
Supervisor: When selected, the supervisor of the user who is in the
Assigned To field of the targeted Sugar record will be prompted to execute
this process activity. This relationship must be configured in the "Reports
to" field of the Users module. For more information about editing User
fields, please refer to the User Management page of the Administration
Guide.

Static Assignment will disable the Team configuration option in this window and
require only the Select Process User field to complete the configuration.
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Round-Robin

Choose the Round Robin assignment method to equally distribute process
activities to the explicit members of a team in a take-your-turn fashion. For
example, if Jim and Sally belong to team "East," a Round Robin distribution for
team East will assign the activity to Jim the first time it runs, to Sally the second
time it runs, and then to Jim again on the third execution (and so on). Round Robin
actions process users in ascending order based on the ID of the user record in the
Users module.

Round Robin will disable the Select Process User option in this window and
require only the "Select Process User From Team" field to complete the
configuration.

 

Self Service

Choose the Self Service assignment method to allow any user of a specified team
to claim the activity in a process. By enabling users to claim process activities as

                         588 / 829



 

they have time for them, Self Service assignment reduces congestion in the
workflow. Self Service activities that are ready to be claimed will appear in the
Self Service Processes tab of the Processes dashlet.

Self Service will disable the Select Process User option in this window and require
only the "Select Process User From Team" field to complete the configuration.

Adding Actions

Actions are automated elements used to execute a business rule, create or update
a Sugar record, or designate a process user. Actions are completed by the
SugarBPM engine and do not require any human interaction to execute. There are
five types of actions available in the Visual Designer and they are all represented
by a single icon on the design toolbar:

The action must be configured after adding it to the designer canvas. The available
action types are:

Business Rule
Assign User
Round Robin
Change Field
Add Related Record
Doc Merge
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Note: The Action will have an error alert (!) icon warning you to add an outgoing
sequence connector. This is normal and will disappear after you create the next
element and connect it to the action. For more information about element errors,
refer to the Process Validation section of this page.

The Action will display a question mark image until it has been configured. Right-
click on the Action icon to configure the action type. By default, an Action element
is configured as type "Unassigned". This is simply to prevent a non-configured
Action from affecting the Process flow. You must choose one of the Action Types
and then configure the appropriate settings.

 

Settings: This option will be grayed out until an action type is selected.
Action Type: Choose the type of action this element will execute. These
options are explained in detail in the remaining Adding Actions sections of
this page.
Delete: Remove the element from the canvas.

Business Rule

This Action type allows the administrator to select a process business rule in order
to return a corresponding value. Business Rule actions must be followed by a
Gateway element to analyze the rule's return value. Follow these steps to add a
process business rule to the process definition:
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Note: The process business rule must already be configured and saved in the 
Process Business Rules module in order for it to be available in the Action's
settings and must utilize the same target module as the process definition.

1. Right-click on the Action icon and then select Action Type > "Business
Rule":

2. The Action's icon will change to:

3. Right-click on the icon again and choose "Settings":

4. Select the appropriate process business rule and then click the Save
button. Please note that the Rule dropdown list will only display rules that
were configured for the same target module as the process definition's
target module.

5. Now place a gateway element to the right of the business rule icon.
Connect the business rule action to the gateway using a sequence
connector.
Note: The gateway element is required in conjunction with a business rule
action.

6. Determine the number of possible outcomes for the business rule. Drag the
corresponding elements for each icon (any combination of events, actions,
or activities) to the design canvas, just to the right of the gateway.

7. Connect the gateway to these elements using sequence connectors.
8. Finally, configure the gateway criteria before moving on. The gateway will

evaluate all possible outcomes of the business rule and direct the flow of
the process to the next element as appropriate. Please refer to the Adding
Gateway Elements section of this page for more information.

Assign User

This Action type allows the administrator to specify a new process user or the user
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who will be responsible for the remaining part of the process. Assign User actions
should be followed by an Activity for the process user to complete. When a process
reaches this point in a flow, the process user will see a line item in their Processes
dashlet or Processes module list view.

Follow these steps to add an Assign User action to the process definition:

Note: If an Assign User action is not properly configured, it will stop the flow of
the process.

1. Right-click on the Action icon and then select Action Type > "Assign User":

2. The Action's icon will change to:

3. Right-click on the icon and choose "Settings":

4. The Settings dialog window has two options:

Select Process User: Select the name of the user that will be responsible
for the remaining process steps, until the process ends or a new process
user is designated. The Dropdown list will only display users that have an
Active status in the Users module.
Update "Assigned To" on record: Enable this option to automatically
change the Sugar record's "Assigned To" field to the process user chosen in
the previous field. If the new user is not already a member of any of the
teams on the record, the SugarBPM engine will append the user's private
team to the record for visibility purposes.
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Click "Save" to preserve these settings and return to the visual designer canvas.

Round Robin

This Action type assigns the process and, optionally, the target record, to the
members of a team in a take-your-turn fashion. For example, if Jim and Sally
belong to team "East", a Round Robin distribution for team East will assign the
record to Jim the first time it runs, to Sally the second time it runs, and then to Jim
again on the third execution (and so on). Round Robin actions select users for
record assignment in ascending order based on the ID of the user record in the
Users module.

Follow these steps to add a Round Robin action to the process definition:

1. Right-click on the Action icon and then select Action Type > "Round
Robin":

The Action's icon will change to:

2. Right-click on the icon and choose "Settings":

3. The Settings dialog window has two options initially but more become
available as fields are enabled:
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Select Process User from Team: Select the name of the team
from which a member will be chosen for assignment. If the Round
Robin team is not already related to the record engaged in the
process, it will be appended to the record's team set. Note that
users with a "Members Reports-to" membership in a team are not
included in the round-robin selection. See the Team Management
documentation for more details on this type of membership.
Update "Assigned To" on record: Enable this option if the Sugar
record's Assigned To field should also be updated to the team
member selected by the Round Robin action. Enabling this field
causes the next checkbox to be displayed.
Set "Assigned To" by availability: Enabling the previous
checkbox causes this field to be displayed. Enable this option if you
want SugarBPM to assign records based on users' availability for
work.
Required shift availability: Set these fields according to how
much time employees need to have available to be assigned the
record. See the Round Robin Availability section below for details
on setting this field.
If no users are available: Select the user that will be assigned
records if no users in the Round Robin team are available.

4. Click "Save" to preserve these settings and return to the visual designer
canvas.

Round Robin Availability

If you configure a Round Robin action to assign records by availability, the process
calculates the next user in the round-robin sequence that is available based on
their shifts, shift exceptions, and holidays. Users who are currently on shift are
considered available unless they have an enabled shift exception or holiday at that
moment. Shift exceptions that are not enabled are not included. Refer to the Shifts
documentation for details on setting up shifts and shift exceptions, and refer to
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the Getting Started documentation for details on creating user holidays.

If you also specify the minimum required shift availability, the calculations will
consider only the users that have enough shift time before the specified deadline to
complete the necessary work. For example, if your employees need two hours to
perform the work required before the deadline (e.g., to meet the Service Level
Agreement for a customer), set the Required shift availability field as follows:

Number field: Enter the number portion of the minimum required
availability duration.
Time dropdown field: Select the time unit (e.g., hours or minutes) for the
duration.
Datetime dropdown field: Select the deadline before which users must
have the required amount of availability. This dropdown menu lists all
fields of type Datetime on the target record. Note that it may not make
sense to use datetime fields that are always in the past (e.g., Date Created).

Use the "If no users are available" field to select a default user to assign records to
if none of the members of the team are available. Note that if the deadline is in the
past at the time of record assignment, it is not possible for any user to have
enough availability to be selected. As a result, the default user will be selected.

Change Field

This Action type will let you change the value of one or more fields on the target
record, on records related to the target record, or on records related to that
related record. Please note that calculated fields, including the Forecast field in
the Revenue Line Items module (or in the Opportunities module if Revenue Line
Items are disabled), cannot be modified by a Change Field action.

Note: If a Change Field action is not properly configured, the flow will ignore the
action and continue running without changing any fields.

Follow these steps to add a Change Field action to the process definition:

1. Right-click on the Action icon and then select Action Type > "Change
Field":
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2. The Action's icon will change to:

3. Right-click on the icon again and choose "Settings":

4. The Change Fields window will appear. The Module field will be pre-
populated according to the target module specified in the process
definition's record view, and that module's available fields will be listed in
the Fields section below. 

There are also several options that will allow you to change one or more
fields on a one-away or two-away record related to the target module. The
options are as follows:

Module (required): Select the first-level module relationship to the
record you want to modify.

If the record you want to modify is the target record, then
simply leave the target module selected (default).
If the record you want to modify is a one-away record (e.g., a
record that is directly related to the target record), then
select the module with the record that you want to modify.
If the record you want to modify is a two-away record (e.g.,
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a record that is related to a record that is directly related to
the target record), then select the intermediate module
here; not the target module nor the module that contains the
record you want to modify. 

Filter: Optionally, apply a filter to the first-level module. For
example, if the first-level module is Cases, you can restrict the
criteria to apply to only open cases by setting "Status > is not equal
to > Closed". Please note that, if the first-level module is on the one
side of a one-to-one or many-to-one relationship, then the filter
option will be grayed out, as the filter can be defined in the criteria
of the event that precedes the action.
Related To: Optionally, select a second-level module relationship.
For example, set the second-level module to Accounts if you want to
modify the accounts that are related to the records in the first-level
module field.
Filter: Optionally, apply a filter to the second-level module
records. Please note that, if the first-level module is on the one side
of a one-to-one or many-to-one relationship, then the filter option
will be grayed out.
Fields (required): Finally, select the fields you want to modify on
the record, as explained in the next step.

5. To have the process definition update a field, you must first enable that
field for editing by clicking inside the field's adjacent checkbox. Each field
will be locked from editing until its corresponding checkbox is selected.

6. Enter or select the desired field value. Fields that display a Settings  icon
support advanced configurations.

7. Click "Save" to preserve these settings and return to the Visual Designer
canvas.

Advanced Configuration Options for Change Field Actions

The following field types support advanced configuration options for Change
Field actions, as indicated by the Settings  icon.

Text Fields

To specify the value of a text field, use any combination of Sugar field variables
and text strings. For example, to append the Opportunity's Likely Amount to an
existing Opportunity name, follow these steps. In this example, a $100 opportunity
named "5 Widgets" will be updated to "5 Widgets - $100".
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1. Enable the checkmark next to the field name that you want to edit, and
then click on the Settings icon next to the empty field:

2. Click on Opportunities Fields > Opportunity Name. This will insert a
variable into the Opportunity Name field that references the current value
of the field when the corresponding process reaches this point in the flow.

3. Place the cursor inside the field immediately after the variable and type a
space or hyphen character for formatting.

4. Click on the Settings icon again.
5. Click on Opportunities Fields > Likely to insert a second field variable.

6. When the formula is complete, the field value container will look similar to
this:

Note: If a Change Field action references a field variable that is also changed by
the action, the variable will reflect the value of the field before the change field
action executes. For example, if the action changes the Probability field to
{probability + 1}, and the same action also inserts the Probability field variable
into the Description field, after saving, the description will display {probability}
and the Probability field will equal {probability + 1}.

Number Fields

To create a calculated value for number fields, use some combination of operators,
Sugar variables, and constants. For example, to calculate the Worst Amount field
to contain 50% of the value of the Likely Amount field, follow these steps:

1. Enable the checkmark next to the field name that you want to edit, and
then click on the Settings icon next to the empty field:
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2. In the criteria builder, place the variable for "Likely Currency" onto the
criteria window by clicking on Fields > Opportunities > Likely Currency.
This will automatically add the variable to the window:

3. Click on the multiply (x) operator from the Operators list to add it to the
formula window:

4. Now tell the criteria builder to multiply the Likely amount by half, or 0.5.
Click on Constants > String, Number and Boolean > type "0.5" in the Value
field (with no quotes) and then click "Add Number" to move the value to the
criteria builder canvas.
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5. When the formula is complete, click away from the criteria builder window
to see the formula in the field value container:

Date Fields

Date and datetime fields will reveal a criteria builder where the admin can
calculate a particular value. Please see the Fixed Dates section of the Creating
Conditions for Events and Actions documentation on this page to learn how to
configure date fields.

User Fields

For Change Field actions, user fields support the following variable user types
relative to the record that triggered the running process:

Created by User: The user who created the trigger record
Current User: The user who is defined as the process user within the
process definition
Last Modified by User: The user who last modified the trigger record
Record Owner: The user assigned to the trigger record
Supervisor: The supervisor of the user assigned to the trigger record

Add Related Record
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This Action type will create a new Sugar record and relate it to the target Sugar
record or to a record related to the target record. Please note that the values of
calculated fields, including the Forecast field in the Revenue Line Items module (or
in the Opportunities module if Revenue Line Items are disabled), cannot be directly
defined by an Add Related Record action.

When the SugarBPM engine creates a new record, the record's assigned user will
receive an assignment notification email if notifications are enabled in
Sugar's system settings and the user has enabled notifications in their user profile.
For more information on assignment notifications, please refer to the Getting
Started documentation in the Application Guide and the Email documentation in
the Administration Guide.

Note: If an Add Related Record action is not properly configured, the flow will
ignore the action and continue running without creating a new record.

Follow these steps to add an Add Related Record action to the process definition:

1. Right-click on the Action icon and then select Action Type > "Add Related
Record":

2. The Action's icon will change to:

3. Right-click on the icon and choose "Settings":

4. The Add Related Record window will appear. The Module field will present
the potential options in alphabetical order, with the topmost module's
available fields listed in the Fields section below. 
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The following options will allow you to create a related record or a record
in a two-away module related to the target module:

Related Module (required): Select the first-level module
relationship to the record you want to create.

If the record you want to create is directly related to the
target record, then select that module here.
If the record you want to create is a two-away record (e.g., a
record that will be related to a record that is directly
related to the target record), then select the intermediate
module here; not the target module nor the module where
you want to create a new record. 

Filter: If the record you want to create is a two-away
record, optionally, apply a filter to the first-level module. For
example, if the first-level (i.e., one-away) module is Contacts, you
can create related call records for only the related contacts where
"Do Not Call > is not equal to > Yes". Please note that, if the first-
level module is on the one side of a one-to-one or many-to-one
relationship, then the filter option will be grayed out.
Related To: Optionally, select a second-level module relationship.
For example, set the second-level module to Calls if you want to
create calls related to the contact records in the first-level Related
Module field.

5. Complete the fields that the SugarBPM engine will populate in the new
record. Any fields that are required by the module (indicated by a red
asterisk) must be configured in this step. The following screenshot shows
an Add Related Record action configured for a Cases process to create call
records related to any contacts that are related to the target case and do
not have Do Not Call set.
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Fields that display a Settings  icon support advanced configurations.
6. Click "Save" to preserve these settings and return to the Visual Designer

canvas.

Advanced Configuration Options for Add Related Record Actions

The following field types support advanced configuration options for Add Related
Record actions, as indicated by the Settings  icon. 

Text Fields

To specify the value of a text field, use any combination of Sugar field variables
and text strings. For example, when creating a follow-up task related to a target
opportunity, follow these steps to use the opportunity's Name field in the subject of
the task. In this example, a task related to an opportunity named "5 Widgets" will
have the subject "Follow up - 5 Widgets".

1. Click on the Settings  icon next to the empty field, then choose
Opportunities Fields > Opportunity Name. This will insert a variable into
the Subject field that references the opportunity when the corresponding
process reaches this point in the flow.

2. Place the cursor inside the field immediately before the variable and type
"Follow up: " Include a space or hyphen character for formatting. When the
formula is complete, the field value container will look similar to this:

Number Fields
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To create a calculated value for number fields, use some combination of operators,
Sugar variables, and constants. For example, to calculate the Worst Amount field
to contain 50% of the value of the Likely Amount field, follow these steps:

1. Click on the settings  icon next to the empty field:

2. In the criteria builder, place the variable for "Likely Currency" onto the
criteria window by clicking on Fields > Opportunities > Likely Currency.
This will automatically add the variable to the window:

3. Click on the multiply (x) operator from the Operators list to add it to the
formula window:

4. Now tell the criteria builder to multiply the Likely amount by half, or 0.5.
Click on Constants > String, Number and Boolean > type "0.5" in the Value
field (with no quotes) and then click "Add Number" to move the value to the
criteria builder canvas.
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5. When the formula is complete, click away from the criteria builder window
to see the formula in the field value container:

Date Fields: Date and datetime fields will reveal a criteria builder where the
admin can calculate a particular value. Please see the Fixed Dates section of the 
Creating Conditions for Events and Actions documentation on this page to learn
how to configure date fields.

User Fields: For Add Related Record actions, user fields support the
following variable user types relative to the record that triggered the running
process:

Created by User: The user who created the trigger record
Current User: The user who is defined as the process user within the
process definition
Last Modified by User: The user who last modified the trigger record
Record Owner: The user assigned to the trigger record
Supervisor: The supervisor of the user assigned to the trigger record

Doc Merge

This action type uses the Doc Merge feature to merge a document template with
designated records. Merged documents are assigned to the user who initiates the
process action.

Follow these steps to add a Doc Merge action to the process definition:
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1. Right-click on the Action icon and then select Action Type > "Doc Merge".

The icon changes to:

2. Right-click on the icon, and then choose "Settings":

3. Identify the following options in the Settings dialog window:

Document Template: The name of the Document Template to be
merged with records. You must begin typing in the Search field to
initiate a search for Document Templates.
Doc Merge to PDF: When this option is selected, the resulting
merged document will be a PDF file type. Leave the checkbox de-
selected to output the file as its native file type as stored in the
Document Templates module (e.g., DOCX).
Send merged document via email: If this option is selected, the
resulting merged document will be sent via email using the selected
email template, From, and To values. 
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4. Click the Save button to preserve these settings and return to the visual
designer canvas.

 

Adding Gateway Elements

Gateways are connective elements used to control the flow of a process via
merging and splitting. When a single activity may result in several different
outcomes, a Gateway serves as a splitting mechanism (i.e., divergent element).
When several activities may result in a common outcome, a Gateway serves as a
merging mechanism (i.e., convergent element).

A Gateway is represented as a diamond in the Visual Designer and by the fourth
group of icons on the design toolbar. There are two icons that each enable at least
one type of configurable divergent or convergent moment.
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To add a Gateway element to a process definition, drag and drop one of the two
Gateway icons onto the designer canvas. Right-click on the diamond-shaped icon
that appears in order to define a Gateway type, direction, and configure its
settings.

The four types of Gateways are explained in the following sections.

Gateway Type Divergent Convergent Use
Exclusive Gateway ✅ ✅ When divergent,

determines a single
outgoing path
based on data
conditions;
When convergent,
accepts only the
flow that reaches it
first

Inclusive Gateway ✅  Evaluates all
criteria to
determine one or
more outgoing
paths

Parallel Gateway ✅ ✅ When divergent,
begins the
concurrent
execution of all
outgoing paths;
When convergent,
waits for
completion of all
concurrent paths

Event-Based
Gateway

✅  Evaluates Wait
events and Receive
Message events,
creating a "race"
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condition

Note: A convergent gateway is usually required after a divergent gateway, but not
always. Carefully consider the outcome for each path in all possible user scenarios
and be sure to use the appropriate End event(s). When divergent paths do not
converge, you will most likely need to use Terminate Process End events. For more
information on End events, please refer to the Adding End Events section of this
page.

Default Sequence Flows

Default sequence flows represent the path your process takes when none of the
defined gateway conditions evaluate to true.

There must be one default sequence flow defined per divergent gateway
object.
Define the default flow before configuring any other criteria for the
outgoing flows. Because default flow elements require no conditions, the
default flow element will not have a corresponding Criteria field in the
Gateway's criteria builder pop-up.
Failure to define a default sequence flow will result in an element error, as
explained in the Process Validation section of this page.

To define a default sequence flow, first, connect the Gateway to all possible
outcome elements. Next, right-click on the Gateway icon and hover over the
Default Flow option. A menu will appear listing all of the potential flow routes from
the Gateway. Select the element that should occur when no criteria are met by the
others.

After defining the default flow, the sequence connector leading to the default flow
element will be distinguished by a small hash mark through the connector line:
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For more information on interacting with sequence connectors, please refer to the 
Sequence Flow section of this documentation.

Exclusive Gateways

 

Exclusive gateways can be used to diverge or converge flow elements in a process.
Exclusive gateways will evaluate several conditions but only direct the flow to or
from a single path in the flow.

Divergent Exclusive Gateway

Only one path will succeed from an Exclusive gateway, and it will be the one that
first accomplishes its start criteria.

Note: You must define a default sequence flow for divergent Exclusive gateways to
account for situations where all criteria are false.

If several criteria are true, the flow will be routed through the first
(topmost) flow that evaluates as true.
If no criteria are true, the flow will be routed through the default flow. If
you have not set a default flow, the process definition will be blocked by
this element.

Follow these steps to configure a divergent Exclusive gateway:

1. Drag the Exclusive gateway icon onto the designer canvas.
2. A divergent Gateway requires two or more subsequent elements (any

combination of intermediate events, end events, actions, and/or activities).
These must be placed on the canvas and connectors must join the elements
on the canvas before the Gateway can be configured.
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3. Once the Gateway has been connected to the subsequent elements, right-
click on the Gateway icon and select Direction > Diverging:

4. Specify a default flow for the Gateway. If no criteria are fulfilled, the flow
will be routed through the default one. From the visual designer canvas,
right-click on the Gateway icon and hover over the Default Flow option. A
menu will appear listing all of the potential flow routes from the Gateway.
Select the element that should occur when no criteria are met by the
others.

Note: The route set as default will not appear in the Criteria configuration
window (step 6).

5. Right-click on the element again and select the option "Settings".

6. A pop-up window will appear with a separate Criteria field for each
potential outcome except the default one, which requires no criteria.

Click inside each criteria field to display the criteria builder tool.
Refer to the Creating Conditions for Events and Actions section of
this page for criteria builder instructions.
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Drag and drop the Criteria fields in descending order of priority.

The criteria will be evaluated as they are presented in this window
from top to bottom. Only one path will succeed from an Exclusive
gateway, and it will be the one that first accomplishes its criteria.
The remaining criteria will not be evaluated. If no criteria are
fulfilled, the default flow will succeed (see step 4).

7. Click "Save" to return to the design canvas and continue building the
process definition.

Note: A convergent gateway is usually required after a divergent gateway, but not
always. Carefully consider the outcome for each path in all possible user scenarios
and be sure to use the appropriate End event(s). When divergent paths do not
converge, you will most likely need to use Terminate Process End events. For more
information on End events, please refer to the Adding End Events section of this
page.

Convergent Exclusive Gateway

This Gateway joins multiple paths in a single thread, but only accepts the first flow
that reaches the Gateway; the other flows will not be evaluated after that. There
are no settings for this element. To configure this Gateway as a convergent
element, right-click on the Gateway element and select Direction > Converging:

 

Inclusive Gateways
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Inclusive gateways are divergent elements that direct a process's flow along all of
the paths that accomplish their criteria. This may result in one flow or multiple
flows.

Note: You must define a default sequence flow for Inclusive gateways to account
for situations where all criteria are false.

If only one set of criteria evaluates as true, the flow will follow that path as
well as the default path.
If several criteria are true, the flow will be routed along all paths that
evaluate as true, which always includes the default path.
If no criteria are true, the flow will only be routed through the default flow.
If you have not set a default flow, the Process Definition will be blocked by
this element.

Follow these steps to configure an Inclusive gateway:

1. Drag the Exclusive gateway icon onto the designer canvas.
2. Right-click on the Gateway icon and select Convert > Inclusive Gateway.

The icon will transform from an empty diamond to a diamond
containing a circle.
Please note that the label will not automatically update and may still
be labeled as "Exclusive". Edit this label as appropriate for your
process.

3. A divergent Gateway requires two or more subsequent elements (any
combination of intermediate events, end events, actions, and/or activities).
These must be placed on the canvas and connectors must join the elements
on the canvas before the Gateway can be configured.
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4. Once the Gateway has been connected to the subsequent elements, specify
a default sequence flow for the Gateway. The flow will always be routed
through the default one at a minimum, as well as through any other paths
that evaluate to true. From the visual designer canvas, right-click on the
Gateway icon and hover over the Default Flow option. A menu will appear
listing all of the potential flow paths from the Gateway. Select the element
that should occur when no criteria are met by the others.

Note: The path set as default will not appear in the Criteria configuration
window (step 6).

5. Right-click on the Gateway again and select "Settings".

6. A pop-up window will appear with a separate Criteria field for each
potential outcome except the default one, which requires no criteria. Click
inside each criteria field to display the criteria builder tool. Refer to the 
Creating Conditions for Events and Actions section of this page for criteria
builder instructions.

7. Click "Save" to return to the design canvas and continue building the
process definition.

Note: A convergent gateway is usually required after a divergent gateway, but not
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always. Carefully consider the outcome for each path in all possible user scenarios
and be sure to use the appropriate End event(s). When divergent paths do not
converge, you will most likely need to use Terminate Process End events. For more
information on End events, please refer to the Adding End Events section of this
page.

Parallel Gateways

 

Use a Parallel gateway in a complex process that has multiple things happening all
at once (or "parallel" to each other). Unlike other gateways, there is no evaluation
inside this gateway; it simply tells the process that two or more flows are about to
happen at the same time.

Parallel gateways can be divergent or convergent. Divergent Parallel gateways will
direct parallel flows, whereas convergent Parallel gateways will receive parallel
flows. The same gateway is used for diverging and converging:

Divergent Parallel Gateway

The divergent Parallel gateway divides the flow into two or more elements in
parallel until a subsequent (convergent) Parallel gateway or until the paths are
legally terminated via End events. For example, in the screenshot above, the
process requires approval from the sales manager and a credit check from the
accounting department. If you tried to use an Exclusive gateway for this, it would
enforce only one of these options (sales approval OR credit check). But using a
Parallel gateway, the process can branch off in both directions at the same time
and then converge later. When the parallel flows reconvene, use a convergent
Parallel gateway to merge them. 

Note: All divergent Parallel gateways must have a convergent Parallel gateway to
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close out the multiple paths; otherwise, the engine leaves them active.

The following example demonstrates a process where the Parallel gateway is
leveraged to kick off two separate functions. The top flow starts the approval and
specifies behavior for approve/reject response. The bottom flow starts a separate
flow and eventually, a convergent parallel gateway is used to resume a singular
flow for the process.

Note: A convergent gateway is usually required after a divergent gateway, but not
always. Carefully consider the outcome for each path in all possible user scenarios
and be sure to use the appropriate End event(s). When divergent paths do not
converge, you will most likely need to use Terminate Process End events. For more
information on End events, please refer to the Adding End Events section of this
page.

Convergent Parallel Gateway

A convergent Parallel gateway joins multiple paths into a single thread. The
process flow will re-commence only when all of the flows that converge into this
gateway have arrived. There are no configuration settings for this gateway.

Event-Based Gateways

 

Event-based gateways are used to create a "race" condition between Activities,
Wait events, and Receive Message events that occur immediately after the
gateway. Event-based gateways stop the process flow until one of the activities or
events have completed per the following guidelines:

Receive Message events are complete when their condition is met.
Wait events are complete when they have satisfied the entirety of their set
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duration. 
Activity elements are complete when the activity's form has been approved,
rejected, or routed, or if the activity gets reassigned to another user via
"Select New Process User".

As soon as the first element completes, the flow direction then continues along the
path that completed first and the incomplete paths are dropped. There are no
configuration settings for an event-based gateway, but the following supporting
elements are required:

A combination of two or more form Activities, Wait events, or Receive
Message events to evaluate immediately after the gateway.
A convergent exclusive gateway must close out the multiple paths;
otherwise, the engine leaves them active.

To add an Event-based gateway to your process design, drag and drop the gateway
element onto the canvas. By default, it will be set as Exclusive; to convert it into
event-based, right-click on the icon and select Convert > Event-Based Gateway.

Adding End Events

End events are represented by the fifth icon grouping on the design toolbar. There
is one icon that can be configured three different ways after placing it on the
Designer Canvas.

 

To define an End event type, drag the End event icon onto the Designer Canvas
and then right-click on the red circle. Choose "Result" from the menu, and then
find the appropriate End event type. Note that the active End event type will be
grayed out because it is already selected, and the default type is "Do Nothing".
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The three types of End event are:

Do Nothing

Most often used for sequential processes, this event ends a thread of the Process
Definition without doing anything. It will not affect parallel threads that may be
running simultaneously in the process. Those threads will continue to run
uninterrupted by the Do Nothing End event. This event does not need any
configuration; it is set by default when you drag and drop an End event onto the
canvas.

To create a Do Nothing End event, drag and drop the End event icon into the
canvas. Right-click on the element icon and confirm that "Do Nothing" is grayed
out by default in the Result menu, indicating that it is the active End event type. If
it is not grayed out, click on "Do Nothing" to make it the active End event type.

Terminate Process

Most often used for parallel processes, this event terminates the flow of the branch
for which it is designed while simultaneously terminating the entire process,
regardless of any parallel events in the process definition. The Terminate Process
event does not need any configuration.

To create a Terminate Process End event, drag and drop the End event icon into
the canvas. Right-click on the element icon then choose "Terminate Process" in the
Result menu to make it the active End event type.

                         618 / 829



 

Send Message

The Send Message End event will signify the end of a process by emailing a
message created in the Process Email Templates module to specified recipients.
When a Send Message end event has multiple incoming paths, it will send an email
message for each path coming into it. If you want the message to be sent only
once, then you must use a converging gateway in front of the end event.

Please note that SugarBPM can only send email templates created in the Process
Email Templates module and cannot send email messages created in any other
part of the Sugar application. If no Process Email Template is specified in the
event configuration, then the Process will terminate but no message will be sent. If
your email template has been configured with a variable to show the old value of a
changed field, it is important to strategically position the Send Message
event within your process definition's design. For more information, refer to the 
Process Email Templates documentation. 

Note: Send Message End events require the SugarBPM Scheduled Job scheduler
to execute. If schedulers are not running, the message will not be sent. For more
information, please refer to the SugarBPM documentation.

To create a Send Message End event, follow these steps:

1. Drag and drop the End event icon into the canvas. Right-click on the
element icon and then choose "Send Message" in the Result menu to make
this the active End event type.

2. Right-click on the canvas icon and select the option "Settings" to configure
the event. A new window will appear:
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Module: (read-only)This is the module that was set as the target
module for the process definition and which also must be the target
module for the email template.
Email Template: (required) Choose an email template from the
dropdown list. This list will only show templates that use the target
module specified in the previous field.
From: (required) Choose who should be shown as the sender of this
email. Options include users associated with the target record (e.g.,
Record Owner), System Email, any Sugar user, and any outgoing
email account configured in Sugar. If you select a user, the name of
the sender will be the user's first and last name, and the email
address of the sender and reply-to email address will be their
primary email address. For details on how these fields are set for
outgoing email accounts, see the Emails documentation.
To, Cc, Bcc: (required) Specify the message's recipients. Click
inside the text area to select variable users, the explicit members of
a Sugar team, and/or type one or more email addresses. Please
refer to the Working With Recipient Fields section of this page for
more information about configuring the To, Cc, and Bcc fields.

Note: Marketing and campaign emails should never be sent using SugarBPM. This
is because SugarBPM does not respect the subject's request to opt out, which
raises a liability concern.

Setting Conditions

Conditional criteria may be defined for elements in a process definition based on 
process business rules, response forms, field values, related modules, specified
users, and date intervals.

Creating Conditions for Events and Actions
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Start event, End event, and all types of Action elements will display conditions as
logical or mathematical operations, depending on the type of field that is under
evaluation.

The available conditional components are:

Logical Operations: Used in criteria builders for text and other non-
numerical field types.

Module Field Evaluation
User Evaluation
Relationship Change Evaluation

Mathematical Operations: Used in criteria builders for date and numerical
field types.

Fixed Date
Time Span
Sugar Date Variables

Logical Operations

Logical operations utilize the AND, OR, and NOT operators in conjunction with the 
Module Field Evaluation, User Evaluation, and Relationship Change Evaluation
options to specify conditions for an event. For example, a Start event for
opportunities may be limited to only opportunities containing a certain sales stage.
Logical operations are defined inside a criteria builder in the process definition's
design view.

The logical operations window will always contain a criteria field and logical
operators:

Criteria field: This is the field where the criteria will be constructed. Click
inside the criteria field to reveal the logical operators and supported
evaluation types.

Logical Operators: Click on the AND, OR, and NOT buttons to create
logical statements. Use the parentheses to group operations.
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Module Field Evaluation

Note: Module Field Evaluations are logical operations that may be used in Start
events and Receive Message events.

To reveal the Module Field Evaluation panel, click inside the criteria field and then
click on "Evaluations" and select "Module Field Evaluation":

The Module Field Evaluation panel consists of the following options:

Module: Click the down arrow to list and select the related module whose
values will be evaluated.
All/Any Related Records (for related records on the "many" side of a
relationship): Decide how to evaluate related records when more than one
related record may exist.
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Select "All Related Records" if the criteria must be true for all
related records.
Select "Any Related Records" if the criteria require only one or
more of the related records to evaluate as true.
Select "Any Related Records" if you want to use the "changes",
"changes to", or "changes from" operator.
Note: Process definitions created before Sugar 8.1 did not have the
"any/all" option and will evaluate only the most recently modified
related record. An administrator can update this setting on the
Start event's criteria after upgrading to Sugar 8.1 or higher.

Field: Click the down arrow to list and select the field variable of the
chosen module.
Comparison Operator (not labeled): Click the down arrow to list and
select a comparative operator. Depending on the field type used in the
evaluation, available options may include "is", "is not", "is equal to", "is not
equal to", "contains", "does not contain", "includes any", "does not include
any", "changes", "changes from", and "changes to".

For global termination criteria, do not set target record "changes"
as a process terminate criteria or it will cause the process to
terminate right after starting.
Note: Comparison operators may not always work as expected for
records that were created or edited before the process definition
was enabled. To ensure that existing records are evaluated properly
for comparators such as "field changes from/to", perform an
arbitrary mass update on the target module's records immediately
after enabling the process definition so that Sugar can capture the
"from" field values.

Value: Enter a value to compare.
Add: Move the evaluation to the criteria field.

Note: Checkbox fields are evaluated as "yes" or "no" (without quotes). 

User Evaluation

Note: User Evaluations are logical operations that may be used in Start events,
Send Message events, and Gateways.

To reveal the User Evaluation panel, click inside the criteria field and then click on
"Evaluations" and select "User Evaluation":
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The User Evaluation panel consists of the following options:

User: Click the down arrow to list and select the type of user related to the
current process:

Current User: For a Start event, the Current User refers to the
user who is assigned to the target record. For any other element,
the Current User refers to the last user who has been defined in the
process definition.
Supervisor: applies to the supervisor of the logged-in user who
triggers the process
Record Owner: applies to the user who is assigned to the record
that triggers the process

Operator: Click the down arrow to select the comparison operator:
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is admin: The condition will only evaluate as true if the user
specified in the User field is an admin user. This option will
complete the evaluation definition and disable the Value field.
has role of: The condition will only evaluate as true if the user
specified in the User field is a member of a certain role. This option
will populate the Value field with a list of available user roles.
is user: The condition will only evaluate as true if the user specified
in the User field is a specific user. This option will populate the
Value field with a list of active users. To select multiple users, add
this evaluation once for each user and connect the evaluations with
OR operators. Surround all of the user evaluations with
parentheses.

is not admin: The condition will only evaluate as true if the user
specified in the User field is not an admin user. This option will
complete the evaluation item and disable the Value field.
does not have role of: The condition will only evaluate as true if
the user specified in the User field is not a member of a certain role.
This option will populate the Value field with a list of available user
roles.
is not user: The condition will only evaluate as true if the user
specified in the User field is not a specific user. This option will
populate the Value field with a list of active users. To select multiple
users, add this evaluation once for each user and connect the
evaluations with AND operators. Surround all of the user
evaluations with parentheses.

Value: This field will be disabled if the Operator field is set to "is admin" or
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"is not admin". If the Operator is set to "is user" or "is not user", the Value
field will load the user list as field options. If the Operator is set to "has role
of" or "does not have role of", the Value field will load the roles list as field
options.
Add: Move the evaluation to the criteria field. By default, the evaluation
will be placed at the end of the criteria statement but can be relocated
within the statement by dragging it to the desired location.

Relationship Change Evaluation

Note: Relationship Change Evaluations are logical operations that may be used in
Start events and Receive Message events.

To reveal the Relationship Change Evaluation panel, click inside the criteria field
and then click on "Evaluations" and select "Relationship Change Evaluation":

The Relationship Change Evaluation panel consists of the following options:

Module: Click the down arrow to list and select the related module you
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want to monitor for relationship addition or removal. The default value is
"Any Relationship", which is triggered when any related record is added or
removed from the target module, regardless of the related module.
Added/Removed/Added or Removed: Choose which type of relationship
change(s) you wish to trigger on.

Select "Added" to trigger when a related record is added to the
target record.
Select "Removed" to trigger when a related record is removed from
the target record.
Select "Added or Removed" to trigger when a related record is
added or removed from the target record.

Field: Click the down arrow to list and select the field variable of the
chosen module. If "Any Relationship" is selected instead of a specific
module, then this field, the comparison operator, and the value are disabled
because it is not possible to add field criteria that apply to every module.
Comparison Operator (not labeled): Click the down arrow to list and
select a comparative operator. Depending on the field type used in the
evaluation, available options may include "is", "is not", "is equal to", "is not
equal to", "contains", "does not contain", "includes any", "does not include
any", "changes", "changes from", and "changes to".

For global termination criteria, do not set target record "changes"
as a process terminate criteria or it will cause the process to
terminate right after starting.
Note: Comparison operators may not always work as expected for
records that were created or edited before the process definition
was enabled. To ensure that existing records are evaluated properly
for comparators such as "field changes from/to", perform an
arbitrary mass update on the target module's records immediately
after enabling the process definition so that Sugar can capture the
"from" field values.

Value: Enter a value to compare.
Add: Move the evaluation to the criteria field.

Note: Checkbox fields are evaluated as "yes" or "no" (without quotes).

It is important to note that relationship changes cannot occur at the same time as
any other change, whether it is another relationship change, a field change, or a
user change. Therefore, criteria that join a relationship change with another
evaluation using an AND operator will never evaluate to true because the
relationship change happens independently of any other action. It is safe to join
them with an OR operator, however, to trigger when either condition is true.

Using Evaluations
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Follow these steps to add a condition to a Start event:

1. Right-click on the opportunity Start event icon and choose "Settings".

2. Click inside the criteria field and then click on "Evaluations" and select
"Module Field Evaluation" to restrict this Process Definition to only certain
opportunities.

3. Choose a field, operator, and field value for the first condition and then
click "Submit" to add the condition to the Criteria window.

4. Use the boolean logic elements AND, OR, and NOT in conjunction with
parentheses for grouped criteria to build a compound filter.
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5. Continue adding evaluation filters to the Criteria window.

6. When satisfied, click outside of the Criteria field to close the Evaluations
window and then click "Save".

Mathematical Operations

Mathematical operations utilize mathematical operators in conjunction with the
Fixed Date, Time Span, and Sugar Date variable options to specify conditions on an
event. Mathematical operators can also be used to calculate a numerical value for
a Sugar field using a combination of Sugar field variables and constant values.
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Mathematical operations are defined inside a criteria builder in the process
definition's design view.

Note: Mathematical Operations may be used for Wait events, Change Field
actions, and Add Related Record actions.

Mathematical operators primarily serve two purposes:

Calculating Dates: Use addition (+) and subtraction (-) to create a date that
is relative to another date. For example, set a quote as valid until two
weeks after its close date:

Calculating Numeric Values: Use addition (+), subtraction (-),
multiplication (x), and division (/) to create a calculated value relative to
another Sugar field. Define a specific order of operations by leveraging
parentheses in your formulas. For example, set a discount amount to 10%
of the sum of a record's subtotal plus tax:

Calculating Dates

Dates are calculated in conditions using one or a combination of fixed date, time
span, and Sugar date field variables. Anything other than the listed configurations
or a legal chaining of the supported configurations will be marked as not valid and
cannot be saved in a process definition.

The following table lists the supported configurations for date, datetime, and time
span calculations in criteria:
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Configuration Type Supported Expressions
Time Span = date - date

= datetime - datetime
= timespan +/- timespan

Date = date (e.g., a Fixed Date or 
Sugar Date Variable)

Datetime = timespan
= datetime (e.g., a Fixed Date or
Sugar Date Variable)

Note: For more information on the Run Time option, which is shown near the plus
and minus operators, please refer to the Sugar Date Variables section.

Fixed Date

The Fixed Date option enables the administrator to specify a formal, static date as
a field value or as a variable in a formula that will calculate a field value. For
example, if all opportunities in a process are expected to close at the end of the
year, create a Change Field action that uses Fixed Date to change all
opportunities' Expected Close Date fields to December 31, 2015.

Note: Fixed Dates may be used in mathematical operations for Wait events,
Change Field actions, and Add Related Record actions.

To reference a Fixed Date, follow these steps:

1. Click inside the date field and then click on "Constants" and select "Fixed
Date":

2. The window will transition to a single Date field; click inside the Date field
to reveal a calendar picker. Navigate from month to month using the back
(<) and forward (>) symbols near the month label. Click on the date that
will be used in the formula.
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3. Click the Add button to move the selected date onto the criteria builder
canvas:

If the date added in this step is the static date for the field value, then the formula
is complete. If the Fixed Date is only one component of a larger formula that will
be used to determine a field value, then the Fixed Date should be entered in the
order it is expected in the formula along with a logical combination of Time Span, 
Sugar Date variables, and mathematical operators.

Time Span

The Time Span option allows the passage of time within a date formula. For
example, if a Due Date should be set for two weeks after a record's Start Date,
build a formula that uses the Time Span "2 weeks" as a variable (e.g., 'Start Date +
2w'). To use a time span element relative to now (e.g., set a due date for 2 weeks
from now), then use the Time Span element with a Run Time variable.

Note: Time Spans may be used in mathematical operations for Wait events,
Change Field actions, and Add Related Record actions.

To reference a time span, follow these steps:

1. Click inside the date field and then click on "Constants" and select "Time
Span":
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2. The next window will display a Value field and a Units field. Use these two
fields together to create a logical time span phrase (e.g., 2 weeks would be
set as Value=2; Units=weeks). Time spans can be specified in years,
months, weeks, and days for date fields and all of the previous
increments plus hours and minutes for datetime fields.

You also have access to the business hours unit for datetime fields on
modules related to business centers. This allows you to perform
calculations using the open hours of a business center. When you select
"business hours", the Business Center dropdown menu appears where you
can search for a specific business center or choose "From Target Module"
to use the business center associated with the target module. For more
information, refer to the Business Center Management documentation.

3. Click the Add button to move the selected time span onto the criteria
builder canvas.

Note: The time span element is only one component of a larger formula. Enter it in
the order it is expected along with a logical combination of Fixed Date, Sugar Date
variables, and/or Mathematical Operators.

Sugar Date Variables

Sugar Date variables include the Run Time variable as well as the date fields from
Sugar records. "Run Time" refers to the moment the process element runs. For
example, an action that executes at 9:30AM on January 3 has a Run Time value of
January 3 for date fields or 9:30AM January 3 for datetime fields. Date field
variables can be used to add context to a date formula (e.g., Date Created + 1
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month) or referenced independently (e.g., an action or event that triggers on
Expected Close Date or three days after run time).

Note: Sugar Date variables may be used in mathematical operations for Wait
events, Change Field actions, and Add Related Record actions.

To reference a Sugar date variable, follow these steps:

1. Click inside the date field and the Run Time variable will appear as a
button next to the plus and minus operators. To drill down to the date
variables for each available module, click on "Fields" then click on the
arrow adjacent to the desired module.

2. After clicking on the module name, the window will reveal a list of all
available date fields for that module. Click on any date field to move it to
the criteria builder window:

Note: If the date variable is the only component of the date formula, then
the formula is complete. If the date variable is only one component of a
larger formula that will be used to determine a field value, then the
variable should be entered in the order it is expected in the formula along
with a logical combination of Time Span, Fixed Dates, and/or Mathematical
Operators.

Creating Conditions for Activities and Gateways

Form activities and gateway elements can evaluate user responses to forms or
business rules that have been created by the administrator.

The available evaluations are:

Form Response Evaluations: Configure this type of criteria for gateways
that follow a Form activity.
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Business Rule Evaluations: Configure this type of criteria for gateways that
follow a business rule action.

Form Response Evaluations

If a process contains an Approve/Reject activity, it must be followed by a gateway
with a form response evaluation. To configure this evaluation, follow these steps:

Note: A divergent Gateway requires two or more subsequent elements (any
combination of intermediate events, end events, actions, and/or activities). These
must be placed on the canvas and connectors must join the elements on the canvas
before the Gateway can be configured.

1. Drag an Activity element onto the design canvas as explained in Adding
Form Activities.

2. Drag an Exclusive gateway element onto the design canvas to the right of
the Activity.

3. Drag two or more Actions or Events onto the canvas to the right of the
Gateway.

4. Connect the activity to the gateway and the gateway to the subsequent
elements using Sequence Connectors.

5. Right-click on the gateway element and specify a default flow. This will be
the direction that the flow takes if no criteria are accomplished within the
gateway element. For this example, the default flow is set to the action
labeled, "Approve". Please note that the default flow options will not be
available until the corresponding elements have been placed on the canvas
and connected to the gateway.

A hash mark will indicate that a default flow has been successfully
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configured:

6. Next, right-click on the gateway element again and select "Settings". Note
that only the non-default outcome or outcomes will need to be configured.
For the current example, we set the default flow to "Approve" so there is
one criteria window, which represents the one non-default element in this
example.

7. Click inside the Criteria window to reveal evaluation options. The only
required evaluation for a Form activity is the "Form Response Evaluation".
Click on Evaluations > Form Response Evaluation and then select the form
response that will result in the non-default flow. In this example, the form
response must be "Rejected" or else the default flow will take over. Click
"Submit" to move the condition to the Criteria window. If multiple criteria
are required, click on the AND, OR, NOT, and parentheses operators as
needed and insert additional conditional statements.

Note: Despite a Form activity having two outcomes (approval and
rejection), it is possible to configure additional outcomes using a
combination of criteria beyond the form response. For example, a separate
outcome may be configured for:

Form Response = Rejected AND Status = New
Form Response = Approved AND Status = New
Form Response = Approved AND Status = Closed
else Default Flow: In other words, if none of the above criteria are
accomplished, continue with the default flow element. Please note
that the default element does not need to be configured. It will
always be the outcome when all other criteria evaluate to false.

8. Only one outcome can occur from an Exclusive gateway, and it will be the
one that accomplishes the condition. If several criteria are true, the priority
will be higher on the one that lies further up the configuration. To change
the priority order of a Gateway that is directed toward multiple elements:

Right-click on the Gateway element and select the option "Settings".
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There will be a criteria builder window for each related element.
Place the mouse pointer to the left or right side of the criteria fields
and the pointer will change its appearance to a standard "move"
cursor type.

Drag and drop the criteria fields into the desired sequence. This
order will set the priority of the Gateway criteria.

When you are satisfied with the conditions and their processing
order, click "Save" to preserve the changes and return to the visual
designer canvas.

Business Rule Evaluations

When referencing a process business rule within a process definition, the action
must be followed by a gateway with a business rules evaluation.
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Note: A divergent Gateway requires two or more subsequent elements (any
combination of intermediate events, end events, actions, and activities). These
must be placed on the canvas and connectors must join the elements on the canvas
before the Gateway can be configured.

The following steps are an example of incorporating a business rule evaluation in a
process definition:

1. Drag an Action element onto the design canvas and configure it as
explained in the Business Rule section of this page.

2. Drag an Exclusive gateway element onto the design canvas to the right of
the Action.

3. Drag two or more action, intermediate, or end events onto the canvas to
the right of the diverging gateway.

4. Add a converging exclusive gateway to the right of everything and then
connect the Business Rule action to the diverging gateway and connect the
diverging gateway to all subsequent elements using Sequence Connectors.
Notice that, in the example here, there are three potential outcomes for the
gateway: "Assign to Jim", "Assign to Will", or proceed straight to the
"Converge" point.

5. Next, confirm that all of the diverging gateway's potential outcomes
connect to the converge point using Sequence Connectors.

6. Right-click on the gateway element and specify a default flow. This will be
the direction that the flow takes if no criteria are accomplished within the
gateway element. For this example, the default flow is set to the action
labeled, "Assign to Jim". Please note that the default flow options will not
be available until the corresponding elements have been placed on the
canvas and connected to the gateway as explained in the previous steps.
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A hash mark will indicate that you have successfully configured the default
flow:

7. Next, right-click on the gateway element again and select "Settings". Only
the non-default outcome or outcomes will need to be configured. For the
current example, we set the default flow to "Assign to Jim" so there are two
criteria windows, which represent the two non-default elements in this
example: "Assign to Will" and "Converge".

8. Click inside the first Criteria window to reveal the evaluation options. The
only required evaluation for a business rule is the "Business Rules
Evaluation". Follow the remaining steps to configure the Business Rules
Evaluation.

9. Click on Evaluations > Business Rules Evaluation. The Business Rule field
will appear and display all of the Business Rules that have been referenced
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by action elements in the current process definition.
10. Select the name of the Business Rule action that this gateway is evaluating.

In this example, we added an action named "Assignment Rule" in step 1, so
we will select that value.

11. The Response field will evaluate the Return Value designated in the
process business rule. Type the Return Value that, when returned by the
business rule, will result in the current process path. For example, if a
Return Value of 1 causes the process to end, type "1" (no quotes) into the
Response field for the Converge element's Criteria.

Note: Process business rule "Return Values" will always convert to text for
evaluation in the Response field within a process definition.

12. Click "Add" to move the condition to the Criteria window.
13. If multiple criteria are required for a single flow direction, click on the

AND, OR, NOT, and parentheses operators as needed and insert additional
conditional statements.

14. Continue configuring Criteria for all possible flow outcomes.
15. Only one outcome can occur from an Exclusive gateway, and it will be the

one that accomplishes the condition. If several criteria are true, the priority
will be higher on the one that lies further up the configuration. To change
the priority order of a Gateway that is directed toward multiple elements:

Right-click on the Gateway element and select the option "Settings".
There will be a criteria builder window for each related element.
Place the mouse pointer to the left or right side of the criteria fields
and the pointer will change its appearance to a standard "move"
cursor type.
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Drag and drop the criteria fields into the desired sequence. This
order will set the priority of the Gateway criteria.

When you are satisfied with the conditions and their processing
order, click "Save" to preserve the changes and return to the visual
designer canvas.

Exiting the Visual Designer

At any time during the design of the process definition, you can exit the visual
designer by clicking the X at the top of the design canvas. While the visual
designer automatically saves your progress by default, you should always press the
Save button before exiting the designer in case the last save action occurred
before your most recent change or the auto-save has been disabled in Admin > 
System Settings.

Returning to the Visual Designer

After exiting the Visual Designer, you can return to design view of a process
definition from any of the following locations in Sugar:

From the process definition's record view, select "Design" from the record's
Actions menu:
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From the Process Definitions module's list view, select "Design" from the
record's Actions menu:

From the Process Definitions dashlet, click on the Design icon adjacent to
the relevant process definition:

Please note that it may take several seconds for the design canvas to load.

 

Enabling and Disabling Process Definitions

It is necessary to enable process definitions when their design is complete. It is
also possible to disable process definitions when needed. The following sections
explain how to enable or disable a process definition.

Enabling Process Definitions

New process definitions are set to "Disabled" by default. This is a preventative
feature that ensures a process instance is not triggered inadvertently during the
design phase.
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Note: Before enabling a process definition, please be sure that you have included a
Terminate Process condition in your process design's settings.

After the design is fully configured, exit the Visual Designer and set the process
definition to "Enabled". There are three ways to enable a process definition:

Enabling via Dashlet: Visit your SugarBPM dashboard. Disabled process
definitions will be listed in the "Disabled" tab of the Process Definitions
dashlet. Find the Enable/Disable icon adjacent to the relevant process
definition. Click on the icon and processes will immediately begin running
when the process definition's conditions are met.

Enabling via List View: Navigate to the Process Definitions list view by
clicking on the Process Definitions module tab. From list view, identify the
process definition that you want to enable. Click on that row's actions menu
and select "Enable" from the dropdown options.

Enabling via Record View: Click the process definition's name in the list
view or from the Process Definitions dashlet to navigate to its record view.
Edit the record's Status field to "Enabled" and then click the Save button.
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The process definition's Status will change from red to green "Enabled". Processes
will immediately begin running when the process definition's conditions are met.

Disabling Process Definitions

Disabling a process definition will prevent it from triggering new processes. Any
running processes related to the disabled process definition will pause in an In-
Progress state until the process definition is re-enabled. To disable a process
definition, use any of the techniques explained in the Enabling Process Definitions
section, choosing "Disabled" instead of "Enabled".

Working With Sugar Modules

The Process Definitions module uses Sugar's Sidecar user interface. The following
sections detail menus, views, and actions common to Sidecar modules and contain
links to additional information within the page or links to the User Interface
documentation.

Menus

The following sections describe the various menu options in the Process
Definitions module with links to more information about each option in the User
Interface documentation or, for process definition-specific functionality, within this
page.

Module Tab Menus

Click the Process Definitions module tab in the navigation bar to access the
Process Definitions list view. You may also click the three-dots menu in the Process
Definitions tab to display the Actions, Recently Viewed, and Favorites menus. The
Actions menu allows you to perform important actions within the module. The
Recently Viewed menu displays the list of process definitions you last viewed in the
module. The Favorites menu displays the list of process definitions you most
recently marked as favorites in the module.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create Process Definition Opens the record view layout to create a

new process definition.
View Process Definitions Opens the list view layout to search and

display process definitions.
Import Process Definitions Opens the import wizard to enable

import of .bpm files.

To access the Process Definitions module or module tab, you must also be a 
System Administrator user or a regular user with a role that provides developer
access to one or more modules. For more information on module tab menus
including other reasons a module may not be included in the menu, see the User
Interface documentation.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual process definition record directly from the list
view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview the design of this process

definition in the intelligence pane.
Design Navigate directly to the process

definition's Visual Designer, where you
can create and edit the process flow.

Edit Edit this process definition.
Export Download a copy of this process

definition to your computer as a .bpm
file.

Delete Delete this process definition.
Enable/Disable Enable or disable this process definition.

Record View Actions Menu

The process definition's record view displays the fields relevant to the Process
Definitions module. To access a process definition's record view, simply click a
hyperlinked process definition name from the Process Definitions list view. The
record view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this process definition.
Design Navigate directly to the process

definition's Visual Designer, where you
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can create and edit the process flow.
Export Download a copy of this process

definition to your computer as a .bpm
file.

Share Share a link to this process definition in
Sugar via email.

Copy Duplicate this record to make a new
process definition.

Delete Delete this process definition.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules.

Content Link Description
Viewing Process Definitions
  Viewing via List View
  Viewing via Record View
  Viewing via Recently Viewed

The Viewing Records section describes
various methods of viewing process
definition records, including via the
Process Definitions list view and record
view, the Recently Viewed menu in the
Process Definitions module tab. For
information on viewing a process
definition's message content, please
refer to the Designing Process
Definitions section below.

Searching for Process Definitions
  List View Search
  Creating a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Process Definitions module.

Process Definitions List View
  Total Record Count
  Create Button

The List View section walks through the
many elements of the Process
Definitions List View layout which
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  List View Search
  Favorite Designation
  Column Reordering
  Column Resizing
  Column Sorting
  Column Selection
  Preview
  Record Actions Menu
  Pagination
  Intelligence Pane

contains a filterable list of all process
definition records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Process Definitions list view are
described in the List View Record
Actions Menu section of this page.

Process Definitions Record View
  Favorite Designation
  Next or Previous Record
  Actions Menu
  Show More
  Intelligence Pane

The Record View section walks through
the many elements of the Process
Definitions Record View layout which
contains detailed information about a
single process definition record. While
the generic menu options are described
in the User Interface sections linked to
the left, the options specifically
available in the Process Definitions
record view are described in the Record
View Actions Menu section of this page.

Editing Process Definitions
  Editing Inline via Record View
  Editing via Record View
  Editing Inline via List View

The Editing Records section describes
the methods of editing existing process
definition record fields: inline via the
Process Definitions record view, in full
edit mode on the record view, and inline
via the Process Definitions list view.
For information on editing a process
definition record's content, please refer
to the Designing Process Definitions
section below.

Deleting Process Definitions
  Deleting via Record View
  Deleting via List View

The Deleting Records section describes
two ways to delete process definitions:
via the Process Definitions record view
and via an individual record's Actions
menu on the list view.

Favoriting Process Definitions
  Favoriting via List View
  Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking process definitions as favorites,
including via the Process Definitions list
view and Process Definitions record
view. Favoriting a process definition
record allows you to easily access it
from list views and the Process
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Definitions module tab.
Sharing Process Definitions The Sharing Records section provides

instructions for the Share record view
option which composes an email with a
link to the process definition record. If
the recipient is logged into Sugar,
clicking the link will bring them directly
to the record view.

Process Business Rules

Overview

The Process Business Rules module is one of four modules that make up
Sugar's SugarBPM™ (formerly known as Sugar Process Author), Sugar's business
process management tool that enables administrators to streamline common
business processes by managing approvals, sales processes, call triaging, and
more. The Process Business Rules module is used to create reusable rules that will
be referenced by records created in the Process Definitions module. The rule or set
of rules may enforce business policy, make a decision, or infer new data from
existing data.

Before continuing, please read the SugarBPM overview page, which defines
critical vocabulary and other elements that may be referenced in this article.

This documentation contains the following pages:

SugarBPM
Process Definitions
Process Business Rules (current page)
Process Email Templates
Stock SugarBPM Templates

Additionally, the Processes page of the Application Guide contains documentation
for the user-facing elements of SugarBPM.

The following image illustrates the relationship between all of the SugarBPM
modules:
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This documentation will cover information and actions specific to the Process
Business Rules module. For instructions concerning views and actions which are
common across most Sugar modules, such as creating, editing, and deleting
records, please refer to the Working With Sugar Modules section of this page.

Process Business Rule Fields

The Process Business Rules module contains the following fields.  For information
on using and editing various field types, refer to the User Interface documentation.

Field Description
Assigned To The Sugar user assigned to the process

business rule.
Business Rule Type Specifies how a rule set will be

evaluated. This field defaults to "Single
Hit", meaning that each row will be
evaluated independently from top to
bottom. When a rule in the rule set
evaluates as true, the evaluation process
stops and that rule's conclusions are
executed.

Date Created The date the process definition record
was created.
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Date Modified The date the process definition record
or its design was last modified.

Description A description or other information about
the process definition.

Integration Sync ID The sync key field used by external
integrations to identify Sugar records in
the external application. See the 
Integrate REST API endpoints in the
Developer Guide for more details on
how to use this field.
Note: This field is not visible in the user
interface.

Name A unique and descriptive name.
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports.
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Target Module The module that will be used for the
Start event in the process definition
design.

Creating Process Business Rules

You should typically create business rules before creating any process definitions
that will use the rules. However, it is possible to save an incomplete process
definition in order to navigate away and build a rule, then return later to complete
the process definition.

Process business rules can be created from any of the following places in Sugar:

Process Business Rules dashlet:

Process Business Rules module tab menu:

                         651 / 829

https://support.sugarcrm.com/smartlinks/developer_guide/integration/web_services/rest_api/endpoints/
https://support.sugarcrm.com/documentation/sugar_versions/8.3/pro/application_guide/tags/


 

Process Business Rules list view:

Upon clicking "Create Process Business Rule" (or the Create button from list view),
you will be directed to the record view. The record view is where you store
information that will make it easy to find and understand the rule in the future.
After completing this form, click "Save & Design" to navigate to the Rules Builder
interface where the actual rule criteria and outcomes are defined.

 

For more information about the available fields in the Process Business Rules
module, please refer to the Process Business Rule Fields section of this
documentation. After configuring and saving the process business rule, it will
automatically appear on the administrator's Process Business Rules dashlet and
list view, but it will not be ready to use in a process definition until the design
step has been completed via the Rules Builder.

Designing Process Business Rules

After saving the process business rule record, use the Rules Builder table to define
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the conditions and conclusions for the rule(s).

Note: The Rules Builder interface may not be compatible with some touch-screen
mobile devices. Please interact with the Rules Builder from a desktop or laptop
computer to prevent any potential complications.

The Rules Builder Interface

 

Note: The UI elements of the Rules Builder are only displayed if they are relevant
to the current view. For example, new rules and rules with only one row will not
contain the selection boxes and Trash icon until additional rows have been added.

Click the plus (+) icon to the right of the Conditions header to add
additional condition columns.
Click the minus (-) icon above a condition column to delete the column.
Click the plus (+) icon to the right of the Conclusions header to add
additional conclusion columns.
Click the minus (-) icon above a conclusion column to delete the column.
Click the plus (+) icon at the bottom of the table to add additional rows and
create a rule set.
Select the checkbox next to one or more rows and then click the Trash icon
to delete the selected row(s).
Select the checkbox next to one or more rows and then click on one of the
selected rows' numbers to drag and drop them to a new position.

The following steps describe how to interact with the Rules Builder.

1. For each column in the Conditions section, select a field variable (e.g., Lead
Source) from the dropdown inside the white header cell.
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2. Beneath the header, click inside the first row and select the operator
needed to evaluate the variable selected in step 1. To change the operator,
click on the cell to view and select the available operators in the list.

3. Next to the operator, select the field value for the condition. Click on the
empty area of the cell to select a field value or access the criteria builder
where you can define constants, fields, etc. For more information on using
the criteria builder, please refer to the Process Definitions documentation.

4. Optionally, add more Condition columns to satisfy your use case. All
conditions defined within the same row must be met in order to trigger the
associated conclusion. In addition, when any one row has satisfied all of its
conditions, its conclusion will be triggered and no subsequent rows will be
evaluated. 

5. For the Conclusions block, click in the empty row beneath the Return Value
header.

6. In the criteria builder, define the return value for when the row's condition
evaluates as true. A process definition's Gateway will evaluate the returned
values and react accordingly. A Return Value is required for each row.
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7. Optionally, add more Conclusion columns to update a field value (e.g.,
"Assigned to") when the row's condition evaluates as true.

8. Continue adding conditional rows as needed until your rule set is complete.
For more information, please refer to the Creating Rule Sets section.

Creating Rule Sets

A single process business rule record could potentially define a set of several rules,
or a rule set. In the following example of a set of rules for routing leads, each row
of the Rules Builder table represents a separate rule that will be evaluated by the
process. Each row is evaluated independently in descending order. When a rule in
the rule set is evaluated as true, the evaluation process stops. Therefore, only the
conclusions defined by the first (topmost) true condition will be returned.

The following example represents a rule set that evaluates two fields, "Lead
Source" and "Status", to determine a return value, assigned user, and a possible
value for "Do Not Call". The first row translates conversationally to: If the lead has
a new status and its source is a Cold Call, then capture the office phone number,
assign the lead to Jim Brennan, and make no changes to the Do Not Call field.

Condition and Conclusion Elements

Process business rules comprise at least one condition:conclusion element.

Conditions: One or more "if" statements that will be evaluated as true or
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false.
Conclusions: The results that are returned if the condition evaluates to
true.

By default, a true condition must result in a Return value. The Return value can be
constructed using variables, constants, operators and/or literal values. If there are
to be multiple outcomes to the condition, the Return value must be specified as the
first conclusion in the business rule. For example, to change the value of a given
field when the condition is true, set an arbitrary return value and then click on the
+ button adjacent to the table header "Conclusions" to add another conclusion
column to the row where the field update can be defined.

The condition will evaluate a set of given variables and if the condition is evaluated
as "true", the conclusion will then return a specified value.

Note: Process business rule Return values will always convert to text for
evaluation within a process definition.

Operator Elements

Conditions utilize comparison operators. Multiple conditions in a single row will be
combined using AND logic, requiring all conditions in a row to be satisfied in order
for the statement to be evaluated as true. The available operators are:

Operator Definition Available for Field
Types

== is equal to integer, currency, date,
dropdown, multiselect

!= is not equal to integer, currency, date,
dropdown, multiselect

>= is greater than or equal to integer, currency, date
<= is less than or equal to integer, currency, date
> is greater than integer, currency, date
< is less than integer, currency, date
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is exactly matches text, email
is not does not exactly match text, email
starts with first characters of

the field match 
text, email 

ends with last characters of the field
match

text, email 

contains the characters are found
in sequence anywhere in
the field

text, email 

does not contain the characters are not
found in sequence
anywhere in the field

text, email 

Note: If using a currency field in a business rule, values should have no currency
symbol (such as $) and no thousands separator. Only the period (.) is allowed as a
decimal separator.

For information about utilizing process business rules in process definitions, refer
to the Actions > Business Rule section of the Process Definitions documentation. 

Working With Sugar Modules

The Process Business Rules module use Sugar's Sidecar user interface. The
following sections detail menus, views, and actions common to Sidecar modules
and contain links to additional information within the page or links to the User
Interface documentation.

Menus

The following sections describe the various menu options in the Process Business
Rules module with links to more information about each option in the User
Interface documentation or, for template-specific functionality, within this page.

Module Tab Menu

Click the Process Business Rules module tab in the navigation bar to access the
Process Business Rules list view. You may also click the three-dots menu in the
Process Business Rules tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform important actions within the
module. The Recently Viewed menu displays the list of business rules you last
viewed in the module. The Favorites menu displays the list of business rules you
most recently marked as favorites in the module.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create Process Business Rule Opens the record view layout to create a

new process rule.
View Process Business Rules Opens the list view layout to search and

display process rules.
Import Process Business Rules Opens the import wizard to enable

import of .pbr files.

To access the Process Business Rules module or module tab, you must also be a 
System Administrator user or a regular user with a role that provides developer
access to one or more modules. For more information on module tab menus
including other reasons a module may not be included in the menu, see the User
Interface documentation.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual process rule record directly from the list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview Preview this rule in the intelligence

pane.
Design Navigate directly to the Rules Builder

view, where you can create and/or edit
the condition(s) and conclusion(s)
defined by this process business rule.

Edit Edit this process business rule record.
Export Download a copy of this rule to your

computer as a .pbr file.
Delete Delete this process business rule.

Record View Actions Menu

The business rule's record view displays the fields relevant to the Process Business
Rules module. To access a rule's record view, simply click a hyperlinked business
rule name from the Process Business Rules list view. The record view's Actions
menu appears on the top right of the page and allows you to perform various
operations on the current record.
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The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this process business rule record.
Design Navigate directly to the Rules Builder

view, where you can create and/or edit
the condition(s) and conclusion(s)
defined by this process business rule.

Export Download a copy of this business rule to
your computer as a .pbr file.

Share Share a link to this business rule in
Sugar via email.

Copy Duplicate this record to make a new
process business rule.

Delete Delete this process business rule.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
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modules.

Content Link Description
Viewing Process Business Rules
  Viewing via List View
  Viewing via Record View
  Viewing via Recently Viewed

The Viewing Records section describes
various methods of viewing business
rule records, including via the Process
Business Rules list view and record
view, the Recently Viewed menu in the
Process Business Rules module tab. For
information on viewing the rule(s)
defined within the Rules Builder, please
refer to the Designing Process Business
Rules section of this page.

Searching for Process Business Rules
  List View Search
  Creating a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Process Business Rules
module.

Process Business Rules List View
   Total Record Count
   Create Button
  List View Search
  Favorite Designation
  Column Reordering
  Column Resizing
  Column Sorting
  Column Selection
  Preview
  Record Actions Menu
  Pagination
  Intelligence Pane

The List View section walks through the
many elements of the Process Business
Rules List View layout which contains a
filterable list of all process business rule
records in Sugar. While the generic
menu options are described in the User
Interface sections linked to the left, the
options specifically available in the
Process Business Rules list view are
described in the List View Record
Actions Menu section of this page.

Process Business Rules Record View
  Favorite Designation
  Next or Previous Record
   Actions Menu
  Show More
  Intelligence Pane

The Record View section walks through
the many elements of the Process
Business Rules Record View layout
which contains detailed information
about a single business rule record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Process Business Rules
record view are described in the Record
View Actions Menu section of this
page.  

Editing Process Business Rules The Editing Records section describes
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  Editing Inline via Record View
  Editing via Record View
  Editing Inline via List View

the methods of editing existing business
rule record fields: inline via the Process
Business Rules record view, in full edit
mode on the record view, and inline via
the Process Business Rules list view.
For information on editing the rules
defined in the Rules Builder, please
refer to the Designing Process Business
Rules section of this page.

Deleting Process Business Rules
  Deleting via Record View
  Deleting via List View

The Deleting Records section describes
two ways to delete business rules: via
the Process Business Rules record view
and via an individual record's Actions
menu on the list view.

Favoriting Process Business Rules
  Favoriting via List View
  Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking business rules as favorites,
including via the Process Business Rules
list view and Process Business Rules
record view. Favoriting a business rule
record allows you to easily access it
from list views and the Process Business
Rules module tab.

Sharing Process Business Rules The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the process email template
record. If the recipient is logged into
Sugar, clicking the link will bring them
directly to the record view.

Process Email Templates

Overview

The Process Email Templates module is one of four modules that make
up SugarBPM™, Sugar's business process management tool that enables
administrators to streamline common business processes by managing approvals,
sales processes, call triaging, and more. A process email template is required in
order to include a Send Message event in a process definition. Sugar's core
product includes several places where email templates can be created for different
purposes, but SugarBPM requires all sent messages to be created via the Process
Email Templates module.
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Before continuing, please read the SugarBPM overview page, which defines
critical vocabulary and other elements that may be referenced in this article.

The SugarBPM documentation contains the following pages:

SugarBPM (overview)
Process Definitions
Process Business Rules
Process Email Templates (current page)
Stock SugarBPM Templates

Additionally, the Processes page of the Application Guide contains documentation
for the user-facing elements of SugarBPM.

The following image illustrates the relationship between the four SugarBPM
modules:

This documentation will cover information and actions specific to the Process
Email Templates module. For instructions concerning views and actions which are
common across most Sugar modules, such as creating, editing, and deleting
records, please refer to the Working With Sugar Modules section of this page.

Process Email Template Fields

The Process Email Templates module contains the following fields. For information
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on using and editing various field types, refer to the User Interface
documentation. 

Field Description
Assigned To The Sugar user assigned to the process

email template.
Date Created The date the process email template

record was created.
Date Modified The date the process email template

record or its content was last modified.
Description A description or other information about

the process email template.
Integration Sync ID The sync key field used by external

integrations to identify Sugar records in
the external application. See the 
Integrate REST API endpoints in the
Developer Guide for more details on
how to use this field.
Note: This field is not visible in the user
interface.

Name A unique and descriptive name.
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports.
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Target Module The module against which the
template's processes will be defined.

Creating Process Email Templates

You should typically create email templates before creating any process definitions
that will use the templates. However, it is possible to save an incomplete process
definition in order to navigate away and build an email template, then return later
to complete the process definition.

Process email templates can be created from any of the following places in Sugar:

Process Email Templates dashlet:
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Process Email Templates module tab menu:

Process Email Templates list view:

Upon clicking "Create Process Email Template" (or the Create button from list
view), you will be directed to the record view. The record view is where
Sugar stores information that will make it easy to find and understand the purpose
of the email template in the future. After completing this form, you will be directed
to the design view to create the actual content of the message.

After configuring and saving the process email template, it will automatically
appear on the administrator's Process Email Templates dashlet and list view, but it
will not be ready to use in a process definition until the design step has been
completed via the design view. 

Designing Process Email Templates
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After submitting the template's record view, you must create the custom layout
and design of the message that will be sent by related process definitions. Click
"Save & Design" in record view to automatically enter the Process Email
Template's design view. The field values for Target Module, Name, and Description
are automatically pre-populated on this screen based on the values entered on the
record view.

SugarBPM's email template design interface is an easy-to-use WYSIWYG editor.
The two elements available in the design view that cannot be accessed from record
view are the design toolbar and the message body. The following sections cover
how to use these elements to craft an email message template.

At any time during the design of a template, you may click the Save button to
preserve your work. After completing the content of the message, expand the
record's Actions Menu to reveal "Save & Exit". Click on this menu item to return to
the Process Email Templates list view and continue working in Sugar.

The Design Toolbar
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The toolbar is powered by the TinyMCE rich-text editor framework and presents
familiar formatting options:

Element Button(s) Function
Edit HTML Source Bypass the rich-text editor

options and insert your
own HTML code, or view
the HTML code of an
existing template to make
advanced changes.

Bold; Italic; Underline;
Strikethrough

Use these basic font
formatting options to
easily add common styles
to text in the message
body.

Insert/Remove Bulleted
List; Insert/Remove
Numbered List

Transform paragraphs in
the message body into a
formatted list.

Align Left; Align Center;
Align Right; Justified

Set paragraph alignment.

Text Color; Background
Color

Choose a custom font
color or highlight text with
a background font color.

Font Size Make text larger or
smaller.

Fields Selector Look up and insert Sugar
module field variables. For
more information, see the 
Fields Selector section
below.

Record Link Selector Look up and insert a
hyperlink to a Sugar
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record related to the
process's target
record. For more
information, see
the Record Link Selector
 section below.

Insert/Edit Link Insert or edit a link to a
web page, hosted file, or
other location on the web. 

Using the Fields Selector Tool

Process email templates can be customized using data pulled directly from your
Sugar database. For example, an email template triggered by the Cases module
could contain critical case details such as the support agent's name or the phone
number of the contact related to the case. Related-module fields can be referenced
from modules that have a one-to-one or one-to-many relationship with the target
module. If a field has been updated, both its old and current values can be
included. 

Note: Before using old values in your message's template, be sure to refer to
the Understanding Current and Old Values section for important usage information
regarding your process definition's design.

Common use cases for the Fields Selector tool include using the recipient's name
and mentioning the old and new values of a changed field such as "Status" in the
message body. To insert custom values using the Fields Selector tool, follow these
steps:

1. From the process email template's design view, place the cursor in the
message body where the custom name variable should appear. Click on the
Fields Selector icon in the design toolbar.

2. The Fields Selector drawer will open over the current screen. By default, it
displays all fields in the template's target module. To find a variable from a
related module, click the word "Module" to the left of the search bar and
select the desired module.
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3. The list of field variables will update automatically. Open the dropdown
adjacent to the field or fields that you would like to insert and choose
"Current Value". In this example, we are choosing to add the current value
of the recipient's first and last name. Click "Done" to insert the field
variables into the email template.

4. The template's design view will once again be visible and the selected
variables will appear where your cursor was positioned before clicking the
Fields Selector icon. The variables are wrapped in curly braces and must
retain their special formatting to be detected in the sent message.

If necessary, use the text editor to move the variables or insert additional
characters. In this example, we will move the first name variable
{::assigned_user_link::first_name::} into position before the last name
variable and insert a space character in between the two:
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5. Next, place the cursor where you would like to insert the old and new
values of the case's Status field then open the Fields Selector drawer again.

6. In the drawer, open the dropdown adjacent to the Status field and select
"Current and Old Values" then click "Done". Both variables will be inserted
into the message.
Note: Before using current and old values in your message's template, be
sure to refer to the Understanding Current and Old Values section for
important usage information regarding your process definition's design.

7. If necessary, reorganize the text to place the current and old variables
where desired. In this example, we will put the old value before the current
one and complete the sentence:

8. Continue editing the template as needed and save.

The final product may look similar to this:
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For information about using process email templates in process definitions, refer
to the Send Message Events section of the Process Definitions documentation.

Understanding Current and Old Values

When utilizing the Fields Selector tool to insert the current or old value of a field,
it is important to strategically position the Send Message event within your
process definition's design. Keep in mind the following guidelines:

If the value of a field did not change during the action that triggers the
Send Message event, both the Old Value and Current Value variables will
display the current value. Therefore, only use the Old Value variable when
a specific field is expected to change during the triggering event.
If the value of a field changes more than once in a process, then its old and
current values will be determined by the event that most closely precedes
the Send Message event. 
If your process definition contains a Wait event, be sure that the Wait event
does not occur between the action that changes the field and the Send
Message event. This would prevent the old value from being communicated
to the Send Message event.
Old values of related-module fields are only preserved if they are changed
within the same save, such as a Change Field event in the process or a
logic hook that is triggered during the process.

For information about using process email templates in process definitions, refer
to the Send Message Events section of the Process Definitions documentation.

Using the Record Link Selector Tool

If desired, you may insert a URL in the message content that links to the target
record or a record from a related module. For example, an email template
triggered from the Cases module could contain a link to the related case record in
Sugar. If you wish to send an email to a user when a process is assigned to them
via an Activity element in the process definition, you can also insert a link to the
process awaiting the user's action.

Note: Related-module links will only be available for modules that have a one-to-
many relationship with the target module. 

To insert a link using the Record Link Selector tool, follow these steps:

1. From the Process Email Template's design view, place the cursor in the
message body where you want to insert a record link. Click on the Record
Link Selector icon in the design toolbar.
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2. The Record Link Selector drawer will open over the current screen,
displaying the name of the target module on the first line followed by the
names of modules that have a one-to-many relationship with the target
module. Click on the radio button next to the module that contains the
record you want to link to and then click "Select".

3. The template's design view will once again be visible and a variable
representing the selected URL will appear where your cursor was
positioned before clicking on the Record Link Selector icon.

Note: In the recipient's inbox, the message will contain an unformatted
URL (e.g., https://instancename.com/#Cases/1234-abcd-5678-efgh) that
links to the related record. To instead display a word or phrase hyperlinked
to the record, you can click on the Edit HTML Source button in the design
toolbar and place the link variable in an HTML anchor tag:

4. After completing the content of the message, click "Save & Exit".
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For information about using process email templates in process definitions, refer
to the Send Message Events section of the Process Definitions documentation.

Linking to Processes

If you wish to send an email to a user when a process is assigned to them via an 
Activity element in the process definition, you can insert a link directly to the
process record awaiting their action. To do this, simply choose the Processes
module in the Record Link Selector. When clicked in the email, this link will open
the record view of the active process, allowing the assigned user to execute (e.g.,
approve or route) the process. See the Processes page in the Application Guide for
more information on how users can work with processes.

Email templates containing process links should only be used in Activity elements,
not Send Message events. Outside the context of an activity, there is no viewable
active process awaiting action by a user, and therefore such links are invalid. If
you use an email template containing a process link in a Send Message event, the
link will simply appear blank in the email.

It is also possible for a process link in an email to become out of date if the user
clicks the link after they have already executed the process. Once executed, the
process is no longer available to be viewed and the user will see a warning in
Sugar that the process is now closed.

Working With Sugar Modules

The Process Definitions module uses Sugar's Sidecar user interface. The following
sections detail menus, views, and actions common to Sidecar modules and contain
links to additional information within the page or links to the User Interface
documentation.

Menus

The following sections describe the various menu options in the Process Email
Templates module with links to more information about each option in the User
Interface documentation or, for template-specific functionality, within this page.

Module Tab Menus
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Click the Process Email Templates module tab in the navigation bar to access the
Process Email Templates list view. You may also click the three-dots menu in the
Process Email Templates tab to display the Actions, Recently Viewed, and
Favorites menus. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the list of templates you last
viewed in the module. The Favorites menu displays the list of templates you most
recently marked as favorites in the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Process Email Template Opens the record view layout to create a

new email template.
View Process Email Templates Opens the list view layout to search and

display email templates.
Import Process Email Templates Opens the import wizard to enable

import of .pet files.

To access the Process Email Templates module or module tab, you must also be a 
System Administrator user or a regular user with a role that provides developer
access to one or more modules. For more information on module tab menus
including other reasons a module may not be included in the menu, see the User
Interface documentation.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual process email template record directly from the
list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview Preview this email template in the

intelligence pane.
Design Navigate directly to the template's

design view, where you can create and
edit the message's content.

Edit Edit this process email template.
Export Download a copy of this template to

your computer as a .pet file.
Delete Delete this process email template.

Record View Actions Menu

The template's record view displays the fields relevant to the Process Email
Templates module. To access a template's record view, simply click a hyperlinked
template name from the Process Email Templates list view. The record view's
Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this process email template.
Design Navigate directly to the template's

design view, where you can create and
edit the message's content.

Export Download a copy of this template to
your computer as a .pet file.

Share Share a link to this template in Sugar
via email.

Copy Duplicate this record to make a new
process email template.

Delete Delete this process email template.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules.
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Content Link Description
Viewing Process Email Templates
  Viewing via List View
  Viewing via Record View
  Viewing via Recently Viewed

The Viewing Records section describes
various methods of viewing process
email template records, including via
the Process Email Templates list view
and record view and the Recently
Viewed menu in the Process Email
Templates module tab.

For information on viewing the content
of a template's message, please refer to
the Designing Process Email Templates
section below.

Searching for Process Email Templates
  List View Search
  Creating a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Process Email Templates
module.

Process Email Templates List View
   Total Record Count
   Create Button
  List View Search
  Favorite Designation
  Column Reordering
  Column Resizing
  Column Sorting
  Column Selection
  Preview
  Record Actions Menu
  Pagination
  Intelligence Pane

The List View section walks through the
many elements of the Process Email
Templates List View layout which
contains a filterable list of all process
email template records in Sugar. While
the generic menu options are described
in the User Interface sections linked to
the left, the options specifically
available in the Process Email
Templates list view are described in the 
List View Record Actions Menu section
of this page.

Process Email Templates Record View
  Favorite Designation
  Next or Previous Record
   Actions Menu
  Show More
  Intelligence Pane

The Record View section walks through
the many elements of the Process Email
Templates Record View layout, which
contains detailed information about a
single process email template record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Process Email
Templates record view are described in
the Record View Actions Menu section
of this page.  

Editing Process Email Templates The Editing Records section describes
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  Editing Inline via Record View
  Editing via Record View
  Editing Inline via List View

the methods of editing existing process
email template record fields: inline via
the Process Email Templates record
view, in full edit mode on the record
view, and inline via the Process Email
Templates list view.

For information on editing the content
of a template's message, please refer to
the Designing Process Email Templates
section below.

Deleting Process Email Templates
  Deleting via Record View
  Deleting via List View

The Deleting Records section describes
two ways to delete process email
templates: via the Process Email
Templates record view and via an
individual record's Actions menu on the
list view.

Favoriting Process Email Templates
  Favoriting via List View
  Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking process email templates as
favorites, including via the Process
Email Templates list view and Process
Email Templates record view. Favoriting
a process email template record allows
you to easily access it from list views
and the Process Email Templates
module tab.

Sharing Process Email Templates The Sharing Records section provides
instructions for the Share option in
record view, which composes an email
with a link to the process email template
record. If the recipient is logged into
Sugar, clicking the link will bring them
directly to the record view.

Stock SugarBPM Templates

Overview

SugarBPM™ has a number of pre-built, stock process definitions, process business
rules, and process email templates that are available depending on your license
type. These templates work together to automate common business processes
(e.g., Service Level Agreement management on cases). This page lists and
describes each of the stock process definitions, including their associated business
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rules and email templates, that come out-of-the-box for users with the required
license type. For more information on license types, refer to the User Management
 documentation.

Before continuing, please read the SugarBPM overview page, which defines
critical vocabulary and other elements that may be referenced in this page.

The SugarBPM documentation contains the following pages:

SugarBPM (overview)
Process Definitions
Process Business Rules
Process Email Templates
Stock SugarBPM Templates (current page)

Additionally, the Processes page of the Application Guide contains documentation
for the user-facing elements of SugarBPM.

Prerequisites

The following conditions are required to access and configure the stock process
definition templates described below:

You must be an administrator or have developer-level role access to the
template's target module.
You must have a Sugar Serve license type to access the SugarBPM Serve
templates.

For more information on license types, refer to the User Management
documentation.

Viewing Stock SugarBPM Templates

All of the available stock SugarBPM templates can be accessed via their respective
modules: Process Definitions, Process Business Rules, and Process Email
Templates. They can be identified by a tag that indicates they are a stock record:

SugarBPM Module Tag
Process Definitions

Process Business Rules

Process Email Templates
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Each stock record also has a category tag such as "Customer Service" or
"Sales". Users can filter each list view by tag as explained in the User Interface 
documentation.

To see which tags a record has, you can view the Tags field on the record or
preview it in list view using the eye icon. Refer to the Tags documentation for more
details on how tags work and the User Interface documentation for more
information on previewing records.

Stock Process Definitions

The sections below list all stock process definitions in Sugar and the stock business
rules and email templates that they use.

Serve Templates

The SugarBPM templates in this section help to automate customer service
processes around cases and notes. To access these templates, users must have a
Sugar Serve license type. See the License Types documentation for more
information on how licenses work.

Case Follow-Up Date Management V2

Overview

Target Module Associated Process
Business Rules

Associated Process
Email Templates

Cases New Case SLA V2 Follow-Up Warning
V2
Case Assigned V2
Notify Manager:
SLA Missed V2

Description

This SugarBPM template is a revision of the original version that was included in a
previous version of Sugar Serve. The V2 version is available in Sugar Serve 11.0
and higher and includes new functionality. For details on the new functionality and
how to configure it, refer to the Stock SugarBPM - Case Follow-Up Date
Management article.

This process definition updates the case's Follow-Up Date and sends email
notifications during the lifecycle of new and updated cases. It can be broken down
into three general stages: new case assignment and initial response, existing case
waiting on the customer service representative, and existing case waiting on the
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customer.

New Case Assignment and Initial Response:
When a new case is created, the process calculates and sets the follow-up date,
assigns the case to a customer service representative, notifies them, and waits to
ensure that the follow-up date is met by a status change before advancing to the
next stage. If it is not met, the process sets the SLA Met field to "No", sends an
email notification to the representative's supervisor, and continues to wait for a
status change before advancing.

Existing Case Waiting on the Customer Service Representative:
The process waits for a status change on the case and then updates the follow-up
date using the business center's business hours and sets the First Response Sent
field to "Yes". If the status changes to any open status other than "Pending Input",
the process adds 8 business hours to the follow-up date. It then waits for another
status change while the customer service representative works on the case.

Existing Case Waiting on the Customer:
If the status changes to "Pending Input", the process adds 16 business hours to the
follow-up date then waits for the customer to respond. If they do not respond by
the follow-up date, an additional 16 business hours are added and the process
sends an email to the customer notifying them that the case is awaiting their
response. If the customer sends an email related to the case, the case status is
changed to "Assigned". However, if they do not respond by the new follow-up date,
then the case is automatically closed.

Configuration Notes

Refer to the Getting Started With SugarBPM for Sugar Serve and Stock SugarBPM
- Case Follow-Up Date Management articles for help configuring this process
definition and your instance to work together.

Case Status Update on Inbound Customer Note

Overview

Target Module Associated Process
Business Rules

Associated Process
Email Templates

Notes none none

Description

This process definition changes a case's status from Pending Input to Assigned
when a customer adds a note to the case.

Configuration Notes
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If you have customized the available values for the Status field in your Cases
module, you must update the following elements in the process definition to use
the statuses available in your instance:

Start Event
Change Field Action

Customer Notification of Case Status Change

Overview

Target Module Associated Process
Business Rules

Associated Process
Email Templates

Cases none Customer
Notification of
Case Status
Change

Description

When a case's status changes except when changed by an Inbound Email, all
contacts related to the case are notified via email.

New Portal User

Overview

Target Module Associated Process
Business Rules

Associated Process
Email Templates

Contacts none New Portal
Registration
Portal Registration
Acknowledgement

Description

When a new contact is created in Sugar from a new portal registration, this
process definition sends two emails. The first is sent to the assigned user of the
new contact, informing them of the new portal user needing activation. The second
is sent to the new portal user, acknowledging that their registration was submitted
successfully.

New Note Notification

Overview

Target Module Associated Process
Business Rules

Associated Process
Email Templates
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Notes none Client Notification
of New Note
Agent Notification
of New Note

Description

When a new note related to a case is created, this process definition sends an
email notification to the relevant party. If the client creates the note, the email is
sent to the case owner. Otherwise, if the customer service representative creates
the note, the email is sent to the primary contact on the case. If there is no primary
contact, then the note description is updated to specify why no email notification
was sent.

Restoring Stock SugarBPM Templates

To undo all changes to a stock Sugar BPM record and restore it to its original
state, file a case with the Sugar Support team.

Tile View Settings

Overview

Tile view allows users to visualize and engage with their cases and tasks in an
intuitive drag-and-drop interface. Users can drag tiles from one column to another
to move a record from one status to another. Administrators can configure tile
view to fit their specific business needs by enabling and disabling modules,
changing the visible columns, and selecting the fields displayed in each tile via
Admin > Tile View Settings. This page describes how to configure the tile views in
Sugar.

For information on using tile view in Sugar, refer to the User Interface
documentation in the Application Guide.

Note: Tile view functionality is supported for cases, opportunities, tasks, and
leads, but not all user license types can access all of these modules. For more
information on license types and the module functionality available for each type,
refer to the License Types Matrix documentation. 
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Tile View Modules

Upon navigating to Admin > Tile View Settings, the tile view administration page's
topmost section is labeled "Tile View Modules". In this panel, you can enable and
disable tile view access for the available modules.

Tile View Modules Fields

The Tile View Modules section for tile view administration contains the following
field:

Field Description
Enabled Modules Multiselect field used to enable and

disable tile view access for supported
modules.

Enabling and Disabling Tile View

Use the Enabled Modules field to enable and disable access to tile view for users.
By default, tile view is enabled for Cases and Tasks. 

To disable tile view for a module, click the X next to its name (e.g., Tasks) to
remove it from the Enabled Modules field and then click "Save". To enable a
module, click inside the Enabled Modules field and select it from the list of
supported modules. 

Please note that the order of the module names will also control the order that the
modules appear in the Module Settings tab below. Simply drag and drop the
modules into your preferred order and then click "Save". The next time you visit
Tile View Settings, the tabs under Module Settings will appear in the order that
the modules were saved.
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Note: Tile view functionality is supported for cases, opportunities, tasks, and
leads, but not all user license types can access all of these modules. For more
information on license types and the module functionality available for each type,
refer to the License Types Matrix documentation. 

Module Settings

The tile view administration page's lower section is labeled "Module Settings". In
this panel, you can select the field whose values will be used as columns as well as
configure the available field values, tile fields, and tiles displayed per column for
each module's tile view.

Module Settings Fields

The Module Settings section for tile view administration contains the following
fields:

Field Description
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Module (tabs) Use the Module tabs to navigate from
one module's Tile View settings to
another. Only the modules enabled in
the Tile View Modules section will be
shown.

Select the field whose values will be
used as columns

The field by which you want to group
your tile view. The field's values will be
used as columns across the top of the
tile view. You may select any dropdown
field.

Drag and drop to set available columns
and their order

The field values for the field (e.g.,
Status) selected in the first dropdown
option will display in the Available
Values column. Use drag and drop to
move the field values between hidden
and available to determine whether the
value will be used as a column in tile
view:

Available Values: These field
values will be used as column
headers in the tile view.
Hidden Values: Records with
these field values will not be
shown in the tile view and the
values will not appear in the
header.

Tile Header Field Select the field (e.g., Subject) whose
value will be shown as the tile's
clickable header. 

Tile Body Fields Select the fields whose values will be
shown in the tile's body beneath the tile
header field (e.g., Subject). Drag and
drop the fields into the order that you
want them to be listed.

Tiles displayed per column Select the number of tiles that each
column in the tile view should load by
default. Users will be able to manually
scroll beyond this number of records to
load additional tiles.

Configuring Tile View Column Headers

In the Module Settings section, you can select the field (e.g., Status, Priority)
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whose values (e.g., Not Started, In Progress) will be used as columns in the tile
view as shown in the image below. 
Note: It is important to note that only dropdown fields are available to select for
the tile view column headers.

Use the following steps to configure the tile view column headers:

1. Navigate to Admin > Tile View Settings > Module Settings.
2. Click on the tab for the module's tile view that you would like to configure.

3. In the dropdown field below the module tabs, select the field (e.g., Status)
whose values will be used as columns in the tile view. 

4. The Available Values list below will automatically update with the field
values for the field you selected in the previous step. To hide a value from
the tile view, simply drag and drop the value from the Available Values
column to the Hidden Values column. Hidden values will not appear as
columns in the tile view and any records that contain a hidden value will be
omitted from the tile view. All values in the Available Values column will
appear as column headers in the tile view. 
Note: If you add a new value to the selected dropdown field (e.g., Status)
via Admin > Studio, the value will automatically appear in the Available
Values column. You will need to click "Save" on the Tile View Settings page
in order to have the new dropdown value appear as a column header in tile
view. If you do not wish to add the new dropdown value as a column
header, simply drag and drop the value to the Hidden Values column.
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5. To change the left-to-right order of the tile view column headers, drag and
drop the values (e.g., Not Started, In Progress) up or down within the
Available Values list per your viewing preference.

6. Click "Save" to preserve your changes or proceed to the next section for
steps to configure the appearance of individual tiles.

After saving the changes, there will be one column header for each value in the
Available Values list. If there are no records that contain one of the Available
Values, then that value's column will contain no records in the tile view until a
record has been saved with that value. 

Configuring Tiles

The following steps explain how to configure the individual tiles to show your
preferred fields. Both stock and custom fields in the module (e.g., Tasks) will be
available to add to the Tile Header Field and Tile Body Fields to display in the tile
view. Please note that as you change the tile-options fields, the Tile Preview in the
Intelligence Pane will automatically update to reflect your current selections.

Use the following steps to configure the individual tile header and body: 

1. Navigate to Admin > Tile View Settings > Module Settings and click on the
tab for the module's tile view that you would like to configure. If you are
continuing steps from the previous section, then simply proceed to the next
step.

2. Locate the Tile Header Field and select the field that you want to use as the
topmost line of the tiles. This is typically the Subject or Name field but can
be configured as you please.

3. Next, select the fields that you want to appear under the tile header field in
the Tile Body Fields. You can drag and drop them into the order you want
them to appear and see the Tile Preview update in real-time. 
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4. Click "Save" to preserve your changes.

Sugar Hint Administration

Overview

Sugar Hint is a relationship intelligence service that is available to be purchased
and enabled on your Sugar instance to make external information available for
your contacts, leads, and accounts in Sugar. Data such as social media accounts,
work information, and company details are visible for contacts and leads based on
their email address and for accounts based on their websites and company names.
Users can also quickly import the enriched data into the Sugar database with a
single click. 

Sugar Hint is built-in to Sugar and enabled via license key. This guide outlines how
an admin can configure Hint to suit their organization. For information on using
Hint once it has been installed, please refer to the Sugar Hint documentation in
the Application Guide.

Note: If you have Sugar Sell Premier, Hint powers the data enrichment and news
feed capability. Hint is automatically enabled and there is not a separate license
key for Hint. 
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Prerequisites

Sugar Hint is included with Sugar Sell Premier and enables the data enrichment
and news feed capability. Sugar Hint can also be purchased as an add-on for Sugar
Sell Advanced, Enterprise, and Serve. Please contact your Sugar partner or
representative to learn more.

Cron must be enabled because Hint relies on several scheduled jobs to
function.
If your Sugar instance is not SugarIdentity-enabled and you want your
service region to be Europe or Asia/Pacific, you must specify the Hint
services region before you install or upgrade to Sugar 12.0 or higher. The
default service region is the United States.
If your server has firewalls set up that block direct access to the internet,
you must add the following Hint service URLs to your allowlist in order for
Hint to work:

https://hint-data-enrichment.service.sugarcrm.com
https://hint-interest-subscription.service.sugarcrm.com
https://hint-notifications.service.sugarcrm.com

If you purchase Hint as an add-on to Sugar Sell Advanced, Enterprise, or
Serve, an administrator must also:

Input the Hint license key
Assign Hint licenses to users

Getting Started with Hint

Once you have enabled Hint, you can proceed with choosing the service region and
setting the Hint license.

Choosing the Hint Services Region

If your Sugar instance is SugarIdentity-enabled, your Hint region is automatically
configured to connect with services hosted in the supported region nearest to that
of your Sugar instance. For Sugar 12.0, the available regions are the United
States, Europe, and Asia/Pacific.

If your Sugar instance is not SugarIdentity-enabled, you must manually configure
which region you are in by using the hint.hint_install_target_geo property to select
a region. You must set the region before installing or upgrading to Sugar 12.0 or
higher. Modify this setting in the config.php or config_override.php file located in
the root folder. See the Core Settings page in the Developer Guide for details on
this property.

Note: Once configured, it is not possible to modify the region Hint connects to.
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Setting the Hint License Type

Admins without the Hint license type can still access Hint configuration in the Hint
section of the Admin page. If you remove the Hint license type from a user, that
user will no longer have access to Hint (e.g., the Hint panel or Hint Insights
dashlet) and will no longer receive notifications for any of their Hint Insights
subscriptions. However, their notification settings are preserved and notifications
resume if you assign the Hint license type to the user again. Note that the Hint
license type cannot be selected alone and must be applied in conjunction with a
CRM license type (e.g., Sell or Serve).

For information on updating user records, refer to the User Management
documentation. For more information on license types, refer to the Understanding
User Types, License Types, and Sugar Licenses article.

Admin Configuration

Optionally, an administrator can configure the fields enriched by Hint or shown in
the Sugar Hint preview panel for leads, contacts, and accounts. Each module's
Sugar Hint panel may be configured independently. Admins can also configure the
Hint logger, turn off Hint notifications, and resync with the Hint Insights service in
the Sugar Hint section added to the Admin page.

The following two sections describe the available Hint fields and how to configure
the Sugar Hint dashboard panels to meet your organization's needs.

Understanding Hint Fields

Hint adds a new panel to the bottom of record view layouts in the Contacts, Leads,
and Accounts modules, which causes the Show More panel to be automatically
expanded. The Sugar Hint panel in record view displays the fields added by Hint
during installation. 

The following custom fields will be added to your modules and their record views.
An administrator can add these fields to other layouts (e.g., Mobile, list view, etc.)
if desired via Admin > Studio. For more information on modifying layouts, please
refer to the Studio documentation.

Display Lab
el

Database
Name

Type Added to
Accounts

Added to
Contacts

Added to
Leads

Annual
Revenue

hint_account
_annual_rev
enue_c

TextField  ✔ ✔

Company hint_account TextField  ✔ ✔
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Description _description
_c

Company Fa
cebook

hint_account
_facebook_h
andle_c

URL ✔ ✔ ✔

Company
Location

hint_account
_location_c

TextField ✔ ✔ ✔

Company
Logo 1

hint_account
_pic_c, hint_
account_log
o_c

Image, URL ✔   

Company
Size

hint_account
_size_c

TextField ✔ ✔ ✔

Company Tw
itter

hint_account
_twitter_han
dle_c

URL  ✔ ✔

Company
Website

hint_account
_website_c

TextArea  ✔  

Education hint_educati
on_c

TextField  ✔ ✔

Education
Additional 2

hint_educati
on_2_c

TextField  ✔ ✔

Facebook
Link

hint_faceboo
k_c

URL  ✔ ✔

FY End hint_account
_fiscal_year_
end_c

TextField ✔ ✔ ✔

Industry hint_account
_industry_c

TextField ✔ ✔ ✔

Industry
Tags

hint_industr
y_tags_c

TextField ✔ ✔ ✔

NAICS Code hint_account
_naics_code_
label_c

TextField ✔ ✔ ✔

Previous
Jobs

hint_job_2_c TextField  ✔ ✔

SIC Code hint_account
_sic_code_la
bel_c

TextField  ✔ ✔

Twitter Link hint_twitter_ URL  ✔ ✔
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c
Year
Founded

hint_account
_founded_ye
ar_c

TextField ✔ ✔ ✔

1 In the database, the Company Logo field is represented by two fields:
hint_account_pic_c, which is the actual image field you see, and
hint_account_logo_c, which contains the URL location of the image.
2 The Education Additional field is not listed in Admin > Hint Fields because it is
always displayed as the second line of the Education field in the Hint panel. Any
configurations applied to the Education field are automatically applied to the
Education Additional field for the module.

Hint also uses some of Sugar's stock fields to store enriched data. The following
stock fields in the Contacts, Leads, and Accounts modules are populated when
downloading Hint's enriched data. If you have modified your layouts to remove
these fields, you may want to add them back to your layouts via Admin > Studio.
For more information on modifying layouts, please refer to the Studio
 documentation.

Display
Label

Database
Name

Type Populated
for
Accounts

Populated
for
Contacts

Populated
for Leads

Account
Name

account_na
me

TextField   ✔

Annual
Revenue

annual_reve
nue

TextField ✔   

Avatar picture Image  ✔ ✔
Description description TextArea ✔   
Mobile phone_mobil

e
Phone  ✔ ✔

Office Phone phone_work Phone  ✔ ✔
Other Phone phone_other Phone  ✔ ✔ 
SIC Code sic_code TextField ✔   
Title title TextField  ✔ ✔
Twitter
Account

twitter TextField ✔   

Website website URL ✔  ✔ 

Users without a Hint license can see imported values in these fields if the fields are
displayed on their record view. Note that by default, the panel that Hint adds to
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record view is only visible to Hint users, but the custom fields it contains can be
added to other places (e.g., a different panel in record view) to allow non-Hint
users to see the data.

Configuring Hint Fields

Administrators can navigate to Admin > Hint Fields to personalize the Sugar Hint
dashboard panel by showing, hiding, and rearranging the displayed fields, as well
as enabling and disabling enrichment for each one. The Sugar Hint Fields drawer
displays all of the fields found in Studio for the module along with the Hint fields
for that module.

On the right-hand side is a list of fields available to be configured. The top section,
Enriched Fields, lists all fields that Hint can enrich, including both those added by
Hint and stock Sugar fields. The bottom section, Additional Sugar Fields, lists all
fields that Hint cannot enrich; you may wish to show these in the Sugar Hint panel
for informational purposes when viewing the Hint preview from list view. Enabling
"Show in Hint" for enriched fields displays them in the Hint dashboard panel and
the Hint section of record view. Enabling "Show in Hint Panel" for additional Sugar
fields simply displays them in the Hint dashboard panel. The search bar at the top
can be used to look for a specific field in either section.

                         694 / 829



 

In the Enriched Fields section, fields marked with an asterisk (*) are fields added
by Hint. They can only be shown in the Hint panel if they are enriched, and so
disabling enrichment for them also disables the Show in Hint checkbox. There are
also some fields with the Show in Hint checkbox hidden; these fields cannot be
removed from the view because Hint is designed to always show them. Likewise,
fields in the Additional Sugar Fields section with the Show in Hint Panel checkbox
disabled can also not be removed.

On the left-hand side is a live-updated view of what the Sugar Hint panel will look
like as you make your changes. Each module is displayed in its own tab and
switching between tabs updates the list of fields on the right as well.

To configure the Hint panel for a module, update the checkboxes for each field on
the right-hand side. Disabling "Enrich Field" prevents Hint from returning any
enriched data for that field. Once you have the desired fields displayed, drag and
drop items directly within the layouts to reorder them. Those displayed with a lock
icon cannot be moved or hidden because Hint is designed to always show these
fields.
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Once you are satisfied with your changes for each module, click "Save" to preserve
all three modules' configurations. To restore the specific tab you are viewing to its
default values, see the Restoring Default Settings section.

Restoring Default Settings

If you would like to revert the Hint fields for a specific module to its default state,
use the link at the bottom of the tab. Clicking this link immediately restores the
current tab to its original state. It is recommended to only restore the default
settings if you have not already manually made changes to the configuration
without saving. That way, if you restore the defaults and decide you do not want to
keep this change, you can simply click "Cancel" to close the drawer and undo the
reversion.
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Configuring the Hint Logger

The Hint logger writes log entries to the Sugar log to help you debug potential
unexpected behavior. The default log level is "Alert" but it can be changed to levels
such as "Critical", "Info", or "Debug" in Admin > Hint Configuration. Navigate to
Admin > Hint Configuration and select the desired level in the dropdown menu in
the Hint logger section and click "Save" to preserve the change. The new log level
will be used immediately.

Turning off Hint Notifications

Occasionally, it is useful to turn off all notifications (i.e., email, desktop pop-up,
and Hint Insights dashlet) for an entire Sugar instance. One particular example is
when you are cloning an instance, such as for troubleshooting purposes. If you
clone an instance where users are subscribed to Hint notifications, they will start
to receive duplicates of all email notifications - one from the original instance and
one from the clone. To avoid this, navigate to Admin > Hint Configuration on the
cloned instance to turn off notifications and save this change before enabling cron.
This way, users will continue to receive notifications from the production instance
and will not receive any duplicates once you enable cron on the clone.

Resyncing With the Hint Insights Service

If you are seeing inconsistent behavior in notifications from the Hint Insights
 service, you may need to resync with the service. This inconsistency may manifest
as changes to preferences and email addresses not taking effect.

To resync, click "Resync with the Hint Insights service" in the Hint section of the
Admin page. A popup will appear asking you to confirm that you wish to proceed
with the sync. It is important to note that performing a resync will cause any
pending email digest stories to be lost and existing news to be cleared from the
Hint Insights dashlet.

Notifications of all types will resume after the sync completes.

DocuSign

Overview

Sugar provides the option to modify DocuSign settings to change how Sugar users
can interact with DocuSign from within Sugar. Sugar admins can select the model
that makes the most sense for their organization via Admin > DocuSign > Settings.
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DocuSign Settings

Recipient selection behavior allows you to modify if users may select recipients in
Sugar. If you set this to "Display list of potential recipients", users are allowed to
choose recipients when creating an envelope. The alternative setting, "Don't show
potential recipients" disables this feature; this is the default setting.

Advanced Configuration Options

Overview

Sugar comes with many different ways to configure your system to best meet your
needs. Many configuration options are available throughout the application;
though, some advanced options are not available through the interface, but can
still be configured.

In the root directory of Sugar, there are two configuration files: config.php and
config_override.php. These files hold many configuration options within your
instance of Sugar. The config_override.php file is available for you to modify
Sugar's configuration. For more information on which options are available to
change, please refer to the Developer Guide.

Note: Instances running on Sugar's cloud service do not have access to modify the
config_override.php file.

Maintenance Mode

On rare occasions, you may need to restrict users from logging in to Sugar. This is
particularly useful when upgrading Sugar or making significant changes to the
application (e.g., changing config values, making code-level changes, or deploying
changes via Studio, Module Builder, or Module Loader). For these situations, we
recommend enabling maintenance mode, which is disabled by default. With
maintenance mode enabled, only administrators will be able to log in, and regular
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users will receive an alert on the login screen letting them know that the system is
temporarily unavailable. All incoming API calls will also encounter an error
message until maintenance mode has been disabled. When possible, it is best
practice to notify affected users in advance of a maintenance period.

To enable maintenance mode for your instance, add the following line to the
config_override.php file:

  $sugar_config['maintenanceMode'] = true;

System Configuration

Changing values in the config files can change functionality and behaviors in
Sugar. We always recommend testing your changes on a development or test
system before changing values in a production system. After changing the
config_override.php file, you should perform a Quick Repair and Rebuild from the
Admin > Repair menu. For more information, please refer to the Repair
documentation.

Configuring File Permissions

Many features in Sugar require the web server to have the proper file permission
settings to be able to read and write files. At a minimum, the following files and
directories need to be writable from your web server:

./config.php

./config_override.php

./sugarcrm.log

./cache/ and all subdirectories and files

./custom/ and all subdirectories and files

./data/ and all subdirectories and files

./modules/ and all subdirectories and files

Sugar running on Windows with IIS will need the IIS user (IUSR_[computerName])
to have access to these files.

Sugar running on Linux expects the listed files and directories to be owned by the
same user running the web server and to also be in the same group. Sugar would
then require the following permissions:

2770 for the directories listed above
660 for the config.php file and all files in the directories listed above
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770 for bin/sugarcrm

When running on Linux, the config.php file in your Sugar instance's root directory
contains a setting called default_permissions. This setting controls the ownership
and accessibility to all files and folders created by Sugar. The following is an
example of setting Read, Write, and Execute permissions for the Apache user and
the Apache group on CentOS operating system:

   default_permissions' => array(
   'dir_mode' => 1528,
   'file_mode' => 432,
   'user' => 'apache',
   'group' => 'apache',
),

The values for dir_mode and file_mode are decimal equivalent values for the
standard octal values entered for permissions. The value 1528 is the decimal
equivalent of the octal value 02770 and a value of 432 which is the decimal
equivalent of octal value 0660. These are the recommended directory and file
permissions for Linux systems.

Note: If the octal values are entered, they will be interpreted as decimal and will
not provide the expected file permission settings.

The 'user' and 'group' values determine the ownership of the files created. When
empty, your Apache settings will take precedence to determine file and directory
ownership. These values should be set explicitly to the Apache user and group on
your server and these values will vary depending on the Apache setup and/or Linux
OS you are running. To update these values, please edit the config_override.php
file in the root directory of your installation and add the following lines:

  $sugar_config['default_permissions']['user'] = '<your Apache user>';
$sugar_config['default_permissions']['group'] = '<your Apache group>';
   

Note: These values will take effect for only newly created files, not existing files. If
you need to change the file permissions or ownership for existing files, you must
execute the changes through the file system.

Allowing POP Email Accounts
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Inbound email accounts are set up to work with IMAP protocols by default. If your
email provider required POP3 access instead of IMAP, you can add the following
line to the config_override.php file:

  $sugar_config['allow_pop_inbound'] = true;

This will allow new inbound email accounts to be configured with POP3 or IMAP.

Note: POP3 access is not supported and can cause unintended consequences.
IMAP is the recommended protocol to use for inbound email accounts.

Security Options

By default, all administrators have access to administrative tools in Sugar like the
Upgrade Wizard, Module Builder, and Module Loader. The following sections will
show a few different ways to disable these options.

Locking Down Admin Control

If you are managing multiple instances of the Sugar application, you can maintain
complete control over the Sugar instances by preventing users with administrative
privileges from making any changes. To do this, you can lock down the Upgrade
Wizard and Module Builder with a single command in the config_override.php file:

  $sugar_config['admin_access_control'] = true;

Locking Down Module Loader

To ensure that users with administrative privileges do not load sub-standard
modules into Sugar, you can restrict the Module Loader to a specific directory on
the web server that you control. This allows you to check modules before they are
loaded into Sugar. To restrict the module loader, simply add the following lines to
the config_override.php file:

  $sugar_config['use_common_ml_dir'] = true;
$sugar_config['common_ml_dir'] = '/Applications/MAMP/htdocs/sugarcrm/s
creenedModules';
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This will prevent any admin users from loading a module from any directory other
than the specified directory. Once a module is approved through the necessary
channels, the module can be placed in the specified directory for any admin to
install when necessary.

Another method for locking down the module loader is to enable the package
scanner. The package scanner is enabled by default for instances hosted on
SugarCloud. If you are running Sugar on-site, you can enable the package scanner
by adding the following command in the config_override.php file:

  $sugar_config['moduleInstaller']['packageScan'] = true;

When the package scanner is enabled, the module loader will check the files being
loaded for various functions that could be damaging to the server or instance of
Sugar. For more information on which functions are denylisted and how to
configure the package scanner, please refer to the Developer Guide.

Note: Sugar Sell Essentials customers do not have the ability to upload custom file
packages to Sugar using Module Loader.

Enabling Sites as Referers

To prevent Cross-Site Request Forgery (XSRF) attacks, Sugar has a list of
acceptable sites that are allowed as a referer to Sugar. If you receive a "Possible
Cross Site Request Forgery (XSRF) Attack Detected" message from an approved
site trying to access Sugar, you can add that approved site's URL to the list of valid
referers by adding the following line to the config_override.php file:

  $sugar_config['http_referer']['list'][] = 'my.site.com';

This line will add the specified site to the list of approved sites. If you have
multiple sites to add, repeat this line for each site required.

Performance

If the performance of your Sugar instance begins to degrade, there are some
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configuration options you can enable to lighten the load on your system. The
following options may cause Sugar's performance to increase, but some
performance gains will come with a loss of functionality.

Recommended Server Settings

Sugar recommends a PHP memory limit of at least 1GB. This value may need to be
increased depending on how your users utilize Sugar. For example, operations
such as mass update and imports may require additional memory depending on
your instance size and configuration. To change this limit, edit the setting within
php.ini:

  memory_limit = 1G

In addition, display_errors should always be set to "off". Enabling this option can
result in adverse behavior for your users. To turn this setting off, edit the option
within php.ini:

  display_errors = off

When making changes to either of these settings or any other settings within
php.ini, you must restart the web server before the settings will take effect. 

Limiting System Resources

Sugar allows non-admin users to be restricted to how many queries they can run
per action. By default, the limit for all modules is set to 1000 queries. This
prevents user-initiated processes from taking up too many system resources. If an
operation is performed by a user that attempts too many queries they will see a
message returned saying: "Error: Query limit of 1000 reached for Leads module."
To change this limit for all modules, add the following line to the
config_override.php file:

  $sugar_config['resource_management']['default_limit'] = 5000; // def
ault is 1000
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Note: Setting the default_limit value to 0 will remove the query limit altogether for
all modules.

In addition to setting the default for all modules, you can specify certain modules
to have a different value. To remove the limit for specific modules only you need to
specify the modules and the limit for those modules by adding the following lines
to the config_override.php file:

  $sugar_config['resource_management']['special_query_modules'][] = 'A
ccounts';
$sugar_config['resource_management']['special_query_modules'][] = 'Con
tacts';
$sugar_config['resource_management']['special_query_limit'] = 0; // de
fault is 50000

In this example, the Accounts module, Contacts module, and any other module in
the special_query_modules array will no longer be limited. All other modules will
adhere to the default limit.

Note: Setting this limit too low can severely restrict users from performing basic
actions. Alternatively, removing the limits altogether may let users inadvertently
perform operations that significantly impact overall performance.

Configuring a Secondary Database

Sugar allows you to configure your instance to pull reports or list view data from a
secondary database instead of your live database. Reports and list views can
create a heavy load on the database, so separating out the reports or list view data
on a different database or server can help alleviate some performance issues.

To configure a secondary database, set the appropriate array in the
config_override.php file:

Reports: $sugar_config['db']['reports']
Dashlets, Subpanels, and List Views: $sugar_config['db']['listviews']

Set the following values in the array to configure Sugar to use a secondary
database:

Key Value
db_host_name The host name of the server running the

secondary database.
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db_user_name The user name to connect to the
secondary database.

db_password The password to connect to the
secondary database.

db_name The name of the secondary database.
db_type The type of database running the

secondary (DB2, mysql, mssql, oracle).

For example:

  $sugar_config['db']['reports'] =
   array(
      'db_host_name' => 'sugar_secondary',
      'db_user_name' => 'ro_user',
      'db_password' => 'ro_user_password',
      'db_name' => 'sugarcrm_reports',
      'db_type' => 'mysql',
   );

Note: You must create the secondary database and the sync mechanism to keep
the secondary up to date with the live database. The Sugar application will not
sync data from the live database to the secondary.

Changing the Upload Directory

Sugar stores content, such as images, documents, and installable modules,
uploaded by users in the upload directory. Some of these documents may be large
in size and can cause performance issues. Administrators can move the upload
directory to a different location to ensure that enough space is available for
uploads without affecting the system. You can change the location of the uploads
to a different folder within the sugar directory or use an absolute path to place the
folder anywhere in the file system. You can change this location by adding the
following line to the config_override.php file:

  $sugar_config['upload_dir'] = 'd:\upload\';

Note: Remember to copy files from the old upload directory into the new upload
directory for accessibility. The upload directory should be writable by the user
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running the web server.

Changing the Cache Directory

Sugar uses a cache directory to store files (such as compiled templates,
aggregated variable definitions, remote mailbox data, various cache files)
produced by the system to optimize functionality and enhance system
performance. These files can take considerable space, especially in larger systems.
You can change the location of the cache to a different folder within the sugar
directory or use an absolute path to place the folder anywhere in the file system.
You can change this location by adding the following line to the
config_override.php file:

  $sugar_config['cache_dir'] = 'd:\cache\';

Some of the cache files can be accessed by direct URLs. So if you move the cache
directory, you should also ensure that the URL /cache/ (relative to the main Sugar
site URL) on your web server is configured to refer to the new cache location. For
more information on how to configure mappings between URLs and file system
directories, refer to your web server documentation.

Note: The cache directory needs to be created first, or you may receive an
internal server error. The cache directory should be writable by the user running
the web server.

Configuring Count Queries

By default, list views and subpanels in Sugar return record counts. This can be
convenient to know how many records were found for a specific search, but in
order to retrieve the record count; Sugar needs to perform additional queries on
the database. When there are large amounts of data, these queries can cause
performance issues. You can disable these count queries in Sugar by adding the
following line to the config_override.php file:

  $sugar_config['disable_count_query'] = true;

Instead of seeing the total record count, you will see the current known record
count with a plus sign next to it.
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Disabling Related Calculation Fields

When a calculated field in Sugar uses the related function in the Sugar Logic, this
will cause the calculated field to be executed when the related module is updated.
This can cause a cascading effect through the system to update related calculated
fields. When this happens you may receive a 502 Gateway Error. You can disable
the related calculation field updates by adding the following line to the
config_override.php file:

  $sugar_config['disable_related_calc_fields'] = true;

Note: This is a global setting that will affect all modules. If you have a calculated
field in Accounts that sums up all Opportunities for the account, setting this value
to true will no longer update the opportunity account sum in Accounts until the
account record itself is modified. However, if this setting is left disabled, the sum
would update any time a related opportunity or the account is modified.

Disabling Automatic Searches

By default, list views in Sugar remember the last search performed by the current
user in each module. While this can be convenient, it is sometimes unnecessary. If
the last search performed in a module was an extensive search, the next time the
user navigates to that module will inadvertently perform the search again. This can
have a negative impact on performance in Sugar.

Set one of the following values for $sugar_config['save_query'] in the
config_override.php file to configure different options for saving list view queries:

Value Description
all Populates the last search and executes

it.
Note: This is the default behavior in
Sugar.

no Discards the previous search and
executes a search with no criteria.

populate_only Populates the last search but does not
execute it.

For example:

  $sugar_config['save_query'] = 'populate_only';
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Note: The $sugar_config['save_query'] setting is not supported for Sidecar
modules and only applies to Legacy modules. 

Configuring Cron for Schedulers

Sugar's scheduler jobs are executed by the cron utility which runs on your server.
There are several configuration options available to ensure that long-running or
failed scheduler jobs do not impede your other scheduler jobs from running in a
timely manner.

First, max_cron_runtime determines how long a single job should be allowed to
run. If a single job exceeds this limit, cron.php is aborted with the long-running job
marked as in progress in the job queue. The next time cron runs, it will skip the job
that overran the limit and start on the next job in the queue. Additionally, if the
total running time of a single cron run across all current jobs exceeds
max_cron_runtime, then cron will complete whatever job it is currently executing,
then stop. The next time cron runs, it will pick up with the next queued job. The
max_cron_runtime uses seconds as its units and defaults to 1800 (30 minutes). You
may wish to adjust this number based on the typical time requirements of
scheduler jobs in your instance.

By default, max_cron_runtime is not enforced on your instance. In order to enforce
this limit, set enforce_runtime to true.

  $sugar_config['cron']['enforce_runtime'] = true; // default is false
$sugar_config['cron']['max_cron_runtime'] = 1800; // seconds, default 
is 1800

The timeout configuration controls how long cron will wait before re-starting a job
that previously failed to complete. Once a job has been marked as in progress for
longer than the timeout setting, the next cron run will mark the job as failed,
making it eligible in the queue to be executed by the following cron run. The
timeout uses seconds as its units and defaults to 3600 (1 hour). You may wish to
adjust this number based on how quickly you wish a failed or long-running job to
be reattempted. Please note that should enforce_runtime be set to false or your
max_cron_runtime be longer than the timeout, a job which is running normally may
be set to "failed" upon reaching this timeout limit.
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  $sugar_config['jobs']['timeout'] = 3600; // seconds, default is 3600

Business Center Management

Overview

Business centers represent your company's centers of operation. When they are
related to your accounts and other records, they can be leveraged in reports and
filters to add detail and differentiation to your Sugar data like any other relate
field. In addition, each business center describes a time zone, operating hours, and
holidays so that a concept called "Business Hours" can be leveraged in 
SugarBPM™. While some companies may only need to define one business center,
others may segment their customers by geographical region, customer type, or
other criteria and, therefore, require multiple business centers. For example,
companies with wide geographical reaches can create business centers for each
region, allowing them to use varying business hours on a per-region level. 

Business centers are specified at the account level. When a case is created, the
related account's Business Center field is copied to the case, though users can also
manually set the field. Refer to the Cases documentation for more information.
Records' related business centers can then be leveraged by business rules and
processes crafted in SugarBPM. SLA management is achieved in Sugar Serve by
a stock SugarBPM template leveraging related business centers to calculate case
follow-up dates. Refer to the Getting Started With SugarBPM for Sugar Serve
and Stock SugarBPM - Case Follow-Up Date Management articles for help
configuring the stock template and your instance to work together.

This documentation covers information and actions specific to the Business
Centers module, which is available exclusively for Sugar Serve and Sugar Sell
users. For instructions concerning views and actions that are common across most
Sugar modules, such as creating, editing, and deleting business centers, refer to
the Working With Sugar Modules section of this page.

Please note that you will only be able to access business center records if your
user has a Sugar Serve or Sugar Sell license type, and as allowed by your team
membership and assigned roles. By default, only System Administrator users with
a Sugar Serve or Sugar Sell license type have the ability to create, edit, delete, and
merge business centers, though these abilities can be granted to regular users as
described in the Creating a Business Center Administrator section below.
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Business Center Fields

The Business Centers module contains a number of stock fields that come out-of-
the-box with Sugar. For information on using and editing various field types, refer
to the User Interface documentation.

Field Description
Time Zone The time zone where the business

center is located
Business Hours The hours of the day in which business

is conducted at this business center
Note: For more information, refer to the
Setting Business Hours section

Address The business center's physical address
Teams The Sugar team(s) assigned to the

business center record
Assigned To The Sugar user assigned to the business

center record
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation

Date Created The date the business center record was
created

Date Modified The date the business center record was
last modified

Integration Sync ID The sync key field used by external
integrations to identify Sugar records in
the external application. See the 
Integrate REST API endpoints in the
Developer Guide for more details on
how to use this field
Note: This field is not visible in the user
interface

Setting Business Hours

Creating a business center and setting its business hours is only available to Sugar
Serve and Sugar Sell users who are administrators or who have Admin-level role
access to the Business Centers module as explained in the Creating a Business
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Center Administrator section. To set business hours, navigate to the Business
Hours panel on a business center's record view and enter the hours of operation
for each day of the week. For each day's "Hours" field, select one of the following
options:

Open: The business center has operating hours on this day of the week.
After selecting "Open", you must select the Open Time and Close Time for
the day. The default open hours are 8:00 AM - 5:00 PM.
Open 24 Hours: The business center's operating hours are 12:00 AM -
11:59 PM.
Closed: The business center does not have operating hours on this day of
the week.

Each business center's specified operating hours can be used in SugarBPM's
business hour calculations. After setting the business center's hours, you can 
designate the holidays for which each business center will be closed. 

Business Holidays and Business Centers

Below a business center record are several subpanels including the Business
Holidays subpanel. This subpanel allows administrators to create one-day holiday
records for a business center. Holidays will not be included in business hour date
and time calculations used by SugarBPM in Sugar Serve and Sugar Sell. Holidays
can be added by clicking the Create icon (+) in the Business Holidays subpanel. 

Holidays contain three fields:

Field Description
Holiday Name A descriptive label for the holiday.

Note: It is recommended to utilize a
standard format that includes the
calendar year (e.g., "2020 Independence
Day") in the Holiday Name field.

Holiday Date The year, month, and day that this
holiday occurs.
Note: For holidays that span multiple
days, separate Business Holiday records
must be created for each day.

Description A brief description or reason for the
holiday.

Holidays created from a business center's subpanel are automatically related to
that business center. The same holiday can be used for additional business centers
by using the Link Existing Record option in the Business Holidays subpanel for the
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other business centers:

Creating a Business Center Administrator

By default, only System Administrator users with a Sugar Serve or Sugar Sell
license type have the ability to create, edit, delete, and merge business center
records in the Business Centers module. It may be helpful to delegate these
administrative tasks to one or more designated user(s) without giving them full
administrative permissions in Sugar.

Use the following steps to create a Business Center Administrator role:

1. Navigate to Admin > Role Management.
2. Click the three-dots menu in the Roles module tab that appears in the 

navigation bar, then select "Create Role".

 
3. Enter a name (e.g., Business Center Admin) for the role then click "Save".
4. On the Role Chart screen, click "Business Centers" in the module's list to

the far left of the page.

5. The screen will display the role settings specific to the Business Centers
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module. The Access and Access Type columns will default to "Not Set".
Click directly on the "Not Set" text for each column and select the following
options:

Access: Enabled
Access Type: AdminNote: All other role settings can remain as "Not Set" since the Admin

access type will ensure full access to the remaining options.

6. Click "Save" to preserve the changes.
7. Scroll to the Users subpanel on the bottom of the screen and click "Select

User". Search and select the user(s) you wish to assign this role to.

8. After selecting the user(s), navigate to the user's profile to view their
access information via the Access tab. Confirm that the Business Center
Admin role is displayed in the Roles subpanel and the Business Centers
module's access is set to "Admin".

Any user assigned to the Business Center Admin role will have the ability to access
increased functionality such as creating, editing, deleting, and merging records in
the Business Centers module. For more information on creating roles, please refer
to the Role Management documentation.

Working With Sugar Modules
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While the Business Center Management module has some features that only apply
to business centers, it also uses the Sidecar user interface that most Sugar
modules are based on. The following sections detail menus, views, and actions
common to Sidecar modules and contain links to additional information within the
page or links to the User Interface documentation.

Menus

The Business Centers module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or within this page.

Module Tab Menus

Click the Business Centers module tab in the navigation bar to access the Business
Centers list view. You may also click the three-dots menu in the Business Centers
module tab to display the Actions, Recently Viewed, and Favorites menus. The
Actions menu allows you to perform important operations within the module. The 
Recently Viewed menu displays the list of business centers you most recently
viewed. The Favorites menu displays the list of business centers you most recently
marked as favorites.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Create Business Centers Opens the record view layout to create a

new business center record.
View Business Centers Opens the list view layout to search and

display business center records.
Import Business Centers Opens the import wizard to create or

update business center records using
external data.

For more information on module tab menus including reasons a module may not be
included in the menu, see the User Interface documentation.

List View Menus

The Business Centers list view displays all business center records and allows for
searching and filtering to locate specific business centers. You can view the basic
details of each record within the field columns of the list view or click a business
center's name to open the record view. To access a module's list view, simply click
the module's tab in the navigation bar. 

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual business center records or
click the checkbox in the list header to select all records displayed on the current
set of list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more business

center records at a time.
Merge Merge two or more duplicate business

center records.
Delete Delete one or more business center

records at a time.
Export Export one or more business center

records' data to a CSV file.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Map For instances with Sugar Maps enabled,
display this record or the selected
records on a map.

Directions starting from Current User For instances with Sugar Maps enabled,
plot driving directions on a map from
your address to this record or all
selected records.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on a business center record directly from the list view.
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The options in the Record Actions menu allow you to perform the following
operations:

Menu Item Description
Preview (eye icon) Preview this record in the intelligence

pane.
Edit Edit this record.
Directions starting from this record For instances with Sugar Maps enabled,

plot driving directions on a map from
this record to another record or records.

Delete Delete this record.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Record View Actions Menu

The Business Center record view displays a single business center record in full
detail including its relevant fields and subpanels of related records. To access a
business center's record view, simply click on the business center's name from the
list view, dashlet, or from report results. The record view's Actions menu appears
on the top right of the page and allows you to perform various operations on the
current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this record.
Share Share a link to this record via email.
Find Duplicates Locate potential duplicates of this

business center.
Copy Duplicate this business center to create

a new business center.
View Audit Log View a list of changes that have been

made to this business center record.
Delete Delete this record.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Geocode For instances with Sugar Maps enabled,
manually set this record's location on a
map.
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Map For instances with Sugar Maps enabled,
display this record or the selected
records on a map.

Directions starting from Current User For instances with Sugar Maps enabled,
plot driving directions on a map from
your address to this record or all
selected records.

Common Views and Actions

In the table below, the left column contains links to the User Interface page
covering topics that are applicable to all Sidecar modules. The right column has
links to sections of the current page that cover topics specific to business centers.

General Instructions for Working
With Sugar Modules

Business-Centers-Specific
Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Business-Centers-specific help
exists for each topic, use the links below
to navigate to sections of the current
page.

Creating Records  
Viewing Records  
Searching for Records  
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane  
Editing Records Setting Business Hours
Deleting Records  
Finding Duplicate Records  
Viewing Audit Logs  
Favoriting Records  
Sharing Records  

Employee Records

Overview

Sugar's Employees module consists of individual people within your organization.
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The Employees module allows you to see a list of all employees, their contact
information, and their employment status in one convenient location. Employee
records are typically created when a user record is created, but users with
administrative access can also add non-user employees. This means that, typically,
all users will be listed as employees, but not all employees are necessarily Sugar
users.

Note: For instances that use SugarIdentity, the administrator will need to access 
SugarIdentity to create and manage user records. 

As the Employees module contains internal information about your company, not
specifically Sugar, it is not subject to team and role restrictions.

Employee Fields

The Employees module contains a number of stock fields that come out of the box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Fields
can be altered, added, or removed via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide. 

For instances that use SugarIdentity, the administrator will need to
access SugarIdentity to edit the following read-only fields for any employee
records that are tied to a user record in SugarIdentity:

First Name
Last Name
License Type
Note: For certain SugarIdentity-enabled instances, this field is only
available to manage in SugarIdentity. 
Title
Department
Office Phone
Primary Address
City
State
Postal Code
Country
Primary Email Address  

Field Description
City The city of the employee's address.
Country The country of the employee's address.
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Department The department where this employee
works.

Email Address The employee's email address.
Employee Status The employee's employment status in

the organization, either: Active,
Terminated, or Leave of Absence.

Fax The employee's fax number.
First Name The employee's first name.
Home Phone The employee's home phone number.
IM Name The employee's instant message screen

name.
IM Type The employee's instant message client

type.
Last Name The employee's last name.
Mobile The employee's mobile phone number.
Notes A description or other information about

this employee.
Office Phone The employee's office phone number

and extension.
Other An additional phone number for the

employee.
Picture A picture, headshot, or identifying

image of the employee.
Primary Address The number and street of the

employee's address.
Postal Code The postal code of the employee's

address.
Reports to This field list's the employee's manager,

if the manager is a Sugar user.
State The state of the employee's address.
Title The employee's job title.

Employees Module Tab

The Employees module tab can be accessed by clicking your profile icon and
selecting "Employees" in the user menu. 
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Once in the Employees list view, you can click the three-dots menu in the
Employees module tab to display the Actions and Recently Viewed menus. The
Actions menu allows you to perform important actions within the module.
The Recently Viewed menu displays the list of employees you last viewed in the
module. Please note that clicking the module tab allows you to access the
Employees list view.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Employee Opens the edit view layout to create a

new employee.
View Employees Opens the list view layout to search and

display employees.

Creating Employees

There are various methods for creating employees in Sugar including via the
Employees module, the Users module, and duplication. The full edit view layout
opens when creating the employee directly from the Employees menu and includes
all of the relevant fields for your organization's employees. The edit view layout
can be configured via Admin > Studio. For more information on configuring
layouts, please refer to the Studio documentation. Please note that when a new 
user is created, an employee record is also created by default using the relevant
information from the user record. For instances that use SugarIdentity, an
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administrator will need to access SugarIdentity in order to create new users.

Creating Via Employees Module

One of the most common methods of employee creation is via the Create Employee
option in the Employees module tab. This opens up the edit view layout which
allows you to enter in all the relevant information for the employee.

Use the following steps to create an employee via the Employees module:

1. Click the three-dots menu in the Employees module tab and select "Create
Employee".

2. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

3. Once the necessary information is entered, click "Save".

Creating Via Users Module

When a user is created, an employee record is also created by default using the
relevant fields from the user record to be populated on the employee record. The
field in the Users module that controls this is the "Display Employee Record" field.
For more information on creating users, please review the Users documentation.

Note: For instances that use SugarIdentity, an administrator will need to access
SugarIdentity to create new users.
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Creating Via Duplication

You can also create a new employee by duplicating an existing employee record.
The Copy option is useful if the employee you are creating has similar information
to an existing employee. 

Use the following steps to create an employee by duplicating an existing record:

1. Navigate to an employee record's detail view.
2. Click the Actions menu and select "Copy".

3. The displayed edit view is pre-populated with the original employee's
values. Update the necessary fields, then click "Save".

Viewing Employees

There are various options available for viewing employee records in Sugar
including via Employees list view, Employees detail view, and the Employees
Recently Viewed menu. Please note that you will only be able to access these views
by first clicking on the Employees button after clicking on your user name on the
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top right side of Sugar.

Viewing Via List View

The Employees list view displays all employee records meeting the current search
criteria. To access the list view, simply click the Employees option under your user
name on the module tab bar. While list view shows key employee fields, you can
click the employee's name to open the record in detail view. For more information
on viewing employees via list view, please refer to the Employees List View section
of this documentation.

Viewing Via Detail View

The Employees detail view displays thorough employee information by showing all
employee fields. The detail view can be reached by clicking an employee record's
link from the Employees list view. For more information on viewing employees via
detail view, please refer to the Employees Detail View section of this
documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which employees you have recently viewed.
Click the three-dots menu in the Employees module tab to see a list of the 3
records you most recently viewed in the module. Clicking the record's name (e.g.,
Will Westin) within the list will open it in detail view.

Searching Employees

The Employees list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Employees list view below.
Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all records that start
with the keyword entered in the search. To broaden the search, you can use the
wildcard at the beginning of your text as well (e.g., %services). This will pull up
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any record that has the word "services" in the name, regardless of how it starts or
ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, click "Advanced Search" to access additional search
functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.
Active Employees: Select this box to return only records where Employee
Status is Active.

 

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "Active Employees" and enter an employee's name, Sugar will only return
employee records with a matching name that is active. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all employee records, simply click "Clear" and then "Search" to perform a
blank search with no filters.

Administrators can configure what fields appear on the Employees Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration Guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
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Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search: Click the Search button or press your Return/Enter key to perform
the search.
Clear: Click the Clear button to clear all criteria from the searchable fields.
Active Employees: Select this box to return only records where Employee
Status is Active.
Layout Options: Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches: Save, recall, update, and delete searches that you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "Active Employees" and enter an employee's name, Sugar will only return
employee records with a matching name that is active. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all employee records, simply click "Clear" and then "Search" to perform a
blank search with no filters.

Administrators can configure what fields appear on the Employees Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration Guide.

Employees List View

The Employees list view displays all employee records meeting the current search
criteria. You can view the basic details of each employee within the field columns.
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You have the option to change what fields are displayed in the list view by
configuring your layout options in the Employees advanced search. For more
information on configuring your list view, please refer to the Layout Options
section of the Search documentation. Users with administrator or developer access
also have the ability to change what fields are visible in the list view via Admin >
Studio. For more information on editing layouts, please refer to the Studio
 documentation in the Administration Guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to
the System documentation in the Administration guide.

Checkbox Selection

You can perform actions on employee records directly from the list view by first
selecting the desired records. To select individual employee records on the
Employees list view, mark the checkbox on the left of each row. To select or
deselect multiple case records on the list view, use the options in the checkbox
dropdown menu:

Select This Page: Selects all records shown on the current page of case
results.
Select All: Selects all records in the current search results across all pages
of case results.
Deselect All: Deselects all records that are currently selected.
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Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more employees at

a time.
Export Export one or more employees to a CSV

file.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

Employees Detail View

The Employees detail view displays thorough employee information by way of all
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employee fields grouped into one page.

Users with administrator or developer access have the ability to change the detail
view by configuring the layout via Admin > Studio. For more information on
editing layouts, please refer to the Studio documentation in the Administration
Guide.

Next or Previous Record

On the upper right of the Employees detail view, there are two buttons that allow
you to page through each employee in the Employees list view's current search
results. Clicking the Previous button displays the previous employee of the current
search results while clicking the Next button displays the next employee of the
current search results. The text in between shows which employee result you are
currently viewing within the total number of current results.

Editing Employees

Administrators may edit employees at any time to update or add information to the
record. You can make changes to existing employee records via the Employees edit
view and quick create forms. Edit view is available within the Employees module
and includes all of the Employees fields you should need. You can configure the
Employees edit view via Admin > Studio. For more information on configuring
layouts, please refer to the Studio documentation in the Administration Guide.

For instances that use SugarIdentity, the administrator can only edit employee
records that are created directly in Sugar. For any employee records that are tied
to a user record in SugarIdentity, there are certain fields (e.g., Office Phone, Title)
in the employee's record that are read-only and can only be edited in
SugarIdentity.  

Editing Via Detail View

You can edit employees via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes. 
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Editing Via List View

You can also edit employees by clicking the Pencil icon to the left of each
employee's name in the list view. The edit view layout will open where you can
update the necessary fields and click "Save" to preserve your changes.

Deleting Employees

If an employee record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from the Employee's detail view. Deleting
employee records will also delete the user record that this employee was related
to.

Note: For instances that use SugarIdentity, the administrator can only delete
employee records that are created directly in Sugar. Any employee records that
are tied to a user record in SugarIdentity cannot be deleted, and administrators
will need to access SugarIdentity to delete the user record. Deleting the user
record in SugarIdentity will delete the corresponding user and employee records
from Sugar.  

Use the following steps to delete an employee record via the detail view:

1. Navigate to an employee record's detail view.
2. Click the Actions menu and select "Delete".
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3. A pop-up message will display asking for confirmation and alerting you that
the User record will also be deleted. Click "Ok" to proceed.

Exporting Employees

Sugar's Export option allows administrators to download all fields for the selected
employees to their computers as a CSV (comma-separated values) file. This may be
useful when needing to use Employee data with other software such as Microsoft
Excel. Due to PHP memory limitations on the server, there may be occasions when
the application times out while exporting a large number of employee records. If
you encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Employees may be exported from the Employees list view by selecting "Export"
from the Actions menu. For more information on exporting records in Sugar,
please refer to the Export documentation.

Mass Updating Employees

Mass Updating allows administrators to make the same change to multiple
employee records at once from the Employees list view. Administrators can control
which fields are available to change during mass update via Admin > Studio.
Currently, only fields with the data type of date, datetime, dropdown, multiselect,
and radio may be altered during a mass update. For more information on
configuring mass update, please refer to the Studio documentation in the
Administration Guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
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of employee records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Use the following steps to mass update employee records from the list view:

1. Navigate to the Employees list view by clicking the Employees module tab.
2. Use the list view's Basic or Advanced Search to find employees you wish to

modify.
3. Select the desired employees individually or using the checkbox

dropdown's options.
4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.

6. Click "Update" to save the changes to all of the currently selected
employee records.

Knowledge Base Administration

Overview

Sugar's Knowledge Base module provides the ability to create, maintain, and
publish articles. Certain aspects of the Knowledge Base module are only available
for administrators or users with developer-level role access including the creation
and editing of templates and accessing the Knowledge Base settings. This
documentation will cover information and actions specific to Knowledge Base
administration.
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For more information on actions available to regular users such as creating and
editing articles, please refer to the Knowledge Base documentation in the
Application Guide. For instructions concerning views and actions which are
common across most Sugar modules, such as creating, editing, and deleting
templates, please refer to the Working With Sugar Modules section of this page.

Settings

You have the option to add, edit, or delete different languages for article records in
the Settings section. This is helpful if articles are to be translated into multiple
languages. When one or more additional languages have been added, users can 
create localization articles. It is important to note that when a language is deleted
from the available languages, all localization articles created with that language
will also be deleted.

To access the Settings page, click the three-dots menu in the Knowledge Base
module tab to open the Actions menu and select "Settings".

The Knowledge Base Settings drawer will appear which allows you to edit, add, or
remove languages for the Knowledge Base module. To add a new language, click
the "+" icon and enter the Language Code and Language Label. To remove a
language, select the "-" icon. The primary language is set in the Language field by
default for all new articles. But you can change the primary language by selecting
the star icon. Click "Save" to finalize any changes made.
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Working With Sugar Modules

While the Knowledge Base Templates list view has some features that only apply to
KB templates, it also uses the Sidecar user interface that most Sugar modules are
based on. The following sections detail menus, views, and actions common to
Sidecar modules and contain links to additional information within the page or
links to the User Interface documentation.

Menus

The Knowledge Base Templates section contains various options and functionality
which are available via menus in the list view and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Knowledge Base
Templates-specific functionality, within this page.

List View Menus

The Knowledge Base Templates list view displays all knowledge base template
records and allows for searching and filtering to locate specific templates. You can
view the basic details of each record within the field columns of the list view or
click a template's name to open the record view. To access the Knowledge Base
Templates list view, simply click the three-dots menu on the Knowledge Base
module's tab in the navigation bar and select "View Templates".

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual template records or click
the checkbox in the list header to select all records displayed on the current set of
list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more templates at a

time.
Merge Merge two or more duplicate templates.
Delete Delete one or more templates at a time.
Export Export one or more templates to a CSV

file.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual template directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this template in the intelligence

pane.
Edit Edit this template.
Follow (Available if Activity Streams are
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enabled) Follow changes to this
template in your activity stream.

Delete Delete this template.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Record View Actions Menu

The knowledge base template record view displays a single template in full detail
including its fields and the activity stream. To access a template's record view,
simply click a hyperlinked template name from anywhere within Sugar. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.

The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this template.
Share Share this template.
View Audit Log View a record of changes to this

template.
Delete Delete this template.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.
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Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

In the table below, the left column contains links to the User Interface page
covering topics that are applicable to all Sidecar modules. The right column has
links to sections of the current page that cover topics specific to KB templates.

General Instructions for Working
With Sugar Modules

KB-Templates-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When KB-Templates-specific help exists
for each topic, use the links below to
navigate to sections of the current page.

Creating Records  
Viewing Records  
Searching for Records  
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane  
Editing Records Settings
Deleting Records  
Exporting Records  
Merging Records  
Viewing Record Audit Logs  
Favoriting Records  
Following Records  
Sharing Records  
Using the TinyMCE Text Editor  

Tag Management

Overview

Tags are user-created keywords or phrases that can help users find, group, and
classify large amounts of data by common attributes that may not be defined via
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basic database fields. Sugar® stores tags as individual records in the Tags module.
Modules using the Sidecar user interface (e.g., Accounts, Contacts, etc.) contain a
Tags field where users can create and share tags that can be used to identify
records in filters, dashlets, and reports. For more information about Sidecar
modules, please refer to the User Interface documentation in the Application
Guide.

While tags can be created and used by regular Sugar users, some actions in the
Tags module are only available to administrators and users with Developer-level
role access. This documentation will cover these administration options which
allow you to manage the system-wide tag repository. For information about tag
functionality which is available to regular users, please refer to the Tags
documentation in the Application Guide. For instructions concerning views and
actions which are common across most Sugar modules, such as creating, editing,
and deleting tags, please refer to the Working With Tags section of this page.

Note: The Tags module is not configurable in Studio.

Understanding Tag Behavior

The act of relating a tag to a Sugar record is referred to as "tagging". By default,
modules using the Sidecar user interface (e.g., Contacts, Leads, Accounts, etc.) are
enabled for tagging and include the Tags field in the layout. Tags can be related to
multiple records across any Sidecar module, so a single tag can appear on multiple
records. Likewise, a single record can have multiple tags. Unlike other Sugar
modules, users can see all tag records regardless of their team memberships.
Additionally, users will be able to edit Tag fields to add existing tags or create new
tags regardless of any role restrictions their user has for the Tags module.

Please note that only administrators and users with Developer-level role access
may create, edit, merge, and delete tags in the Tags module. To assign a Tags
Administrator role to a Sugar user, please refer to the Creating a Tags
Administrator section of this page.

Note: While the "Find Duplicates" functionality is disabled for all users of the Tags
module, users with administrator access to the Tags module can find and merge
duplicate tag records via list view. For more information on merging records, refer
to the User Interface documentation.

For more information on tag usage guidelines and interacting with tags in Sugar,
please refer to the Tags documentation in the Application Guide.

Tag Fields

The Tags module contains a number of stock fields that come out-of-the-box with
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Sugar. For information on using and editing various field types, refer to the User
Interface documentation. The definitions below are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs.

Field Description
Name The name or designation of the tag.
Assigned To The Sugar user assigned to the tag

record.
Date Created The date the tag record was created.
Date Modified The date the tag record was last

modified.
Description A description or other information about

the tag.

Consolidating Synonymous Tags

Sugar prohibits users from saving duplicate tag records, but with many users
working in and importing new records to Sugar, it is possible for synonymous tag
records (e.g., computer and computers) to accidentally occur in the system.

Before creating a new tag record, a good practice is to first check that a similar
tag does not already exist in Sugar. You can locate candidates for cleanup using
the list view search from the Tags list view. Searching for tags with similar names
or other information can turn search into a powerful, duplicate-finding tool. If
synonymous tag records are detected, perform a merge as described in the User
Interface documentation.

Note: While the "Find Duplicates" functionality is disabled for all users of the Tags
module, users with administrator access to the Tags module can find and merge
duplicate tag records via list view.

Creating a Tags Administrator

By default, only administrator or developer users have the ability to create, edit,
delete, and merge tags in the Tags module. It may be helpful to delegate these
administrative tasks to one or more designated user(s) without giving them full
administrative permissions in Sugar.

Use the following steps to create a Tags Administrator role:

1. Navigate to Admin > Role Management.
2. Click the three-dots menu in the Roles module tab that appears in the 
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navigation bar, then select "Create Role".

 
3. Enter a name (e.g., Tags Administrator) for the role, then click "Save".
4. On the Role Chart screen, click "Tags" in the module's list to the far left of

the page.

5. The following screen will display the role settings specific to the Tags
module. The Access and Access Type columns will default to "Not Set".
Click the "Not Set" in both columns and select the following options::

Access: Enabled
Access Type: AdminNote: All other role settings can remain as "Not Set" since the Admin

access type will ensure full access to the remaining options.
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6. Click "Save" to preserve the changes.
7. Scroll to the Users subpanel on the bottom of the screen and click "Select

User". Search and select the user(s) you wish to assign this role to.

8. After selecting the user(s), navigate to the user's profile to view their
access information via the Access tab. Confirm that the Tags Administrator
role is displayed in the Roles subpanel and the Tag module's access is set
to "Admin".
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Any user assigned to the Tags Administrator role will have the ability to access
increased functionality such as creating, editing, deleting, and merging records in
the Tags module. For more information on creating roles, please refer to the Role
Management documentation.

Working With Tags

While the Tags module has some features that only apply to contacts, it also uses
the Sidecar user interface that most Sugar modules are based on. The following
sections detail menus, views, and actions common to Sidecar modules and contain
links to additional information within the page or links to the User Interface
documentation.

Menus

The Tags module contains various options and functionality which are available via
menus in the module tab, list view, and record view. The following sections present
each menu and its options with links to more information about each option in the
User Interface documentation or, for Tags-specific functionality, within this page.

Module Tab Menus

Click the Tags module tab in the navigation bar to access the Tags list view. You
may also click the three-dots menu in the Tags module tab to display the Actions,
Recently Viewed, and Favorites menus. The Actions menu allows you to perform
important operations within the module. The Recently Viewed menu displays the
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list of tags you most recently viewed. The Favorites menu displays the list of tags
you most recently marked as favorites. 

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Tag Opens the record view layout to create a

new tag.
View Tags Opens the list view layout to search and

display tags.
Import Tags Opens the import wizard to create or

update tags using external data.

For more information on module tab menus including reasons a module may not be
included in the menu, see the User Interface documentation.

List View Menus

The Tags list view displays all tag records and allows for searching and filtering to
locate specific tags. You can view the basic details of each record within the field
columns of the list view or click a tag's name to open the record view. To access a
module's list view, simply click the module's tab in the navigation bar.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
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allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual tag records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more tags at a time.
Merge Merge two or more duplicate tags.
Delete Delete one or more tags at a time.
Export Export one or more tags to a CSV file.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Note: While the "Find Duplicates" functionality is disabled for all users of the Tags
module, users with administrator access to the Tags module can find and merge
duplicate tag records via list view. For more information on merging records, refer
to the User Interface documentation.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual tag directly from the list view.
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The options in the Record Actions menu allow you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this tag in the intelligence

pane.
Edit Edit this tag.
Delete Delete this tag.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Record View Actions Menu

The Tags record view displays a single tag in full detail including its relevant fields
and subpanels of related records. To access a tag's record view, simply click a
hyperlinked tag name from the Tags list view, Tags list view dashlet, or from
report results. The record view's Actions menu appears on the top right of the
page and allows you to perform various operations on the current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this tag.
Share Share a link to this tag via email.
View Audit Log View a record of changes to this tag.
Delete Delete this tag.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

Common Views and Actions

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules.

Content Link Description
Creating Tags
  Basic Tag Creation
  Importing Tags

The Creating Records section covers the
various methods of creating new tag
records, including via the Create button
in the Tags module and importing a list
of tags into Sugar using a .csv
spreadsheet.

Viewing Tags
  Viewing via List View

The Viewing Records section describes
the various methods of viewing tag
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  Viewing via Record View
  Viewing via Recently Viewed
  Viewing via Dashlets 
  Viewing via Preview
  Viewing via Reports

records, including via the Tags list view
and record view, the Recently Viewed
menu in the Tags module tab, list view
dashlets showing tag information,
previewing tags in the right hand side
panel, and reports displaying tag data.

Searching for Tags
  List View Search
  Creating a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Tags module.
Note: For information on using tags as
global search filters, please refer to the 
Tags documentation in the Application
Guide. 

Tags List View
  Total Record Count
  Create Button
  List View Search
  Checkbox Selection
  Mass Actions Menu
  Favorite Designation
  Column Reordering
  Column Resizing
  Column Sorting
  Column Selection
  Preview
  Record Actions Menu
  Pagination
  Dashboards

The List View section walks through the
many elements of the Tags List View
layout which contains a filterable list of
all tag records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Tags list view are described in the 
List View Mass Actions Menu and List
View Record Actions Menu sections of
this page.

Tags Record View
  Favorite Designation
  Next or Previous Record
  Actions Menu
  Subpanels
  Related Record Subpanels
  Filtering Subpanels
  Reordering Subpanels
  Dashboards

The Record View section walks through
the many elements of the Tags Record
View layout which contains detailed
information about a single tag record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Tags record view are
described in the Record View Actions
Menu section of this page.  

Editing Tags
  Editing Inline via Record View
  Editing via Record View 
  Editing Inline via List View 
  Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
tag records, including inline via the
Tags record view, in full edit mode on
the record view, inline via the Tags list
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view, and via the Mass Update option on
the list view.
Note: If the tag's name is edited, all
records related to the tag will
automatically display the updated tag
value.

Deleting Tags
  Deleting via Record View
  Deleting via List View
  Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted tags, including via the Tags
record view, an individual record's
Actions menu on the Tags list view, and
the Mass Actions menu on the list view.

Exporting Tags The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of tags and all their data
as a .csv file for use outside of Sugar
(e.g., in Microsoft Excel).

Merging Tags
  Merging via List View

The Merging Records section provides
instructions for merging duplicate tags
which will combine field values and
related records into a single tag.
Note: Date Created and Date Modified
field types are not supported when
merging duplicate Tag records in Sugar.

Viewing Tag Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record
view option which displays a history of
changes to the tag's audited fields.
Note: Only the Assigned User Id field is
audited for the Tags module and will be
displayed in the audit log.

Favoriting Tags
  Favoriting via List View
  Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking tags as favorites, including via
the Tags list view or Tags record view.
Favoriting a tag allows you to easily
access it from list views, dashlets, or the
Tags module tab.

Sharing Tags The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the tag record. If the recipient is
logged into Sugar, clicking the link will
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bring them directly to the tag's record
view.

Console Management

Overview

Sugar Serve's Service Console and the Renewals Console are Home page
dashboards that provide a powerful work environment for service and sales agents.
The Service Console can be managed and configured by system admin users with a
Serve license type. The Renewals Console can be managed and configured by
system admin users with a Sell or Enterprise license type. In addition, a regular
user who is assigned to the dashboard has the ability to administer and configure
the consoles. For more information on how to configure the various parts of the
consoles, refer to the Configuring the Consoles section below. 

For more information on license types and the module functionality available for
each type, refer to the User Management documentation. Please note that Sugar's
console dashboards cannot be duplicated or deleted. 

Prerequisites

In order to configure the consoles, the following requirements must be met:

You must be a system administrator user.
Note: The system admin can also assign the console dashboard to a regular
user if they wish to designate a console administrator who will manage the
dashboard for the organization. For more information, refer to the 
Designating a Console Administrator section below.
You must have a Sugar Serve license type to configure the Service Console.
You must have a Sugar Sell or Enterprise license type to configure
the Renewals Console.

For more information on license types and the module functionality available for
each type, refer to the User Management documentation.

Designating a Console Administrator

If you wish to designate a non-admin user as a console administrator to manage
and configure the consoles for your organization, you will need to assign the
applicable dashboards to the specific user. Use the following steps to designate a
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user as a console administrator:

1. Click the three-dots menu in the Home tab of the navigation bar then select
"Manage Dashboards". 

2. In the Dashboards module list view, select the console (i.e., Service
Console, Renewals Console) for which you want to designate a console
administrator. 

3. Change the Assigned To field to the desired user.

 
4. Next, navigate back to "Manage Dashboards" and remove the filter in the

Dashboards list view to display all available dashboards. If you are
designating a console administrator for the Service Console, locate
the Case Details dashboard and reassign it to the same user from Step 3.
For the Renewals Console, locate and reassign the "Account Details" and
"Opportunity Details" dashboards to the same user from Step 3. Please note
that you must reassign this dashboard to the user in order to give them the
ability to edit the dashlets contained in the Case Detail drawer (for Service
Console), Account Detail drawer (for Renewals Console), and Opportunity
Detail drawer (for Renewals Console). 
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Once the applicable dashboards have been reassigned to the desired user, going
forward the user assigned to the dashboards will be able to manage and configure
the consoles just like the system admin user. 

Configuring the Consoles

The Console can be configured by system admin users or by a regular user who is 
assigned to the dashboard. Please note that the user must have a Sugar Serve
license type to access and configure the Serve Console, and a Sugar Sell or
Enterprise license type to access and configure the Renewals Console. Also, keep
in mind that in order to access and configure the dashlets in the module tab
drawers (e.g., Case Detail drawer), you will need to have at least one record
assigned to you. Any changes made to the Consoles will update the dashboard for
all users who access the console. The following sections cover the basics of
configuring the Overview tab, the module tab lists, and the module tab drawers.

Configuring the Overview Tab

Admin users and the user assigned to the Console dashboard can rename the
dashboard, add and remove dashlets, rearrange and resize dashlets, and edit
dashlets on the dashboard. Any changes made to the Overview tab will be updated
for all users who access the console. 

To add dashlets, click the floating actions button on the Console dashboard then
select "Add Dashlet" in the floating actions menu to select and configure your
desired dashlet. You can delete dashlets by clicking the Gear icon at the top right
of the dashlet and selecting "Remove".  

To change the position of dashlets in the Overview tab, simply drag and drop the
dashlet in the desired location to swap the position of two dashlets in the
dashboard. To resize dashlets, click the double-ended arrow that appears in the
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bottom corners of the dashlet and drag to the desired size.

You can also configure dashlets in the dashboard by clicking the Gear icon at the
top right of the dashlet and selecting "Edit" which will display configuration
options specific to the dashlet.  

For more information on rearranging, resizing, and editing dashlets, refer to
the Dashboards and Dashlets documentation.

Restoring Overview tab Layout

If you wish to restore the Overview tab of the Service Console dashboard's layout
back to the default out-of-the-box layout, simply click the floating actions button
and select the Restore Default Dashboard option. The console dashboard layout
will be updated to the out-of-the-box layout for all users who access the console.

Configuring the Metric Bar and Metric Tabs

Metric tabs allow you to deploy predefined filters and views to your users for
multiple unified team views. Both the Service Console and the Renewals Console
require a relationship hierarchy based on teams to determine which users the
metric tabs are deployed to. To learn more, please see the Team Management
page.
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Out of the box, the Service Console's Cases tab has the following metric tabs: All
Escalated cases, All Unassigned cases, My Team's Cases, and My Cases. For a
more general overview of how metric tabs work, please see the Service Console
documentation and the Metrics page.

Metric Bar

The metric bar is a bar across the top of the console that holds all of a user's
metric tabs. The bar is available on any module tab (e.g., Cases, Opportunities) and
can be seen below the console's tabs:

 

In the above screenshot, you can see that there are four metric tabs on the metrics
bar. Each tab has individual settings, while the module bar also has settings that
are configured by the three-dots menu available at the end of the metrics bar.
There is no limit to how many metric tabs can be included, but they may be hidden
in an overflow menu.

Metric Bar Settings
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The metric bar stores all the metric tabs, as well as providing the ability to
organize and manage a layout to assign and deploy to users. Please see the Metrics
documentation for more specific information on creating and deploying metric
tabs.

 

The following menu options are available:

Create New: Create a new metric tab. You will be taken to the Metrics
module to create a new record. To view specific information on how to set
filters and layouts to a new metric tab, please see the Metrics
 documentation.
Organize: Set a particular order for metric tabs to deploy to users and
choose which tabs are visible on the metric bar. While metric tabs may be
dragged to the visible column, you must click the X on the tab to send it to
the hidden column.

Users may also organize their own metric bar; please see the Service
Console documentation for more information.
Manage: Access the Metrics module. Please see the Metrics Module
section for more information.

Metric Tabs Settings
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Each individual metric tab has its own settings; some are accessible only to the
admin, while others are for all users. To access these options, hover over a metric
tab and click the three-dots menu at the end of the metric tab.

 

The following menu options are available:

View Details: View all details of the metric record. This module is read-
only unless you are an administrator. For more information on the Metrics
module, please review the Metrics documentation. 
Edit: Edit the metric tab. Only admins can edit metric tabs.
Hide: Remove the tab from the metric bar. All users can do this in their
own metric bar. If the user wishes to put the metric tab back, they may
navigate to Organize on the metric bar's three-dots menu to return the tab.
Delete: Remove the metric tab. Only admins can remove metric tabs. If you
delete all tabs for the console, users will see text that says "No Metric Tabs
Configured. Please contact your administrator." If a user hides all of their
metric tabs from their own view, they will instead see "No Metric Tabs
Visible. Choose "organize" to make metric tabs visible."

Metrics Module

The Metrics module stores all settings for all metric tabs, which are displayed in
the consoles. Having multiple metric tabs allows users to quickly view different
filtered and configured lists with one click. The metrics may have different filters,
as well as different fields visible in the console list view. Regular users can view
metrics in a read-only capacity, while administrators can also create and edit
metrics. Please see the Metrics page for more information.

Metrics

Overview
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The Metrics module stores all settings for all metric tabs, which are displayed in
the Service Console. Having multiple metric tabs allows users to quickly view
different filtered and configured lists with one click. The metrics may have
different filters, as well as different fields visible in the console list view. Regular
users can view metrics in a read-only capacity, while administrators can also
create and edit metrics. For more information on working on consoles, please see
the Service Console documentation. Additional information on admin configuration
can be found in the Console Management page.

Metrics Fields

The Metrics module contains a number of stock fields that come out of the box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation.

Settings Tab Fields

Field Description
Context/Module The location where the metric can be

displayed (e.g., Service Console / Cases)
Teams The Sugar team(s) assigned to the

metric record
Status The current status of the metric record.

Inactive metrics are not displayed in the
metric bar

Filter The filter that is applied when viewing
the returned results in the metric tab
Note: For more details on building
filters, please see the Search
documentation.

Description Explanation and details of the metric
record

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Date Created The date the metric record was created
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Date Modified The date the metric record was last
modified

Assigned to The Sugar user assigned to the metric
record

 

List Layout Tab Fields

Field Description
Primary Sort Order The first field by which the list is sorted
Secondary Sort Order The optional second field by which the

list is sorted
Freeze First Column A checkbox that automatically freezes

the first column of the module tab list
view so that it is remains visible when
scrolling horizontally

Creating and Editing Metric Tabs

The console's module tab contains a metric bar that contains multiple metric
tabs. Metric tabs allow you to deploy predefined filters and views to your users for
unified team views. Both the Service Console and the Renewals Console require a
relationship hierarchy based on teams to determine which users the metric tabs
are deployed to. To learn more, please see the Team Management page.

Each tab has its own settings, and the metric bar also has its own settings. An
admin can configure the module tab lists and filters via a metric tab's three-dots
menu. Additionally, an admin may use the three-dots menu on the metric bar itself
to create and deploy a new metric tab. For more information on how admins can
configure the console, please see the Console Management page.

To create a metric tab, choose the Create New option in the metrics bar's three-
dots menu.
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To edit a metric tab, click the Edit option in the specific metric tab's three-dots
menu or access it directly in the Metrics module, which can be accessed via the
Manage option under the metric bar's three-dots menu.

Settings Tab

When creating or editing a module tab, you will see two tabs, the first of which is
the Settings tab. The Settings tab stores all the basic information about the metric
tab, including the status and the team(s) it is deployed to. The first field, the
Context/Module field is not editable, but instead, shows the console and module
associated with the metric (e.g., Service Console / Cases). The Teams field is used
to control the teams that will be able to access and use the metric tab in their
console. For more information on teams, please read the Team Management page.

Once you have set the teams to which you wish to deploy the metric tab, a filter
needs to be set. If no filter is set, the metric tab will show all records in the
module. As only 100 records can be displayed on a metric tab at a time, it is best to
make different views using filters to narrow down the results to a helpful and
manageable subset. Create the filter in the same way you create list view filters.
For more information on creating filters, please see the Search documentation.
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List Layout Tab

Each module tab allows you to set the default sort order, enable or disable column
freezing, and define a filter for the Cases tab list in the Service Console. To set a
default sort order for a field column in the list view, simply select a primary and
optional secondary-level sort order for the list's display in the Default Sort Order
section. You can also designate the specific field column to be sorted in descending
or ascending order by toggling between the Sort Descending or Sort Ascending
button to the right of the dropdown list. Please note that the Sort Descending and
Sort Ascending buttons will appear for the Secondary Sort Order once you select a
field. The available fields to select in the Primary and Secondary Sort Order
dropdown lists are determined by the Columns list on the right-hand side. As fields
are added to or removed from the Columns list, the available fields in the sort
order dropdown lists will update in real-time. For example, if the selected field
(e.g., Priority) in the Primary Sort Order field is removed from the Columns list,
then that field will also be removed from both sort order dropdown lists, and the
secondary sort order value (e.g., Follow Up Date), if selected, will automatically
move up to the Primary Sort Order field. Please note that certain field types such
as ID, relate (e.g., Assigned to), and widget-type fields (e.g., Status *, Follow Up
Date *) will not appear as available options in the sort order dropdown lists as they
are not sortable.

The Freeze First Column setting, if enabled, automatically freezes the first column
of the metric tab list view for users so that it is always visible even when scrolling
horizontally. Note that an admin can disable this feature for the whole Sugar
instance. See the User Interface page for details on column freezing and the 
System page for details on the system-wide admin setting.

The Filter section allows you to filter the list view based on pre-defined filters (e.g.,
My Items) as well as custom filters. Simply use the plus and minus buttons to add
or remove filter criteria like you would for a standard list view filter. For more
information on creating filters, refer to the Search documentation. Please note that
administrators can configure the Search layout in Admin > Studio to control which
fields are available as filters for the Cases tab list view. For more information on
editing the Search layout, refer to the Studio documentation. 
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Once you have made the necessary configurations, click "Save" to preserve the
changes and update the module tab's view for all users who access the console. 

Configuring the Console's Tabbed List Views

In addition to setting a default sort order and defining a filter for the list view, you
can also designate which fields to display as columns in the metric tab's list
view as well as the left-to-right order of the field columns. Simply use the
"Columns" and "Available Fields" lists on the right-hand side to configure the list
view layout per your business needs. Fields with an asterisk (e.g., Status *) are
widget-type fields that provide data based on one or more fields in a special
format. See the Widgets section for a list of widget-type fields available in the
Service Console.
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Use the following steps to configure the Cases tab's list view for the Service
Console:

1. To add a field to the list view layout, drag and drop the desired
stock/custom fields (e.g., Date Created) from the Available Fields list to the
Columns list.
Note: The Preview table below the Filter field will automatically update in
real-time to reflect your current field selections and the designated order of
the field columns configured in the Columns list.

2. To display multiple field values in a single column, click the "Multi-Field
Column" option below the Columns list. A multi-row box will then appear in
the Columns list where you can drag and drop two fields from either the
"Available Fields" or "Columns" lists that you wish to display in the same
column.
Note: The column will display the field values in two rows, and you can
drag and drop the fields within the multi-field box to designate which field
value will appear on top.
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3. To remove a field from the layout, simply hover your mouse over the
particular field pill or multi-row box in the Columns list then click the "x" to
the right of the name. The field(s) will then reappear in the Available Fields
list.

4. To change the left-to-right order of the fields displayed on the list view,
drag and drop the fields up or down within the Columns list.

5. Click "Save" to preserve and update the Cases tab's list view for all users
who access the console.

Widgets

Several widgets are available in the Service Console to display data from existing
fields in a different format. These fields are marked with an asterisk (*) in the
Columns and Available Fields lists. The following widgets are available in the
Cases tab of the Service Console:

Follow Up Date *: Displays the value of the Follow Up Date field in terms
of the amount of time until or since the follow-up date (e.g., in 3 days)
Status *: Displays the value of the Status field in a color-coded badge

Restoring Default Settings

Below the preview table, you will see two options that allow you to easily access
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the Console Management documentation from the Console Settings window or
restore the console back to the administrator-set default settings. If you wish to
restore the default admin-set configuration, simply click the "Click here" link. After
restoring the default settings, you will need to click "Save" in the Console Settings
window to preserve the changes. 

Configuring the Module Tab Drawers

The module tab drawers can be accessed by clicking on a module tab (e.g., Cases)
in the console (e.g., Service Console) then clicking the desired record's row in the
list view. This opens a drawer within the console that aggregates key information
about the record, its related records, past/upcoming interactions (e.g., emails,
calls, meetings), etc. The drawer contains four dashlets that can be rearranged and
configured by system admin users as well as the regular user assigned to the
dashboard. To access and configure the dashlets in the module tab drawers (e.g.,
Case Detail drawer), you will need to have at least one record assigned to you.

To change the position of dashlets in the module tab drawer, simply drag and drop
the dashlet in the desired location on the layout to swap the position of two
dashlets. To resize dashlets, drag the double-ended arrow at the bottom right
corner. You can also configure the dashlets in the dashboard by clicking the Gear
icon at the top right of the dashlet and selecting "Edit", which will display
configuration options specific to the dashlet. To retrieve updated information in
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the dashlet, you can select the Refresh option in the dashlet gear menu, which will
manually refresh the dashlet. Select "Remove" in the dashlet gear menu to delete
the dashlet from the module tab drawer.

To add dashlets to the module tab drawer, click the floating actions button in the
drawer then select "Add Dashlet". Click the title (e.g., List View) corresponding to
the desired dashlet in the Add Dashlet page then configure the dashlet as desired.
For more information on rearranging, editing, adding, and deleting dashlets, refer
to the Dashboards and Dashlets documentation. Please note that any changes
made to the layout and dashlet settings will be updated for all users who access
the console.

Note: Record view dashlets such as the Case Record Dashlet and Account Record
Dashlet can be edited via Studio > {Module Name} > Layouts > Record View
Dashlet. For more information, refer to the Dashboards and Dashlets and Studio
 documentation.

Working With Sugar Modules

While the Metrics module has some features that only apply to metrics, it also uses
the Sidecar user interface that most Sugar modules are based on. The following
sections detail menus, views, and actions common to Sidecar modules and contain
links to additional information within the page or links to the User Interface
documentation.

List View Menus

The Metrics list view displays all metric records and allows for searching and
filtering to locate specific metrics. You can view the basic details of each record
within the field columns of the list view or click a business center's name to open
the record view. To access a module's list view, simply click the module's tab in the
navigation bar.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual business center records or
click the checkbox in the list header to select all records displayed on the current
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set of list view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more business

center records at a time.
Delete Delete one or more business center

records at a time.
Doc Merge Select or create a DOCX template to

merge record data into documents that
will be accessible in the Doc Merge
widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on a business center record directly from the list view.

The options in the Record Actions menu allow you to perform the following
operations:

Menu Item Description
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Edit Edit this record.
Delete Delete this record.
Doc Merge Select or create a DOCX, XLSX, or PPTX

template to merge record data into
documents that will be accessible in the
Doc Merge widget.

Doc Merge to PDF Select or create a DOCX, XLSX, or PPTX
template to merge record data into PDF
documents that will be accessible in the
Doc Merge widget.

  Common Views and Actions 

In the table below, the left column contains links to the User Interface page
covering topics that are applicable to all Sidecar modules. The right column has
links to sections of the current page that cover topics specific to metrics.

General Instructions for Working
With Sugar Modules

Metrics-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Business-Centers-specific help
exists for each topic, use the links below
to navigate to sections of the current
page.

Creating Records  
Viewing Records  
Searching for Records  
List View List View Mass Actions Menu

List View Record Actions Menu
Record View  
Intelligence Pane  
Editing Records  
Deleting Records  
Finding Duplicate Records  
Viewing Audit Logs  
Favoriting Records  
Sharing Records  

Sugar Automate Administration
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Overview

Sugar Automate lets administrators create easy-to-follow, visual business
processes for users to complete against their Sugar records. Each Smart Guide is
an end-to-end process that is split into color-coded stages, and each stage contains
one or more call, meeting, or task activities that the user can complete with
optional dependencies and actions on related records. This guide covers how to
start using Sugar Automate as an administrator.

Note: Sugar Automate was incorporated in version 12.3 of Sugar Sell and Sugar
Serve and 13.0 for Sugar Enterprise. For Sugar versions 12.2 or earlier, where
Sugar Automate was available as an installable connector, please refer to the
separate Sugar Automate documentation.

For users to view Sugar Automate Smart Guides, they must be assigned a Sugar
Automate license. For more information please refer to the License Management
 page. For information on using Sugar Automate after an administrator sets up a
Smart Guide, please refer to the Sugar Automate page in the Application Guide.

Prerequisites

Sugar Automate is included with Sugar Sell Premier and enables the guided selling
capability. Sugar Automate can also be purchased as an add-on for Sugar Sell
Advanced, Enterprise, and Serve. Please contact your Sugar partner or
representative to learn more.

Understanding Smart Guides

A Smart Guide is a set of successive stages through which most customers proceed
as they participate in the decision-making process. A traditional Smart Guide is
often characterized by the stages of awareness, consideration, purchase, and
loyalty. Depending on your business needs, you may have more or fewer stages or
even several variations of the Smart Guide for different types of consumers. With
Sugar Automate, administrators have the freedom to create multiple, unique Smart
Guides specific to their business processes.

The Smart Guide in Sugar is presented in an easy-to-follow visual format,
comprising a progression of stages and activities within those stages.
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Smart Guide performance is measured in terms of progress and momentum. For
more information on how these measurements are calculated and where to see
them, please refer to the Understanding Progress and Momentum section of this
page.

Before creating a Smart Guide template, we recommend planning the Smart Guide
outside of Sugar. Take the time to fully understand the individual steps that make
up the customer's decision-making process and the steps in Sugar that correlate
with each part of the Smart Guide. For more complicated Smart Guides, it may
help to sketch a diagram or map the Smart Guide on a spreadsheet before creating
the Smart Guide template and related stages and activities in Sugar.

Configuring Smart Guide Display Settings

Smart Guides may be displayed as a panel beneath its parent record or as a
separate record-view tab from the rest of the record. By default, all Smart Guides
will be rendered in panel format unless the admin changes the display settings.
Each Smart Guide-enabled module's display settings can be configured
independently.

There are four display configurations available. The "tab" options will be grayed
out and not selectable until you have saved the module's Display Type as "Tab" in
Studio > Layouts > Record View as described in the steps below.

Panel - Bottom (default): The Smart Guide panel will show at the bottom
of the record view.
Panel - Top: The Smart Guide panel will show at the top of the record
view.
Note: If "Panel - Top" is selected and tabs are enabled for the record view
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in Studio, then the Smart Guide will revert to the default display as a panel
at the bottom of the record.
Tab - First: The Smart Guide panel will be shown as the first tab of a
tabbed record view layout. This option is grayed out and not selectable
until you have saved the module's Display Type as "Tab" in Studio >
Layouts > Record View.
Tab - Last: The Smart Guide panel will be shown as the last tab of a
tabbed record view layout. This option is grayed out and not selectable
until you have saved the module's Display Type as "Tab" in Studio >
Layouts > Record View.

Use the following steps to change a module's Smart Guides to display in the tabbed
format:

1. Navigate to Admin > Studio and select the module (e.g. Accounts) for
which you want to change your Smart Guides to a tabbed view.

2. Click on "Layouts" and then select the "Record View" layout to edit.
3. In the upper section of the record view layout, change "Display Type" to

"Tab". Then click "Save & Deploy". For more information on changing to
tabbed display type, refer to the Studio documentation in the Sugar
Administration Guide.

4. Once you have changed the module to a tabbed view, navigate to Admin >
Configure Modules in the Sugar Automate Settings section of the admin
page:

5. Select "Tab - First" or "Tab - Last" as desired for the module and then click
"Save".
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Note: If the "Tab - First" and "Tab - Last" options for any dropdown are
disabled, then the Tab view has not been enabled for that module in Studio.
To enable the Tab view, return to step 1 of these instructions.

The Smart Guides created within the selected module (e.g. Accounts) will now
display as an additional tab in the record view instead of a panel below the record.

Sugar Automate Template Access

Templates created for Sugar Automate utilize three template modules:

Smart Guide Templates
Smart Guide Stage Templates
Smart Guide Activity Templates

Administrator users can automatically access all of these modules to create new
Smart Guide templates. To grant developer access to a regular user for creating
Smart Guide templates, the user's role must have "Developer" access to all three
template modules.

For regular users, a team is set on the activity template, stage template, and Smart
Guide template records. Assuming the admin creates the template records using
the global team, regular users without Developer role permissions will have access
to all Smart Guides in Sugar, even if they are related to records outside of their
team(s). Administrators should leverage the team fields on the Smart Guide
template records if this is a concern.

For more information about teams and roles, please refer to the Team
Management and Role Management documentation.

Creating Smart Guide Templates
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The administrator composes a Smart Guide in Sugar using three steps:

1. Create a Smart Guide template.
2. Add stages to the Smart Guide template.
3. Add activities (calls, meetings, and tasks) to each stage of the Smart Guide

template.

A Smart Guide template is the record that controls what users see after they
choose a Smart Guide from the Smart Guide picker in the Smart Guide panel under
leads, contacts, and other modules participating in the Smart Guide. Each time a
user chooses to start a new Smart Guide for a record, a copy of the template with
its related stages and activities is created.

Note: Running Smart Guides are automatically named "Record Name - Smart
Guide Name," where the record name is the name of the record the user is viewing
when they start the Smart Guide (e.g., the account's name) and the Smart Guide
name is the name of the Smart Guide template that they choose.

The following steps cover creating a Smart Guide template.

1. Navigate to Admin > Templates in the Sugar Automate Settings section of
the Admin page:
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2. Click the Create button on the upper right of the Smart Guide Templates
list view. Alternatively, click the three-dots menu in the Smart Guide
Templates module tab to open the Actions menu and select "Create Smart
Guide Template".

From list view:

From the module tab:

3. Refer to the Smart Guide Template Fields section of this page to complete
the fields in the record view layout. All required fields are marked as such
and must be completed prior to saving.

4. After completing the Smart Guide template fields, click "Save" and then
move on to the Adding Stages to Smart Guide Templates section to add
stages to the Smart Guide.

Smart Guide Template Fields

The Smart Guide Templates module contains the following fields:

Field Description
Active This checkbox controls whether the

Smart Guide is visible to users on Sugar
records. When checked, the Smart
Guide is available for users to enable on
records. It is a good idea to uncheck this
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box until you have completely
configured the Smart Guide and its
related records.

Note: Sugar Automate includes several
templates that are enabled by default. If
you do not want users to have the option
to select them, simply uncheck the
Active box for those records.

Active Smart Guide(s) Limit The maximum number (integer) of
Smart Guides from this template that
may run simultaneously for a given
parent record. When the limit is
reached, users will be prohibited from
launching a duplicate Smart Guide on a
record until one of the running Smart
Guides for this template has been
completed for the parent record.

Assignee Rule Choose how users should be assigned to
activities within the Smart Guide. The
Assignee Rule is directly related to the
Target Assignee, explained later in this
table.

None: Users will be manually
assigned to activities.
On Stage Start: When a new
stage begins on a Smart Guide,
the Target Assignee will be
assigned to that stage's
activities.
On Create: When a new Smart
Guide begins, the Target
Assignee will be assigned to all
of the Smart Guide's activities.
Previous Activity Completed:
The Target Assignee will be
assigned to each activity when
the previous activity gets
completed.

Note: By default, users will not get
notified when task activities are
assigned to them by virtue of the
assignee rule in a Smart Guide.
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Auto Reassign Open Activities Select this option if you would like any
open (Not Started or In Progress)
activities to get reassigned when the
assigned user changes on the parent
module record. The Target Assignee
field must be set to "Parent Assignee" at
the Smart Guide Template level for this
option to work.

Note: This setting may be overridden at
the activity level. For more information,
see the Assignee Rule and Target
Assignee field descriptions in the Smart
Guide Activity Template Fields section. 

Target Assignee Choose the user(s) who will be
automatically assigned to the activities
in the Smart Guide according to the
Assignee Rule.

Current User: The definition of
"Current User" is dependent on
the selected Assignee Rule.

On Stage Start: The
Current User is the user
that initiates a new stage
for a new or in-progress
Smart Guide stage in
Sugar.
On Create: The Current
User is the user that
initiates the Smart Guide.
Previous Activity
Completed: The Current
User is the user
completing the previous
task.

Parent Assignee: All Smart
Guide activities will be assigned
to the assigned user for the
stage's related lead, account,
contact, opportunity, or case
record. This is the default
assignee for Smart Guides.

Note: This setting may be overridden at
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the activity level. For more information,
see the Assignee Rule and Target
Assignee field descriptions in the Smart
Guide Activity Template Fields section.

Available Modules Select the Sugar modules that will be
followed along the Smart Guide. A
Smart Guide may include any
combination of default modules and the
modules configured in Smart Guide >
Configure Modules.

Note: If you select Leads, Contacts, and
Opportunities for the Smart Guide's
"Available Modules", a user will be able
to start the Smart Guide on a lead
record and continue to manage the
same Smart Guide after they convert the
lead into a contact and, optionally, an
opportunity. Please note that the related
contact and opportunity records must be
created on the Lead Conversion screen
in order for the Smart Guide to continue
with those records. 

Cancel Action Decide what should happen to
incomplete or not-started Smart Guide
activities if a user cancels a running
Smart Guide by clicking "Cancel" in the 
Smart Guide Actions menu:

Set Not Applicable: All
incomplete activities for the
canceled Smart Guide will close
with a status of "Not Applicable".
Remove Open Activities: All
incomplete activities for the
canceled Smart Guide will be
deleted and progress will be
calculated on the partial Smart
Guide according to the
remaining activities.

Please note that "Cancel" will stop the
current Smart Guide without deleting
the Smart Guide record even if "Remove
Open Activities" is set. Completed
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activities will not be affected by either
of the Cancel Action options.

Date Completed The date and time that the Smart
Guide was completed.

Date Started The date and time that the Smart Guide
was initiated.

Description Enter a description for or other
information about the Smart Guide's
intended use.

Disabled Activity Actions Optionally, select any activity actions
that you want to restrict for this Smart
Guide. For more information, refer to
the Disabling Stage and Activity Actions
 section.

Disabled Stage Actions Optionally, select any stage actions that
you want to restrict for this Smart
Guide. For more information, refer to
the Disabling Stage and Activity Actions
 section.

Name Enter the user-facing name of the Smart
Guide. This will be the menu option that
appears in the Smart Guide selector
under Sugar records.

Not Applicable Action Decide how to allocate points for
activities marked "Not Applicable" in
this Smart Guide. The "Default" setting
will close the activities with 10/10
points; "Custom" will close the activity
with 0/0 points for the Smart Guide.

Points The Points field calculates and displays
the sum total of points related to
activities in the Smart Guide. This field
cannot be edited and will default to
blank until you have added activities
with point values to the Smart Guide.
For more information on activity points,
please refer to the Points description in
the Smart Guide Activity Template
Fields section.

Related Activities The Related Activities field calculates
and displays the sum total of activities
in the Smart Guide. This field cannot be

                         777 / 829



 

edited and will default to zero until you
have added activities to the Smart
Guide.

Smart Guide Templates Module Tab

The Smart Guide Templates module tab is located on the navigation bar at the top
of the Sugar screen after the administrator clicks on "Templates" on the Admin
panel. Click the three-dos menu in the Smart Guide Templates tab to display the
Actions, Recently Viewed, and Favorites menus. The Actions menu allows you to
perform important actions within the module. The Recently Viewed menu displays
the list of Smart Guide templates you last viewed in the module. The Favorites
menu displays the list of Smart Guide templates you most recently marked as
favorites in the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Smart Guide Template Opens the record view layout to create a

new Smart Guide template
List Smart Guide Templates Opens the list view layout to search and

display Smart Guide templates
Import Smart Guide Templates Opens the import wizard to create or

update Smart Guide templates using
external data

Adding Stages to Smart Guide Templates

After creating the Smart Guide template record, you must create stages for the
Smart Guide. Stages are the groups of activities in the customer's decision-making
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process and are defined in the Smart Guide Stage Templates module.

After saving the Smart Guide template, follow these steps to add a stage to the
Smart Guide:

1. Click on the Add Stage button in the panel below the Smart Guide
template's fields:

2. Refer to the Smart Guide Stage Template Fields section of this page to
complete the fields in the record view layout. All required fields are marked
as such and must be completed prior to saving.

3. After completing the stage template's fields, click "Save." At this point in
the design process, you may only need to populate the stage's name (e.g.
"Awareness") before saving.

4. Continue creating stage templates via the Add Stage button until you have
made one for every stage of the Smart Guide. For example, if the current
Smart Guide will move through Awareness > Consideration > Purchase >
Loyalty, you must create four separate stage templates.

5. New stages will be added to the end of the Smart Guide cycle. At any time
from the Smart Guide template's design panel, you can re-order the stages
by simply dragging them into the order you prefer. The stage's order
numbers will adjust appropriately.

6. After creating a stage template for each stage of the Smart Guide and
ordering the stages as desired, move on to the Adding Activities to Smart
Guide Templates section to add activities to the stages.

Smart Guide Stage Template Fields
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The Smart Guide Stage Templates module contains the following fields:

Field Description
Smart Guide Template Select the Smart Guide template that

contains this stage. This field should be
automatically populated.

Date Completed The date and time that the last activity
in the stage was completed, turning the
stage's header arrow green.

Date Started The date and time that the first activity
in the stage was initiated by its assigned
user.

Description Enter a description for or other
information about the stage's intended
goal.

Name Enter the name of the stage within the
Smart Guide. The name will be
displayed in the arrow-shaped column
header for this stage.

Order "Order" is the step number that
corresponds to the stage in the overall
Smart Guide. By default, the number
will reflect the order in which the stages
are created, but it can be edited as
needed. The order number is also
displayed in the arrow-shaped column
header for this stage.

Points The Points field calculates and displays
the sum total of points for all activities
in the stage. This field cannot be edited
and will default to blank until you have
added activities with point values to the
stage. For more information on activity
points, please refer to the Points
description in the Smart Guide Activity
Template Fields section.

Related Activities This field counts and displays the
number of activities related to the stage
via the Smart Guide Activity Templates
module. This field cannot be edited and
will default to blank until you have
added activities to the stage.
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Start Next Smart Guide This field allows the admin to optionally
select a Smart Guide that will begin
when this stage is completed. The new
Smart Guide will be created and related
to the same parent record as the current
Smart Guide's parent.

Adding Activities to Smart Guide Templates

Activities are the concrete actions that must be completed to move from one stage
to the next. Under each stage, you can add activities in the form of tasks, calls,
meetings, and milestones via the Smart Guide Activity Templates module. For calls
and meetings, the connector will automatically add the activity's assigned user and
the person associated with the Smart Guide's parent Sugar record (e.g. the lead or
contact) as guests for the activity. This ensures that the activity appears on the
assigned user's calendar and that the call or meeting shows up in the lead or
contact's subpanel. Users can add or remove guests via the call or meeting's
record view.

After saving a Smart Guide's stage template, follow these steps to add an activity
to the stage:

1. Hover over the stage where you want to add an activity. When the stage's
Actions menu appears, click the down arrow to reveal the options to add an
activity:

Alternatively, click "Copy" from a similar activity's Actions menu to
duplicate, edit, and save a new activity in the Smart Guide.

2. Click on "Add Task," "Add Call," or "Add Meeting" to create an activity
record for the stage.

3. Refer to the Smart Guide Activity Template Fields section of this page to
complete the fields in the record view layout. If creating a task, select the
relevant task Type. All required fields for the new activity are marked as
such and must be completed prior to saving.

4. After completing the activity template's fields, click "Save."
5. Continue adding activities to this stage and all of the other stages in the

Smart Guide as required by your business process. New activities will be
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added to the end of the Smart Guide stage. At any time, from the Smart
Guide Template designer, you can re-order the activities by simply
dragging them into the order you prefer. You may also drag and drop
activities around from one stage to another. The activity order numbers will
automatically adjust for the stage.

Once you have defined all activities for each stage of the Smart Guide, you may
choose to add sub-activities to the activities created in this section. If so, please
refer to the Adding Sub-Activities section. If sub-activities are not required by your
business process, then the Smart Guide template is complete and is ready to share
with users. For more information on using the templates you have created for
Sugar Automate, please refer to the Sugar Automate User Guide.

Adding Sub-Activities

The activities on a Smart Guide Template may optionally contain one or more sub-
activities. Simply expand the parent activity's Actions menu and select the
appropriate activity type that you would like to nest underneath it. For example, an
activity task called "Get Approval" could contain two sub-activity tasks for
"Manager Approval" and "QA Signoff", which may be assigned to different users.

After saving a stage's activity template, follow these steps to add sub-activities
under the activity:

1. On the parent activity (e.g. "Get Approval"), click the down arrow to reveal
the Actions menu:
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2. Click on "Add Task," "Add Call," or "Add Meeting" to create an activity
record under the current activity. Alternatively, click "Copy" from a similar
sub-activity's Actions menu to duplicate, edit, and save a new sub-activity
in the Smart Guide.

3. Refer to the Smart Guide Activity Template Fields section of this page to
complete the fields in the record view layout. If creating a task, select the
relevant task Type. All required fields for the new activity are marked as
such and must be completed prior to saving.

4. After completing the activity template's fields, click "Save." The sub-activity
will be slightly indented and display the default order number x.1, where x
is the order number of the parent activity.

5. To add another sub-activity to the same parent, return to the parent
activity's Actions menu and select the appropriate activity type to create.
Complete the activity's details and save. The second sub-activity will
display the default order number x.2 when shown in the Smart Guide panel.

6. Continue adding sub-activities as required by your business process. New
sub-activities will be added to the end of the parent activity. At any time,
from the Smart Guide Template designer, you can re-order the sub-
activities by simply dragging them into the order you prefer. You may not
individually drag sub-activities to a new parent activity, but you can drag
and drop the parent activities including all their sub-activities around from
one stage to another. The activity order numbers will automatically adjust
for the stage.

Once you have defined all activities and optional sub-activities for each stage of the
Smart Guide, the template is complete and ready to share with users. For more
information on using the templates you have created for Sugar Automate, please
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refer to the Sugar Automate User Guide.

Smart Guide Activity Template Fields

The Smart Guide Activity Templates module contains the following fields:

Field Description
Activity Type Define the activity as a task, call, or

meeting. Please note that tasks may be
action items or milestone activities,
depending on the selected Task Type.

Allow Activity By Optionally, restrict the ability to
complete this activity to one or more
users, teams, or roles. 

Assignee Rule Optionally, choose how users should be
assigned to this activity if you want the
Assignee Rule to be different than the
one you set at the Smart Guide
Template level. The activity's Assignee
Rule will always take precedence over
the Smart Guide Template's Assignee
Rule.

The Assignee Rule is directly related to
the Target Assignee, explained later in
this table.

Inherit: This is the default
setting for an activity. The
Inherit value will respect the
Assignee Rule set at the Smart
Guide level.
None: Users will be manually
assigned to this activity.
On Stage Start: When this
activity's stage begins, the
Target Assignee will be assigned
to this activity.
On Create: When the Smart
Guide begins, the Target
Assignee will be assigned to this
activity.
Previous Activity Completed:
The activity's Target Assignee
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will be set the moment that the
previous activity is closed or
held.
Specific Activity
Completed: The activity's
Target Assignee will be set the
moment that the activity
selected in the "Assignee Rule
Activity" field is closed or held.

Note: By default, users will not get
notified when task activities are
assigned to them by virtue of the
assignee rule in a Smart Guide.

Assignee Rule Activity Shown only when the Assignee Rule is
set to "Specific Activity Completed", the
Assignee Rule Activity field displays all
other activities that are related to the
current Smart Guide. Select the activity
that will determine the current activity's
assignee.

Target Assignee If you have set an activity-level Assignee
Rule, choose the user(s) who should be
automatically assigned to this activity.

Inherit: This is the default
setting for activities. The Inherit
value will respect the Target
Assignee set at the Smart Guide
level.
Current User: The definition of
"Current User" is dependent on
the selected Assignee Rule.

On Stage Start: The
Current User is the user
that initiates a new stage
for a new or in-progress
Smart Guide stage in
Sugar.
On Create: The Current
User is the user that
initiates the Smart Guide.
Previous Activity
Completed: The Current
User is the user
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completing the previous
task.

Parent Assignee: The Smart
Guide activity will be assigned to
the assigned user for the stage's
related lead, account, contact,
opportunity, or case record. 
User: Select a specific user to
handle this activity for all Smart
Guides. Choosing this option will
reveal the User selector field.
Team: Selecting a team for the
activity will set the activity's
primary team. A user from that
team can then manually assign
the activity to a specific user.
Choosing this option will reveal
the Team selector field.
User & Team: Select both the
user and team that will be
assigned to this activity for all
Smart Guides. Choosing this
option will reveal the User and
Team selector fields.

Blocked By For the Blocked By field, select one or
more optional activities that users must
complete before they can start the
current activity. For more information,
refer to the Blocking Activities section.

Blocked By Stages For the Blocked By Stages field, select
one or more optional stages that users
must complete before they can start the
current activity. For more information,
refer to the Blocking Activities section. 

Smart Guide Stage Template This field should be automatically
populated with the stage that owns this
activity.

Description Enter a description for or other
information about the activity's intended
goal.

Direction Only visible for call activities, the
Direction field indicates whether the call
will be inbound or outbound.

Duration (hours/minutes) Only visible for call and meeting
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activities, the Duration field is optional
and represents the length of time that
the activity will last.

Guests Only visible for call and meeting
activities, the Guests section allows you
to choose a combination of contacts and
users to automatically add as guests to
the call or meeting record.

Specific Users: Select any
active user to invite.
Specific Contacts: Select any
contact record to invite.
Related Parent Users: Invite
the user who is in any user-
relate field from the Smart
Guide's parent record.
Related Parent Contacts:
Select a contact that is related to
the Smart Guide's parent record
Add All Contacts From
Parent: Invite all of the contacts
that are related to the Smart
Guide's parent record.

Momentum Start Trigger Decide when this activity's momentum
tracker should begin relative to the
Smart Guide or stage you are in. By
default, this field is not set and the
additional momentum fields will not
appear until you have selected an option
for the Start Trigger. If the Momentum
Start Trigger is not set for a parent,
then the sub-activities will not affect the
parent's momentum regardless of
momentum applied for sub-activities.

When Created: The activity's
Momentum start date will be
relative to the day the entire
Smart Guide began.
When Stage Started: The
activity's Momentum start date
will be relative to the day the
current stage began.
When Previous Activity
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Completed: The activity's
Momentum start date will be
relative to the day the previous
activity was closed or held.
When Specific Activity
Completed: This trigger will
present all of the Smart Guide's
related activities for selection.
The current activity's Momentum
start date will be set at the
moment the selected activity has
been completed.
On Parent Date Field: The
activity's Momentum start date
will be relative to a day found in
a date field of the Smart Guide's
parent module. This option will
reveal the Momentum Start
Field and Momentum Start
Module fields.

Momentum Points The Momentum Points field controls the
display of the Momentum Bar as well as
the Gauge Chart for every running
Smart Guide in Sugar. A higher
momentum point value for one activity
over another would indicate the relative
importance of that activity over the
other. For more information, please
refer to the Smart Guide Momentum
and Calculating Momentum sections of
this page.

Momentum Due Days The number of days expected to
complete the Activity. If the activity
should be completed in less than a full
day, enter 0 for this field and use the
Momentum Due Hours field instead.

Momentum Due Hours The number of hours in addition to the
Momentum Due Days expected to
complete the Activity. If the activity
should be completed in whole days,
enter 0 for this field and use the
Momentum Due Days field instead.

Momentum Start Module
Momentum Start Field

Visible only after setting the Momentum
Start Trigger to "On Parent Date Field",
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use these two fields to specify the
module and field that contains the date
relative to which the activity's
momentum timer will begin. You must
select the module first to populate the
available date fields for that module.

Name Enter the name of the action item or
milestone that this activity represents.
The name will be displayed on the
activity card under the stage's column
header.

Order This is the step number that
corresponds with where the activity
chronologically appears under the stage
header. By default, the number will
reflect the order in which the activities
are created, but it can be edited as
needed. The order number is also
displayed to the left of the activity's
name.

Points The Points field controls the growth of
the Progress bar that is displayed for
every running Smart Guide in Sugar.
You can assign 1 to 10 points to an
activity using the dropdown, which
defaults to 10. Each time you assign
points to an activity, the parent stage's
total point value increases and so does
the overall Smart Guide's point value.
Later, when a user engages with a
Smart Guide, the Progress Bar will grow
commensurate to each completed
activity's point value relative to the
Smart Guide's total point value. For
more information on progress points,
please refer to the Smart Guide
Progress section of this page.

Populate Fields This field is only visible on the activity
template when the activity's target Call,
Meeting, or Task module contains one
or more custom fields that were created
in Studio. The admin can specify a
custom value for any custom field.
Simply select the field that you would
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like to update (e.g. "Call Purpose") from
the dropdown list and then type the
value (e.g. "Call to schedule demo") in
the adjacent field. You can populate the
values of multiple fields for the activity
record by using the Add and Remove
icons at the end of the row.

Priority Only visible for task activities, this will
help you prioritize the tasks in a Smart
Guide

Send Invites For calls and meetings, choose whether
Sugar should send email invitations to
the guests. 

None: Do not send email
invitations to the call or meeting
guests.
On Create: When a user starts
this Smart Guide, Sugar will
instantly send email invitations
to the activity's assigned user
and the person associated with
the Smart Guide's parent Sugar
record (e.g. the lead or contact).
On Stage Start: When the stage
starts that contains this
activity, Sugar will send email
invitations to the guests on the
call or meeting record. By
default, the guest list contains
the activity's assigned user and
the person associated with the
Smart Guide's parent Sugar
record (e.g. the lead or contact),
but users can add or remove
guests via the call or meeting's
record view before the stage
begins.

Due Date Type Decide when this activity's progress
timer should recognize that this task is
due relative to the Smart Guide or stage
you are in. After selecting an option, you
will be prompted to enter the number of
days until the activity is due in the Due
Days field.
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Days From
Created: The activity's
due date will be relative
to the day the entire
Smart Guide began.
Days From Stage
Started: The activity's
due date will be relative
to the day the current
stage began.
Days From Previous
Activity Completed:
The activity's due date
will be relative to the day
the previous activity was
closed or held.
Days From Parent Date
Field: The activity's due
date will be relative to a
day found in a date field
of the Smart Guide's
parent module. This
option will reveal the Due
Date Field, Due Date
Module, and Due Date
Criteria fields.
Days From Specific
Activity Completed:
The activity's due date
will be relative to the day
a specified activity is
completed. This option
will reveal the Due Date
Activity field.

Due Days Visible only after selecting the Due Date
Type, enter the number of days it should
take to complete this activity in order to
calculate the activity's Due Date field.

Note: If the Due Date Type is "Days
From Parent Date Field" and the Due
Date Criteria is set to "Percentage",
then this field will be read as a
percentage number (e.g., "50" = 50%)
instead of a number of days.
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Due Date Activity Visible only after setting the Start/Due
Date Type to "Days From Specific
Activity Completed", use this field to
select the activity that, when closed, will
set the current activity's due date based
on the value set in Start/Due Days.

Due Date Module Visible only after setting the Due Date
Type field to "Days from Parent Date
Field", select the module that contains
the field that contains the date relative
to which the activity will be due. You
must select the module before you can
select the Due Date Field.

Due Date Field Visible only after setting the Due Date
Type field to "Days from Parent Date
Field", select the field that contains the
date relative to which the activity will be
due. You must select the module first to
populate the available date fields for
that module.

Due Date Criteria Visible only after setting the Due Date
Type to "Days From Parent Date Field",
choose how to calculate the Due Date
relative to the Due Date Field:

Absolute: The Due Days field
will be interpreted as a number
of days to add or subtract from
the Due Date Field field. (e.g.,
Expected Close Date +/- 2 days)
Percentage: The Due Days field
will be interpreted as a
percentage value (e.g., a value of
50 equals 50%, which is
multiplied against the difference
between the date the activity
starts and the value in the Due
Date Field).

Start Date Type Decide when this activity's progress
timer should begin relative to the Smart
Guide or stage you are in. After
selecting an option, you will be
prompted to enter the number of days
until the activity is due in the Start Days
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field.

Days From Created: The
activity's start date will be
relative to the day the entire
Smart Guide began.
Days From Stage Started: The
activity's start date will be
relative to the day the current
stage began.
Days From Previous Activity
Completed: The activity's start
date will be relative to the day
the previous activity was closed
or held.
Days From Parent Date Field:
The activity's start date will be
relative to a day found in a date
field of the Smart Guide's parent
module. This option will reveal
the Start Date Field and Start
Date Module fields.
Days From Specific Activity
Completed: The activity's start
date will be relative to the day a
specified activity is completed.
This option will reveal the Start
Date Activity field.

Start Days Visible only after selecting the Start
Date Type, enter the number of days it
should take to start this activity relative
to the trigger event.

Start Date Field;
Start Date Module

Visible only after setting the Start Date
Type to "Days From Parent Date Field",
use these two fields to specify the
module and field that contains the date
relative to which the activity will begin.
You must select the module first to
populate the available date fields for
that module.

Time of Day Only visible for call and meeting
activities, the Time of Day field is an
optional start time for the activity.
Please note that the start date will be
determined by the Start/Due Date Type
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and Start/Due Days fields.
Start Next Smart Guide This field allows the admin to optionally

select a Smart Guide that will begin
when this activity is completed. The new
Smart Guide will be created and related
to the same parent record as the current
Smart Guide's parent.

Task Type The Task Type field is shown when
"Task" is selected for the Activity Type.
Each task type is represented by a
different icon in the Smart Guide. The
types of tasks are:

 Customer Task: This task
will be performed by the
customer, such as a click-
through on a message or a
request for information. The
Smart Guide's target assignee
must manually close this task in
Sugar to complete the activity in
the Smart Guide.

 Internal Task: This task will
be assigned to a Sugar user to
complete. Some examples of
internal tasks include sending
product information and
proposals.

 Agency Task: This task will
be performed by a 3rd party
supplier or a non-Sugar user.
Some examples of agency tasks
include credit checks and
procurement approvals. The
Smart Guide's target assignee
must manually close this task in
Sugar to complete the activity in
the Smart Guide.

 Automatic Task: This task
represents an activity that is
performed by an automated
process, typically within Sugar
(e.g. workflows or Advanced
Workflow) or in a connected app.
The Smart Guide's target
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assignee must manually close
this task in Sugar to complete
the activity in the Smart Guide.

 Milestone: This task often
requires no action. It represents
a significant decision or moment
in the customer's Smart Guide.
Some examples include reaching
a targeted revenue amount or a
certain number of email clicks or
opens.

URL Optionally, insert an internal (from your
Sugar instance) or external (from the
web or your intranet) URL that will help
the user complete the current activity.
The value of the URL field will be shown
as a link shortcut on the activity in the
Smart Guide view. For more
information, refer to the Sugar
Automate User Guide.

Note: Custom URLs can be crafted
using the same variables that are
leveraged in Web Hooks for Smart
Guides. 

Adding Related Sugar Actions

Each stage and activity in a Smart Guide may contain up to four Related Sugar
Actions that prompt the user to create, view, or edit a Sugar record that is related
to the Smart Guide's parent record. The Related Sugar Actions module is available
as a subpanel under each Smart Guide, stage, and activity template's record view.

When used on activities, a Related Sugar Action will appear on the activity in the
Smart Guide as the icon in the following screenshot unless you set the Display Icon
field to "No" or set the Action Trigger Type to be automatic. When the user hovers
over a Related Sugar Action icon on an activity, they will see the descriptive text
used as the Related Sugar Action record's name. The user can click on the icon at
any time during the Smart Guide to perform the activity's related action. The
admin also has the option to launch the action automatically when its parent
activity begins or ends using the Trigger Event setting on the activity's Related
Sugar Action record. For more information on the options available, refer to the 
Related Sugar Action Fields section. For more information on completing Related
Sugar Actions, refer to the Sugar Automate User Guide.
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When used on a stage or Smart Guide instead of at the activity level, a Related
Sugar Action will not show as an icon; instead, it will automatically initiate when
the stage or Smart Guide is set to In Progress or Completed, as set in the Trigger
Event field. For more information on the options available, refer to the Related
Sugar Action Fields section. For more information on completing Related Sugar
Actions, refer to the Sugar Automate User Guide.

To add a Related Sugar Action to a Smart Guide stage or activity, follow these
steps:

1. Navigate to the Smart Guide template record and find or create the stage
or activity that should contain a Related Sugar Action.

2. Click on the name of the stage or activity in the template.

3. From the stage or activity's record view, scroll down to the Related Sugar
Actions subpanel and click on the Create (+) button.

Note: There is a limit of one active Related Sugar Action per Trigger Event
type for each stage or activity in a Smart Guide. Attempting to add a
second Related Sugar Action for the same Trigger Event type will result in
an error on save unless one of the records has an "Active" value of "false". 

4. After clicking the Create (+) button, complete the form fields according to
the Related Sugar Action Fields and Pre-Populating Fields via Related
Sugar Actions sections, and then click "Save".

When setting the Relationship field, the first selector will always
display the parent record's module name (i.e., Calls, Meetings, or
Tasks) and refer to itself using the "self" identifier. If you would like
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to choose a record in a one-away module from the stage or activity
(e.g., the opportunity related to the activity), then change the first
selector to that module's name. A second Relationship selector
dropdown will then appear containing the related module's name
and it will now contain the "self" identifier to indicate that it is the
chosen record. If you would like to choose a record in a two-away
module from the stage or activity (e.g., create a contact related to
the opportunity that is related to the activity), then change the
second selector field to the two-away module. For this example, the
two-level relationship will require three dropdown fields configured
like this: 

5. After saving the Related Sugar Action, you will return to the stage or
activity record view. You can now add another Related Sugar Action for a
different Trigger Event on the stage or activity or click on the Smart Guide
Template name to return to configuring the overall Smart Guide.

Blocking Activities

Using the Blocked By field, the admin has the option to make an activity's start
dependent on the completion of one or more earlier activities. For example, you
can block users from starting "Meeting 2" until "Meeting 1" has been completed.

Similarly, the admin can choose to block activities until a specified stage has been
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completed using the Blocked By Stages field. For example, you can block users
from starting the "Value Proposition Meeting" activity until the "Prospecting and
Introduction" stage has been completed. 

Blocked activities display the Blocked icon (a circle with a slash) and do not have
options to start or complete the activity from the Smart Guide panel. Users will
also receive an error if they attempt to close the activity from its Sugar record
view. Once the required activities have been completed, then the blocked activity
will become unblocked.

Pre-Populating Fields via Related Sugar Actions

In the Related Sugar Actions module, values can also be set to pre-populate in
fields on the related record. When the Related Sugar Action is triggered and the
Action Trigger Type field is set to "Manual", a new drawer will open and the values
will be prefilled in the drawer which you selected in the Related Sugar Action
record's Populate Fields section. If the Action Trigger Type field is set to
"Automatic", the records will be created or updated in the background with the
predefined field values.

Simply select the field that you would like to update (e.g. "Name") from the
dropdown list and then type the value (e.g. "Call to schedule demo") in the
adjacent field. You can populate the values of multiple fields for the related record
by using the Add and Remove icons at the end of the row. If you choose to populate
a date or datetime-type field, then you can either set a fixed date (or date and
time) or one that occurs in the future relative to the day the action is triggered.
For relate fields, simply choose the field name and then select the record to relate.

When the Related Sugar Action's "Action Type" is set to "Create Record" and the
relationship type is a call, meeting, or task, the newly created activity will be
related to the Smart Guide and show up in the Smart Guide panel. To place the
new activity in a specific position in the Smart Guide, use the Populate Fields
functionality to set the "Smart Guide Order" field to the numeric place that the
activity should occupy in the Smart Guide.

Related Sugar Action Fields

The Related Sugar Actions module contains the following fields:

Field Description
Action Type Select whether you want the action to

edit, view, or create a related Sugar
record.

Note: When using the "Edit" and "View"
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action types, it is best practice to select
a related module that has a "one"
relationship with the current record
because the application can only let you
edit or view one related record during
the action. If more than one relationship
exists (a "many" relationship), the edit
or view action will occur for only one of
the related records. This may confuse
the user into thinking that only one
related record exists even when that is
not true.

Action Trigger Type This field is visible when the Action
Type field is set to "Create Record":

Manually Create/Update
Record: In the Smart Guide's
activity, the Related Sugar
Action icon will be visible. After
triggering this action, a new
drawer will open to manually
create/update the record. Any
predefined field values will be
added into the record's edit
view.
Automatically Create/Update
Record: The Related Sugar
Action icon will not be visible in
the Smart Guide's activity and
the functionality will be
performed in the background.
Any predefined field values will
also be automatically updated on
the record. For created email
records, choosing this option will
cause the email message to be
sent automatically to the chosen
recipients.

Active When "Active" is set to true, the Sugar
action will occur on the Smart Guide's
stage or activity record. A given stage or
activity can only have one active Related
Sugar Action per Trigger Event type.

Display Icon Set to "Yes" by default and available
only for Related Sugar Actions on
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activities with a trigger type of
"Manually Create/Update Record", set
this field to "No" to hide the clickable
icon that allows users to manually
initiate the Related Sugar Action. 

Email Fields When Action Type is set to "Create
Record" and the Relationship field is set
to "Email", the following two fields are
exposed to configure the email message:

Email Template: Select the
email template from Sugar's
Email Templates module to use
for the email. 
Select "To" Email
Address: Choose a combination
of contacts and users to
automatically add as recipients
of the email record.

Specific Users: Select
any active user.
Specific Contacts:
Select any contact
record.
Related Parent Users:
Add the user who is in
any user-relate field from
the Smart Guide's parent
record.
Related Parent
Contacts: Add a contact
that is related to the
Smart Guide's parent
record
Add All Contacts From
Parent: Add all of the
contacts that are related
to the Smart Guide's
parent record.

Smart Guide/Stage/Activity Template This is the parent Smart Guide, stage, or
activity template that contains the
Related Sugar Action. It should be pre-
populated with the name of the template
you started from.

Name The name of the Related Sugar Action
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record; will be displayed as a
description when the user hovers over
an activity's Related Sugar Action icon
in the Smart Guide.

Populate Fields This field is only visible on the Related
Sugar Action when the Action Type field
is set to "Create Record". The admin can
specify a custom value for fields on the
related Sugar record. For more
information, refer to the Pre-Populating
Fields via Related Sugar Actions
section.

Relationship Use the Relationship selector to choose
the type of record that you want the
user to view, create, or edit. For more
information on using the selector, refer
to the steps listed within the Adding
Related Sugar Actions to Stages and
Activities section.

Trigger Event Select when the user should be
prompted to complete this action. Please
note that each Trigger Event can only
have one active Related Sugar Action
per stage or activity.

In Progress: The action will
automatically launch in a new
tab when the stage or activity is
set to "In Progress".
Completed:  The action will
automatically launch in a new
tab when the stage or activity is
set to "Completed".
Not Applicable: For activities
only, the action will
automatically launch in a new
tab when the activity is set to
"Not Applicable".

Note: Regardless of the selected
Trigger Event, the user may choose to
click the Related Sugar Action icon on
an activity at any time during the Smart
Guide to perform the action without
being prompted. Proactively performing
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an action without prompt will not
prevent the prompt from occurring at
the designated Trigger Event time, but
the user may click "Cancel" to reject the
prompt.

Removing Stages and Activities from Smart Guide
Templates

If you would like to remove a stage or activity from a Smart Guide template, simply
expand the stage or activity's Actions menu and click on "Delete Stage" or "Delete
Activity." This will apply to all Smart Guides that are started after the change has
been made. Any running or completed Smart Guides will not be affected by the
deletion.

Disabling Stage and Activity Actions

If you would like to remove an option from the Stage Actions Menu or the Activity
Actions Menu in a Smart Guide, select the options using the "Disabled Stage
Actions" and "Disabled Activity Actions" fields on the Smart Guide template record.
These fields are both multiselect and are empty by default.

Disabling a stage action will remove it from the Actions menu for all users
on all of the stages in the Smart Guide.
Disabling an activity action will remove it from the Actions menu on all of
the Smart Guide's activities for all users.

Changes made to the Disabled Actions fields on existing Smart Guide templates
will be applied instantly on save and apply to all new and existing Smart Guides
related to the template.

Copying Smart Guide Templates

You can also create a new Smart Guide template by duplicating an existing Smart
Guide's template. The Copy option is useful if the Smart Guide you want to create
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has similar stages and activities to an existing Smart Guide. Unlike other records
in Sugar, all of the related stages and activities will also copy over to the new
Smart Guide template, which you can edit, rearrange, delete, or add to later.

The following steps cover creating a new Smart Guide template by duplicating an
existing Smart Guide template:

1. Navigate to Admin > Templates in the Smart Guide section of the Admin
panel.

2. Click on the name of the Smart Guide that you want to copy.
3. Click the record's Actions menu and select "Copy".

4. The displayed record view is pre-populated with the original Smart Guide's
values. Update the necessary fields and then click "Save."

Importing Smart Guide Templates

Smart Guide templates can be exported from one Sugar instance and then
imported into another Sugar instance where both have Sugar Automate (e.g. from
your test or development instance to your live production instance). Only files that
have been exported from a Sugar instance can be imported into a Sugar instance.
Exported Smart Guides will download as the appropriate .json file type for upload
to the Smart Guide Templates module.

Follow these steps to export a Smart Guide template from a test instance and then
import it to a production instance as an example:

Note: Both instances must have Sugar Automate.

1. In your test instance, create and configure a Smart Guide template with the
desired stages and activities according to the sections covered earlier on
this page.

2. When you are satisfied with the template, expand the template's record-
view Actions menu and click on "Export." Save the exported .json file to
your computer.
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3. Navigate to your production instance. In the Admin panel, click on
"Templates" in the Smart Guide section.

4. Click the three-dots menu in the Smart Guide Templates module tab and
select "Import Smart Guide Template".

5. Click on "Choose File" to search for and select the .json file you saved in
step 2 and then click "Import."

6. Review the template's design and settings to be sure everything imported
as expected.

7. Finally, activate the Smart Guide template in your production instance by
placing a checkmark in the template record's Active field and immediately
test its behavior.

Note: You cannot import a new Smart Guide template with the same name but
different ID as an existing Smart Guide template. You must change the name of the
new record or use "Copy" to create a duplicate Smart Guide template.

Updating Smart Guide Templates via Import

If you have access to a test instance with Sugar Automate, you can update existing
Smart Guide templates via the import tool. The existing Smart Guide template and
the updated Smart Guide template must have the same record IDs. This allows you
to export a Smart Guide template for maintenance without interrupting your
production instance.
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Follow these steps to update an existing Smart Guide template via the import tool:

Note: You must already have Sugar Automate on both your test and production
instances.

1. In your production instance, navigate to the record view for the Smart
Guide template that you would like to update.

2. Expand the template's record-view Actions menu and click on "Export."
Save the exported .json file to your computer.

3. Navigate to your test instance's Admin panel and click on "Templates" in
the Smart Guide section.

4. Click the three-dots menu in the Smart Guide Templates module tab and
select "Import Smart Guide Template."

5. Click on "Choose File" to search for and select the .json file you saved in
step 2 and then click "Import."

6. Navigate to the imported Smart Guide and make any changes according to
the sections covered earlier on this page.

7. When you have finished testing and making changes, expand the template's
record-view Actions menu and click on "Export." Save the exported .json
file to your computer, replacing the previous template file if prompted.

8. Return to your production instance. Navigate to the Admin panel and click
on "Templates" in the Smart Guide section.

9. Expand the Smart Guide Templates module tab and select "Import Smart
Guide Template."

10. Click on "Choose File" to search for and select the .json file you saved in
step 7 and then click "Import."

11. An alert will prompt you to confirm that you would like to replace the
existing template. Click "Confirm" to commit the update or click cancel to
without making any changes.
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The changes you made in your test instance should now be reflected in the original
Smart Guide template in your production instance. The changes will apply to all
Smart Guides that are started after the import. Any running or completed Smart
Guides will not be affected.

Using Smart Guides With SugarBPM

Customers using SugarBPM for workflow automation can configure their process
definitions to start, cancel, or delete a Smart Guide when specified conditions are
met.

Starting Smart Guides via SugarBPM

Administrators can configure process definitions to start a certain Smart Guide
when conditions are met for a record. For example, some opportunities may not
need to engage in the exhaustive sales process, like when an existing customer
requests a quote. For this scenario, the "Opportunity Quick Deal" Smart Guide
could be set to automatically begin when a new opportunity is created for existing
business. 

To set a condition for Smart Guides to start via SugarBPM, simply build a Change
Fields action into a process definition for the affected module. For the "quick deal"
example mentioned above, the affected module is Opportunities. In its simplest
form, the basic process definition structure would be as follows:

Target module: Opportunities
Start event: New records only; Type = Existing Business
Change Fields action: Smart Guide Template = "Opportunity Quick Deal"
End event: Terminate

For more information on creating process definitions, please refer to the 
SugarBPM documentation.

Canceling and Deleting Smart Guides via Sugar BPM

Two checkbox fields exist on the Smart Guide record that, when set to "true"
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(checked), will either cancel or delete a Smart Guide: "Is Canceled" and "Is
Deleted". An administrator can configure a SugarBPM process definition's Change
Fields action to set one of these fields to "true" and thereby cancel or delete the
running Smart Guide when a condition is met. For example, If an opportunity
closes before a related sales Smart Guide has completed, then the Smart Guide
could be set to automatically cancel.

To set a condition for deleting or canceling Smart Guides via SugarBPM, simply
build a Change Fields action into a process definition for the affected module. For
the example mentioned above, the affected module is Opportunities. In its simplest
form, the basic process definition structure would be as follows:

Target module: Smart Guides
Start event: New records and all updates; Smart Guide Template =
"Opportunity Quick Deal"
Receive Message event: Opportunities "Status" changes to "Closed Won"
OR Opportunities "Status" changes to "Closed Lost"
Change Fields action: "Is Cancelled" = true
End event: Terminate

For more information on creating process definitions, please refer to the 
SugarBPM documentation.

Adding SugarBPM Event Criteria Based on Smart Guides

When designing events that evaluate a set of criteria (e.g., Start event, gateways),
you can add criteria that evaluate meetings, calls, or tasks that are sub-activities of
a Smart Guide activity. For example, you might design a Start event that triggers a
process when all of the sub-tasks under the target meeting in a Smart Guide are
complete, which then notifies the creator of the meeting via email. In its simplest
form, the basic process definition for this example would be as follows:

Target module: Meetings
Start event: Updated records only (all updates); Tasks (Child Tasks:
parent_meeting_of_task_rel) when All Related Records have Status =
"Completed"
Send Message event: Send to user who created the meeting
End event: Terminate

The module relationships that represent these sub-activities in Smart Guides can
be difficult to differentiate from other relationships to the same modules but they
follow a certain naming convention. If you are viewing a process definition that
targets the Meetings module, the three sub-activity relationships are named as
described in the following table:
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Module Relationship in a Process
Definition Targeting the Meetings
Module

Value in the Module Dropdown Field

Call sub-activities of a meeting Calls [*:M] (Child Calls:
parent_meeting_of_call_rel)

Meeting sub-activities of a meeting Meetings [*:M] (Child Meetings:
parent_meeting_of_meeting_rel)

Task sub-activities of a meeting Tasks [*:M] (Child Tasks:
parent_meeting_of_task_rel)

The naming convention is the same when targeting the Calls or Tasks modules and
the names of the relationships in the above table can be extrapolated to these
target modules.

For more information on creating process definitions, please refer to the 
SugarBPM documentation.

Understanding Progress and Momentum

Sugar Automate measures the performance of each Smart Guide in Sugar via 
Smart Guide progress and Smart Guide momentum. Smart Guide progress lets you
know how close to completion the Smart Guide is, while momentum measures how
efficiently the Smart Guide has advanced with respect to the time-based
performance standards set by the administrator. 

The following sections explain progress and momentum in detail.

Smart Guide Progress

Smart Guide progress is visually represented as a Progress Bar. The blue portion
of the bar represents the percentage of points that have been completed relative to
the Smart Guide's total point value.
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Points contribute to the growth of the Progress Bar for running Smart Guides in
Sugar. When creating activities for your Smart Guide templates, you can assign 1
to 10 points to each activity in the Smart Guide. Each time you assign points to an
activity, the parent stage's total point value increases and so does the overall
Smart Guide's point value. Later, when a user engages with a Smart Guide, the
progress bar will grow commensurate to each completed activity's point value
relative to the Smart Guide's total point value.

While an activity can have a maximum of 10 points, there is no limit to the number
of points that may be attributed to a stage or Smart Guide. For more information
on Smart Guide progress, please refer to the Calculating Progress section of this
page.

All fields associated with Smart Guide progress are located on the activity's task,
meeting, or call record. For more information on assigning progress points, please
refer to the Smart Guide Activity Template Fields section.

Calculating Progress

The Smart Guide panel contains a progress bar that represents how far along a
customer is in the Smart Guide based on the point values and statuses of the
Smart Guide's activities. The administrator assigns the point values from 1 point
up to 10 points for each activity in a Smart Guide. When an activity is In Progress,
30% of its point value is credited to the progress bar. Activities set to Held,
Completed, Not Held, or Not Applicable credit 100% of their point values to the
progress bar. The Smart Guide calculates its overall progress as a percentage
rounded up to the next whole number: {points completed}/{total Smart Guide
points}.

For example, in the Smart Guide below, the administrator has created a Smart
Guide with a total of 240 points, and the activities associated with 80 of those
points have been completed. Therefore, the progress bar shows that the Smart
Guide is 33% complete (80/240=0.333, rounded down).
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Smart Guide Momentum

For most processes, there is an optimal amount of time that should elapse between
stages and activities. This is known as process momentum. Depending on the type
of Smart Guide, this is sometimes called velocity, efficiency, or forward motion.
Momentum functionality in the Sugar Automate allows admins to define the
optimal time-to-complete between activities and stages. The performance
standards can then be calculated against actual time-to-complete and used by
individuals and their managers to assess process efficiency.

Momentum Points contribute to the Momentum Score for running Smart Guides in
Sugar. A higher momentum point value for one activity over another would
indicate the relative importance of that activity over the other. All fields associated
with momentum are located on the activity's task, meeting, or call record. For
more information on assigning momentum points, please refer to the Smart Guide
Activity Template Fields section.

Smart Guide momentum is visually represented in Sugar as a Gauge Chart dashlet
but can also be displayed as a Momentum Bar on the list view dashlet. Both
visualizations show how well the Smart Guide is keeping up with expected time
standards as a percentage of momentum points completed.

For more information on the momentum functionality, please refer to the 
Calculating Momentum section of this page.

Calculating Momentum

Smart Guide momentum reflects how well a Smart Guide is keeping up with
expected time standards as a percentage of momentum points completed. When
momentum is defined for one or more activities, it becomes a part of a summed
score for the Smart Guide Stage as well as to the Smart Guide object itself.

The momentum of an activity contains its total Momentum Points when not yet
started. The tracking of the actual momentum days or hours only begins when an
activity has been started.

Below is an example of how Momentum Points and Momentum Scores are
calculated for the Gauge Chart and the Momentum Bar. As an example, imagine a
Smart Guide template that has been set up with two stages that have two tasks
each. Each task has the following Momentum Points and Momentum Due Days
set: 

Task Momentum
Points

Momentum
Due Days

Momentum
Due Hours

Stage
Totals

Smart
Guide Total

Task A 100 5 0 200 320
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potential 
momentum
points

potential 
momentum
points

Task B 100 5 0

Task C 80 5 0 120
potential 
momentum
points

Task D 40 5 0

In the example above, Task A is given a Momentum Point value of 100. if Task A is
completed within its expected 5 days (i.e., less than 120 hours), then the
Momentum Score for that task will remain 100. However, if Task A is completed
after the expected 5 days, for example, it takes 6 days (i.e., 144 hours), then the
score for that task will be less than 100 because there is a penalty for each hour
over the projected hours that a task is not completed.

The following calculation is used to calculate the Momentum Score for an activity:

Activity Momentum = (expected time / actual time) x potential activity
points

The formula applied to Task A, which was completed in 144 hours opposed to the
projected 120 hours, gives us a Momentum Score of 83 from the activity's 100
potential momentum points:

(120/144) x 100 = 83

Assuming no other activities in our example have kicked off, Tasks B, C, and D still
have perfect 100% scores and the overall Smart Guide Momentum after Task A is
completed is a total 303 (83+100+80+40) out of a potential 320, or 95% (rounded
up) of the Smart Guide's potential momentum points, as represented by the Smart
Guide's gauge chart:
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Momentum Scores are also visualized in the Smart Guide list view dashlet as a 
color-coded bar that follows the same color convention as the gauge chart and with
a bar-length that represents the momentum score's percentage of the Smart
Guide's potential momentum:

Reporting on Momentum

Smart Guide progress points, momentum points, and momentum scores are also
reportable fields in the Reports module. For more information on building reports
in Sugar, please refer to the Reports documentation. As an example, the following
report evaluates the average rate of momentum for the activities in a given Smart
Guide for all users. It helps to identify common points of delay in the Smart Guide
that may need the attention of management.

Note: Before using this report, be sure that you have assigned momentum points
for the activities in the Smart Guides that you want to track and that enough time
has passed for momentum values to have been calculated. For more information on
assigning momentum points, please refer to the Smart Guide Activity Template
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Fields section.

Use the following steps to create a report that evaluates the average momentum
for each task in a Smart Guide:

1. Navigate to the Reports module and create a Summation Report for the
Smart Guides module.

2. Define the first filter:
In the Related Modules panel, under the Smart Guides folder, find
the "Smart Guide Stages" folder and click on the + icon to expand
it.
Under the Smart Guide Stages folder, find the "Tasks" folder and
click on the word "Tasks".
In the Available Fields panel, click on the Status field to add the
filter to the main panel.
Set the filter's operator and value to "is Completed".

3. Define the second filter:
In the same Available Fields panel, click on the Smart Guide
Momentum Points field to add a new filter to the main panel.
Set the filter's operator and value to "Greater than 0".

4. Define the third filter:
In the Related Modules panel, under the topmost Smart Guides
folder, click on the words "Smart Guide Template" next to the
Smart Guide Template folder.
In the Available Fields panel, click on the Name field to add the
filter to the main panel.
Select your favorite Smart Guide template for the filter and enable
the Run Time Filter option.

5. Click "Next" and then set one Group-By field:
In the Related Modules panel, under the Smart Guides folder, find
the "Smart Guide Stages" folder and click on the + icon to expand
it.
Under the Smart Guide Stages folder, find the "Tasks" folder and
click on the word "Tasks".
In the Available Fields panel, click on the Subject field to add it to
the main panel.

6. Click "Next" to proceed to the Display Summary step where one Display
Summary line should already be set.

7. Set the following additional Display Summary:

Smart Guides > Smart Guide Stages > Tasks > AVG: Smart Guide
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Momentum Ratio
8. Click "Next" to proceed to the Chart Options step and choose "Vertical Bar

(Grouped)".
9. Click "Next" to proceed to the final step, name the report "Average

Momentum Ratio by Smart Guide Task", and click "Save & Run".

The resulting report will display a separate bar for each task in the selected Smart
Guide. The bar represents what fraction of 1 (i.e., 100%) each task has achieved in
momentum. Those with a value of less than 1 have lower rates of momentum based
on the average of their actual vs expected completion times. In the table below the
chart, you can also view the total average momentum for the entire Smart Guide.

 

Advanced Configurations

The following advanced options may be configured by administrators who want to 
enable additional modules to be used with Smart Guide templates, to define
custom "closed" statuses for records used in Smart Guides, and to create Web
Hooks for communicating with external systems.
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Configuring Modules for Smart Guides

The Smart Guide panel will be included on records for modules that are enabled
for Smart Guides via Configure Modules. By default, the Accounts, Contacts,
Leads, Opportunities, and Cases modules are enabled. When you create new Smart
Guide templates, the templates may include any combination of the enabled
modules.

If your business converts lead records into contacts and opportunities, then you
may want to design a Smart Guide template that follows the lead as it is converted
in the system. For example, if you design a Smart Guide template and select Leads,
Contacts, and Opportunities for the Smart Guide's Available Modules, a user will
then be able to start the Smart Guide on a lead record and continue to manage the
same Smart Guide after they convert the lead into a contact and, optionally, an
opportunity. Please note that the contact and opportunity records must be created
on the Lead Conversion screen in order for the Smart Guide to continue with those
records. 

To enable additional modules to be used with Smart Guide templates, you can
configure Sugar Automate's available modules via Admin > Sugar Automate
Settings > Configure Modules. Conversely, you can disable modules so that they
cannot be used in Smart Guides.

The following steps walk through how to make modules available for Sugar
Automate for your instance.

1. Navigate to Admin > Sugar Automate Settings > Configure Modules.

2. In the top section, select or remove modules until the multi-select field
displays the modules that you may want to use in a Smart Guide template
and click "Save". When you start creating individual Smart Guide
templates, you can select as many or as few of the enabled modules as you
like for each template.
Note: If you see a "No Access" label on this step, please clear your browser
cache and reload the page.
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Configuring Custom "Closed" Statuses

Many instances have been configured to use different statuses (e.g. Closed, In
Progress, Invalid) for records than the statuses used in a stock Sugar instance. You
may define which statuses Sugar Automate considers "closed" for your instance via
the Sugar dropdown editor.

By default, Sugar Automate considers tasks as closed when they have a status of
"Completed" or "Not Applicable". Calls and meetings are closed when they have a
status of "Held" or "Not Held". To add or remove statuses that are considered
closed in your instance, navigate to Admin > Dropdown Editor and modify the
statuses for the respective dropdown list shown below:

cj_calls_completed_status_list
cj_meetings_completed_status_list
cj_tasks_completed_status_list

For more information on working with dropdown lists, refer to the Developer Tools
documentation in the Sugar Administration Guide.

Assignment Notifications

When a user starts a new Smarx and one or more of the activities in that Smart
Guide are assigned to another user(s), the other users will receive a single,
compiled "digest" style email that lists all of the activities that are assigned to
them and of record type "task". No notifications will be sent to the logged-in user
starting the Smart Guide for tasks that are assigned to them. For any call or
meeting activities in the Smart Guide, email invitations will be sent according to
the default behavior of the Sugar version you are using.
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Please note that notification emails will only be sent if "Send Assignment
Notification" is enabled in both the admin System Email Settings and in the user's
profile.

Web Hooks

The Smart Guide Web Hooks allow you to send data to an external URL so that
additional processing can be completed outside the Sugar application. This can
allow you to send the data to other applications within your organization (e.g. send
a Slack message) or to validate that the Smart Guide can progress on to the next
stage.

Smart Guide Web Hooks are available for use with records in all of the template
modules (Smart Guide Templates, Stage Templates, and Activity Templates) via
the Web Hooks subpanel under each template's record view.

The following fields are available when creating a Smart Guide Web Hook:

Field Description
Active Whether the Web Hooks should trigger 
Custom Post Body Visible only when the Request Body field

is set to "Send Custom Post Body".
Enter the data that you want to send to
the endpoint with your request.

Error Message Path The path of the message to display when
an error occurs

Headers Optionally, send additional headers with
your Web Hook request. Each new line
will be treated as a new header. For
example: 

Content-Type: application/jsonX-
Api-Key: xxxxxxxxx

Ignore Errors Whether non-2xx HTTP Status Codes
should throw errors

Name The name of the Web Hook
Request Body Decide if you want to send the Smart

Guide's data or custom post body with
your request. 

Send Smart Guide
Information: The Smart
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Guide's values are sent in
the request as 'key =>
value' pairs.
Send Custom Post
Body: This option will
reveal the Custom Post
Body field where you can
add your custom post
body as a JSON string or
a Query String or plain
text, depending on the
implementation of the
endpoint you are sending
the request to. This will
be sent with your request
to the endpoint. For
information on including
variable data from the
Smart Guide or its
related parent record
(e.g., the Smart Guide's
name or fields from the
account record in an
account Smart Guide),
refer to the Custom Post
Body Variables section of
this page.

Request Format Select a format for sending the request
out

Request Method The HTTP request method that the web
logic will utilize to call out to the
specified URL

Response Format Select a format for receiving a response
Sort Order The order to process the Web Hook

relative to the order numbers of any
other Web Hooks for this template

Trigger Event The event that must occur in order for
the web logic hook to process (required
field)

URL The URL that will receive the data
transmitted by the web logic hook
Note: This URL should be a URL
outside of your Sugar instance. If you
have an instance on Sugar's cloud
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service, it is your responsibility to host
the URL that will process the web logic
hook.

Web Hook Example

This example will cover how to send a Slack message using the Web Hooks for
Sugar Automate.

Prerequisite: To successfully set up this integration, you must be the admin for
your Slack workspace or have permission explicitly granted by the Slack admin to
add webhooks to your workspace via the Slack API. 

Steps to complete:

1. Navigate to https://api.slack.com/apps and create a new app for your
workspace.

2. Activate incoming webhooks for your app:

3. After activating webhooks, click "Add New Webhook to Workspace" at the
bottom of the screen, and in the pop-up, select the Slack channel where you
want your message to appear. Copy the resulting URL to your clipboard.
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4. In your Sugar instance, navigate to the Web Hooks subpanel under the
template record (Smart Guide Template, Stage Template, or Activity
Template) where you want the web hook to trigger from. Click "Create" (+)
in the subpanel.

5. Configure the web hook record's fields as follows:

Request Method: POST
Trigger Event: For this example, we have selected "After In
Progress", meaning that our hook will get triggered after the parent
activity's status has been set to "In Progress".
URL: Enter the Webhook URL that you generated and copied from
Slack's API in the earlier step.
Request Format: Set the format in which the "Post Body" will be
sent. It can be a JSON string or a query string. For the Slack
example, we will be sending a JSON String.
Custom Post Body: Enter the post body to send with your request
as instructed in the Slack API documentation. For testing, we have
entered:
 {"text": "This message was sent via Smart Guide webhook:tada:"}
Note: To include variable data from the Smart Guide or its related
parent record (e.g., the Smart Guide's name or fields from the
account record in an account Smart Guide), refer to the Custom
Post Body Variables section of this page.

6. Save the web hook record in Sugar with an "Active" status enabled.
7. Test your web hook by clicking on "Send Test Request" in the Test

Webhook dashlet in the intelligence pane of the web hook's record view.
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To test your web hook in production, start the related Smart Guide in your Sugar
instance and set the relevant Smart Guide, stage, or activity to "In Progress".
When this web hook triggers, you will see a message in your Slack app.

Custom Post Body and URL Variables

When sending a web hook request via POST with a custom post body, you can
include field variables from the Smart Guide's parent record (the parent account or
contact, for example) and from the Smart Guide, stage, and activities to which the
web hook is associated. Additionally, the Current User, Assigned User, and site
URL variables can be sent to the external endpoint.

The variables used for web hooks can also be used in the URL field on Smart Guide
Activity records to create custom dynamic URLs that reflect data from the parent
record. For example, entering the value
http://www.google.com/search?q={$parent.name} will take the user who clicks
the link from a running Smart Guide to a google search for the name of the parent
record.
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The following variables are only a few examples but serve to illustrate the format
that is used. Please note that relate-type fields cannot be used as variables.

{$site_url}
{$current_user.full_name}
{$assigned_user.full_name}
{$parent.name}
{$activity.name}
{$stage.name}
{$Smart Guide.name}

Test Webhook Dashlet

From the Web Hooks record view, you will see a special Test Webhook Dashboard
which contains the Test Webhook dashlet. The Test Webhook dashlet lets you send
a test request to validate your work. Simply save the web hook record and then
click on "Send Test Request".

SugarLive Management

Overview

SugarLive, available to users with a Sugar Serve 11.0 and higher or Sugar Sell
11.1 and higher license type, is an omnichannel tool for customer service agents
and sales team members to communicate in real-time with customers via chat and
phone. SugarLive is available toward the bottom of Sugar's navigation bar, which
is also where system administrators with a Sugar Serve or Sugar Sell license type
can open the configuration screen to customize the layout. In particular, admins
can choose the fields available in the Summary panel and the inclusion and layout
of the dashlets in the Contact, Account, Lead, and Case tabs. Please note, the Lead
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tab is only available to users with a Sugar Sell license, and the Case tab is only
available to users with a Sugar Serve license.

To use SugarLive, your organization must have an Amazon Connect account
because Amazon Connect is used to route incoming calls and chats to SugarLive.
See the prerequisites outlined in the SugarLive documentation for more details.

Prerequisites

In order to configure the SugarLive layout, the following requirements must be
met:

You must be a system administrator user.
You must have a Sugar Serve or Sugar Sell license type.
You must either be logged out of Amazon Connect or have your status set
to "Offline" in the Communication panel. See the Configuring the
Communication Panel and Logging In sections of the SugarLive
documentation for details on logging out and updating your status in
Amazon Connect.

Although SugarLive can only be used with certain web browsers, it is still possible
to configure the SugarLive layout using all supported browsers. See the Supported
Platforms page for details on which supported browsers cannot be used to access
SugarLive.

For more information on license types and the module functionality available for
each type, refer to the User Management documentation.

Configuring SugarLive

To customize the layout of SugarLive, click the three-dot menu to the right of the
SugarLive icon in the navigation bar and choose "Configure Layout". This opens
SugarLive in a configuration view where you can change which information is
shown and in which layout. The floating actions button is open by default so you
can quickly access all of the configuration tools available. Note that the three-dot
menu is only available to Sugar Serve or Sugar Sell admins and can only be
opened when logged out of Amazon Connect or set to "Offline". Any changes made
to SugarLive will update the layout for all users who access SugarLive.
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Once open, the SugarLive configuration view shows a read-only preview of what
SugarLive looks like for all users without actual data. The Summary panel and 
Detail panel can be configured but the Communication panel cannot, so it is
displayed as a placeholder to help you visualize what the final layout will look like.
Certain basic settings can be configured by all users in the Communication panel
during a live session; see the SugarLive page for more details on these settings. In
the Detail panel, all tabs are enabled even though they are empty so that you can
configure them. For more information on using each of these panels during an
active session, see the SugarLive documentation.

When you are done customizing the SugarLive layout, click the X button in the top
right corner. This closes the configuration view, which allows you to log in to
Amazon Connect or set yourself to "Available" again. All changes made to the
Detail panel are automatically saved, so you can close the view at any time without
losing your changes.

Configuring the Summary Panel

To change which fields are displayed in the Summary panel, click the Configure
Summary Panel option with the pencil icon in the floating actions button. This
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opens a drawer where you can configure the fields in the Summary panel for both
call and chat sessions. Changes made to the Summary panel are applied for all
users once you click the Save Summary Panel button within the drawer.

The drawer is divided into three sections:

Preview: This section shows a live preview of what the Summary panel
currently looks like, including any unsaved changes you have made since
opening the drawer. It contains a Calls and a Messages tab so you can
configure the Summary panel differently for each.
Layout: This section shows the fields that are currently configured to be
displayed in the Summary panel and includes a link to restore the default
settings for the tab.
Available Fields: This section lists all fields for the current module (e.g.,
calls or messages) that are not already displayed in the Summary panel.
Note: Action Button fields are not available to add to the layout.
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To add fields to the Summary panel for call or chat sessions, open the appropriate
tab and drag fields from the Available Fields section to any position in the Layout
section. You can also drag fields within the Layout section to reorder them. To
remove a field, click the X icon that appears next to the field when you hover over
it.

As you make updates to the layout, the preview on the left side is automatically
updated to reflect your changes so you can see what each update will look like.
The Summary panel has a maximum height, so a vertical scrollbar is added when
more fields than can fit are added to the layout. If there is a scrollbar in the
preview, there will also be one in SugarLive during an actual session.
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Note that the Guests and Related to fields at the top cannot be removed. These
fields indicate to which records the current session is linked and are updated using
the Link button in the Detail panel of SugarLive. See the SugarLive documentation
for more details on linking records.

Once you are happy with your changes to the layout, click "Save Summary Panel"
to save your changes in both the Calls and Messages tabs. Note that the main
SugarLive configuration view always shows the Calls Summary panel but both can
be previewed within the Configure Summary Panel drawer.

Restoring Default Settings

To reset the layout of the Summary panel for the specific type of session you are
editing (e.g., call or chat), select "Click here" in the blue box on the right side. This
immediately restores the default settings for the tab. If you change your mind and
want to return the layout to its previously-saved state, click "Cancel" to close the
drawer without saving. Otherwise, to preserve the reset default layout, click "Save
Summary Panel" to save both tabs.

Configuring the Detail Panel

The Detail panel is a tabbed view displayed on the right side of SugarLive. For the
most part, it can be configured in the same way you edit any dashboard, by
dragging, resizing, adding, editing, and removing dashlets. Changes you make to
each tab are immediately visible to all users the next time they open SugarLive. To
avoid disruption to your customer service agents' work, it is recommended to make
SugarLive configuration changes outside of regular business hours.
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When you first open the SugarLive configuration view, the Detail panel is set to the
Contact tab and the floating actions button is open so you can quickly access
configuration options. See the sections below for details on configuring
the Contact, Account, Lead, and Case tabs, and using the floating actions button to
restore default settings or configure the Summary panel.

Note: The Search tab is not able to be configured.

Module Tabs

The Contact, Account, Lead, and Case tabs can all be completely configured in the
same way you edit any dashboard, by adding, editing, removing, rearranging, and
resizing dashlets. Note that the Record View dashlet in the top left corner of each
tab includes the Link button to relate the current record to the call or message in
context. Removing the dashlet is not recommended because it also removes the
ability to choose to which contact, account, lead, or case the ongoing session
should be linked. You can use the floating actions button to restore the current tab
to its default layout at any time. See the Dashboards and Dashlets page for details
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on editing dashboards in Sugar.

Floating Actions Button

The floating actions button is shown on all tabs of the Detail panel and contains
options to configure the Summary panel and restore the current tab to its default
settings. On the Contact, Account, Lead, and Case tabs, it also contains an option
to add a dashlet to the tab. Restoring to defaults only impacts the current tab and
will restore all aspects, including the configuration of all dashlets (e.g., list view
filters) and the complete dashboard layout. If you click "Confirm" in the pop-up
that appears, the change is saved immediately and cannot be undone.
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